Vision
Engineering Manual

Software Issue: v18.0 MD
Vision • Engineering Manual

- Ross Part Number: 4800DR-401-18.0
- Release Date: January 20, 2015. Printed in Canada.
- Software Issue: v18.0 MD

The information contained in this manual is subject to change without notice or obligation.

Copyright

©2015 Ross Video Limited, Ross®, OverDrive®, and any related marks are trademarks or registered trademarks of Ross Video Limited. All other trademarks are the property of their respective companies. PATENTS ISSUED and PENDING. All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, mechanical, photocopying, recording or otherwise, without the prior written permission of Ross Video. While every precaution has been taken in the preparation of this document, Ross Video assumes no responsibility for errors or omissions. Neither is any liability assumed for damages resulting from the use of the information contained herein.

Windows is a registered trademark of Microsoft Corporation in the United States and other countries.

Mac OS X is a trademark of Apple Inc., registered in the U.S. and other countries.

Fedora and the Infinity design logo are trademarks of Red Hat, Inc.

Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of their respective owners.

Python and PyCon are trademarks or registered trademarks of the Python Software Foundation.

Patents

Patent numbers 4,205,346; 5,115,314; 5,280,346; 5,561,404; 7,034,886; 7,508,455; 7,602,446; 7,834,886; 7,914,332; 8,499,019 B2; 2039277; 1237518; 1127289 and other patents pending.

Send Us Your Comments

We welcome any comments you have about our documentation. Send comments to the Technical Communications department at the following address: solutions@rossvideo.com
Important Regulatory and Safety Notices to Service Personnel

Before using this product and any associated equipment, refer to the “Important Safety Instructions” listed below to avoid personnel injury and to prevent product damage.

Product may require specific equipment, and/or installation procedures to be carried out to satisfy certain regulatory compliance requirements. Notices have been included in this publication to call attention to these specific requirements.

Symbol Meanings

**Protective Earth** — This symbol identifies a Protective Earth (PE) terminal, which is provided for connection of the supply system’s protective earth (green or green/yellow) conductor.

This symbol on the equipment refers you to important operating and maintenance (servicing) instructions within the Product Manual Documentation. Failure to heed this information may present a major risk of damage or injury to persons or equipment.

**Warning** — The symbol with the word “Warning” within the equipment manual indicates a potentially hazardous situation which, if not avoided, could result in death or serious injury.

**Caution** — The symbol with the word “Caution” within the equipment manual indicates a potentially hazardous situation which, if not avoided, may result in minor or moderate injury. It may also be used to alert against unsafe practices.

**Warning Hazardous Voltages** — This symbol is intended to alert the user to the presence of uninsulated “dangerous voltage” within the product enclosure that may be of sufficient magnitude to constitute a risk of shock to persons.

**ESD Susceptibility** — This symbol is used to alert the user that an electrical or electronic device or assembly is susceptible to damage from an ESD event.

Important Safety Instructions

**Warning**

1. Read these instructions.
2. Keep these instructions.
3. Heed all warnings.
4. Follow all instructions.
5. Do not use this apparatus near water.
6. Clean only with a dry cloth.
7. Do not block any ventilation openings. Install in accordance with manufacturer’s instructions.
8. Do not install near heat sources such as radiators, heat registers, stoves, or other apparatus (including amplifiers) that produce heat.

9. Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized plug has two blades with one wider than the other. A grounding type plug has two blades and a third grounding prong. The third prong is provided for your safety. If the provided plug does not fit into your outlet, consult an electrician for replacement of the obsolete outlet.

10. Protect the power cord from being walked on or pinched, particularly at plugs, convenience receptacles, and the point where they exit from the apparatus.

11. Only use attachments/accessories specified by the manufacturer.

12. Unplug this apparatus during lightning storms or when unused for long periods of time.

13. Refer all servicing to qualified service personnel. Servicing is required when the apparatus has been damaged in any way, such as when the power-supply cord or plug is damaged, liquid has been spilled or objects have fallen into the apparatus, the apparatus has been exposed to rain or moisture, does not operate normally, or has been dropped.

14. Do not expose this apparatus to dripping or splashing, and ensure that no objects filled with liquids, such as vases, are placed on the apparatus.

15. To completely disconnect this apparatus from the AC Mains, disconnect the power supply cord plug from the AC receptacle.

16. The mains plug of the power supply cord shall remain readily operable.

17. The Octane/QMD-X, MD-X, QMD, and MD (Live Production Engine) chassis is to be rack mounted only.

**Warning**

18. **Indoor Use: WARNING:** To reduce the risk of fire or electric shock, do not expose this apparatus to rain or moisture.

19. The safe operation of this product requires that a protective earth connection be provided. A grounding conductor in the equipment's supply cord provides this protective earth. To reduce the risk of electrical shock to the operator and service personnel, this ground conductor must be connected to an earthed ground.

20. **WARNING:** This apparatus, when equipped with multiple power supplies, can generate high leakage currents. To reduce the risk of electric shock, ensure that each individual supply cord is connected to its own separate branch circuit with an earth connection.

21. **CAUTION:** These service instructions are for use by qualified service personnel only. To reduce the risk of electric shock, do not perform any servicing other than that contained in the operating instructions unless you are qualified to do so (Engineering Manual only).

**Caution**

22. These apparatus contain Lithium batteries, which if replaced incorrectly, or with an incorrect type, may cause an explosion. Replace only with the same type. Dispose of used batteries according to the manufacturer’s instruction.

23. Service barriers within this product are intended to protect the operator and service personnel from hazardous voltages. For continued safety, replace all barriers after servicing.

24. Certain parts of this equipment still present a safety hazard with the power switch in the OFF position. To avoid electrical shock, disconnect all A/C power cords from the chassis' rear appliance connectors before servicing.

25. This product contains safety critical parts, which, if incorrectly replaced, may present a risk of fire or electrical shock. Components contained within the product’s power supplies and power supply area are not intended to be customer-serviced and should be returned to the factory for repair.
26. To reduce the risk of fire, replacement fuses must be the same type and rating.

27. Use only power cords specified for this product and certified for the country of use.

28. The safe operation of this equipment requires that the user heed and adhere to all installation and servicing instruction contained within the equipment’s Engineering Manuals.

29. For applicable V-100/V-100A Touchscreen Panel power supplies, see user instructions contained within the Product’s Engineering Manual.

30. **WARNING**: Batteries shall not be exposed to excessive heat such as sunshine, fire or the like.

31. **WARNING**: This product includes an “Ethernet Port” which allows this product to be connected to a local area network (LAN). Only connect to networks that remain inside the building. Do not connect to networks that go outside the building.

**EMC Notices**

**United States of America**

**FCC Part 15**

This equipment has been tested and found to comply with the limits for a class A Digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

*Notice — Changes or modifications to this equipment not expressly approved by Ross Video Limited could void the user’s authority to operate this equipment.*

**CANADA**

This Class “A” digital apparatus complies with Canadian ICES-003.

*Cet appareil numerique de la classe “A” est conforme a la norme NMB-003 du Canada.*

**EUROPE**

This equipment is in compliance with the essential requirements and other relevant provisions of CE Directive 93/68/EEC.

**INTERNATIONAL**

This equipment has been tested to CISPR 22:1997 along with amendments A1:2000 and A2:2002, and found to comply with the limits for a Class A Digital device.

*Notice — This is a Class A product. In domestic environments, this product may cause radio interference, in which case the user may have to take adequate measures.*

**General Handling Guidelines**

- Careful handling, using proper ESD precautions, must be observed.
• Power down the system before PCB removal.

A Word About Static Discharge

Throughout the many procedures in this Engineering Manual, please observe all static discharge precautions.

**Caution** — Avoid handling the switcher circuit boards in high static environments such as carpeted areas, and when synthetic fiber clothing is worn. Touch the frame to dissipate static charge before removing boards from the frame, and exercise proper grounding precautions when working on circuit boards.
Warranty and Repair Policy

Ross Video Limited (Ross) warrants its switchers and related options, to be free from defects under normal use and service for a period of ONE YEAR from the date of shipment. Fader handle assemblies are warranted for the life of the product. If an item becomes defective within the warranty period Ross will repair or replace the defective item, as determined solely by Ross.

Warranty repairs will be conducted at Ross, with all shipping FOB Ross dock. If repairs are conducted at the customer site, reasonable out-of-pocket charges will apply. At the discretion of Ross, and on a temporary loan basis, plug in circuit boards or other replacement parts may be supplied free of charge while defective items undergo repair. Return packing, shipping, and special handling costs are the responsibility of the customer.

Software upgrades for switchers may occur from time to time, and are determined by Ross Video. The upgrades are posted on the Ross Video website, and are free of charge for the life of the switcher.

This warranty is void if products are subjected to misuse, neglect, accident, improper installation or application, or unauthorized modification.

In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or consequential damages (including loss of profit). Implied warranties, including that of merchantability and fitness for a particular purpose, are expressly limited to the duration of this warranty.

This warranty is TRANSFERABLE to subsequent owners, subject to Ross’ notification of change of ownership.
Environmental Information

The equipment that you purchased required the extraction and use of natural resources for its production. It may contain hazardous substances that could impact health and the environment.

To avoid the potential release of those substances into the environment and to diminish the need for the extraction of natural resources, Ross Video encourages you to use the appropriate take-back systems. These systems will reuse or recycle most of the materials from your end-of-life equipment in an environmentally friendly and health conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.

If you need more information on the collection, reuse, and recycling systems, please contact your local or regional waste administration.

You can also contact Ross Video for more information on the environmental performances of our products.
# Contents

## Introduction

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About This Manual</td>
<td>Eng 1-2</td>
</tr>
<tr>
<td>Documentation Conventions</td>
<td>Eng 1-3</td>
</tr>
<tr>
<td>Documentation Terms</td>
<td>Eng 1-4</td>
</tr>
<tr>
<td>Abbreviations</td>
<td>Eng 1-5</td>
</tr>
<tr>
<td>Related Publications</td>
<td>Eng 1-6</td>
</tr>
<tr>
<td>A Word About Technical Support</td>
<td>Eng 1-7</td>
</tr>
</tbody>
</table>

## Switcher Basics

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Equipment Overview</td>
<td>Eng 2-2</td>
</tr>
<tr>
<td>Vision Control Panel</td>
<td>Eng 2-2</td>
</tr>
<tr>
<td>Vision Touchscreen Display</td>
<td>Eng 2-7</td>
</tr>
<tr>
<td>Frame</td>
<td>Eng 2-7</td>
</tr>
<tr>
<td>Control Panel Modules</td>
<td>Eng 2-10</td>
</tr>
<tr>
<td>Control Panel CPU Module</td>
<td>Eng 2-10</td>
</tr>
<tr>
<td>Panel Module Controller Board</td>
<td>Eng 2-10</td>
</tr>
<tr>
<td>Keyers Module</td>
<td>Eng 2-10</td>
</tr>
<tr>
<td>Global Memory Module</td>
<td>Eng 2-10</td>
</tr>
<tr>
<td>Effects Memory Module</td>
<td>Eng 2-10</td>
</tr>
<tr>
<td>Transition Module</td>
<td>Eng 2-11</td>
</tr>
<tr>
<td>Positioner Module</td>
<td>Eng 2-11</td>
</tr>
<tr>
<td>Preview Bus Module</td>
<td>Eng 2-11</td>
</tr>
<tr>
<td>Power Distribution Board</td>
<td>Eng 2-11</td>
</tr>
<tr>
<td>Frame Boards</td>
<td>Eng 2-12</td>
</tr>
<tr>
<td>Frame CPU Board</td>
<td>Eng 2-12</td>
</tr>
<tr>
<td>Video Input Board, 16 Input</td>
<td>Eng 2-12</td>
</tr>
<tr>
<td>Video Input Board, with Crosspoint</td>
<td>Eng 2-12</td>
</tr>
<tr>
<td>Video Input Board, 10 Input</td>
<td>Eng 2-12</td>
</tr>
<tr>
<td>Video Output Board</td>
<td>Eng 2-12</td>
</tr>
<tr>
<td>Video Processor Board</td>
<td>Eng 2-13</td>
</tr>
<tr>
<td>Midplane</td>
<td>Eng 2-13</td>
</tr>
<tr>
<td>Crosspoint Board</td>
<td>Eng 2-13</td>
</tr>
<tr>
<td>Squeeze &amp; Tease Carrier Board</td>
<td>Eng 2-13</td>
</tr>
<tr>
<td>Power Supplies</td>
<td>Eng 2-13</td>
</tr>
<tr>
<td>Communication Ports</td>
<td>Eng 2-15</td>
</tr>
<tr>
<td>Control Panel Communication Ports</td>
<td>Eng 2-15</td>
</tr>
<tr>
<td>Frame Communication Ports</td>
<td>Eng 2-16</td>
</tr>
<tr>
<td>Tally Ports</td>
<td>Eng 2-18</td>
</tr>
</tbody>
</table>
Physical Installation and Cabling

Unpacking Your Switcher ................................................................. Eng 3-2
Static Discharge ........................................................................ Eng 3-2
Serial Numbers ........................................................................... Eng 3-2
Opening and Closing the Frame Door ........................................ Eng 3-3
Octane/QMD/X Frame ................................................................. Eng 3-3
MD/X Frame ................................................................................ Eng 3-4
Frame Installation ......................................................................... Eng 3-5
Installing the Frame ................................................................. Eng 3-5
Control Panel Installation .......................................................... Eng 3-7
Control Panel Installation ......................................................... Eng 3-7
Touchscreen Display Installation ........................................ Eng 3-8
Frame to Control Panel Cabling ................................................ Eng 3-11
Frame to Control Panel Cable Installation .................................... Eng 3-11
Keyboard and Mouse Installation ............................................... Eng 3-12
Video Input Cabling .................................................................... Eng 3-13
Default Input Mapping ............................................................. Eng 3-13
Video Output Cabling ................................................................ Eng 3-15
Default Output Mapping ............................................................ Eng 3-15
Monitor Connections ................................................................ Eng 3-16
Button Inserts ............................................................................. Eng 3-17
Button Insert Films .................................................................... Eng 3-17
Installing Control Panel Button Inserts ...................................... Eng 3-17
Power Supply Connections ......................................................... Eng 3-19
Frame Power Connection ........................................................... Eng 3-19
Control Panel Power Connection ............................................. Eng 3-19
Touchscreen Display Power Connection ..................................... Eng 3-20
Power Fail Indicators ................................................................ Eng 3-21
Power Failure ............................................................................. Eng 3-21

Initial Setup and Verification

Powering Up and Powering Down the Switcher ................................ Eng 4-2
Powering Up the Switcher .......................................................... Eng 4-2
Powering Down the Switcher ...................................................... Eng 4-3
Network Setup ............................................................................ Eng 4-5
Frame Network Setup ................................................................. Eng 4-5
Control Panel Network Setup ..................................................... Eng 4-6
Network Security ........................................................................ Eng 4-8
MultiPanel Setup ......................................................................... Eng 4-9
MLE Assignment ........................................................................ Eng 4-9
Using the Menu System

Touchscreen Interface ................................................................. Eng 5-2
Menu System Basics ................................................................. Eng 5-5
  Using the Punchpad .............................................................. Eng 5-7
  Using the Positioner with the Menu System ......................... Eng 5-9
Quick Navigation Buttons ......................................................... Eng 5-10
Menu Skins ................................................................................ Eng 5-12
Control Panel Mnemonics ......................................................... Eng 5-13
  Default Mnemonic Appearance .............................................. Eng 5-13
Control Panel Displays ............................................................ Eng 5-16
Using the Naming Menus ............................................................ Eng 5-17
Help Features ............................................................................. Eng 5-18
  Online Manuals ................................................................ Eng 5-18
  Pop-up Help ........................................................................ Eng 5-18
Screen Captures ........................................................................ Eng 5-19

Software Upgrades and Options

Vision Web Interface Account .................................................... Eng 6-2
Software Upgrade ...................................................................... Eng 6-3
  Preparing the Switcher Before an Upgrade ............................. Eng 6-3
  Performing the Upgrade ........................................................ Eng 6-3
  Rebooting the Switcher After an Upgrade ............................... Eng 6-6
System Information Overview .................................................... Eng 6-7
  System Information Region ...................................................... Eng 6-7
  Storage Capacity Region ......................................................... Eng 6-8
Installed Options ......................................................................... Eng 6-9
  Accessing the Installed Options Menus ..................................... Eng 6-9
  Installing Serial Numbers ........................................................ Eng 6-11
  Installing Software Options ..................................................... Eng 6-11
  Storing and Recalling Option Codes ..................................... Eng 6-14

Input Source Configuration and Check

Naming Input Sources .................................................................. Eng 7-2
Source Configuration Menu Overview ........................................ Eng 7-3
Assigning Input Source Types ..................................................... Eng 7-4
Assigning Alphas ....................................................................... Eng 7-6
Configuring Auto Keys .............................................................. Eng 7-8
### Video Output Configuration and Check

- Configuring Video Outputs .............................................................. Eng 8-2
  - To Configure your Output BNCs .................................................. Eng 8-2
- Checking Video Outputs ................................................................. Eng 8-5
  - To Confirm the Outputs on the Output BNCs ............................... Eng 8-5
- Clean Feed ...................................................................................... Eng 8-7
  - To set up a Clean Feed Output .................................................... Eng 8-7
- Fade to Black .................................................................................. Eng 8-9
- MLE Tally ....................................................................................... Eng 8-10
  - To Set Up an MLE Tally ............................................................... Eng 8-10
- Ancillary Data ................................................................................ Eng 8-11
  - To Set the Ancillary Data Parameters ....................................... Eng 8-11
- Switch on Field ............................................................................. Eng 8-13
  - To Set which Field a Transition is Performed On ...................... Eng 8-13
- MultiViewer .................................................................................... Eng 8-14
  - MultiViewer Assignment ............................................................ Eng 8-14
  - MultiViewer Layouts .................................................................. Eng 8-15
- Mix/DSK ......................................................................................... Eng 8-19
  - Mix/DSK Setup ........................................................................... Eng 8-20
  - Mix/DSK Operation ................................................................. Eng 8-20
- MultiDSK ...................................................................................... Eng 8-22
  - MultiDSK Setup .......................................................................... Eng 8-23
- Mix/DSK and MultiDSK ............................................................... Eng 8-24
  - Mix/DSK and MultiDSK Setup ..................................................... Eng 8-24
- AuxKeys ...................................................................................... Eng 8-26
  - AuxKeys Setup ........................................................................... Eng 8-26
  - AuxKey Pre Mixer/Keyer ........................................................... Eng 8-28

### Basic Communications Setup

- Communications Overview .......................................................... Eng 9-2
- Device Drivers ............................................................................. Eng 9-2
- Control Panel Serial Communications Ports ............................. Eng 9-2
- Frame Serial Communications Ports ......................................... Eng 9-2
- Ethernet Communications ......................................................... Eng 9-3
- Installing and Managing FlexDevice Drivers ............................ Eng 9-4
  - Installing FlexDevice Drivers .................................................. Eng 9-4
  - Initializing FlexDevice Drivers ................................................ Eng 9-5
  - Stopping FlexDevice Drivers ................................................... Eng 9-5
  - Deleting FlexDevice Drivers .................................................... Eng 9-6
- Setting Up Communications ....................................................... Eng 9-7
## Vision Engineering Manual (v18.0 MD) Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom Control Bank Setup</td>
<td>Eng 10-7</td>
</tr>
<tr>
<td>Naming Custom Control Banks and Shortcuts</td>
<td>Eng 10-8</td>
</tr>
<tr>
<td>Programming Control Panel Functions</td>
<td>Eng 10-10</td>
</tr>
<tr>
<td>Relative Custom Controls</td>
<td>Eng 10-11</td>
</tr>
<tr>
<td>Running Multiple Custom Controls</td>
<td>Eng 10-13</td>
</tr>
<tr>
<td>Programming Special Functions</td>
<td>Eng 10-15</td>
</tr>
<tr>
<td>Attaching Custom Controls to Panel Buttons</td>
<td>Eng 10-25</td>
</tr>
<tr>
<td>Deleting Custom Control Attachment to Panel Buttons</td>
<td>Eng 10-26</td>
</tr>
<tr>
<td>Editing Custom Controls</td>
<td>Eng 10-28</td>
</tr>
<tr>
<td>To Edit a Custom Control</td>
<td>Eng 10-29</td>
</tr>
<tr>
<td>Attaching a Custom Control to a Panel Button</td>
<td>Eng 10-32</td>
</tr>
<tr>
<td>Deleting Custom Controls</td>
<td>Eng 10-33</td>
</tr>
<tr>
<td>Custom Control Shortcuts</td>
<td>Eng 10-34</td>
</tr>
<tr>
<td>Device Transport Commands</td>
<td>Eng 10-36</td>
</tr>
<tr>
<td>Setting up Device Transport Commands</td>
<td>Eng 10-36</td>
</tr>
<tr>
<td>Custom Control Variable Pause</td>
<td>Eng 10-37</td>
</tr>
<tr>
<td>Setting a Custom Control Variable</td>
<td>Eng 10-37</td>
</tr>
<tr>
<td>Inserting a Variable Pause</td>
<td>Eng 10-37</td>
</tr>
</tbody>
</table>

## Custom Controls

- Custom Controls ........................................................................ Eng 10-2
- Tips for Working with Custom Controls .................................. Eng 10-2
- Stopping Custom Controls ..................................................... Eng 10-4
- Custom Control Interfaces .................................................... Eng 10-5
- Custom Control Bank Setup ..................................................... Eng 10-7
- Naming Custom Control Banks and Shortcuts ............................. Eng 10-8
- Programming Control Panel Functions .................................... Eng 10-10
- Relative Custom Controls ..................................................... Eng 10-11
- Running Multiple Custom Controls ......................................... Eng 10-13
- Programming Special Functions ............................................ Eng 10-15
- Attaching Custom Controls to Panel Buttons ............................ Eng 10-25
- Deleting Custom Control Attachment to Panel Buttons ................ Eng 10-26
- Editing Custom Controls ....................................................... Eng 10-28
- To Edit a Custom Control ...................................................... Eng 10-29
- Managing Custom Controls ..................................................... Eng 10-32
- Deleting Custom Controls ..................................................... Eng 10-33
- Custom Control Shortcuts ..................................................... Eng 10-34
- Device Transport Commands .................................................... Eng 10-36
- Setting up Device Transport Commands ................................... Eng 10-36
- Custom Control Variable Pause ............................................. Eng 10-37
- Setting a Custom Control Variable ......................................... Eng 10-37
- Inserting a Variable Pause ................................................... Eng 10-37

## Swticher Personality

- Personality List ....................................................................... Eng 11-2
- Control Panel Button Color Schemes ...................................... Eng 11-17
- General Color Usage Setup .................................................... Eng 11-17
- Assigning a Crosspoint Color ............................................... Eng 11-19
- Selecting a Color ................................................................... Eng 11-19
- Mnemonic Color Schemes ....................................................... Eng 11-21
- Control Panel Display Brightness ......................................... Eng 11-23
- Loading Color Schemes ........................................................... Eng 11-24
- Lock/Unlock Personality ....................................................... Eng 11-25
Completing Setup

Aux Bus Setup ........................................................................................................ Eng 12-2
Selecting Aux Buses .............................................................................................. Eng 12-2
Naming Aux Buses ................................................................................................. Eng 12-2
Aux Bus Router Follow .......................................................................................... Eng 12-3
Default MLE Map Assignment .............................................................................. Eng 12-5
Squeeze & Tease Mode ............................................................................................. Eng 12-6
Key 4 Mode .............................................................................................................. Eng 12-8
Standard GPI Setup ................................................................................................. Eng 12-10
  GPI I/O Information .............................................................................................. Eng 12-10
  GPI I/O Connection ............................................................................................... Eng 12-11
Setting Up GPI Inputs ............................................................................................ Eng 12-11
GPI Input Tallies ...................................................................................................... Eng 12-14
Setting Up GPI Outputs ......................................................................................... Eng 12-15
  Naming GPI Outputs .............................................................................................. Eng 12-16
Clip Setup ................................................................................................................ Eng 12-17
  Programming Clips ................................................................................................. Eng 12-17
  Grabbing a Timecode ............................................................................................. Eng 12-20
Audio Channel Setup .............................................................................................. Eng 12-21
  Setting Up Audio Sources ..................................................................................... Eng 12-21
  Setting Up Audio Channels ................................................................................... Eng 12-22
  Setting Up Audio Groups ...................................................................................... Eng 12-23
  Setting Audio Channel Names ............................................................................... Eng 12-24
  Setting Audio Fade Rate ....................................................................................... Eng 12-24
  Not Assign Audio Channel to Audio Fader ......................................................... Eng 12-25
Factory Default Settings ........................................................................................ Eng 12-27
  Recalling Factory Default Settings ...................................................................... Eng 12-27
Preview Overlay Setup ............................................................................................ Eng 12-30
  Preview Overlay Font Color .................................................................................. Eng 12-30
  Preview Overlay Component Setup ....................................................................... Eng 12-31
Set System Time ...................................................................................................... Eng 12-37
  Setting System Time Manually ............................................................................ Eng 12-37
  Setting System Time Automatically ....................................................................... Eng 12-38
Auto Follow ............................................................................................................. Eng 12-39
  Auto Follow Setup ................................................................................................. Eng 12-39
Frame Over-Temperature Shutdown .................................................................... Eng 12-44
Lock/Unlock Installation ......................................................................................... Eng 12-45

File and Setup Storage

File Storage Overview ............................................................................................ Eng 13-2
Storing and Recalling Files and Setups ................................................................. Eng 13-4
  Storing Registers ................................................................................................. Eng 13-4
  Recalling Registers ............................................................................................... Eng 13-9
Managing Setups with an External Computer ...................................................... Eng 13-15
  Downloading Setups to an External Computer ..................................................... Eng 13-15
  Uploading Setups from an External Computer ....................................................... Eng 13-15
Hard Drive Backup and Restore .......................................................................... Eng 13-17
  To Backup the Switcher Hard Drive ..................................................................... Eng 13-17
  To Restore the Switcher Hard Drive ...................................................................... Eng 13-18

Auxiliary Panels

Auxiliary Panel Overview ....................................................................................... Eng 14-2
Auxiliary Control Panel ........................................................................................ Eng 14-2
Remote Aux Panels ............................................................................................... Eng 14-3
Installing Auxiliary Panels ................................................................................... Eng 14-5
Switcher Maintenance 18

Switcher Logs
Collecting Logs
Deleting Logs
Cycling Logs

To Run the VNC Viewer .................................................................Eng 17-31
Video Checksum Custom Controls ...............................................Eng 17-32
Setting Up a Checksum Custom Control .................................Eng 17-32
Using a Checksum Custom Control ...........................................Eng 17-34
Communication Port Monitor .......................................................Eng 17-36
To Monitor a Serial Port .............................................................Eng 17-36
Port Monitor Data Files ...............................................................Eng 17-37

Appendix A. Menu Trees 19

Setup and Installation Menu Trees .................................................Eng 19-2
Setup Menu Tree ........................................................................Eng 19-2
Installation Menu Tree .................................................................Eng 19-2
Source Configuration Menu Tree ...............................................Eng 19-3
Output BNC Menu Tree ..............................................................Eng 19-4
Communications Menu Tree .........................................................Eng 19-5
Custom Control Bank Menu Tree ................................................Eng 19-6
Custom Controls Menu Tree ........................................................Eng 19-7
File Storage Menu Tree ...............................................................Eng 19-8
Disk Store Menu Tree .................................................................Eng 19-8
Disk Recall Menu Tree .................................................................Eng 19-8
Disk Store Individual Item Menu Tree ........................................Eng 19-9
Disk Recall Individual Item Menu Tree .......................................Eng 19-9
Recall Factory Menu Tree ............................................................Eng 19-10
Squeeze & Tease and Effects Menu Tree ......................................Eng 19-11
Effects Menu Tree ......................................................................Eng 19-11
Squeeze & Tease MD Position/Crop Menu Tree .......................Eng 19-11
Squeeze & Tease MD Border Menu Tree ......................................Eng 19-12
Squeeze & Tease MD Sequence Menu Tree ...............................Eng 19-12
Channel Management Menu Tree ..............................................Eng 19-12

Cleaning the Frame Air Filter .......................................................Eng 18-15
Frame Power Supply Failure .........................................................Eng 18-6
Frame Fan Failure .......................................................................Eng 18-8
Control Panel Power Supply .......................................................Eng 18-10
Frame Power Supply Function ................................................................Eng 18-12
Replacing the Hard Drive ..............................................................Eng 18-16
Replacing a Control Panel Module ..............................................Eng 18-21
Removing a Control Panel Module .............................................Eng 18-21
Upgrading PMCs ........................................................................Eng 18-23
Dusting Mode .............................................................................Eng 18-25

Troubleshooting a Failed Power Supply ........................................Eng 18-2
Troubleshooting a Failed Cooling Fan .........................................Eng 18-3
Replacing a Power Supply Module ..............................................Eng 18-4
Replacing the Hard Drive on the 4800AR-001 Frame CPU Board....Eng 18-16
Replacing the Hard Drive on the 4800AR-002 Frame CPU Board....Eng 18-18
Replacing a Control Panel Module ..............................................Eng 18-21
Installing a Control Panel Module ..............................................Eng 18-22
Updating PMCs ..........................................................................Eng 18-23
Deleting Logs .............................................................................Eng 17-38
Collecting Logs ..........................................................................Eng 17-38
Cycling Logs ..............................................................................Eng 17-39

Troubleshooting a Failed Cooling Fan ..........................................Eng 18-3
Troubleshooting a Failed Power Supply .......................................Eng 18-2
Replacing a Power Supply Module ..............................................Eng 18-4
Replacing a Power Supply Module ..............................................Eng 18-4
Replacing a Control Panel Module ..............................................Eng 18-21
Removing a Control Panel Module .............................................Eng 18-21
Upgrading PMCs ........................................................................Eng 18-23
Appendix B. Specifications

Standard Components................................................................. Eng 20-2
General Switcher Specifications.................................................. Eng 20-3
Control Panel Power Supplies...................................................... Eng 20-3
Frame Power Supplies................................................................. Eng 20-4
Operating Environment Requirements......................................... Eng 20-5
Physical Specifications............................................................... Eng 20-6
Control Panel Dimensions.......................................................... Eng 20-6
Frame Dimensions...................................................................... Eng 20-6
Communication Specifications.................................................... Eng 20-8
Default Network Settings............................................................. Eng 20-8
Module Control Link Backbone................................................... Eng 20-9
Frame Connector Types............................................................... Eng 20-12
Control Panel Connector Types.................................................. Eng 20-13
Video Characteristics................................................................. Eng 20-14
Video Processing......................................................................... Eng 20-14
Video Formats............................................................................ Eng 20-14
Timing......................................................................................... Eng 20-15
LTC Timecode Input...................................................................... Eng 20-15
Video Input Signal Characteristics.............................................. Eng 20-15
Video Output Signal Characteristics........................................... Eng 20-16
Frame Pinouts............................................................................ Eng 20-17
Peripheral Ports........................................................................ Eng 20-17
Panel Port.................................................................................... Eng 20-17
GPI I/O Ports............................................................................... Eng 20-18
LAN Ports.................................................................................... Eng 20-19
AC Power Ports.......................................................................... Eng 20-19
Control Panel Pinouts................................................................. Eng 20-21
Remote Ports.............................................................................. Eng 20-21
External Link Ports...................................................................... Eng 20-21
Tally Ports.................................................................................... Eng 20-22
AC Power Ports.......................................................................... Eng 20-23
Control Panel CPU Module Ports............................................... Eng 20-24
Control Panel CPU Module Functional Components................ Eng 20-24
Control Panel CPU Module Rear Panel....................................... Eng 20-25
Remote Aux Panel Pinouts.......................................................... Eng 20-27
GPI Port...................................................................................... Eng 20-27
Main Port.................................................................................... Eng 20-27
Echo Port.................................................................................... Eng 20-28
Aux Panel Programming Mode Summary.................................... Eng 20-29

Appendix C. Worksheets

Video Input Worksheet................................................................. Eng 21-2
Bus Map Worksheet................................................................. Eng 21-6
Video Output Worksheet............................................................ Eng 21-9
Communications Worksheet..................................................... Eng 21-11
Standard GPI I/O Input Worksheets.......................................... Eng 21-11
Standard GPI I/O Output Worksheets........................................ Eng 21-14
Aux Panel GPI I/O Worksheet................................................... Eng 21-15
Custom Control Worksheets...................................................... Eng 21-18
Conversion Loop Worksheets..................................................... Eng 21-20
Appendix D. Software Licenses

GNU General Public License ................................................................. Eng 22-2
Lesser GNU Public License (LGPL) ..................................................... Eng 22-4
BSD License ....................................................................................... Eng 22-7
   General ......................................................................................... Eng 22-7
Apache License .................................................................................. Eng 22-8
Expat License .................................................................................... Eng 22-10
Imlib2 ............................................................................................... Eng 22-11
Jiffy ................................................................................................. Eng 22-12
Fedora 14 - License Agreement ......................................................... Eng 22-13
PSF LICENSE AGREEMENT FOR PYTHON 2.7.3 ......................... Eng 22-14

Appendix E. Custom Device Protocols

Custom Devices – Uses and Limitations ........................................... Eng 23-2
Advanced Topics and Tables ................................................................. Eng 23-3

Glossary of Terms

Index
Introduction

A Word of Thanks

Congratulations on choosing the Ross Vision Multi-Definition Digital Production Switcher. You have purchased the power and versatility of a digital Multi-Level Effects (MLE®) switcher that is ready to take on all creative challenges in today’s competitive live production environment. You’ll be pleased at how easily your Vision switcher fits into your overall working environment.
About This Manual

This manual takes you through the physical installation, configuration, and setup required to integrate your Octane/QMD-X, MD-X, QMD, or MD frame with a Vision control panel into your facility.

If, at any time, you have a question pertaining to the installation of your Ross Vision switcher, please contact us at the numbers listed in the front of this manual. Our technical staff are always available for consultation, training, or service.

For information on setting up external devices to work with your Vision switcher, refer to the Ross Video External Device Setup Sheet for your device.
Documentation Conventions

The following conventions are used throughout this manual:

- Navigation procedures in this manual set state the button you are to press, followed by the menu that the button appears on. For example, the following navigation procedure shows you how to navigate from the Main Menus to the Installation Menus. In this case, you press More, and then Setup on the Main Menu 2-2, then you press Installation on the Setup Menu 1-2.
  › Press HOME ➔ Setup ➔ Installation.

- References in this manual to navigation buttons, such as HOME, UP ONE, and HOLD, refer to the buttons on the Touchscreen Display located immediately to the left of the Display Region that you are interacting with.

- Rear panel connectors are indicated in bold-faced upper case letters. For example:
  › The AUX 1 connector is …

- Control Panel buttons are indicated in bold-faced upper case letters, using a sans-serif font. For example:
  › Press WIPE to …

- Menu names on the integral display panel are indicated in bold-faced text. For example:
  › The Aux Bus Setup Menu allows you to …

- Softkey labels on the integral display are indicated in bold-faced text, using a sans-serif font. They are not indicated by the function key below the display that you press. For example:
  › Press Accept New Name to register …

- Each module, or group of buttons, on the control panel is shown in bold-faced text. For Example:
  › Press the UNDO button in the Global Memory Module to …

- The “Operating Tip” and “Note” boxes are used throughout this manual to provide customers with additional useful information. For example:

  Operating Tip — When the DHCP is set to On, you can use the Refresh button to poll the server for the current network address information.

  Note — If the DHCP option in On, the remaining settings are automatically configured. If the DHCP is Off, you will have to manually enter values into all the fields.
Documentation Terms

The following terms are used throughout this guide:

- **“Switcher”** refers to the entire Vision Multi-Definition Production Switcher, consisting of its electronics frame and control panel.
- **“Frame”** and **“Electronics Frame”** both refer to the Octane/QMD-X, MD-X, QMD, and MD Multi-Definition Digital Production Switcher chassis.
- **“Operator”** and **“User”** refer to the person who uses the Vision Multi-Definition Production Switcher.
- **“Control Panel”** refers to the large multi-button control panel of the Vision Multi-Definition Production Switcher.
- **“Master Panel”** refers to the panel in a MultiPanel application that can control and can be connected to external devices.
- **“Satellite Panel”** refers to the panels in a MultiPanel application that cannot be connected to an external device.
- **“SDI”** refers to Serial Digital Video, a digital video signal that is distributed via a single coaxial cable with BNC connectors.
- **“Video System”** refers to the mix of interconnected digital equipment (including the edit controller, VTRs, DVEs, etc.) in which the Vision Multi-Definition Production Switcher is included.
- **“Storage device”** refers to the hardware used to save and recall Setups, configurations and registers of the Vision Multi-Definition Production Switcher. Examples of storage devices are the internal hard drive and a USB flash drive.
- **“Bottom MLE”** refers to the lowest, or Program/Preset, MLE on each switcher. This MLE is typically the MLE that provides the main program output of the switcher, and includes the Downstream Keyers. On a **Vision 2**, for example, this would be **MLE 2**.
- **“Half MLE”** refers to the Program/Preset, MLE on the **Vision x.5 MLE switchers**. The Mix/DSK option is applied to this MLE.
- **“Full MLE”** refers to the full featured MLEs of a switcher. On a **Vision 2.5**, for example, MLEs 1 and 2 are Full MLEs, because they are fully functional, but MLE 3 is a Half MLE.
- **“Setup”** refers to a group, or set, of registers that are stored together either on the switcher, or on an external computer. Setups can be stored and recalled to quickly configure the switcher for different productions.
### Abbreviations

The following table (Table 1.1) abbreviations are used throughout the text.

**Table 1.1 Abbreviations used in this Manual**

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>A-D</td>
<td>Analog-to-Digital</td>
</tr>
<tr>
<td>AUX</td>
<td>Auxiliary</td>
</tr>
<tr>
<td>CG</td>
<td>Character Generator</td>
</tr>
<tr>
<td>D-A</td>
<td>Digital-to-Analog</td>
</tr>
<tr>
<td>DA</td>
<td>Distribution Amplifier</td>
</tr>
<tr>
<td>DDR</td>
<td>Digital Disk Recorder</td>
</tr>
<tr>
<td>DSK</td>
<td>Downstream Keyer</td>
</tr>
<tr>
<td>DVE</td>
<td>Digital Video Effects</td>
</tr>
<tr>
<td>DVR</td>
<td>Digital Video Recorder</td>
</tr>
<tr>
<td>ID</td>
<td>Identification</td>
</tr>
<tr>
<td>HD</td>
<td>High Definition</td>
</tr>
<tr>
<td>MD</td>
<td>Multi-definition</td>
</tr>
<tr>
<td>MLE</td>
<td>Multi-level Effects</td>
</tr>
<tr>
<td>PGM</td>
<td>Program Bus</td>
</tr>
<tr>
<td>PST</td>
<td>Preset Bus</td>
</tr>
<tr>
<td>PST PATT</td>
<td>Preset Pattern</td>
</tr>
<tr>
<td>PV</td>
<td>Preview</td>
</tr>
<tr>
<td>RU</td>
<td>Rack Unit</td>
</tr>
<tr>
<td>SD</td>
<td>Standard Definition</td>
</tr>
<tr>
<td>TD</td>
<td>Technical Director</td>
</tr>
<tr>
<td>VCR</td>
<td>Video Cassette Recorder</td>
</tr>
<tr>
<td>VDCP</td>
<td>Video Disk Communications Protocol</td>
</tr>
<tr>
<td>VTR</td>
<td>Video Tape Recorder</td>
</tr>
</tbody>
</table>
Related Publications

All Vision switchers come with a complete set of system documentation that includes an Operator’s Manual and an Engineering Manual.

For a complete operational overview of the Vision product line, refer to the following publications:

- *Ross Video External Device Setup Sheets Compendium*, Ross Part Number: 4800DR-404
A Word About Technical Support

At Ross Video, we take pride in the quality of our products, but if a problem does occur, help is as close as the nearest telephone.

Our 24-Hour Hot Line service ensures you have access to technical expertise around the clock. After-sales service and technical support are provided directly by Ross Video personnel. During business hours (eastern standard time), technical support personnel are available by telephone. Outside of normal business hours and on weekends, a direct emergency technical support phone line is available. If the technical support personnel who is on call does not answer this line immediately, a voice message can be left and the call will be returned shortly. Our Technical support staff are available to react to any problem and to do whatever is necessary to ensure customer satisfaction.

• Technical Support: (+1) 613-652-4886
• After Hours Emergency: (+1) 613-349-0006
Switcher Basics

In This Chapter

This chapter provides a basic introduction to the Vision switcher, including an overview of the boards in the control panel and frame, as well as an introduction to the various ports, and video buses.

The following topics are discussed in this chapter:

• Equipment Overview
• Control Panel Modules
• Frame Boards
• Communication Ports
• Tally Ports
• GPI I/O Port
• Video Routing
• Video Formats
• CPU Structure
• Board Labelling
Equipment Overview

This section provides an overview of the control panel and frame of the Vision Live Production Engine.

The 4-Keyer option that is available for the Octane/QMD-X and QMD frames adds two additional keyers to each MLE of the switcher. Included with this option is a 4-Keyer, Keyers Module for each MLE.

Vision Control Panel

The control panel of the Vision switcher provides all the basic user input of the switcher, as well as the majority of the external device control. Depending on the Vision switcher you have, your control panel will look like one of the following:

Vision 4 Control Panel

The Vision 4 control panels (Figure 2.1) have 4 Panel Rows, 40 Crosspoint Buttons per Bus, 40 Custom Control Buttons, a Transition Module, Memory System Module and Keyer Module per MLE and a Positioner Module as standard.

![Vision 4 Control Panel](image)

**Figure 2.1** Vision 4 Control Panel (4-Keyer Shown)

On the rear of the Vision 4 control panels there are 8 Remote Ports, 8 Tally Ports, 2 PS/2 Ports, 4 External Link Ports, an Ethernet Port for connecting the control panel to the frame, and a Primary and Redundant Power Supply Port, as standard. Refer to the section “Communication Ports” on page Eng 2-15 for more information on these communication ports.

Vision 3 Control Panel

The Vision 3 control panels (Figure 2.2) have 3 Panel Rows, 32 Crosspoint Buttons per Bus, 32 Custom Control Buttons, a Transition Module, a Memory Module, and Keyer Module per MLE, and a Positioner Module as standard.
On the rear of the Vision 3 control panels there are 8 Remote Ports, 6 Parallel Tally Ports, 2 PS/2 Ports, 4 External Link Ports, an Ethernet Port for connecting the control panel to the frame, and a Primary and Redundant Power Supply Port, as standard. Refer to the section “Communication Ports” on page Eng 2-15 for more information on these communication ports.

**Vision 2X Control Panel**

The Vision 2X control panels (Figure 2.3) have 2 Panel Rows, 32 Crosspoint Buttons per Bus, 32 Custom Control Buttons, a Transition Module, a Memory Module, and Keyer Module per MLE, and a Positioner Module as standard.

On the rear of the Vision 2X control panel there are 8 Remote Ports, 6 Tally Ports, 2 PS/2 Ports, 4 External Link Ports, an Ethernet Port for connecting the control panel to the frame, and a Primary and Redundant Power Supply Port, as standard. Refer to the section “Communication Ports” on page Eng 2-15 for more information on these communication ports.
**Vision 3M Control Panel**

The **Vision 3M** control panels (Figure 2.4) have **3 Panel Rows, 24 Crosspoint Buttons** per Bus, **24 Custom Control Buttons**, a **Transition Module**, an **Effects Memory Module** and **Keyer Module** per MLE, and a **Positioner Module** as standard.

![Figure 2.4 Vision 3M Control Panel (4-Keyer Shown)](image)

On the rear of the **Vision 3M** control panels there are **8 Remote Ports**, **6 Parallel Tally Ports**, **2 PS/2 Ports**, **4 External Link Ports**, an **Ethernet Port** for connecting the control panel to the frame, and a **Primary** and **Redundant Power Supply Port**, as standard. Refer to the section “Communication Ports” on page Eng 2-15 for more information on these communication ports.

**Vision 2M Control Panel**

The **Vision 2M** control panels (Figure 2.3) have **2 Panel Rows, 24 Crosspoint Buttons** per Bus, **24 Custom Control Buttons**, a **Transition Module**, a **Memory Module**, and **Keyer Module** per MLE, and a **Positioner Module** as standard.

![Figure 2.5 Vision 2M Control Panel (4-Keyer Shown)](image)

On the rear of the **Vision 2M** control panel there are **8 Remote Ports, 4 Tally Ports, 2 PS/2 Ports, 4 External Link Ports**, an **Ethernet Port** for connecting the control panel to the frame,
and a Primary and Redundant Power Supply Port, as standard. Refer to the section “Communication Ports” on page Eng 2-15 for more information on these communication ports.

**Vision 2 Control Panel**

The Vision 2 control panels (Figure 2.6) have 2 Panel Rows, 16 Crosspoint Buttons per Bus, 16 Custom Control Buttons, a Transition Module, a Memory Module and Keyer Module per MLE, and a Positioner Module as standard.

![Figure 2.6 Vision 2 Control Panel (4-Keyer Shown)](image)

On the rear of the Vision 2 control panels there are 8 Remote Ports, 4 Parallel Tally Ports, 2 PS/2 Ports, 4 External Link Ports, an Ethernet Port for connecting the control panel to the frame, and a Primary and Redundant Power Supply Port, as standard. Refer to the section “Communication Ports” on page Eng 2-15 for more information on these communication ports.

**Vision 1M Control Panel**

The Vision 1M control panel (Figure 2.8) has 1 Panel Row, 24 Crosspoint Buttons per Bus, 24 Custom Control Buttons, a Transition Module, a Memory Module, and Keyer Module per MLE, and a Positioner Module as standard.
On the rear of the Vision 1M control panel there are 8 Remote Ports, 2 Parallel Tally Ports, 2 PS/2 Ports, 4 External Link Ports, an Ethernet Port for connecting the control panel to the frame, and a Primary and Redundant Power Supply Port, as standard. Refer to the section “Communication Ports” on page Eng 2-15 for more information on these communication ports.

Vision 1 Control Panel

The Vision 1 control panel (Figure 2.8) has 1 Panel Row, 16 Crosspoint Buttons per Bus, 16 Custom Control Buttons, a Transition Module, a Memory Module, and Keyer Module per MLE, and a Positioner Module as standard.

On the rear of the Vision 1 control panel there are 8 Remote Ports, 2 Parallel Tally Ports, 2 PS/2 Ports, 4 External Link Ports, an Ethernet Port for connecting the control panel to the...
frame, and a **Primary** and **Redundant Power Supply Port**, as standard. Refer to the section “**Communication Ports**” on page Eng 2-15 for more information on these communication ports.

**Vision Touchscreen Display**

The interactive touchscreen display (**Figure 2.9**) of the Vision control panel provides all of the menu interaction for the switcher, including functions such as pattern control selection, external device interface control, and switcher setup. Refer to the section “**Touchscreen Interface**” on page Eng 5-2 for more information on using the touchscreen display.

---

**Note** — The **Touchscreen Display** is an option with the **Vision 1**, and **2** control panels. If you do not have the Touchscreen Display, an LCD computer monitor with a DVI-D connector is required.

---

**Frame**

The frame of the Vision switcher performs all the video routing and manipulation of the switcher. The frame consists of a chassis with a midplane into which all the frame boards are installed. Boards are installed into both the front and the rear of the frame.

**Frame Rear**

The rear of the frame is where all of the **Video Input** and **Video Output Boards** are located, as well as the communications ports on the **Frame CPU Board**. The rear of the MD (**Figure 2.10**), QMD (**Figure 2.11**), and MD-X, and Octane/QMD-X (**Figure 2.12**) frames are shown below.

---

**Figure 2.9** Vision Touchscreen Display

**Figure 2.10** Rear View of Frame (MD Shown)
Frame Front

The front of the frame is where the Squeeze & Tease Carrier Boards, Video Processor Boards, and, in the Octane/QMD-X, and MD-X frames, the Crosspoint Board are located. The number and position of the Squeeze & Tease Carrier Boards, and Video Processor Boards depends on the configuration and model of your frame.

The frame can be configured in a number of ways, depending on the number of MLEs, and Squeeze & Tease DVE channels you require per MLE-pair. These requirements determine where boards are installed in the frame. Refer to the section “Squeeze & Tease” on page Eng 2-27 for more information on where the Video Processor and Squeeze & Tease Carrier Boards are located in the frame. The front of the Octane/QMD-X, and MD-X frame (Figure 2.13), and the QMD, and MD frame (Figure 2.14) are shown below.
For More Information...

- on the front frame boards, refer to the section “Frame Boards” on page Eng 2-12.
- on installing and removing boards from the frame, refer to the section “Removing and Installing Frame Boards” on page Eng 4-18.
Control Panel Modules

The Vision control panel consists of a number of removable modules. These modules include all the interface buttons on the control panel, as well as the controllers inside the control panel.

Control Panel CPU Module

The Control Panel CPU Module houses the Single Board Computer (SBC) and the Panel Communications Hub (PCH). This module performs all the command and control functions between the different modules on the control panel and the frame.

Panel Module Controller Board

The Panel Module Controller (PMC) is installed on each control panel module and is used to communicate with the Control Panel CPU Module. Each PMC is connected in series with the other PMCs in the same row on the Module Control Link backbone and is identified by a link and node address. Refer to the section “Module Control Link Backbone” on page Eng 20-9 for more information on how the modules are connected on the Module Control Link backbone.

Keyers Module

The Keyers Modules consists of the Effects Keyer Board that supports the buttons and mnemonic displays on the module, and a PMC that provides the communications with the Control Panel CPU Module.

The Keyers Module comes in a 2-Keyer, 4-Keyer, and 8-Keyer configuration, and allow you to perform all the Key type, Key modifier, and Key transitions for the assigned MLE. The 8-Keyer configuration is only available with the MultiDSK™ option.

Global Memory Module

The Global Memory Module consists of the Global Memory Board that supports the buttons, mnemonic displays, and module display on the module, and a PMC that provides the communications with the Control Panel CPU Module.

The Global Memory Module allows you to store and recall memories to all MLEs at once, or to specific MLEs. Only the Program/Preset MLE can support a Global Memory Module.

Effects Memory Module

The Effects Memory Module consists of the Effects Memory Board that supports the buttons, mnemonic displays, and module display on the module, and a PMC that provides the communications with the Control Panel CPU Module.

Note — The Vision 1 control panel does not support the Effects Memory Module. Instead, it uses a single Global Memory Module.

The Effects Memory Module allows you to store and recall memories to individual MLEs. The Program/Preset MLE does not support an Effects Memory Module.
Transition Module

The Transition Module consists of the Transition Board that supports the buttons, mnemonic displays, module display, and fader on the module, and a PMC that provides the communications with the Control Panel CPU Module.

The Transition Module allows you to set and perform all key and background transitions on the assigned MLE. This includes the type of transition, as well as whether the transition is a cut, auto-transition, or a manual transition using the fader.

Positioner Module

The Positioner Module consists of the Positioner Board that supports the buttons and positioner on the module. The Positioner Module connects to the Preview Bus Module to communicate with the Control Panel CPU Module.

The Positioner Module allows you to use the positioner to directly control external devices, such as robotic cameras, or quickly alter menu values by moving the positioner in the appropriate axis. The positioner can follow the menu system, or be locked to a specific external device, such as a robotic camera.

Preview Bus Module

The Preview Bus, Preview Overlay, and Fade To Black Modules are all supported by the Preview Bus Board. The Preview Bus Module supports the buttons, module display and USB port on the modules, as follows:

- **Preview Bus Module** — The Preview Bus Module allows you to assign video feeds directly to your preview monitor. These video feeds include the background and preview of each MLE, as well as the main program output.

- **Preview Overlay Module** — The Preview Overlay Module allows you to turn on and off specific elements of the preview overlay. The menu systems follows the activation of preview overlay elements, allowing you to quickly adjust each one.

- **Fade to Black Module** — The Fade to Black Module allows you to cut or fade the output of the switcher to black. A USB port is also located on this module to allow you to connect a USB device, or a USB flash drive, for storing and recalling setups.

Power Distribution Board

The Power Distribution Board routes power between the control panel power supplies and the individual modules on the control panel, as well as pass power supply and cooling fan status signals to the Control Panel CPU Module.
Frame Boards

The frame uses a number of removable boards and cards to operate. This allows the quick replacement of a board in the frame without having to power down or disassemble the frame.

Frame CPU Board

(4800AR-002)

The Frame CPU Board resides in Slot A at the rear of the frame, and is connected to the midplane. It contains the Hard Drive, the system memory, and the main system microprocessor, and is responsible for the high-level control functions and all Ethernet and remote serial communication for the frame and the Ethernet connection between the frame and control panel. The Frame CPU Board is also where the Global-Store is located.

Video Input Board, 16 Input

(4800AR-060, 4800AR-061)

The Video Input Board comes in four configurations, two with an analog reference loop (4800AR-060A, 4800AR-061A), and two without (4800AR-060B, 4800AR-061B). All versions have 16 multi-definition serial digital inputs, but the two with reference have 2 additional BNC for the reference connections.

Video Input Board, with Crosspoint

(4400AR-062, 4400AR-061)

Both the Video Input Boards with Crosspoint (4400AR-062, 4400AR-061), in addition to the 16 multi-definition serial digital inputs and reference loop, have a 72×72 crosspoint.

The Octane/QMD-X, and MD-X frames do not support the Video Input Board with Crosspoint, using the Crosspoint Board instead.

Video Input Board, 10 Input

(4800AR-060, 4800AR-061)

Both the Video Input Boards with 10 Inputs (4800AR-060C, 4800AR-061C) come with 10 multi-definition serial digital inputs instead of 16, and no reference loop.

Video Output Board

(4800AR-064, 4800AR-065, 4800AR-066, 4800AR-067)

Each 4800AR-064, 4800AR-066, and 4800AR-067 board contains 16 fully configurable multi-definition video outputs that can be used as Aux Buses, MLE Program, MLE Preview, MLE Clean Feed, Preview Overlay, AuxKeys™, or MultiDSK™.

The 4800AR-065 boards contain 16 SDI only video outputs that can be used as MLE Program, MLE Preview, MLE Clean Feed, or Preview Overlay.

Only BNCs E9 to E16 are available on a Video Output Board installed in Slot E of the QMD frame.
Video Processor Board

(4800AR-040, 4800AR-041, 4800AR-043)

The Video Processor Board (4800AR-040 and 4800AR-041 only) performs all of the basic video effects in the switcher. Functions such as the interface to the Squeeze & Tease MD Boards, Chroma keying, patterns and wipes, and transitions are all generated on this board.

The Video Processor Board (4800AR-043 only) performs all of the video effects in the switcher, including 2D DVE effects. Functions such as Chroma keying, patterns and wipes, and transitions are all generated on this board.

How the Video Processor Boards are installed in the frame depends on the type of frame, and how the frame is configured for the number of MLEs. Refer to the section “Video Processor” on page Eng 2-24 for more information on the Video Processor Boards in the frame.

The Video Processor Board (4800AR-040 and 4800AR-041 only) provides 2 slots for the optional XFX Extra Effect Cards. The Video Processor Board (4800AR-043 only) has the XFX functionality built-in.

Midplane

The Midplane is a non-removable board that provides the interconnections between the switcher frame boards, the power supplies, and the fan assembly, as well as the routing through which all video signals, communication, and control commands pass. The board has no active components.

Crosspoint Board

(4800AR-020)

The Crosspoint Board is a 144×144 switch that can route HD as well as SD video signals. Only one Crosspoint Board can be installed in the front of the frame.

The QMD and MD frames do not support the Crosspoint Board, using the Video Input Board with Crosspoint instead.

Squeeze & Tease Carrier Board

(4800AR-047)

Note — The Squeeze & Tease Carrier Board is not compatible with the Video Processor Board (4800AR-043).

The Squeeze & Tease Carrier Board provides 4 slots for the Squeeze & Tease MD Cards and 2 slots for the Squeeze & Tease WARP MD Cards. The board also provides local control as well as video routing and power to these cards.

How the Squeeze & Tease Carrier Boards are installed in the frame depends on the type of frame, and how the frame is configured for the number of MLEs and Squeeze & Tease DVE channels that are required. Refer to the section “Squeeze & Tease” on page Eng 2-27 for more information on where the Squeeze & Tease Carrier Boards are located in the frame.

Power Supplies

Each frame requires at least one or two power supplies, depending on the type and size of frame, to provide enough power to operate. Additional Redundant power supplies can be installed to
allow all power supplies to operate in a load sharing mode. In this mode, if a power supply were to fail, the remaining power supplies can provide enough power to keep the frame operating. This allows for the hot swapping of a failed power supply without interruption to the operation of the switcher.

The minimum number of power supplies required by each frame is listed as follows:

- **Octane/QMD-X** — 2 × 12 Volt, 700 Watt, Power Supply
- **MD-X** — 3 × 12 Volt, 500 Watt, Power Supply
- **QMD** — 1 × 12 Volt, 700 Watt, Power Supply
- **MD** — 2 × 12 Volt, 500 Watt, Power Supply

**Note** — If a power supply fails, the **Power Fail** indicator on the **Touchscreen Display** lights, indicating that there is a problem with one of the power supplies.

**For More Information...**

- on fail indicators, refer to the section “**Fail Indicators Diagnosis**” on page Eng 17-10.
- on frame power supplies, refer to the section “**Frame Power Supply**” on page Eng 18-12.
Communication Ports

The Vision control panel has a number of communication ports on both the control panel and the frame that are used to communicate with external devices, such as Character Generators, Video Servers, and Robotic Cameras. There are also RJ-45 LAN ports on both the control panel and the frame that are used for frame/control panel communication, switcher upgrades, and external device control.

Control Panel Communication Ports

The majority of the communication ports for the switcher are located on the rear of the control panel. These ports (Figure 2.15) include the serial ports for external device control, external link ports for communication with Auxiliary Control Panels, the Touchscreen Display and other external modules, an Ethernet Port for communication with the frame, PS/2 ports, USB ports, and a DVI Video port.

![Communication Ports on the Rear of the Vision Control Panel](image)

1. **DVI Video Port**
   The single DVI-D port is used to connect to the Touchscreen Display to provide the video signal from the control panel to the display. If you do not have the Ross Touchscreen Display, a LCD monitor with a DVI-D connector is required.

2. **Mouse Port**
   This PS/2 port is used to connect a standard mouse to the switcher.

3. **Keyboard Port**
   This PS/2 port is used to connect a standard keyboard to the switcher.

4. **Ethernet Port**
   The single 8-pin RJ-45 port is used to connect to the facility network on the same subnet as the frame. This connection provides all the communication between the control panel and the frame.

5. **USB Ports**
   These 2 USB ports are used to connect to supported USB devices.

6. **External Panel Link Ports**
   The 4 External Panel Link ports are used to connect with the Auxiliary Control Panels, legacy Synergy Remote Aux Panels, and to the Touchscreen Display.
7. Remote Ports

These **8 DB9** serial ports are used to connect to most of the external devices supported by the Vision switcher, with the exception of Editors. Remote ports support both **RS-232** and **RS-422** communication, in both a Straight Through and Null Modem configuration.

Frame Communication Ports

The majority of the communications ports on the frame (Figure 2.16) are used for controlling peripheral equipment such as Editors. In addition to the Peripheral ports, there are LAN ports for connecting to an external computer for upgrades and for external device control, a GP I/O port for GPI and GPO triggers, a Panel port for communication with a legacy control panel, USB ports, and a Time Code Input port.

![Communication Ports on the Frame CPU Board](image)

Figure 2.16 Communication Ports on the Frame CPU Board

1. **LAN Ports**

   These **2 RJ-45** ports support standard **10/100 Base TX Ethernet** communication for connection to the Vision control panel network hub, or switch for external device control, upgrades, image transfer, and the external backup of switcher setups. Only the **LAN 1** port should be used to connect to the Vision control panels.

2. **GP I/O Port**

   The single **DB25 GP I/O** port is used to connect to a GP I/O distribution system, providing **10** pins for **GPI Inputs** and **10** pins for **GPI Outputs** to the switcher. A single pin is provided for ground. These GPIs can be used to trigger transitions, custom controls, or recall a memory registers on the switcher.

   There are **4** additional pins on the port that are used as a power-fail relay. These normally closed relays open in the event of a power failure, or other switcher failure that may prevent reliable program output.

3. **Peripheral Ports**

   These **4 DB9** serial ports are used to connect to external equipment such as Editors. Peripheral ports support both **RS-232** and **RS-422** communication in a Straight Through or Null configuration.

4. **Panel Port**

   The single **8-pin RJ-45 Panel** port is used to connect to the legacy Synergy control panel and provides all the communication between the control panel and frame.

5. **USB Ports**

   These **2 USB** ports are used to connect to supported USB devices.

6. **Time Code Input**

   The single **Time Code Input** port is used to connect to an external time reference for synchronization.
For More Information...

- on connecting external equipment to a remote or peripheral port, refer to the section “Communications Overview” on page Eng 9-2.
- on connecting to the frame, refer to the section “Frame Installation” on page Eng 3-5.
- on connecting to the control panel, refer to the section “Control Panel Installation” on page Eng 3-7.
- on setting up communications between the control panel and frame, refer to the section “Frame to Control Panel Cabling” on page Eng 3-11.
Tally Ports

The **DB25 Tally** ports (Figure 2.17) on the Vision control panels provide standard parallel contact closure tallies for the switcher. Tallies can be assigned to any video input signal using the menu system.

The Vision control panel provides **36** tallies as standard, with **18** tallies per port (Figure 2.18). Depending on the Vision control panel you have, extended tallies can be installed in groups of **36**.

The maximum parallel tallies supported by each control panel is as follows:

- **Vision 1** — **36** maximum
- **Vision 1M** — **36**, or **72**
- **Vision 2** — **36** maximum
- **Vision 2M** — **36**, or **72**
- **Vision 3M** — **36**, **72**, or **108**
- **Vision 2X** — **36**, **72**, or **108**
- **Vision 3** — **36**, **72**, or **108**
- **Vision 4** — **36**, **72**, **108**, or **144**

*For More Information...*

- on assigning tallies to video inputs, refer to the section “Assigning Tallies to Input Sources” on page Eng 7-22.
- on the pinouts and voltages for the Tally ports, refer to the section “Control Panel Pinouts” on page Eng 20-21.
**GPI I/O Port**

The single **DB25 General Purpose Interface (GPI)** port on the **CPU Board** of the frame (Figure 2.19) is used for GPI Input and GPI Output signals.

![GPI I/O Port](image)

**Figure 2.19 The GPI I/O Port on the CPU Board of the Frame**

There are **10 GPI Inputs** that can be used to trigger transitions, custom controls, or memory recalls on the switcher in different areas, or MLEs. Setup is done through the menu system, allowing you to associate a GPI Input with a Function, and specify which Area, or MLE, you want that function to be performed in. If you select custom control as the function, you must specify the custom control you want to execute, rather than the area. GPI Inputs can also be used to activate a tally.

There are **10 GPI Outputs** that can be used to trigger events on external equipment. Like the GPI Inputs, setup is done through the menu system, allowing you to configure the trigger type and level for each GPI. Output GPIs are typically triggered using custom controls.

**For More Information...**
- on setting up GPI Inputs, refer to the section “**Standard GPI Setup**” on page Eng 12-10.
- on setting up GPI Outputs, refer to the section “**Programming Special Functions**” on page Eng 10-15.
- on the pinouts and voltages of the GP I/O port, refer to the section “**Frame Pinouts**” on page Eng 20-17.
Video Routing

Video routing is handled by various boards installed in the frame. The boards used to route video through the frame depends on the type of frame you have, as follows:

- **Octane/QMD-X/MD-X** — The boards primarily responsible for video routing are the Crosspoint Board, the Video Processor Board, and the Squeeze & Tease MD Carrier Board.

- **QMD/MD** — The boards primarily responsible for video routing are the Video Input Board, the Video Processor Board, and the Squeeze & Tease MD Carrier Board.

Each of these boards in the frame work together with the Midplane and the Video Output Board to take an input video signal, manipulate it, and route it to the desired output.

Crosspoint Matrix

The crosspoint matrix allows you to route a video signal from any Input BNC to any, or all, Output BNC. Video signals are received by the Input BNC and sent to the Crosspoint. Depending on how the switcher is currently operating, the Crosspoint will send the video signals to the Video Processor and Squeeze & Tease Carrier for any video manipulation that is required. The manipulated video signals are then sent back to the Crosspoint to be routed to the desired Video Output, and finally to the Output BNC.

Video flow through the crosspoint to the other boards in the frame depends on the frame you are using and how it is configured.

**Note** — Video manipulation can only occur on video signals that are in the same video format as the switcher is currently operating in. Non-native video formats must be converted before they can be manipulated. Refer to the section “Setting Up a Conversion Loop” on page Eng 16-2 for more information on up/down converters.

For More Information...

- on the different board configurations of the frame, refer to the section “Squeeze & Tease” on page Eng 2-27.
Octane/QMD-X Crosspoint Matrix

**Figure 2.20 Video Flow Through the Crosspoint Board**

**Note** — The Squeeze & Tease Carrier Board is not compatible with the Video Processor Board (4800AR-043).

The **Crosspoint Board** has the following inputs:

- **96** video feeds from the **Input BNCs** on the **Video Input Boards** in **Slots C through H**.
- **8** video feeds from the **Video Processor Board** in **Slot 2** (depending on configuration).
- **8** video feeds from the **Video Processor Board** in **Slot 4** (depending on configuration).
- **8** video feeds from the **Video Processor Board** in **Slot 7** (depending on configuration).
- **8** video feeds from the **Video Processor Board** in **Slot 9** (depending on configuration).
- **4** video feeds from the **Global-Store** on the **CPU Board** in **Slot A**.

The **Crosspoint Board** has the following outputs:

- **48** video feeds to the **Output BNCs** on the **Video Output Boards** in **Slots I through K**.
- **16** video feeds to the **Video Processor Board** in **Slot 2** (depending on configuration).
- **16** video feeds to the **Video Processor Board** in **Slot 4** (depending on configuration).
- **16** video feeds to the **Video Processor Board** in **Slot 7** (depending on configuration).
- **16** video feeds to the **Video Processor Board** in **Slot 9** (depending on configuration).
- **4** video feeds to the **Global-Store** on the **CPU Board** in **Slot A**.
The **Crosspoint Board** has the following inputs:

- **96** video feeds from the **Input BNCs** on the **Video Input Boards** in **Slots C through H**.
- **8** video feeds from the **Video Processor Board** in **Slot 4**.
- **8** video feeds from the **Video Processor Board** in **Slot 9**.
- **4** video feeds from the **Global-Store** on the **CPU Board** in **Slot A**.

The **Crosspoint Board** has the following outputs:

- **48** video feeds to the **Output BNCs** on the **Video Output Boards** in **Slots I through K**.
- **16** video feeds to the **Video Processor Board** in **Slot 4**.
- **16** video feeds to the **Video Processor Board** in **Slot 9**.
- **4** video feeds to the **Global-Store** on the **CPU Board** in **Slot A**.
Note — The Squeeze & Tease Carrier Board is not compatible with the Video Processor Board (4800AR-043).

The Crosspoint Board has the following inputs:

- 48 video feeds from the Input BNCs on the Video Input Boards in Slots C through E.
- 16 video feeds from the Video Processor Boards in Slots 1 and 3.
- 4 video feeds from the Global-Store on the CPU Board in Slot A.

The Crosspoint Board has the following outputs:

- 24 video feeds to the Output BNCs on the Video Output Boards in Slots B and E.
- 16 video feeds to the Video Processor Boards in Slots 1 and 3.
- 4 video feeds to the Global-Store on the CPU Board in Slot A.

Note — If a Video Output Board is installed in Slot E, a total of 32 Input BNCs and 24 Output BNCs will be available.

MD Crosspoint Matrix

The Crosspoint Board has the following inputs:
• 32 video feeds from the Input BNCs on the Video Input Boards in Slots C through D.
• 8 video feeds from the Video Processor Board in Slot 1.
• 4 video feeds from the Global-Store on the CPU Board in Slot A.

The Crosspoint Board has the following outputs:
• 16 video feeds to the Output BNCs on the Video Output Boards in Slot B.
• 16 video feeds to the Video Processor Board in Slot 1.
• 4 video feeds to the Global-Store on the CPU Board in Slot A.

Video Processor

The Video Processor Board (4800AR-040 and 4800AR-041) performs most of the non-Squeeze & Tease video manipulation for the switcher. Background, Key, Alpha, DVE and Utility signals are all sent to the Video Processor and returned as Program, Preview, Clean, and DVE video and alpha.

The Video Processor Board (4800AR-043) performs all of the video manipulation, including 2D DVE effects, for the switcher. Background, Key, Alpha, DVE and Utility signals are all sent to the Video Processor and returned as Program, Preview, Clean, and DVE video and alpha.

Note — The Squeeze & Tease Carrier Board is not compatible with the Video Processor Board (4800AR-043).

The number and placement of the Video Processor Boards in the frame depends on the frame you have and how it is configured.

Octane/QMD/X Video Processor

The Octane/QMD-X, and QMD frames can support 2 MLEs with each Video Processor Board. The placement of the Video Processor Boards depends on the number of MLEs, and Squeeze & Tease DVE channels you require per MLE-pair. These requirements will determine where boards are installed in the frame. Refer to the section “Squeeze & Tease” on page Eng 2-27 for more information on where the Video Processor and Squeeze & Tease Carrier Boards are located in the frame.

The inputs and outputs for the Video Processor Board are the same, except for the MLEs they are supporting (Figure 2.24).
The Video Processor Board for MLE 1 and MLE 2 has the following inputs:

- 2 MLE BKGD video feeds (one for MLE 1 and one for MLE 2).
- 2 MLE PST video feeds (one for MLE 1 and one for MLE 2).
- 2 Key 1 Video video feeds (one for MLE 1 and one for MLE 2).
- 2 Key 1 Alpha video feeds (one for MLE 1 and one for MLE 2).
- 2 Key 2 Video video feeds (one for MLE 1 and one for MLE 2).
- 2 Key 2 Alpha video feeds (one for MLE 1 and one for MLE 2).
- 2 Key 3 Video video feeds (one for MLE 1 and one for MLE 2).
- 2 Key 3 Alpha video feeds (one for MLE 1 and one for MLE 2).
- 2 Key 4 Video video feeds (one for MLE 1 and one for MLE 2).
- 2 Key 4 Alpha video feeds (one for MLE 1 and one for MLE 2).

The Video Processor Board for MLE 1 and MLE 2 has the following outputs:

- 2 PGM video feeds (one for MLE 1 and one for MLE 2).
- 2 PV video feeds (one for MLE 1 and one for MLE 2).
- 2 Clean Feed video feeds (one for MLE 1 and one for MLE 2).
- 2 Utility Bus Out video feeds (one for MLE 1 and one for MLE 2).
MD/X Video Processor

The MD-X and MD frames can support 2 MLEs with each Video Processor Board. The Video Processor Board performs most of the non-Squeeze & Tease video manipulation for the switcher. Background, Key, Alpha, DVE and Utility signals are all sent to the Video Processor and returned as Program, Preview, Clean, and Aux Loopthrough.

The inputs and outputs for the Video Processor Board are the same, except for the MLEs they are supporting (Figure 2.25).

![Video Flow through the Video Processor](image)

Figure 2.25 Video Flow through the Video Processor

The Video Processor Board for MLE 1 and MLE 2 has the following inputs:

- 2 MLE BKGD video feeds (one for MLE 1 and one for MLE 2).
- 2 MLE PST video feeds (one for MLE 1 and one for MLE 2).
- 2 Key 1 Video video feeds (one for MLE 1 and one for MLE 2).
- 2 Key 1 Alpha video feeds (one for MLE 1 and one for MLE 2).
- 2 Key 2 Video video feeds (one for MLE 1 and one for MLE 2).
- 2 Key 2 Alpha video feeds (one for MLE 1 and one for MLE 2).
- 2 Aux Loopthrough video feeds.
- 2 Utility video feeds.

The Video Processor Board for MLE 1 and MLE 2 has the following outputs:

- 2 PGM video feeds (one for MLE 1 and one for MLE 2).
- 2 PV video feeds (one for MLE 1 and one for MLE 2).
- 2 Clean Feed video feeds (one for MLE 1 and one for MLE 2).
- 2 Aux Loopthrough video feed.
Squeeze & Tease

The Squeeze & Tease Carrier Boards support the Squeeze & Tease MD and WARP cards that perform all of the Squeeze & Tease video manipulation for the switcher. When Squeeze & Tease resources are required by the switcher, the desired video signals are sent from the Video Processor Board to the Squeeze & Tease Carrier Board. The video signals are then sent back to the Video Processor Board.

Note — The Squeeze & Tease Carrier Board is not compatible with the Video Processor Board (4800AR-043).

The number and placement of the Squeeze & Tease Carrier Boards in the frame depends on the frame you have and how it is configured.

Octane/QMD-X Squeeze & Tease

The Video Processor Boards and Squeeze & Tease Carrier Boards can be installed in the Octane/QMD-X frame in a number of ways, depending on the number of MLEs, and Squeeze & Tease resources you require. These configurations are as follows:

- **Slots 6 - 9** — The Squeeze & Tease Carrier Boards in Slot 6 and Slot 8 of the QMD-X frame support the Video Processor Boards in Slot 7 and Slot 9, respectively. In this configuration, the 8 Squeeze & Tease DVE channel resources and 2 Squeeze & Tease WARP generators provided by each Squeeze & Tease Carrier Board in Slot 6 are dedicated to the Video Processor Board in Slot 7. Similarly, the 8 Squeeze & Tease DVE channel resources and 2 Squeeze & Tease WARP generators provided by each Squeeze & Tease Carrier Board in Slot 8 are dedicated to the Video Processor Board in Slot 9 (Figure 2.27).

- **Slots 2 - 4** — The Squeeze & Tease Carrier Board in Slot 3 of the QMD frame supports the Video Processor Boards in Slot 2 and Slot 4. In this configuration, the 8 Squeeze & Tease DVE channel resources, and 2 Squeeze & Tease WARP generators, provided by the Squeeze & Tease Carrier Board are split across the two Video Processor Boards. This provides a total of 4 Squeeze & Tease DVE channel resources and 1 Squeeze & Tease WARP generator to MLE 5 and MLE 6, supported by the Video Processor Board in Slot 4, and 4 Squeeze & Tease DVE channel resources and 1 Squeeze & Tease WARP generator to MLE 7 and MLE 8, supported by the Video Processor Board in Slot 2 (Figure 2.26).

MD-X Squeeze & Tease

The Squeeze & Tease Carrier Board in Slot 3 supports MLE 1 and MLE 2 (Figure 2.27), and the Squeeze & Tease Carrier Board in Slot 8 supports MLE 3 and MLE 4. Both have the same inputs and outputs, except for the MLEs they are supporting.

Note — The inputs and outputs for the Squeeze & Tease Carrier in Slot 8 are the same as the inputs for the Squeeze & Tease Carrier in Slot 3, except that they are for MLE 3 and MLE 4, not MLE 1 and MLE 2.
QMD Squeeze & Tease

The Squeeze & Tease Carrier Board in Slot 2 of the QMD frame supports the Video Processor Boards in Slot 1 and Slot 3. In this configuration, the 8 Squeeze & Tease DVE channel resources, and 2 Squeeze & Tease WARP generators, provided by the Squeeze & Tease Carrier Board are split across the two Video Processor Boards. This provides a total of 4 Squeeze & Tease DVE channel resources and 1 Squeeze & Tease WARP generator to MLE 1 and MLE 2, supported by the Video Processor Board in Slot 1, and 4 Squeeze & Tease DVE channel resources and 1 Squeeze & Tease WARP generator to MLE 3 and MLE 4, supported by the Video Processor Board in Slot 3 (Figure 2.26).

MD Squeeze & Tease

The MD frame has a single Squeeze & Tease Carrier Board (Figure 2.27) that supports the Squeeze & Tease MD and WARP cards that perform all of the Squeeze & Tease video manipulation for the switcher. When Squeeze & Tease resources are required by the switcher, the desired video signals are sent from the Video Processor Board, to the Squeeze & Tease Carrier Board. The video signals are then sent back to the Video Processor Board.

Figure 2.26 Video flow to and from a shared Squeeze & Tease Carrier
The **Squeeze & Tease Carrier Board** in both the shared and dedicated configuration, has the following inputs:

- 8 video feeds to the **Squeeze & Tease MD Cards** (2 per card).
- 4 video feeds to the **Squeeze & Tease WARP Cards** (2 per card).

The **Squeeze & Tease Carrier Board** in both the shared and dedicated configuration, has the following outputs:

- 16 video feeds from the **Squeeze & Tease MD Cards** (4 per card).
- 4 video feeds from the **Squeeze & Tease WARP Cards** (2 per card).

**XFX Extra Effects**

The **XFX Extra Effects Card** performs different functions, depending on the options you purchase. Current options include a Dual Border Generator and MLE-Store.

The Dual Border Generator option provides visually dynamic border, shadow, and outline effects to both linear MLE keyers, with either hard or soft edges. The option can also enhance Self Keys, Chroma Keys, and Preset Pattern Keys.

The MLE-Store provides 4 channels of still images per MLE, or 2 video channels with 2 alpha channels. Each MLE can have separate images loaded and images with embedded alpha channels are supported by dedicating one of the MLE-Store channels to the alpha channel.

The **Video Processor Board (4800AR-040 and 4800AR-041 only)** supports up to 2 XFX Cards (**Figure 2.28**). When XFX resources are required by the switcher, the desired video signals are sent from the **Video Processor Board**, to the **XFX Cards** on the **Video Processor Board**. The video signals are then sent back to the **Video Processor Board**. The **Video Processor Board (4800AR-043)** has the XFX functionality built-in.
The XFX Card has the following inputs:

- 4 video feeds.

The XFX Card has the following outputs:

- 4 MLE-Store Channels, or 2 MLE-Store Channels with 2 Alpha Channels.
- 4 video feeds from the Dual Border Generator, including 2 Video Channels and 2 Alpha Channels.
Video Formats

The Vision switcher can operate in a number of different video formats, at different frequencies in either interlaced or progressive scan mode. When you switch between these formats, various displays and settings automatically change to show the new information. To better understand what is being displayed, you must first understand what the information for the different video formats means.

The video formats that are displayed on the Vision switcher (Figure 2.29) provide three pieces of information about the video format. This information is the number of horizontal Scan Lines, whether the scan lines are Interlaced (i) or Progressive (p), and the Frequency that the scan lines are drawn at.

Figure 2.29 Video Formats Provide Three Pieces of Information

Horizontal Scan Lines

The number of horizontal scan lines is related to the pixel resolution of the image on screen. For example, if you have a 720p 59.94 Hz video signal, the 720 is the number of vertical scan lines. A video signal with 720 scan lines usually corresponds to a 1280×720 (H×V) pixel image. This means that the image is comprised of 1280 columns of pixels and 720 rows of pixels (Figure 2.30). The reason the vertical resolution, the 720, is used to denote the video format is because of how it is drawn on a standard television. With Cathode-Ray Tube (CRT) television monitors, the image is created, or drawn, one pixel at a time, in rows, from the left side of the screen to the right, to create one scan line.

Figure 2.30 A 720 video signal has 720 scan lines by 1280 vertical pixels

Since each scan line starts from a vertical pixel, there are 720 rows of pixels, or scan lines, being drawn horizontally. The same is true of a video signal with 1080 vertical scan lines, which corresponds to a 1920×1080 pixel image.

Interlaced vs. Progressive

In the previous section we learned that a video signal is made up of a number of horizontal scan lines that are drawn from left to right on the screen. Although these scan lines are always drawn from left to right, they can be drawn in either an Interlaced or Progressive pattern.
**Interlaced**

An Interlaced video format starts at the top of the screen and draws all the odd number scan lines and then all the even number scan lines in sequence. This results in half the image being drawn in one pass and the other half of the image being drawn in the second. These two passes are called **Fields**, where the first pass is called **Field 1** and the second pass is called **Field 2**. When both **Field 1** and **Field 2** have been drawn, resulting in a complete image, you have a single **Frame**.

![Field 1 and Field 2](image)

**Figure 2.31** *An Interlaced Video Format Draws Field 1 and Field 2 Separately, to Create a Frame*

Both **Field 1** and **Field 2** must be drawn to create **Frame 1**. If you are using field or frame numbers as a counter, you should remember that you must double the number if you are converting from frames to fields. For example, a 4 frame delay is equal to an 8 field delay.

**Progressive**

A Progressive scan video format draws each scan line in sequence, starting from the top of the screen and working to the bottom. Unlike Interlaced, with Progressive scan the entire image is drawn at one time, in a single pass (**Figure 2.32**). This means that there are no fields in a Progressive scan image.

![Progressive Frame 1](image)

**Figure 2.32** *A Progressive scan video format draws each line in sequence*

Because there are no fields in a Progressive scan video signal, you cannot use it as a reference signal for an Interlaced video signal. Because the Interlaced video format requires information about when each field is being drawn, you must use a Progressive scan video format as reference for a Progressive scan video signal.
Progressive Segmented Frame

A Progressive Segmented Frame video format is similar to a Progressive Scan video format, in that both draw each scan line in sequence from the top of the screen to the bottom. Unlike the Progressive Scan video format, the Progressive Segmented Frame video format transmits the video signal as if it were interlaced. The odd scan lines are transmitted, followed by the even ones. The even field are delayed one field on the transmitting end, and the odd fields are delayed one field on the receiving end. This allows the transmission of Progressive video signals via equipment that was designed to handle Interlaced video signals only.

Because there are no true fields in a Progressive Segmented Frame video format, you cannot use it as a reference signal for an Interlaced video format.

Frequency

In the previous sections we learned that a video image is comprised of a number of horizontal scan lines that are drawn in either a Progressive or Interlaced format. The length of time it takes to draw the scan lines from the top of the screen to the bottom in a single pass is called the **Frequency**, and is measured in Hertz (Hz). With a Progressive scan video format, the frequency is the time it takes to draw the entire image. With an Interlaced video format, the frequency is the time it takes to draw 1 field, or half, of the image (Figure 2.33).

![Figure 2.33 Interlaced and Progressive video formats with the same frequency](image)

For example, an interlaced format of **1080i 50 Hz** draws **50** fields per second. Compare this to a Progressive scan format of **720p 50 Hz** which draws **50** frames per second. Notice that the Interlaced format is actually only drawing **25** frames (**Field 1** plus **Field 2**) per second, where the Progressive scan format is drawing the full **50** frames per second.

Using Frame and Field Information

**Frame** and **Field** rates become very important when you are setting up custom control pauses, transition rates or any other system that counts a period of time in frame or fields on the switcher. Remember from the previous section that in a Progressive scan format, running at **50 Hz**, the switcher draws **50** frames per second. In an Interlaced format, also running at **50 Hz**, the switcher draws **25** frames per second.

The Vision switcher uses frames to measure transition rates and custom control pauses. The amount of time that this represents depends on the frequency and format you are operating the switcher in. For example, if you are operating the switcher in **1080i 59.94 Hz**, the default MLE transition rate is set at **15** frames (Figure 2.34). Since the frequency for an Interlaced format is shown in fields, you must divide this number by **2** in order to get the number of frames per second, **30**. By comparing the transition rate (**15** frames) and the video format frequency (**30** frame per second) you can calculate that the transition rate is **½** a second.

![Figure 2.34 Transition Rate Information in the Global Memory System Module](image)
If you were operating the switcher in 720p 59.94 Hz, the default MLE rate is set at 30 frames. Since the frequency for a Progressive scan format is shown in frames, no conversion is required. By comparing the transition rate (30 frames) and the video format frame frequency (60 frames per second) you can calculate that the transition rate is ½ a second.

**Important** — *When you switch reference formats, you must perform a soft reset of the switcher in order to load the default rates for the format you have set.*

**For More Information...**

- on setting up the switcher reference, refer to the section “Reference Connection and Setup” on page Eng 4-11.
- on resetting the switcher, refer to the section “Resetting the Switcher” on page Eng 4-24.
CPU Structure

This section describes the CPU structure of the Vision switcher, in terms of which areas are controlled by which specific microprocessors. Effectively, the CPU structure functions as a master/slave multi-processor system, where the master processor controls high level functionality and delegates other tasks to slave processors.

Processor distribution and functionality are as follows:

- One PowerPC CPU on the Frame CPU Board is responsible for performing high level functions, and issuing commands to the remaining microprocessors. This processor manages all serial channels to and from the frame, manages communications with the control panel, and manages communications with all other peripheral devices connected to the frame.

- The Frame Processor also controls non-MLE functions, including all Aux Bus functions and all crosspoint switching on the Crosspoint Module. It does not control the Preview Overlay Module, but it does issue commands to that module, in terms of what text and graphics to display.

- One PowerPC CPU on the Video Processor Board processes high-level information from the Frame CPU Board that pertains to the current state and specific commands issued on each MLE. This high level information includes which functions are enabled or disabled, and what configurations have been set up by the user on the control panel. The Video Processor Board translates that information, and sets the required bits in the hardware to complete the command request. Some examples of this high level information are as follows:
  - If you press WIPE in an MLE and select the circle wipe, that information goes to the Frame CPU — which in turn tells the selected Video Processor that a circle wipe has been requested. The Video Processor then draws the proper tables required to make the image.
  - If you pull the Fader from Program to Preset, the Frame Processor receives that information and analyzes how it affects the high level structures within the switcher, such as which buses are moving, what type of effect has been requested (Dissolve, Wipe, etc.). The Frame Processor then passes the current state of a particular field to the MLE Processor, which then writes the specific values of the effect to the video processing circuitry.
  - If you press the AUTO TRANS button, that command goes from the Control Panel to the Frame Processor, which in turn keeps track of which state the transition is in. Commands are then issued to the MLE Processor to perform the transition at (for example) 4% in one field, 8% in the next field — until complete. The MLE Processor in turn does not process the video itself, but rather issues commands to the hardware on the MLE Board to set the mixer to the requested ratio and manipulate the pixels accordingly.

- One PowerPC CPU on the Video Output Board is used for local control of this card. It also provides internal ethernet access, program store, and still store images.

- One PowerPC CPU on the Squeeze & Tease MD Carrier Board governs the on-board communication and control, as well as the communication with the midplane and the daughter cards mounted on the board.

- The Squeeze & Tease MD Carrier board also contains a single CPU, which performs all the mathematical calculations required for the DVE effects.

All boards in the frame also contain a micro-controller to manage upgrades, system booting, and other housekeeping functions.
A Note About CPU Architecture

Virtually all of the lookup tables and all of the bits that are used to configure the hardware and map the crosspoints are set every field. The switcher is in effect performing a complete memory recall operation every single field, always guaranteeing that the control panel is set properly. In terms of the architecture, there is no difference between a requested memory recall operation and the way that the switcher updates the panel normally — every field.

In addition to increasing the reliability of the switcher tremendously, this functionality also allows you to return to the exact state of the panel, should a power failure occur.
Board Labelling

Every circuit board in the Vision switcher that was manufactured by Ross Video is labelled to identify the name of the board, the board number and the revision, or issue, number. This identification is usually found on the outside edge of the board, next to the Ross Video logo (Figure 2.35).

The following information is present on the circuit board:

- **Ross Logo** — The Ross logo identifies the board as having been designed and manufactured by Ross Video.
- **Board Name** — The board name identifies the function of the board, allowing you to quickly and easily identify the different boards in the switcher.
- **Board Number** — The board number is tied to the board name and the product line that the board is from. This number identifies the board, and the function it performs.
- **Revision** — The revision number identifies the issue of the board.

**Note** — Where a white square is present in the label string, letters may be written within the square to indicate a minor variation on the board itself.
Physical Installation and Cabling

In This Chapter

This chapter provides information on unpacking, installing, and basic cabling for your Vision switcher.

The following topics are discussed in this chapter:

- Unpacking Your Switcher
- Opening and Closing the Frame Door
- Frame Installation
- Control Panel Installation
- Frame to Control Panel Cabling
- Video Input Cabling
- Video Output Cabling
- Button Inserts
- Power Supply Connections
- Power Fail Indicators

**Warning** Hazardous Voltage — This apparatus, when equipped with multiple power supplies, can generate high leakage currents. To reduce the risk of electric shock, ensure that each individual supply cord is connected to its own separate branch circuit with an earth connection.

**Caution** — The frame door must be installed on the frame for proper cooling. Leaving the frame door off may cause the frame to overheat, resulting in unexpected behavior or damage to equipment.

**Important** — All cables must be run in accordance with good engineering practices. Ensure that there is sufficient room for the cable and that enough slack is left in the cable run to permit long, gentle bends. Always install cables so that they will not be subjected to physical abuse.
Unpacking Your Switcher

A Vision switcher is usually shipped in two, or more, boxes, depending on the options you purchased with your switcher. These boxes may vary, but usually contain the following:

- **Box 1** — This box contains the frame, with all the required boards installed.
- **Box 2** — This box contains the control panel, touchscreen display, cables, and manuals.

**Note** — The **Touchscreen Display** is an option with the **Vision 1** and **2** control panels. If you do not have the Touchscreen Display, an LCD computer monitor with a DVI-D connector is required.

Once the boxes are unpacked, check the contents against the packing list to ensure that all items are included. If any items are missing or damaged, contact your sales representative or Ross Video Limited immediately.

Static Discharge

**ESD Susceptibility** — Static discharge can cause serious damage to sensitive semiconductor devices. Avoid handling the switcher circuit boards in high static environments such as carpeted areas and when synthetic fiber clothing is worn. Touch the frame to dissipate static charge before removing boards from the frame and exercise proper grounding precautions when working on circuit boards.

Serial Numbers

Serial numbers have been implemented to allow Ross Video to properly track which options have been purchased by each customer. Switchers have serial numbers installed (in flash memory) at the factory.

**For More Information...**

- on serial numbers, refer to the section “Installing Serial Numbers” on page Eng 6-11.
Opening and Closing the Frame Door

If you are installing hardware options, or replacing a circuit board or power supply, you must remove and re-install the frame door.

**Caution** — The frame door must be installed on the frame for proper cooling. Leaving the frame door off may cause the frame to overheat, resulting in unexpected behavior or damage to equipment.

Octane/QMD/X Frame

The door on the Octane/QMD-X and QMD frames swings open, allowing for quick access to the boards and cards in the frame. The door can also be completely removed for greater access into the frame.

1. Gently pull the door latch out and rotate it to release the door. The Octane/QMD-X door has two latches.

   ![Frame Door Overview (QMD Shown)](image)

   **Figure 3.1** Frame Door Overview (QMD Shown)

2. Swing the door open, as shown (Figure 3.1).

   **Operating Tip** — To remove the door from the frame completely, open the door to its full extent. The door will be perpendicular to the front of the frame. Lift the door directly up to unhook it from the hinge pins and remove the door from the frame.
MD/X Frame

Opening and Removing the Frame Door

1. Gently pull the door latch out and up, releasing the door from the top of the frame (Figure 3.2). The door retainer prevents the door from falling.

![Figure 3.2 Frame Door Overview (MD Shown)](image)

2. With both hands, grasp the sides of the door, and gently lift it. Rotate the bottom towards you until the bottom edge clears the pivoting tongue on which it rests, and the door retainer is free of the frame top plate.

3. Move the door away from the frame, and place it on a clean, flat surface.

Installing and Closing the Frame Door

1. With both hands, grasp the sides of the frame door, and, ensuring that the door retainer is under the top of the frame, hook the grooved bottom edge over the pivoting tongue on the bottom front ledge of the frame (Figure 3.3).

![Figure 3.3 Frame Door Overview (MD Shown)](image)

2. When you are satisfied that the door is resting properly, firmly press the top of the door until the latch pops into place and is secure.
Frame Installation

This section gives an in-depth overview on how to install the frame into your facility. For information on the dimensions of your frame, refer to the section “Frame Dimensions” on page Eng 20-6.

The Vision switcher has an operating temperature range of 0 to 35 degrees Celsius.

Use the following guidelines when installing the frame into your equipment rack:

• Install the frame so as to ensure maximum stability, and adequate ventilation during operation.
• Ensure that both sides of the frame are clear, so that airflow through the frame is not restricted in any way.
• If possible, but not required, leave a 1RU space above the frame to facilitate installation and removal of the frame door.
• The frame should be installed in a dry, dust free, and easily accessible location.

To ensure maximum stability, the frame must be mounted to the rack using the 2 Support Brackets that are located at the rear of the frame. These brackets are included in your Installation Kit.

Installing the Frame

Notice — Failure to install both the Support Brackets, or Rack Mount Arms, as described will void the warranty.

1. Remove the front door from the frame. Refer to the section “Opening and Closing the Frame Door” on page Eng 3-3 for more information on removing and installing the frame door.

2. Using standard rack mounting bolts (not supplied) install the frame into the rack.

3. Install the Rack Mount Arms or Support Backets as follows:
   • If you have an Octane/QMD-X frame, refer to the instructions that came with your Rack Mount Kit.
   • If you have a QMD frame, use standard rack mounting bolts (not supplied) to attach the support brackets to the Rear Panel Mounting Flange (Figure 3.4). The support brackets are adjustable to accommodate different rack sizes.

4. Inspect all the boards in the frame to ensure that they are properly seated.

Figure 3.4 Support Brackets on the Frame (QMD Shown)
5. Inspect all power supplies installed in the frame to ensure that they are properly seated and that the power switch is in the OFF position.

6. If you need to install or remove any of the boards or cards in the frame, refer to the section “Removing and Installing Frame Boards” on page Eng 4-18.

7. Re-install the frame door.

**Operating Tip** — Even though you will be accessing the frame later in the installation process, it is a good practice to put the frame door on when you are not working in the frame. This protects the boards and circuits in the frame from accidental damage, and dust or debris.

**For More Information...**

- on frame specifications, refer to the section “Standard Components” on page Eng 20-2.
- on working with the frame power supplies, refer to the section “Frame Power Supply” on page Eng 18-12.
Control Panel Installation

This section gives an in-depth overview on how to install the Vision control panel into your facility. This includes installing the control panel into, or on, the desk, installing the Touchscreen display into a mount, and installing any Auxiliary Control Panels.

Control Panel Installation

The Vision control panel can be installed in one of 3 ways; on top of the desk, partially inserted into the desk, or flush with the desk. Refer to the section “Control Panel Dimensions” on page Eng 20-6 for the specific dimensions of each Vision control panel.

Desk Top Control Panel Installation

The Vision control panel can be installed sitting on a desk (Figure 3.5). In this installation, ensure that nothing is blocking the cooling vents at the front and rear of the control panel.

![Figure 3.5 Profile of Control Panel Sitting on Desk](image)

In-Desk Control Panel Installation

To install the Vision control panel in the desk, you will have to install the mounting brackets onto the control panel, and ensure that the cutout in the desk is of the specified size. There must also be enough cable clearance at the back of the cutout to allow the cables to be connected to the control panel.

The desk must be between 0.65 and 1.7 inches thick for the Under-Desk Brackets to install properly and secure the Vision control panel into the desk.

1. Ensure that the cutout and clearances are adequate for your control panel.
2. If the mounting brackets are not already installed, install the mounting brackets onto the control panel (Figure 3.6) using the provided screws.

![Figure 3.6 Installing the Mounting Brackets](image)

3. Gently slide the control panel into the cutout in the desk. The control panel will drop into the cutout from above and rest on the edge supports (Figure 3.7).

![Figure 3.7 Profile of Control Panel Sitting in the Desk](image)

4. Check the clearances around the control panel and at the back for the cables.
5. Install the Under-Desk Brackets on both sides of the control panel to secure the control panel in the desk (Figure 3.8). There are six (6) Under-Desk Brackets for the Vision 4, and four (4) for all other Vision control panels.

![Figure 3.8 Under-Desk Brackets Installation](image)

6. Additional screws (not provided by Ross Video) can be installed through the Under-Desk Bracket into the desk to ensure the control panel does not move.

7. If desired, the Tie-Down Screws (4800FR-690) can be inserted up through the slots on either side of the bottom of the control panel to prevent the panel top from being opened.

Flush Mounted Control Panel Installation

To install the Vision control panel flush into the desk, you must ensure that the cutout in the desk is of the specified size, and that there is enough cable clearance at the back of the cutout to allow the cables to be connected to the control panel.

1. Ensure that the cutout and clearances are adequate for your control panel.

2. Gently slide the control panel into the cutout in the desk. The control panel will drop into the cutout from above and rest on the edge supports (Figure 3.9).

![Figure 3.9 Profile of Control Panel Sitting Flush in the Desk](image)

3. Check the clearances around the control panel and at the back for the cables.

4. If you need to secure the control panel in place, pre-drilled holes are provided in the sides of the control panel tub for securing the control panel to the desk with screws. Screws are not provided.

5. If desired, the Tie-Down Screws (4800FR-690) can be inserted up through the slots on either side of the bottom of the control panel to prevent the panel top from being opened.

Touchscreen Display Installation

To install the Touchscreen Display for the Vision control panel, you must install the mounting arm, install the touchscreen display on the mounting arm, and then connect the video and communication cables between the control panel tub and the display.

Note — The Touchscreen Display is an option with the Vision 1 and 2 control panels. If you do not have the Touchscreen Display, an LCD computer monitor with a DVI-D connector is required. Connect the LCD monitor to the DVI port on the back of the Vision control panel in accordance with the instruction that came with the LCD monitor.
Ross Video does not provide a mounting arm with the Vision control panel. When selecting a mounting arm, you should consider the environment that the control panel will be operating in. For example, in a mobile or truck environment, a more rigid mounting arm is needed to secure the Touchscreen Display.

Operating Tip — Ross Video recommends the Humanscale M7 Desk Mount Flat Panel Monitor Arm by Media Control Co., Inc. (mcergo.com).

In order to properly complete this procedure need the following Touchscreen Display cables and equipment:

- **DVI Cable** — This is a standard DVI-D cable that connects to the DVI-D port on the control panel and the DVI-D port on the Touchscreen Display.
- **Control Cable** — This is a network cable with an RJ-45 connector on both ends. This cable connects to the Aux 1 port on the control panel and the PREV port on the Touchscreen Display.
- **USB Cable** — This is a standard USB cable that connects to the USB port on back of the control panel and the USB port on the Touchscreen Display.
- **Mounting Arm** — The user supplied mounting arm must have a VESA FDMI MIS-D 75 or 100, C compliant mounting bracket to support the Touchscreen Display.

### Installing the Touchscreen

1. Secure the **Touchscreen Display** (Figure 3.10) to the VESA FDMI MIS-D 75 or 100, C Mounting Arm using the 4 #6 screws (#850-013R), flat washers (#960-010R), and locking washers (#960-023R) provided with the Vision control panel Installation Kit and position the display as desired.

![Figure 3.10 Control Panel to Touchscreen Display Cable Connections](image)

2. Connect and secure one end of the **DVI Cable** to the DVI port on the back of the control panel (Figure 3.11).

3. Connect and secure the other end of the **DVI Cable** to the DVI port on the touchscreen display.
Figure 3.11 Touchscreen Display Connections to the Vision Control Panel

4. Connect and secure one end of the **Control Cable** to the **External Panel Link 1** port on the back of the control panel.

5. Connect and secure the other end of the **Control Cable** to the **PREV** port on the Touchscreen Display.

6. Connect one end of the **USB Cable** to a **USB** port on the back of the control panel. It does not matter which port you use.

7. Connect the other end of the **USB Cable** to the **USB** port on the Touchscreen Display.

**For More Information...**

- on connecting the power supply connections, refer to the section “**Power Supply Connections**” on page Eng 3-19.
- on installing a Remote Aux Panel, refer to the section “**Auxiliary Panels**” on page Eng 14-1.
- on control panel specifications, refer to the section “**Standard Components**” on page Eng 20-2.
- on the Touchscreen Display, refer to the section “**Touchscreen Interface**” on page Eng 5-2.
- on the ports on the back of the control panel, refer to the section “**Control Panel Communication Ports**” on page Eng 2-15.
- on the ports on the back of the frame, refer to the section “**Frame Communication Ports**” on page Eng 2-16.
Frame to Control Panel Cabling

This section gives an in-depth overview of how to connect the Vision control panel to the frame. These connections include the network connection between the control panel and the frame, and connecting the keyboard and mouse to the control panel.

Frame to Control Panel Cable Installation

The frame and control panel connect to each other through a standard network switch. This connection allows the control panel and frame to pass command and control information between each other, as well as allowing the control panel to connect to external devices on the same subnet. You can connect up to 9 control panels to the frame.

Important — Do not connect the CAT5 (TIA/EIA-568-B) network cable to any of the External Link ports on the back of the control panel. Doing so may damage the control panel.

1. Connect and secure one end of the CAT5 (TIA/EIA-568-B) network cable to the LAN1 port on the CPU Board at the back of the frame. (Figure 3.12)

![Figure 3.12 Connecting the Vision Control Panel to the Frame (QMD-X Shown)](image)

Important — It is recommended that you use only a 10/100mbps switch to connect the Vision control panel to the frame. Using a 10/100/1000mbps (gigabit) switch may cause switcher instability and/or loss of communication between the control panel and the frame. Programming a 10/100/1000mbps (gigabit) switch to 100mbps is not recommended.

2. Connect and secure the other end of the CAT5 (TIA/EIA-568-B) network cable to your local network (a local network switch for example). Refer to the documentation that came with your network switch, or talk to your IT personnel, for more information on setting up and using the switch.

3. Connect and secure a second CAT5 (TIA/EIA-568-B) network cable to the LAN 10/100 port on the control panel. If you are connecting more than one control panel in a MultiPanel application, start by connecting the Master Panel.

4. Connect and secure the other end of the CAT5 (TIA/EIA-568-B) network cable to the same local network or switch.
5. Repeat from Step (3.) for each Satellite Panel you are connecting to the switcher.

For More Information...

- on setting up network communication between the control panel and frame, refer to the section “Network Setup” on page Eng 4-5.
- on MultiPanel setup, refer to the section “MultiPanel Setup” on page Eng 4-9.

Keyboard and Mouse Installation

A keyboard and a mouse can be connected to the Vision control panel to allow you to interact with the switcher and the menus. The Vision control panel supports a mouse and keyboard plugged into the dedicated PS/2 ports, or the USB ports.

The keyboard and mouse must be plugged into the PS/2 at startup in order to be discovered by the control panel. Plugging the keyboard or mouse into the USB ports can be done while the control panel is operating.

Note — The Vision control panel supports any standard 101-Key, 102-Key, or 104-Key Enhanced Keyboards, and any standard PS/2 Mouse.

Use the following methods to install the keyboard and mouse:

- Connect a standard keyboard to the PS/2 Keyboard port at the back of the Vision control panel (Figure 3.13).
- Connect a standard mouse to the PS/2 Mouse port at the back of the Vision control panel (Figure 3.13).

Figure 3.13 Keyboard and Mouse Ports on the Vision Control Panel

This completes the method for installing the keyboard and mouse.

For More Information...

- on the Keyboard or Mouse ports, refer to the section “Control Panel Communication Ports” on page Eng 2-15.
Video Input Cabling

This section discusses how to connect video signals to the Input BNCs of the Vision switcher.

Connect your input video signals to the BNCs on the Video Input Boards as required. Each input is identified by the Slot the board is in, and the Number (1 to 16 inclusive) at the top left of the BNC (Figure 3.14). For example, if you connect a video source to the BNC numbered 5 on the Video Input Board in Slot C, this input will be identified as BNC C05.

The Video Input Board Slots for each frame are as follows:

- **Octane/QMD-X** — Slots C, D, E, F, G, and H
- **MD-X** — Slots C, D, E, F, G, and H
- **QMD** — Slots C, D, and E (Slot E supports either a Video Input Board with 16 inputs or Video Output Board with 8 outputs.)
- **MD** — Slots C, and D

**Important** — All cables must be run in accordance with good engineering practices. Ensure that there is sufficient room for the cable and that enough slack is left in the cable run to permit long, gentle bends. Always install cables so that they will not be subjected to physical abuse.

**Operating Tip** — A Video Input Worksheet is provided to assist you in keeping track of which sources have been connected to which BNCs, and how those BNCs need to be set up. Refer to the section “Video Input Worksheet” on page Eng 21-2 for a copy of this worksheet.

**For More Information...**

- on setting up video input signals, refer to the section “Assigning Input Source Types” on page Eng 7-4.

![Video Input Boards on the frame (QMD Shown)](image)

**Note** — The Vision switcher passes all embedded audio and ancillary data signals, including “closed captioning” that are present on the background video. The individual MLE program outputs each have the ancillary data associated with the background video for that MLE.

Default Input Mapping

The Vision switcher is shipped with a factory default mapping for the available inputs to the crosspoint buttons on the control panel. This allows you to verify video input signals immediately, without having to first configure the inputs. The default mapping depends on the control panel and number of Video Input Boards you have installed.
By default, the first button on the crosspoint bus is mapped to Black, the buttons following that are mapped to the video inputs, starting with the upper most Video Input Board installed in the frame. The last buttons on the bus are mapped to the four Global-Store channels, MLE Re-entries (if installed), and Shift (Figure 3.15).

![Figure 3.15 Default Crosspoint Button Mapping (Vision 1 Shown)](image)

On the Shifted crosspoint bus, the first two buttons are mapped to Color Background 1 and Color Background 2, the next are mapped to each of the MLE-Stores (if installed), and the buttons following that are mapped to the video inputs continuing from those on the unshifted bus. The last button is the Shift button.

**Operating Tip** — If you want to verify inputs connected to not mapped to crosspoint buttons by default, you will have to map those sources to crosspoint buttons manually.

**For More Information...**

- on restoring factory default settings, refer to the section “Resetting the Switcher” on page Eng 4-24.
- on assigning inputs to specific crosspoint buttons, refer to the section “Creating Bus Maps” on page Eng 7-13.
- on Global-Stores, refer to the section “Still-Store Overview” on page Ops 10-2.
- on Bus Holds, refer to the section “Editing Bus Maps” on page Eng 7-13.
Video Output Cabling

This section discusses how to connect to the Output BNCs of the frame, and which Output BNCs to connect monitors to for verifying inputs.

Connect your output cables to the BNCs on the Video Output Boards as required. Each output is identified by the Slot the board is in, and the Number (1 to 16 inclusive) at the top left of BNC (Figure 3.16). For example, if you connect a cable to the BNC numbered 5 on the Video Output Board in Slot K, this input will be identified as BNC K05.

**Important** — All cables must be run in accordance with good engineering practices. Ensure that there is sufficient room for the cable and that enough slack is left in the cable run to permit long, gentle bends. Always install cables so that they will not be subjected to physical abuse.

**Operating Tip** — A Video Output Worksheet is provided to assist you in keeping track of which sources have been connected to which BNCs, and how those BNCs need to be set up. Refer to the section “Video Output Worksheet” on page Eng 21-9 for a copy of this worksheet.

The Video Output Board Slots for each frame are as follows:

- **Octane/QMD-X** — Slots I, J, and K
- **MD-X** — Slots I, J, and K
- **QMD** — Slot B, and E (Slot E supports either a Video Input Board with 16 inputs or Video Output Board with 8 outputs.)
- **MD** — Slot B

**For More Information...**

- on setting up video input signals, refer to the section “Configuring Video Outputs” on page Eng 8-2.

**Figure 3.16** Video Output Boards on the Frame (QMD Shown)

**Note** — The Vision switcher passes all embedded audio and ancillary data signals, including “closed captioning” that are present on the background video. The individual MLE program outputs each have the ancillary data associated with the background video for that MLE.

**Default Output Mapping**

The Vision switcher is shipped with a factory default mapping for outputs. Like the input mapping, the output mapping has the Output BNCs configured to certain outputs from the factory. How the outputs are mapped depends on the options installed on your switcher.
The following output sources are default mapped from the factory:

- **Program:**
  - Octane/QMD-X — The main switcher program output is mapped to **K01** by default.
  - MD-X — The main switcher program output is mapped to **K01** by default.
  - QMD — The main switcher program output is mapped to **B01** by default.
  - MD — The main switcher program output is mapped to **B01** by default.

- **Preview:**
  - Octane/QMD-X — The main switcher preview output is mapped to **K02** by default.
  - MD-X — The main switcher preview output is mapped to **K02** by default.
  - QMD — The main switcher preview output is mapped to **B02** by default.
  - MD — The main switcher preview output is mapped to **B02** by default.

**Note** — If you have a half MLE switcher (a Vision 2.5 QMD-X for example), or you have the MultiDSK™ option installed, the main switcher program and preview are locked to specific Output BNCs. Refer to the section “Mix/DSK” on page Eng 8-19 for more information on the default mapping for the half MLE switchers.

- **Aux** — The Aux outputs are mapped to the remaining Output BNCs in order.

**Monitor Connections**

Virtually any Output BNC of the switcher can be assigned as your program or preview output; however, if you have the Mix/DSK or MultiDSK™ options installed, these outputs are locked to specific Output BNCs. In order to verify the functionality of the switcher and the input video sources, connect a monitor to the Output BNC that is default mapped to.

**Important** — All cables must be run in accordance with good engineering practices. Ensure that there is sufficient room for the cable and that enough slack is left in the cable run to permit long, gentle bends. Always install cables so that they will not be subjected to physical abuse.

If you are using a serial digital monitor, connection is direct. If you are using an analog monitor, one of three D-A converters is required:

- Serial Digital to NTSC
- Serial Digital to PAL
- Serial Digital to Analog Component

For more information on the full line of Ross Video conversion equipment, contact your sales representative or Ross Video Limited.

**For More Information...**

- on assigning output sources to individual BNCs, refer to the section “Configuring Video Outputs” on page Eng 8-2.
- on Output BNCs that are locked on the half MLE switchers, refer to the section “Mix/DSK” on page Eng 8-19.
- on Output BNCs that are locked with the MultiDSK option, refer to the section “MultiDSK” on page Eng 8-22.
- on Output BNCs that are locked with the AuxKey™ option, refer to the section “AuxKeys” on page Eng 8-26.
Button Inserts

This section discusses how to install an insert film into a button on the Vision control panel. Installing an insert film into a button allows you to name specific crosspoint or custom control buttons, or to replace the default button names with those of a different language.

Button Insert Films

A number of commonly used alternative insert films are provided with each Vision switcher. These insert films will have to be cut out from the sheet with a sharp knife or razor and inserted into the desired button.

If you would like custom inserts for your switcher, or need a replacement sheet of alternative or default inserts, contact your Ross Video sales representative for ordering information.

**Important** — Using insert films that do not meet the recommended criteria may damage the button cap and diffuser.

If you would like to create your own insert films, they must meet the following criteria:

- All inserts must be created on a 0.1575 inch (4 millimetre) polyester film.
- All inserts must be created using a screen printing process.
- All inserts must be created using an epoxy based ink.
- All inserts must be cut the dimensions indicated (Figure 3.17).

![Figure 3.17 Control Panel Button Insert Film Sizes](image)

- The text on the insert film should fit within the white area in the center of the film (Figure 3.17) to be visible through the cap.
- The insert films must cut with 0.020 inch (0.50 millimetre) rounded corners. This is to allow the insert films to easily fit into the cap.

Installing Control Panel Button Inserts

1. Remove the **Cap Assembly** from the **Switch Assembly** by grasping it firmly and pulling directly away from the control panel surface (Figure 3.18).

![Figure 3.18 Removing Cap Assembly](image)
2. Remove the **Lens** from the **Diffuser** by using your fingernail, or common end micro screwdriver, to pry the two apart (Figure 3.19).

![Figure 3.19 Removing Lens from Diffuser](image)

3. Place the **Insert Film** into the **Lens** so that the readable side is facing up. The notches on the sides of the **Lens** must be at the sides of the text on the **Insert Film**, and not on the top or bottom (Figure 3.20).

![Figure 3.20 Installing the Insert Film into the Cap Assembly](image)

4. Aligning the notches on the sides of the **Lens** and **Diffuser**, press the **Lens** and **Diffuser** together until they click together (Figure 3.20).

5. Aligning the notches on the sides of the **Cap Assembly** to the tabs on the side of the **Switch Assembly**, press **Cap Assembly** down onto the **Switch Assembly** with a rolling motion until they click together (Figure 3.21).

![Figure 3.21 Re-Installing the Cap Assembly](image)
Power Supply Connections

Both the Vision control panel and frame have removable power supplies that connect to mains power to provide the operational power for the switcher. This section describes how to connect the power supplies to the AC outlet.

Note — Refer to the section “Important Regulatory and Safety Notices to Service Personnel”, at the beginning of this manual, for correct line cord information.

Frame Power Connection

The frame supports a number of power supplies to provide an N+1 or N+2 redundant power option. This allows one, or two, power supplies to be removed from the frame without interrupting the operation of the switcher. The N+2 option also allows you to power the switcher from 2 separate circuits, so that if one circuit goes down, the two power supplies connected to the other circuit will not be affected.

Warning Hazardous Voltage — This apparatus, when equipped with multiple power supplies, can generate high leakage currents. To reduce the risk of electric shock, ensure that each individual supply cord is connected to its own separate branch circuit with an earth connection.

In order to properly complete this procedure you need the following cables:

• Power Cable — One power cable per power supply is required.

To Connect Power to the Frame

1. Ensure that all power supplies are properly installed and turned OFF. Refer to the section “Powering Down the Switcher” on page Eng 4-3 for more information on the location of the power switches.

2. Connect and secure a power cable into the PS1 port at the back of the frame.

3. Connect and secure a power cable into the remaining PS ports at the back of the frame. Ensure that there is a power supply installed in each slot that you are connecting the power cord to.

4. Connect each power cable into the appropriate AC outlet.

Note — Refer to the section “Important Regulatory and Safety Notices to Service Personnel”, at the beginning of this manual, for correct line cord information.

For More Information...

• on installing a frame power supply, refer to the section “Frame Power Supply” on page Eng 18-12.

• on the power consumption of the frame, refer to the section “Power Consumption – Frame” on page Eng 20-4.

Control Panel Power Connection

The Vision control panel can have redundant power, providing an N+1 power source, allowing the failure of a power supply to not interrupt the operation of the switcher.
In order to properly complete this procedure you need the following cables:

- **Power Cable** — One power cable per power supply is required.

### To Connect Power to the Control Panel

1. Ensure that the control panel is turned **OFF**. Refer to the section “Powering Down the Switcher” on page Eng 4-3 for more information on the location of the power switches.

2. Connect a power cable into each of the AC ports at the back of the control panel. If you do not have the redundant power option, only one power supply and AC port is present.

3. Connect each power cable into the appropriate AC outlet.

*For More Information...*

- on the power consumption of the control panel, refer to the section “Power Consumption – Control Panel” on page Eng 20-3.

### Touchscreen Display Power Connection

The Touchscreen Display for the Vision control panel has an independent primary power supply, and optional redundant power supply. These external brick power supplies plug into the **PS1** and **PS2** ports on the back of the Touchscreen Display.

In order to properly complete this procedure you need the following equipment:

- **Power Supply** — This GlobTek® Inc., external power supply, model TR9CE4000LLP-Y, provides power to the Touchscreen Display.

*To connect power to the Touchscreen Display:*

1. Connect and secure the **Primary GlobTek External Power Supply** to the **PS1** port on the back of the Touchscreen Display.

*Caution — Always connect the External Power Supply to the Touchscreen before connecting the AC mains power. Connecting the power supply to the AC mains power before connecting to the Touchscreen could damage the Touchscreen.*

2. If purchased, connect and secure the **Secondary GlobTek External Power Supply** to the **PS2** port on the back of the Touchscreen Display

3. Connect the power cables into the appropriate AC outlets.
Power Fail Indicators

At the bottom of the Touchscreen Display there are two Power Fail indicators that show the current state of the power supplies on the control panel and the frame.

- **Panel Fail** — This indicator lights to show that there is a problem with the power supplies or fans in the control panel.
- **Frame Fail** — This indicator lights to show that there is a problem with the power supplies or fans in the frame. This could be a complete power failure, or the failure of a power supply.

For More Information...

- on diagnosing the power fail indicators, refer to the section “Fail Indicators Diagnosis” on page Eng 17-10.
- on replacing a frame power supply, refer to the section “Frame Power Supply” on page Eng 18-12.
- on replacing a control panel power supply, refer to the section “Control Panel Power Supply” on page Eng 18-10.

Power Failure

When the Vision switcher experiences a power failure, the control panel and frame react as follows:

- **Control Panel Power Loss** — If the control panel loses power, the frame is unaffected and the switcher continues to pass video. When power is restored to the control panel, the settings of the control panel before power was lost are restored.
- **Frame Power Loss** — If the frame loses power, the Frame Fail indicator lights and the splash screen is shown on the Touchscreen Display. When power is restored to the frame, the Frame Fail indicator clears and the control panel returns to the Default State.
- **Complete Power Loss** — If both the control panel and the frame lose power, the switcher returns to the Default State when power is restored.

For More Information...

- on the Default State of the switcher, refer to the section “Resetting the Switcher” on page Eng 4-24.
Initial Setup and Verification

In This Chapter

This chapter provides information on how to initially set up and verify the video signals for your Vision switcher.

The following topics are discussed in this chapter:

• Powering Up and Powering Down the Switcher
• Network Setup
• Network Security
• MultiPanel Setup
• Reference Connection and Setup
• Input Verification
• Functional Check
• Removing and Installing Frame Boards
• Resetting the Switcher

ESD Susceptibility — Static discharge can cause serious damage to sensitive semiconductor devices. Avoid handling the switcher circuit boards in high static environments such as carpeted areas and when synthetic fiber clothing is worn. Touch the frame to dissipate static charge before removing boards from the frame and exercise proper grounding precautions when working on circuit boards.
Powering Up and Powering Down the Switcher

This section describes how to power up and power down the control panel and the frame.

Powering Up the Switcher

This procedure shows you how to properly power up the control panel and frame of your Vision switcher.

Note — The control panel will not start up properly if there is a USB flash drive in the USB port on the control panel. You must remove the USB flash drive from the USB port on the control panel before powering the control panel up.

1. Lift up on the control panel lid to gain access to the control panel tub.
2. Toggle the Primary and, if installed, Secondary AC Power switches for the control panel to ON. The power switches are located inside the control panel tub (Figure 4.1).

3. Press the Control Panel CPU Module Power Switch. The control panel starts to power up.
4. Close the control panel lid.
5. Remove the door from the frame. Refer to the section “Opening and Closing the Frame Door” on page Eng 3-3 for more information.
6. Find the Frame Power Supplies located on the right hand side, inside the frame (Figure 4.2). The yellow Standby indicator should be lit, indicating that AC power is connected to the power supply, but the power supply is not turned on.

Figure 4.1 Power Switches Inside the Control Panel Tub
7. Power on the frame as follows:
   - **Octane/QMD-X/MD-X** — Toggle the Power switch on each Power Supply to **ON**. Find the Main Power switch located on the Cooling Fan Card on the left side of the frame, and toggle it to **ON**.
   - **QMD/MD** — Toggle the Power switch on each Power Supply to **ON**. The yellow Standby indicator should clear and the green Power indicator is lit.

   **Note** — If the green Power indicators on all power supplies are not lit, refer to the section “Frame Power Supply” on page Eng 18-12 for information on diagnosing a power supply.

8. Check that the green Status indicators on the Cooling Fan Board, on the left side of the frame, come on, indicating that all the cooling fans are operating. If the green Status indicators do not come on, Refer to the section “Frame Fan Failure” on page Eng 18-8 for information on replacing a cooling fan.

9. Check that the blue Heartbeat indicator on the front of the boards installed in the frame come on and start flashing. It may take a few seconds for all the boards to start up. If the Heartbeat indicator on a board does not start up after 5 minutes, remove the board and re-install it.

10. Install the door back on the frame.

11. On the control panel, the Main Menus is shown on the Touchscreen Display.

**Powering Down the Switcher**

This procedure shows you how to properly power down your Vision switcher by placing the Frame CPU Board into a hibernation mode. In this mode, it is safe to turn off all your power supplies.

   **Note** — Only the Master Panel can perform a system shutdown. The System Shutdown Menu is not accessible from the Satellite Panels.

1. Press HOME ⇒ More ⇒ System Shutdown ⇒ Shut Down. The system prompts you to confirm the shutdown. Once confirmed, the switcher powers down.

   **Warning Hazardous Voltage** — Even though the switcher has been shut down, the power supplies are still active until they have been physically switched off.

2. Open the front door of the frame. Refer to the section “Opening and Closing the Frame Door” on page Eng 3-3 for more information.
3. Confirm that the **System Status** indicators on the left side of the frame are flashing **Green**, indicating that it is safe to turn the power off.

4. Power off the frame as follows:
   - **Octane/QMD-X/MD-X**
     - Locate the **Main Power** switch on the **Cooling Fan Carrier** on the left side of the frame and toggle it to **OFF**.
     - Toggle the **Power** switch on each **Power Supply** to **OFF**.
   - **QMD/MD**
     - Locate the **Power Supplies** on the right side of the frame and toggle the **Power** switch on each one to **OFF**.

5. Wait about 6 seconds for the system to discharge any residual power. The Status indicators will go out.

6. Lift up on the control panel lid to gain access to the control panel tub.

7. Toggle the **Primary** and, if installed, **Secondary AC Power** switches for the control panel to **OFF**. The power switches are located inside the control panel tub (**Figure 4.1**).

8. Close the control panel lid.

For More Information...

- on using the menu system of the switcher, refer to the section “**Menu System Basics**” on page Eng 5-5.
- on the control panel power supplies, refer to the section “**Control Panel Power Supply**” on page Eng 18-10.
- on the frame power supplies, refer to the section “**Frame Power Supply**” on page Eng 18-12.
Network Setup

This section provides instructions for configuring the network setup for your Vision switcher, including the frame and control panel. This allows proper communication between the control panel(s) and the frame, as well as any Ethernet based external devices on the same sub-network. Software upgrades can also be performed over a network by connecting to the web interface of the frame.

If the frame is using the default network settings, the control panel will automatically detect the frame on power up. No network setup is required. Once connected, you can change the network settings of each Vision control panel. You must restart the switcher each time you want to apply different network settings.

You can connect up to nine (9) Vision control panels to a single MD/X or Octane/QMD/X frame. In either a single panel or MultiPanel configuration, you must configure a Master Panel. Once the Master Panel is configured, up to eight (8) Satellite Panels can be configured.

**Important** — Contact your IT department before connecting the control panel or frame to your facility network to ensure that there are no conflicts. They will provide you with the network information for the frame and control panels (Table 4.1). Refer to the section “Default Network Settings” on page Eng 20-8 for the factory default network address and settings of the switcher.

**Table 4.1 Frame and Panel Network Information**

<table>
<thead>
<tr>
<th>Frame</th>
<th>IP Address</th>
<th>Subnet Mask</th>
<th>Gateway</th>
</tr>
</thead>
<tbody>
<tr>
<td>LAN 1</td>
<td>. . .</td>
<td>. . .</td>
<td>. . .</td>
</tr>
<tr>
<td>LAN 2 (optional)</td>
<td>. . .</td>
<td>. . .</td>
<td>. . .</td>
</tr>
<tr>
<td>Panel ID</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master Panel</td>
<td>. . .</td>
<td>. . .</td>
<td>. . .</td>
</tr>
<tr>
<td>Satellite Panel #1</td>
<td>. . .</td>
<td>. . .</td>
<td>. . .</td>
</tr>
<tr>
<td>Satellite Panel #2</td>
<td>. . .</td>
<td>. . .</td>
<td>. . .</td>
</tr>
<tr>
<td>Satellite Panel #3</td>
<td>. . .</td>
<td>. . .</td>
<td>. . .</td>
</tr>
<tr>
<td>Satellite Panel #4</td>
<td>. . .</td>
<td>. . .</td>
<td>. . .</td>
</tr>
<tr>
<td>Satellite Panel #5</td>
<td>. . .</td>
<td>. . .</td>
<td>. . .</td>
</tr>
<tr>
<td>Satellite Panel #6</td>
<td>. . .</td>
<td>. . .</td>
<td>. . .</td>
</tr>
<tr>
<td>Satellite Panel #7</td>
<td>. . .</td>
<td>. . .</td>
<td>. . .</td>
</tr>
<tr>
<td>Satellite Panel #8</td>
<td>. . .</td>
<td>. . .</td>
<td>. . .</td>
</tr>
</tbody>
</table>

**Frame Network Setup**

From the frame Web Interface, you set up the IP Addresses of the frame, as well as selecting the IP Addresses of all the control panels that can access the frame (Table 4.1). The LAN 1 port is used to connect the Vision control panels to the frame. The LAN 2 port can be used to connect external devices to the frame, or to a graphics suite for the uploading of stills.

1. On your computer, open your Web Browser and, in the address bar, enter the IP address of your frame and press Enter. The QMD/X Web Interface Splash Screen is displayed.

2. Enter your username and password as follows when the Login Dialog Box appears. The default Name is user and Password is password.
3. Click Other... ➔ Network to display the Network Page. This page allows you to change the network configuration of the frame network ports, as well as enter the current IP Address of the Master Panel, and Satellite Panels.

![Network Setup Page](image)

4. Enter the network setup information for the LAN 1 port on the frame as follows:
   - Enter the new Frame IP address in the IP Address field for LAN 1.
   - Enter the new Frame network mask in the Network Mask field for LAN 1.
   - Enter the new Frame gateway in the Gateway field.

   **Operating Tip** — To activate the LAN 2 port, enter an IP Address and Network Mask for LAN 2. The Gateway is common for both the LAN 1 and LAN 2 ports.

5. Enter the IP address for the Master Panel, and each Satellite Panel, you are connecting to the frame as follows:
   - Enter the Master Panel IP address in the IP Address Master Panel field. This does not change the IP address of the Master Panel. To set the IP address of a control panel, you must set it from the panel.
   - Enter the Satellite Panel IP addresses in the IP Address Satellite X field for each Satellite Panel you want to use with the frame. The satellite number is the Panel ID that is set on the Satellite Panel.

6. Press Change and Reboot to restart the switcher and apply the new settings.

Next, you must set up the control panels with the corresponding IP address, and Panel ID.

**Control Panel Network Setup**

To configure the network settings of the Master Panel and Satellite Panels, you must have the IP Address for both the frame that you want to connect to, and each of the control panels (Table 4.1). If you are not connecting any Satellite Panels to your switcher, only configure the Master Panel.

You must perform the following procedure on each control panel.
1. Ensure that the control panel and frame are connected to the same subnet.
2. Place the control panel into diagnostic mode by pressing HOME three (3) times quickly.

![Network Setup Menu](image)

4. Enter the IP address of the LAN 1 port on the frame in the IP Address field using the keyboard or the keypad on the Global Memory Module.
5. Enter the network setup information for the control panel as follows:
   - Enter the new Panel IP address in IP Address field using the keyboard or the keypad on the Global Memory Module.
   - Enter the new Panel subnet mask in the Subnet Mask field using the keyboard, or the keypad on the Global Memory Module.
   - Enter the new Panel gateway in the Gateway field using the keyboard, or the keypad on the Global Memory Module.
6. Use the Panel ID knob to select the Panel ID that corresponds to the IP Address you set from the Network Page from the QMD/X Web Interface.

**Operating Tip** — If you want to cancel the changes you have made to the network information, press Revert To Current on the Network Setup Menu to revert to the last saved network settings.

7. Press Save to store the new network setup information.
8. Press Yes to reboot the panel and apply the new network settings.
9. Repeat this procedure for each control panel you are connecting to the frame.

**For More Information...**
- on powering up or down the switcher, refer to the section “Powering Up and Powering Down the Switcher” on page Eng 4-2.
- on setting the DIP switch to default the IP address of the frame, refer to the section “Frame CPU Board DIP Switch” on page Eng 20-8.
Network Security

The Vision switcher uses a standard ethernet connection for communication between the control panel and the frame, as well as between some external devices and the switcher. Any time your switcher is connected to a public network, it is important to follow certain precautions to ensure that your switcher is not vulnerable. These precautions are as follows:

- **Limit Access** — Anyone who can access your network could also have access to your sensitive data and equipment. Limit network access by keeping your production equipment on a separate network segment or use a firewall. Contact your IT department for more information about how your network is set up.

- **Change Default Passwords** — Change the **Web Interface** password for your switcher. Refer to the section “Vision Web Interface Account” on page Eng 6-2 for more information.

- **Disable Unused Services** — The Vision switcher provides access to a number of default services as listed below. These services can be disabled by **Ross Video Technical Support** if required for added security.
  - **Web Server** — This service is used for the Web Interface.
  - **WebDAV** — This service is used to transfer images and animations to the switcher for use with the internal Still-Stores.
  - **Telnet Server** — This service is used for diagnostic and maintenance purposes.
MultiPanel Setup

To set up a MultiPanel system you must configure the network settings on each of the control panels and frame, assign MLEs to each of the control panels, assign system permissions, and then set up the video outputs for each of your Program MLEs.

Refer to the section “Network Setup” on page Eng 4-5 for information on setting the network configuration for a MultiPanel system.

MLE Assignment

The MLE assignment sets which MLEs a specific control panel has access to, and can control. The highest number MLE assigned to a control panel is the program MLE for that control panel. This MLE is tallied for the control panel. The highest number MLE assigned to a control panel in the entire switcher is the Program MLE for the switcher. This is the MLE that has the MultiDSK, Half MLE, and Preview Overlay options.

1. Press HOME ➔ Setup ➔ Installation ➔ More ➔ MultiPanel.

2. Select the Master Panel, or Satellite X panel, that you want to set the MLE assignment for.

3. Next to MLE Permissions, select the MLEs that you want to assign to the control panel. The control panels that an MLE is assigned to are shown on the MLE button. The Master Panel is shown as MP, and Satellite Panels are shown as P#.

4. Next to Virtual Program MLE, select the MLE that you want to use as the Program MLE for the control panel.

Note — The MLE that has the MultiDSK, Half MLE, and Preview Overlay options is indicated with Pgm MLE (full MLE), Pgm Mix (MixDSK), Pgm Multi (MultiDSK), or Mix Multi (Mix/DSK and MultiDSK).

5. Press HOME to display the Installation Change Confirmation Screen.

6. Accept or reject the changes you have made as follows:
   - Press Confirm to accept the changes and reset all Remote, Peripheral, and Net ports.
   - Press Confirm w/o Reset to accept the changes without resetting all Remote, Peripheral, and Net ports. Only use this if told to do so by Ross Video Technical Support.
• Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

Next, you must set up the Video Output BNCs for the Program MLEs. The Program output, and Preview output, for the switcher is locked to the highest MLE assigned in the system. If you are using different Program MLEs for different control panels, you must assign an output BNC to the **MLE X Program** and **MLE X Preview** for that MLE, where X is the number of your MLE.

Refer to the section “**Configuring Video Outputs**” on page Eng 8-2 for information on assigning the MLE Program and MLE Preview to an output BNC.

### System Permissions

Each Satellite Panel can be granted permission to view and change the installation settings on the switcher.

**Operating Tip** — Only one control panel can be accessing the Installation Menus at any one time. To see which control panel is currently in the menu, and to force that control panel out of the menu, press **HOME → Setup → More → More → Inst. Menu Status**. Press **Force Inst Menu Change** to force the other control panel out of the Installation Menu.

1. Press **HOME → Setup → Installation → More → MultiPanel → System Permissions**.

   ![System Permissions Menu](image)

   **System Permissions Menu**

2. Toggle the button for a Satellite panel on to grant system permissions to that control panel.
Reference Connection and Setup

The Flexible Reference system in the Vision switcher allows you to use an Interlaced video format as the reference to operate the switcher in a video format of the same frequency. Choosing a progressive video format as a reference limits you to operating the switcher only in that same video format and frequency. For example, if you have a 1080i 59.94 Hz input reference you can operate the switcher in 720p 59.94 Hz, but not 1080i 50 Hz. However, if you have a 720p 59.94 Hz input reference, you can only operate the switcher in 720p 59.94 Hz. If you need to change frequencies, you can have multiple input references and switch between them as needed.

Reference Signal Connection

The Vision switcher accepts either an analog Tri-Level Sync or Composite reference signal connected to the reference loop BNCs on one of the Video Input Boards on the switcher.

**Note** — If the reference loop is not connected, the loop BNC should be terminated with a 75ohm termination.

Connect the reference signal to one of the REF connectors on the Video Input Board. If an additional reference is needed, a second Video Input Board with reference must be used.

**Operating Tip** — Always use a stable signal that is low in jitter, and that preferably originates from a reliable analog test signal generator.

For More Information...

- on reference signal characteristics, refer to the section “Video Characteristics” on page Eng 20-14.

Compatible Video Formats

Depending on the input reference format you use, you will only be able to operate the switcher in certain formats (Table 4.2). References to 1080p 59.94Hz (A) and 1080p 50Hz (A) refer to 1080p Level A only.

**Note** — The 1080p 59.94Hz, 1080p 50, and 1080p 29.97Hz video formats are not supported by some older frame boards. If any of these boards are present in the frame, a warning message is shown on the Main Menu and the board(s) is listed on the Status Menu.
**Important** — It is not recommended that you operate the switcher in these video formats when you are using a composite sync (480i or 576i) reference signal.

The Vision switcher allows you to use any interlaced video format to operate the switcher in any format of the same frequency; however, the use of **480i** or **576i** (Composite Sync) reference signals for High Definition (**720p** or **1080i**) video modes is not recommended. Using a composite sync reference signal for High Definition video modes results in excessive jitter on the video output of the switcher, falling outside the range specified by **SMPTE-292M**. This may result in downstream equipment being unable to properly receive these signals.

The use of composite sync reference formats is recommended for Standard Definition video modes only, and provides stable outputs with jitter performance in compliance with **SMPTE-259M** specifications.

<table>
<thead>
<tr>
<th>Input Reference</th>
<th>Usable Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>480i</td>
<td>• 480i</td>
</tr>
<tr>
<td></td>
<td>• 480i 16:9</td>
</tr>
<tr>
<td></td>
<td>• 720p 59.94Hz*</td>
</tr>
<tr>
<td></td>
<td>• 1080i 59.94Hz*</td>
</tr>
<tr>
<td></td>
<td>• 1080p 29.97Hz</td>
</tr>
<tr>
<td></td>
<td>• 1080p 59.94Hz (A)</td>
</tr>
<tr>
<td>576i</td>
<td>• 576i</td>
</tr>
<tr>
<td></td>
<td>• 576i 16:9</td>
</tr>
<tr>
<td></td>
<td>• 720p 50Hz*</td>
</tr>
<tr>
<td></td>
<td>• 1080i 50Hz*</td>
</tr>
<tr>
<td></td>
<td>• 1080p 50Hz (A)</td>
</tr>
<tr>
<td>720p 59.94Hz</td>
<td>• 720p 59.94Hz</td>
</tr>
<tr>
<td>720p 50Hz</td>
<td>• 720p 50Hz</td>
</tr>
<tr>
<td>1080i 59.94Hz</td>
<td>• 480i</td>
</tr>
<tr>
<td></td>
<td>• 480i 16:9</td>
</tr>
<tr>
<td></td>
<td>• 720p 59.94Hz</td>
</tr>
<tr>
<td></td>
<td>• 1080i 59.94Hz</td>
</tr>
<tr>
<td></td>
<td>• 1080p 29.97Hz</td>
</tr>
<tr>
<td></td>
<td>• 1080p 59.94Hz (A)</td>
</tr>
<tr>
<td>1080i 50Hz</td>
<td>• 576i</td>
</tr>
<tr>
<td></td>
<td>• 576i 16:9</td>
</tr>
<tr>
<td></td>
<td>• 720p 50</td>
</tr>
<tr>
<td></td>
<td>• 1080i 50Hz</td>
</tr>
<tr>
<td></td>
<td>• 1080p 50Hz (A)</td>
</tr>
<tr>
<td>1080p 24Hz</td>
<td>• 1080p 24Hz</td>
</tr>
<tr>
<td>1080pSF 24Hz</td>
<td>• 1080pSF 24Hz</td>
</tr>
<tr>
<td>1080pSF 23.98Hz</td>
<td>• 1080pSF 23.98Hz</td>
</tr>
<tr>
<td>1080p 29.97Hz</td>
<td>• 1080p 29.97</td>
</tr>
</tbody>
</table>
Reference Setup

Depending on the input reference, and the MLE options purchased, you can select a number of HD or SD video formats for the switcher to operate in. This is the native video format that all video manipulation is performed in by the switcher.

The current input reference format (Reference mode) and video format (Video mode) that the switcher is operating in are shown on the Main Menu. If the current input reference format is not present or locked, the Reference mode text appears red.

If you have the MLE SD option installed on one or more MLEs, those MLEs will only be able to operate in SD video formats; 480i, 576i, 480i 16:9, and 576i 16:9. The MLE MD options supports all video formats.

1. Press HOME ➔ Setup ➔ Installation ➔ More ➔ Reference.

2. Use the Input Board knob select the Video Input Board you have connected the reference to.

   **Note** — Video Input Boards that are not installed, or do not have a reference input, appear gray and cannot be used as a reference input.

3. Use the Ref Format knob to select the reference format of the input reference.

4. Use the Video Format knob to select the video format you want the switcher to operate in. The list of available formats will vary, depending on the format of the input reference that you selected above and the MLE MD or MLE SD option that is installed.

5. Reset the video format of all Input BNCs to the video format of the switcher as follows:
   - Press Reset Input Formats to have the switcher set all Input BNCs to the same video format that the switcher is currently operating in.

6. Reset the video format of all Output BNCs to the currently selected video format as follows:
   - Use the Video Format knob to select the video format that you want to set all Output BNCs to.

   **Note** — When you reset all Output BNCs to the selected video format, this will include any Aux Buses that are being used for SmartConversion. Refer to the section “Setting Up a Conversion Loop” on page Eng 16-2 for more information.

   - Press Reset Output Formats to have the switcher set all Output BNCs to the currently selected video format. You are asked to confirm the change.

7. Press HOME to display the Installation Change Confirmation Screen.
8. Accept or reject the changes you have made as follows:
   - Press **Confirm** to accept the changes and reset all Remote, Peripheral, and Net ports.
   - Press **Confirm w/o Reset** to accept the changes without resetting all Remote, Peripheral, and Net ports. Only use this if told to do so by Ross Video Technical Support.
   - Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

---

**Important** — *When you switch reference formats, you must perform a soft reset (ALL+ALL) in order to load the default Keyer, MLE, and dissolve rates for the format you have set.*

---

**Internal Reference**

The Vision switcher can generate an internal reference signal that can be used for any internally generated video signal. For example, you can use matte color, Global-Store images, or MLE-Store images with the internally generated reference signal to test the functionality of the switcher during initial setup.

---

**Important** — *The internally generated reference signal cannot be used with external video signals. The switcher will not be able to synchronize the external video signals without an external reference.*

---

The switcher can generate the following internal reference signals:

- 1080i 59.94
- 1080i 50
- 1080pSF 24
- 1080pSF 23.98
- 1080p 24

Refer to the section “**Compatible Video Formats**” on page Eng 4-11 for a list of video formats that the switcher can operate in using these internal reference formats.

**To Set an Internal Reference**

1. Press HOME ⇒ Setup ⇒ Installation ⇒ More ⇒ Reference.
2. Toggle **Reference** to select an Internal and External reference.
   - **Int** — Select this option to use the internally generated reference signal.
   - **Ext** — Select this option to use an external reference signal.
3. Press HOME to display the **Installation Change Confirmation Screen**.
4. Accept or reject the changes you have made as follows:
   - Press **Confirm** to accept the changes and reset all Remote, Peripheral, and Net ports.
   - Press **Confirm w/o Reset** to accept the changes without resetting all Remote, Peripheral, and Net ports. Only use this if told to do so by Ross Video Technical Support.
   - Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.
For More Information...

- on working with different video formats, refer to the section “Video Formats” on page Eng 2-31.
- on reference signal specifications, refer to the section “Video Characteristics” on page Eng 20-14.
Input Verification

The Vision switcher displays the currently assigned source for each crosspoint button on the mnemonic display above the button. For internally generated sources, such as Black or Global-Stores, the name describes the source, BLCK for example. For external video sources, the default name is the BNC that the crosspoint button is assigned to. For example, button 2 on the control panel is assigned to Input 001. The name In 001 is displayed above button 2.

Operating Tip — Verification of video sources is best done on the Program (PGM) Bus of the bottom MLE. This is the bus that is fed directly out of the Program BNC. This procedure assumes that all crosspoint selections are made on this bus.

1. The initial state, or reset state, of the switcher is to have Black selected on all buses. Black should be displayed on the monitor.
2. Select crosspoint button 2 on the PGM Bus. The name In 001 should be shown in the mnemonic display above the button.
3. Refer to your Input Worksheet and confirm that the source you have connected to In 001 is what is being displayed on the monitor.
   • If the video signal displayed on the monitor is not what you have recorded on the Input Worksheet for In 001, double-check the connections to the BNC to ensure that sources have not been mislabelled.
4. Repeat Steps (2.) and (3.) for each crosspoint button on the PGM Bus that is mapped to a BNC. The last 4 crosspoint buttons are mapped to internal sources.
5. Select Global-Store 1 on the PGM Bus. The name GS 1 is shown in the mnemonic display above the button and the Global-Store Menu is shown on the Touchscreen Display. Repeat this for the remaining global-store channels.
6. Press and hold the SHIFT button. The mnemonics change, indicating the sources that are mapped to the crosspoint buttons on the shifted bus.
7. Select Color BKGD 1 on the PGM Bus. The name BKGD 1 is shown in the mnemonic display above the button and the Matte Selection Menu is shown on the touchscreen display.
8. Repeat Steps (2.) and (3.) for each crosspoint button on the shifted bus that is mapped to a BNC.

To verify sources that are not mapped to crosspoint buttons, you must map those sources to buttons and verify them that way.

For More Information...

• on connecting monitors to your Output BNC, refer to the section “Monitor Connections” on page Eng 3-16.
• on setting up Input BNCs, refer to the section “Assigning Input Source Types” on page Eng 7-4.
• on loading Global-Store stills, refer to the section “Loading Stills” on page Ops 10-3.
Functional Check

All Ross Video products undergo thorough quality control and testing before shipment. The following functional check ensures that no damage has occurred during transit, and that all boards are correctly installed.

To perform the functional check, a monitor must be connected to at least one of the outputs. Refer to the section “Monitor Connections” on page Eng 3-16 for information on how to connect a temporarily monitor for the verification of sources.

Operating Tip — Verification of video sources is best done on the Program (PGM) Bus of the highest number MLE. This procedure assumes that all crosspoint selections are made on this bus.

1. Perform a full software reset. Refer to the section “Resetting the Switcher” on page Eng 4-24 for more information on performing a software reset.
2. Select a crosspoint button on the PGM Bus. This video source appears on the Program monitor.
3. Select a different crosspoint button on the PST Bus. This video source appears on the Preview monitor.
4. In the Transition Module for that MLE, select Dissolve (DISS) as the transition type.
5. While watching the Program monitor, move the Fader in the MLE Transition Module from one limit to the other. The video on the Program monitor dissolves to the video source you selected on the PST Bus and the selected crosspoint buttons on each bus will switch, indicating that the new source is currently selected on the PGM Bus.
6. In the Transition Module for that MLE, select Wipe (WIPE) as the transition type.
7. While watching the Program monitor, move the Fader in the MLE Transition Module from one limit to the other. The video on the Program monitor wipes to the video source you selected on the PST Bus and the selected crosspoint buttons on each bus switch, indicating that the new source is currently selected on the PGM Bus.
8. While watching the Program monitor, select different crosspoint buttons on the PGM Bus, ensuring that the cuts are taking place.
9. If your control panel has multiple MLEs, re-enter one MLE into the PGM/PST MLE by pressing the re-entry button on the crosspoint bus. Refer to the section “Default Input Mapping” on page Eng 3-13 for more information on the location of the re-entry buttons.

If you experienced problems with this test, ensure that the buttons and faders are working properly, or check that the reference connections for the switcher are properly set up.

For More Information...

- on diagnosing problems with faders, or buttons refer to the section “Control Panel Diagnostic Tools” on page Eng 17-18.
- on checking the reference settings, refer to the section “Reference Connection and Setup” on page Eng 4-11.
Removing and Installing Frame Boards

The frame comes standard with all the circuit boards already installed. If daughter cards or boards need to be installed, or replaced, you will have to either remove and install, or install the new boards into the frame.

When a new board is installed, the switcher checks the current version of software on the board and tries to upgrade it to the current version of the switcher. If the software on the board is the same as the software on the switcher, there is no change. If the board has a software version that is different than the version on the switcher, the switcher will upgrade the board to the same version as the switcher. For this reason it is important that you upgrade your switcher to the latest version of Vision software prior to installing a new board into the frame.

If you are installing one of the following options, refer to the documentation that came with your hardware for detailed instructions on this option:

- Squeeze & Tease MD
- Squeeze & Tease WARP
- XFX Board (Dual Border Generator and MLE-Store)

For More Information...

- on upgrading the switcher, refer to the section “Software Upgrade” on page Eng 6-3.
- on removing or installing a control panel module, refer to the section “Replacing a Control Panel Module” on page Eng 18-21.

Frame Board Locations

The number and position of the boards in the frame depends on the number of MLEs, Squeeze & Tease resources, video inputs and outputs you require. These boards must be installed in the proper slots in order to ensure proper switcher operation.

Front Frame Boards

The front of the frame is where most of the video processing boards are located. The location and number of boards that are installed in the frame depends on the number of MLEs, and Squeeze & Tease DVE channels you require per MLE-pair. Refer to the following table (Table 4.3), and the illustrations of the Octane/QMD-X/MD-X (Figure 4.4) and QMD/MD (Figure 4.5) frames for information on which slot each front frame board should be installed in.
### Table 4.3 Front Frame Boards

<table>
<thead>
<tr>
<th>Slot</th>
<th>Octane/QMD-X</th>
<th>MD-X</th>
<th>QMD</th>
<th>MD</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slot 0</td>
<td>Fan Board(^a)</td>
<td>Fan Board</td>
<td>Fan Board</td>
<td>Fan Board</td>
</tr>
<tr>
<td>Slot 1</td>
<td>Video Processor Board (MLE 1&amp;2 or MultiViewer 4&amp;3)</td>
<td>Video Processor Board (All MLEs)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Slot 2</td>
<td>Squeeze &amp; Tease Carrier (All MLEs)</td>
<td>Squeeze &amp; Tease Carrier (All MLEs)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Slot 3</td>
<td>Video Processor Board (MLE 7&amp;8(^b) or MultiViewer 2&amp;1)</td>
<td>Video Processor Board (MLE 1&amp;2)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Slot 4</td>
<td>Squeeze &amp; Tease Carrier (MLE 5,6,7,8(^c))</td>
<td>Video Processor Board (MLE 1&amp;2)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Slot 5</td>
<td>Crosspoint Board</td>
<td>Crosspoint Board</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Slot 6</td>
<td>Squeeze &amp; Tease Carrier (MLE 3&amp;4)(^d)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Slot 7</td>
<td>Video Processor Board (MLE 3&amp;4(^b) or MultiViewer 6&amp;5)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Slot 8</td>
<td>Squeeze &amp; Tease Carrier (MLE 1&amp;2)(^c)</td>
<td>Squeeze &amp; Tease Carrier (MLE 3&amp;4)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Slot 9</td>
<td>Video Processor Board (MLE 1&amp;2(^b) or MultiViewer 8&amp;7)</td>
<td>Video Processor Board (MLE 3&amp;4)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

\(^a\) Iss.3 or higher only
\(^b\) Iss.1, Rev.P or higher only
\(^c\) WARP Cards of Iss.1, Rev.D or higher only

**Figure 4.4 Board Slots in the Front of the Frame (Octane/QMD-X/MD-X)**
Rear Frame Boards

The rear of the frame is where input and output BNCs boards are located. The number of boards that are installed in the frame depends on the number of inputs and outputs you require. Refer to the following table (Table 4.4), and the illustrations of the QMD-X/MD-X (Figure 4.6) and QMD/MD (Figure 4.7) frames for information on which slot each rear frame board should be installed in.

Table 4.4 Rear Frame Boards

<table>
<thead>
<tr>
<th>Slot</th>
<th>Octane/QMD-X</th>
<th>MD-X</th>
<th>QMD</th>
<th>MD</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slot A</td>
<td>Frame CPU Board</td>
<td>Frame CPU Board</td>
<td>Frame CPU Board</td>
<td>Frame CPU Board</td>
</tr>
<tr>
<td>Slot B</td>
<td></td>
<td>Video Output Board*</td>
<td>Video Output Board*</td>
<td></td>
</tr>
<tr>
<td>Slot C</td>
<td>Video Input Board</td>
<td>Video Input Board</td>
<td>Video Input with CrossPoint Board</td>
<td>Video Input with CrossPoint Board</td>
</tr>
<tr>
<td>Slot D</td>
<td>Video Input Board</td>
<td>Video Input Board</td>
<td>Video Input Board</td>
<td>Video Input Board</td>
</tr>
<tr>
<td>Slot E</td>
<td>Video Input Board</td>
<td>Video Input Board</td>
<td>Video Input Board or Video Output Board*</td>
<td></td>
</tr>
<tr>
<td>Slot F</td>
<td>Video Input Board</td>
<td>Video Input Board</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Slot G</td>
<td>Video Input Board</td>
<td>Video Input Board</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Slot H</td>
<td>Video Input Board</td>
<td>Video Input Board</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Slot I</td>
<td>Video Output Board</td>
<td>Video Output Board</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Slot J</td>
<td>Video Output Board</td>
<td>Video Output Board</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Slot K</td>
<td>Video Output Board*</td>
<td>Video Output Board*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Slot L</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Slot M</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

a. Only output BNCs E9 through E16 are available on a Video Output Board installed in Slot E of the QMD frame.

* Only a Multi-Definition Video Output Board (4800AR-064, 066, or 067) can be installed in this slot to support the MultiDSK, Mix/DSK, or AuxKeys features.
Removing and Installing Front Frame Boards

The circuit boards at the front of the frame manipulate and route video from the Video Input Boards at the rear of the frame to the Video Output Board. These boards can be removed and replaced as needed by removing the front door of the frame and sliding the desired boards out.

**Warning Hazardous Voltage** — Hazardous voltages are present in the frame as long as any of the power supplies are connected to the AC power.

### Removing a Front Frame Board

1. Back up any switcher setup configurations you have. Refer to the section “Storing and Recalling Files and Setups” on page Eng 13-4 for more information on storing switcher setups.

2. Open the front frame door from the frame. Refer to the section “Opening and Closing the Frame Door” on page Eng 3-3 for more information.

3. Locate the board you want to remove from the frame. Refer to the section “Frame Board Locations” on page Eng 4-18 for information on where each board is located.

4. If a tie wrap has been used to secure the extractor tabs on the sides of the board, remove the tie wrap.

5. Locate the two locking tabs at either side of the board you want to remove.
6. Grasp both locking tabs and rotate them towards you and out towards the outer sides of the frame. This unseats the board from the midplane.

7. Gently slide the board out of the frame and place it on a clean, flat, static-free surface.

8. Install the frame door when you are done removing boards from the frame.

### Installing a Front Frame Board

1. With the frame door removed, locate the slot into which you will be installing the circuit board. Refer to the section “Removing a Front Frame Board” on page Eng 4-21 to ensure proper configuration.

2. Inspect the **Power Connector Blades** on the edge of the board (Figure 4.8) to ensure that they are not bent or damaged.

   ![Power Connector Blades](Figure 4.8 Power Connector Blade Inspection)

3. Align the board with the guide rails and push the board into the slot. When the board stops sliding freely, push firmly to seat the board, and secure it with the ejector tabs.

   **Important** — If there is significant resistance when seating the board, remove the board from the frame and inspect the connectors for bent pins or other damage to the connectors.

4. The switcher upgrades the board you have installed, if required.

5. Locate the two small holes on the front edge of the board, near the extractor tabs. If you wish, you can further secure the board by threading tie wraps through these holes and fastening them around the extractor tabs.

6. Close the frame door when you are done installing boards into the frame.

### Removing and Installing Rear Frame Boards

The circuit boards at the rear of the frame include the **Frame CPU Board**, **Video Input Boards**, and **Video Output Boards**. With the exception of the **Video Input Board** that is providing the reference signal for the switcher, and the **Frame CPU Board**, each of these boards can be removed and replaced during operation.
Removing a Rear Frame Board

1. Locate the board you want to remove from the frame. Refer to the section “Frame Board Locations” on page Eng 4-18 for information on where each board is located.

2. Label and remove any cables connected to the board so that they can be properly connected again.

3. Unscrew the Locking Screws located at either end of the rear panel of the board you want to remove (Figure 4.9).

   ![Figure 4.9 Locking Screws on Rear Frame Board](image)

4. Gently slide the board out of the frame and place it on a clean, flat, static-free surface.

Installing a Rear Frame Board

1. Locate the slot for the board you want to install in the frame.

2. Inspect the Power Connector Blades on your board (Figure 4.10) to ensure that they are not bent or damaged.

   ![Figure 4.10 Power Connector Blade Inspection](image)

   **Important** — If the blades in the power connectors are bent or damaged, contact Ross Video Technical Support. Do not attempt to install a damaged board.

3. Align the new board with the guide rails and slide the board into the frame until the board stops sliding freely.

4. Unscrew the Locking Screws located at either end of the rear panel of the board, or blank spacer, above or below the new board you are installing.

5. Pull the board you just unscrewed the Locking Screws from out of the frame about 1/4” (6mm).

6. Push firmly and evenly on each side of the new board to seat it.

   **Important** — DO NOT use the Locking Screws to seat or force the board into the slot. If you have trouble seating the new board, contact Ross Video Technical Support.

7. Seat the board above or below the new board, and screw in the Locking Screws on both boards.

8. The switcher upgrades the new board you have installed, if required.

9. Reconnect the cables to the board.
Resetting the Switcher

If required, the Vision switcher can be reset from the control panel, returning the switcher to the default state. This can be either a full restart of the switcher, or just the control panel, or a reset of the software.

- **Full Restart** — The Full Restart affects hardware and software simultaneously, physically powering down the switcher and powering it back up again. This is not the same as powering the switcher off and back on again.
- **Control Panel Restart** — The Control Panel Restart restarts the only the control panel, and does not affect the frame.
- **Software Reset** — A Software Reset affects software only, returning the switcher to the default state.

**Note** — The control panel will not start up properly if there is a USB flash drive in the USB port on the control panel. You must remove the USB flash drive from the USB port on the control panel before powering the control panel up.

**Full Restart**

This function performs both a hardware and a software reset simultaneously. Switcher memory registers, personality registers, installation registers, and custom control registers are not affected by the reset, but all other switcher parameters (for example, the current state of the panel) are reset. **BLACK** is selected on all buses.

**Note** — Only the Master Panel can perform a full restart. The **System Shutdown Menu** is not accessible from the Satellite Panels.

1. Press **HOME ➔ More ➔ System Shutdown**.

2. Press **Restart**.

3. The system prompts you to confirm the restart. Once confirmed, the frame powers down and boots up again.

**Control Panel Restart**

This function performs a restart of the Vision control panel. The frame is not affected by the restart of the control panel.
Note — Only the Master Panel can perform a panel restart. The System Shutdown Menu is not accessible from the Satellite Panels.


2. Press Restart Panel.

3. The system prompts you to confirm the restart. Once confirmed, the control panel powers down and boots up again.

Software Reset

The software reset function can be performed from either the Global Memory Module or any individual Effects Memory Module on the control panel. Both methods are described below.

Resetting from the Global Memory Module

From the Global Memory Module you can reset either all of the MLEs assigned by your control panel at once, or each one individually.

Use one of the following methods to reset MLEs from the Global Memory Module:

- **All MLEs** — To reset all MLEs, press and hold both the ALL button in the Recall area and the ALL button in the Store areas (Figure 4.11). Only the MLEs assigned to the control panel are reset.

- **Individual MLEs (1-4)** — To reset MLEs 1-4 individually, press and hold both the MLE # button in the Recall and the MLE # button in the Store areas (Figure 4.12). Where the
is the number of the MLE you want to reset. For example, to reset MLE 1, you would press and hold the MLE 1 buttons. You can only reset MLEs that are assigned to your control panel.

- **Individual MLEs (5-8)** — To reset MLEs 5-8 individually, toggle +4 on and press and hold both the MLE # button in the Recall and the MLE # button in the Store areas (Figure 4.12). Where the # is the number of the MLE you want to reset. For example, to reset MLE 5, you would toggle +4 on, and press and hold the MLE 1 buttons. You can only reset MLEs that are assigned to your control panel.

---

**Note** — You cannot reset an individual MLE from the 1-4 MLE and the 5-8 MLE at the same time.

---

**Figure 4.12 Press to Reset an Individual MLE**

This completes the method for resetting an individual MLE, or all MLEs, from the Global Memory System Module.

### Resetting from an Individual MLE

From each individual Effects Memory Module you can reset the MLE individually.

Use the following method to reset an MLE from the Effects Memory Module:

- Press and hold both the Recall and Store buttons in the Effects Memory Module (Figure 4.13).

---

**Figure 4.13 Press to Reset an individual MLE**

This completes the method for resetting an individual MLE from the Effects Memory Module.
Resetting From the Positioner Module

You can also reset the Crosspoint Group individually from the Positioner Module. This allows you to reset an MLE or an Aux bus, depending on what is assigned to the Crosspoint Group.

1. Press and hold the SEL button on the Crosspoint Group that you want to reset. Refer to the section “Panel Row” on page Ops 4-5 for more information on the Crosspoint Group.

2. Press the CLEAR button on the Positioner Module. The Crosspoint Group will return to the default state.

Default State

When you reset an MLE, Aux Bus, the entire switcher, or perform a complete restart, the switcher returns to the default state.

**Note** — If you reset only an individual MLE, only that MLE is returned to the default state. The rest of the MLEs will remain unaffected.

The default state consists of the following:

- The first crosspoint button (Black by default) is selected on the Key, Background, and Preset buses.
- All Keys are taken off-air.
- In the Preview Bus Module, the PV button is selected.
- In the Transition Modules, Background (BKGD) is selected as included in the next transition, and Dissolve (DISS) is selected as the transition type.

**Note** — All transition rates shown are for an Interlaced video format operating at 59.94 Hz. The switcher automatically calculates the transition rate, based on the video format it is operating in.

- In the Effects Memory Module, the following memories and rates are set:
  - REG:00 — Memory register 00 is preset
  - Memory0 — Memory register 00 was last recalled
  - MLE:015 — MLE transition rate is 15 frames
  - Key:008 — Key transition rate is 8 frames
- In the Global Memory Module, the following memories and rates are set:
  - REG:00 — Memory register 00 is preset
  - Memory0 — Memory register 00 was last recalled
  - M:015 — MLE transition rate is 15 frames
  - D:008 — DSK transition rate is 8 frames
  - F:20 — DSK fade-to-black transition rate is 20 frames
- Auto Select is selected as the Key type in each Keyer.
- The Key 4 Mode is set to External.
Using the Menu System

In This Chapter

This chapter provides information on using the menu system, and adjusting and using the Touchscreen Display of the Vision switcher.

The following topics are discussed in this chapter:

- Touchscreen Interface
- Menu System Basics
- Quick Navigation Buttons
- Menu Skins
- Control Panel Mnemonics
- Control Panel Displays
- Using the Naming Menus
- Help Features
- Screen Captures
Touchscreen Interface

Each large Vision switcher comes with an adjustable touchscreen display (Figure 5.1) that is used to interface with the menu system of the switcher. As you operate the switcher, the menu system follows what you are doing, displaying the appropriate menu. For example, if you select a crosspoint that has been assigned to a robotic camera that is controlled from the switcher, the Camera Head Control Menu for that camera is displayed. Similarly, if you fly a key, the Squeeze & Tease Position/Crop Menu is displayed.

**Note** — The Touchscreen Display is an option with the Vision 1 and 2 control panels. If you do not have the Touchscreen Display, an LCD monitor with a DVI-D connector is required.

![Figure 5.1 Touchscreen Display for the Vision Switcher](image)

1. Control Buttons

To the left of the upper and lower displays there are three buttons that allow you to navigate the menu system in the adjacent display. These buttons are as follows:

- **HOME** — Press this button to display the Main Menus. Pressing the HOME button next to a display region shows the Main Menu 1-2 in that display region. The other display region remains the same.

- **UP ONE** — Press this button to take the display region next to the button up one level in the menu tree. For example, if you navigate to the Disk Menu and press UP ONE, you will return to the Main Menus. Pressing the UP ONE button next to a display region shows the menus from the next level up the menu tree in that display region.

- **HOLD** — Press this button to lock the displays to the current menus. Pressing the HOLD button locks the upper display region to the current menu. The lower display region remains unlocked. It is still be possible to go down levels of the menu tree, but you are not able to go up past the level at which you pressed the HOLD button.
• **MORE** — This button lights to indicate when it can be used to navigate to additional pages of the current menu in the display region next to it. Pressing the MORE button next to a display region shows the next page of the menu in that display region. A soft More button is also present on the display.

2. **Control Knobs**

   Next to upper and lower display regions there are three knobs that allow you to make menu selection on the adjacent display. Each knob adjusts the menu item that is next to it.

   If the Punchpad functionality is available for a menu item, pressing the knob next to a menu item jumps the value to the nearest 10. If you double-press the knob, the value is defaulted.

   **Operating Tip** — *If you are using a mouse with the switcher, you can hover the mouse over the knob and use the scroll wheel to make adjustments.*

3. **Quick Navigation Buttons**

   The Quick Navigation Buttons allow you to navigate to commonly used menus with a single button press. Refer to the section “Quick Navigation Buttons” on page Eng 5-10 for more information. Additional Quick Navigation Buttons can be accessed by using the Quick Navigation More Button.

4. **Upper Display Region**

   The Upper Display Region is one of the two areas on the touchscreen that contains a menu.

   When you use the Online Help, the text is shown in the upper display region.

5. **Lower Display Region**

   The Lower Display Region is one of the two areas on the touchscreen that contains a menu.

6. **Function Buttons**

   The Function Buttons allow you to select items on the Lower Display Region directly above the physical buttons. Selections on the lower display region are made using either the function buttons, or by using the touchscreen directly.

7. **Quick Navigation More Button**

   The Quick Navigation More Button allow you to cycle through all the sets of Quick Navigation Buttons that are programmed on the switcher.

8. **System Power Button**

   The System Power button allows you to quickly shut down the switcher without having to navigate through the menus. When pressed, you are taken to the System Shutdown Menu. When the switcher is powered on, the button is lit.

9. **Touchscreen Display Power Button**

   This button turns the touchscreen display on or off. The touchscreen display must be on in order to view and interact with the menu system on the switcher.

10. **Frame Fail Indicator**

    The Frame Fail Indicator lights if there is a problem with one of the power supplies or cooling fans in the frame. Refer to the section “Fail Indicators Diagnosis” on page Eng 17-10 for more information.

11. **Panel Fail Indicator**

    The Panel Fail Indicator will light if there is a problem with one of the power supplies in the control panel. Refer to the section “Fail Indicators Diagnosis” on page Eng 17-10 for more information.
12. Touchscreen Adjustment Buttons

The Touchscreen Adjustment Buttons allow you to adjust the characteristics, such as brightness and contrast, of the touchscreen display.
Menu System Basics

The menu system on the Vision switcher allows you to set up the switcher, interface with external equipment, set up and perform complex shots or sequences, and record and edit custom controls.

The menu system is set up with a branching architecture, with the Main Menus as the starting point of all menus. This is the menu that is displayed when you press the HOME button next to a display region. Pressing the HOME button next to a display region shows the Main Menu 1-2 in that display region. The other display region remains the same. If you do not have the Touchscreen Display, you must use the Home Quick Navigation button to navigate to the Main Menu 1-2.

From the Main Menus you can move down the tree by selecting one of the other menus in the Navigation Area, or you can move laterally to additional pages of the menu by pressing the More button. Pressing the More button on a display region displays the Main Menu 2-2 in that display region. The other display region remains the same.

You can tell when there are additional pages to a particular menu by the title of the menu, whether it is page 1-3 or 3-3, and whether the More button is lit or not. If the More button is not grayed out, it indicates that there are additional pages to the current menu that are not displayed.

The touchscreen allows you to show two independent menus at once. By default, the lower region is the main auto-follow menu for the switcher, and the upper region is a user mountable menu. For example, you can mount the Global-Store Menu on the upper region and use the bottom region for normal operation (Figure 5.2). This allows you to manage the Global-Store Menu without having to navigate to the menu every time.

![Figure 5.2 Menus](image)

Every menu on the switcher has the same layout, with a Menu Title, Main Area, Selection Area, and Navigation Area (Figure 5.3).
1. **Back and Forward Buttons**

These buttons allow you to move back and forth between menus you have already navigated to, much like the Forward and Back button on your internet browser. For example, pressing the **Back** button takes you to the last menu that was displayed in that display region. If you press the **Forward** button, you navigate back to the original menu.

2. **Menu Titles**

The menu title gives you both the title of the current menu, as well as the current page and total number of pages of the menu. For example, **Main Menu 1-2** is the first page of the **Main Menu**, and **Main Menu 2-2** is the second, and last, page of the **Main Menu**.

3. **Copy Down and Copy Up Buttons**

These buttons allow you to copy the currently displayed menu from one display region to the other.

4. **Swap Buttons**

These buttons allow you to swap the menus currently displayed between the upper and lower display regions. The menu in the upper display region is displayed in the lower, and the menu in the lower display region is displayed in the upper.

5. **Selection Areas**

The selection area of the menu can contain up to three items that are adjusted using the **Selection Knobs** adjacent to the display. These knobs are where the majority of the selection on the menu system are made. In some cases, these items can be adjusted using the positioner.

If the Punchpad functionality is available for a menu item, pressing the knob next to a menu item jumps the value to the nearest 10. If you double-press the knob, the value is defaulted.

If you hover the mouse pointer over a knob value, the scroll wheel on the mouse can be used to adjust the knob value. The scroll wheel acts as if you are turning the knob.
6. **Main Areas**

The main area of the menu is where the bulk of the information is displayed. This includes helpful tips about using the menu, or information on the current state of the switcher. For example, on the **Main Menu 1-2** the main area provides the software version, whether the control panel is a Master Panel or Satellite Panel, the video format that the switcher is currently operating in, the input reference format, and the status of the Remote Enables and Video Correctors.

7. **Navigation Areas**

The navigation area of the menu contains up to six items that can be either a navigation button to another menu, a toggle for a feature, or display a sub-menu that changes the items in the **Selection Area**.

- **Navigation Buttons** have a down pointing arrow next to the name, indicating that if you select this item you are taken to another menu.
- **Toggle Buttons** have a highlighted item beneath the title, indicating what is currently active. This can be an On versus Off, or one feature versus another. Turning a feature on may also activate different option for the same menu.
- **Option Buttons** will change the items currently available in the **Selection Area**, and the **Main Area**. For example, selecting items in the **Navigation Area** of the **Communications Menu** does not take you to another menu, but changes the items in the **Selection Area**.

**Using the Punchpad**

When you select specific installation and operational menus, **Punchpad Icons** ([ ]) appear next to the **Selection Knobs** (Figure 5.4), indicating that you can press the button next to the **Selection Knobs** to use the Punchpad to enter values.

![Figure 5.4 The Punchpad can be used to make selections on the menu system](image)

When the punchpad icon is present, you can press the button next to the **Selection Knob** to display the Punchpad (Figure 5.5). The Punchpad remains on screen until you close it or you navigate away from the menu. Selecting another option on the menu, or pressing **More** does not close the Punchpad.
1. **New Value Field**

   This field shows the new value for the selected knob. Values can be entered into the Punchpad using the keypad on the Punchpad, a keyboard, or the keypad on the Global Memory Module. Global Memory Number Entry must be turned on to use the keypad to enter values. Refer to the section “**Personality List**” on page Eng 11-2 for information on the Global Memory Number Entry feature.

   New values must be within the range for the selected knob. If the new value is outside the range for the knob the closest valid value is entered instead. For example, if the knob goes from **0.0%** to **100.0%**, and you enter **-0.1%** or **109.0%**, the value entered for the knob will be **0.0%** or **100.0%** respectively.

2. **Keypad**

   The keypad allows you to enter new values for the selected knob. The value appears in the New Value Field. Press **ENTER** on the keypad to use the new value, or **CLR** to clear the new value without changing the current knob value.

   You can close the Punchpad by pressing **ENTER** again without entering another value.

3. **Knob Selection**

   The items in the knob selection area represent the knobs on the menu and their current values. The highlighted item represents the knob that the Punchpad is currently assigned to.

   Only items that can use the Punchpad to enter values appear in the knob selection area.

4. **Copy/Paste Buttons**

   The copy and paste buttons allow you to copy a single, or all, the values for the current knobs and paste them to other knobs. Knob values can be copied between knobs on the same menu, or on different menus, as long as the values are in the same format. A decimal value, such as **25.5%**, cannot be pasted into a field that requires a whole number, such as **2 Frames**.

   To copy a specific knob value, select the knob you want to copy and press **Copy**. The value appears in the Mem: field.

   To copy all knob values, press **Copy All**. The values for each knob appear in the Mem 1:, Mem 2:, and Mem 3: fields.

5. **Default and Close Buttons**

   The **Default** button resets the currently selected knob to the default value. All other knob values remain unchanged. This is the same functionality as double-pressing the knob.

   The **Close Window** button closes the Punchpad.
Using the Positioner with the Menu System

When you select specific installation and operational menus, **Positioner Icons** appear next to the knobs (Figure 5.6) on the lower display region, indicating that moving the positioner in that axis adjusts the selection for that knob. Typically, two or three icons are shown, depending upon the selected menu and function.

When these icons appear, you can adjust the selected function or parameter either with the **Selection Knobs** or with the **Positioner**.

![Figure 5.6](image)

*Figure 5.6 The Positioner can be used to make selections on the menu system*

- When the left-right positioner icon ( ) appears, you can move the Positioner left and right to make adjustments to this value.
- When the up-down positioner icon ( ) appears, you can move the Positioner up and down to make adjustments to this value.
- When the circular positioner icon ( ) appears, you can twist the Positioner knob clockwise and counter-clockwise to make adjustments to this value.

For More Information...
- on using the positioner, refer to the section “**Using the Positioner**” on page Ops 4-37.
Quick Navigation Buttons

The Quick Navigation buttons (Figure 5.7) allow you to control the display region next to the buttons, or navigate to commonly used menus with a single button press. The additional Quick Navigation buttons are displayed by pressing the Next button. Refer to the section “Touchscreen Interface” on page Eng 5-2 for more information on the buttons on the Touchscreen Display.

The Quick Navigation buttons display the menu in the lower display region.

![Quick Navigation Buttons](image)

*Figure 5.7 Quick Navigation Buttons*

The default settings for these buttons are as follows:

**First Tab**

- **Home** — The Home button displays the Main Menu 1-2 on the adjacent display region.
- **UP One** — The Up One button displays the menu up one level in the menu tree.
- **Hold** — The Hold button locks the adjacent display region to the current menu.
- **Next** — The Next button toggles between the first and second tab of Quick Navigation Buttons.

**Second Tab**

- **Install** — The Install button displays the Installation Menus.
- **Pers** — The Pers button displays the Personality Menu.
- **Scheme** — The Color Scheme button displays the Color Scheme Menus. From these menus, you can set the color of the buttons on the control panel, as well as the skin used for the menus.
- **Diags** — The Diag button displays the Panel Diagnostics Menu.
- **Help** — The Help button displays the welcome screen for the Online Help. If you have already accessed the online help, this button will display the help at the same page that it was last viewed. If you hold the Help button, and press another button on the control panel, you can view specific help information on that button, or group of buttons. Refer to the section “Help Features” on page Eng 5-18 for more information on using the help.
• **Aux Bus** — The **Aux Bus** button displays the **Aux Bus Outputs Menus**.

• **DVE** — The **DVE** button displays the **S&T MD Main Menu**. From this menu you can access any of the Squeeze & Tease Menus.

• **CustCtrl** — The **Custom Control** button displays the **Custom Control ShotBox Menus**. From these menus you can run any custom control on the switcher.
Menu Skins

The appearance of the menus, including colors and icons, can be customized by using one of the skins provided with your Vision switcher.

1. Press HOME ➔ Setup ➔ Personality ➔ Color Scheme ➔ More ➔ More ➔ Select Skin.

![Select Monitor Skin Menu](image)

2. Use the Monitor Skin knob (the middle knob) on the Select Monitor Skin Menu to select the skin that you want to use.

3. Press Select This Skin on the Select Monitor Skin Menu to load the selected theme.

For More Information...

- on editing or loading color schemes for your switcher, refer to the section “Control Panel Button Color Schemes” on page Eng 11-17.
Control Panel Mnemonics

The Vision control panel uses mnemonics (Figure 5.8) to indicate the sources or functions that are assigned to buttons. For MLE crosspoint buses, and the custom control bus, the mnemonics indicate the sources that are assigned to each button. For the Keyers, the mnemonics indicate whether a key is on-air, and the current source that is selected for that key.

Crosspoint and custom control button mnemonics can be adjusted for color, font size, and brightness, either globally, or on an individual basis.

![Figure 5.8 Mnemonics on the Vision 2 (4-Keyer Shown)](image)

**Note** — The names that are shown on the mnemonics are those that are assigned to the sources or the custom controls. Function names, such as Global-Store, cannot be changed.

Mnemonics can be adjusted in a number of ways to meet the needs of your environment. These can be global adjustments, such as the contrast, brightness or the default appearance, or they can be specific, allowing you to adjust each crosspoint and custom control mnemonic individually when you name it.

**Default Mnemonic Appearance**

You can adjust the font size, background color and whether or not the displays will show the shifted crosspoint names for the mnemonics. These setting are the default settings that are used by the switcher for all the mnemonics. You can override individual mnemonics when you name BNCs or custom controls. These mnemonics are no longer effected by the default settings.
1. Press **HOME** ⇒ **Setup** ⇒ **Personality** ⇒ **Standard Mnemonics**.

![Standard Mnemonics Assignment Menu](image)

2. Set the size of the font used in the mnemonic displays as follows:
   - Use the **Font** knob to select the size of the font used. You can select between the following:

   **Note** — *If names have more than the maximum number of characters per line, the last characters are dropped.*

   - **Small** — Select this option to use a small black font on a color background in the mnemonics. This size allows you to use 6 characters per line, with 2 lines.
   - **Small Invert** — Select this option to use a small color font on a black background in the mnemonics. This size allows you to use 6 characters per line, with 2 lines.
   - **Medium** — Select this option to use a medium black font on a color background in the mnemonics. This size allows you to use 4 characters per line, with 2 lines.
   - **Medium Invert** — Select this option to use a medium color font on a black background in the mnemonics. This size allows you to use 4 characters per line, with 2 lines.
   - **None** — Select this option to have no text appear in the mnemonic displays.

3. Set the color of the background or text as follows:
   - Use the **Color** knob to select the color you want to assign to the background or text. You can select between the following:

   **Note** — *If you are using an inverted font the color is applied to the text, otherwise it is applied to the background.*

   - **Green** — Select this option to use green as the display color.
   - **Yellow** — Select this option to use yellow as the display color.
   - **Orange** — Select this option to use orange as the display color.
   - **None** — Select this option to not use a color for the display.
4. Set the shifted crosspoint display mode for the mnemonics as follows:

**Operating Tip** — The lower label always shows the name of the input that is considered active. Therefore, the name of the unshifted crosspoint is on the lower label until you press down on the shift key; then the shifted crosspoint becomes the lower label.

- Use the **Xpt Mode** knob to select the display mode you want to use. You can select between the following:
  - **1 Name** — Select this option to show only the names of the crosspoints for the selected bus.
  - **2 Names** — Select this option to show the names of the crosspoints for the selected bus and the names of crosspoints when the bus is in Shift mode.

**Note** — The size of the font is overridden to **Small** or **Small Invert** to allow both names to be shown. Names over 6 characters long drop the last characters to allow the name to fit.

- The example to the left shows the 2 Names feature with the font set to invert.

**For More Information...**
- on setting mnemonic color schemes, refer to the section “Mnemonic Color Schemes” on page Eng 11-21.
Control Panel Displays

The Vision control panel uses small displays (Figure 5.9) to provide you with information on the current state of the switcher, or modules on the switcher. Control Panel Displays are located in each MLE bus, Memory Module, and Positioner Module.

![Figure 5.9 Displays on the Vision 2 (4-Keyer Shown)](image)

The Control Panel Displays can be adjusted in a number of ways to meet the needs of your environment. These adjustments include brightness, contrast, and overall appearance.

For More Information...

- on setting the brightness of the displays, refer to the section “Control Panel Display Brightness” on page Eng 11-23.
Using the Naming Menus

The Naming Menus allow you to enter, or change, the name of video sources, custom control, memories and various other elements on the switcher.

1. Use the BACKSPACE button to clear the current name from the New Name field.

   Operating Tip — If you want to use one of the preset names on the switcher, press Preset Names to display Preset Names Menu. You can then use the knob to highlight the name you want to use and press Select. The new name is shown in the New Name field.

2. Use the letters on the menu, or the keyboard, to enter the name into the New Name field.

3. Use the Font knob to select the font size you want to use. Along with size, you can also select whether you want to name to be displayed as inverted, or reverse color.

4. Use the Color knob to select the color you want to use for the mnemonic.

   Operating Tip — If you want the name on the mnemonic to start at a different position, use the Next Mnm Start Pos and Prev Mnm Start Pos buttons to select how much of the name is displayed.

5. Press Accept New Name to save the mnemonic settings for the name.

If you do not like the new name, you can change it back to the factory default by pressing Default.
Help Features

The Vision switcher provides a complete set of online manuals and a function-specific help system that can be viewed on the Touchscreen Display. In addition to this, an extensive pop-up system is provided to help you quickly and easily diagnose operational problems that may occur.

Online Manuals

A complete set of the Vision Manuals are provided on the switcher and can be viewed on the Touchscreen Display.

1. Press Manuals on the Quick Navigation Bar on the Touchscreen Display. The online manuals (Figure 5.10) are displayed in the Upper Display Region.

![Figure 5.10 Online Manuals](image)

2. Press the Manuals button again to close the help.

Operating Tip — To save a copy of the manuals in PDF format to a USB drive, insert a USB drive into the USB port on the Vision control panel and press HOME ➔ More ➔ Help ➔ Copy Manuals To USB.

Pop-up Help

The Pop-up Help feature is designed to alert you when an illegal function is attempted. When the illegal button, or combination of buttons, is pressed, the Pop-up Help window is displayed. This window provides a brief explanation of why the operation cannot be performed, and a reference number that can be used when contacting Ross Technical support.

![Example of Pop-up Help](image)
Screen Captures

The Vision switcher allows you to take screen captures of the current state of the active menu. Screen captures are stored to your removable USB flash drive.

1. Insert a USB flash drive into the USB port on the Vision control panel.

2. Navigate to the menu you want to capture. The switcher will only capture the active, or last used, menu.

3. Take a screen capture as follows:
   • Press and hold the Store ALL button on the Global Memory Module.
   • Press the FADE RATE button on the Global Memory Module.

4. The control panel beeps and the file is stored to the USB flash drive.
Software Upgrades and Options

In This Chapter

This chapter provides instructions for upgrading system software, as well as verifying and installing various software options.

The following topics are discussed in this chapter:

- Vision Web Interface Account
- Software Upgrade
- System Information Overview
- Installed Options
Vision Web Interface Account

A software upgrade is performed using the QMD/X Web Interface. The QMD/X Web Interface allows you to view the status of the boards, cards and modules installed on the switcher and perform upgrades of the software and hardware packages. Since most of the boards are hot-swappable, it is necessary to constantly monitor which boards, cards and modules are installed, and make sure that their software and hardware versions are current and compatible with the rest of the system. In order to use the QMD/X Web Interface, you will have to setup an account to access the frame from the local sub-net.

The current versions of Internet Explorer, Mozilla, and Netscape are supported. If you have any problems, contact Ross Video Technical Support.

1. On your computer, open your Web Browser and, in the address bar, enter the IP address of your frame and press **Enter**. The **QMD/X Web Interface Splash Screen** is displayed.

2. Enter your username and password as follows when the Login Dialog Box appears. The default **Name** is **user** and **Password** is **password**.

3. Click **Other... ⇒ Admin** to display the **Admin Page**. This page allows you to change the username and password for the frame.

4. Change the username and password for the QMD/X Web Interface account as follows:

   **Note** — **Usernames and Passwords can only contain numbers, letters, dashes, underscores and periods; all other characters are invalid.**

   - Enter the new name for the account in the **New Username** field. This is the name that is used when logging on.
   - Enter the password for the new account in the **New password** field. This is the password that is used when logging on.
   - Re-enter the same password in the **Confirm password** field.
   - Click **Apply Changes** to change the username and password. The next time you access the QMD/X Web Interface, you must use this username and password.
Software Upgrade

The software upgrade procedure allows you to upload a software upgrade package to the switcher from an external computer that is on the same sub-network as the switcher. Once uploaded, the switcher extracts the upgrade information and sends it to the boards, cards, and modules on the switcher that require upgrading. Since most of the boards are hot-swappable, it is necessary to constantly monitor which boards are plugged in, and make sure that their software and hardware versions are current and compatible with the rest of the system.

**Important** — Because the software upgrade process automatically returns the switcher to default values, it is important that you back up all switcher registers to the hard drive or USB flash drive at this point. Refer to the section “Storing and Recalling Files and Setups” on page Eng 13-4 for more information on storing your switcher Setups onto the hard drive or USB flash drive.

Before you can perform the upgrade, you must perform a hard reboot of the switcher to ensure that all components are in a known state. This reboot includes both the control panel and the frame, and must be performed both before and after the upgrade.

**Important** — If you are upgrading to Vision from Synergy, you must upgrade to version 6.0MD or 6.1MD with Synergy before you can upgrade to version 7.1MD or higher with Vision.

Preparing the Switcher Before an Upgrade

Recalling the factory default settings before the upgrade ensures that all the boards, cards, and modules on the switcher are in a known state, and are ready to accept an upgrade. However, the factory default procedure also resets the reference format. You must set the reference back to the input reference that is connected to the switcher, and reboot the switcher before starting the upgrade.

1. Perform a recall of all factory default settings. Refer to the section “Recalling Factory Default Settings” on page Eng 12-27 for information on performing a factory default.
2. Power down all Satellite Panels before the upgrade.
3. Set the reference format back to the input reference that is connected to the switcher. Refer to the section “Reference Setup” on page Eng 4-13 for information on reference setup.
4. Shut down the switcher. Refer to the section “Powering Down the Switcher” on page Eng 4-3 for information on shutting down the switcher.
5. Wait at least 6 seconds for the System Status Indicators to go out.
6. Power up the switcher. Refer to the section “Powering Up the Switcher” on page Eng 4-2 for information on powering up the switcher.

Ensure that the switcher is fully powered up before attempting to perform the upgrade.

Performing the Upgrade

Depending on the number of boards, cards and modules in the switcher, and the current version of software on them, it will take between 15 and 40 minutes to complete the upgrade.
Note — After the Factory Default is performed, the Bus Maps and Output BNC settings have been changed to the default settings. Ensure that you can find a source button that is assigned to a valid input, and that you have a monitor connected to a default Aux Bus output of your switcher. You will need to verify that the switcher is passing video properly after the upgrade.

To upgrade the switcher core, you must log into the QMD/X Web Interface and upload the new software package.

Important — Ensure that the switcher is fully powered up before attempting the upgrade. When the switcher is fully powered up it is able to pass video normally.

1. On your computer, open your Web Browser and, in the address bar, enter the IP address of your frame and press Enter. The QMD/X Web Interface Splash Screen is displayed.

2. Enter your username and password as follows when the Login Dialog Box appears. The default Name is user and Password is password.

Operating Tip — The System Information Page shows a list of all the upgradable components on the boards, cards, and modules installed in the control panel and frame. Refer to the section “System Information Overview” on page Eng 6-7 for more information on this page.

3. Click Upgrade to display the Upgrade Page. The Upgrade Page lists all the previous upgrade packages that were stored on the hard drive of the frame.

Important — Consult a Ross Video Technical Support representative before attempting to revert to a previous version of software. Reverting to a previous version of software may disable certain features or processes that were not present in that previous version of software and cause switcher Setups to not be recalled properly.

4. Revert to a previous software version as follows:
   - Select the software upgrade package that you want to install. The name Vision appears in the Additional File column for upgrade packages that include the Vision control panel software upgrade package.
   - Select Vision as the Panel type.
   - Click Upgrade selected version to install the software version on the switcher.
   - Wait while the switcher installs the software version. This may take a few minutes.
   - When the selected software version has been installed, the System Information Page is displayed.
   - Proceed to Step (6) to complete the procedure.

5. Upload and install a new upgrade package as follows:
   - Enter a name for the upgrade package in the New_Name field. This must be unique and descriptive enough to allow you to easily identify it at a later point. Upgrade package names can only include numbers, letters, and underscores or dashes. Spaces and other symbols are not allowed.
   - Click Browse. A file selection dialog box is displayed.
   - Locate the upgrade package file you want to upload to the switcher on your computer. The file is named mdx-<version>-<build>.tgz.
   - Click Open/Choose to select the file. The file path and name appears in the Select File to Upload field.
• Click **Upgrade Selected Version**. The upgrade package is uploaded to the switcher and verified. The panel file is then requested.

• Click **Browse**. A file selection dialog box is displayed.

• Locate the Vision upgrade package file you want to upload to the switcher on your computer. The file is named `vision-<version>-<build>.tgz`.

• Click **Open/Choose** to select the file. The file path and name will appear in the **Select File to Upload** field. If the switcher is unable to verify that the file is an upgrade package, an error message is displayed.

---

**Note** — The **Check if there are additional Ross supplied files to upload after this one** should only be selected if you are advised to upload an additional file by Ross Video Technical Support.

---

• Click **Add This File** to add the selected file to the software upgrade package.

• Wait while the switcher installs the software version. This may take a few minutes.

• When the software version has been installed, the **Additional Files Page** is displayed.

---

**Note** — If you receive a warning that the upgrade has failed because the flash is full (Rsync failed, is flash full?), check the remaining Application Flash in the Storage Capacity section of the **System Info** page. If the remaining capacity is less than 2M, you must delete a number of FlexDevice drivers to free up space for the upgrade. You can re-install the FlexDevice drivers after the upgrade. Once you have freed up the required space, try the upgrade again.

---

6. Click **Reboot Now** to perform a soft restart of the switcher. This cycles the logs on the switcher and propagates the upgrade to all the boards, cards and modules on the switcher.

---

**Important** — If a message asking you to **Reboot** the control panel appears on the menus of the Touchscreen display, click **Cancel**. You will be rebooting the entire switcher in a later step.

---

7. Allow the switcher to propagate the upgrade to all the boards and cards installed in the frame by waiting at least **20 minutes** before proceeding to the next step.

8. Wait for the **System Information Page** to be displayed.
   - Periodically reload/refresh the **System Information Page** until all the items listed have **Done** as their **Status**.
   - Verify that the switcher is passing video properly by selecting different crosspoints. This ensures that the upgrade has completed. If the switcher is not passing video properly, check the **System Information Page** again to ensure all items are done.

9. If the message “**The software versions of the panel and frame do not match**” is shown, you need to upgrade your panel.
   - Press HOME ⇒ More ⇒ System Shutdown ⇒ Upgrade Panel.

10. If the message “**PMCs need to be upgraded; please go to Panel Modules menu**” is shown, you need to upgrade your PMCs.
    - Press HOME ⇒ Setup ⇒ More ⇒ Panel Modules ⇒ Upgrade PMCs.
Rebooting the Switcher After an Upgrade

Rebooting the switcher after the upgrade ensures that all the boards, cards, and modules on the switcher are properly upgraded and initialized. If a board, card or module was not properly upgraded, the switcher attempts to upgrade and initialize it again with the reboot.

Caution — If the switcher has not finished propagating the upgrade before you proceed to shut-down the switcher, you may damage the switcher.

1. Shut down the switcher. Refer to the section “Powering Down the Switcher” on page Eng 4-3 for information on shutting down the switcher.
2. Wait at least 6 seconds for the System Status Indicators to go out.
3. Power up the switcher. Refer to the section “Powering Up the Switcher” on page Eng 4-2 for information on powering up the switcher.
4. Power on each Satellite Panel, in order, to upgrade it. Ensure that a Satellite Panel is upgraded properly before powering on the next one.

Note — If the message “The software versions of the panel and frame do not match” is shown, you need to upgrade your panel. Press HOME ⇒ More ⇒ System Shutdown ⇒ Upgrade Panel.

You have now completed the upgrade procedure and should now recall any Switcher Setups you stored before the upgrade. Refer to the section “Storing and Recalling Files and Setups” on page Eng 13-4 for more information on recalling Setups.
System Information Overview

The **System Information Page** of the QMD/X Web Interface provides an overview of all the boards, cards, and modules in the frame and control panel of the switcher, as well as their current status. An overview of the current storage capacity of the switcher is also provided.

The **System Information Page** is divided into two regions, the **System Information Region** and the **Storage Capacity Region**.

**System Information Region**

This region provides a list of all the functional components on the boards, cards, and modules in the control panel and frame of the switcher. Components are identified by the board, card or module they are located on, the component on that board, card or module, and the slot the board, card or module is located in. For each of these components, the current version of software that is running on the component, the date of the software build and the current status of the component, is displayed. A more detailed description of each of these columns is provided as follows:

- **Component** — This column identifies every board, card, or module on the control panel or frame of the switcher, as well as all satellite control panels, that has a functional component on it that can be upgraded by the normal upgrade procedure.

- **Function** — This column identifies the function component on the board, card or module installed in the switcher. These functional components can be chips, processors, or applications/processes running on the boards, cards or modules.

- **Slot** — This column identifies the slot on the front or rear of the frame that a particular board is installed in. For cards, this column identifies the board that the card is installed on. Numeric slots (1, 2, 3) are located at the front of the frame, and alphabetic slots (A, B, C) are located at the rear of the frame.

---

**Note** — The information listed on this page is specific to your switcher and the boards, cards, and modules you have installed, and may not appear as shown.
• **Version** — This column specifies the current software version and build number that is running on the component. If a component is running a different software version than the other components on the switcher, this may indicate a problem with that component.

• **Date** — This column specifies the date of the software that is running on the component. This is not the date that the software was upgraded, but the date that the software upgrade was created by Ross Video. This date, along with the version number, helps a Ross Video Technical Support person correctly identify the software you are running.

• **Status** — This column specifies the status of the component upgrade. The possible status for a component is as follows:
  › **Pending** — The component requires upgrading and is in the queue to be upgraded.
  › **In Progress** — The component is being upgraded.
  › **No Status** — The component has not reported a status. The component could be rebooting, or there is a failure. If this message remains on for an extended period of time, contact Ross Video Technical Support.
  › **Failed** — The component is reporting a failure to upgrade. Contact Ross Video Technical Support.
  › **Done** — The component has been upgraded successfully.

### Storage Capacity Region

This region provides a list of all the storage both used and available on the switcher. This includes the hard drive located on the **Frame CPU Board**, as well as the flash memory located on the other boards and cards on the switcher. A more detailed description of each of these columns is provided as follows:

• **Device** — This column identifies the storage device that is being used.
• **Total Size** — This column specifies the total amount of storage, used and unused, on the storage device, measured in Megabytes and Gigabytes.
• **Current Usage** — This column specifies the amount of storage that is currently being used for each storage device.
• **Remaining Capacity** — This column specifies the amount of storage that is remaining for each storage device.
• **Percent Used** — This column specifies the percentage of total size that is currently being used for each storage device.

---

**Note** — If the message **Hard disk log contains errors!** is displayed, contact Ross Video Technical Support for information on diagnosing this warning.
Installed Options

Several menus are available that allow you to verify all of the standard and optional boards and software present in your Vision switcher. The menus also display the serial number, allow you to install additional software options, and store and recall option codes.

For More Information...

- on installing control panel modules, refer to the section “Replacing a Control Panel Module” on page Eng 18-21.

Accessing the Installed Options Menus

The following procedures enable you to navigate through the various installed options menus on the Vision switcher. The menus are provided for information only — no action can be taken. Use the information provided in the following menus to verify which options are currently installed on your frame and panel boards.

Note — You cannot view, install, or manage software options from a Satellite Panel. Only the Master Panel has the Installed Options Menu 2-2, and the Software Options, Enter Serial Number, and Add Options buttons.

Installed Options Menu

1. Press HOME ⇨ Setup ⇨ Installed Options ⇨ Software Options.

2. Use any knob to scroll the list of options.

   - The Option column lists all the options that are available to be installed on the switcher.
   - The Enabled column indicates whether that particular option has been installed (enabled) or not.

Panel Boards Menu

The Panel Boards Menu lists specifications of the Control Panel CPU Module, the current Vision OS (Operating System) version, and the status of the power supplies in the control panel.
1. Press HOME ⇒ Setup ⇒ Installed Options ⇒ Panel Boards.

![Panel Boards — Installed Options Menu 1-2]

2. Use any knob to scroll the list of options.
   - The Board column lists all the boards installed in the control panel, and their current status, as well as any USB devices connected to the panel.

Frame Boards Menu

1. Press HOME ⇒ Setup ⇒ Installed Options ⇒ Frame Boards.

![Frame Boards — Installed Options Menu 1-2]

2. Use any knob to scroll the list of options.
   - The Slot column lists each slot on the frame. The slots at the back of the frame are identified with letters, and the slots at the front of the frame are identified with numbers.
   - The Board column lists each circuit board by name, including any daughter cards that may be installed on that board.
   - The HWRev column lists the hardware revision number of each board and card in the frame.
   - The SWRev column lists the revision number of the software that is currently installed on each board or card in the frame.
   - The BuildInfo column lists the build, or software compile, date of the software that is currently installed on each board or card in the frame.
Installing Serial Numbers

If the label “0000000” appears at the top of the Installed Options Menus, a serial number is required.

1. Press HOME ➔ Setup ➔ Installed Options ➔ Enter Serial Number.

2. Call Ross Video Technical Support at the number listed on the menu.

3. Call Ross Video Technical Support to obtain a serial number for your switcher. Have the following information ready when you contact Ross Video Technical Support:
   • Your Name.
   • The Name of the Facility that the switcher is installed in.
   • The Ross Encrypt Code that is listed on the menu.

4. You are given a numeric code by the Technical Support representative.

5. Enter the code using the keypad in the Global Memory Module.

6. Press ENTER on the keypad, or press Finished on the Enter Serial Number Menu.

Installing Software Options

Use the following procedure to activate your software options (after entering a new serial number) or to install a new software option that you have just purchased:
1. Press HOME Setup ⇒ Installed Options ⇒ Software Options.

![Software Options — Installed Options Menu]

2. Use the middle knob to scroll the list of options. The following options are listed:

- **Audio Server Control** — This option allows you to control an audio server from the Vision switcher.
- **AuxKeys** — The AuxKeys™ option allows you to control an Aux Mixer/Keyer from the Aux Bus. Refer to the section “AuxKeys” on page Eng 8-26 to learn how to set up your AuxKeys option.
- **Character Generator** — This option allows you to control a Character Generator from the Vision switcher.
- **DVE Send and Remote CTRL** — This option allows you to control an external DVE from the Vision switcher.
- **Editor Interface** — This option allows you to use an external editor to control your Vision switcher.
- **Extra Half MLE** — This option allows you to control the bottom Program/Preset MLE on a half MLE switcher. For example, a Vision 2.5 switcher. When you add an MLE to the switcher, the default settings are applied to it, including Bus Maps.
- **Large Audio Mixer** — This option allows you to control a large audio mixer from the Vision switcher.
- **MD DVE Option** — This option allows you to use Squeeze & Tease MD with all the video formats that the switcher supports.
- **MLE X MD Option** — This option allows you to control MLE X on your Vision switcher in both High Definition and Standard Definition video formats; where X is the number of the MLE. When you add an MLE to the switcher, the default settings are applied to it, including Bus Maps.
- **MLE X SD Option** — This option allows you to control MLE X on your Vision switcher in Standard Definition video formats only; where X is the number of the MLE. When you add an MLE to the switcher, the default settings are applied to it, including Bus Maps.
- **Monitor Wall** — This option allows you to control a Monitor Wall from the Vision switcher.
- **MultiDSK** — This option allows you to add additional Downstream Keyers for your Program/Preset MLE. Refer to the section “MultiDSK” on page Eng 8-22 for information on how to set up your MultiDSK option.
- **MultiViewer X** — This option allows you to add a MultiViewer to the switcher, where X is the number of the MultiViewer option.
- **Peripheral Bus II** — This option allows you to control a device using the Pbus interface protocol from the Vision switcher.
• **Proc Amps** — This option allows you to control Processing Amplifiers for every input on the switcher.

• **RGB Color Corrector** — This option allows you to control a floating input-based color corrector.

• **Robotic System** — This option allows you to control a robotic camera from the Vision switcher.

• **Router** — This option allows you to control a router from the Vision switcher.

• **SD DVE Option** — This option allows you to use Squeeze & Tease MD with standard definition video formats.

• **Serial Tally** — This option allows you to control a device using the serial tally protocol from the Vision switcher.

• **Small Audio Mixer** — This option allows you to control a small audio mixer from the Vision switcher.

• **SmartConversion** — This option allows you to create a conversion loop with an external Up/Down converter and have the Vision switcher automatically route the video to the converter and back. Refer to the section “**SmartConversion and Up/Down Converters**” on page Eng 16-1 for information on how to set up a conversion loop.

• **Still Store (Aprisa)** — This option allows you to control an external Still Store from the Vision switcher.

• **Video Server Control** — This option allows you to control a video server from the Vision switcher.

• **VTR Remote Control** — This option allows you to control a VTR from the Vision switcher.

3. Press **Add Option** to display the **Enter Option Number Menu**.

4. Call Ross Video Technical Support to obtain the software option code for the option you want to install. Have the following information ready when you contact Ross Video Technical Support:
   
   • Your Name.
   • The Name of the Facility that the switcher is installed in.
   • The Serial Number of the switcher you want to install the option on.
   • The Name of the Options you want to install on the switcher.

5. You are given a 5-digit numeric code by Ross Video Technical Support. Temporary option codes are only valid for 72 hours, or until the switcher is powered down.
Operating Tip — Store your serial number and option codes in a safe place for future reference.

6. Enter the option code using the keypad in the Global Memory Module.

Important — You must enter all 5 characters, including any leading zeros. Failure to do so may prevent the option from being installed properly.

7. Press ENTER on the keypad, or press Finished on the Enter Serial Number Menu. The Installed Options Menu now indicates the options you have just installed.

Storing and Recalling Option Codes

The following procedures allow you to store and recall your option codes to a storage device.

Note — Only the Master Panel can store and recall option codes to either the hard drive or USB flash drive.

Storing Option Codes

1. Press HOME ⇒ Disk.

2. Select the storage device that you want to store your files to as follows:
   • Use the Disk Type knob to select the storage device you want to store your files on. You can choose between the following:
     ‣ Hard Drive — Select this option to store the option codes to the hard drive.
     ‣ USB — Select this option to store the files to a USB flash drive inserted in the USB port on the control panel.

3. Press HOME ⇒ Setup ⇒ Installed Options ⇒ More.

   ![](image)

   Installed Options Menu 2-2

4. Press Backup Codes To USB/Backup Option Codes to store all of your option codes.

Important — The Delete Selected SW Option and Delete All SW Options commands allow you to delete selected, or all, installed software options. Do not attempt to delete your options unless instructed to by Ross Video Technical Support. Ensure that you have stored your option codes before attempting to delete the options.
Recalling Option Codes

1. Press HOME ⇒ Setup ⇒ Installed Options ⇒ More.
2. Press Recall Option Codes to recall all of your option codes.
Input Source Configuration and Check

In This Chapter

This chapter provides information on configuring and checking the video signals on the input sources of the switcher.

The following topics are discussed in this chapter:

- Naming Input Sources
- Source Configuration Menu Overview
- Assigning Input Source Types
- Assigning Alphas
- Configuring Auto Keys
- Non-Sync Detection
- Assigning Audio Channels to Input Sources
- Creating Bus Maps
- Assigning Panel Bus Maps
- Assigning Tallies to Input Sources
- Assigning GPI Outputs to Input Sources
- Checking Keys

Operating Tip — A Video Input Worksheet is provided to assist you in keeping track of which inputs have been connected to the BNCs. Refer to the section “Video Input Worksheet” on page Eng 21-2 for a copy of this worksheet.
Naming Input Sources

Each video input source to the switcher can be given a specific name that is displayed on the mnemonic for that source. The mnemonics can be further customized for color and font size on an individual basis.

You can assign a source to a UMD Input address to provide the mnemonic names. If an input source is assigned to a UMD Input address, any input source name you enter is replaced with the UMD Input name for all the mnemonics and menus.

Note — If you do not have the mnemonics option installed, or want to use button insert, refer to the section “Button Inserts” on page Eng 3-17 for more information on installing button inserts.

1. Press HOME ⇒ Setup ⇒ Installation ⇒ Source Config ⇒ Source Names.

   ![Source Names Menu](image)

   Source Names Menu

Operating Tip — Refer to the section “Using the Naming Menus” on page Eng 5-17 for more information on using the Source Names Menu to enter a name, or set up the mnemonics for the crosspoint button.

2. Use the Source knob to select the input source you want to name. The default input source numbers correspond to physical BNCs on the rear of the frame.

3. Enter the new name you want to use in the New Name field.

4. Press Accept New Name to assign the name to the source.

5. Press HOME to display the Installation Change Confirmation Screen.

   - Press Confirm to accept the changes and reset all Remote, Peripheral, and Net ports.
   - Press Confirm w/o Reset to accept the changes without resetting all Remote, Peripheral, and Net ports. Only use this if told to do so by Ross Video Technical Support.
   - Press Cancel to exit the menus safely, without making any changes. The system returns to the previously stored settings.

For More Information...

- on connecting video signals to Input BNCs, refer to the section “Video Input Cabling” on page Eng 3-13.
- on setting up individual mnemonics for an Input BNC, refer to the section “Using the Naming Menus” on page Eng 5-17.
Source Configuration Menu Overview

The Source Configuration Menus provide information to assist you in configuring each of the input sources. This information is contained in the status box in the center of the menu and provides the following:

- **Source** — This field indicates the currently selected input source. The input source is identified by the name that it was given, or the default name.

- **Type** — This field indicates the type that the input source is configured as. This field identifies input sources as being connected to a device that is controlled by the switcher, such as a Robotic Camera, or that the source is an Alpha.

- **Tallies** — This field indicates the tally number that is assigned to the input source.

- **Auto Key** — This field indicates whether the current input source is set up for an Auto Select Key or not. If the current input source is set up for an Auto Select Key, this field identifies the Alpha or Video (fill) input source, depending on whether the current input source is the Alpha or Video (fill).

- **Video Mode** — This field indicates the video format the current input source is set to. If the video format of the current input source is different that the format the switcher is operating in, a video format conversion may be required.

- **Physical BNC** — This field indicates the physical input BNC on the back of the switcher that the input source is assigned to. For example, the identification number **C01** indicates it is the first BNC on the Video Input Board installed in Slot C.
Assigning Input Source Types

1. Press HOME ➔ Setup ➔ Installation ➔ Source Config ➔ Input Type.

2. Use the Input knob to select the input source that you want to configure.

3. Use the Physical BNC knob to select the physical BNC that you want to assign the input source to. Physical BNCs that appear gray are on Video Inputs Boards that are not installed.

4. In the Input Type area, select how you want the input source configured. Input types are assigned to the input sources, and not the physical BNC. You can choose between the following:

   - **Off** — Select this option to turn the input source off. Selecting Off removes the input source from other menus.
   - **DVE** — Select this option when a DVE Video (fill) signal is assigned to the selected input source. You must have the DVE Send and Remote Control Software Option in order to control the DVE you are assigning to the selected input source. Contact your Ross Video Representative for more information on purchasing this option.
   - **VTR** — Select this option when a VTR or Video Server, or Audio Server is connected to the selected input source. You must have the VTR Remote Control Software Option in order to control the VTR you are assigning to the selected input source. You may also need the additional Video Server Control Software Option or Audio Server Control Software, depending on the device you are connecting. Contact your Ross Video representative for information on purchasing these options.
   - **Alpha** — Select this option when an alpha, or key, signal is connected to the selected input source. Devices such as Character Generators, Graphics (Paint) Systems, and Still Stores typically provide unique alpha signals.
   - **Router** — Select this option when a routing switcher output is connected to the selected input source. You must have the Routing Switcher Interface Software Option in order to control the Router you are assigning to the selected input source. Contact your Ross Video representative for information on purchasing this option.
   - **Still Store** — Select this option when an external Still-Store is connected to the selected input source. You must have the External Still Store Software Option in order to control the external Still-Store you are assigning to the selected input.

---

**Important** — All input sources must be assigned to Video or Alpha unless the device connected to that input source is controlled by the switcher.
source. Contact your Ross Video representative for information on purchasing this option.

- **Robotic Camera** — Select this option when a robotic camera controller is connected to the selected input source. You must have the **Robotic Camera System Interface Software Option** in order to control the Robotic Camera you are assigning to the selected input source. Contact your Ross Video representative for information on purchasing this option.

- **Char Gen** — Select this option when a Character Generator is connected to the selected input source. You must have the **Character Generator Interface Software Option** installed in order to control the Character Generator you are assigning to the selected input source. Contact your Ross Video representative for information on purchasing this option.

- **Video** — This is the default option. Use this option unless the input is an alpha, or a device listed above.

5. Use the **Video Format** knob to select the format of the input video of the selected input source.

---

**Note** — Assigning a **Video Format** to an **Input** that is different than the native video format that the switcher is operating in, can only be used for passing non-native video formats out an Aux Bus unless you have SmartConversion installed. Refer to the section “**Setting Up a Conversion Loop**” on page Eng 16-2 for information on SmartConversion.

6. Press **HOME** to display the **Installation Change Confirmation Screen**.

- Press **Confirm** to accept the changes and reset all Remote, Peripheral, and Net ports.

- Press **Confirm w/o Reset** to accept the changes without resetting all Remote, Peripheral, and Net ports. Only use this if told to do so by Ross Video Technical Support.

- Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.
Assigning Alphas

The Alpha, or Key, video signal is the component of an Auto Key, or Auto Select Key, that cuts the hole in the background video signal for the Video, or fill, component. This section discusses how to assign a video input as an alpha.

1. Press HOME ⇒ Setup ⇒ Installation ⇒ Source Config ⇒ Input Type.
2. Use the Input knob to select the input source you want to assign as a Key Alpha.
3. In the Input Type area, select Alpha.

Operating Tip — When you select Alpha as the Type, the Auto Key item in the Status Box changes to Alpha, indicating whether the new alpha is Shaped or Unshaped.

4. Use the Video Format knob to select the format of the input video of the selected input source.

Note — Assigning a Video Format to an Input that is different than the native video format that the switcher is operating in, can only be used for passing non-native video formats out an Aux Bus unless the SmartConversion™ option is used. Refer to the section “SmartConversion and Up/Down Converters” on page Eng 16-1 for more information.

5. Press Alpha.

6. Define the alpha as shaped or unshaped as follows:
   - Use the Alpha knob to select the input source you want to configure.
   - Use the Mode knob to select the desired Key Alpha mode. You can choose between the following:

Note — Select Unshaped if you are unsure about which mode to use. Unshaped allows the switcher to match the alpha and fill signals that the source device (such as a CG or still-store) is generating. Refer to the Operation Manual of your device for details on its specific fill and alpha output signals.

   - Unshaped — Select this option to have the switcher perform a multiplicative key. With an Unshaped Key, the Key Alpha cuts a hole based on the gradient values of the alpha. Shades of gray are translated into transparency levels, giving the key a soft edge. Unshaped Key alphas can also be considered true linear alphas. Key alphas are set to unshaped by default.
› **Shaped** — Select this option to have the switcher perform an additive key. With Shaped Keys, the Key Alpha cuts a hole based on the monochrome value of the alpha. Shades of gray are translated into either white or black, giving the key a hard edge. Shaped Key alphas are sometimes used with Character Generators to cut very precise holes for the fill.

7. Press **HOME** to display the **Installation Change Confirmation Screen**.
   - Press **Confirm** to accept the changes and reset all Remote, Peripheral, and Net ports.
   - Press **Confirm w/o Reset** to accept the changes without resetting all Remote, Peripheral, and Net ports. Only use this if told to do so by Ross Video Technical Support.
   - Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.
Configuring Auto Keys

Auto Keys allow you to associate the Alpha (key) and Video (fill) signals of an Auto Select Key so that the key is automatically configured when you select the crosspoint. This association simplifies the keying process on the switcher for outputs from Character Generators or External Still Stores, that generate separate Key and Video signals. When you select a key input source on the crosspoint buses, the alpha and fill are automatically selected.

1. Press HOME ⇒ Setup ⇒ Installation ⇒ Source Config ⇒ Auto Key Setup.

Operating Tip — You can associate one Global-Store, or MLE-Store, channel as the alpha for another Global-Store, or MLE-Store, channel. This means that if you load a still that has alpha information in the file, the switcher uses the associated channel to load the alpha still. Only Global-Store and Global-Store, or MLE-Store and MLE-Store, channels can be used in the auto-key.

2. Use the Source knob to select the input source that you want to use as the Fill for the Auto Key. You can choose between the following:

- **MLE X** — Select this option to select the program output of an MLE as the fill, where “X” represents the number of the MLE.
- **STIL X** — Select this option to select the output of a Global-Store channel as the fill, where “X” represents the number of the channel.
- **MLE ST X** — Select this option to select the output of an MLE-Store channel as the fill, where “X” represents the number of the channel.
- **MLEXCLNY** — Select this option to assign Clean Feed 1 or 2 from an MLE as the fill, where “X” represents the number of the MLE, and “Y” the number of the Clean Feed. This is commonly used when the Clean Feed output is set to Layer mode, or to provide an MLE-Store on a Clean Feed output.
- **BNC** — Select this option to select a video source as the fill.

3. Use the Alpha knob to select the input source that you want to use as the Key Alpha for the Auto Key. You can choose between the following:

- **BLACK** — Select this option for video sources with no associated alpha. This is the default setting.
• **STIL** $X$ — Select this option to assign Global-Store channel to the video source as the alpha, where “$X$” represents the number of the channel.

• **MLE ST** $X$ — Select this option to assign MLE-Store channel to the video source as the alpha, where “$X$” represents the number of the channel.

• **MLEXCLNY** — Select this option to assign CleanFeed 1 or 2 from an MLE to the input source as the alpha, where “$X$” represents the number of the MLE, and “$Y$” the number of the Clean Feed. This is commonly used when the Clean Feed output is set to Layer mode.

• **BNC** — Select this option to assign an input source as the alpha.

4. Press **HOME** to display the **Installation Change Confirmation Screen**.

**Note** — The change is not applied until the key is un-selected and re-selected, or the key type is changed.

- Press **Confirm** to accept the changes and reset all Remote, Peripheral, and Net ports.
- Press **Confirm w/o Reset** to accept the changes without resetting all Remote, Peripheral, and Net ports. Only use this if told to do so by Ross Video Technical Support.
- Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.
Non-Sync Detection

The Non-Sync Detect feature allows you to disable the detection and reporting of non-synchronized video signals. Non-synchronised video signals are either not properly timed, or use a different reference format than the one the switcher is operating in.


2. Use the N/S Detection knob to select how you want to apply the non-sync detection. You can choose between the following:

   - **Individual** — Select this option to turn the Non-Sync Detection feature On or Off for individual physical BNCs.
   - **All On** — Select this option to have all non-synchronized video signals detected.
   - **All Off** — Select this option to not have any non-synchronized video signals detected.

3. Turn the Non-Sync Detection feature On and Off for individual physical BNCs as follows:
   - Use the N/S Control knob to select Individual.
   - Use the Physical BNC knob to select the physical BNC that you want to set the Non-Sync Detection feature for.
   - Use the N/S Detect knob to toggle this feature On or Off.
     - **OFF** — Select this option to not have non-synchronized video signals detected for the selected physical BNC.
     - **ON** — Select this option to have non-synchronized video signals detected for the selected physical BNC. If a non-synchronized video signal is selected on the crosspoint bus, the crosspoint button flashes, indicating that the video signal is mis-timed.

4. Press HOME to display the Installation Change Confirmation Screen.
   - Press Confirm to accept the changes and reset all Remote, Peripheral, and Net ports.
   - Press Confirm w/o Reset to accept the changes without resetting all Remote, Peripheral, and Net ports. Only use this if told to do so by Ross Video Technical Support.

---

**Note** — The N/S Control selection is applied across all physical BNCs. Selecting All On or All Off for any physical BNC is applied to all physical BNCs.
• Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

*For More Information...*

• on the non-sync indicators, refer to the section “**Non-Sync Status**” on page Eng 17-16.
Assigning Audio Channels to Input Sources

Audio channels are assigned to input sources to follow the video signal on and off-air during transitions. This Audio-Follow-Video (AFV) process is the normal interaction of an Audio Mixer and the Vision switcher. You can alter this normal AFV operation at any time by applying an Audio Override.

You can assign up to 2 audio sources to each input source. Each audio source can be a channel, or a group of channels.

1. Press HOME ➔ Setup ➔ Installation ➔ Source Config ➔ Audio.

2. Assign audio channels, or groups, to your Input BNCs as follows:

   **Note** — The total number of audio channels that you have available to assign to the input sources depends on the Audio Mixer Interface option you have, and the number of audio channels your Audio Mixer supports.

   - Use the **Input** knob to select the input source that you want to assign an audio channel to for audio follow video operation. When this input source is taken on-air, the Audio Mixer will bring up the selected audio channels.

   **Note** — If you have programmed Audio Assign Custom Controls, the Audio Channel knobs on the Audio Menu will display the custom control that you assigned the channel to.

   - Use the **Audio 1** knob to select an audio channel, or group, that you want to assign to the selected input source.
   - Use the **Audio 2** knob to select another audio channel, or group, that you want to assign to the selected input source.

3. Press HOME to display the Installation Change Confirmation Screen.

   - Press **Confirm** to accept the changes and reset all Remote, Peripheral, and Net ports.
   - Press **Confirm w/o Reset** to accept the changes without resetting all Remote, Peripheral, and Net ports. Only use this if told to do so by Ross Video Technical Support.
   - Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

Your configured Audio Mixer channels will now follow crosspoint transitions for normal AFV operation.
Creating Bus Maps

The Vision switcher allows you to map any input source to any crosspoint button on the control panel using a **Bus Map**. There are 16 editable Bus Maps available, and a single fixed, default, Bus Map, all of which can be applied to all, or select MLEs as either the primary Bus Map, or as a shifted set of input sources for a bus.

In a MultiPanel configuration, all control panels share the same Bus Maps, but which Bus Maps are assigned to each MLE is specific to the panel. For example, on Satellite Panel 1 you can assign Bus Map 5 to MLE 3. On Satellite Panel 4 you can also assign Bus Map 1 to MLE 3, as long as both panels have MLE 3 assigned to them.

Each editable Bus Map must be assigned input sources for each crosspoint button on the bus, and then assigned to the MLE, or bus, that you want to use it on.

**Operating Tip** — Use the **Bus Map Worksheet** to help identify the input source that you want to assign to the crosspoint buttons for each Bus Map. Refer to the section “**Bus Map Worksheet**” on page Eng 21-6 for a copy of this worksheet.

Editing Bus Maps

Bus Maps define the input source that is assigned to each crosspoint button on a bus.

**Operating Tip** — Unless the Bus Map you are editing is assigned to a panel row on the switcher, you will not see the changes you are making.

1. Press HOME ⇄ Setup ⇄ More ⇄ Bus Maps ⇄ Edit.

2. Use the Map knob to select the Bus Map you want to edit. The default Bus Map cannot be edited.

3. Select the button on the shift level that you want to assign a input source to. Use the middle knob to scroll the list. The button lights on the program bus of all panel rows.
Operating Tip — Press Insert to insert a input source at the selected button and shift the remaining input sources to the right. Press Delete to remove an input source at the selected button and shift the remaining input sources to the left. Press Clear to remove the input source from the selected button and not shift the remaining input sources. None is selected for the cleared buttons and the last button when an input source is removed using the Delete.

4. Use the Source knob to select the input source that you want to assign to the selected crosspoint button. You can choose between the following:

Note — Input sources that are assigned to OFF do not appear in the list. If you want to assign these sources to a crosspoint button, you must assign them to a type.

- **NONE** — Select this option to assign no input source to the selected crosspoint button. When pressed, the button lights, but does not stay lit.
- **BKGD 1** — Select this option to assign Color Background 1 to the selected crosspoint button. When selected on the crosspoint bus, the Mattes Selection Menu for Background Generator 1 is displayed.
- **BKGD 2** — Select this option to assign Color Background 2 to the selected crosspoint button. When selected on the crosspoint bus, the Mattes Selection Menu for Background Generator 2 is displayed.
- **BLCK** — Select this option to assign Black to the selected crosspoint button.

Important — You cannot select a crosspoint button assigned to MLE # on that MLE. For example, you cannot select a crosspoint button assigned to MLE 2 on MLE 2, as this causes a feedback loop.

- **MLE X** — Select this option to assign the Program output of an MLE to the selected crosspoint button, where “X” represents the number of the MLE. This allows you to re-enter an MLE into another MLE.

Operating Tip — By default, the MLE re-entry buttons are already mapped to crosspoint buttons. Refer to the section “Default Input Mapping” on page Eng 3-13 for more information on which button the MLE re-entries are default mapped to.

- **SHFT X** — Select this option to assign the “Shift” function to the selected crosspoint button, where “X” refers to the shift level. You must assign a shift button for each level to the No Shift row to be able to access that shift level. Refer to the section “Shifted Crosspoint Buttons” on page Eng 7-16 for more information on using the SHIFT button.
- **STIL X** — Select this option to assign a Global-Store channel to the selected crosspoint button, where “X” represents the number of the channel.
- **MLE-ST X** — Select this option to assign an MLE-Store channel to the selected crosspoint button, where “X” represents the number of the channel.
- **MLEXCLN Y** — Select this option to assign a Clean Feed output from an MLE to the selected crosspoint button, where “X” represents the number of the MLE and “X” represents the number of the Clean Feed.

Important — On an x.5 MLE switcher, the MLE Clean Feed is not supported. Only the dedicated Output BNCs for the Mix/DSK option can provide a dedicated Clean Feed for the bottom, Program/Preset, MLE.
• **MLE X PVW** — Select this option to assign the Preview output from an MLE to the selected crosspoint button, where “X” represents the number of the MLE.

• **PVW OVL** — Select this option to assign the main Preview output with Overlay to the selected crosspoint button.

**Important** — Selecting the Preview with Overlay on the Preset Bus of the bottom MLE causes a feedback loop. This feedback loop does not apply if you have the Mix/DSK or MultiDSK option installed.

• **Key Cut** — Select this option to assign an AuxKey Cut to the selected crosspoint button. The Key Cut allows you to perform a cut of the AuxKey keyer on the selected Aux Bus.

• **KeyTrans** — Select this option to assign an AuxKey Transition to the selected crosspoint button. The Key Trans allows you to perform a transition of the AuxKey keyer on the selected Aux Bus. Refer to the section “AuxKey Setup” on page Ops 7-28 for information on setting the AuxKey transition rate.

• **BKGDCUT** — Select this option to assign an AuxKey Background Cut to the selected crosspoint button. The BKGDCUT allows you to perform a cut of the AuxKey background on the selected Aux Bus.

• **BKGDTRNS** — Select this option to assign an AuxKey Background Transition to the selected crosspoint button. The BKGDTRANS allows you to perform a transition of the AuxKey background on the selected Aux Bus. Refer to the section “AuxKey Setup” on page Ops 7-28 for information on setting the AuxKey transition rate.

• **K+B CUT** — Select this option to assign an AuxKey Background and Key Cut to the selected crosspoint button. The K+B CUT allows you to perform a cut of the AuxKey background and keyer on the selected Aux Bus.

• **K+B TRNS** — Select this option to assign an AuxKey Background and Key Transition to the selected crosspoint button. The K+B TRNS allows you to perform a transition of the AuxKey background and keyer on the selected Aux Bus. Refer to the section “AuxKey Setup” on page Ops 7-28 for information on setting the AuxKey transition rate.

• **Bus Hold** — Select this option to assign a Bus Hold to the selected crosspoint button. The Bus Hold allows you to have the currently selected source, on the bus that you select the Bus Hold for, not change when a memory recall is performed. This is the same as holding the crosspoint button when performing a memory recall. On an Aux Bus, the Bus Hold toggles the Aux Bus Lock on and off.

• **MVX** — Select this option to assign the output of a MultiViewer to the selected crosspoint button, where “X” represents the number of the MultiViewer.

• **In XXX** — Select the desired input source to assign it to the selected crosspoint button, where “XXX” represents the input designation.

5. Select and assign each of your external inputs. Remember that inputs assigned as Off on the Source Configuration Menu are filtered from this list.

**Operating Tip** — You can use the Assign Maps button on the Edit Bus Maps Menu to navigate to the Assign Bus Maps Menu directly. A confirmation screen is displayed, asking you to confirm your changes.

6. Press HOME to display the Bus Map Change Confirmation Screen.
   - Press Confirm to accept the changes.
• Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

**Bus Map Tips**

Use the following tips and tricks when editing or creating a bus map:

- You can map an input source to more than one crosspoint.
- Associate your primary input sources first, followed by your shifted input sources.
- To save a button, you can assign Global-Store channel 2 to the shifted button of Global-Store channel 1.
- You do not need to assign alpha signals to crosspoint buttons. These signals are used automatically when you select the Video crosspoint of the Auto Key.
- A different Bus Map can be assigned to the same MLE from each control panel.

**Shifted Crosspoint Buttons**

The Shift button assignments, and shifted buses, are all stored in the same Bus Map. Up to 8 Shift functions can be assigned to a single bus map.

The **SHIFT** button only shifts the crosspoint bus that the button is pressed on. All other buses remain unchanged.

1. Press and hold a **SHIFT** button on the crosspoint bus you want to access the shifted crosspoint on. If the Shift Lock feature is on, you can double-press the **SHIFT** button instead of holding it.

   **Note** — If Shift Lock is active on an MLE, the mnemonics for that MLE switch to a two-line format.

2. Press the **Crosspoint** button you want to select.
3. Release both buttons.
4. Both the **Crosspoint** button and **SHIFT** buttons remain lit. If you press another Crosspoint button, an unshifted crosspoint and the **SHIFT** button will not be lit.

**For More Information...**

- on Shift Locking, refer to the section “**Personality List**” on page Eng 11-2.

**Copying Bus Maps**

You can copy a bus map from one bus map location to another. This allows you to organize or group your bus maps together.
1. Press HOME ➔ Setup ➔ More ➔ Bus Maps ➔ Copy Map.

![Copy Bus Maps Menu](image)

2. Use the Copy From knob to select the bus map location you want to copy from.

3. Use the Copy To knob to select the bus map location you want to copy to. Any bus map information in this location will be lost.

4. Press Copy Map to copy the bus map information from the one location to the other.

**Defaulting Bus Maps**

You can reset a single, or all 16 user-defined bus maps on the switcher. This returns the bus map to the default input source assignments.


![Bus Maps Menu](image)

2. Default a single bus map as follows:
   - Use the Map knob to select the Bus Map you want to default.
   - Press Default Map to display the Default Bus Maps Warning Screen.
     - Press Confirm to accept the changes.
     - Press Cancel to not accept the changes. The switcher returns to the previously stored settings.

3. Default all bus maps as follows:
   - Press Default ALL Maps to display the Default ALL Bus Maps Warning Screen.
     - Press Confirm to accept the changes.
Press **Cancel** to not accept the changes. The switcher returns to the previously stored settings.

**For More Information...**

- on connecting video signals to Input BNCs, refer to the section “**Video Input Cabling**” on page Eng 3-13.
- on default crosspoint mapping, refer to the section “**Default Input Mapping**” on page Eng 3-13.
Assigning Panel Bus Maps

Bus Maps can be assigned to the program/preset, key, or utility buses of each MLE, or to each Aux Bus. Bus Maps can be assigned to individual buses, MLEs, Aux Buses, or to the entire panel. Bus Map assignment are control panel specific and do not affect the Bus Map assignments on other control panels.

Bus Map assignments are stored in the switcher personality register.

Important — The OverDrive® Production Control System requires that all buses on your switcher are assigned to the same bus map. OverDrive does not support different bus maps on different buses.

Assigning Panel Bus Maps to Individual Buses

Each bus on the Vision control panel is set to the default Bus Map from the factory. To change what Bus Map is assigned to a bus on your control panel, you must first select the bus you want to assign the new map to and then select the new map. Buses assigned to the same MLE on another control panel are unaffected by bus map assignments.

1. Press HOME ⇒ Setup ⇒ Personality ⇒ Bus Maps ⇒ Assign Bus Map ⇒ Individual Buses.

2. Use the Bus knob to select the MLE and Bus that you want to assign a bus map to. Buses that are not available, or present, on your control panel appear gray, but are still selectable. You can choose between the following:
   - **MLEX Pgm/Pst** — Select this option to assign a bus map to the Program and Preset buses of the selected MLE, where “X” represents the MLE you are selecting.
   - **MLEX Key Y** — Select this option to assign a bus map to the Key bus of the selected MLE, where “X” represents the MLE and “Y” the Keyer.
   - **MLEX Utility** — Select this option to assign a bus map to the Utility bus of the selected MLE, where “X” represents the MLE you are selecting.
   - **MultiDSK Y** — Select this option to assign a bus map to the MultiDSK Key bus, where “Y” represents the keyer.
   - **Bank X Aux Y** — Select this option to assign a bus map to the selected Aux Bus, where “X” represents the Bank and “Y” the Aux you are selecting.
   - **RmtAuxPnl LX** — Select this option to assign a bus map to the Remote Aux Panel(s) connected to the External Link Port X, where “X” is the number of the External Link Port. External Link Port 1 is used for the Touchscreen Display.
• **RmtAuxPnl PX** — Select this option to assign a bus map to the Remote Aux Panel(s) connected to the **Peripheral Port X**, where “X” is the number of the Peripheral Port.

• **Extern Row X** — Select this option to assign a bus map to the Auxiliary Control Panel assigned to the **External Row X**, where “X” is the number of the External row that the Auxiliary Control Panel is assigned to.

3. Use the **Map** knob to select the bus map that you want to assign to the selected bus.

4. Press **Perform Assign** to assign the selected bus map to the bus.

### Assigning Panel Bus Maps to Multiple Buses

Each bus on the Vision control panel is set to the default bus map from the factory. To change what bus map is assigned to the entire control panel, or just the MLEs or Aux Buses on the control panel, you must select the component that you want to assign the new bus map to, and then select the new map. Buses assigned to the same MLEs, or Aux Buses, on another control panel are unaffected by bus map assignments.

1. Press **HOME ⇒ Setup ⇒ Personality ⇒ Bus Maps ⇒ Assign Bus Map**.

   **Operating Tip** — If all the buses on your control panel are not assigned to the same bus map, the **Map** knob on the **Assign Panel Bus Map Menu** will initially be set to **Different**.

2. Assign a bus map to all buses on the control panel as follows:
   - Press **Entire Panel**.

   ![Assign Panel Bus Maps Menu](image)

   **Assign to Entire Control Panel — Assign Bus Maps Menu**

   - Use the **Map** knob to select the bus map you want to assign to the buses.

3. Assign a bus map to all MLEs assigned to the control panel as follows:
   - Press **All MLE Buses**.
   - Use the **Map** knob to select the bus map you want to assign to the buses.

4. Assign a bus map to all aux buses on the control panel as follows:
   - Press **All Aux Buses**.
   - Use the **Map** knob to select the bus map you want to assign to the buses.

5. Press **Perform Assign** to assign the selected bus map to the buses.
Naming Bus Maps

Each Bus Map can be given a specific name that is displayed on the menus when working with bus maps.

1. Press HOME ↦ Setup ↦ More ↦ Bus Maps.
2. Use the Map knob to select the Bus Map you want to change the name for.
3. Press Rename Map.

Operating Tip — Refer to the section “Using the Naming Menus” on page Eng 5-17 for more information on using the Rename Map Menu to enter a name, or set up the mnemonics for the crosspoint button.

4. Enter the new name you want to use in the New Name field.

Operating Tip — You should consult your Bus Map Worksheet and use that as a guide for configuring the Input BNCs. Refer to the section “Bus Map Worksheet” on page Eng 21-6 for a copy of this worksheet.

5. Press Accept New Name to assign the name to the Bus Map.
Assigning Tallies to Input Sources

Each Vision control panel includes at least 36 configurable tally relays, each of which can be assigned to any input source. The Extended Tallies options, if available, provide an additional 36 tallies (allowing for a total of 144 on a Vision 4).

Input sources are assigned to tallies so that only one input source can be assigned to a tally, but the same input source can be assigned to multiple tallies.

In a MultiPanel configuration, if you want the Program MLE of a panel to tally, and it is not the highest numbered MLE, then you must set that MLE to tally on that panel. Tallies are control panel specific.

**Operating Tip** — Use the Tally Number column in the Video Input Worksheet to help identify the tally connections that need to be made. Refer to the section “Video Input Worksheet” on page Eng 21-2 for a copy of this worksheet.

1. Press HOME ➔ Setup ➔ Installation ➔ Source Config ➔ Tally.

2. Use the Tally knob to select the tally that you want to associate an input source to. This tells the switcher logic to close the selected relay circuit when the associated input source forms part of the switcher output (as set by the selection made with the Mode knob).

3. Use the Source knob to select the input source to associate with the tally relay. If you do not want to associate an input source with the tally, select NONE. By default, all input sources are assigned to tallies in ascending order. For example, Tally 1 is associated with BNC C01, Tally 2 is associated with BNC C02.

**Note** — You can only assign a tally relay to one input, but can assign multiple tallies to the same input source.

**Operating Tip** — For wiring convenience, it is recommended that you make your tally associations on a 1:1 basis (i.e. Input C11 assigned to Tally 11).

- Use the Mode knob to select the type of tally to assign to the input source. You can choose between the following:
  - On Air — Select this option to have the selected input source tally when it is on-air.
› **Preview** — Select this option to have the selected input source tally when it is on preview (part of the next transition). Whether the input source is on preview depends on how the **Preview Bus Module** is set.

› **AuxNme(#:#)** — Select the Aux Bus 1:1 through 4:8 that you want to tally when the selected input source is selected on that Aux Bus.

4. Press **HOME** to display the **Installation Change Confirmation Screen**.

   • Press **Confirm** to accept the changes and reset all Remote, Peripheral, and Net ports.

   • Press **Confirm w/o Reset** to accept the changes without resetting all Remote, Peripheral, and Net ports. Only use this if told to do so by Ross Video Technical Support.

   • Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

**For More Information...**

   • on the tally ports, refer to the section “**Tally Ports**” on page Eng 2-18.

   • on the **Preview Bus Module**, refer to the section “**Video Preview**” on page Ops 4-15.
Assigning GPI Outputs to Input Sources

Each GPI Output on the switcher can be assigned to an input source with a preroll time. When Roll Clip is active on the Transition Module, and an input source with an assigned GPI Output is taken on-air, the GPI output is triggered immediately, but the transition is delayed for the Preroll time.

1. Press HOME ➔ Setup ➔ Installation ➔ Source Config ➔ More ➔ More ➔ GPIOs.

2. Use the Input knob to select the input source that you want to assign a GPI Output to.

Note — You can only assign one GPI output to an input source at a time, but you can assign multiple input sources to the same GPI output.

3. Use the GPI Outputs knob to select the GPI output that you want to assign to the selected input source.

4. Use the Preroll knob to select the amount of time between the GPI Output trigger, and the transition, when the Roll Clip button is active in the Transition Module.

5. Press HOME to display the Installation Change Confirmation Screen.
   • Press Confirm to accept the changes and reset all Remote, Peripheral, and Net ports.
   • Press Confirm w/o Reset to accept the changes without resetting all Remote, Peripheral, and Net ports. Only use this if told to do so by Ross Video Technical Support.
   • Press Cancel to exit the menus safely, without making any changes. The system returns to the previously stored settings.

For More Information...
   • on the GPI I/O ports, refer to the section “GPI I/O Port” on page Eng 2-19.
Checking Keys

After you have set up your Auto Keys you should test them to ensure that they display properly. This allows you to verify that each alpha-fill combination is working correctly, and generating a proper Linear Key.

1. Select an input source on the Background (BKGD) Bus of the highest number MLE. This is the background that you place the Auto Select key over.

2. Press the Key 1 select (SEL) button to assign the Keyers Module and Key Bus to Key 1 (Figure 7.1).

Operating Tip — If you are unfamiliar with how to use the Keyers, refer to the section “Keyers Module” on page Ops 7-2.

3. Press the Auto Select button on the Keyers Module to display the key as an Auto Select Key.

4. Select an Auto Key input source on the Key Bus of the MLE. This is the Key that you placed over the Background.

Operating Tip — If you select a crosspoint button that is set up to control an external device, the device control menu for that device is displayed. Press the crosspoint button again to display the Auto Key Setup Menu.

5. Select the Key 1 button in the MLE Transition Module of the bottom MLE. This includes the keyer in the next transition. The key appears on the Preview monitor and the Auto Key Setup Menu is displayed.
6. Visually check the appearance of the Auto Key on the preview monitor. Check for the following:
   - The assigned Alpha input signal should be properly cutting the hole in the background.
   - The selected Video (fill) input signal should be properly filling the hole.
   - The edges of the key should be clean.

7. If the Auto Key does not display correctly, ensure that the proper MLE and Key is being shown, and that the proper Video (fill) and Alpha are selected. Check for the following:
   - The correct MLE and Keyer are shown. If the incorrect MLE or Key is shown, ensure that you have selected Key 1 on the bottom PGM/PST MLE.
   - The correct Key Video (fill) source name and Input BNC are shown. If the Key Video is incorrect, ensure that the desired source has been selected, or that it has been properly assigned to the crosspoint button.
   - The correct Key Alpha source name and Input BNC are shown. If the Key Alpha is incorrect, ensure that the Auto Key has been properly set up.
   - The correct Key Attributes are shown. If the Key Attributes are incorrect, ensure that the Auto Key has been properly set up for Shaped or Unshaped, Clip, Gain, and Transparency.

8. If the Auto Key has the correct input sources, but still does not display correctly, ensure that the key is properly set up for Shaped or Unshaped. Check for the following:
   - If the Auto Key has been set up for Unshaped, but the alpha signal is actually Shaped, you will see black edges around the key.
   - If the Auto Key has been set up for Shaped, but the alpha signal is actually Unshaped, you will see jagged edges and no gradation.

9. If the Auto Key is set up properly, but the edges or shadows of the key, do not display properly, adjust the Clip and Gain. Adjust the Clip and Gain as follows:
   - Select the SEL button for Key 1. This ensures that the Key Attribute buttons are assigned to Key 1.
   - Toggle the KEY MEM button in the Keyer Module to Off (not lit) to allow you to override the Clip and Gain settings of the Auto Key.

```
Clip and Gain Enabled — Auto Key Setup Menu

- Use the Clip and Gain knobs on the Auto Key Setup Menu to adjust the appearance of the Auto Key.
- Press and hold the AUTO SELECT button and press the KEY MEM button to save the new Clip and Gain setting for the Auto Key. The Locked labels re-appear and the Clip and Gain controls are locked at the new settings. The Auto Key uses these settings each time the selected Auto Key is used.
```
For More Information...

- on connecting video inputs, refer to the section “Video Input Cabling” on page Eng 3-13.
- on checking video inputs, refer to the section “Input Verification” on page Eng 4-16.
- on keying, refer to the section “Keying” on page Ops 7-1.
- on checking the Non-Sync status of an input selected on a bus, refer to the section “Non-Sync Status” on page Eng 17-16.
Video Output Configuration and Check

In This Chapter

This chapter provides instructions for configuring and checking the video signals on the Output BNCs of the Vision switcher. As you follow each procedure, you are, in effect, building a database that is used by the switcher to provide the desired names, sources, key and fill associations, and overall switcher functionality.

The following topics are discussed in this chapter:

• Configuring Video Outputs
• Checking Video Outputs
• Clean Feed
• Fade to Black
• MLE Tally
• Ancillary Data
• Switch on Field
• MultiViewer
• Mix/DSK
• MultiDSK
• Mix/DSK and MultiDSK
• AuxKeys

Operating Tip — A Video Output Worksheet is provided to assist you in keeping track of which outputs have been assigned to the BNCs. Refer to the section “Video Output Worksheet” on page Eng 21-9 for a copy of this worksheet.
Configuring Video Outputs

The frame has a number of output BNCs that can be set up as either MLE Program, MLE Preview, MLE Clean Feed, Preview with Overlay, an Aux output or an AuxKey. The configuration of your facility will depend largely on how many Video Output Boards are installed, and which options have been purchased.

The number of Output BNC your switcher has depends on the number of Video Output Boards you have installed in the frame.

This section describes how to assign Output BNCs to the output signals of the switcher, such as MLE Program.

Please note the following when configuring video outputs:

- If you have the Mix/DSK, MultiDSK™ or AuxKeys™ options installed, certain Output BNCs are locked to specific outputs. In some cases, only these Output BNCs can be used for the output of this option.
- If you are setting up the Program output for a control panel that does not have the highest number MLE assigned to it, you must use the MLE X PGM.
- The number of Clean Feed outputs for an MLE (MLE X ClnFd), or the main Clean Feed outputs (Clean Feed), depends on the Key 4 Mode that the MLE is set to. For the main Clean Feed output, it depends on the Key 4 Mode settings for the PGM/PST MLE.
- If you are using Aux Buses to pass non-native video format signals through the switcher, Output BNC C03 and C04 on the QMD/MD frames cannot be used. Output BNC C03 and C04 cannot pass video that is of a format other than what the switcher is operating in.

To Configure your Output BNCs

1. Press HOME ➔ Setup ➔ Installation ➔ Output ➔ Output BNCs.

2. Use the Output knob to select a BNC to assign a type to.

3. Use the Source Group knob to jump to the type of sources on the Source knob list.

4. Use the Source knob to select the video source (Table 8.1) that you want to assign to the Output BNC.

5. Press HOME to display the Installation Change Screen.

6. Accept or reject these changes as follows:
   - Press Confirm to accept the changes and reset all Remote, Peripheral, and Net ports.
• Press **Confirm w/o Reset** to accept the changes without resetting all Remote, Peripheral, and Net ports. Only use this if told to do so by Ross Video Technical Support.

• Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

This completes the procedure for setting your Output BNC types.

**Table 8.1 Video Sources**

<table>
<thead>
<tr>
<th>Source Group</th>
<th>Source</th>
<th>Source Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>System Outputs</strong></td>
<td>Program</td>
<td>Select this option to have the main Program output, the output of the highest number MLE, routed to the selected Output BNC. The Program MLE with the MultiDSK, Half MLE, and Preview Overlay options is the highest number MLE assigned to a control panel in the system.</td>
</tr>
<tr>
<td></td>
<td>Preview</td>
<td>Select this option to have the main Preview output, the preview of the highest number MLE, routed to the selected Output BNC.</td>
</tr>
<tr>
<td></td>
<td>PRV w/ OVL</td>
<td>Select this option to have the main Preview output with Preview Overlay output routed to the selected Output BNC.</td>
</tr>
<tr>
<td></td>
<td>PRV w/o OVL</td>
<td>Select this option to have the main Preview output without Preview Overlay output routed to the selected Output BNC.</td>
</tr>
<tr>
<td><strong>MLE Outputs</strong></td>
<td>MLE X PGM</td>
<td>Select this option to have the Program output of the selected MLE routed to the selected Output BNC, where “X” represents the MLE you are selecting.</td>
</tr>
<tr>
<td></td>
<td>MLE X PRV</td>
<td>Select this option to have the Preview output of the selected MLE routed to the selected Output BNC.</td>
</tr>
<tr>
<td></td>
<td>MLE X LkAhd</td>
<td>Select this option to have the Look Ahead Preview output of the selected MLE routed to the selected Output BNC.</td>
</tr>
<tr>
<td></td>
<td>MLE X ClnFd1(2)</td>
<td>Select this option to have the Clean Feed 1 or Clean Feed 2 output of the selected MLE routed to the selected Output BNC where “X” represents the MLE you are selecting.</td>
</tr>
<tr>
<td><strong>Clean Feeds</strong></td>
<td>Clean Feed 1(2)</td>
<td>Select this option to have the main Clean Feed 1 or Clean Feed 2 output routed to the selected Output BNC.</td>
</tr>
<tr>
<td><strong>MultiViewers</strong></td>
<td>MVXY</td>
<td>Select this option to have the output of a MultiViewer routed to the selected Output BNC, where “X” is the number of the MultiViewer, and “Y” is the head on that MultiViewer.</td>
</tr>
<tr>
<td><strong>Global Stores</strong></td>
<td>GlobalStore X</td>
<td>Select this option to assign the output of the selected Global-Store to the selected Output BNC, where “X” represents the Global-Store channel you are selecting.</td>
</tr>
<tr>
<td><strong>Aux Monitor</strong></td>
<td>Aux Monitor</td>
<td>Select this option to have the Program output of the active Aux Bus routed to the selected Output BNC. When you assign an Aux Bus to a Crosspoint Group, or panel row, the output of that Aux Bus is routed to the Aux Monitor output. This does not apply to the Aux Bus selected by an Auxiliary Control Panel.</td>
</tr>
<tr>
<td><strong>Aux Bus Follows</strong></td>
<td>Aux Bus Outputs 1:1 - 6:8</td>
<td>Select this option to have the source selected on the Aux Bus routed to the Output BNC. You can select between Bank1, Aux1 through Bank6, Aux8.</td>
</tr>
<tr>
<td><strong>Inputs</strong></td>
<td>In XXX</td>
<td>Select this option to have an input source routed directly to an Output BNC, where “X” is the number of the Input BNC.</td>
</tr>
</tbody>
</table>
### Table 8.1 Video Sources

<table>
<thead>
<tr>
<th>Source Group</th>
<th>Source</th>
<th>Source Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MLE Bus Follows</td>
<td>MLE X PGM</td>
<td>Select this option to have the source selected on the Program Bus of the MLE</td>
</tr>
<tr>
<td></td>
<td>MLE X PST</td>
<td>Select this option to have the source selected on the Preview Bus of the MLE</td>
</tr>
<tr>
<td></td>
<td>MLE X KEYY</td>
<td>Select this option to have the video of the source selected on the Key Bus of the MLE routed to the Output BNC, where “X” represents the MLE and “Y” the Key.</td>
</tr>
<tr>
<td></td>
<td>MLE X KEYY Alpha</td>
<td>Select this option to have the alpha of the source selected on the Key Bus of the MLE routed to the Output BNC, where “X” represents the MLE and “Y” the Key.</td>
</tr>
<tr>
<td></td>
<td>MLE X Util1(2)</td>
<td>Select this option to have the video of the source selected on the Utility Bus of the MLE routed to the Output BNC, where “X” represents the MLE.</td>
</tr>
<tr>
<td>MultiDSK Follows</td>
<td>MultiDSKYV</td>
<td>Select this option to have the video of the source selected on the MultiDSK Key routed to the Output BNC, where “Y” represents the Keyer.</td>
</tr>
<tr>
<td></td>
<td>MultiDSKYA</td>
<td>Select this option to have the alpha of the source selected on the MultiDSK Key routed to the Output BNC, where “Y” represents the Keyer.</td>
</tr>
<tr>
<td>Aux Mix Output</td>
<td>(fixed)</td>
<td>These items are fixed to the outputs of the AuxKey assigned to the selected Output BNCs.</td>
</tr>
<tr>
<td>MixMulti Outputs</td>
<td>(fixed)</td>
<td>These items are fixed to the outputs of the Mix/DSK and/or MultiDSKs.</td>
</tr>
</tbody>
</table>

For More Information...
- on default output mapping, or video output cabling, refer to the section “Video Output Cabling” on page Eng 3-15.
- on activating and configuring the MultiDSK option, refer to the section “MultiDSK” on page Eng 8-22.
- on setting up an AuxKey, refer to the section “AuxKeys” on page Eng 8-26.
- on activating and configuring the Mix/DSK option, refer to the section “Mix/DSK” on page Eng 8-19.
- on Key 4 Mode, refer to the section “Key 4 Mode” on page Eng 12-8.
- on setting up a MultiViewer, refer to the section “MultiViewer” on page Eng 8-14.
Checking Video Outputs

Nearly every Output BNC of the Vision switcher can be assigned to any output source, allowing you to assign multiple outputs to a single output signal. After the cable connections to the Output BNCs are completed, and the output signals are assigned to the BNCs, you can check that the proper output signal is being fed out of each Output BNC.

To confirm which output signal is being sent to which Output BNC, use the Aux Bus Outputs Menu 2-2 in conjunction with the Output BNC Verification table (Table 8.2).

Operating Tip — The Aux Bus Outputs Menu 1-2 lists the selected outputs for all the Aux Buses on the switcher.

To Confirm the Outputs on the Output BNCs


2. Press the button corresponding to the Output BNC range that you want to check. The video signal for each of the Output BNC in the selected range is shown on the menu.

This completes the procedure for confirming the outputs on the Output BNCs.

Table 8.2 Output BNC Verification

<table>
<thead>
<tr>
<th>To Verify This Output</th>
<th>Do This...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program</td>
<td>Select different crosspoint buttons on the PGM Bus. Depending on the number of MLEs you have, you may have to assign the Program MLE to a Panel Row on your panel.</td>
</tr>
<tr>
<td>Preview without Overlay</td>
<td>Select different crosspoint buttons on the PV Bus. Depending on the number of MLEs you have, you may have to assign the Preview MLE to a Panel Row on your panel.</td>
</tr>
<tr>
<td>Preview with Overlay</td>
<td>Select Source ID and Safe Title in the Preview Overlay Module to place these elements on the Preview Monitor. Perform the same test as outlined in the Preview without Overlay section.</td>
</tr>
<tr>
<td>Clean Feed</td>
<td>On the half MLE switchers (2.5 MLE for example), or switchers with the MultiDSK™ option installed, the Clean Feed is fixed to specific BNCs. A monitor must be connected to these BNC to test the output. Refer to the section “Configuring Video Outputs” on page Eng 8-2 for more information. Refer to the section “Clean Feed” on page Eng 8-7 for more information on the Clean Feed.</td>
</tr>
</tbody>
</table>
Table 8.2 Output BNC Verification

<table>
<thead>
<tr>
<th>To Verify This Output</th>
<th>Do This...</th>
</tr>
</thead>
<tbody>
<tr>
<td>MLE PGM</td>
<td>Select different crosspoint buttons on the PGM Bus of MLE 1. Repeat for each MLE installed on your switcher.</td>
</tr>
<tr>
<td>MLE PV</td>
<td>Select different crosspoint buttons on the PV Bus of MLE 1. Repeat for each MLE installed on your switcher.</td>
</tr>
<tr>
<td>MLE Clean Feed</td>
<td>Put all Keys on-air with a different source and select each of the Clean Feed positions in turn. As you go from Before Keys to Between Keys X&amp; Y, you will see the keys appear on-air. Repeat for each MLE installed on your switcher.</td>
</tr>
<tr>
<td>MLE LkAhd</td>
<td>Select different crosspoint buttons on the PGM Bus of MLE 1. Re-enter MLE 1 onto the PGM/PST MLE. Select different crosspoints buttons on the PV Bus of MLE 1. Repeat for each MLE installed on your switcher.</td>
</tr>
<tr>
<td>MV&lt;sup&gt;a&lt;/sup&gt;</td>
<td>Connect an monitor to the Output BNC that the MultiViewer is assigned to and load a layout into the MultiViewer. Refer to the section “MultiViewer” on page Eng 8-14 for more information on setting up a MultiViewer.</td>
</tr>
<tr>
<td>Bank&lt;sub&gt;X&lt;/sub&gt;, Aux&lt;sub&gt;Y&lt;/sub&gt; (X:Y)&lt;sup&gt;b&lt;/sup&gt;</td>
<td>Use the MLE SEL Button Menu to assign the Key Bus of an MLE to Bank X, Aux Y.</td>
</tr>
</tbody>
</table>

---

<sup>a</sup> The MultiViewer option must be installed in order to be able to test this output.

<sup>b</sup> Where X represents the number of the Bank, and Y the number of the Aux Bus you want to check.
Clean Feed

The FlexiClean™ feature allows you to create a secondary program output that is taken from a different location in the video layering for the selected MLE. The Clean Feed for each MLE can be configured to take the video signal before any of the keys (Figure 8.1). This does not include the specific Clean Feed outputs provided by the MultiDSK™ or Mix/DSK options.

**Important** — If you have a 4-Keyer MLE, the Clean Feeds that are available to that MLE depend on the Key 4 Mode that you have set up. Always check your Key 4 Mode before using the Clean Feed output in your production. If the active Key 4 Mode does not support one or both Clean Feeds, alternate video will be fed out of the Clean Feed output BNCs.

**Figure 8.1** Clean Feed can be taken from before or between the keys (4-Keyer Shown)

**Note** — If you set up a Clean Feed for the Program/Preset MLE with MultiDSK or Mix/DSK active, only the before Key 1 output is shown, even if before Key 2 is selected.

To set up a Clean Feed Output

1. Press HOME ➔ Setup ➔ Installation ➔ Output ➔ Clean Feed.

2. Use the MLE knob to select the MLE from which the Clean Feed originates.

3. Use the CleanFeed knob to select the Clean Feed output you want to set up.

4. Use the Mode knob to select the video source for the Clean Feed. You can choose between the following:
   - **BeforeKey 1-4** — Select this option to have the Clean Feed output pulled after the program/preset bus of the MLE, but before the keys are added (Figure 8.1).
   - **AfterKey 4** — Select this option to have the Clean Feed output pulled after all the keys. This will be the same and the program output for the MLE.
   - **Layer** — Select this option to have the combined key alphas of the MLE used as the video source for the Clean Feed. This allows you to use the key alphas from one MLE on another MLE, as an alpha for an auto select key for example.
Operating Tip — If you set up an Auto Select key with an MLE program and the Clean Feed in Layer mode for that MLE, you can re-enter an MLE as an Auto Select key on another MLE. You must have all the keyers selected as part of the next transition on the MLE that the keys are set up on.

- **MLEStore 1-4** — Select this option to have an MLE-Store used as the video source for the Clean Feed. This allows you to select the output of an MLE-Store from one MLE on another MLE.

- **ChromaKey1Map** — Select this option to have the chroma key color map or alpha for the first chroma key on the MLE used as the video source for the Clean Feed. The first chroma key on the MLE is the first (lowest number) key on the MLE that is configured as a chroma key.

- **ChromaKey2Map** — Select this option to have the chroma key color map or alpha for the second chroma key on the MLE used as the video source for the Clean Feed. The second chroma key on the MLE is the second key on the MLE that is configured as a chroma key.

5. Press **HOME** to display the Installation Change Screen.
   - Press **Confirm** to accept the changes and reset all Remote, Peripheral, and Net ports.
   - Press **Confirm w/o Reset** to accept the changes without resetting all Remote, Peripheral, and Net ports. Only use this if told to do so by Ross Video Technical Support.
   - Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

For More Information...

- on the Program Bus Clean Feeds for the half MLE switcher, the Mix/DSK options, refer to the section “Mix/DSK” on page Eng 8-19.

- on the Program Bus Clean Feeds for the MultiDSK option, refer to the section “MultiDSK” on page Eng 8-22.

- on setting up an Output BNC for Clean Feed, refer to the section “Configuring Video Outputs” on page Eng 8-2.

- on default output mapping, or video output cabling, refer to the section “Video Output Cabling” on page Eng 3-15.

- on video layering, refer to the section “Video Layering” on page Ops 4-3.

- on Key 4 modes, refer to the section “Key 4 Mode” on page Eng 12-8.

- on setting up an Auto Key, refer to the section “Configuring Auto Keys” on page Eng 7-8.
Fade to Black

Fade to Black allows you to have one or all MLEs fade to black with a single button press. Pressing the button again returns the outputs of the MLEs from black to their previous state.

In an MultiPanel configuration, the fade to black only affects the MLEs that are assigned to the control panel that the fade to black is performed on, and that fade to black is turned on for. Each control panel has a unique fade to black rate, but which MLEs that fade to black is turned on for is common across all control panels.

1. Press **HOME** ➔ **Setup** ➔ **Installation** ➔ **Output** ➔ **Fade To Black**.

   ![Fade To Black Menu](image)

2. Toggle the desired MLEs **On** or **Off**, as required. Setting an MLE to **Off** will not fade the MLE to black when the transition is performed. MLEs that are not installed still show up on the menu. If a MultiViewer is active, the MLE it replaces is grayed out.

3. Press **HOME** to display the **Installation Change Screen**.
   - Press **Confirm** to accept the changes and reset all Remote, Peripheral, and Net ports.
   - Press **Confirm w/o Reset** to accept the changes without resetting all Remote, Peripheral, and Net ports. Only use this if told to do so by Ross Video Technical Support.
   - Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

**For More Information...**
- on using Fade to Black, refer to the section “Fade to Black” on page Ops 4-36.
MLE Tally

The MLE Tally feature allows you to force a selected MLE to always function as if it is on air, regardless of whether or not it is re-entered on the Program/Preset Bus. For example, you may want to send the output of MLE 1 to an external device, such as a VTR, while the Program/Preset bus is on-air. In this configuration, you may want both MLE 1 and the Program/Preset Bus to be tallied. To achieve this, the MLE Tally feature must be used.

In a MultiPanel configuration, the highest number MLE assigned to each panel is tallied as the Program MLE (Always).

To Set Up an MLE Tally

1. Press HOME ➔ Setup ➔ Installation ➔ Output ➔ More ➔ MLE Tally.

   ![MLE Tally Setup — Output Menu 2-2](image)

2. Use the MLE knob to select the MLE for which you want to assign a tally function.

3. Use the Tally knob to select the desired tally function. You can choose between the following:
   - Always — Select this option to tally the selected MLE regardless of what is selected on the highest number MLE. The crosspoint selection will always be lit red, and all sources selected on the MLE will tally accordingly.
   - On Air — Select this option when you want an MLE to be tallied only when it is selected on the highest number MLE.

4. Press HOME to display the Installation Change Screen.
   - Press Confirm to accept the changes and reset all Remote, Peripheral, and Net ports.
   - Press Confirm w/o Reset to accept the changes without resetting all Remote, Peripheral, and Net ports. Only use this if told to do so by Ross Video Technical Support.
   - Press Cancel to exit the menus safely, without making any changes. The system returns to the previously stored settings. 
Ancillary Data

The Ancillary Data setup allows you to select which lines in the vertical and horizontal blanking area (Figure 8.2) can be stripped or passed, as well which line the video image starts on. This allows you to protect and pass information such as embedded audio, or closed captioning, with the video signal.

Field and Frame line numbers depend on the video format the switcher is operating in. If the switcher is operating in a Progressive Scan video format, no even or odd information is displayed.

Ancillary data parameters are set independently for each video format. Changing video formats recalls the last saved parameters for the selected video format.

To Set the Ancillary Data Parameters

1. Press HOME ⇄ Setup ⇄ Installation ⇄ Output ⇄ More ⇄ Ancillary Data.

2. Use the Field (Line) knob to select a particular line across the field, or the entire horizontal blanking region, that you want to adjust the Pass or Strip setting for.

3. Use the Pass/Strip knob to select either Pass or Strip.
   - **Pass** — Select this option to have any information in the selected lines, or the entire horizontal blanking region, remain in with the video signal. Use this setting if there is embedded audio.
   - **Strip** — Select this option to have any information in the selected lines, or the entire horizontal blanking region, stripped from the video signal.

4. Select the field, or line, that the video image starts on as follows:
   - Use the Image Starts knob to select the lines that are the first line of Active Video. If closed captioning is present in the video signal, set the Image Start to the line after the closed captioning line.
Operating Tip — Press **Default Anc Data** on the **Output Menu 2-2** to restore the ancillary data setting to their default values for the current video format.

5. Press **HOME** to display the **Installation Change Screen**.
   - Press **Confirm** to accept the changes and reset all Remote, Peripheral, and Net ports.
   - Press **Confirm w/o Reset** to accept the changes without resetting all Remote, Peripheral, and Net ports. Only use this if told to do so by Ross Video Technical Support.
   - Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.
Switch on Field

The **Switch On** feature allows you to set on which field the switcher will perform a transition in an Interlaced video format. This option is not available if the switcher is operating in a Progressive Scan video format.

To Set which Field a Transition is Performed On

1. Press **HOME ➔ Setup ➔ Installation ➔ Output ➔ More.**
2. Toggle **Switch on** to **F1** or **F2** to select which field a transition is performed on.
   - **F1** — Select **Field 1 (Odd Field)** to have transitions performed after odd field of the source video is drawn. This is the default setting.
   - **F2** — Select **Field 2 (Even Field)** to have transitions performed after the even field of the source video is drawn.
3. Press **HOME** to display the **Installation Change Screen**.
   - Press **Confirm** to accept the changes and reset all Remote, Peripheral, and Net ports.
   - Press **Confirm w/o Reset** to accept the changes without resetting all Remote, Peripheral, and Net ports. Only use this if told to do so by Ross Video Technical Support.
   - Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.
MultiViewer

The MultiViewer™ allows you to view ten video sources from a single output BNC, or have the MultiViewer output routed to an Aux Bus. Any video source on the switcher, including Program, Preview, Media-Store channels, and MLE re-entries, can be assigned to any box on the MultiViewer. All the boxes on the MultiViewer include mnemonic source names and red and green tallies.

**Note** — MultiViewer cannot output a **1080p** video format. If the switcher is operating in this video format, the MultiViewer feature will output **1080i**.

![MultiViewer Layout Example](image)

**Figure 8.3 MultiViewer Layout Example**

MultiViewer Assignment

The MultiViewer options allow you to assign up to two MultiViewers to each Video Processor Board. The resources provided by a Video Processor Board can be assigned to either an MLE or a MultiViewer. The other MLE/MultiViewer on the Video Processor Board is unaffected.

**Note** — When an MLE is assigned as a MultiViewer, or back to an MLE, the Video Processor Board providing the MLE must reboot for the change to take effect.

1. Press HOME ➔ Setup ➔ Installation ➔ More ➔ Video Processor.

![Video Processor Config Menu](image)

2. Press the MLE X/MLE Y button for the Video Processor Board that you want to assign a MultiViewer to.

3. Press the MultiViewer X button for the MLE that you want to assign as a MultiViewer.
4. Press HOME to display the Installation Change Screen.
   • Press Confirm to accept the changes and reset all Remote, Peripheral, and Net ports. All Video Processor Board that changes were made on will reboot.
   • Press Confirm w/o Reset to accept the changes without resetting all Remote, Peripheral, and Net ports. Only use this if told to do so by Ross Video Technical Support. All Video Processor Board that changes were made on will reboot.
   • Press Cancel to exit the menus safely, without making any changes. The system returns to the previously stored settings.

MultiViewer Layouts

Each MultiViewer is assigned a layout that specifies how the boxes are arranged and what source is assigned to each box in the layout. The size and number of boxes in the layout depends on the layout that is selected.

Assigning a Layout to a MultiViewer

1. Press HOME ⇒ Setup ⇒ More ⇒ MultiViewer.

2. Select the Layout XX that you want to assign to a MultiViewer.

3. Select the MultiViewer X that you want to assign a layout to, where X is the number of the MultiViewer.

Editing a MultiViewer Layout

1. Press HOME ⇒ Setup ⇒ More ⇒ MultiViewer.
2. Select the **Layout XX** that you want to edit.
3. Press **Layout Editor → Sources**.

![MultiViewer Layout Editor Menu](image)

4. Select the MultiViewer Source that you want to assign a video source to. These sources are then available to be assigned to boxes on the MultiViewer layout.

5. Use the **Source Group** knob to jump to the type of sources on the **Source** knob list.

6. Use the **Source** knob to select the video source that you want to assign to sources list.

---

**Note** — *Some internal video sources cannot be routed to the MultiViewer directly (using the MLE Bus Follows for example). When this occurs the video is replaced with a “Source Not Supported By MultiViewer” message.*

7. Press **Grid**.

![MultiViewer Layout Editor Menu](image)

8. Use the **MultiViewer** knob to select the head on the MultiViewer that you want to use.

9. Use the **Grid** knob to select the arrangement of the boxes that you want to use.

10. Select the box that you want to assign a video source to.

11. Use the **Source List** knob to select the video source that you want to assign to the box.

12. Configure what is shown on the MultiViewer for the selected box as follows:

   - **Label** — Toggle this button on to show a source label on the box.
   - **Border** — Toggle this button on to show the white border around the box.
   - **4:3/16:9 Marker** — Toggle this button on to show a 4:3 safe area markers on the box.
13. Adjust the transparency of the background behind the source label as follows:
   • Press **Transparency**.
   • Use the **Transparency** knob to adjust the transparency of the source label background.

   **Operating Tip** — *If you don’t want to save your current changes, you can navigate away from the menu or press Cancel Changes.*

14. Press **Save Changes** to save the changes to the edited layout.

**Naming a Layout**

1. Press **HOME** ⇒ **Setup** ⇒ **More** ⇒ **MultiViewer**.

2. Select the **Layout XX** that you want to name.
3. Press **Layout Editor** ⇒ **Layout Name**.

**Operating Tip** — Refer to the section “Using the Naming Menus” on page Eng 5-17 for more information on using the **Change Layout Name Menu** to enter a name.

4. Enter the new name for the layout in the **New Name** field.
5. Press **Accept New Name** on the **Change Layout Name Menu** to store the new name.

*For More Information...*

- on assigning a MultiViewer to an output BNC, refer to the section “**Configuring Video Outputs**” on page Eng 8-2.
Mix/DSK

The Mix/DSK option provides a mixer and two (Mix2K) or four (Mix4K) keyers for the bottom (Program/Preset) MLE in a half MLE switcher. This option must be installed in order to use the Program/Preset MLE on a half MLE switcher, such as a 2.5 QMD-X.

The Mix/DSK feature can only be activated if a Multi-Definition Video Output Board is installed in the following slot of your frame:

- Octane/QMD-X — Slot K
- MD-X — Slot K
- QMD — Slot B
- MD — Slot B

Note — If you also have the MultiDSK option, the assignment of the BNCs on the Video Output Board is different. Refer to the section “Mix/DSK and MultiDSK” on page Eng 8-24 for more information.

The Mix/DSK option assigns and locks certain BNCs on the Video Output Board to the main switcher output video signals (Table 8.3).

### Table 8.3 Mix/DSK Output BNC Assignment

<table>
<thead>
<tr>
<th>BNC</th>
<th>Octane/QMD-X Slot K</th>
<th>MD-X Slot K</th>
<th>QMD Slot B</th>
<th>MD Slot B</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output #01</td>
<td>Program Mix2K</td>
<td>Mix2K</td>
<td>Program</td>
<td>Mix2K</td>
</tr>
<tr>
<td></td>
<td>Program Mix4K</td>
<td>Mix4K</td>
<td>Program</td>
<td>Mix4K</td>
</tr>
<tr>
<td>Output #02</td>
<td>Program Mix2K</td>
<td>Mix2K</td>
<td>Program</td>
<td>Mix2K</td>
</tr>
<tr>
<td></td>
<td>Program Mix4K</td>
<td>Mix4K</td>
<td>Program</td>
<td>Mix4K</td>
</tr>
<tr>
<td>Output #03</td>
<td>Preview Mix2K</td>
<td>Mix2K</td>
<td>Preview</td>
<td>Mix2K</td>
</tr>
<tr>
<td></td>
<td>Preview Mix4K</td>
<td>Mix4K</td>
<td>Preview</td>
<td>Mix4K</td>
</tr>
<tr>
<td>Output #04</td>
<td>Preview Mix2K</td>
<td>Mix2K</td>
<td>Preview</td>
<td>Mix2K</td>
</tr>
<tr>
<td></td>
<td>Preview Mix4K</td>
<td>Mix4K</td>
<td>Preview</td>
<td>Mix4K</td>
</tr>
<tr>
<td>Output #05</td>
<td>Mix Clean 1 Mix2K</td>
<td>Mix Clean 1</td>
<td>Mix Clean 1 Mix2K</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Mix Clean 1 Mix4K</td>
<td>Mix Clean 1</td>
<td>Mix Clean 1 Mix4K</td>
<td></td>
</tr>
<tr>
<td>Output #06</td>
<td>Mix Clean 2 Mix2K</td>
<td>Mix Clean 2</td>
<td>Mix Clean 2 Mix2K</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Mix Clean 2 Mix4K</td>
<td>Mix Clean 2</td>
<td>Mix Clean 2 Mix4K</td>
<td></td>
</tr>
<tr>
<td>Output #07</td>
<td>n/a Mix Clean 3</td>
<td>n/a Mix Clean 3</td>
<td>n/a Mix Clean 3</td>
<td></td>
</tr>
<tr>
<td></td>
<td>n/a Mix Clean 4</td>
<td>n/a Mix Clean 4</td>
<td>n/a Mix Clean 4</td>
<td></td>
</tr>
<tr>
<td>Output #08</td>
<td>n/a Program</td>
<td>n/a Program</td>
<td>n/a Program</td>
<td></td>
</tr>
<tr>
<td></td>
<td>n/a Program</td>
<td>n/a Program</td>
<td>n/a Program</td>
<td></td>
</tr>
<tr>
<td>Output #09</td>
<td>n/a Program</td>
<td>n/a Program</td>
<td>n/a Program</td>
<td></td>
</tr>
<tr>
<td></td>
<td>n/a Program</td>
<td>n/a Program</td>
<td>n/a Program</td>
<td></td>
</tr>
<tr>
<td>Output #10</td>
<td>n/a Program</td>
<td>n/a Program</td>
<td>n/a Program</td>
<td></td>
</tr>
</tbody>
</table>

Operating Tip — Output #07 in a Mix2K system is automatically set to Preview with Overlay when you set up a Mix/DSK. This can be changed later.
Mix/DSK Setup

Setting up the Mix/DSK option activates the Program/Preset MLE on your half MLE switcher, and assign the Output BNC as indicated. The Mix/DSK software option must be installed in order to activate it.

**Note** — Turning this option Off for your half MLE switcher will prevent you from using your Program/Preset MLE. Turning this feature On for a full MLE switcher reverts your full Program/Preset MLE to a half MLE.

1. Press HOME ⇒ Setup ⇒ Installation ⇒ Output ⇒ Mix/DSK MultiDSK.

![Mix/DSK Setup — Output Menu 1-2](image)

2. Use the Mix/Multi knob to turn the Mix/DSK feature on:
   - **Mix2K** — Select this option to activate the half MLE with 2 keyers.
   - **Mix4K** — Select this option to activate the half MLE with 4 keyers.

3. Press HOME to display the Installation Change Confirmation Screen.
   - Press **Confirm** to accept the changes and reset all Remote, Peripheral, and Net ports.
   - Press **Confirm w/o Reset** to accept the changes without resetting all Remote, Peripheral, and Net ports. Only use this if told to do so by Ross Video Technical Support.
   - Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

Mix/DSK Operation

The Mix/DSK option provides a limited Mixer and Keyers to the Program/Preset MLE of your switcher. For the operation of the Program/Preset MLE on a half MLE switcher, the following restrictions apply:

- You can perform **Cuts** and **Dissolves**, but not **Wipes**, **DVE** or **SEQ** effects.
- You can perform **Auto Select Keys** and **Self Keys**, but not **Chroma Keys** or **Preset Pattern Keys**.
- You can perform **Key Invert** effects, but not **Mask**, **Matte Fill** or **Wash** effects.
- The Clean Feeds are locked to before each key (Figure 8.4).
For More Information...

- on performing a factory recall, refer to the section “Factory Default Settings” on page Eng 12-27.
- on using the Mix/DSK MLE, refer to the section “Panel Row” on page Ops 4-5.
- on using Clean Feed outputs, refer to the section “Clean Feed” on page Eng 8-7.
MultiDSK

The MultiDSK™ option provides two (Multi2K) or four (Multi4K) additional Downstream Keyers for your Program/Preset MLE (highest number MLE). The MD/X switchers can only support the Multi2K option.

The MultiDSK feature can only be activated if a Multi-Definition Video Output Board is installed in the following slot in your frame:

- Octane/QMD-X — Slot K
- MD-X — Slot K
- QMD — Slot B
- MD — Slot B

**Note** — If you also have the Mix/DSK option, the assignment of the BNCs on the Video Output Board is different. Refer to the section “Mix/DSK and MultiDSK” on page Eng 8-24 for more information.

The MultiDSK option assigns and locks certain BNCs on the Video Output Board to the main switcher output video signals (Table 8.4).

**Table 8.4 MultiDSK Output BNC Assignment**

<table>
<thead>
<tr>
<th>BNC</th>
<th>Octane/QMD-X</th>
<th>MD-X</th>
<th>QMD</th>
<th>MD</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Slot K</td>
<td>Slot K</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Output #01</td>
<td>Program</td>
<td>Program</td>
<td>Program</td>
<td>Program</td>
</tr>
<tr>
<td>Output #02</td>
<td>Program</td>
<td>Program</td>
<td>Program</td>
<td>Program</td>
</tr>
<tr>
<td>Output #03</td>
<td>Preview</td>
<td>Preview</td>
<td>Preview</td>
<td>Preview</td>
</tr>
<tr>
<td>Output #04</td>
<td>Preview</td>
<td>Preview</td>
<td>Preview</td>
<td>Preview</td>
</tr>
<tr>
<td>Output #05</td>
<td>Multi Clean 5</td>
<td>Multi Clean 5</td>
<td>Multi Clean 5</td>
<td>Multi Clean 5</td>
</tr>
<tr>
<td>Output #06</td>
<td>Multi Clean 6</td>
<td>Multi Clean 6</td>
<td>Multi Clean 4</td>
<td>Multi Clean 4</td>
</tr>
<tr>
<td>Output #07</td>
<td>n/a</td>
<td>Multi Clean 7</td>
<td>Multi Clean 5</td>
<td>Multi Clean 7</td>
</tr>
<tr>
<td>Output #08</td>
<td>n/a</td>
<td>Multi Clean 8</td>
<td>Multi Clean 6</td>
<td>Multi Clean 8</td>
</tr>
<tr>
<td>Output #09</td>
<td>n/a</td>
<td>Program</td>
<td>Program</td>
<td>n/a</td>
</tr>
<tr>
<td>Output #10</td>
<td>n/a</td>
<td>Program</td>
<td>Program</td>
<td>n/a</td>
</tr>
</tbody>
</table>

The Clean Feeds for the MultiDSK option are locked to before each key (Figure 8.5).

**Figure 8.5 Clean Feed for MultiDSK (Multi4K Shown)**
MultiDSK Setup

Setting up the MultiDSK option adds additional Downstream Keyers to the Program/Preset MLE, and assigns the Output BNC as indicated. The MultiDSK software option must be installed in order to activate it.

1. Press HOME ⇒ Setup ⇒ Installation ⇒ Output ⇒ Mix/DSK MultiDSK.

2. Use the Mix/Multi knob on the Output Menu 1-2 to turn the MultiDSK feature on:
   - Multi2K — Select this option to activate the MultiDSK with 2 keyers.
   - Multi4K — Select this option to activate the MultiDSK with 4 keyers.

3. Press HOME to display the Installation Change Confirmation Screen.
   - Press Confirm to accept the changes and reset all Remote, Peripheral, and Net ports.
   - Press Confirm w/o Reset to accept the changes without resetting all Remote, Peripheral, and Net ports. Only use this if told to do so by Ross Video Technical Support.
   - Press Cancel to exit the menus safely, without making any changes. The system returns to the previously stored settings.

For More Information...
- on using the MultiDSK, refer to the section “MultiDSK Operation” on page Ops 7-26.
- on using Clean Feed outputs, refer to the section “Clean Feed” on page Eng 8-7.
Mix/DSK and MultiDSK

If you have the MultiDSK option installed on your half MLE switcher, certain Output BNCs are assigned and locked to the main switcher output video signals (Table 8.5).

### Table 8.5 Mix/DSK and MultiDSK Output BNC Assignment

<table>
<thead>
<tr>
<th>BNC</th>
<th>Octane/QMD-X</th>
<th>MD-X</th>
<th>QMD</th>
<th>MD</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Slot K</td>
<td>Slot K</td>
<td>Slot B</td>
<td>Slot B</td>
</tr>
<tr>
<td>Output #01</td>
<td>Program</td>
<td>Program</td>
<td>Program</td>
<td>Program</td>
</tr>
<tr>
<td>Output #02</td>
<td>Program</td>
<td>Program</td>
<td>Program</td>
<td>Program</td>
</tr>
<tr>
<td>Output #03</td>
<td>Preview</td>
<td>Preview</td>
<td>Preview</td>
<td>Preview</td>
</tr>
<tr>
<td>Output #04</td>
<td>Preview</td>
<td>Preview</td>
<td>Preview</td>
<td>Preview</td>
</tr>
<tr>
<td>Output #05</td>
<td>Mix Clean 1</td>
<td>Mix Clean 1</td>
<td>Mix Clean 1</td>
<td>Mix Clean 1</td>
</tr>
<tr>
<td>Output #06</td>
<td>Mix Clean 2</td>
<td>Mix Clean 2</td>
<td>Mix Clean 2</td>
<td>Mix Clean 2</td>
</tr>
<tr>
<td>Output #07</td>
<td>Multi Clean 3</td>
<td>Multi Clean 3</td>
<td>Multi Clean 3</td>
<td>Multi Clean 3</td>
</tr>
<tr>
<td>Output #08</td>
<td>Multi Clean 4</td>
<td>Multi Clean 4</td>
<td>Multi Clean 4</td>
<td>Multi Clean 4</td>
</tr>
<tr>
<td>Output #09</td>
<td>Program</td>
<td>Program</td>
<td>Program</td>
<td>Program</td>
</tr>
<tr>
<td>Output #10</td>
<td>Program</td>
<td>Program</td>
<td>Program</td>
<td>Program</td>
</tr>
</tbody>
</table>

The Clean Feeds for the Mix/DSK and MultiDSK options are locked to before each key (Figure 8.5).

**Figure 8.6 Clean Feed for Mix/DSK and MultiDSK**

### Mix/DSK and MultiDSK Setup

Setting up the Mix/DSK and MultiDSK options add a limited Mixer and Keyers to the Program/Preset MLE of your switcher with additional Downstream Keyers, and assigns the Output BNC as indicated.
1. Press HOME ⇒ Setup ⇒ Installation ⇒ Output ⇒ Mix/DSK MultiDSK.

![Mix/DSK and MultiDSK Setup — Output Menu 1-2](image)

2. Use the Mix/Multi knob to select Mix2K+Multi2K.

3. Press HOME to display the Installation Change Confirmation Screen.
   - Press Confirm to accept the changes and reset all Remote, Peripheral, and Net ports.
   - Press Confirm w/o Reset to accept the changes without resetting all Remote, Peripheral, and Net ports. Only use this if told to do so by Ross Video Technical Support.
   - Press Cancel to exit the menus safely, without making any changes. The system returns to the previously stored settings.

For More Information...
- on the restrictions of the Mix/DSK option, refer to the section “Mix/DSK Operation” on page Eng 8-20.
- on using the MultiDSK, refer to the section “MultiDSK Keys” on page Ops 7-26.
- on using Clean Feed outputs, refer to the section “Clean Feed” on page Eng 8-7.
**AuxKeys**

The AuxKeys™ option can be used as either an A/B Mixer (Mix between two Aux Buses) or a Mixer/Keyer (Mix and Auto Select Key). Switcher outputs are assigned to AuxKeys in groups of four. Mix or Key operations can be previewed and Clean Feed is also available, similar to a standard MLE.

**Important** — **AuxKeys** cannot be used to pass or manipulate non-native video format signals. If you are using an Aux Bus as a video pass-through for a non-native video format signal, you cannot apply AuxKeys to that Aux Bus.

The AuxKeys option allows you to assign and lock certain BNCs on the Video Output Board to the main switcher outputs. The BNCs on each Video Output Board are separated into groups of 4. Assigning one of these groups to either Aux Keys or Aux Mix/Keys locks the first few BNCs in that group, depending on which option you select.

The AuxKey feature can only be activated on a Multi-Definition Video Output Board.

An example of possible Output BNC assignments are as follows:

**Aux Mixer Example**

- **Output #K09** — This output is locked to **Aux Program**.
- **Output #K10** — This output is locked to **Aux Preview**.

**Aux Mix/Keyer Example**

- **Output #K09** — This output is locked to **Aux Program**.
- **Output #K10** — This output is locked to **Aux Program**.
- **Output #K11** — This output is locked to **Aux Preview**.
- **Output #K12** — This output is locked to **Aux Clean Feed**.

**AuxKeys Setup**

Setting up the AuxKey option adds an Aux Mixer, or Aux Mixer/Keyer to the selected Aux Bus, and assign the Output BNCs as indicated. The AuxKey software option must be installed in order to activate it.

**Note** — The AuxKeys outputs are only available to the Output BNCs that you assign them to and cannot be routed to the main switcher output internally. Refer to the section “**AuxKey Pre Mixer/Keyer**” on page Eng 8-28 for information on re-entering an AuxKey externally to the switcher.
1. Press HOME ➔ Setup ➔ Installation ➔ Output ➔ Output Boards.

![Output Boards — Output Menu 1-2](image)

2. Activate the AuxKeys option as follows:
   - Use the Output Group knob to select the group of 4 BNCs that you want to assign to the Aux Mixer or Aux Mixer/Keyer. Output BNCs on Video Output Boards that are not installed on the frame appear gray.
   - Use the Configuration knob to select the AuxKey configuration you want. You can choose between the following:
     - Outputs — Select this option to assign the selected output group as standard outputs. This frees up the output group to allow you to assign standard switcher outputs to all the BNCs in the group.
     - Aux Mix — Select this option to assign the selected output group as an Aux Mixer. This will allow you to perform Background dissolves in the aux bus.
     - Aux Mix/Key — Select this option to assign the selected output group as an Aux Mixer/Keyer. This allows you to perform Background and Key 1 dissolves in the aux bus.
     - Aux Mix/Pre — Select this option to assign the selected output group as an Aux Mixer/Keyer that is re-entered into the switcher. This allows you to perform Background and Key 1 dissolves in the aux bus and have them properly timed to be available as a source for the rest of the switcher.

3. Press AuxKey Configure.

![AuxKey Configure — Output Menu 1-2](image)

- Use the Aux Keyer knob to select the AuxKey that you want to set up.
- Use the Bus knob to select the bus that you want to assign to an output. You can choose between the following:
> **Background** — Select this option to have the video signal selected on the Background bus of the AuxKey fed out the selected Aux Bus.

> **Preset** — Select this option to have the video signal selected on the Preset bus of the AuxKey fed out the selected Aux Bus.

> **Key** — Select this option to have the video signal selected on the Keyer bus of the AuxKey fed out the selected Aux Bus.

- Use the **Aux Bus** knob to select the Aux Bus output that you want to assign to the selected output. The sources selected on the corresponding bus is fed out of the selected Aux Bus, and does interfere with the dedicated AuxKey output.

---

### Operating Tip

*If you select different sources on an Aux Bus assigned to the Background, Preset, or Key Bus of the AuxKey, the new source is selected on the corresponding bus of the AuxKey, without having to assign the Crosspoint Group to an AuxKey.*

---

4. Press **HOME** to display the **Installation Change Confirmation Screen**.

- Press **Confirm** to accept the changes and reset all Remote, Peripheral, and Net ports.

- Press **Confirm w/o Reset** to accept the changes without resetting all Remote, Peripheral, and Net ports. Only use this if told to do so by Ross Video Technical Support.

- Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

---

**AuxKey Pre Mixer/Keyer**

This section describes how to cable and set up an AuxKey Pre Mixer/Keyer. This allows you to assign an Aux Mixer/Keyer that is re-entered into the switcher. The Vision switcher automatically handles any timing issues.

---

### Important

*The Pre Mixer/Keyer option can only correct the timing for a single pass through the switcher. Do not attempt to re-enter AuxKeys as sources on an AuxKey that you intend to re-enter on an MLE. For example, **AuxKey Pre Mixer/Keyer 1** is re-entered into **AuxKey Pre Mixer/Keyer 2** that is re-entered into MLE 1.*

---

An AuxKey Pre Mixer/Keyer is re-entered into the switcher by physically connecting a BNC cable from the dedicated output BNCs of the AuxKey, to the available input BNCs (**Figure 8.7**). For example, if the AuxKey Pre Mixer/Keyer is assigned to output group **#K09-K12**, the BNC cables are connected from those output BNCs to 3 input BNCs. When the input BNCs are selected on the crosspoint bus, the properly timed output of the AuxKey is shown.
For More Information...

- on setting up an Aux Bus, refer to the section “Aux Bus Setup” on page Eng 12-2.
- on setting up an Aux Panel, refer to the section “Auxiliary Panels” on page Eng 14-1.
- on selecting sources, refer to the section “Panel Row” on page Ops 4-5.
Basic Communications Setup

In This Chapter

This chapter provides general information on installing and initializing FlexDevice™ drivers, and setting up communication with peripheral equipment. For complete information on setting up a specific class of device, refer to the Ross Video External Device Setup Sheet for your particular device.

The following topics are discussed in this chapter:

- Communications Overview
- Installing and Managing FlexDevice Drivers
- Setting Up Communications
- Port Expanders
- External Panel Modules
- Custom Devices
- Extra Options

Operating Tip — A Communications Port Worksheet is provided to assist you in keeping track of which peripheral devices have been connected to which communications ports. Refer to the section "Communications Worksheet" on page Eng 21-11 for a copy of this worksheet.
Communications Overview

The Vision switcher can interface with a number of peripheral devices, such as video servers, audio mixers, routers, character generators, and robotic cameras. These devices interface with the switcher using either serial or ethernet communication. Devices that use serial communication and can be connected to either the control panel or the frame. Ethernet devices must be connected to the same network as the switcher.

Device Drivers

Devices are connected to the switcher using either the built-in device drivers or individual FlexDevice™ drivers. Refer to the Ross Video External Device Setup Sheet for your device for information on which interface must be used with your device.

**Note** — Do not mix different drivers (built-in and FlexDevice driver, or different versions of FlexDevice or built-in drivers) when connecting to the same device. Doing so may cause unexpected control errors.

Individual FlexDevice drivers are uploaded to the switcher using the QMD/X Web Interface. Once a driver has been uploaded to the switcher, an instance of that driver is initialized and assigned to the port that the device is connected to. A single instance of a FlexDevice driver controls a single device. If you are connecting multiple devices of the same type to the switcher, you must activate multiple instances of that driver.

*For More Information...*
- on installing a FlexDevice driver, refer to the section “Installing and Managing FlexDevice Drivers” on page Eng 9-4.

Control Panel Serial Communications Ports

Peripheral equipment connected to the control panel, using a serial transmission standard, use the **8 Remote** ports located on the back of the Master Panel (Figure 9.1). These ports are set up for communication with the device from the control panel using the menu system on the switcher.

![Figure 9.1 Vision 4 Control Panel — Serial Communications (Remote) Ports](image)

Frame Serial Communications Ports

Peripheral equipment connected to the frame, using a serial transmission standard, use the **4 Peripheral** ports located on the CPU Board at the back of the frame (Figure 9.2). These ports are set up for communication with the device from the control panel using the menu system.
Ethernet Communications

The following section presents a brief overview of the ethernet connection process. The exact steps taken in connecting your peripheral equipment and the Vision switcher via an ethernet network depends on the network topology of your facility.

1. Connect the device to the same subnet as your Vision switcher or to a network that has a route to the network your switcher is on. Make a note of the IP Address and Port Number of your device as this information is required when configuring the communication settings on your Vision switcher.
   - Network topologies vary greatly between facilities. Contact your IT Department for assistance in connecting your device to the appropriate network at your location.
   - Refer to the documentation that came with your device for instructions on connecting it to your network.

2. Configure the ethernet settings on your device to communicate with the Vision switcher.

For More Information...

- on the pinouts of the Remote ports, refer to the section “Control Panel Pinouts” on page Eng 20-21.
- on the pinouts of the Peripheral ports, refer to the section “Frame Pinouts” on page Eng 20-17.
Installing and Managing FlexDevice Drivers

FlexDevice drivers are individually installed onto the switcher using the QMD/X Web Interface. Once the driver has been installed onto the switcher, you must initialize an instance of the FlexDevice driver for each device you want to control from the switcher.

**Note** — Not all external devices are currently supported by FlexDevice drivers. Refer to the Ross Video External Device Setup Sheet for your device for information on whether there is a FlexDevice driver for your device.

---

## Installing FlexDevice Drivers

1. On your computer, open your Web Browser and, in the address bar, enter the IP address of your frame and press **Enter**. The **QMD/X Web Interface Splash Screen** is displayed.

2. Enter your username and password as follows when the **Login Dialog Box** appears. The default **Name** is **user** and **Password** is **password**.

3. Click **Other...** ➔ **FlexDevices** to display the **FlexDevices Page**. The **FlexDevices Page** lists all the FlexDevice drivers that are installed on the switcher, their version, and status. If a driver is not compatible with the current version of switcher software, the status will be Obsolete (**OBSOL**) or Unsupported (**UNSUPP**) (Table 9.1).

4. Click **Browse**. A file selection dialog box is displayed.

5. Locate the FlexDevice driver file you want to upload to the switcher on your computer. The file is named `<device>-<version>.tar.gz`.

6. Click **Open/Choose** to select the file. The file path and name appears in the **FlexDevice Driver to Upload** field.

7. Click **Install Driver** to upload and install the selected driver to the switcher.

Next, you must initialize an instance of the driver to be able to assign it to a port.

---

### Table 9.1 FlexDevice Driver Status

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OK</td>
<td>The driver is fully compatible with the switcher software.</td>
</tr>
<tr>
<td>OBSOL</td>
<td>The driver is outdated and a new driver should be downloaded.</td>
</tr>
<tr>
<td>UNSUPP</td>
<td>The driver has not been tested with the current version of switcher software. Please contact Ross Video Technical Support.</td>
</tr>
</tbody>
</table>
Initializing FlexDevice Drivers

1. Press HOME ➔ Setup ➔ Installation ➔ Com Setup ➔ More ➔ Flex Devices.

2. Press Start Driver.

3. Use the Interface knob to select the control panel or frame that you want to initialize the FlexDevice driver on. For example, if you want to control the device from a serial port on the back of the Master Vision control panel, you must select Panel0.

4. Use the Type knob to select the type, or class, of driver you want to initialize.

5. Use the Driver knob to select the driver that you want to initialize an instance of. If the driver you want to initialize does not appear on the menu, ensure that the driver has been installed.

6. Press Accept to initialize an instance of the selected FlexDevice driver. You must initialize a separate instance of a driver for each device you want to control from the switcher.

With an instance of the driver initialized, you must set the driver up for the port you have the device connected to. Refer to the section “Setting Up Communications” on page Eng 9-7 for information on setting up communications.

Stopping FlexDevice Drivers

Before you can stop a FlexDevice driver, the instance of the driver that you want to stop cannot be assigned to a port.

1. Press HOME ➔ Setup ➔ Installation ➔ Com Setup ➔ More ➔ Flex Devices.
2. Press Stop Driver.
3. Use the Interface knob to select the control panel or frame that the FlexDevice driver you want to stop is running on.
4. Use the Type knob to select the type of driver you want to stop.
5. Use the Driver knob to select the driver that you want to stop an instance of.
6. Press Accept to stop the selected instance of the FlexDevice driver.

Deleting FlexDevice Drivers

Before you can delete a FlexDevice driver, all instances of that driver must be stopped.

1. Press HOME ➔ Setup ➔ Installation ➔ Com Setup ➔ More ➔ Flex Devices.

![Delete Driver — FlexDevices Menu]

2. Press Delete Driver.
3. Use the Interface knob to select the control Panel0.
4. Use the Type knob to select the type of driver you want to delete.
5. Use the Driver knob to select the driver that you want to delete.
6. Press Accept to delete the selected FlexDevice driver.
Setting Up Communications

External device communication is set up from the Communications Menu. This menu allows you to initialize an instance of a FlexDevice driver, select the communications port that a device is connected, or assigned to, the type of device it is, the transmission standard that is used, and the communications protocol.

For specific information on setting up a particular external device with the Vision switcher, refer to the Ross Video External Device Setup Sheet for your device.

Setting Up Serial Communications

Note — The status column on the Communications Menu indicates the current compatibility status of each driver installed on the switcher. If a driver is listed as Obsolete or Unsupported, download a new driver from the Ross Video web site. If a driver is listed as Missing or Broken, contact Ross Video Technical Support.

1. Press HOME ⇒ Setup ⇒ Installation ⇒ Com Setup ⇒ Type.

   ![Communications Menu](image)

   Device Type — Communications Menu 1-2

2. Assign a device to a communications port as follows:
   - Use the Com Port knob to select the communications port that you are connecting the device to. You can choose between the following:
     - REMOTE (R1-R8) — Select this option if you are connecting a device to a Remote port on the back of a Vision control panel.
     - Note — Only the Remote ports on the back of the Master Panel can be used to connect to external devices at this time.
     - ExtLnk (L2-L4) — Select this option if you are connecting a device to an External Link port on the back of a Vision control panel.
     - PERIPH (P1-P4) — Select this option if you are connecting a device to a Peripheral port on the back of the frame.
   - Use the Device knob to select the device you are connecting to the select port. If the device you are connecting to the switcher uses a FlexDevice driver, the device type is proceeded by Flex. For example, FlexCAM for Robotic Cameras.

3. Press Select Device.
4. Select the driver you want to assign to the communications port as follows:
   • Use the **Device** knob to select the FlexDevice driver, or communications protocol, you are using. If a message stating that the FlexDevice driver is missing or damaged is displayed, you must re-install the driver.

   **Note** — If you are connecting a VTR or Video Server, use the **VTR Preroll** knob on the *Communications Menu 1-2* to select the pre-roll interval, in frames, for your specific Video Server.

5. Press **Com Type**.

6. Select the type of communication that is used to communicate with your device as follows:
   • Use the **Type** knob to select the type of communications for the selected communications port. You can choose between the following:
     › **RS-232** — Select this option if your device is connected to a remote port or peripheral port and uses the RS-232 (TIA/EIA-232) transmission standard.
     › **RS-422** — Select this option if your device is connected to a remote port or peripheral port and uses the RS-422 (TIA/EIA-422) transmission standard.
     › **RS-422 Null** — Select this option if your device is connected to a remote port or peripheral port and uses the RS-422 (TIA/EIA-422) transmission standard. This option changes the signals on the pinouts of the port for use with a null modem cable.

7. Press **Com Settings**.
8. Set the communications protocols for the serial device as follows:
   - Use the Baud knob to select the baud rate for communicating with your device.
   - Use the Parity knob to select the parity for communicating with your device.

   **Operating Tip** — If you are creating a custom device protocol, refer to the section “Custom Devices” on page Eng 9-21 for information on creating the protocol.

9. Press Extra Options. Some classes of devices support extra options that must be set. Refer to the Ross Video External Device Setup Sheet for your particular device for more information.

   **Note** — If you are setting up a Monitor Wall, you must set the IP Address and Port Number of the Monitor Wall device. If you are not setting up a Monitor Wall, proceed to Step (12.).


11. Select the IP address of the monitor wall device you want to control as follows:
   - Use the Monitor Wall knob to select the specific monitor wall connected to the dispatcher computer that you want to control.
   - In the IP Address field, enter the IP Address of the specific monitor wall you want to control from the selected communications port.
   - In the Port Number field, enter the port number of the monitor wall you want to control.

12. Press HOME to display the Installation Change Confirmation Screen.
• Press **Confirm** to accept the changes and reset all Remote, Peripheral, and Net ports.
• Press **Confirm w/o Reset** to accept the changes without resetting all Remote, Peripheral, and Net ports. Only use this if told to do so by Ross Video Technical Support.
• Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

### Setting Up Ethernet Communications

**Note** — The status column on the **Communications Menu** indicates the current compatibility status of each driver installed on the switcher. If a driver is listed as **Obsolete** or **Unsupported**, download a new driver from the Ross Video web site. If a driver is listed as **Missing** or **Broken**, contact Ross Video Technical Support.

1. **Press HOME ↦ Setup ↦ Installation ↦ Com Setup ↦ Type.**

   ![Communications Menu 1-2](image)

   **Device Type — Communications Menu 1-2**

2. **Assign a device to a communications port as follows:**
   - Use the **Com Port** knob to select the communications port that you are connecting the device to. You can choose between the following:
     - **REMOTE (R1-R8)** — Select this option if you are assigning a device to a Remote port on the back of a Vision control panel.
     - **PERIPH (P1-P4)** — Select this option if you are assigning a device to a Peripheral port on the back of the frame.
     - **NET (N1-N8)** — Select this option if you are assigning a device to the switcher through a network port.
   - Use the **Device** knob to select the device you are assigning to the select port. If the device you are connecting to the switcher uses a FlexDevice driver, the device type is proceeded by Flex. For example, FlexCAM for Robotic Cameras.

3. **Press Select Device.**
4. Select the driver you want to assign to the communications port as follows:
   - Use the **Device** knob to select the FlexDevice driver, or communications protocol you are using.

   **Note** — If you are connecting a VTR or Video Server, use the **VTR Preroll** knob on the **Communications Menu 1-2** to select the pre-roll interval, in frames, for your specific Video Server.

5. Press **Com Type**.

6. Select the type of communication that is used to communicate with your device as follows:
   - Use the **Type** knob to select the type of communications for the selected communications port. You can choose between the following:
     - **Network UDP** — Select this option if your device is connected to the switcher through a network and uses the UDP/IP transmission standard.
     - **Network TCP** — Select this option if your device is connected to the switcher through a network and uses the TCP/IP transmission standard.

7. Press **Com Settings**.
8. Use the **Client/Server** knob to select whether the switcher should act as a client or server. Enter the port settings as follows:

- **Client** — Select this option if the switcher should act as the client when communicating with the device. Enter the settings for the switcher as follows:
  - In the **Remote IP Address** field, enter the IP address of the external device.
  - In the **Remote Port** field, enter the port on the external device that the switcher must connect to.

- **Server** — Select this option if the switcher should act as the server when communicating with the device. Enter the settings for the switcher as follows:
  - In the **Local IP Address** list, select the IP address of the switcher that you want to use to connect with the external device.
  - In the **Local Port** field, enter the port on the switcher that the external device must connect to.

**Note** — Do not change the **Local Port** value unless instructed to do so by Ross Video Technical Support.

9. Press **HOME** to display the **Installation Change Confirmation Screen**.

- Press **Confirm** to accept the changes and reset all Remote, Peripheral, and Net ports.
- Press **Confirm w/o Reset** to accept the changes without resetting all Remote, Peripheral, and Net ports. Only use this if told to do so by Ross Video Technical Support.
- Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.
Port Expanders

Port Expanders allow you to increase the number of external devices that can be connected to the switcher. Port Expanders can be connected to one of the remote ports on the back of a Vision control panel, or connected as an ethernet device, depending on the Port Expander you have.

The Vision switcher supports communications with a number of Port Expanders. The following devices are currently supported by your Vision switcher (Table 9.2).

### Table 9.2 Supported Port Expanders

<table>
<thead>
<tr>
<th>Port Expander</th>
<th>Com</th>
<th>Protocol (Device)</th>
<th>Software Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>RS-422 Four Port Buffered Smart Switch</td>
<td>RS-422</td>
<td>BSS4</td>
<td>n/a</td>
</tr>
<tr>
<td>(RS422BSS4)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Net Expander</td>
<td>Network TCP</td>
<td>NetExp</td>
<td>n/a</td>
</tr>
<tr>
<td>Comtrol® DeviceMaster®</td>
<td>Network TCP</td>
<td>n/a</td>
<td>n/a</td>
</tr>
</tbody>
</table>

**Port Expander Cable Pinouts**

Use the information in this section to connect the Interface Cable from the Vision switcher to the Port Expander. If you are connecting an ethernet device (Network TCP/UDP) no interface cable is required.

For ethernet devices, the pinouts of the serial ports on the device are provided.

*For More Information...*

- on connecting an ethernet device to the Vision switcher, refer to the section “Ethernet Communications” on page Eng 9-3.

**BSS4 Serial Port Expander**

The Vision switcher connects to the BSS4 Serial Port Expander via the Remote ports on the Vision control panel and the Master Port on the BSS4.

Cable connections on the following table (Table 9.3) refer only to those between the Vision switcher and the BSS4 Serial Port Expander. Other cable connections present on the BSS4 Serial Port Expander can be found in the BSS4 Serial Port Expander documentation.
The Net Expander is a virtual port expander that allows you to simulate Remote ports on the Vision control panel that can be assigned to Ethernet devices. No cable connections are required.

**Comtrol DeviceMaster**

The Comtrol® DeviceMaster® allows you to connect a number of serial devices to the switcher through a single ethernet connection. Serial devices connect to the DeviceMaster using a RS-232 or RS-422 connection, and then the DeviceMaster connects to the switcher using a single ethernet connection. Individual devices are identified by a port number on the DeviceMaster.

The DeviceMaster must be on the same subnet as the switcher to ensure proper functionality.

---

**Note** — If you are using a Cisco Systems® brand router, or switch, to connect the Comtrol DeviceMaster to the switcher, you must disable the BPDU Guard on the Cisco Systems® brand router or switch to ensure proper communications.

The Comtrol DeviceMaster uses a different pinout than the Remote Ports on the Vision control panel, and supports both the RS-232 (TIA/EIA-232) and RS-422 (TIA/EIA-422) transmission standards *(Table 9.4)*.

---

### Table 9.3 Vision -to- BSS4 Serial Port Expander Wiring Chart

<table>
<thead>
<tr>
<th>Vision Switcher</th>
<th>BSS4 Serial Port Expander</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>RXA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>TXB (Tx+)</td>
</tr>
<tr>
<td>4</td>
<td>Ground</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>RXB (Rx+)</td>
</tr>
<tr>
<td>8</td>
<td>TXA (Tx-)</td>
</tr>
<tr>
<td>9</td>
<td></td>
</tr>
</tbody>
</table>

### Table 9.4 Comtrol DeviceMaster Port Pinouts (Male)

<table>
<thead>
<tr>
<th>Pin</th>
<th>RS-232</th>
<th>RS-422</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>CD</td>
<td>n/c</td>
</tr>
<tr>
<td>2</td>
<td>Rx</td>
<td>RXA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>Tx</td>
<td>TXA (Tx-)</td>
</tr>
<tr>
<td>4</td>
<td>DTR</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
<td>n/c</td>
</tr>
<tr>
<td>6</td>
<td>DSR</td>
<td>n/c</td>
</tr>
<tr>
<td>7</td>
<td>RTS</td>
<td>TXB (Tx+)</td>
</tr>
<tr>
<td>8</td>
<td>CTS</td>
<td>RXB (Rx+)</td>
</tr>
<tr>
<td>9</td>
<td>RI</td>
<td>n/c</td>
</tr>
</tbody>
</table>
Switcher Communications Setup

The Vision switcher needs to be set up with the communications port that the Port Expander is on, as well as the type, transmission standard, and the protocols for the communications between the Port Expander and switcher.

If you are using a Comtrol DeviceMaster, use the Net Expander to create the ports on the DeviceMaster. If you are setting up a DeviceMaster that has more than 4 ports, you must set up additional Net Expanders. Each Net Expander creates 4 ports.

1. Press HOME ⇒ Setup ⇒ Installation ⇒ Com Setup ⇒ Type.

2. Use the Com Port knob to select the communications port that you are connecting the Port Expander to.
   - BSS4 — Select the Remote port on the back of the control panel that you connected the BSS4 to.
   - NetExp — Select the port that you want to assign the Net Expander ports to. The expanded ports can be used directly from the switcher, or on the Comtrol DeviceMaster.

3. Use the Device knob to select Expander.

4. Press Select Device.

5. Assign the port expander to the Expander communications port as follows:
   - Use the Device knob to select the Port Expander you want to use. You can choose between from the following:
     - BSS4 — Select this option to assign a BSS4 Serial Port Expander to the selected port.
6. Press **Com Type**.

7. Select the type of serial communication that will be used to communicate with the Port Expander as follows:
   - Use the **Type** knob to select the type of communications for the selected port. Refer to the section “**Communication Settings**” on page Eng 9-18 for the specific settings for your Port Expander.

8. Press **Com Settings**.

9. Set the communications settings for the Port Expander as follows:
   - Use the **Baud** knob to select the baud rate for the Port Expander. Refer to the section “**Communication Settings**” on page Eng 9-18 for the specific settings for your Port Expander.
   - Use the **Parity** knob to select the parity for the Port Expander.

10. Press **HOME** to display the **Confirm Changes Screen**.

11. Press **Confirm** to accept the changes you have made to the communications set up of the switcher. If you are setting up a BSS4, a screen is displayed prompting you to program the BSS4 Serial Port Expander.

If you are setting up a BSS4 or a Comtrol DeviceMaster, next you must program the expander.

### Port Expander Programming

Some Port Expanders must be programmed to be able to communicate with the devices and the switcher.
BSS4 Programming

Once the switcher has been set up to communicate with the BSS4, you need to program the BSS4. The Vision switcher will start the programming after you confirm the installation change.

1. Press Continue to start programming the BSS4.

**Note** — If you press Cancel, a warning message is displayed and you will have to perform the set up of the BSS4 again.

2. Move the SET UP SWITCH on the BSS4 to PROG (Figure 9.3).

![Figure 9.3 BSS4 Serial Port Expander — Set Up Switch](image)

3. Disconnect the BSS4 Power Supply from the BSS4 to cycle the power Off.
4. Reconnect the BSS4 Power Supply to the BSS4 to cycle the power On.
5. Press Continue on the Vision control panel. A screen will be displayed informing you that the BSS4 Serial Port Expander has been successfully programmed.

**Note** — If you get an error message stating that the BSS4 could not be programmed, you should confirm your settings and try to program the BSS4 again.

6. Move the SET UP SWITCH on the BSS4 to NORM.
7. Disconnect the BSS4 Power Supply from the BSS4 to cycle the power Off.
8. Reconnect the BSS4 Power Supply to the BSS4 to cycle the power On.

**Comtrol DeviceMaster Programming**

Once the Net Expander ports have been created, you must set up Comtrol DeviceMaster. Refer to the documentation that came with the DeviceMaster for information on using the Comtrol® PortVision® software to set up the DeviceMaster.

Use the following information to set up your DeviceMaster:

- You must use a Static IP address for the DeviceMaster. You need to enter this address into the switcher so that it can connect to the DeviceMaster.
- You must set up each serial port on the DeviceMaster for the device you are connecting to it. Ensure the following is set up on the Comtrol PortVision software:
  - **Serial Configuration** — Use the Transmission Standard, Baud, Parity, Data Bits, and Stop Bits information provided by Ross Video.
  - **TCP Connection Configuration** — For each serial port on the DeviceMaster, ensure that Enable and Listen are checked and enter a port number for the serial port. Ross Video suggests that you start numbering the ports at 1001. Leave all other setting at their default values.

**Note** — If you are connecting a device using the RAP protocol to the DeviceMaster, you must have Listen unchecked and enter the IP address of the Master Panel in the Connect To: field, as well as the Local IP Port in the To Port: field. The Local Port is found on the Communications Menu.
UDP Connection Configuration — For each serial port on the DeviceMaster, ensure that Enable Serial to Ethernet, Enable Ethernet to Serial, and Enable Ethernet Receive from any IP address are unchecked. Leave all other setting at their default values.

Communication Settings

In order to have the Vision switcher communicate with a Port Expander, the Port Expander and the switcher must be set up to communicate with each other.

Use the following communications settings (Table 9.5) when connecting your Port Expander to the Vision switcher. Refer to your Port Expander documentation for additional information on setting up your Port Expander.

<table>
<thead>
<tr>
<th>Device</th>
<th>Trans Standard</th>
<th>Baud Rate</th>
<th>Parity</th>
<th>Data Bits</th>
<th>Stop Bits</th>
<th>Com Protocol</th>
</tr>
</thead>
<tbody>
<tr>
<td>RS-422 Four Port Buffered Smart Switch</td>
<td>RS-422 (TIA/EIA-422)</td>
<td>38400</td>
<td>None</td>
<td>8</td>
<td>1</td>
<td>Native</td>
</tr>
<tr>
<td>Net Expander</td>
<td>Network TCP</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
<td>Ethernet</td>
</tr>
<tr>
<td>Comtrol DeviceMaster</td>
<td>Network TCP</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
<td>Ethernet</td>
</tr>
</tbody>
</table>

Assigning Devices to Port Expander Ports

You will now notice that there are four new serial ports on the Communications Menu. These ports are labelled A, B, C and D, corresponding to the Slave Ports on the Port Expander, and will start with the number of the serial port that the Port Expander is connected to.

For example, if the BSS4 is connected to Remote 1 port on the control panel, then the four Extended Remote Ports will be Remote 1A, Remote 1B, Remote 1C, and Remote 1D.

Please note the following about each Port Expander:

- **BSS4** — The BSS4 only supports the RS-422 transmission standard. Any device using the RS-232 transmission standard requires a RS-422 to RS-232 converter. Refer to the documentation for your device to ensure you are using the correct type of serial communications.
- **NetExp** — The NetExp allows you create virtual serial ports that can be assigned to ethernet based external devices. For example, if you are controlling four channels on an ethernet controlled Character Generator, you can assign each channel to a NetExp port, and only consume a single Remote port.
- **Comtrol DeviceMaster** — The DeviceMaster uses the virtual serial ports of the NetExp to assign serial devices to the serial ports on the DeviceMaster. When you set up a device on one of the virtual serial ports, you must assign it to the IP address of the DeviceMaster and the port number that you assigned to the serial port on the DeviceMaster. The IP address and port number are set up on the DeviceMaster using the Comtrol® PortVision® software that came with the DeviceMaster.

Assigning Devices to DeviceMaster Net Expander Ports

1. Press HOME ➔ Setup ➔ Installation ➔ Com Setup.
2. Select one of the virtual serial ports and set up the device as normal. The Com Type must be set to Network TCP.

![Communication settings screen]

**IP Settings — Communications Menu 1-2**

4. Use the Client/Server knob to select whether the switcher should act as a client or server. Enter the port settings as follows:

- **Client** — Select this option if the switcher should act as the client when communicating with the device. Enter the settings for the switcher as follows:
  - In the Remote IP Address field, enter the IP address of the external device.
  - In the Remote Port field, enter the port on the external device that the switcher must connect to.

- **Server** — Select this option if the switcher should act as the server when communicating with the device. Enter the settings for the switcher as follows:
  - In the Local IP Address list, select the IP address of the switcher that you want to use to connect with the external device.
  - In the Local Port field, enter the port on the switcher that the external device must connect to.

**Note** — Do not change the Local Port value unless instructed to do so by Ross Video Technical Support.

5. Press HOME to display the Installation Change Confirmation Screen.

- Press Confirm to accept the changes and reset all Remote, Peripheral, and Net ports.
- Press Confirm w/o Reset to accept the changes without resetting all Remote, Peripheral, and Net ports. Only use this if told to do so by Ross Video Technical Support.
- Press Cancel to exit the menus safely, without making any changes. The system returns to the previously stored settings.
External Panel Modules

External Vision panel modules, such as the SideBox, must be set up on the external link port that it is connected to.

For information on cabling your external panel module to the Vision control panel, refer to the documentation that came with your external panel module.

1. Press HOME ⇒ Setup ⇒ Installation ⇒ Com Setup ⇒ Type.

2. Assign an External Link port to the external panel module as follows:
   - Use the Com Port knob to select the communications port on the Vision switcher that is connected to the external panel module.
   - Use the Device knob to select Ext Module. If the OverDrive Production Control System is set up with the switcher, you cannot assign ExtLnk 2 to Ext Module.

3. Press HOME to display the Installation Change Confirmation Screen.
   - Press Confirm to accept the changes and reset all Remote, Peripheral, and Net ports.
   - Press Confirm w/o Reset to accept the changes without resetting all Remote, Peripheral, and Net ports. Only use this if told to do so by Ross Video Technical Support.
   - Press Cancel to exit the menus safely, without making any changes. The system returns to the previously stored settings.

Next you must map the module to a panel row on the Vision control panel.

For More Information...
   - on assigning modules to a panel row, refer to the section “Mapping a Module to a Row” on page Eng 17-5.
   - on how GPIs are assigned by panel row, refer to the section “Auxiliary Control Panel GPIs” on page Eng 14-11.
Custom Devices

The Custom Device setup feature allows you to program serial command protocols for controlling external devices not otherwise supported by the Vision switcher. Custom Devices are also useful in testing currently unsupported commands to external devices, as well as other communications testing.

Custom Device Protocols are supported for the following device classes:

- VTRs
- Video Servers
- Audio Server

**Important** — The option for the external device you want to program a custom device protocol for must be purchased and installed before you can use the custom device protocol.

**Note** — Refer to the specific chapter on the device you are using for information on setting up communications for the custom device.

Custom Device commands allow you to select the signals that the switcher will send to the custom device when you select a command on the switcher.

The supported custom device commands are as follows:

- Seek Timecode
- Rewind
- Frame Reverse
- Play Reverse
- Pause
- Stop
- Play
- Frame Advance
- Fast Forward
- Record
- Diagnostic 1
- Diagnostic 2
- Diagnostic 3

**Programming Custom Device Commands**

The **CUSTOM0** and **CUSTOM1** protocols can be programmed for a number of commands that the switcher will send to the custom device. Refer to the documentation that came with your custom device for information on the input signals that the device requires to perform the desired command.

**Note** — Custom Device protocols support only one-way communication. The switcher does not record, or act upon, signals being returned from the custom device.
Operating Tip — For more information on the use and limitations of the custom device protocol, refer to the section “Custom Devices – Uses and Limitations” on page Eng 23-2.

1. Press HOME ➔ Setup ➔ Installation ➔ Com Setup ➔ Custom Devices.
2. Use the Custom knob to select the custom device protocol (CUSTOM0 or CUSTOM1) that you want to program.
3. Press Modify.

4. Use the Command Tag knob to select the command you want to set up. You can choose between the following:
   - SEEK TIMECODE — This command applies to VTRs, video servers and audio servers, and is run from the VTR Remote Menu and custom controls. When executed, the command sends the VTR Clip Time as a packed BCD of the form HHMMSSFF.
   - REWIND — This command applies to VTRs, video servers and audio servers and is run from the VTR Remote Menu and custom controls.
   - FRAME REVERSE — This command applies to VTRs, video servers, and audio servers and is run from the VTR Remote Menu and custom controls.
   - PAUSE — This command applies to VTRs, video servers, and audio servers, and is run from the VTR Remote Menu and custom controls.
   - STOP — This command applies to VTRs, video servers, and audio servers, and is run from the VTR Remote Menu and custom controls.
   - PLAY — This command applies to VTRs, video servers, and audio servers, and is run from the VTR Remote Menu and custom controls.
   - FRAME ADVANCE — This command applies to VTRs, video servers, and audio servers, and is run from the VTR Remote Menu and custom controls.
   - FAST FORWARD — This command applies to VTRs, video servers, and audio servers, and is run from the VTR Remote Menu and custom controls.
   - RECORD — This command applies to VTRs, video servers, and audio servers, and is run from the VTR Remote Menu and custom controls.

Note — The PLAY command requires the Roll Clip feature (ROLL CLP) in order to tie the command to a transition.

Note — The FADER POSITION command is not currently supported by the Vision QMD/X or MD/X switcher.
• **DIAGNOSTIC 1** — This command applies to VTRs, video servers, and audio servers, and is run from custom controls only.

• **DIAGNOSTIC 2** — This command applies to VTRs, video servers, and audio servers, and is run from custom controls only.

• **DIAGNOSTIC 3** — This command applies to VTRs, video servers, and audio servers, and is run from custom controls only.

Operating Tip — You can use the *Clear Command* button to erase all the entries you have made for the selected command.

5. Insert a byte into the signal for the selected command as follows:
   - Press **Insert Line** to insert a line, or byte, to the command signal.

   ![Coding a Byte — Custom Devices Modify Menu](image)

   **Coding a Byte — Custom Devices Modify Menu**

   - Use the **Set Nibble** knob to select the Hexidecimal value you want to insert in the first nibble of the byte.
   - Press **Toggle Nibble** to select the second nibble of the byte.
   - Use the **Set Nibble** knob to select the Hexidecimal value you want to insert in the second nibble of the byte.

6. Press **Insert Line** to add additional bytes to the command. Each byte is coded in the same way.

Operating Tip — You can use the **Choose Line** knob on the *Custom Device Modify Menu* to select the different bytes for editing.

7. Insert a packed **Command Flag** as follows:
   - Use the **Choose Line** knob to select the byte you want to place the command flag in.
   - Press **Toggle Special**.
• Use the **Command Flag** knob to select the command flag you want to insert. You can choose between the following:
  - **[Break On]** — This command flag forces the output to data low.
  - **[Break Off]** — This command releases the Break On command, allowing the output to go off of data low.
  - **[Checksum]** — This command inserts an 8-bit additive checksum byte.

**Note** — For RS-232 communication, data low is a positive voltage.

  - **[Param...]** — The Parameter command allows you to insert special parameters into the signal. This command is to be used in conjunction with the **Special Options Menu**. Refer to the section “**Advanced Topics and Tables**” on page Eng 23-3 for a description of the available commands.

8. Press **HOME** to display the **Installation Change Confirmation Screen**.

  - Press **Confirm** to accept the changes and reset all Remote, Peripheral, and Net ports.
  - Press **Confirm w/o Reset** to accept the changes without resetting all Remote, Peripheral, and Net ports. Only use this if told to do so by Ross Video Technical Support.
  - Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

**For More Information...**

  - on the uses and limitations of the custom device protocol, refer to the section “**Custom Devices – Uses and Limitations**” on page Eng 23-2.
  - on the settings available for the protocols, refer to the section “**Advanced Topics and Tables**” on page Eng 23-3.
Extra Options

The Communications Menu allows you to set up an external device to operate with the Vision switcher. This section (Table 9.6) describes each of the extra options on the Communications Menu.

Not all devices support all extra options. For information on a specific device, refer to the Ross Video External Device Setup Sheet for your device.

### Table 9.6 Extra Option Settings

<table>
<thead>
<tr>
<th>Audio Mixer Options</th>
<th>Values</th>
</tr>
</thead>
</table>
| **Channel Label**   | The Channel Label option allows you to select where the switcher gets the names for audio channels. You can choose between the following:  
  - **Switcher** — Use the name stored on the switcher  
  - **Channel ID** — Use the channel ID from the audio mixer  
  - **User Label** — Use the user assigned channel name from the audio mixer  
  - **Fixed Label** — Use the input channel number from the audio mixer  
  - **Inherited Label** — Use the source signal name from the audio mixer |
| **Converter**       | The Converter option allows you to select the MIDI to Serial converter that you are using to connect to the audio mixer. You can choose between the following:  
  - **MIDiator** — MIDiator™ Systems MS-124W  
  - **SMC** — Ross GearLite SMC-9901 |
| **Freq**            | The Frequency option allows you to select the length of time, in fields, that the switcher will wait between polling the audio mixer for status information. |
| **Max Channels**    | The Max Channels option allows you to select the maximum number of channels installed on your audio mixer. |
| **Mixers**          | The Mixers option allows you to select the number of audio mixers you are connecting together and controlling from the same communications port. You can connect up to two audio mixers together to a single serial communications port. |
| **OD Master**       | The OD Master option allows you to select the master level on the audio mixer that the switcher, and the OverDrive Production Control System, should be controlling. |
| **PGM Output**      | The PGM Output option allows you select the master level control the switcher is assigned to. |
| **Post-Fade Delay** | The Post-Fade Delay option allows you to set the length of time, in fields, after a fader is set from the switcher that the switcher ignores movements of that fader from the audio mixer. |
| **Version**         | The Version option allows you to select the version number of the audio mixer you are connecting to the selected communications port. |

<table>
<thead>
<tr>
<th>Audio Server Options</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bus Address</strong></td>
<td>The Bus Address option allows you to select the Remote Control Address that the audio server is set to.</td>
</tr>
</tbody>
</table>
### Automation Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clip Lists</td>
<td>The Clip Lists option allows you to select whether the switcher updates/retrieves the clip list data from the video servers when Automation is enabled.</td>
</tr>
<tr>
<td><em>Yes</em></td>
<td>Select this option to have the switcher not update/retrieve clip lists from video servers when Automation is enabled.</td>
</tr>
<tr>
<td><em>No</em></td>
<td>Select this option to have the switcher update/retrieve clip lists from video servers when Automation is enabled.</td>
</tr>
</tbody>
</table>

### CG Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BackToBack</td>
<td>The Back-to-Back option allows the switcher to preload the second CG page if OverDrive has back-to-back CG pages in a rundown.</td>
</tr>
<tr>
<td><em>No</em></td>
<td>Select this option to have the switcher pause to load the second CG page in a back-to-back CG rundown from OverDrive.</td>
</tr>
<tr>
<td><em>Yes</em></td>
<td>Select this option to have the switcher preload the second CG page in a back-to-back CG rundown from OverDrive.</td>
</tr>
</tbody>
</table>

### Display Mode

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On Trigger</td>
<td>Select this option to have the template remain hidden until the Play command is sent.</td>
</tr>
<tr>
<td>Immediately</td>
<td>Select this option to have the template taken on-air as soon as the Take command is issued.</td>
</tr>
</tbody>
</table>

### PlayTime

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The Play Time option allows you to select the maximum duration for playing an animation, in seconds.</td>
</tr>
</tbody>
</table>

### Show On PV

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>No</em></td>
<td>Select this option to have the switcher take CG pages directly to air when the take command is received, and not show the page on preview when it is prepped.</td>
</tr>
<tr>
<td><em>Yes</em></td>
<td>Select this option to have the switcher tell the CG to show the page on preview when the page is prepped by OverDrive. The page is taken to program when the take command is received from OverDrive.</td>
</tr>
</tbody>
</table>

### Software Ver

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Before 3.0</em></td>
<td>Select this option for XPression version 3.0, or earlier.</td>
</tr>
<tr>
<td><em>Before 5.0</em></td>
<td>Select this option if your CG uses .ins or .icg files.</td>
</tr>
<tr>
<td><em>3.0 or later</em></td>
<td>Select this option for XPression version 3.0, or later.</td>
</tr>
<tr>
<td><em>5.0 or later</em></td>
<td>Select this option if your CG uses .scribe or .scribelist files.</td>
</tr>
<tr>
<td><em>XML type</em></td>
<td>Select this option if your CG uses .xml files.</td>
</tr>
<tr>
<td><em>Non-Pro</em></td>
<td>Select this option for all non-professional versions of the character generator.</td>
</tr>
<tr>
<td><em>Pro</em></td>
<td>Select this option for all professional versions of the character generator.</td>
</tr>
</tbody>
</table>

### Timeout

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The Timeout option allows you to set the length of time that the switcher will wait for a response from a CG before reporting communication lost.</td>
</tr>
</tbody>
</table>

### Editor Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bus Mapping</td>
<td>The Bus Mapping option allows you to select either the original GVG4000 bus mapping, or the current bus map of the switcher.</td>
</tr>
<tr>
<td><em>Normal</em></td>
<td>Select this option to use the original GVG4000 bus mapping.</td>
</tr>
<tr>
<td><em>Simple</em></td>
<td>Select this option to use a direct one-to-one mapping to the current bus map of the switcher.</td>
</tr>
<tr>
<td><strong>Editor Options</strong></td>
<td>The Custom Control MLE option allows you to select whether memory recalls on a particular MLE perform a custom control rather than recalling the memory. The specific custom control that is run is based on the memory that is being recalled. Memories 1-19 correspond to Bank 1, Custom Controls 1-20; memories 20-39 correspond to Bank 2, Custom Controls 1-20; and so on. You can choose between the following:</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
</tbody>
</table>
| CustCtrl MLE | - **Any** — Select this option to have memory recalls for any MLE run a custom control rather than recall a memory.  
- **Pgm-Pst** — Select this option to have memory recalls for the Main Program MLE run a custom control rather than recall a memory.  
- **MLE1** — Select this option to have memory recalls MLE 1 run a custom control rather than recall a memory.  
- **MLE2** — Select this option to have memory recalls MLE 2 run a custom control rather than recall a memory.  
- **MLE3** — Select this option to have memory recalls MLE 3 run a custom control rather than recall a memory. |
| Editor Type | The Editor Type option allows you to select the type of editor you are connecting to the selected communications port. |
| Pattern | The Pattern option allows you to select how you want to access wipe patterns. You can choose between the following: |
| | - **Pattern #** — Select this option to use the wipe pattern numbers to select the wipe on the editor.  
- **Wipe Bttn** — Select this option to use the wipe button numbers to select the wipe on the editor. |
| Use Break | The Use Break option allows you to select whether the switcher must receive a break command before going into Active Mode. You can choose between the following: |
| | - **Yes** — Select this option to enable the switcher to go into Active Mode once a Break and an Address is received.  
- **No** — Select this option to enable the switcher to go into Active Mode but the editor sends commands and messages without Breaks. |
| **Pbus Options** | The Query Cmd option allows you to select the type of query commands supported by the Pbus device. You can choose between the following: |
| Query Cmd | - **Relaxed** — Select this option to be able to control all devices connected to the Pbus device whether they respond to the query command or not.  
- **Strict** — Select this option to be able to control only devices connected to the Pbus device that respond to query commands.  
- **Silent** — Select this option to be able to control all devices connected to the Pbus device, without using query commands. The switcher does not send query commands. |
| Robotic Camera Options | The Command Delay option allows you to select the length of time, in 16ms increments, that the switcher waits between sending commands to the camera. |
| CmdDelay | The Focus Speed option allows you to select the maximum focus speed. |
| Focus Speed | The Iris Control option allows you to select what you want to control the iris of the camera. You can choose between the following: |
| Iris Control | - **Lens** — Select this option to have the iris controlled by the lens of the camera.  
- **Camera** — Select this option to have the iris controlled by the camera controller. |
<table>
<thead>
<tr>
<th>Robotic Camera Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Iris Speed</td>
<td>The Iris Speed option allows you to set the speed at which the iris opens and closes.</td>
</tr>
</tbody>
</table>
| Iris Mode               | The Iris Mode option allows you to select how the iris opening is changed. You can choose between the following:  
  - **Velocity** — Select this option to have the iris opening changed by the velocity at which the iris ring is turned. Use this option unless the camera is controlling the iris itself.  
  - **Incremental** — Select this option to have the iris opening changed incrementally by a value. Use this option only if the camera is controlling the iris itself. |
| Iris Res                | The Iris Res option allows you to select the number of bits in the camera control signal. Different camera head controllers use different numbers of bits. Choose the value that gives you a 100% display when the iris is fully open. |
| Lens Type               | The Lens Type option allows you to select the type of lens that is being used on the camera. You can choose between the following:  
  - **Rainbow** — Select this option if the camera uses a Rainbow-CCTV Lens.  
  - **Fujinon** — Select this option if the camera uses a Fujinon/Canon Telecon Lens. |
| Master Ped              | The Master Pedestal option allows you to add (Yes) or remove (No) the Pedestal (Black) button from the Camera Head Control Menu. |
| Pan/Tilt Damping        | The Pan/Tilt Damping option allows you to select the amount of damping you want on pan and tilt movements. The higher the value, the more damping is applied. |
| Pan/Tilt Speed          | The Pan/Tilt Speed option allows you to select the maximum pan and tilt speed. The higher the value, the faster the pan and tilt speed. |
| Panel ID                | The Panel ID option allows you to select a unique ID that the camera uses to identify the Vision switcher. |
| Protocol                | The Protocol option allows you to select the protocol that is used by the positioner on your camera controller. You can choose between the following:  
  - **Level 0** — Select this option to disable joystick/positioner control.  
  - **Level 1** — Select this option to enable Pan, Tilt, Zoom, and Focus control.  
  - **Level 3** — Select this option to enable Pan, Tilt, Zoom, Focus, Iris, Mped (Black Level) and Elevation control.  
  - **Level 4** — Select this option to enable all for controls of Level 3, plus Shot Store. |
| RclTime                 | The RclTime option allows you to select the amount of time that the switcher allows for a camera to recall a shot. |
| Poll                    | The Poll option allows you to select which camera is polled. You can choose between the following:  
  - **Selected** — Select this option to have only the currently selected camera polled. Only use this option if instructed to do so by Ross Video Technical Support.  
  - **All** — Select this option to have all cameras polled. |
| Select Delay            | The Select Delay option allows you to select the length of time, in fields, that the switcher will wait after selecting a camera. |
| SerialSwitch            | The SerialSwitch option allows you to select the type of serial switch you are using to connect to your camera. You can choose between the following:  
  - **STS-12** — Select this option to assign an STS-12 Serial Control Transfer Switch to the selected port.  
  - **CP-RMR-S** — Select this option to assign a CP-RMR-S Serial Receiver to the selected port.  
  - **DS-4** — Select this option to assign a DS-4 Device Server to the selected port. |
### Robotic Camera Options

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>ShotOffset</td>
<td>The ShotOffset option allows you to select whether shots are indexed based on 0 or 1.</td>
</tr>
<tr>
<td>Zoom Speed</td>
<td>The Zoom Speed option allows you to select the maximum zoom speed.</td>
</tr>
<tr>
<td>Z Speed</td>
<td>The Z Speed option allows you to select the speed that height or elevation changes are performed.</td>
</tr>
</tbody>
</table>

### Router Options

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Base</td>
<td>The Base option allows you to select whether the router starts counting crosspoints at 0 or 1.</td>
</tr>
<tr>
<td>Level Base</td>
<td>The Level Base option allows you to select whether the router starts counting levels at 0 or 1.</td>
</tr>
<tr>
<td>Num Levels</td>
<td>The Num Level option allows you to select the number of levels that the router is using. This sets the number of levels that the router switches when the input source from the router is set to All levels.</td>
</tr>
<tr>
<td>Src &amp; Dest Base</td>
<td>The Src &amp; Dest Base option allows you to select whether the router starts counting source and destinations at 0 or 1.</td>
</tr>
<tr>
<td>Xpts</td>
<td>The Xpts option allows you to select the number of crosspoints that are available on the router.</td>
</tr>
</tbody>
</table>

### Serial Tally Options

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
</table>
| At Black | The At Black option allows you to set the at black action for the tally interface. You can select between the following:  
- **All Off** — Select this option to have the switcher report that nothing is on-air when the switcher is as black.  
- **Active On** — Select this option to have the switcher not report anything different when the switcher is at black. |
| Data Txfr | The Data Txfr option allows you to set the message size protocol for the tally device. You can select **Minimal**, **Normal**, or **Complete**. |
| Rate | The Rate option allows you to select the rate, in fields, between update messages sent by the switcher to the tally device. |
| Slot 1 | The Slot 1 option allows you to select the MLE that you want to assign to the first MLE Slot on the tally device. |
| Slot 2 | The Slot 2 option allows you to select the MLE that you want to assign to the second MLE Slot on the tally device. |
| Slot 3 | The Slot 3 option allows you to select the MLE that you want to assign to the third MLE Slot on the tally device. |
| Slot PGM | The Slot PGM option allows you to select the MLE that you want to assign to the Program MLE Slot on the tally device. |
| Source Name | The Source Name option allows you to set the input name that the switcher passes to the tally device. You can choose between the following:  
- **Router Src** — Select this option to use the router source names that are being passed through the switcher from a router.  
- **Source Name** — Select this option to use the input source name. |
<p>| Start | The Start option allows you to select <strong>None</strong> or <strong>Init</strong> as the start message for the tally device. |</p>
<table>
<thead>
<tr>
<th><strong>Video Server Options</strong></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Clip List</strong></td>
<td>The Clip List option allows you to associate a Video Server with either Clip List A or Clip List B, or use the Floating list. Clip List A and Clip List B are cached for fast access when the associated Video Server is selected. Each Clip List can only be associated with one physical device.</td>
</tr>
</tbody>
</table>
| **Cmd Queuing** | The Cmd Queuing option allows you to select whether the switcher must receive replies for every command sent to the Video Server. You can choose between the following:  
  - **Strict** — Select this option to have the switcher require a confirmation message from the Video Server for each command. The switcher will re-send a command (as set by the Send Tries value) until it receives a confirmation message from the Video Server.  
  - **Relaxed** — Select this option to have the switcher not require a confirmation message from the Video Server for each command. |
| **Cue & Pause** | The Cue & Pause option sets whether the switcher sends a pause command immediately after a cue command. This allows you to have the video server cue a clip and advance it so that you can preview the first frame of the clip.  
  - **No** — Select this option to not have the switcher send the pause command immediately after the cue command.  
  - **Yes** — Select this option to have the switcher send the pause command immediately after the cue command. |
| **Eject Clip** | The Eject Clip option sets whether the video server ejects the current clip before it cues the next clip.  
  - **No** — Select this option to not have the video server eject a clip before it cues the next clip.  
  - **Yes** — Select this option to have the video server eject a clip before it cues the next clip. This will often default the video output to black. |
| **ExtendedChar** | The ExtendedChar option allows you to set whether the switcher allows non-printing characters for clip IDs. You can choose between the following:  
  - **No** — Select this option to have the switcher replace non-printing characters with spaces.  
  - **Yes** — Select this option to have the switcher use the extended character set. |
| **LoopMinLength** | The LoopMinLength option allows you to set the minimum length of a clip, in seconds, that can be looped. The minimum length is three (3) seconds. |
| **LoopRecueTime** | The LoopRecueTime option allows you to set the amount of time, in frames, before the end of a clip that the switcher sends a loop command. |
| **MediaIDLength** | The MediaIDLength option allows you to select the maximum character length of the clip IDs displayed on the VTR Clips, Inpoint/Outpoint, and Remote Control Menus. You can choose between the following:  
  - **Short IDs** — Select this option if your device uses an ID length of up to 8 characters.  
  - **Long IDs** — Select this option if your device uses an ID length of up to 32 characters. |
| **Panel** | The Panel option allows you to select the control panel, in a MultiPanel system, that the device is connected to. |
| **Playback Mode** | The Playback Mode option allows you to set the playback mode that your Video Server is using. You can choose between the following:  
  - **PB** — Select this option if your device does not go to Electronic-to-Electronic (EE) mode.  
  - **PB/EE** — Select this option if your device does go to EE mode. If you select this option, you enable the serial device to automatically go into PB/EE mode. If a stop command is issued, the device enters EE mode. If a pause command is issued, the device stays in Playback mode. |
<table>
<thead>
<tr>
<th><strong>Video Server Options</strong></th>
<th>Description</th>
</tr>
</thead>
</table>
| Play w/Alpha | The Play with Alpha option allows you to have the switcher play both the video and alpha channels from a video server. Both the video and alpha input sources must have the video server assigned to them, and must be set up as an auto key to associate the video with the alpha.  
  • **No** — Select this option to not have the associated alpha video channel played on the video server when the video channel is played.  
  • **Yes** — Select this option to have both the video and alpha channels played on the video server at the same time. The switcher does not check the status of the video server channels before sending the play command in this mode. |
| Port Cmds | The Port Cmds option allows you to set whether your Video Server supports the Open Port, Select Port, and Close Port commands. You can choose between the following:  
  • **No** — Select this option if your device does not support port commands.  
  • **Yes** — Select this option if your device does support port commands. |
| Record Time | The Record Time option allows you to set the maximum number of minutes that the Video Server will record for when it received the Record custom control command. |
| Send Tries | The Send Tries option allows you to specify the number of times that the switcher will try to send the same command to the Video Server if the switcher has not received a confirmation response. |
| Status Interval | The Status Interval option allows you to specify amount of time that the switcher waits between status check requests of the video server. |
| Status Tries | The Status Tries option allows you to specify the number of times that the switcher will send a status check request to a video server without getting a ready response. |
| TargetMachine | The TargetMachine option allows you to select the video server that you are assigning to the selected communications port. |
| TimeOut | The TimeOut option allows you to select the length of time, in fields, that the switcher will wait for a reply from the Video Server before trying to send a command again. |

<table>
<thead>
<tr>
<th><strong>VTR Options</strong></th>
<th>Description</th>
</tr>
</thead>
</table>
| Decode NAKs | The Decode NAKs (Not Acknowledgement) option allows you to have the switcher decode the NAK messages sent from the VTR to the switcher. The NAK messages must be decoded for the switcher to act on them. You can choose between the following:  
  • **No** — Select this option to have the switcher not decode the NAK messages. Only select this option if you are encountering problems using the Play command with your device or as advised by Ross Video Technical Support.  
  • **Yes** — Select this option to have the switcher decode the NAK messages. |
| NPlayRetries | The NPlayRetries option allows you to set the number of times the switcher attempts to send a Play command to the VTR. |
| Request TC | The Request Timecode option allows you have the switcher request timecode information from the VTR. The timecode information can then be displayed on the Remote Control Menu, as well as the preview overlay.  
  • **No** — Select this option to have the switcher not request timecode information.  
  • **Yes** — Select this option to have the switcher request timecode information. If the timecode information is returned from the VTR, it is displayed on the Remote Control Menu and preview overlay. |
<p>| TargetMachine | The TargetMachine option allows you to select the video server that you are assigning to the selected communications port. |</p>
<table>
<thead>
<tr>
<th>VTR Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wait nFields</td>
<td>The Wait nFields option allows you to set the length of time the switcher waits before assuming that a Play command failed, or was not received by the VTR.</td>
</tr>
</tbody>
</table>
Custom Controls

In This Chapter

This chapter provides general information on setting up and naming custom control banks, as well as programming, naming, and editing custom control buttons.

The following topics are discussed in this chapter:

- Custom Controls
- Custom Control Interfaces
- Custom Control Banks
- Programming Control Panel Functions
- Programming Special Functions
- Attaching Custom Controls to Panel Buttons
- Naming Custom Controls
- Editing Custom Controls
- Managing Custom Controls
- Deleting Custom Controls
- Custom Control Shortcuts
- Device Transport Commands
- Custom Control Variable Pause

Operating Tip — A Custom Control Worksheet is provided to assist you in keeping track of which custom control have been programmed. Refer to the section "Custom Control Worksheets" on page Eng 21-18 for a copy of this worksheet.
Custom Controls

Once programmed, a custom control can be played back by pressing a button. The custom control can be as simple as triggering an output GPI pulse, or as complex as recalling a specific memory register, performing a switcher transition, and flying a group of Keys.

Custom Control functions can be broken down into the following groups:

- **Custom Control Banks** — Up to 48 custom control buttons can be set up as Bank buttons. Each bank can contain a complete set of custom controls. When you select, or press, a custom control Bank button, all the non-Bank custom control buttons switch to the custom controls that were recorded in that Bank.

- **Control Panel Functions** — A custom control can be programmed to play back a series of control panel button presses. Menu selections, however, cannot be recorded.

- **VTR Functions** — A custom control can be programmed to send specific commands, such as play, cue or rewind, to a VTR or Video Server. The targeted server or VTR must be installed before you are able to record a custom control for it.

- **DVE Functions** — A custom control button can be programmed to send specific commands, such as play effect, frame advance or stop, to the Primary External DVE. The DVE functions do not apply to the Internal Squeeze & Tease DVE.

- **Time Clock Functions** — A custom control can be programmed to start, stop, or reset the preview overlay clock.

- **Pbus Functions** — A custom control can be programmed to send commands to a Pbus device.

- **Special Functions** — A custom control can be programmed with a number of special functions, such as fire GPIs, goto Menus, and pause a custom control. Refer to the section “Programming Special Functions” on page Eng 10-15 for more information on special functions.

- **Monitor Wall Functions** — A custom control can be programmed to load a monitor wall layout, assign channels, and modify text on a monitor wall. The targeted monitor wall must be installed before you are able to record a custom control for it.

- **Audio Server Functions** — A custom control can be programmed to send specific commands, such as play, cue or rewind, to an Audio Server. The targeted server must be installed before you are able to record a custom control for it.

*Note* — When recording a memory recall in a custom control, it may be necessary to add a pause of between 1-10 frames after the memory recall.

Tips for Working with Custom Controls

A control panel custom control allows you to automate a series of button presses into a single macro. There are, however, a number of things that you must keep in mind when creating or running a custom control in order to produce the desired effect.

- Including an All+All reset in a custom control with other events may result in unexpected results. If you need to have an All+All reset in a custom control, it should be either the only or last event in the custom control.

- Certain custom control functions can be assigned to shortcut buttons, allowing quick access to these functions from control panel buttons. Refer to the section “Custom Control Shortcuts” on page Eng 10-34 for more information on custom control shortcuts.
• If you are including a memory recall in the custom control, you must ensure the Auto Recall settings are the same as when the memory was stored. This ensures a consistent output.

• For non crosspoint buttons, a custom control only records that a specific button was pressed, and does not record the state that the button was in. For example, if you press the TIME CLOCK button on the Preview Overlay module while recording a custom control, the custom control will only record that the button was pressed. If you run the custom control immediately after recording it, TIME CLOCK is turned off.

• A custom control records the specific bus map source that is mapped to the crosspoint button that is selected, and not the specific crosspoint button. This allows a custom control created with one bus map to be run with a different bus map, as long as the same bus map source exists in the different bus map.

• To program a custom control that will recall a memory and then perform a transition, you must recall the memory on the MLE you want to perform the transition on, then use the Cut or Auto Trans buttons to perform the transition. A custom control cannot record the movement of a fader.

• A custom control will not automatically compensate for the time a memory recall or transition will require to complete. In these cases, you must insert a custom control pause after the event that requires time to complete.

• You can insert a Custom Control Hold command into a custom control that will hold the custom control at a specific point until the continue command is received. The custom control is continued by either pressing the custom control button again, or by a GPI Input trigger.

• You can create a Looping Custom Control by inserting a Loop CC event into the custom control.

• You can insert a Run Custom Control command into a custom control that will automatically run another custom control. If the Multiple Custom Control feature is active, both custom controls can run at the same time. If the Multiple Custom Control feature is turned off, inserting a Run Custom Control command ends the recording, and playing, of the first custom control. Refer to the section “Running Multiple Custom Controls” on page Eng 10-13 for information on running multiple custom controls. If a custom control starts multiple custom controls, you must stop each one individually, or use the Stop Other Custom Control command.

• You can run multiple custom controls at the same time by pressing the corresponding custom control button. If a custom control is already running, pressing the button again will stop it.

• You can insert a Select Memory Bank command into a custom control that will select different memory bank(s) when the custom control is run. To insert the Select Memory Bank command into a custom control, select the memory bank(s) you want to select as you are recording the custom control. A custom control can have multiple Select Memory Banks. If you only press the BANK button, the next successive Bank is recorded, depending on what Memory Bank Cycle is set to. Refer to the section “Personality List” on page Eng 11-2 for more information on Memory Bank Cycle.

• You can create a custom control that will affect an MLE that is not assigned to your control panel by creating the custom control on a control panel that does have the MLE assigned to it.

• A custom control that selects a source on an MLE will select the correct source when a different bus map is used, only if the original bus map still exists on the switcher.

• If you include a button in a custom control that has another custom control attached to it, the command to run the second custom control is ignored when the initial custom control is run. This does not apply to actual custom control buttons.
• When you are recording a custom control, the message “CC RECORDING” is shown on the Main Menu.

• The size of the selected custom control is shown next to the name, in the Selected field on the left of the menu (xx/yy bytes) on the Custom Control Menu. The first number (xx) is the size of the macro, and the second is the size of all the macros in the selected bank (yy).

• You can use a custom control to navigate to a specific menu either by using the Go To Menu event, or by navigating to the menu when recording the custom control. Not all menus support this feature.

Stopping Custom Controls

If you have created a long or looping custom control, there are a number of ways that you can stop it.

• Press the custom control button for the custom control you want to stop. This applies only to the custom control assigned to that button.

• Press and hold the Stop CC button and press the custom control button for the custom control you want to stop. You must assign the Stop CC function to a bank button.

• Double-press the Stop CC button to stop all running custom controls. You must assign the Stop CC function to a bank button.

• Run an empty custom control (a custom control that has no events).

• Insert the Stop Other Custom Control command into a custom control.

For More Information...

• on storing custom controls, refer to the section “Storing and Recalling Files and Setups” on page Eng 13-4.

• on programming custom control buttons, refer to the section “Programming Control Panel Functions” on page Eng 10-10.

• on creating a custom control bank, refer to the section “Custom Control Bank Setup” on page Eng 10-7.

• on Video Checksum custom controls, refer to the section “Video Checksum Custom Controls” on page Eng 17-32.
Custom Control Interfaces

Each switcher supports up to 48 banks of 48 custom controls. These custom controls can be accessed either from the Custom Control Bus, the Soft Shot Box Menu, or from the optional Custom Control Shot Box Module.

Custom Control Bus

The custom control bus on the Vision switchers is located just above the Program/Preset MLE (Figure 10.1), and has the same number of number of buttons as a crosspoint group.

Custom Control Soft Shot Box

The Custom Control Soft Shot Box allows you access to all 48 custom controls that can be programmed per Custom Control Bank on the Touchscreen Display. From the menu, you select the Bank you want to use and the Custom Control on that Bank that you want to run.

The Custom Control mnemonic names and colors are shown on the buttons.

- Press HOME ⇒ More ⇒ Effects ⇒ More ⇒ CC Soft Shot Box.

If you are recording, or inserting into, a custom control, all of the custom control buttons on the Custom Control Soft Shot Box Menu appear gray, except for the button for the custom control being recorded. A red Record icon is shown on the custom control that is being recorded, or inserted into. Pressing that button will stop the recording.
Custom Control Shot Box Module

The Custom Control Shot Box Module (Figure 10.2) allows you to map custom controls from various banks to any of the 28 buttons on the Shot Box Module.

Figure 10.2  Shot Box Module

For More Information...

- on the Custom Control Shot Box Module, refer to the section “Custom Control Shot Box Module” on page Eng 15-2.
- on setting up Shot Box Pages, refer to the section “Creating Shot Box Pages” on page Eng 15-3.

Global Memory Module

You can run a custom control from the Global Memory module. This option is only available if the CC Global Recall personality option is turned on.

Keep the following in mind when running custom controls from the Global Memory Module:

- The “>” symbol indicates what you are entering, the bank or custom.
- Press the BANK button to reset the selected bank and custom to 01.

To Run a Custom Control From the Global Memory Module

1. Press RECALL CLIP/CC. If you have an older control panel, the button may be labelled RECALL CLIP.
2. Use the keypad to enter the 2-digit number of the bank that you want to run the custom control on.
3. Press ENTER to select the bank.
4. Use the keypad to enter the 2-digit number of the custom control you want to run.
5. Press ENTER to select the custom control. The RUN CC +/- button will light to indicate a valid custom control.
6. Press RUN CC +/- to run the custom control. The buttons turns red when the custom is running.

For More Information...

- on the CC Global Recall personality option, refer to the section “Personality List” on page Eng 11-2.
Custom Control Banks

Before programming the actual custom controls themselves, you must determine whether or not you want to enable custom control banks. Custom Control Banks allow you to group custom controls together, separate from custom controls on other banks. Up to 48 custom control banks can be created. Each bank is assigned to a custom control button, similar to how a custom control is recorded to a custom control button. When you select different Banks, the remaining custom control buttons switch to the custom controls that were recorded to the selected bank.

Three types of banks are available; Normal, Audio, and Transport:

- **Normal** — Normal banks are for storing normal custom controls dealing with typical switcher video functions such as recalling memories and performing a transition.
- **Audio** — Audio banks are used when custom controls are created for use when the switcher is in Audio Custom Control mode, and remotely operates an audio mixing board through the PGM and PST bus crosspoints.
- **Transport** — Transport banks are used for device transport commands. Normal custom controls cannot be assigned to a Transport bank.

**Operating Tip** — You can save the number of buttons you assign to Bank buttons by using the Bank shortcut. Refer to the section “Custom Control Shortcuts” on page Eng 10-34 for more information.

Custom Control Bank Setup

1. Press HOME → Setup → Installation → More → Custom Controls.

2. Assign a custom control bank type as follows:
   - Use the Bank/Function knob to select the bank you want to enable. For information on assigning functions to bank buttons, refer to the section “Custom Control Shortcuts” on page Eng 10-34.
   - Use the Button knob to select the custom control button that you want to assign as the bank. The custom control button you have selected lights up on the control panel.

**Operating Tip** — Select NONE if you want to disable a bank that you have previously set up. This does not delete the custom controls on that bank. Assigning that bank to a button again, allows the custom controls on that bank to be accessible again.
Use the Type knob to select the custom control bank type you want to create. You can choose between the following:

- **Audio** — Select this option for custom controls that communicate with external audio mixers.
- **Normal** — Select this option for custom controls that perform any function except communicating with external audio mixers.
- **Transport** — Select this option for device transport commands. Normal custom controls cannot be assigned to a Transport bank.

3. Press HOME to display the Installation Change Confirmation Screen.

- Press Confirm to accept the changes and reset all Remote, Peripheral, and Net ports.
- Press Confirm w/o Reset to accept the changes without resetting all Remote, Peripheral, and Net ports. Only use this if told to do so by Ross Video Technical Support.
- Press Cancel to exit the menus safely, without making any changes. The system returns to the previously stored settings.

Once you have created all the custom control banks you need, you should name them.

*For More Information...*

- on device transport commands, refer to the section “Device Transport Commands” on page Eng 10-36.
- on assigning functions to bank buttons, refer to the section “Custom Control Shortcuts” on page Eng 10-34.

**Naming Custom Control Banks and Shortcuts**

The name you apply to a custom control bank or shortcut appears on the menus, the mnemonic above the custom control button, and the buttons on the Shot Box Menu. This allows you to easily distinguish between different custom control banks or shortcuts, and between banks and custom controls.

**Operating Tip** — You can revert the name of a bank or shortcut to the default at any time by pressing Default on the Bank Names Menu. This will not default any custom mnemonic settings.

1. Press HOME ➔ Setup ➔ Installation ➔ More ➔ Custom Controls ➔ Modify Name.
2. Name a custom control bank or shortcut as follows:
   • Use the **Bank/Function** knob to select the custom control bank or shortcut you want to name.

   **Operating Tip** — Refer to the section “Using the Naming Menus” on page Eng 5-17 for more information on using the **Bank/Function Names Menu** to enter a name, or set up the mnemonics for the custom control button.

   - Enter the new name for the custom control bank or shortcut in the **New Name** field. The name can be no more than 13 characters in length.

3. Press **Accept New Name** to store the new name and mnemonic settings.

4. Press **HOME** to display the **Installation Change Confirmation Screen**.
   - Press **Confirm** to accept the changes and reset all Remote, Peripheral, and Net ports.
   - Press **Confirm w/o Reset** to accept the changes without resetting all Remote, Peripheral, and Net ports. Only use this if told to do so by Ross Video Technical Support.
   - Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.
Programming Control Panel Functions

This section provides information on programming standard control panel functions, such as crosspoint selection and other button presses. Refer to the section “Programming Special Functions” on page Eng 10-15 for information on programming special functions.

If you are creating a custom control that contains re-entered MLEs and intend to use the custom control on different switchers, or you are creating a custom control for use with an OverDrive® Production Control System, you should create a Relative Custom Control. Refer to the section “Relative Custom Controls” on page Eng 10-11 for more information.

In a MultiPanel configuration, custom controls only record actions for the MLEs that are assigned to the control panel that the custom control is being recorded on. If that custom control is run on a different control panel, with different MLEs assigned to it, the custom control still performs actions on the MLEs that were assigned to the original control panel.

**Note** — Entering the Custom Control Menu stops all custom controls that were started from that control panel, but does not affect running custom controls that were started from other control panels. You can still start a custom control from another control panel.

**Operating Tip** — You can record a custom control to a Bank button, however, you will not be able to run that custom control directly from the control panel.

1. Press HOME ⇒ Custom Controls. If the Custom Control button is grayed out, the Custom Control Menu is being displayed on another panel connected to the system.

2. Select the custom control button you want to record to as follows:
   - Use the Bank knob to select the bank that you want to record the custom control on.
   - Use the Button knob to select the custom control button you want to record to.

**Important** — Custom Control buttons with an * or an @ next to them have already been programmed. For information on editing this custom control, refer to the section “Editing Custom Controls” on page Eng 10-29.

3. Press Start Recording. The custom control button that is being recorded to starts to flash, indicating that a custom control is being recorded to that custom control button.
**Note** — If you do not want to save the custom control you just recorded, or you do not want to record a custom control, press **Cancel Recording**.

4. Press the buttons on the control panel that you want to have recorded in the custom control. Refer to the section “**Tips for Working with Custom Controls**” on page Eng 10-2 for more information on what types of actions can be recorded into a control panel custom control.

5. Press **Finish Recording** to finish recording to the custom control. The custom control button will stop flashing. The size of the custom control you just created is shown next to the name, in the Selected field on the left of the menu (xx/yy bytes). The first number (xx) is the size of the macro, and the second is the size of all the macros in the selected bank (yy).

**For More Information...**

- on storing custom controls, refer to the section “**Storing and Recalling Files and Setups**” on page Eng 13-4.
- on the setting the Multiple Custom Control option, refer to the section “**Personality List**” on page Eng 11-2.

**Relative Custom Controls**

Relative Custom Controls store the MLE re-entry position so that they can be taken on-air from any MLE that is re-entered on the **PGM/PST MLE**. For example, if you have **MLE 2** re-entered into **MLE 3** (Figure 10.3), of a **Vision 2.5**, and record a standard custom control event for **MLE 2**, that custom control event will only run on **MLE 2**. The standard custom control will only record that the buttons on **MLE 2** were pressed, and does not record that the MLE was re-entered into **MLE 3**.

![Figure 10.3 MLE 2 Re-entered into MLE 3, the Program/Preset MLE](image)

If you record the same events as a relative custom control, you could recall the button presses made on **MLE 2** on **MLE 1** (Figure 10.4), if **MLE 1** is re-entered into **MLE 3**.
Relative custom controls are not MLE specific, as normal custom controls, but instead are re-entry specific. This means that the re-entry order, or levels that the relative custom control was recorded on, do not need to be the same in order to run that custom control. For example, if we again record a relative custom control on MLE 2, which is re-entered into MLE 3 (Figure 10.3), we can run that relative custom control with more or fewer MLEs. If we have MLE 1 re-entered into MLE 2 and MLE 2 re-entered into MLE 3 (Figure 10.5), the relative custom control is run on MLE 1.

If we have no MLEs re-entered (Figure 10.6), the relative custom control is run on MLE 3.

You can run the same relative custom control on multiple control panels at the same time. However, a relative custom control can only be stopped from the control panel that it was started on. The same relative custom control is treated as an independent custom on each control panel.

**Programming Relative Custom Controls**

1. Set up your MLE re-entry configuration to record the relative custom control at the re-entry level you want. Refer to the section “Re-entry” on page Ops 4-13 for more information on MLE re-entry.

2. Press HOME ⇒ Custom Controls. If the Custom Control button is grayed out, the Custom Control Menu is active on another panel connected to the system.
3. Select the custom control button you want to record to as follows:
   - Use the Bank knob to select the bank that you want to record the custom control on.
   - Use the Button knob to select the custom control button you want to record to.

   **Important** — Custom Control buttons with an ♦ or an @ next to them have already been programmed. For information on editing this custom control, refer to the section “Editing Custom Controls” on page Eng 10-29.

4. Press Start Relative Recording. The custom control button that is being recorded to starts to flash, indicating that a custom control is being recorded to that custom control button.

5. Press the buttons on the control panel that you want to have recorded in the custom control. Refer to the section “Tips for Working with Custom Controls” on page Eng 10-2 for more information on what types of actions can be recorded into a control panel custom control.

6. Press Finish Recording to finish recording to the custom control. The custom control button stops flashing.

**Running Multiple Custom Controls**

The Multiple Custom Controls feature allows you to have a single custom control start multiple other custom controls, or you can manually start multiple custom controls using the corresponding custom control buttons. A maximum of 10 custom controls can be running at the same time. All the custom controls will continue to play out until they reach the end, or loop (Figure 10.7).

**Important** — The switcher does not track custom controls that are started as part of another custom control. Running multiple custom controls that start the same custom control, or editing a custom control that is run by another custom control, could produce unexpected results. Only Relative custom controls can have multiple instances of the same custom control running at the same time.

**Operating Tip** — You can insert a Stop Other Custom Controls command that will stop all other running custom controls, except the one that is currently running.
If the Multiple Custom Controls feature is turned off, a Run Custom Control command ends the current custom control. Pressing another custom control button also stops the first custom control and starts the second (Figure 10.8).

You must have the multiple custom controls feature enabled from the Personality Menu to be able to run multiple custom controls.

For More Information...

- on programming special custom control commands, refer to the section “Programming Special Functions” on page Eng 10-15.
- on naming a custom control, refer to the section “Naming Custom Controls” on page Eng 10-28.
- on storing custom controls, refer to the section “Storing and Recalling Files and Setups” on page Eng 13-4.
- on setting the Multiple Custom Control feature, refer to the section “Personality List” on page Eng 11-2.
Programming Special Functions

Special functions allow you to include events not associated with a button press into a custom control, such as a Time Clock function. A special function can be inserted into any existing custom control, or used when creating a new custom control.

**Note** — Entering the Custom Control Menu stops all custom controls that were started from that control panel, but does not affect running custom controls that were started from other control panels.

1. Press HOME ⇒ Custom Controls. If the Custom Control button is grayed out, the Custom Control Menu is active on another panel connected to the system.
2. Select the custom control you want to record to.
3. Press Start Recording ⇒ Insert Special.
4. Select the Device or Input that you want to apply the command to.
5. Select the command you want to insert into the custom control. Refer to the following table (Table 10.1) for a list of available commands for your device.
6. Press Insert to insert the selected command into the custom control.
7. Press HOME.
8. Press Custom Controls.
9. Press Finish Recording, or the flashing custom control button, to finish recording to the selected custom control. The custom control button stops flashing.

### Table 10.1 Insert Special Custom Control Commands

<table>
<thead>
<tr>
<th>Class</th>
<th>Commands</th>
<th>Sub-Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>External Devices</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| Audio Fader | Assign Fader  | Audio Fader | The Assign Fader custom control allows you to assign a different audio channel to an audio fader.  
1. Use the Fader knob to select the audio fader you want to assign an audio channel to.  
2. Use the Audio Src knob to select the audio channel you want to assign to the audio channel. |
|             | Reset Fader   |          | The Reset Fader custom control allows you to reset the audio fader channel assignments back to the default setting of the audio fader map. |
The Set AFV Level custom control allows you to set a new audio level for the audio channel assigned to an audio fader. This new level is then used for all audio follow video transitions.

The AFV Off custom control turns off normal Audio Follow Video (AFV) functionality. Audio channel assigned to video sources will not automatically be taken on-air with the video source. Audio channel can still be taken on-air manually. The AFV Off functionality remains active until the AFV On custom control is run.

The AFV On custom control returns the switcher to normal Audio Follow Video (AFV) functionality, after the AFV Off custom control was run.

The AFV Hold custom control allows you to have audio channel assigned to video sources automatically taken on-air with the video source, but are unchanged when the video source is taken off-air.

The Assign Audio custom control has two roles when working with audio. In normal mode, it allows you to access the levels for the audio channel or group you have assigned to that button. In audio override mode, it allows you to perform audio only transition and override the normal audio follow video operation.

The Audio All Off custom control allows you to fade all audio channels on either the program or preset bus off. This can be useful for quickly removing all audio from either bus, or taking all audio channels off-air after you have performed an Audio Memory Recall.

The Audio Channel Off custom control allows you to turn an audio channel, or group, off. This can be useful if you want to take an audio channel, or group, off-air at once. You can use the Audio Channel Off for either the program or preset buses.

You can include a number of Audio Channel Off events in a single custom control, allowing you to turn multiple audio channels, or groups, off for either the Program or Preset buses.

The Audio Channel On custom control allows you to turn an audio channel, or group, on at the level it was last on at, or leave it unchanged as the channel is already on-air. This can be useful if you want to take an audio channel, or group, on-air at once. You can use the Audio Channel On for either the program or preset buses.

You can include a number of Audio Channel On events in a single custom control, allowing you to turn multiple audio channels, or groups, on for either the program or preset buses. Unlike the Audio Memory function, the Reset Audio will return the switcher to audio follow video operation.

The Audio Memory custom control allows you to recall a memory that has been stored on the Audio Mixer. This can be used to take a number of audio channels on-air at different levels all at once. Refer to the documentation that came with your Audio Mixer for more information on storing audio memories.

The Audio Mute Off custom control allows you to un-mute an audio channel, or group. This is the same as pressing mute on the Audio Mixer.

The Audio Mute On custom control allows you to mute an audio channel, or group. This is the same as pressing mute on the Audio Mixer.

<table>
<thead>
<tr>
<th>Class</th>
<th>Commands</th>
<th>Sub-Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio Mixer</td>
<td>Set AFV Lvl</td>
<td>Special</td>
<td>The Set AFV Level custom control allows you to set a new audio level for the</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>audio channel assigned to an audio fader. This new level is then used for</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>all audio follow video transitions.</td>
</tr>
<tr>
<td></td>
<td>AFV Off</td>
<td></td>
<td>The AFV Off custom control turns off normal Audio Follow Video (AFV)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>functionality. Audio channel assigned to video sources will not automatically</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>be taken on-air with the video source. Audio channel can still be taken on-</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>air manually. The AFV Off functionality remains active until the AFV On</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>custom control is run.</td>
</tr>
<tr>
<td></td>
<td>AFV On</td>
<td></td>
<td>The AFV On custom control returns the switcher to normal Audio Follow Video</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>(AFV) functionality, after the AFV Off custom control was run.</td>
</tr>
<tr>
<td></td>
<td>AFV Hold</td>
<td></td>
<td>The AFV Hold custom control allows you to have audio channel assigned to</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>video sources automatically taken on-air with the video source, but are</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>unchanged when the video source is taken off-air.</td>
</tr>
<tr>
<td></td>
<td>Assign Audio</td>
<td></td>
<td>The Assign Audio custom control has two roles when working with audio. In</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>normal mode, it allows you to access the levels for the audio channel or</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>group you have assigned to that button. In audio override mode, it allows</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>you to perform audio only transition and override the normal audio follow</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>video operation.</td>
</tr>
<tr>
<td></td>
<td>Audio All Off</td>
<td></td>
<td>The Audio All Off custom control allows you to fade all audio channels on</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>either the program or preset bus off. This can be useful for quickly</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>removing all audio from either bus, or taking all audio channels off-air</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>after you have performed an Audio Memory Recall.</td>
</tr>
<tr>
<td></td>
<td>Audio CH Off</td>
<td></td>
<td>The Audio Channel Off custom control allows you to turn an audio channel,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>or group, off. This can be useful if you want to take an audio channel, or</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>group, off-air at once. You can use the Audio Channel Off for either the</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>program or preset buses.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>You can include a number of Audio Channel Off events in a single custom</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>control, allowing you to turn multiple audio channels, or groups, off for</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>either the Program or Preset buses.</td>
</tr>
<tr>
<td></td>
<td>Audio CH On</td>
<td></td>
<td>The Audio Channel On custom control allows you to turn an audio channel,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>or group, on at the level it was last on at, or leave it unchanged as the</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>channel is already on-air. This can be useful if you want to take an audio</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>channel, or group, on-air at once. You can use the Audio Channel On for</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>either the program or preset buses.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>You can include a number of Audio Channel On events in a single custom</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>control, allowing you to turn multiple audio channels, or groups, on for</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>either the program or preset buses. Unlike the Audio Memory function, the</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Reset Audio will return the switcher to audio follow video operation.</td>
</tr>
<tr>
<td></td>
<td>Audio Memory</td>
<td></td>
<td>The Audio Memory custom control allows you to recall a memory that has</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>been stored on the Audio Mixer. This can be used to take a number of audio</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>channels on-air at different levels all at once. Refer to the documentation</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>that came with your Audio Mixer for more information on storing audio</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>memories.</td>
</tr>
<tr>
<td></td>
<td>Aud Mute Off</td>
<td></td>
<td>The Audio Mute Off custom control allows you to un-mute an audio channel,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>or group. This is the same as pressing mute on the Audio Mixer.</td>
</tr>
<tr>
<td></td>
<td>Aud Mute On</td>
<td></td>
<td>The Audio Mute On custom control allows you to mute an audio channel, or</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>group. This is the same as pressing mute on the Audio Mixer.</td>
</tr>
</tbody>
</table>
The PGM Audio Level/Duration custom control allows you to override the levels for audio channels on the Program bus over a number of fields. If the audio channel is already on-air, you can change the level or take it off-air, if the channel is off, you can take the channel on-air as an override. PGM Audio Level custom controls differ from Audio Channel On custom controls in that you select the level that you want the audio channel to be set to, and the length of time you want to change in level to occur over. When run, the custom control will alter the level of the channel over the selected duration, even if it is on-air.

1. Use the Group knob to select the channel or group you want to create the custom control for.
2. Press Level, and use the Level knob to select the audio level you want to take the selected channels to.
3. Press Duration, and use the Fields knob to select the length of time, in frames, that you want it to take to change the audio level.

You can include a number of PGM Audio Level events in a single custom control, allowing you to alter multiple audio channels, or groups, at the same time.

The PST Audio Level custom control allows you to override the levels for audio channels on the preset bus. If the audio channel is already on-air, you can change the level or take it off-air, if the channel is off, you can take the channel on-air as an override. PST Audio Level custom controls differ from Audio Channel On custom controls in that you select the level that you want the audio channel to be set to. When run, the custom control will alter the level of the channel, even if it is on-air. Audio CH On will only take the channel on-air if it is off and will not change the level. This could be useful when you want to alter the levels of a number of channels, or groups, at the same time.

You can include a number of PST Audio Level events in a single custom control, allowing you to alter multiple audio channels, or groups, at the same time.

The Reset Audio custom control allows you to return to the normal audio follow video mode and remove all currently selected overrides. This can be performed for either the program or the preset bus. You must set up two custom controls if you want to perform both independently.

<table>
<thead>
<tr>
<th>Class</th>
<th>Commands</th>
<th>Sub-Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PGM Aud Lv Dur</td>
<td></td>
<td></td>
<td>The PGM Audio Level/Duration custom control allows you to override the levels for audio channels on the Program bus over a number of fields. If the audio channel is already on-air, you can change the level or take it off-air, if the channel is off, you can take the channel on-air as an override. PGM Audio Level custom controls differ from Audio Channel On custom controls in that you select the level that you want the audio channel to be set to, and the length of time you want to change in level to occur over. When run, the custom control will alter the level of the channel over the selected duration, even if it is on-air. 1. Use the Group knob to select the channel or group you want to create the custom control for. 2. Press Level, and use the Level knob to select the audio level you want to take the selected channels to. 3. Press Duration, and use the Fields knob to select the length of time, in frames, that you want it to take to change the audio level. You can include a number of PGM Audio Level events in a single custom control, allowing you to alter multiple audio channels, or groups, at the same time.</td>
</tr>
<tr>
<td>PST Audio Lvl</td>
<td></td>
<td></td>
<td>The PST Audio Level custom control allows you to override the levels for audio channels on the preset bus. If the audio channel is already on-air, you can change the level or take it off-air, if the channel is off, you can take the channel on-air as an override. PST Audio Level custom controls differ from Audio Channel On custom controls in that you select the level that you want the audio channel to be set to. When run, the custom control will alter the level of the channel, even if it is on-air. Audio CH On will only take the channel on-air if it is off and will not change the level. This could be useful when you want to alter the levels of a number of channels, or groups, at the same time. You can include a number of PST Audio Level events in a single custom control, allowing you to alter multiple audio channels, or groups, at the same time.</td>
</tr>
<tr>
<td>Reset Audio</td>
<td></td>
<td></td>
<td>The Reset Audio custom control allows you to return to the normal audio follow video mode and remove all currently selected overrides. This can be performed for either the program or the preset bus. You must set up two custom controls if you want to perform both independently.</td>
</tr>
<tr>
<td>Audio Server</td>
<td>Go To Cut</td>
<td>Insert Audio Server</td>
<td>The Go To Cut custom control allows you to have the Audio Server cue to a selected cut or track. You must select the clip</td>
</tr>
<tr>
<td></td>
<td>Pause</td>
<td></td>
<td>The Pause custom control allows you to have the Audio Server go into pause mode.</td>
</tr>
<tr>
<td></td>
<td>Play</td>
<td></td>
<td>The Play custom control allows you to have the Audio Server go into play mode, or 1× forward</td>
</tr>
<tr>
<td></td>
<td>Stop</td>
<td></td>
<td>The Stop custom control allows you to have the Audio Server stop.</td>
</tr>
<tr>
<td>Character</td>
<td>Execute Macro</td>
<td>Insert CG</td>
<td>The Execute Macro custom control allows you to have a custom control on the switcher trigger a macro on a character generator. Enter the macro command you want to run in the Macro Name field (up to 62 characters). For example, to open and execute a macro on a Chyron, enter “Lyric.Open&lt;name&gt;”. Additional commands can be sent to the CG by inserting another Execute Macro custom control. <strong>Note:</strong> You must insert a pause between execute macro commands in a custom control to ensure that there is enough time for each event to be processed properly.</td>
</tr>
<tr>
<td>Generator</td>
<td>GPI</td>
<td></td>
<td>The GPI custom control allows you to trigger a GPI input on the CG. Use the keypad on the Global Memory Module to select the GPI you want to trigger.</td>
</tr>
<tr>
<td></td>
<td>Load To PGM</td>
<td></td>
<td>The Load custom control allows you to load a page or template into the Character Generator Program channel. Use the keypad on the Global Memory Module to select the template and layer you want. Press Change Template to enter a new template, and Layer to enter a new layer.</td>
</tr>
</tbody>
</table>
## Table 10.1 Insert Special Custom Control Commands

<table>
<thead>
<tr>
<th>Class</th>
<th>Commands</th>
<th>Sub-Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load To PV</td>
<td><strong>Insert DVE</strong></td>
<td></td>
<td>The Load custom control allows you to load a page or template into the Character Generator Preview channel. Use the keypad on the Global Memory Module to select the template and layer you want. Press <strong>Change Template</strong> to enter a new template. Press <strong>Layer On</strong> and use the <strong>Layer</strong> knob to enter a new layer.</td>
</tr>
<tr>
<td>Play</td>
<td></td>
<td></td>
<td>The Play custom control allows you to play an animation.</td>
</tr>
<tr>
<td>Read</td>
<td></td>
<td></td>
<td>The Read custom control allows you to load a page or template into the Character Generator Preview channel. Use the keypad on the Global Memory Module to select the template and layer you want. Press <strong>Change Template</strong> to enter a new template, and <strong>Layer On</strong> to enter a new layer.</td>
</tr>
<tr>
<td>Resume</td>
<td></td>
<td></td>
<td>The Resume custom control allows you to resume playing an animation that was paused. Use the keypad on the Global Memory Module to select the layer you want. Press <strong>Layer On</strong> and use the <strong>Layer</strong> knob to enter a new layer.</td>
</tr>
<tr>
<td>Seq Next</td>
<td></td>
<td></td>
<td>The Sequence Next custom control allows you to select the previous effect in the sequence.</td>
</tr>
<tr>
<td>Seq Prev</td>
<td></td>
<td></td>
<td>The Sequence Previous custom control allows you to select the next effect in the sequence.</td>
</tr>
<tr>
<td>Seq Take</td>
<td></td>
<td></td>
<td>The Sequence Take custom control allows you to take the current effect in the sequence on-air.</td>
</tr>
<tr>
<td>Set Folder</td>
<td></td>
<td></td>
<td>The Set folder custom control allows you to set the default folder for pages or templates.</td>
</tr>
<tr>
<td>Take</td>
<td></td>
<td></td>
<td>The Take custom control allows you to play the next effect that is cued up on the Character Generator. The next effect will be on the preview (PV) of the Character Generator and will be taken to the program (PGM) of the Character Generator with this custom control.</td>
</tr>
<tr>
<td>Take Out</td>
<td></td>
<td></td>
<td>The Take Out custom control allows you to clear all graphics from the specified channel. Press <strong>Layer On</strong> and use the <strong>Layer</strong> knob to enter a new layer.</td>
</tr>
<tr>
<td>DVE</td>
<td>Frame Advance</td>
<td>Insert DVE</td>
<td>The Frame Advance custom control advances the DVE effect forward by one frame.</td>
</tr>
<tr>
<td></td>
<td>Frame Reverse</td>
<td></td>
<td>The Frame Reverse custom control allows you to reverse the DVE effect backwards by one frame.</td>
</tr>
<tr>
<td></td>
<td>Go To End</td>
<td></td>
<td>The Go To End custom control allows you to cue the DVE to the end of its effect.</td>
</tr>
<tr>
<td></td>
<td>Go To Start</td>
<td></td>
<td>The Go To Start custom control cues the DVE to the start of its effect.</td>
</tr>
<tr>
<td></td>
<td>Key Frame Adv</td>
<td></td>
<td>The Key Frame Adv custom control allows you to cue the DVE effect to the next Keyframe boundary.</td>
</tr>
<tr>
<td></td>
<td>Key Frame Rev</td>
<td></td>
<td>The Key Frame Rev custom control allows you to cue the DVE effect to the previous Keyframe boundary.</td>
</tr>
<tr>
<td></td>
<td>Pause</td>
<td></td>
<td>The Pause custom control allows you to pause the DVE effect.</td>
</tr>
<tr>
<td></td>
<td>Play</td>
<td></td>
<td>The Play custom control plays the DVE effect forward.</td>
</tr>
<tr>
<td></td>
<td>Play Rev</td>
<td></td>
<td>The Play Rev custom control allows you to play the DVE effect in reverse.</td>
</tr>
<tr>
<td></td>
<td>Recall</td>
<td></td>
<td>The Recall custom control allows you to recall a selected DVE effect (from 1 to 99).</td>
</tr>
<tr>
<td></td>
<td>Rewind</td>
<td></td>
<td>The Rewind custom control allows you to rewind the DVE effect (simulates a shuttle reverse).</td>
</tr>
<tr>
<td></td>
<td>Stop</td>
<td></td>
<td>The Stop custom control allows you to stop the DVE effect.</td>
</tr>
<tr>
<td>GPI</td>
<td>Reset GPI</td>
<td>Special</td>
<td>The Reset GPI custom control allows you to reset the state of an output GPI connection. This can be used to return an output GPI to a known state if there is a problem.</td>
</tr>
</tbody>
</table>
Simulate GPI
The Simulate GPI custom control allows you to manually trigger a GPI input on the switcher using a custom control. The switcher reacts as if a trigger was received on the selected input GPI.

Trigger GPI
The Trigger GPI command allows you to trigger a pre-selected output GPI using a custom control.

Assign Channel
The Assign Channel custom control allows you to program a custom control to assign a specific input channel to a particular monitor on the Monitor Wall. Each monitor in a layout requires an input channel for the video it displays.

Modify Dynamic Text
The Modify Dynamic Text custom control allows you to program a custom control to assign specific, pre-defined, Dynamic text to a particular text address on a Monitor Wall layout. The text address will have to be assigned to a template for a custom control to be able to change the text.

There are two types of text labels used on a Monitor Wall: Static and Dynamic. Static text labels are set during the creation of the Monitor Wall setup and can only be modified using the tools provided with the Monitor Wall. Dynamic text labels can be modified at any time from the Vision switcher.

Load Layout
The Layout custom control allows you to program a custom control to load a specific layout on a Monitor Wall. A Monitor Wall can have several different layouts created, each with a variety of monitors and inputs.

Automation: Act MLE Trans
The Act MLE Trans custom control allows you to have all MLEs that are contributing to the program output of the switcher, except for the program MLE, to be transitioned according to the settings in the MLE Transition Module.

Automation: Keys Off Air
The Keys Off Air custom control allows you to have all the on-air keys, on all MLEs that are contributing to the program output of the switcher, dissolved off-air. MultiDSK keys are not affected by this custom control.

OverDrive: Take & Prep
The Take & Prepare Next custom control allows you to tell OverDrive to take current shot on-air and prepare the next shot in the rundown.

OverDrive: Prep Next
The Prepare Next custom control allows you to tell OverDrive to prepare the next shot in the rundown.

OverDrive: Prep Prev
The Prepare Previous custom control allows you to tell OverDrive to prepare the previous shot in the rundown.

OverDrive: Prep CC
The Prepared CC custom control allows you to tell OverDrive to run one of the prepared CC buttons on rundown control. The buttons are numbered 1-6.
- Use the CC knob to select the custom control you want to run.

OverDrive: On-Air CC
The On-Air CC custom control allows you to tell OverDrive to run one of the on-air CC buttons on rundown control. The buttons are numbered 1-6.
- Use the CC knob to select the custom control you want to run.

OverDrive: Transition
The Transition custom control allows you to tell OverDrive to activate a particular button on rundown control. The buttons are numbered 1-4.
- Use the Trans knob to select transition rate.

OverDrive: Rundown
The Rundown custom control allows you to tell OverDrive to run a selected event in a rundown.
- Use the Cmd knob to select the command.

Recall
The Recall custom control allows you to have the Pbus device recall a memory from the selected register when the custom control is run. You can choose between 0 and 4095.

Store
The Store custom control allows you to have the Pbus device store a memory to the selected register when the custom control is run. You can choose between 0 and 4095.

<table>
<thead>
<tr>
<th>Class</th>
<th>Commands</th>
<th>Sub-Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simulate GPI</td>
<td></td>
<td></td>
<td>The Simulate GPI custom control allows you to manually trigger a GPI input on the switcher using a custom control. The switcher reacts as if a trigger was received on the selected input GPI.</td>
</tr>
<tr>
<td>Trigger GPI</td>
<td></td>
<td></td>
<td>The Trigger GPI command allows you to trigger a pre-selected output GPI using a custom control.</td>
</tr>
<tr>
<td>Monitor Wall</td>
<td>Assign Chan</td>
<td>Insert Monitor Wall Control</td>
<td>The Assign Channel custom control allows you to program a custom control to assign a specific input channel to a particular monitor on the Monitor Wall. Each monitor in a layout requires an input channel for the video it displays.</td>
</tr>
<tr>
<td></td>
<td>Modify Text</td>
<td></td>
<td>The Modify Dynamic Text custom control allows you to program a custom control to assign specific, pre-defined, Dynamic text to a particular text address on a Monitor Wall layout. The text address will have to be assigned to a template for a custom control to be able to change the text.</td>
</tr>
<tr>
<td></td>
<td>Load Layout</td>
<td></td>
<td>The Layout custom control allows you to program a custom control to load a specific layout on a Monitor Wall. A Monitor Wall can have several different layouts created, each with a variety of monitors and inputs.</td>
</tr>
<tr>
<td>OverDrive®</td>
<td>Automation: Act MLE Trans</td>
<td>Special</td>
<td>The Act MLE Trans custom control allows you to have all MLEs that are contributing to the program output of the switcher, except for the program MLE, to be transitioned according to the settings in the MLE Transition Module.</td>
</tr>
<tr>
<td></td>
<td>Automation: Keys Off Air</td>
<td></td>
<td>The Keys Off Air custom control allows you to have all the on-air keys, on all MLEs that are contributing to the program output of the switcher, dissolved off-air. MultiDSK keys are not affected by this custom control.</td>
</tr>
<tr>
<td></td>
<td>OverDrive: Take &amp; Prep</td>
<td></td>
<td>The Take &amp; Prepare Next custom control allows you to tell OverDrive to take current shot on-air and prepare the next shot in the rundown.</td>
</tr>
<tr>
<td></td>
<td>OverDrive: Prep Next</td>
<td></td>
<td>The Prepare Next custom control allows you to tell OverDrive to prepare the next shot in the rundown.</td>
</tr>
<tr>
<td></td>
<td>OverDrive: Prep Prev</td>
<td></td>
<td>The Prepare Previous custom control allows you to tell OverDrive to prepare the previous shot in the rundown.</td>
</tr>
<tr>
<td></td>
<td>OverDrive: Prep CC</td>
<td></td>
<td>The Prepared CC custom control allows you to tell OverDrive to run one of the prepared CC buttons on rundown control. The buttons are numbered 1-6.</td>
</tr>
<tr>
<td></td>
<td>OverDrive: On-Air CC</td>
<td></td>
<td>The On-Air CC custom control allows you to tell OverDrive to run one of the on-air CC buttons on rundown control. The buttons are numbered 1-6.</td>
</tr>
<tr>
<td></td>
<td>OverDrive: Transition</td>
<td></td>
<td>The Transition custom control allows you to tell OverDrive to activate a particular button on rundown control. The buttons are numbered 1-4.</td>
</tr>
<tr>
<td></td>
<td>OverDrive: Rundown</td>
<td></td>
<td>The Rundown custom control allows you to tell OverDrive to run a selected event in a rundown.</td>
</tr>
<tr>
<td>Pbus</td>
<td>Recall</td>
<td>Insert Pbus</td>
<td>The Recall custom control allows you to have the Pbus device recall a memory from the selected register when the custom control is run. You can choose between 0 and 4095.</td>
</tr>
<tr>
<td></td>
<td>Store</td>
<td></td>
<td>The Store custom control allows you to have the Pbus device store a memory to the selected register when the custom control is run. You can choose between 0 and 4095.</td>
</tr>
</tbody>
</table>
### Table 10.1 Insert Special Custom Control Commands

<table>
<thead>
<tr>
<th>Class</th>
<th>Commands</th>
<th>Sub-Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Robotic Camera</td>
<td>Trigger</td>
<td></td>
<td>The Trigger custom control allows you to have a trigger value sent to the selected port on the Pbus device when the custom control is run. You can choose between 0 and 15.</td>
</tr>
<tr>
<td></td>
<td>Recall Shot</td>
<td>Insert Robotic Camera Control</td>
<td>The Recall Shot custom control allows you to recall a shot on a particular robotic camera with a specific duration for the recall to be performed. When programming this custom control, you are recalling a specific camera on a remote port by selecting its input source, or input name.</td>
</tr>
<tr>
<td></td>
<td>Resave Last</td>
<td></td>
<td>The Resave Last custom control allows you to overwrite the last prepared shot or recalled move with the current position of the camera. For a move, only the prepared position is overwritten. You must re-prepare the move before you can execute it.</td>
</tr>
<tr>
<td></td>
<td>Prepare Move</td>
<td></td>
<td>The Prepare Move custom control allows you to prepare a camera move on a particular camera. Use the <strong>Shot</strong> knob to select the move you want to prepare.</td>
</tr>
<tr>
<td></td>
<td>Execute Move</td>
<td></td>
<td>The Execute Move custom control allows you to execute a prepared camera move on a particular camera. Use the <strong>Shot</strong> knob to select the move you want to execute. The move must be prepared before it can be executed.</td>
</tr>
<tr>
<td></td>
<td>Cam All Stop</td>
<td></td>
<td>The Cam All Stop custom control allows you to quickly stop all robotic camera operations. Use this command to stop all motion of a robotic camera with a single command.</td>
</tr>
<tr>
<td></td>
<td>Deselect Cam</td>
<td></td>
<td>The Deselect Cam custom control allows you to deselect the robotic camera that was last selected. When a camera is selected by the switcher, that camera remains selected until another camera is selected, or the Deselect Cam custom control is run.</td>
</tr>
<tr>
<td></td>
<td>Grab Positioner</td>
<td></td>
<td>The Grab Positioner custom control allows you to select which camera is assigned to the positioner by cycling through all the cameras selected on preview, one at a time. Each time the custom control is run, the positioner assignment will jump to the next camera that will go on-air with the next transition.</td>
</tr>
</tbody>
</table>
| RossTalk       | SeqIn     | Insert RossTalk Cmd | The SeqIn custom control allows you to load a template to air on a specific layer to the output channel selected in the template. The Sequencer focus moves to this item.  
  - **Take ID** — Press **Take ID** and use the **Take ID** knob to select the take id for the template you want to load.  
  - **Layer** — Press **Layer ID** and use the **Layer ID** knob to select the layer you want to use. |
|               | Take      |          | The Take custom control allows you to load a template to air in a specific frame-buffer and on a specific layer.  
  - **Take ID** — Press **Take ID** and use the **Take ID** knob to select the take id for the template you want to load.  
  - **Layer** — Press **Layer ID** and use the **Layer ID** knob to select the layer you want to use.  
  - **Frame-Buffer** — Press **Buffer ID** and use the **Buffer ID** knob to select the frame-buffer you want to use. |
|               | SeqOut    |          | The SeqOut custom control allows you to take a template off-air.  
  - **Take ID** — Press **Take ID** and use the **Take ID** knob to select the take id for the template you want to take off-air. |
|               | ClearFB   |          | The ClearFB custom control allows you to clear a specific frame-buffer.  
  - **Frame-Buffer** — Use the **Buffer ID** knob to select the frame-buffer you want to use. |
### Table 10.1 Insert Special Custom Control Commands

<table>
<thead>
<tr>
<th>Class</th>
<th>Commands</th>
<th>Sub-Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ClearLayerFB</td>
<td></td>
<td></td>
<td>The ClearLayerFB custom control allows you to clear a specific layer in a specific frame-buffer. <strong>Layer</strong> — Press <strong>Layer ID</strong> and use the <strong>Layer ID</strong> knob to select the layer you want to use. <strong>Frame-Buffer</strong> — Press <strong>Buffer ID</strong> and use the <strong>Buffer ID</strong> knob to select the frame-buffer you want to use.</td>
</tr>
<tr>
<td>Resume</td>
<td></td>
<td></td>
<td>The Resume custom control allows you to resume a specific layer in a specific frame-buffer. <strong>Layer</strong> — Press <strong>Layer ID</strong> and use the <strong>Layer ID</strong> knob to select the layer you want to use. <strong>Frame-Buffer</strong> — Press <strong>Buffer ID</strong> and use the <strong>Buffer ID</strong> knob to select the frame-buffer you want to use.</td>
</tr>
<tr>
<td>ClearAllFB</td>
<td></td>
<td></td>
<td>The ClearAllFB custom control allows you to clear all frame-buffers.</td>
</tr>
<tr>
<td>Read</td>
<td></td>
<td></td>
<td>The Read custom control allows you to take the current selection in the Sequencer to air.</td>
</tr>
<tr>
<td>Next</td>
<td></td>
<td></td>
<td>The Next custom control allows you to take the current selection in the Sequencer to air and advance the current selection to the next item in the list.</td>
</tr>
<tr>
<td>Up</td>
<td></td>
<td></td>
<td>The Up custom control allows you to move the current selection in the Sequencer to the item above in the list.</td>
</tr>
<tr>
<td>Down</td>
<td></td>
<td></td>
<td>The Down custom control allows you to move the current selection in the Sequencer to the item below in the list.</td>
</tr>
<tr>
<td>Focus</td>
<td></td>
<td></td>
<td>The Focus custom control allows you to set the Sequencer focus to a specific template. <strong>Take ID</strong> — Press <strong>Take ID</strong> and use the <strong>Take ID</strong> knob to select the take id for the template you want to load.</td>
</tr>
<tr>
<td>GPI</td>
<td></td>
<td></td>
<td>The GPI custom control allows you to trigger a simulated GPI. <strong>GPI</strong> — Use the <strong>GPI</strong> knob to select the GPI that you want to use.</td>
</tr>
<tr>
<td>TypeInCmd</td>
<td></td>
<td></td>
<td>The TypeInCmd custom control allows you to enter a manual RossTalk command into a custom control.</td>
</tr>
<tr>
<td><strong>Router</strong></td>
<td>Fire Salvo</td>
<td>Insert Router Control</td>
<td>The Fire Router Salvo custom control allows to fire a salvo on the router. You will have to program your salvos on the router itself in order to be able to fire them. Refer to your router documentation for information on storing a salvo on your particular router.</td>
</tr>
<tr>
<td></td>
<td>Take XPT</td>
<td>Insert VTR</td>
<td>The Take XPT custom control allows you to change the source and destination on the router with a single custom control.</td>
</tr>
<tr>
<td><strong>Video Server/ VTR</strong></td>
<td>Fast Forward</td>
<td>Insert VTR</td>
<td>The Fast Forward custom control allows you to have the VTR go into full fast forward mode.</td>
</tr>
<tr>
<td></td>
<td>Frame Advance</td>
<td></td>
<td>The Frame Advance custom control allows you to have the VTR move (jog) the video one frame forward.</td>
</tr>
<tr>
<td></td>
<td>Frame Reverse</td>
<td></td>
<td>The Frame Reverse custom control allows you to have the VTR move (jog) the video one frame reverse.</td>
</tr>
<tr>
<td></td>
<td>Go To Clip</td>
<td></td>
<td>Select this command to have the VTR cue to a selected clip. When you select Go To Clip, the <strong>Clip</strong> knob appears, allowing you to select the number (00-99) for the clip you want to cue up.</td>
</tr>
<tr>
<td></td>
<td>In Flag Reset</td>
<td></td>
<td>The In Flag Reset custom control allows you to turn the Entry In mode on the VTR off. When the Entry In mode is off, the VTR will rewind the preroll time when Preroll command is issued.</td>
</tr>
<tr>
<td></td>
<td>In Recall</td>
<td></td>
<td>The In Recall custom control allows you to turn the Entry In mode on the VTR on. When the Entry In mode is on, the VTR will go to the in-entry point that has previously been set on the VTR, minus the preroll, when the Preroll command is issued. The in-entry point is set from the VTR, and not from the switcher.</td>
</tr>
</tbody>
</table>
### Insert Special Custom Control Commands

<table>
<thead>
<tr>
<th>Class</th>
<th>Commands</th>
<th>Sub-Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pause</td>
<td>The Pause custom control allows you to have the VTR to into pause mode.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Play</td>
<td>The Play custom control allows you to play a video clip (with alpha if the option is set for the device). The switcher will confirm the status of the video server, and then send the play command.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Play Loop Off</td>
<td>The Play Loop Off custom control allows you to have a currently looping clip stop playing the next time it reaches the end.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Play Loop On</td>
<td>The Play Loop On custom control allows you to have the currently cued and playing clip loop back to the beginning when it finished playing.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Play no Stat</td>
<td>The Play no Stat custom control allows you to play a video clip (with alpha if the option is set for the device). The switcher does not confirm the status of the video server, but immediately sends the play command.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Preroll</td>
<td>The Preroll custom control allows you to have the VTR go to the predefined in-entry, minus a set preroll time, when In Recall is active. When In Recall is not active, the VTR will rewind the pre-roll time from the current point. The in-entry point and preroll time are set from the VTR, and not from the switcher.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Record</td>
<td>The Record custom control allows you to have the VTR go into record mode. You must use the Stop custom control to stop the recording. It is a good practice to create a Stop custom control before creating the Record custom control so that you can stop the recording.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rewind</td>
<td>The Rewind custom control allows you to have the VTR go into full fast rewind mode.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Standby Off</td>
<td>The Standby Off custom control allows you to take the VTR out of standby mode. When not in standby mode, the heads of the VTR are removed from the tape, showing noise or black on the video output. This command will only work if the VTR is stopped.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Standby On</td>
<td>The Standby On custom control allows you to put the VTR in standby mode. In standby mode, the heads of the VTR are engaged, showing video on the video output. The VTR automatically goes into this mode when the Play, Rewind, Fast Forward, or Pause commands are issued.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Stop</td>
<td>The Stop custom control allows you to have the VTR perform a stop and eject. This command stops the selected channel, and unloads the clip.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Internal Devices and Commands

<table>
<thead>
<tr>
<th>Class</th>
<th>Commands</th>
<th>Sub-Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time Clock</td>
<td>Time Clock</td>
<td></td>
<td>The Count Down custom control allows you to have the custom control start the time clock counting down from a preset time to 0. The preset starting time is set using either the Reset custom control, or from the Time Clock Menu.</td>
</tr>
<tr>
<td></td>
<td>Count Down</td>
<td></td>
<td>The Count Up custom control allows you to have the custom control start the time clock counting up from 0.</td>
</tr>
<tr>
<td></td>
<td>Count Up</td>
<td></td>
<td>The Count Down/Up custom control allows you to have the custom control start the time clock counting down from a preset time to 0, and then back. This will continue until the Reset or Stop command is given.</td>
</tr>
<tr>
<td></td>
<td>Count Down/Up</td>
<td></td>
<td>The Reset custom control allows you to have the custom control reset the time clock to the time selected using the Reset Time knob on the Insert Time Clock Menu.</td>
</tr>
<tr>
<td></td>
<td>Stop</td>
<td></td>
<td>The Stop custom control allows you to have the custom control stop the time clock.</td>
</tr>
<tr>
<td>Menus</td>
<td>Go To Menu</td>
<td>Special</td>
<td>The Go To Menu command allows you to use a custom control to navigate to a particular menu. This allows you to quickly jump between frequently used menus without having to navigate through the menu system.</td>
</tr>
<tr>
<td>Transitions</td>
<td>Cut Keys</td>
<td>Special</td>
<td>The Cut Keys custom control allows you create a custom control that will cut keys on or off on a particular MLE, or for the MultiDSK Keyers.</td>
</tr>
</tbody>
</table>
The Transition Keys custom control allows you create a custom control that will transition keys on or off on a particular MLE, or for the MultiDSK Keyers.

The Safe Title custom control allows you to create a custom control that will recall a specific safe title configuration on the preview overlay.

The Hold CC custom control allows you place a command in a custom control that will stop a custom control where the hold is placed in the custom control. To continue the custom control, you must press the custom control button again, or use a GPI trigger.

The mnemonic for the custom control shows **Held** when the custom control is at hold.

The Hold for Group custom control allows you to place a command in a custom control that will stop a custom control where the hold is placed in the custom control. The custom control will hold until the Run Held Group custom control event is triggered for the group that the Hold For Group command was assigned to. For example, if you insert the Hold For Group A command into two custom controls and Hold For Group B into another two custom controls, the Run Held Group A event will only resume the first two (group A) custom control. The remaining two (group B) custom controls will remain holding until the Run Held Group B event is triggered.

The mnemonic for the custom control shows **HldFor Run** when the custom control is at hold.

The Hold for Run custom control allows you to place a command in a custom control that will stop a custom control where the hold is placed in the custom control. The custom control will hold until the Run All Held CCs custom control event is triggered.

The mnemonic for the custom control shows **HldFor Run** when the custom control is at hold.

The Loop CC custom control allows you to have a custom control run continuously until you stop it, or a Stop Custom Control command is executed from another custom control.

The Notify End CC custom control is for internal use only. Only use this custom control if instructed to do so by Ross Video Technical Support.

The Pause CC custom control allows you to place a command in a custom control that will stop a custom control where the pause is placed in the custom control. The length of time that the custom control is paused is set when the pause event is inserted into the custom control.

The Run Held custom control allows you to resume all of the custom controls that are at hold from a Hold or Hold For Run event. Custom controls that are at hold from a Hold For Group event are unaffected.

The Run Held Group custom control allows you to resume all of the custom controls that are at hold from the Hold For Group event for the same group. Only the custom controls that used the Hold For Group event, and are of the same group, resume. For example, if you insert the Hold For Group A command into two custom controls and Hold For Group B into another two custom controls, the Run Held Group A event will only resume the first two (group A) custom control. The remaining two (group B) custom controls will remain holding until the Run Held Group B event is triggered.

The Stop Held X custom control allows you to stop all of the custom controls that are at hold from the Hold For Group event for the same group. Only the custom controls that used the Hold For Group event, and are of the same group, stop. For example, if you insert the Hold For Group A command into two custom controls and Hold For Group B into another two custom controls, the Stop Held Group A event will only stop the first two (group A) custom control. The remaining two (group B) custom controls will remain holding until the Stop or Resume Held Group B event is triggered.

### Table 10.1 Insert Special Custom Control Commands

<table>
<thead>
<tr>
<th>Class</th>
<th>Commands</th>
<th>Sub-Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trans Keys</td>
<td>Trans Keys</td>
<td>Special</td>
<td>The Transition Keys custom control allows you create a custom control that will transition keys on or off on a particular MLE, or for the MultiDSK Keyers.</td>
</tr>
<tr>
<td>Safe Title</td>
<td>Safe Title</td>
<td>Special</td>
<td>The Safe Title custom control allows you to create a custom control that will recall a specific safe title configuration on the preview overlay.</td>
</tr>
<tr>
<td>Hold CC</td>
<td>Hold CC</td>
<td>Special</td>
<td>The Hold CC custom control allows you place a command in a custom control that will stop a custom control where the hold is placed in the custom control. To continue the custom control, you must press the custom control button again, or use a GPI trigger. The mnemonic for the custom control shows <strong>Held</strong> when the custom control is at hold.</td>
</tr>
<tr>
<td>Hold For Group</td>
<td>Hold For Group</td>
<td>Special</td>
<td>The Hold For Group custom control allows you to place a command in a custom control that will stop a custom control where the hold is placed in the custom control. The custom control will hold until the Run Held Group custom control event is triggered for the group that the Hold For Group command was assigned to. For example, if you insert the Hold For Group A command into two custom controls and Hold For Group B into another two custom controls, the Run Held Group A event will only resume the first two (group A) custom control. The remaining two (group B) custom controls will remain holding until the Run Held Group B event is triggered. The mnemonic for the custom control shows <strong>HldFor Run</strong> when the custom control is at hold.</td>
</tr>
<tr>
<td>Hold For Run</td>
<td>Hold For Run</td>
<td>Special</td>
<td>The Hold for Run custom control allows you to place a command in a custom control that will stop a custom control where the hold is placed in the custom control. The custom control will hold until the Run All Held CCs custom control event is triggered. The mnemonic for the custom control shows <strong>HldFor Run</strong> when the custom control is at hold.</td>
</tr>
<tr>
<td>Loop CC</td>
<td>Loop CC</td>
<td>Special</td>
<td>The Loop CC custom control allows you to have a custom control run continuously until you stop it, or a Stop Custom Control command is executed from another custom control.</td>
</tr>
<tr>
<td>Notify End CC</td>
<td>Notify End CC</td>
<td>Special</td>
<td>The Notify End CC custom control is for internal use only. Only use this custom control if instructed to do so by Ross Video Technical Support.</td>
</tr>
<tr>
<td>Pause CC</td>
<td>Pause CC</td>
<td>Special</td>
<td>The Pause CC custom control allows you to place a command in a custom control that will stop a custom control where the pause is placed in the custom control. The length of time that the custom control is paused is set when the pause event is inserted into the custom control.</td>
</tr>
<tr>
<td>Run Held</td>
<td>Run Held</td>
<td></td>
<td>The Run Held custom control allows you to resume all of the custom controls that are at hold from a Hold or Hold For Run event. Custom controls that are at hold from a Hold For Group event are unaffected.</td>
</tr>
<tr>
<td>Run Held Group</td>
<td>Run Held Group</td>
<td></td>
<td>The Run Held Group custom control allows you to resume all of the custom controls that are at hold from the Hold For Group event for the same group. Only the custom controls that used the Hold For Group event, and are of the same group, resume. For example, if you insert the Hold For Group A command into two custom controls and Hold For Group B into another two custom controls, the Run Held Group A event will only resume the first two (group A) custom control. The remaining two (group B) custom controls will remain holding until the Run Held Group B event is triggered.</td>
</tr>
<tr>
<td>Stop Held X</td>
<td>Stop Held X</td>
<td></td>
<td>The Stop Held X custom control allows you to stop all of the custom controls that are at hold from the Hold For Group event for the same group. Only the custom controls that used the Hold For Group event, and are of the same group, stop. For example, if you insert the Hold For Group A command into two custom controls and Hold For Group B into another two custom controls, the Stop Held Group A event will only stop the first two (group A) custom control. The remaining two (group B) custom controls will remain holding until the Stop or Resume Held Group B event is triggered.</td>
</tr>
</tbody>
</table>
The Stop Other CC custom control allows you to place a command in a custom control that will stop all other running custom controls, except the one the command is in. This can be used to stop other looping custom controls at a specific point.

The Variable Pause CC custom control allows you to place a command in a custom control that will stop a custom control where the pause is placed in the custom control. The length of time that the custom control is paused is set as the result of the Pause Equation. Refer to the section “Custom Control Variable Pause” on page Eng 10-37 for information on setting a pause variable.

The Run Sequence custom control allows you to have a custom control run a sequence on the selected MLE and Keyer. This allows you to run a dissolve or wipe and still run a sequence in the same MLE. The sequence you want to run must be loaded before running the custom control. If you are using a Relative Custom Control, you must select the PGM/PST MLE as the MLE to run the sequence on. You do not need to have SEQ selected on the Transition Module.

Refer to the section “Video Checksum Custom Controls” on page Eng 17-32 for more information on using this diagnostic tool.

<table>
<thead>
<tr>
<th>Class</th>
<th>Commands</th>
<th>Sub-Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stop Other CC</td>
<td></td>
<td></td>
<td>The Stop Other CC custom control allows you to place a command in a custom</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>control that will stop all other running custom controls, except the one the</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>command is in. This can be used to stop other looping custom controls at a</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>specific point.</td>
</tr>
<tr>
<td>V Pause CC</td>
<td></td>
<td></td>
<td>The Variable Pause CC custom control allows you to place a command in a</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>custom control that will stop a custom control where the pause is placed in</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>the custom control. The length of time that the custom control is paused is</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>set as the result of the Pause Equation. Refer to the section “Custom Control</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Variable Pause” on page Eng 10-37 for information on setting a pause variable.</td>
</tr>
<tr>
<td>Run Sequence</td>
<td>Special</td>
<td></td>
<td>The Run Sequence custom control allows you to have a custom control run a</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>sequence on the selected MLE and Keyer. This allows you to run a dissolve</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>or wipe and still run a sequence in the same MLE. The sequence you want to</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>run must be loaded before running the custom control. If you are using a</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Relative Custom Control, you must select the PGM/PST MLE as the MLE to run</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>the sequence on. You do not need to have SEQ selected on the Transition</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Module.</td>
</tr>
<tr>
<td>n/a</td>
<td>Insert Video</td>
<td></td>
<td>Refer to the section “Video Checksum Custom Controls” on page Eng 17-32 for</td>
</tr>
<tr>
<td>Video</td>
<td>Checksum</td>
<td></td>
<td>more information on using this diagnostic tool.</td>
</tr>
<tr>
<td>Checksum</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table 10.1  Insert Special Custom Control Commands
Attaching Custom Controls to Panel Buttons

The Attach Custom Control feature allows you to attach a custom control to any button on the control panel or auxiliary control panel mapped to an internal panel row. This does not include the buttons on the touchscreen display, custom control bus, or Shotbox.

Custom controls are attached to the physical button on the MLE, and not the function of the button. This means that if a custom control is attached to a crosspoint button, changing the bus map, or using the shifted bus, does not affect the custom control attachment to the original button. For example, if you attach a custom control to a crosspoint button on MLE 1, the custom control runs if you press that button, or Shift and that button. If you assign the MLE to a different panel row, the custom control attachment follows the MLE to the new panel row.

If you include a button in a custom control that has another custom control attached to it, the command to run the second, attached, custom control is ignored when the initial custom control is run. This does not apply to actual custom control buttons.

**Note** — The CC/Macro Attachments personality option must be set to on for custom controls attached to control panel buttons to be executed when that button is pressed.

Attaching a Custom Control to a Panel Button

Custom controls are attached either after (Post-Attach), before (Pre-Attach), or instead-of (Replace) the function of the button.

**Important** — When you attach a custom control to a panel button, the association is with the custom control button, and not the custom control. If you change which custom control is assigned to the custom control button, that change is also applied to the attachment.

1. Press HOME ⇒ Custom Controls ⇒ More ⇒ Attach Macros.

   ![Attach Custom Controls Menu](image)

   **Attach Custom Controls Menu**

   2. Select the button on the Vision control panel or local Auxiliary Control Panel that you want to attach a custom control to. Only Auxiliary Control Panels that are mapped to internal panel rows can have custom controls attached to the buttons.

   **Operating Tip** — Toggle **Show Attach** on the **Attach Custom Controls Menu** to **On** to show the control panel button that you are attaching the custom control to.

   3. Select the custom control that you want to attach to the selected button as follows:
• Use the **Bank** knob to select the custom control bank that you want to select the custom control from.
• Use the **Macro** knob to select the custom control that you want to attach.

4. Use the **Attachment Type** knob to select how the custom control is attached to the button as follows:
   - **Post-Attach** — Select this option to attach the custom control after the normal action of the button. When the control panel button is pressed, the normal function of the button is executed, followed by the custom control. For example, if the action of the button is an auto transition, the switcher will start the transition and then execute the custom control. Note that the switcher does not wait for the transition to complete before executing the custom control.
   - **Pre-Attach** — Select this option to attach the custom control before the normal action of the button. When the control panel button is pressed, the custom control is run, followed by the normal function of the button. The switcher does not wait for the custom control to complete before executing the normal function of the button.
   - **Replace** — Select this option to attach the custom control instead of the normal action of the button. When the control panel button is pressed, the custom control is run. The normal function of the button is not executed.

5. Press **Attach**.

---

**Operating Tip** — If you attach a custom control to a crosspoint button on the keyer bus, the **Show CC’s on Key Bus** personality option allows you to have the name of the custom control shown on the mnemonic for that button.

---

**For More Information...**
- on CC/Macro Attachment, refer to the section “**Personality List**” on page Eng 11-2.
- on Show CC’s on Key Bus, refer to the section “**Personality List**” on page Eng 11-2.

---

### Deleting Custom Control Attachment to Panel Buttons

1. Press HOME ➔ Custom Controls ➔ More ➔ Attach Macros.
2. Toggle **Show List** to On.

---

**Operating Tip** — You can delete all the attachments of custom controls to control panel buttons by pressing **Delete All Attachments** on the **Attach Custom Controls Menu**.
3. Use the **Scroll list with Knob 3** knob to select the custom control attachment that you want to remove.

4. Press **Delete Attachment**.
Naming Custom Controls

When a custom control has been programmed, it can be named. This name appears on the menus, the mnemonics, and the Shot Box buttons for the custom controls. This is useful when working with multiple custom control banks. As you switch banks, the mnemonics display the names for the custom controls on the selected bank.

1. Press HOME ⇒ Custom Controls.
2. Select the custom control button you want to name.

**Note** — If the custom control that you want to change the name for is already running, the Modify Name button is gray, and you cannot modify the name until the custom control has stopped.

3. Press Modify Name.

![Custom Control Name Menu](image)

**Operating Tip** — Refer to the section “Using the Naming Menus” on page Eng 5-17 for more information on using the Custom Control Name Menu to enter a name, or set up the mnemonics for the custom control button.

4. Enter the new name for the custom control bank in the New Name field. The name can be no more than 8 characters in length.
5. Press Accept New Name to store the new name and mnemonic settings.
Editing Custom Controls

Once a custom control has been created, you can go back and edit that custom control by inserting or removing events. Editing a custom control also allows you to view the sequence of events that were added, and then insert pauses, holds, or special functions or commands, where they are needed.

You cannot edit a custom control if the custom control is running on another panel connected to the system.

If a custom control contains pauses or holds, a timeline is shown, indicating the duration of the custom control, and at which points different events will occur.

The rest of the menu provides additional information on the currently selected event and the total duration of the custom control. This information is provided as follows:

- **Event** — The event field indicates the currently selected event, and the total number of events in the custom control.
- **Duration** — The duration field indicates the total time (seconds:fields) for the custom control to play out.
- **Event Information** — The event information is located at the bottom center of the menu and provides information on the MLE, key, or memory that is being used in the selected event. If more than one MLE is involved in the event, then the number for the lowest number MLE is displayed.

**Important** — You can only edit a custom control on the same panel it was recorded on, or a panel with the exact same settings, including MLE assignments and bus maps.

**To Edit a Custom Control**

1. Press HOME ⇒ Custom Controls.
2. Select the custom control you want to edit.
3. Press Edit/View. If you have selected a transport custom control, you can only view the events in the custom.

**Note** — If you are editing a Relative Custom Control, `<relative>` appears next to the Bank and Button identification, and the relative MLE level (R LVL) is displayed instead of the MLE number.
Operating Tip — You can test a single event in a custom control by selecting the event you want to test and pressing Run Single Event. You can use this feature to step through a custom control to check for errors. Similarly, the Run From Here function allows you to run the custom control from the currently selected event to the end.

4. Modify an event as follows:
   - Use the Event knob to select the event that you want to edit.
   - Press Modify Event.

5. Insert a control panel button event as follows:
   - Use the Event knob to select the location in the custom control that you want to insert the event. The new event is inserted before the selected event.
   - Press Insert Event.
6. Insert a special function event as follows:
   • Use the Event knob to select the location in the custom control that you want to insert the event. The new event is inserted before the selected event.
   • Press Insert Event.
   • Press Insert Special.
   • Insert the special events that you want to record to the custom control. Refer to the section “Programming Special Functions” on page Eng 10-15 for more information on inserting special events.
   • Press UP ONE to display the Custom Controls Menus.
   • Press Finish Inserting to save your changes. The Edit Custom Control Menu is displayed.

7. Delete an event as follows:
   • Use the Event knob to select the event you want to delete.
   • Press Delete Event to delete the selected event.
Managing Custom Controls

When a custom control has been programmed, the commands in that custom control can be copied, moved, or swapped with other custom controls on the switcher. This allows you to duplicate custom controls on different banks, or re-organize the custom controls.

You cannot copy, move, or swap a custom control if the custom control is running on another panel connected to the system.

Important — When you attach a custom control to a panel button, the association is with the custom control button, and not the custom control. If you change which custom control is assigned to the custom control button, that change is also applied to the attachment.

1. Press HOME ⇒ Custom Controls ⇒ Copy/Move Macros.
2. Press Source.
3. Select the source custom control as follows:
   • Use the Bank knob to select the bank that the custom control you want to manage is on.
   • Use the Button knob to select the custom control you want to copy, move, or swap.
4. Press Destination.

   ![Destination — Manage Custom Controls Menu](image)

5. Select the destination custom control as follows:
   • Use the Bank knob to select the bank that the custom control you want to manage is on.
   • Use the Button knob to select the custom control you want to paste or swap the custom control to.
6. Copy, Move, or Swap a custom control as follows:
   • Press Copy to copy the source custom control to the destination. Both custom controls will contain the same commands.
   • Press Move to move the source custom control to the destination. The commands in the source custom control are moved to the destination. The source custom control will be empty after the move.
   • Press Swap to swap the source custom control and the destination.
Deleting Custom Controls

Once a custom control have been created, you can delete the entire custom control from the Custom Controls Menu.

You cannot delete a custom control if the custom control is running on another panel connected to the system.

1. Press HOME ⇒ Custom Controls.

2. Select the custom control button you want to delete as follows:
   • Use the Bank knob to the select the bank that the custom control you want to delete is on.
   • Use the Button knob to select the custom control you want to delete. Only custom controls that have been programmed can be deleted.

3. Press Delete Macro. The Delete Custom Control Confirmation Screen is displayed.

   ![Delete Custom Control Confirmation Screen]

   - Press Confirm to delete the custom control.
   - Press Cancel to cancel deleting the custom control.
Custom Control Shortcuts

Shortcuts for common custom control commands can be mapped to custom control panel buttons. This allows you to perform tasks, such as recording and saving a custom control, right from the control panel, without having to use the menu system.

**Important** — Custom Control Shortcuts require the mnemonics option for the custom control bus be installed.

**Note** — The Custom Control Shortcuts do not support the CC Soft Shot Box, the Custom Control Shot Box, or the Auxiliary Control Panels.

1. Press HOME ➔ Setup ➔ Installation ➔ More ➔ Custom Controls.

   ![Custom Controls Menu](image)

2. Use the Bank/Function knob to select the shortcut you want to assign to a button.
   - **Record** — Select this option to create a custom control shortcut that allows you to record a custom control without using the menu system. To record a custom control using the shortcut, press and hold the Record button and select the custom control you want to record to. Both buttons flash red while recording. Press the Record (Cancel) button again to cancel the recording, or the custom control button you are recording to (Save), to save the recording.
   - **Pause(Hold)** — Select this option to create a custom control shortcut that allows you to insert a pause or hold into a custom control you are recording, without using the menu system. To insert a pause or hold into a custom control using the shortcut, press and hold the Pause button. A series of durations, in fields, are shown on the mnemonics for the custom control bus, as well as Hold, Hold for Run, and Hold for Run A-Z. Press the custom control button below the event to insert that pause or hold into the custom control. The Hold for Run A-Z buttons can only show as many groups as there are available custom control buttons on the bus.
   - **Bank** — Select this option to create a custom control shortcut that allows you to select any custom control bank without assigning each bank to a custom control button. Press and hold the Bank button and all the other custom control buttons change to bank select buttons. Select the bank you want and release both buttons.
   - **Run Held** — Select this option to create a custom control shortcut that allows you to resume all of the custom controls that are at hold from a Hold or Hold For Run event. Custom controls that are at hold from a Hold For Group event are unaffected.
   - **Run Held X** — Select this option to create a custom control shortcut that allows you to resume a group of held custom controls that are at hold from the Hold For...
Run X event. Press and hold the Run Held X button and all the other custom control buttons change to group select buttons. Select the group of custom controls that you want to resume.

- **Run A-Z** — Select this option to create a custom control shortcut that allows you to resume a specific group of held custom controls held by the Hold For Group custom control event. For example, press the Run A button to resume all the custom controls held in group A.

- **Stop CC** — Select this option to create a custom control shortcut that allows you to stop a, or all, running custom controls. The Stop CC command cannot stop a custom control that is at hold.
  - **Stop 1 CC** — Press and hold the Stop CC button and press the custom control button for the custom control you want to stop.
  - **Stop All CCs** — Double-Press the Stop CC button.

- **Stop Held X** — Select this option to create a custom control shortcut that allows you to stop a group of held custom controls that are at hold from the Hold For Run X event. Press and hold the Stop Held X button and all the other custom control buttons change to group select buttons. Select the group of custom controls that you want to stop.

3. Use the **Button** knob to select the custom control button that you want to assign as the shortcut. The custom control button you have selected lights up on the control panel.

4. Press **HOME** to display the **Installation Change Confirmation Screen**.
   - Press **Confirm** to accept the changes and reset all Remote, Peripheral, and Net ports.
   - Press **Confirm w/o Reset** to accept the changes without resetting all Remote, Peripheral, and Net ports. Only use this if told to do so by Ross Video Technical Support.
   - Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

---

**Operating Tip** — You can change the name of a custom control shortcut the same as you change the bank name. Refer to the section “Naming Custom Control Banks and Shortcuts” on page Eng 10-8 for more information.
Device Transport Commands

The Device Transport Commands allow you to use custom control buttons to send transport commands, such as play, stop, rewind, and pause, to a device using the Betacam protocol. Transport command buttons are tallied for the status of the device.

Transport commands are set up for a single device connected to an input source. If you need to control multiple devices, you must set up additional custom controls for each device.

Setting up Device Transport Commands

Device transport commands can only be added to a Transport custom control bank.

1. Press HOME ⇒ Custom Controls. If the Custom Control button is grayed out, the Custom Control Menu is being displayed on another panel connected to the system.
2. Use the Bank knob to select the Transport bank you want to program the transport command to.
3. Use the Button knob to select the custom control button you want to record to.
5. Press VTR.
6. Use the Input knob to select the VTR that you want to assign the transport command to. This is the VTR that the custom control will send the commands to.
7. Use the Function knob to select the command you want to assign to the button.
8. Press Insert to insert the command into the custom control. Only a single command can be programmed into the custom control.

Operating Tip — You can view the contents of a transport custom control by selecting the custom control button and pressing the View button on the Custom Controls Menu 1-2.
Custom Control Variable Pause

The Custom Control Variable Pause allows you to place a command in a custom control that will stop, or pause, a custom control where the pause is placed in the custom control. The length of time that the custom control is paused is set as the result of the Pause Equation.

Variable pauses are commonly used to insert pauses into custom controls to compensate for satellite uplink latency. For example, you can use a variable in all your custom controls where you need to sync with a satellite feed. You can then adjust that variable for changes in latency, and all your custom controls that use that variable are updated.

Setting a Custom Control Variable

1. Press HOME ⇒ Custom Controls ⇒ More ⇒ Set Variables.

![Set Variables Menu]

Operating Tip — Press Reset All on the Set Variables Menu to set all the variable to the default value (0).

2. Use the Variable knob to select the variable that you want to set a value for. If you change the value of a variable, all equations that use that variable will be changed.

3. Use the Frames and Seconds knobs to select the length of time that you want the variable set to. The number of frames for each second depends on the video format the switcher is operating in.

Inserting a Variable Pause

1. Press HOME ⇒ Custom Controls. If the Custom Control button is grayed out, the Custom Control Menu is active on another panel connected to the system.

2. Select the custom control you want to record to.

3. Press Start Recording ⇒ Insert Special ⇒ Special.

4. Use the Function knob to select V Pause CC.
5. In the **Enter Pause Eq’n** field, enter the equation you want to calculate the length of the variable pause. The equation can be any combination of variables that are added (+), subtracted (-) or multiplied (*) together. Negative numbers, division, and spaces are not supported. Side-by-side variables are multiplied together (AB=A*B).

6. Press **Insert** to insert the variable pause.
Swinger Personality

In This Chapter

This chapter provides information on finalizing the setup of the personality settings of your switcher, as well as the color schemes use for the control panel.

The following topics are discussed in this chapter:

- Personality List
- Control Panel Button Color Schemes
- Mnemonic Color Schemes
- Control Panel Display Brightness
- Loading Color Schemes
- Lock/Unlock Personality
## Personality List

There are a number of settings for how the switcher will react to different situations, or how switcher elements appear to the operator. All these settings are grouped together into the Switcher Personality. These settings include double press rates, memory bank cycling, and sleep time, among others.

This section covers the items on the Personality Scroll List only.

### Note

*Personality settings that can be set for an individual control panel must be set from the control panel, or panel id, you want them to apply to.*

1. Press HOME ⇒ Setup ⇒ Personality.

2. Use the Option knob to select the option you want to set. Refer to the following table (Table 11.1) for a list of options and values.

3. Use the Value knob to select the value you want to set for the selected option.

### For More Information...

- on **3D Pattern Button Assign**, refer to the section “DVE Wipe Pattern Button Assignment” on page Ops 14-13.

- on **Standard Mnemonics**, refer to the section “Default Mnemonic Appearance” on page Eng 5-13.


- on **Color Scheme**, refer to the section “Control Panel Button Color Schemes” on page Eng 11-17.

- on **MLE Maps**, refer to the section “Default MLE Map Assignment” on page Eng 12-5.

- on **Preview Font Colors**, refer to the section “Preview Overlay Setup” on page Eng 12-30.

- on **Autofollow Setup**, refer to the section “Auto Follow” on page Eng 12-39.

- on **Squeeze & Tease Mode**, refer to the section “Squeeze & Tease Mode” on page Eng 12-6.
Table 11.1  Personality Option Settings

<table>
<thead>
<tr>
<th>Personality Option</th>
<th>Description</th>
<th>Values</th>
</tr>
</thead>
</table>
| Assign MLE (Assign MLE) | The Assign MLE feature allows you to disable the ability to assign a control panel row to a different MLE. The control panel row will be locked to the currently assigned MLE.                                  | • On — Select this option to allow a panel row to be assigned to a different MLE.  
  • Off — Select this option to disable the ability to assign a different panel row to an MLE. The Assign MLE button on the MLE Sel Button Menu is grayed out. |
| Audio Cut Only (AudioCutOnly) | The Audio Cut Only feature sets whether audio transitions occur at the same rate as the video transition, or whether the audio transitions cut. Note that this is not a true cut as the speed that one channel is taken off-air and the next channel is taken on-air depends on the Audio Mixer.  
When Editor Remote Enable is Enabled, and OverDrive is controlling the switcher, the audio transition rate for the PGM MLE is set from OverDrive. | • On — Select this option to have audio transition cut, regardless of the type or rate of the video transition.  
• Off — Select this option when using OverDrive, or to have the audio transition at the same rate as the video or at the Audio Fade rate. |
| Audio Transition (AudioTrans) | Depending on how you want audio transitions to be performed, you can set up the switcher so that it will either perform an audio transition when a transition is performed on any MLE, or only when a transition is performed on an on-air MLE.  
Note: If OverDrive is controlling the switcher, this is locked to All. | • All — Select this option to have the switcher perform an audio transition when any MLE is transitioned.  
• Pgm — Select this option to have the switcher perform an audio transition only when an on-air MLE is transitioned. An MLE is considered to be on-air when it is re-entered onto the Program/Preset MLE. |
| Auto Key Alpha (Auto Key Alpha) | The Auto Key Alpha feature allows you to select how the switcher treats the alpha when the internally generated Black is assigned to an auto key.                                                                 | • Relaxed - Select this option to have the switcher treat the alpha as if it is white. The key is not transparent.  
• Strict - Select this option to have the switcher treat the alpha as if it is black. The key is fully transparent. |
| Auto Recall (Auto Recall) | The Auto Recall feature sets whether or not the switcher includes switcher settings, such as Effects Dissolve on or off, with the memory.                                                                        | • Off — Select this option to have memories not recall KEYS ONLY, Effects Dissolve and DVE Wipe settings with the memory. These attributes must be turned on manually before the memory is recalled. This is the default setting.  
• On — Select this option to have memories also recall the KEYS ONLY, Effects Dissolve (EFF DISS) settings stored with the memory from the Global Memory Module. |
### Table 11.1  Personality Option Settings

<table>
<thead>
<tr>
<th>Personality Option</th>
<th>Description</th>
<th>Values</th>
</tr>
</thead>
</table>
| Auto Remove Key (AutoRemoveKey)    | The Auto Remove Key feature allows you to have the switcher remove a Keyer from the Next Transition after that Keyer has been transitioned off-air from the Keyers Module. For example, Key 2 is on-air and it is selected as part of the next transition on the Transition Module. If you cut or dissolve Key 2 off-air from the Keyers Module, Key 2 will be de-selected for the next transition on the Transition Module. If Key 2 was the only selected item for the next transition, the background will be selected instead. | • Off — Select this option to have the switcher not remove the Keyer from the next transition selection if it has just been transitioned off-air from the Keyers Module.  
• On — Select this option to have the switcher remove the Keyer from the next transition selection if it has just been transitioned off-air from the Keyers Module. |
| Bank 0 Lit (Bank 0 Lit)            | The Bank 0 Lit feature sets whether or not the Bank button on the Memory Modules is lit when Bank 0 is selected.                                                                                             | • Off — Select this option to have the BANK button not lit when Bank 0 is selected.             
• On — Select this option to have the BANK button lit when Bank 0 is selected in the Memory Module, or Global Memory Module. |
| BKGD Double Press (BKGD DblPress)  | The Background Double-Press feature allows you to have a double-press of the BKGD button on a Transition Module select background and all on-air keyers as part of the next transition.                                         | • Off — Select this option to not include the on-air keyers with the next transition when the BKGD button is double-pressed.                          
• On — Select this option to include all on-air keyers with the next transition when the BKGD button is double-pressed. |
| Camera Grab Time (Camera Grab)     | The Camera Grab Time feature allows you to have the switcher select the first camera on the preview bus a set amount of time (in seconds) after a transition has been performed. This allows you to automatically have menu and positioner control over the camera when OverDrive prepares the next shot. A duration of 0 seconds turns this feature off.  
Note: This feature is only active when Editor is turned on.                                                                                       | Use the Time knob to set the time (in seconds) after a transition that the switcher selects the camera. |
| CC/Macro Attachments (CC Attachments) | The Custom Control/Macro Attachment feature sets whether or not custom controls that are attached to control panel buttons using the Attach Custom Controls Menu are run when the button is pressed.                                                                                   | • Off — Select this option to have custom controls attached to control panel buttons not run when the button is pressed.                        
• On — Select this option to have custom controls attached to control panel buttons run when the button is pressed. |
<table>
<thead>
<tr>
<th>Personality Option</th>
<th>Description</th>
<th>Values</th>
</tr>
</thead>
</table>
| CC Global Recall (CC Global Recall)| The CC Global Recall feature sets whether or not the RECALL CLIP/CC button on the Global Memory module can be used to run a custom control. | • Off — Select this option to only allow clips to be recalled from the Global Memory module using the RECALL CLIP/CC button.  
• On — Select this option to only allow custom controls to be run from the Global Memory module using the RECALL CLIP/CC button. |
| Clear Bus Hold on All-All (Clear BusHold) | The Clear Bus Hold on All-All feature sets whether or not the Bus Hold selection on a bus is cleared when a soft-reset is performed. | • Off — Select this option to have the Bus Hold feature not cleared when a software reset is performed.  
• On — Select this option to have the Bus Hold feature cleared on every bus when a software reset is performed. |
| Default Trans Active (Dft Trns Activ) | The Default Transition Active feature allows you to set a default transition rate for switcher transitions, effects, and sequences. | • Off — Select this option to use the video format based default transition rates when you default an MLE or the entire switcher.  
• On — Select this option to use the selected default transition rates when you default an MLE or the entire switcher. |
| Default Trans Eff Rate (Dft Trns Eff) | The Default Transition Effects Dissolve Rate feature allows you to set a default effects dissolve rate.  
This rate is only used if the Default Trans Rate Active feature is set to On. | • Use the Rate knob to set a default rate, in frames. |
| Default Trans FTB Rate (Dft Trns FTB) | The Default Transition Fade to Black Rate feature allows you to set a default fade to black rate.  
This rate is only used if the Default Trans Rate Active feature is set to On. | • Use the Rate knob to set a default rate, in frames. |
| Default Trans Key Rate (Dft Trns Key) | The Default Transition Key Rate feature allows you to set a default Keyer transition rate.  
This rate is only used if the Default Trans Rate Active feature is set to On. | • Use the Rate knob to set a default rate, in frames. |
| Default Trans PGM Rate (Dft Trns PGM) | The Default Transition PGM(MLE) Rate feature allows you to set a default MLE transition rate.  
This rate is only used if the Default Trans Rate Active feature is set to On. | • Use the Rate knob to set a default rate, in frames. |
| Default Trans Seq Rate (Dft Trns Seq) | The Default Transition Sequence Rate feature allows you to set a default sequence rate.  
This rate is only used if the Default Trans Rate Active feature is set to On. | • Use the Rate knob to set a default rate, in frames. If you set the rate to 1, the transition uses the duration set in the sequence. |
### Table 11.1 Personality Option Settings

<table>
<thead>
<tr>
<th>Personality Option</th>
<th>Description</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Double Press Rate</td>
<td>The Double-Press Rate feature sets the length of time that you have to press a button a second time in order for the switcher to treat it as a double-press.</td>
<td>Use the <strong>Value</strong> knob on the <strong>Personality Menu 1-2</strong> to select the amount of time, in frames, that you are given to press a button again for the switcher to treat it as a double-press.</td>
</tr>
<tr>
<td>(DblPress Rate)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DSK 1 Auto Cut</td>
<td>The Downstream Keyer Auto Cut feature sets whether or not the DSKs are cut off-air when a source is selected directly on the Main Program Bus of the switcher.</td>
<td>Off — Select this option to have the Downstream Keyers not affected by selections made directly on the <strong>Program Bus</strong> of the <strong>Program/Preset MLE</strong>. On — Select this option to have the selected Downstream Keyers automatically taken off-air when any source is selected directly on the <strong>Program Bus</strong> of the <strong>Program/Preset MLE</strong>.</td>
</tr>
<tr>
<td>(DSK1 Auto Cut)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DSK 2 Auto Cut</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(DSK2 Auto Cut)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DSK 3 Auto Cut</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(DSK3 Auto Cut)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DSK 4 Auto Cut</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(DSK4 Auto Cut)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DSK 5 Auto Cut</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(DSK5 Auto Cut)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DSK 6 Auto Cut</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(DSK6 Auto Cut)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DSK 7 Auto Cut</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(DSK7 Auto Cut)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DSK 8 Auto Cut</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(DSK8 Auto Cut)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
The Editor Pattern Codes feature sets whether or not the GVG100, GVG100/200, or GVG4000 editor pattern codes are displayed on the pattern buttons. When active for a particular editor protocol, the plain or hexidecimal pattern code is shown on the pattern buttons on the Pattern Selection Menu.

<table>
<thead>
<tr>
<th>Personality Option</th>
<th>Description</th>
<th>Values</th>
</tr>
</thead>
</table>
| Editor Pattern Codes        | The Editor Pattern Codes feature sets whether or not the GVG100, GVG100/200, or GVG4000 editor pattern codes are displayed on the pattern buttons. When active for a particular editor protocol, the plain or hexidecimal pattern code is shown on the pattern buttons on the Pattern Selection Menu. | • None — Select this option to have no pattern code numbers on the pattern buttons.  
• GVG100 Bttn# — Select this option to have the GVG100 button number, for the pattern, displayed on the pattern button.  
• GVG100 Bttn#H — Select this option to have the GVG100 button number, for the pattern, displayed in hexidecimal on the pattern button.  
• GVG100/200 — Select this option to have the GVG100/200 pattern code displayed on the pattern button.  
• GVG100/200 H — Select this option to have the GVG100/200 pattern code displayed in hexidecimal on the pattern button.  
• GVG4000 — Select this option to have the GVG4000 pattern code displayed on the pattern button.  
• GVG4000 H — Select this option to have the GVG4000 pattern code displayed in hexidecimal on the pattern button.  
• OverDrive — Select this option to have the Ross pattern code displayed on the pattern button. Use this number to select a pattern in OverDrive. |
| Editor Trans Rates          | The Editor Transition Rates feature sets whether transition rates that are set from an external editor are doubled or not. | • Normal — Select this option to have the transition rates that are set from an external editor not changed.  
• Double — Select this option to have the transition rates that are set from an external editor doubled. |
| ExCamMoveOnTrans            | The Execute Camera Move on Transition feature sets whether the camera move will be triggered with a transition or not. | • Off — Select this option to not have the camera move execute on a transition.  
• On — Select this option to have the camera move execute on a transition.  
• Roll Clip — Select this option to use the Roll Clip functionality to have a camera move execute on a transition. The set Preroll time is be used. |
### Table 11.1 Personality Option Settings

<table>
<thead>
<tr>
<th>Personality Option</th>
<th>Description</th>
<th>Values</th>
</tr>
</thead>
</table>
| **Fixed Memories** (Fixed Mem) | The Fixed Memory feature allows you to select whether memories are recalled on the MLEs that they were recorded on, or whether they are recalled on MLEs relative to the PGM MLE. | • **Off** — Select this option to have memories recalled on MLEs that are the same relative distance from the PGM MLE as they were recorded. For example, if MLE 4 is the Program MLE and you store a memory on MLE 2. If you change the Program MLE to MLE 8, the memory is recalled on MLE 6.  
  • **On** — Select this option to have memories recalled on same MLE they were recorded on. |
| **FTB Display** (FTB Display) | The Fade to Black Display Mode sets whether the display on the Fade to Black Module will display the current fade rate, or the number of Up/Down Converters available on the switcher.  
Refer to the section “Fade to Black Display Mode for Up/Down Converters” on page Eng 16-7 for information on setting the Fade to Black Display feature. | • **SmrtConv** — Select this option to have the display on the Fade to Black Module show the number of available up/down converters for SmartConversion to use.  
  • **FTB** — Select this option to have the display on the Fade to Black Module show the transition rate for a Fade to Black transition. |
| **Global Mem Num Entry** (Glob NumEntry) | The Global Memory Number Entry Mode sets whether the keypad on the Global Memory Module can be used to enter Punchpad values. | • **Off** — Select this option to not be able to use the keypad on the Global Memory Module to enter Punchpad values.  
  • **On** — Select this option to be able to use the keypad on the Global Memory Module to enter Punchpad values. |
| **Global-Store 4 Mode** (GlobStorChan4) | The Global-Store 4 Mode option sets whether or not the 4th channel of Global-Store is available or not. This channel is shared by the Preview Overlay. When Global-Store channel 4 is active, the Preview Overlay is not available. | • **Still-Store** — Select this option to enable Global-Store channel 4. Preview Overlay is disabled.  
  • **Pvw Overlay** — Select this option to disable Global-Store channel 4. The Preview Overlay is enabled. |
| **Isolate MultiDSK** (ISO MultiDSK) | You can isolate the MultiDSKs to prevent them from being affected by memory recalls and soft-resets of the switcher. If you isolate the MultiDSKs, you will not be able to include them in a transition on the Transition Module. You will only be able to transition the MultiDSKs from the Keyers Module. | • **Off** — Select this option to include the MultiDSKs with the rest of the MLE.  
  • **On** — Select this option to isolate the MultiDSKs from the rest of the MLE. The MultiDSKs will not be affected by memory recalls, soft-resets, or Program/Preset MLE Transitions. |
### Key Cut Then Fade (KeyCutThenDis)

The Key Cut then Fade feature allows you to change the behavior of the **CUT** button on the **Keyers** module. When this feature is active, the **CUT** button on the **Keyers** module will cut a key on-air, but dissolve, or fade, the key off-air. This allows you to use the same button to cut a key on-air and then transition it off-air. If you press **CUT** as the key is being transitioned off-air, a cut is immediately performed to take the key off-air.

- **Off** — Select this option to have the **CUT** button on all **Keyers** modules operate normally.
- **On** — Select this option to have the **CUT** button on all **Keyers** modules will cut keys on-air, but dissolve them off-air.

### Keypad Clip IDs Entry (KeypadClipIDs)

The Keypad Clip IDs Entry feature sets whether the Global Memory or Effects Memory keypads allow you to select a clip on a video server.

- **None** — Select this option to have the keypads not allow you to load a clip on the selected video server.
- **MLE** — Select this option to have only the Effects Memory keypad allow you to load a clip on the selected video server.
- **Global** — Select this option to have only the Global Memory keypad allow you to load a clip on the selected video server.
- **Both** — Select this option to have all keypads allow you to load a clip on the selected video server.

### Keypad DVE Num Entry (KeypadDVE)

The Keypad DVE Num Entry feature sets whether the Global Memory or Effects Memory keypads allow you to select a DVE wipe pattern for a transition.

- **None** — Select this option to have the keypads not allow you to select a new DVE wipe pattern for a transition.
- **MLE** — Select this option to have only the Effects Memory keypad allow you to select a new DVE wipe pattern for a transition.
- **Global** — Select this option to have only the Global Memory keypad allow you to select a new DVE wipe pattern for a transition.
- **Both** — Select this option to have all keypads allow you to select a new DVE wipe pattern for a transition.

### Keypad Still Num Entry (KeypadStill)

The Keypad Still Num Entry feature sets whether the Global Memory or Effects Memory keypads allow you to load a still in a Global-Store or MLE-Store.

- **None** — Select this option to have the keypads not allow you to load a still.
- **MLE** — Select this option to have only the Effects Memory keypad allow you to load a still.
- **Global** — Select this option to have only the Global Memory keypad allow you to load a still.
- **Both** — Select this option to have all the keypads allow you to load a still.

---

**Table 11.1 Personality Option Settings**

<table>
<thead>
<tr>
<th>Personality Option</th>
<th>Description</th>
<th>Values</th>
</tr>
</thead>
</table>
| Key Cut Then Fade (KeyCutThenDis) | The Key Cut then Fade feature allows you to change the behavior of the **CUT** button on the **Keyers** module. When this feature is active, the **CUT** button on the **Keyers** module will cut a key on-air, but dissolve, or fade, the key off-air. This allows you to use the same button to cut a key on-air and then transition it off-air. If you press **CUT** as the key is being transitioned off-air, a cut is immediately performed to take the key off-air. | **Off** — Select this option to have the **CUT** button on all **Keyers** modules operate normally.  
**On** — Select this option to have the **CUT** button on all **Keyers** modules will cut keys on-air, but dissolve them off-air. |
| Keypad Clip IDs Entry (KeypadClipIDs) | The Keypad Clip IDs Entry feature sets whether the Global Memory or Effects Memory keypads allow you to select a clip on a video server. | **None** — Select this option to have the keypads not allow you to load a clip on the selected video server.  
**MLE** — Select this option to have only the Effects Memory keypad allow you to load a clip on the selected video server.  
**Global** — Select this option to have only the Global Memory keypad allow you to load a clip on the selected video server.  
**Both** — Select this option to have all keypads allow you to load a clip on the selected video server. |
| Keypad DVE Num Entry (KeypadDVE) | The Keypad DVE Num Entry feature sets whether the Global Memory or Effects Memory keypads allow you to select a DVE wipe pattern for a transition. | **None** — Select this option to have the keypads not allow you to select a new DVE wipe pattern for a transition.  
**MLE** — Select this option to have only the Effects Memory keypad allow you to select a new DVE wipe pattern for a transition.  
**Global** — Select this option to have only the Global Memory keypad allow you to select a new DVE wipe pattern for a transition.  
**Both** — Select this option to have all keypads allow you to select a new DVE wipe pattern for a transition. |
| Keypad Still Num Entry (KeypadStill) | The Keypad Still Num Entry feature sets whether the Global Memory or Effects Memory keypads allow you to load a still in a Global-Store or MLE-Store. | **None** — Select this option to have the keypads not allow you to load a still.  
**MLE** — Select this option to have only the Effects Memory keypad allow you to load a still.  
**Global** — Select this option to have only the Global Memory keypad allow you to load a still.  
**Both** — Select this option to have all the keypads allow you to load a still. |
<table>
<thead>
<tr>
<th>Personality Option</th>
<th>Description</th>
<th>Values</th>
</tr>
</thead>
</table>
| **Keypad Wipe Num Entry (KeypadWipe)** | The Keypad DVE Num Entry feature sets whether the Global Memory or Effects Memory keypads allow you to select a wipe pattern for a wipe transition. | • **None** — Select this option to have the keypads not allow you to load a wipe pattern.  
• **MLE** — Select this option to have only the Effects Memory keypad allow you to load a wipe pattern.  
• **Global** — Select this option to have only the Global Memory keypad allow you to load a wipe pattern.  
• **Both** — Select this option to have all the keypads allow you to load a wipe pattern. |
| **Matte Limit (Matte Limit)** | The Matte Limit feature sets whether or not the Matte Generators on the switcher are limited to the RGB color space or not. | • **Off** — Select this option to have the color range of the matte generators not limited to the RGB color space. This is the default setting.  
• **On** — Select this option to have the color range of the matte generators limited to the RGB color space. |
| **Memory Bank Cycle (MemBank Cycle)** | The Memory Bank Cycle feature sets the maximum number of memory banks that you will cycle through when pressing the Bank button on a Memory Module.  
**Note:** This feature is disabled if Quick Bank Select is set to On. | • Use the Value knob on the Personality Menu 1-2 to select the maximum number of Memory Banks you want to cycle through, starting from Bank00.  
By repeatedly pressing the BANK button on the keypad of the Memory Modules or Global Memory Module, you can jump from bank to bank. The Cycle Max value sets how many Banks you can cycle through, starting at Bank00, before jumping back to Bank00. |
| **Mouse Sensitivity (Mouse Speed)** | The Mouse Sensitivity feature allows you to set the speed that the mouse pointer moves around the screen when you move the mouse. | • Use the Value knob on the Personality Menu 1-2 to select a sensitivity, or speed, for the mouse. |
| **Multiple Customs (Multiple CCs)** | The Multiple Custom Controls feature allows you to set whether the switcher can run multiple custom controls simultaneously or only one at a time.  
**Note:** If OverDrive is controlling the switcher, this is locked to Off. | • **On** — Select this option to allow multiple custom controls to run simultaneously. Starting a custom control while a custom control is running does not stop the other custom control and the currently selected one starts.  
• **Off** — Select this option to allow only one custom control to run at a time. Starting a custom control while a custom control is running stops the running custom control and starts the new one. |
### Table 11.1 Personality Option Settings

<table>
<thead>
<tr>
<th>Personality Option</th>
<th>Description</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Panel Sleep Time</td>
<td>The Panel Sleep Time feature sets the length of time before the switcher goes into sleep mode. <strong>Note:</strong> An Audio Control Module that is installed on an external panel row will not go into sleep mode, and using the module will not wake the rest of the panel.</td>
<td>• Use the <strong>Value</strong> knob on the <strong>Personality Menu</strong> 1-2 to select the amount of time, in minutes, that the control panel will go without being use before entering sleep mode. Selecting a sleep time of 0 prevents the control panel from entering sleep mode.</td>
</tr>
<tr>
<td>Pbus Memory</td>
<td>The Pbus Memory feature allows you to store or recall memories on a Pbus device when you store or recall memories on the switcher.</td>
<td>• <strong>No Send</strong> — Select this option to have the switcher not tell the Pbus devices to store or recall memories. • <strong>Send</strong> — Select this option to have the switcher tell all connected Pbus devices to perform a memory store or recall when one is performed on the switcher. The memory number is the same as the one used on the switcher.</td>
</tr>
<tr>
<td>Quick Bank Select</td>
<td>The Quick Bank Select feature allows you to select a memory bank by either holding the <strong>BANK</strong> button and selecting the bank, or by pressing the <strong>BANK</strong> button, and then selecting the bank. You can always select a bank by pressing and holding the <strong>BANK</strong> button and selecting the bank.</td>
<td>• <strong>Off</strong> — Select this option to select a memory bank by pressing and holding the <strong>BANK</strong> button, and selecting the bank. • <strong>On</strong> — Select this option to select a memory bank by pressing and releasing the <strong>BANK</strong> button, and selecting the bank.</td>
</tr>
<tr>
<td>Recall Global-Store</td>
<td>The Recall Global-Store Memory Mode sets whether the Global-Store settings are included with memory recalls always, only when turned on from the <strong>MLE Memory Attributes Menu</strong>, or never.</td>
<td>• <strong>Never</strong> — Select this option to have Global-Store settings never included during memory recalls. The stills loaded in the Global-Store channels are not replaced with those included in the memory. • <strong>Always</strong> — Select this option to have Global-Store settings always included during memory recalls. The stills loaded in the Global-Store channels are replaced with those included in the memory. • <strong>Attributes</strong> — Select this option to have Global-Store setting included during memory recalls if the Global-Store channel is turned on from the <strong>MLE Memory Attributes Menu</strong>.</td>
</tr>
</tbody>
</table>
### Table 11.1 Personality Option Settings

<table>
<thead>
<tr>
<th>Personality Option</th>
<th>Description</th>
<th>Values</th>
</tr>
</thead>
</table>
| Recall MLE-Store        |             | **Never** — Select this option to have MLE-Store settings never included during memory recalls. The stills loaded in the MLE-Store channels are not replaced with those included in the memory.  
**Always** — Select this option to have MLE-Store settings always included during memory recalls. The stills loaded in the MLE-Store channels are replaced with those included in the memory.  
**Attributes** — Select this option to have MLE-Store setting included during memory recalls if the MLE-Store channel is turned on from the MLE Memory Attributes Menu. |
| Recall WhiteFlash       |             | **Never** — Select this option to have WhiteFlash settings never included during memory recalls.  
**Always** — Select this option to have WhiteFlash settings always included during memory recalls.  
**Attributes** — Select this option to have WhiteFlash setting included during memory recalls if the Transition Area option is turned on from the MLE Memory Attributes Menu. |
| Re-entry Depth          |             | **Prevent** — You can only create re-entry chains up to 4 MLEs deep.  
**Warn** — You can create re-entry chains over 4 MLEs deep, but a pop-up is displayed.  
**Allow** — You can create re-entry chains over 4 MLEs deep. |
| Re-entry Loops          |             | **Off** — Select this option to have the switcher block re-entry loops. If a crosspoint is selected that would cause a re-entry loop, a popup is displayed and the crosspoint is not selected. If the crosspoint selection is contained in a memory, Black is selected instead.  
**On** — Select this option to have the switcher not block re-entry loops. A popup is displayed. |
**Table 11.1 Personality Option Settings**

<table>
<thead>
<tr>
<th>Personality Option</th>
<th>Description</th>
<th>Values</th>
</tr>
</thead>
</table>
| Roll Clip Mode (RollClip Mode)   | The Roll Clip Mode determines how the ROLL CLIP button behaves when a server is selected on the preview bus. This setting is applied to all MLEs on the switcher. Note: If OverDrive is controlling the switcher, this is locked to Arm. | • Play — This mode allows you to play a server clip directly by pressing the ROLL CLIP button on the Transition Module. Once pressed, the clip will start to play and will have to be taken on-air manually with a transition.
• Arm — This mode allows you to have the server play the clip with the next transition performed in the Transition Module that the ROLL CLIP button is on, or lit, in. This can be used to roll multiple servers if they are re-entered. Once pressed, the clip will only start to play when a Cut or Auto-Transition is performed. You can also play the clip by double-pressing the crosspoint button on the same MLE.
• Armed Always — This selection locks the switcher in Arm and does not allow the ROLL CLIP button to be turned off. |
| Roll Clip On-Air Only (RIClipOnAirOnly) | The Roll Clip On-Air Only determines how to play a clip based on the MLE On-Air status.                     | • Always — Select this option to always play a server clip even if the MLE is not On-Air.
• On-Air Only — Select this option to play a server clip only when the MLE is On-Air. |
| Shift Locking (Shift Locking)   | The Shift Locking feature sets whether double-pressing the SHIFT button on a crosspoint bus toggles shift on. Note: If Shift Lock is active on an MLE, the mnemonics for that MLE switch to a two-line format. | • Off — Select this option to have the Shift button function normally.
• On — Select this option to have the bus remain shifted when the SHIFT button is double-pressed. Pressing the SHIFT button again returns the bus to unshifted. |
| Show CC’s on Key Bus (ShowCCAttach) | The Show CC’s on Key Bus feature sets whether or not custom controls that are attached to crosspoint buttons on the keyer bus are shown on the keyer mnemonics. | • Off — Select this option to not show the custom control name on the mnemonic.
• On — Select this option to show the name of the custom control attached to a crosspoint button on the mnemonic. |
**Table 11.1 Personality Option Settings**

<table>
<thead>
<tr>
<th>Personality Option</th>
<th>Description</th>
<th>Values</th>
</tr>
</thead>
</table>
| **Show Last CC Pressed (Show Last CC)** | The Show Last Custom Control Pressed feature allows you to keep the last pressed custom control button lit after the custom control has finished. The button remains lit until another custom control is pressed or the switcher is reset. This is shown for each custom control bank independently. Use the **Color** knob to select the color you want the custom control button to be lit with. | **Off** — Select this option to not continue to light the custom control button after the custom control has finished.  
**On** — Select this option to continue to light the custom control button after the custom control has ended. |
| **Show Last Mem Recalled (Show Last Mem)** | The Show Last Memory Recalled feature allows you to keep the last pressed memory number lit after you have recalled a memory on the same bank. The button remains lit until another memory is recalled or the switcher is reset. This is shown for each effects memory module independently. | **Off** — Select this option to not light the last memory number you have recalled.  
**On** — Select this option to light the last memory number you have recalled, if the memory is in the same bank. |
| **Squeeze & Tease Mode (S&T Mode)** | Refer to the section “Squeeze & Tease Mode” on page Eng 12-6 for information on this personality setting. | |
| **Store Mode (Store Mode)** | The Store Mode sets whether or not a memory module remains in Store Mode after a memory has been stores, or switch to Recall Mode. | **Hold** — Select this option to have the **Global Memory Module**, or the **Memory Module**, stay in Store mode after a memory has been stored.  
**1-Time** — Select this option to have the **Global Memory Module**, or the **Memory Module**, switch to Recall mode after a memory has been stored. |
| **Swap Keyer Cut & Auto (SwapKeyC/A)** | The Swap Keyers Cut & Auto feature allows you to swap the behavior of the **CUT** and **Auto TRANS** buttons on the **Keyers** module. When this feature is set to swap, the **CUT** button performs an auto transition, and the **AUTO TRANS** button performs a cut. | **Swap** — Select this option to have the **CUT** and **AUTO TRANS** buttons on all **Keyers** modules swap their functions. The **CUT** button performs an Auto Trans.  
**Normal** — Select this option to have the transition buttons on the **Keyers** modules keep their original functions. |
| **Swap PGM/PST Buses (SwapPGM/PST)** | The Swap Program and Preset Buses feature allows you to swap the functions of the Program bus to the Preset bus on all MLEs. When this feature is turned on, the sources that you select on the preset bus act as if they are being selected on the program bus, and the sources selected on the program bus act as if they are being selected on the preset bus. | **Swap** — Select this option to have the Program and Preset buses on all MLEs swapped.  
**Normal** — Select this option to have the Program and Preset buses keep their original functions. |
### Table 11.1 Personality Option Settings

<table>
<thead>
<tr>
<th>Personality Option</th>
<th>Description</th>
<th>Values</th>
</tr>
</thead>
</table>
| Swap Trans Cut & Auto (SwapTransC/A) | The Swap Trans Cut & Auto feature allows you to swap the behavior of the CUT and AUTO TRANS buttons on the Transition module. When this feature is set to swap, the CUT button performs an auto transition, and the AUTO TRANS button performs a cut. | - **Swap** — Select this option to have the CUT and AUTO TRANS buttons on all Transition modules swap their functions. The CUT button performs an Auto Trans.  
- **Normal** — Select this option to have the transition buttons on the Transition modules keep their original functions. |
| Time Clock Source (TimeClock Src) | The Time Clock Source feature allows you to set the source for the Preview Overlay Time Clock. This source can either be internally generated, or generated from an external UMD device. An external UMD device must be set up on a Remote port in order for the switcher to receive time clock data. | - **Internal** — Select this option to have the switcher use the internally generated time clock data.  
- **UMD Input** — Select this option to have the switcher use data from an external UMD device for the time clock. You must use the Time Clock UMD Number feature to set which UMD Address that the time clock data should come from. |
| Time Clock UMD Number (TimeClock UMD) | The Time Clock UMD Number feature allows you to set the specific address of the UMD input that you want to get the time clock data from.                                                                           | - Use the Value knob on the Personality Menu 1-2 to select the address, or UMD input number, that you want to get the time clock data from. |
| UltraChrome Dflt Color (UCchrome Color) | The UltraChrome Default Color feature allows you to set the default color that the UltraChrome will be set to when the keyer has been defaulted. Once a different color is set for the UltraChrome, that new color remains until the keyer is defaulted, or until a different UltraChrome color is set manually. | - Use the Value knob on the Personality Menu 1-2 to select the default color you want to use for UltraChrome. |
| UltraChrome Dflt Mode (UCchrome Mode) | The UltraChrome Default Mode feature allows you to set the default mode that UltraChrome operates in. Once a different mode is set for the UltraChrome, that mode remains until the keyer is defaulted, or until a different UltraChrome mode is set manually. | - Use the Value knob on the Personality Menu 1-2 to select the default mode for UltraChrome. Refer to the section “UltraChrome Operating Modes” on page Ops 7-11 for more information on the UltraChrome modes. |
| UltraChrome Dflt Width (UCchrome Edge) | The UltraChrome Default Edge Width feature sets whether or not the Edge Sensitivity is set to High or Low when the chroma key is initialized.                                                                     | - **On** — Select this option to have Edge Sensitivity set to Low and the Width set to 2 when the key is initialised.  
- **Off** — Select this option to have Edge Sensitivity set to High and the Width set to 0 when the key is initialised. |
| VTR POL On-air Display (VTR On-air) | The VTR On-air feature allows you to specify whether the current timecode or the remaining time (for a video server) of the currently loaded clip is displayed on the On-air line on the Preview Overlay when VTR TC is active.                                                                 | - **Current** — Select this option to use the current timecode of the VTR, or Video Server.  
- **Remaining** — Select this option to use the remaining time of the currently loaded clip. Cannot be used for VTRs, on Video Servers. |
The VTR Prepared feature allows you to specify whether the current timecode or the remaining time (for a video server) of the currently loaded clip is displayed on the Prepared line on the Preview Overlay when VTR TC is active.

- **Current** — Select this option to use the current timecode of the VTR, or Video Server.
- **Remaining** — Select this option to use the remaining time of the currently loaded clip. Cannot be used for VTRs, on Video Servers.

The Wake Up On Command feature allows you to specify whether the control panel will wake from sleep mode when it receives a command from OverDrive.

- **On** — Select this option to have the control panel wake up when it receives a command from OverDrive.
- **Off** — Select this option to have the control panel not wake up when it receives a command from OverDrive.

<table>
<thead>
<tr>
<th>Table 11.1 Personality Option Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Personality Option</td>
</tr>
<tr>
<td>---------------------</td>
</tr>
<tr>
<td>VTR POL Prep’d Display (VTR Prep’d)</td>
</tr>
<tr>
<td>Wake Up On Command (Wakeup On Cmd)</td>
</tr>
</tbody>
</table>
Control Panel Button Color Schemes

The current color selection for the buttons on the control panel can be edited at any time during operation. This allows you to change the glow color for MLEs and AuxKeys, as well as the on-air crosspoints, or apply a specific color to an input. The color of the control buttons on the control panel modules can also be edited.

General Color Usage Setup

There are a number of options for how the colors of the buttons on the Vision control panel can be organized. Each MLE can have a unique color, or they can all be the same. Unique colors can also be applied to the buttons on the touchscreen display, and the auxiliary control panels, as well as the selected crosspoint or function buttons. The MLE re-entry buttons and specific crosspoint buttons can have unique colors as well.

The color usage for the control panel must be set up before the individual colors can be edited.

1. Press HOME ➔ Setup ➔ Personality ➔ Color Scheme.

2. Toggle the MLEs Same Clr to On or Off to apply the same color all MLEs:
   - **Off** — Select this option to use individual color schemes for each MLE on the switcher. Each MLE will have the current color scheme that is assigned to it displayed on the menu.
   - **On** — Select this option to use the same color scheme for all MLEs on the switcher. The individual color schemes for each MLE are replaced with a global color scheme.

4. Assign a color for selected crosspoint buttons as follows:
   - Use the Option knob to select Selected Xpts.
   - Use the Use knob to select which color you want to use for the selected buttons. You can choose between the following:
     - **Item On Color** — Select this option to apply the Item On Color to the selected crosspoints buttons.
     - **MLE Color** — Select this option to apply the MLE Glow color to the selected crosspoint buttons.

5. Assign a color for selected non-crosspoint buttons on each module as follows:
   - Use the Option knob to select Selected Bttns.
   - Use the Use knob to select which color you want to use for the selected buttons. You can choose between the following:
     - **Item On Color** — Select this option to apply the Item On Color to the selected buttons.
     - **MLE Color** — Select this option to apply the MLE Glow color to the selected buttons.

6. Assign a color for the custom control buttons as follows:
   - Use the Option knob to select Custom Controls.
   - Use the Use knob to select which color you want to use for the custom control buttons. You can choose between the following:
     - **Disp Color** — Select this option to apply the Display Glow Color to the custom control buttons.
     - **MLE Color** — Select this option to apply the MLE Glow color to the selected buttons.

7. Assign a color for the re-entry buttons as follows:
   - Use the Option knob to select Re-entry Glow.
   - Use the Use knob to turn this feature on or off:
     - **No** — Select this option to not assign a different color to the re-entry buttons.
     - **Yes** — Select this option to assign the MLE Glow color to the re-entry button for that MLE. For example, if the glow color for MLE 1 is blue, and the glow color for MLE 2 is yellow. The re-entry button for MLE 1 is blue on MLE2, instead of the yellow glow color for MLE 2.
8. Assign a color for the select crosspoint buttons as follows:
   • Use the **Option** knob to select **Xpt Colors**.
   • Use the **Use** knob to turn this feature on or off.
     › **No** — Select this option to not use a different color for specific video inputs.
     › **Yes** — Select this option to allow a User Color to be applied to the crosspoint button for a specific video input. Refer to the section “Assigning a Crosspoint Color” on page Eng 11-19 for information on assigning a color to a video input.

### Assigning a Crosspoint Color

Each video source on the switcher can have one of six user assignable colors assigned to the crosspoint button for that source.

To assign a user color to a specific crosspoint button, the Xpt Colors option must be turned on. Refer to the section “General Color Usage Setup” on page Eng 11-17 for information on turning on the Xpt Color option.

1. Press HOME ➔ Setup ➔ Personality ➔ Color Scheme ➔ Setup Xpt Colors.

   ![Setup Xpt Colors Menu]

   **Setup Xpt Colors Menu**

2. Use the **Input** knob to select the button, or input, that you want to assign a user color to.

3. Use the **Color** knob to assign a user color to the selected input.

### Selecting a Color

Any of the glow or user colors for the buttons on the control panel can be adjusted.

---

**Note** — With some pre-loaded color schemes, or user created color schemes, the **Item On Color** or **On-Air** colors may not be easily distinguishable from the **Glow** color. Make sure to test a color scheme with each MLE and Aux before using it.
1. Press HOME ➔ Setup ➔ Personality ➔ Color Scheme ➔ Select Buttons.

![Color Scheme Menu 1-3]

2. Adjust the Glow color of the MLEs and Aux Buses as follows:
   - Use the Color knob to select the element that you want to change the color for.
   - Press Modify Color.

   ![HSL Color Space — Color Selection Menu]

   - Select the color space that you want to edit the button color in as follows:
     - RGB — Press RGB to display the RGB color space. This allows you to edit the button color by mixing Red, Green, and Blue together.
     - HSL — Press HSL to display the HSL color space. This allows you to edit the button color by adjusting the Hue, Saturation, and Luminance of the color.
   - Modify a color as follows:
     - HSL Color Space — Use the Luminance, Saturation, and Hue knobs to adjust the color of the selected element.
     - RGB Color Space — Use the Red, Green, and Blue knobs to adjust the color of the selected element.
   - Press UP ONE to accept the color selection and display the Color Scheme Menus.
Mnemonic Color Schemes

The current color selection for the mnemonics on the buses of the control panel can be edited at any time during operation. By adjusting the brightness of the color LEDs in the mnemonics, you can create a new, custom color for the mnemonics.

Custom colors for individual input sources can be created for each video source. Refer to the section “Naming Input Sources” on page Eng 7-2 for more information on editing mnemonic colors for individual input sources.

1. Press HOME ➔ Setup ➔ Personality ➔ Color Scheme ➔ More.
2. Select the mnemonic color that you want to adjust as follows:
   • Orange — Press Mnemonic Orange and use the Orange Gain knob to adjust the gain of the orange LED in the mnemonics.
   • Yellow — Press Mnemonic Yellow and use the Yellow Gain knob to adjust the gain of the yellow LED in the mnemonics.
   • Green — Press Mnemonic Green and use the Green Gain knob to adjust the gain of the green LED in the mnemonics.
4. Adjust the Brightness and Contrast of the mnemonic display on the control panel as follows:
   • Use the Mnemonic Brightness knob to adjust the brightness of the mnemonics.
   • Use the Mnemonic Contrast knob to adjust the contrast of the mnemonics.
5. Press Extern Mnemonic Bright/Contrast.
Adjust the Brightness and Contrast of the mnemonic display on external panels, such as the Auxiliary Control Panel, as follows:

- Use the **Mnemonic Brightness** knob to adjust the brightness of the mnemonics.
- Use the **Mnemonic Contrast** knob to adjust the contrast of the mnemonics.
Control Panel Display Brightness

You can adjust the brightness of the Control Panel Displays from the menu. These displays include all the module displays found on the control panel, but not the Touchscreen Display.

**Operating Tip** — Lower **Display Brightness** settings will prolong the life of the displays on the control panel.

1. Press **HOME** ➔ **Setup** ➔ **Personality** ➔ **Color Scheme** ➔ **More** ➔ **Display Bright./Contrast**.

2. Use the **Display Brightness** knob to adjust the brightness of the displays.

3. Use the **Display Contrast** knob to adjust the contrast of the displays.

*For More Information...*

- on menu themes, refer to the section “**Menu Skins**” on page Eng 5-12.
Loading Color Schemes

The Vision switcher comes pre-installed with a number of different color schemes that you can use.

Each color scheme contains the button color settings, mnemonic brightness and contrast, as well as the brightness and contrast of the displays. Monitor Skins are not included in Color Schemes.

1. Press HOME ➔ Setup ➔ Personality ➔ Color Scheme ➔ Load Color Scheme.

2. Use the Scheme (middle) knob to select the color scheme you want to load.

3. Press Select This Scheme to apply the selected color scheme to the switcher.

Operating Tip — If you do not want to use the selected color scheme, you can press Undo Changes on the Load Color Scheme Menu to revert back to the previous color scheme.
Lock/Unlock Personality

The Lock/Unlock Personality feature allows you to lock-out changes to the Personality Menus with a password. This prevents changes to the Personality Menus without first unlocking the personality settings. This also included the recalling of a personality register.


**Note** — If the Lock/Unlock Personality feature is active, and a password has been set up, the Enter Personality Password Menu is displayed. Enter the password in the New Name field and press Accept New Name to display the Lock/Unlock Personality Menu.

2. Toggle Personality Lock to On or Off:
   - On — Select this option to turn the personality lock feature on.
   - Off — Select this option to turn the personality lock feature off.

**Operating Tip** — You can delete the current password by pressing Clear Password on the Lock/Unlock Personality Menu.

3. Set a password for the personality lock as follows:
   - Press Add/Change Password.
     - Enter the new password in the New Password field.
     - Press Accept New Password to save the new password.
Completing Setup

In This Chapter

This chapter provides information on finalizing the setup of the Vision switcher. This includes setting up Aux Buses, including the installation of remote aux panels, recalling factory setting, personality setup, and setting up the preview overlay.

The following topics are discussed in this chapter:

- Aux Bus Setup
- Default MLE Map Assignment
- Squeeze & Tease Mode
- Key 4 Mode
- Standard GPI Setup
- Clip Setup
- Audio Channel Setup
- Factory Default Settings
- Preview Overlay Setup
- Set System Time
- Auto Follow
- Frame Over-Temperature Shutdown
- Lock/Unlock Installation
Aux Bus Setup

An Aux Bus allows you to use the additional Output BNC of the Vision switcher to pass video signals out to other external equipment. There are a total of 48 Aux Buses available on the switcher, that have access to all the same video signals that are available to an MLE. The Aux Buses are organized into 6 Banks, with 8 Aux Buses per bank.

If you have the AuxKey option installed, Aux Bus outputs can be used to pass dedicated mixed video signals, including keys, out to other external equipment, or back into the switcher as an additional mixer/keyer.

An Aux Bus can be accessed in a number of ways, either through the Auxiliary Control Panels, or by assigning a crosspoint group to an Aux Bus.

Selecting Aux Buses

1. Press the SEL button on the Crosspoint Group that you want to assign the Aux Bus to. The MLE SEL Button Menu for the selected Crosspoint Group is displayed.
2. Press Select Aux Bus.
3. Press the Aux Bus Bank X button to select the Aux Bus Bank that you want to use, where X is the number of the bank.
4. Press the Aux Bus X or AuxKey X button to select the Aux Bus that you want to use, where X is the number of the aux bus.

For More Information...

• on using an Aux Bus, refer to the section “Assigned to Aux Bus” on page Ops 4-7.

Naming Aux Buses

Each Aux Bus on the Vision switcher can be given a specific name that is displayed on the menus for that source.
1. Press HOME ⇒ Setup ⇒ Installation ⇒ Aux Bus ⇒ Modify Name.

![Aux Bus Names Menu](image)

**Operating Tip** — Refer to the section “Using the Naming Menus” on page Eng 5-17 for more information on using the **Aux Bus Names Menu** to enter a name.

2. Use the **Aux Bus** knob to select the Aux Bus you want to name.
3. Enter the new name you want to use in the **New Name** field.
4. Press **Accept New Name** to assign the name to the Aux Bus.

**Aux Bus Router Follow**

The router follows feature allows you to map sources on the switcher to sources on the router so that when a source is selected on the switcher, the corresponding source is selected on the router. A single destination on the router is associated to an aux bus on the switcher.

The router must be set up to be controlled by the switcher for this feature to work.

1. Press HOME ⇒ Setup ⇒ Installation ⇒ Aux Bus ⇒ More ⇒ Router Follow.
2. Assign a Router to an Aux Bus as follows:
   - Press **Select Router**.

![Select Router — Aux Bus Router Follow Menu](image)

   • Use the **Aux Bus** knob to select the Aux Bus that you want to router to follow.
   • Use the **Router** knob to select the router that you want to follow the Aux Bus.
3. Press **Select Output**.
Select Output — Aux Bus Router Follow Menu

- Use the **Rtr Dest** knob to select the destination on the router that you want to use for router follow.
- Use the **Breakaway** knob to select the breakaway on the router that you want to use for router follow.

4. Press **Input Matrix**.

- Use the **Input** knob to select the video input on the switcher that you want to assign a router source to.
- Use the **Rtr Src** knob to select the router source you want to assign to the video input on the switcher.

**For More Information...**

- on setting up an Output BNC as an Aux Bus output, refer to the section “**Configuring Video Outputs**” on page Eng 8-2.
- on setting up and using the AuxKeys option, refer to the section “**AuxKeys**” on page Eng 8-26.
- on setting up an Auxiliary Control Panel, refer to the section “**Auxiliary Panels**” on page Eng 14-1.
- on assigning Bus Maps to all or individual Aux Buses, refer to the section “**Assigning Panel Bus Maps**” on page Eng 7-19.
Default MLE Map Assignment

The Default MLE Map Assignment feature allows you to specify the default MLE that each Crosspoint Group, or row, on the switcher, and external to the switcher, is assigned to.

1. Press HOME ⇒ Setup ⇒ Personality ⇒ MLE Maps.

![MLE Map Menu]

2. Use the Panel Row knob to select the Crosspoint Group, or row, that you want to assign an MLE to. You can choose between the following:
   - **Row X** — Select the row on the control panel (1 through 8) that you want to assign an MLE to, where X is the number of the row.
   - **Ext Row X** — Select the external row (1 through 16) on an Auxiliary Control Panel, for example, that you want to assign an MLE to, where X is the number of the row.

3. Use the Mapped to MLE knob to select the MLE that you want to assign to the selected row to.

**Note** — The Default MLE Map Assignment is only applied after a restart or **ALL+ALL** software reset. Refer to the section “Resetting the Switcher” on page Eng 4-24 for more information on performing a restart or software reset.
Squeeze & Tease Mode

The Squeeze & Tease Mode sets how Squeeze & Tease resources are allocated or shared among MLE-pairs on the switcher.

1. Press HOME ⇒ Setup ⇒ Personality.
2. Use the Option knob to select S&T Mode.
3. Use the Value knob to toggle to Fixed or Float.

Note — Squeeze & Tease MD DVE channel resources are available to MLE-pairs. How many DVE channel resources are available to each MLE-pair depends on the configuration of your switcher. Refer to the section “Squeeze & Tease” on page Eng 2-27 for more information on the different configurations.

- **Fixed** — Select this option to have the Squeeze & Tease DVE channel resources locked to specific MLEs in the MLE-pair as follows (WARP resources are not locked):
  - Octane/QMD-X — MLEs 1-4 have 4 DVE channel resources locked to them, and MLEs 5-8 have 2 DVE channel resources locked to them.
  - QMD-X — Each MLE has 4 DVE channel resources locked to it.
  - MD-X — Each MLE has 4 DVE channel resources locked to it.
  - QMD — Each MLE has 2 DVE channel resources locked to it.
  - MD — Each MLE has 4 DVE channel resources locked to it.

- **Floating** — Select this option to have the Squeeze & Tease DVE channel resources and WARP resources float across the MLE-pair as follows:
  - Octane/QMD-X — MLEs 1-4 have access to all 8 DVE channel resources provided by the Squeeze & Tease Carrier Board, and MLEs 5-8 have access to 4 DVE channel resources, and both WARP resource.
  - QMD-X — Each MLE-pair has access to all 8 DVE channel resources provided by the Squeeze & Tease Carrier Board.
  - MD-X — Each MLE-pair has access to all 8 DVE channel resources provided by the Squeeze & Tease Carrier Board.
  - QMD — Each MLE-pair has access to 4 DVE channel resources, and a single WARP resource. For example, MLE 1 and MLE 2 share 4 DVE channel resources and 1 WARP resource, and MLE 3 and MLE 4 share the remaining 4 DVE channel resources and 1 WARP resource.
Note — If there is only 1 Squeeze & Tease MD WARP card installed in the QMD frame, that WARP resource floats between all MLES on the switcher. If there is only 1 Video Processor Board board installed in the QMD frame, WARP resources float between both MLES on the switcher.

> MD — Each MLE-pair has access to all 8 DVE channel resources provided by the Squeeze & Tease Carrier Board.

For More Information...
- on MLEs and video routing, refer to the section “Video Routing” on page Eng 2-20.
- on Squeeze & Tease DVE Channel Resources, refer to the section “DVE Keys (Fly Key)” on page Ops 8-2.
Key 4 Mode

The Key 4 Mode sets how many Utility Buses, Aux Bus Color Correctors and Clean Feeds are available to the selected MLE when Key 4 is using internal or external video sources.

Keep the following in mind when setting the Key 4 Mode:

- Key 4 Mode is only available on 4-Keyer Octane/QMD-X and QMD switchers.
- Key 4 Mode settings are stored and recalled with memories.

1. Press HOME ➔ Setup ➔ Installation ➔ Key 4 Config.

2. Press the MLE X button to select the MLE that you want to set up the Key 4 Mode for.

3. Select the mode that you want to assign to the selected MLE as follows:
   
   - **Flexi Mode** — Select this option to be able to switch between External Mode and Internal Mode 1 from the MLE Sel Button Menu.
   
   - **External Mode** — Select this mode to allow Key 4 to have access to all video sources. The selected MLE has access to 0 Utility Buses, 0 Aux Bus Color Correctors, and 2 Clean Feeds. Utility Masks can only select MLE-Stores in this mode.
   
   - **Internal Mode 1** — Select this mode to restrict Key 4 to have access to MLE-Stores only. The selected MLE has access to 2 Utility Buses, 0 Aux Bus Color Correctors, and 2 Clean Feeds.
   
   - **Internal Mode 2** — Select this mode to restrict Key 4 to have access to MLE-Stores only. The selected MLE has access to 0 Utility Buses, 2 Aux Bus Color Correctors, and 0 Clean Feeds.
   
   - **Internal Mode 3** — Select this mode to restrict Key 4 to have access to MLE-Stores only. The selected MLE has access to 1 Utility Bus, 1 Aux Bus Color Corrector, and 1 Clean Feed.

4. Press HOME to display the Installation Change Confirmation Screen.

   - Press Confirm to accept the changes and reset all Remote, Peripheral, and Net ports.
   
   - Press Confirm w/o Reset to accept the changes without resetting all Remote, Peripheral, and Net ports. Only use this if told to do so by Ross Video Technical Support.
   
   - Press Cancel to exit the menus safely, without making any changes. The system returns to the previously stored settings.
For More Information...

- on using the Flexi Mode, refer to the section “Selecting an MLE Mode” on page Ops 4-10.
Standard GPI Setup

The Vision switcher uses General Purpose Interface (GPI) input and output signals to trigger events on external equipment, or have external equipment trigger events on the switcher. All of these signals are passed through a single DB25 port on the Frame CPU Board. This port provides the 10 GPI Inputs and 10 GPI Outputs of the standard GPIs, with a single Ground pin.

Operating Tip — A GPI Output Worksheet and a GPI Input Worksheet are provided to assist you in setting up your GPIs. Refer to the section “Standard GPI I/O Input Worksheets” on page Eng 21-13 for a copy of the GPI Input worksheet. Refer to the section “Standard GPI I/O Output Worksheets” on page Eng 21-14 for copy of the GPI Output worksheet.

GPI I/O Information

You can use the GPI I/O Information to check the settings of all the GPI I/Os on the switcher. This allows you to quickly determine which GPI I/O is being used for what, and which GPI I/Os are still available for use.

1. Press HOME ⇒ Setup ⇒ Installation ⇒ GPI I/O ⇒ View GPI I/O.

2. Use the Scroll knob to scroll through the list of input and GPI Outputs. The following information is provided:

   • **GPI Information**
     
     › **GPI #** — This column provides the GPI number and assignment of each GPI Input on the switcher. GPIs that are not assigned are also indicated.
     
     › **Polarity** — This column provides the current level, or signal polarity, of each GPI Input on the GPI I/O port.

   • **GPO Information**
     
     › **GPO #** — This column provides the GPO number for each GPI Output on the switcher.
     
     › **Name** — This column provides the name of each GPI Output.
     
     › **Trigger** — This column provides the trigger effect that is used for each GPI Output.
     
     › **Level** — This column provides the current level, or signal polarity, of each GPI Output on the GPI I/O port.
GPI I/O Connection

You can connect a single DB25, male, connector to the GPI I/O port on the CPU Board frame of your Vision switcher (Figure 12.1). The GPI I/O port provides 10 GPI Input pins, 10 GPI Output pins, plus a single Ground pin.

![Figure 12.1 GPI I/O Port on Frame CPU Board](image)

To connect to a specific GPI Input or GPI Output, locate the wire connected to the pin for the GPI I/O you want to use (Table 12.1).

Table 12.1 Pinouts — GPI I/O Port

<table>
<thead>
<tr>
<th>GPI Input Pin #</th>
<th>Signal</th>
<th>GPI Output Pin #</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Ground</td>
<td>1</td>
<td>Ground</td>
</tr>
<tr>
<td>2</td>
<td>n/c</td>
<td>14</td>
<td>n/c</td>
</tr>
<tr>
<td>3</td>
<td>n/c</td>
<td>15</td>
<td>n/c</td>
</tr>
<tr>
<td>4</td>
<td>GPI In 10</td>
<td>16</td>
<td>GPI Out 10</td>
</tr>
<tr>
<td>5</td>
<td>GPI In 9</td>
<td>17</td>
<td>GPI Out 9</td>
</tr>
<tr>
<td>6</td>
<td>GPI In 8</td>
<td>18</td>
<td>GPI Out 8</td>
</tr>
<tr>
<td>7</td>
<td>GPI In 7</td>
<td>19</td>
<td>GPI Out 7</td>
</tr>
<tr>
<td>8</td>
<td>GPI In 6</td>
<td>20</td>
<td>GPI Out 6</td>
</tr>
<tr>
<td>9</td>
<td>GPI In 5</td>
<td>21</td>
<td>GPI Out 5</td>
</tr>
<tr>
<td>10</td>
<td>GPI In 4</td>
<td>22</td>
<td>GPI Out 4</td>
</tr>
<tr>
<td>11</td>
<td>GPI In 3</td>
<td>23</td>
<td>GPI Out 3</td>
</tr>
<tr>
<td>12</td>
<td>GPI In 2</td>
<td>24</td>
<td>GPI Out 2</td>
</tr>
<tr>
<td>13</td>
<td>GPI In 1</td>
<td>25</td>
<td>GPI Out 1</td>
</tr>
</tbody>
</table>

For More Information...
- on the GPI I/O port, refer to the section “GPI I/O Ports” on page Eng 20-18.

Setting Up GPI Inputs

GPI Inputs can be used to trigger a number of events on the switcher from a GPI I/O device. An example of a commonly used GPI Input is the small, hand-held, trigger a weather forecaster uses to advance through the different backgrounds in the weather forecast.

Note — The GPI Interface must be enabled in order to control the switcher using GPI Inputs. Refer to the section “GPI Interface Control” on page Ops 11-2 for more information on turning the GPI Interface on.

1. Press HOME ➔ Setup ➔ Installation ➔ GPI I/O ➔ Inputs.
2. Assign a Memory Recall event to an GPI Input as follows:
   - Use the GPI Input knob to select the GPI Input that you want to configure.
• Use the **Function** knob to select the function you want to assign to the selected GPI Input. You can choose between the following:
  › **Off** — Select this option to have the switcher perform no function when a trigger signal is received by the selected GPI Input.
  › **Mem Recall** — Select this option to have the memory recalled across all MLEs when a trigger signal is received by the selected GPI Input.

![GPI I/O](image)

**Memory Recall — GPI I/O Menu**

• Use the **Memory** knob to select the memory register that you want to be recalled on all MLEs when the GPI Input signal is received.

3. Assign a **Transition** event to an GPI Input as follows:

![GPI I/O](image)

**Operating Tip** — A GPI triggered transition will only transition the selected Key or Background buses on the target MLE. If you want to ensure that only a particular transition is performed when the GPI signal is received, have a memory recalled before the transition.

- Use the **GPI Input** knob to select the GPI Input that you want to configure.
- Use the **Function** knob to select the function you want to assign to the selected GPI Input. You can choose between the following:
  › **Off** — Select this option to have the switcher perform no function when a trigger signal is received by the selected GPI Input.
  › **Auto** — Select this option to have an auto transition performed in the MLE, MultiDSK key, or Fade to Black Module, that you select when a trigger signal is received by the selected GPI Input.
  › **Cut** — Select this option to have a cut performed in the MLE, MultiDSK key, or Fade to Black Module, that you select when a trigger signal is received by the selected GPI Input.

![GPI I/O](image)

**Transition Function — GPI I/O Menu**
• Use the **Area** knob to select the MLE, MultiDSK key, or Fade to Black Module, that you want the selected function to be performed when the GPI Input signal is received.

4. **Assign a Run Custom Control** event to an GPI Input as follows:

   Operating Tip — If you have a custom control with a number of holds in it, the GPI Run Custom Control trigger can be used to start the custom control, and continue it at each hold.

   • Use the **GPI Input** knob to select the GPI Input that you want to configure.
   • Use the **Function** knob to select the function you want to assign to the selected GPI Input. You can choose between the following:
     - **Off** — Select this option to have the switcher perform no function when a trigger signal is received by the selected GPI Input.
     - **Cust Ctrl** — Select this option to have the custom control you select run when a trigger signal is received by the selected GPI Input.

   ![GPI I/O Menu](image1)

   **Run Custom Control Function — GPI I/O Menu**

   • Use the **Cust Ctrl** knob to select the custom control bank and button you want to run when the GPI I/O signal is received. The Bank is indicated by the number before the # sign, and the button by the number after the # sign. For example, custom control button 12 on bank 3 is shown as 3#12.

5. Press **GPI Polarity**.

   ![GPI I/O Menu](image2)

   **GPI Input Polarity — GPI I/O Menu**

6. **Assign a trigger signal polarity** to an GPI Input as follows:
   • Use the **GPI Input** knob to select the GPI Input that you want to configure.
   • Use the **Polarity** knob to select the trigger signal polarity you want to assign to the selected GPI Input. You can choose between the following:
› **Low** — Select this option to have the GPI I/O triggered when a low signal is received. The GPI Input should be receiving a constant high signal. When the signal goes low (0 Volts), the GPI I/O will respond to the trigger.

› **High** — Select this option to have the GPI I/O triggered when a high signal is received. The GPI Input should be receiving a constant low signal. When the signal goes high (+5 Volts), the GPI I/O will respond to the trigger.

7. Press **HOME** to display the **Installation Change Confirmation Screen**.
   
   • Press **Confirm** to accept the changes and reset all Remote, Peripheral, and Net ports.
   
   • Press **Confirm w/o Reset** to accept the changes without resetting all Remote, Peripheral, and Net ports. Only use this if told to do so by Ross Video Technical Support.

   • Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

### GPI Input Tallies

You can associate a particular GPI Input with a standard parallel tally. This allows you to force the switcher to toggle a tally on or off when an GPI Input signal is received, even if the tally is associated to an input source that is not on-air.

1. Press **HOME** → **Setup** → **Installation** → **GPI I/O** → **Tally on GPIs**.

![GPI Input Tallies — GPI I/O Menu](image)

2. Use the **Tally** knob to select the tally you want to associate with an GPI Input.

   **Note** — You can assign a tally to a GPI Input that is already assigned to an input source. The switcher will not distinguish between a tally that is activated because of a GPI trigger, or because the input source is on-air.

3. Use the **GPI Input** knob to select the GPI Input that you want to assign to the selected tally. The tally remains on as long as the GPI I/O trigger remains on.

4. Press **HOME** to display the **Installation Change Confirmation Screen**.
   
   • Press **Confirm** to accept the changes and reset all Remote, Peripheral, and Net ports.
   
   • Press **Confirm w/o Reset** to accept the changes without resetting all Remote, Peripheral, and Net ports. Only use this if told to do so by Ross Video Technical Support.
• Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

**For More Information...**

• on assigning tallies to input sources, refer to the section “Assigning Tallies to Input Sources” on page Eng 7-22.

### Setting Up GPI Outputs

GPI Outputs can be used to trigger events on an external GPI I/O device from the switcher. An example of an Output GPI I/O would be the use of an GPI Output to trigger a transition on a Character Generator. Refer to the documentation that came with your device for more information on what commands you can trigger with a GPI I/O.

1. Press **HOME ⇒ Setup ⇒ Installation ⇒ GPI I/O ⇒ Outputs**.

![GPI Outputs — GPI I/O Menu](image)

2. Use the **GPI Output** knob to select the GPI Output that you want to configure.

3. Use the **Trigger** knob to select the trigger signal type you want to assign to the selected GPI Output. You can choose between the following:

   - **Pulse Low** — Select this option to have the GPI Output send a momentary low (0 Volts) trigger and then return to the base high (+5 Volts) level. The duration of the trigger is set with the **Pulse Dur’n** knob.

   - **Pulse High** — Select this option to have the GPI Output send a momentary high (+5 Volts) trigger and then return to the base low (0 Volts) level. The duration of the trigger is set with the **Pulse Dur’n** knob.

   - **Level Low** — Select this option to have the GPI Output toggle from the base high (+5 Volts) level to the low level (0 Volts). The GPI Output signal remains at this level until reset.

   - **Level High** — Select this option to have the GPI Output toggle from the base low (0 Volts) level to the high level (+5 Volts). The GPI Output signal remains at this level until reset.

4. Use the **Pulse Dur’n** knob to select the duration of the trigger signal, in frames, that you want to use.
5. Press HOME to display the Installation Change Confirmation Screen.
   • Press Confirm to accept the changes and reset all Remote, Peripheral, and Net ports.
   • Press Confirm w/o Reset to accept the changes without resetting all Remote, Peripheral, and Net ports. Only use this if told to do so by Ross Video Technical Support.
   • Press Cancel to exit the menus safely, without making any changes. The system returns to the previously stored settings.

Naming GPI Outputs

Each GPI Output can be named. This name is displayed on all the menus for the selected GPI I/O.

1. Press HOME ⇒ Setup ⇒ Installation ⇒ GPI I/O ⇒ Name Outputs.

2. Use the Output number knob to select the GPI Output you want to name.

3. Enter the new name you want to use in the New Name field.

4. Press Accept New Name on to assign the new name to the GPI Output.

5. Press HOME to display the Installation Change Confirmation Screen.
   • Press Confirm to accept the changes and reset all Remote, Peripheral, and Net ports.
   • Press Confirm w/o Reset to accept the changes without resetting all Remote, Peripheral, and Net ports. Only use this if told to do so by Ross Video Technical Support.
   • Press Cancel to exit the menus safely, without making any changes. The system returns to the previously stored settings.
Clip Setup

In order to easily recall clips on the VTR or Video Server from the Vision switcher, you must store the clips you want to use to Clip Registers on the switcher. These Clip Registers store the location, or timecode, on the device for the clip, and the name of the clip.

Note — The switcher supports a maximum of 10,000 clips in the clip list from a video server. If there are more than 10,000 clips on your video server, the switcher will only report 10,000.

In a MultiPanel configuration, only the Master Panel can access the VTR Clips Menus. The VTR Clips Menu allows you to perform the following functions:

- Select a VTR or Video Server and a clip number.
- Grab or enter a timecode (and other device specific data), name the clip, and store it in a clip register. Up to 300 clip registers can be stored (using registers 000 to 299).
- Cue and preview each clip.
- Modify the inpoint and outpoint of a clip.

Programming Clips

1. Press HOME ⇒ Clips ⇒ Assign Clips ⇒ Clip Type.

2. Select the Clip Register you want to store a VTR clip to as follows:
   - Use the Clip knob to select the clip register that you want to store the clip information to (000 through 299).
   - Use the Device knob to select the device you want to store the clip information for. A device is selected by the input source that it is assigned to. Select NONE to disable a clip and have it not displayed on the Remote Control Menu.
   - Use the Looping knob to select if you want the clip to loop by default. This turns the Loop button on the Remote Control Menu on or off when the clip is cued.

Note — Only VDCP video servers support the looping of clips. If the clip is from a VTR or Betacam video server, you cannot enable looping.

3. Name the Clip Register as follows:
   - Press Name Clip. The Clip Name is the name that is shown for the register on all the displays on the switcher.
Operating Tip — Refer to the section "Using the Naming Menus" on page Eng 5-17 for more information on using the Clip Name Menu to enter a name for a clip.

- Enter the new name for the clip in the New Name field. The name can be no more than 8 characters in length and cannot contain a leading or trailing space.
- Press Accept New Name to store the new name and display the VTR Clips Menu 1-2.

4. Select a clip on the VTR or Video Server as follows:
   - Press Choose ID.

Operating Tip — If you know the name of the clip, press Enter ID and enter the name of the clip directly from the Enter Clip ID Menu. Only clip names up to 96 characters long are supported.

Note — If you want to refresh the list of clips returned by the VTR or Video Server, press Refresh & Choose ID to poll the device for a current list of clips. The total number of clips returned is indicated under the Showing heading.

- Use the \( \times 1, \times 10, \) or \( \times 100 \) knobs to select the clip on the VTR or Video Server that you want to use. The ID and Duration of the currently selected clip is shown in the respective fields.

5. Modify the Inpoint and Outpoint of the clip as follows:
   - Press Inpoint/Outpoint.
**Note** — If you select different start and end frames to use on-air, the original inpoint and outpoint for the clip will remain unchanged on the device. This allows you to create sub-clips from a longer master clip directory on the switcher.

**Inpoint/Outpoint Menu**

- Toggle **Enable** to enable the Inpoint/Outpoint overrides.
  - **No** — Select this option to use the default inpoint and outpoint of the clip on the VTR or Video Server. If you have made changes to the inpoint of outpoint of the clip, these values are saved, but not applied to clip until you select **Yes**.
  - **Yes** — Select this option to override the inpoint and outpoint of the clip on the VTR or Video Server. When you select **Yes**, the Inpoint/Outpoint Menu changes to allow you to modify the start and stop positions of the clip.

- Toggle **Edit** to select either the inpoint or outpoint for editing.
  - **In** — Select this option to modify the inpoint, or start position, of the clip.
  - **Out** — Select this option to modify the outpoint, or stop position, of the clip.

**Operating Tip** — You can cue the clip to the current Inpoint or Outpoint by pressing **Cue to Inpoint** when **Edit** is set to **In**, or **Cue to Outpoint** when **Edit** is set to **Out**.

- Press **Hours/Minutes**.

**Hours/Minutes — Inpoint/Outpoint Menu**

- Use the **Hours** knob to adjust the value in the hours field of the Inpoint or Outpoint.
- Use the **Minutes** knob to adjust the value in the minutes field of the Inpoint or Outpoint.

- Press **Seconds/Frames**.
Seconds/Frames — Inpoint/Outpoint Menu

- Use the **Seconds** knob to adjust the value in the seconds field of the **Inpoint** or **Outpoint**.
- Use the **Frames** knob to adjust the value in the frames field of the **Inpoint** or **Outpoint**.
- Press **Grab Timecode** to use the new **Inpoint** or **Outpoint** value for the clip registers.

Grabbing a Timecode

If you do not know the timecode for the inpoint or outpoint you want to store, you can manually scan the video using the commands on the **VTR Clips Menu 2-2** and grab the timecode.

1. Press **HOME ⇒ Clips ⇒ Assign Clips**.
2. Select the clip register and VTR or Video Server you want to store.
3. Grab a timecode as follows:

<table>
<thead>
<tr>
<th>VTR Clips (2-2)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Clip</strong>: 00 <strong>Clip Name</strong>: &quot;W-A-Bank&quot; <strong>Device</strong>: Ross SMS (R2) <strong>ID</strong>: &quot;W-A-Bank&quot; <strong>Duration</strong>: 00:00:45:11</td>
</tr>
<tr>
<td><strong>Start</strong>: 00:00:45:10 <strong>End</strong>:</td>
</tr>
</tbody>
</table>

Transport Controls — VTR Clips Menu 2-2

- Cue the VTR or Video Server to the desired clip location using the transport controls: **Rewind**, **Back Frame**, **Pause**, **Play**, **Ahead Frame**, and **Fast Forward**.
- Press **Pause** to hold the device at the desired timecode.
- Press **Grab Timecode** to grab the current timecode. The new timecode is displayed on the **Timecode** field.
Audio Channel Setup

Audio from a remote mixer can be configured as individual channels or grouped together, with up to three channels per group. When you set up the audio channels, you also set the Default Levels for the individual channels. These default levels are the ones that the switcher will set the channels to when you perform an audio reset custom control.

For More Information...

- on setting up Audio Control modules, refer to the section “Audio Control Module” on page Eng 15-6.

Setting Up Audio Sources

For some audio mixers, each audio source needs to be assigned to an audio channel that is controlled by the switcher. This allows you to select specific audio sources to be controlled when there are more audio sources than input channels on the Audio Mixer.

1. Press HOME ➔ Setup ➔ Installation ➔ More ➔ Audio ➔ Assign Source.

Assign Audio Source Menu

2. Assign as audio source to an audio channel as follows:
   - Use the Audio Channel knob to select the input audio channel you want to assign an audio source to. The number of channels listed is the number of channels you selected when setting the Max Channels extra options for your Audio Mixer.
   - Use the Audio Source knob to select the audio source that you want to assign to the selected input audio channel.

3. Press Name Channel.

Audio Source Names Menu
Operating Tip — Refer to the section “Using the Naming Menus” on page Eng 5-17 for more information on using the Audio Source Names Menu to enter a name for the audio group.

- Use the Audio Src knob to select the audio source you want to name.
- Enter the new name you want to use in the New Name field. The name can be no longer than eight characters.
- Press Accept New Name to assign the name to the audio source.

4. Press Assign All to send the audio input channel to audio source assignments to the Audio Mixer.

5. Press HOME to display the Installation Change Confirmation Screen.
- Press Confirm to accept the changes and reset all Remote, Peripheral, and Net ports.
- Press Confirm w/o Reset to accept the changes without resetting all Remote, Peripheral, and Net ports. Only use this if told to do so by Ross Video Technical Support.
- Press Cancel to exit the menus safely, without making any changes. The system returns to the previously stored settings.

Setting Up Audio Channels

Each audio channel can be set with a custom audio level that is used when the channel is taken on-air. This level can be adjusted manually using the sliders on the Audio Mixer, or by selecting the level on the menu. The default audio level for each channel is 75%.

1. Press HOME ⇒ Setup ⇒ Installation ⇒ More ⇒ Audio ⇒ Audio Level.

2. Include audio channels from the control of the switcher as follows:
- Use the Audio Channel knob to select the audio channel that you want to remove from the control of the switcher. All channels are included by default.

Note — If you have programmed Audio Assign Custom Controls, the Audio Channel knob will display the custom control that you assigned the channel to.

- Use the Include knob to select Yes, to include the channel, or No, to not include the channel. If the channel is not included, the switcher will not control the audio levels for that channel.
3. Set the level for each audio channel as follows:
   - Use the **Audio Channel** knob to select the audio channel that you want to set the default level for.
   - Use the **Level** knob to select the default level for the selected channel. All channels are initially set at **75%**.

4. Press **HOME** to display the **Installation Change Confirmation Screen**.
   - Press **Confirm** to accept the changes and reset all Remote, Peripheral, and Net ports.
   - Press **Confirm w/o Reset** to accept the changes without resetting all Remote, Peripheral, and Net ports. Only use this if told to do so by Ross Video Technical Support.
   - Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

### Setting Up Audio Groups

Up to three audio channels, or groups, can be grouped together. This allows you to assign multiple audio channels to a single input source. Assigning audio channels will not change the default audio levels that have been set for each of the channels. When the group is taken on-air, each audio channel is taken up to the level set for that particular channel.

**Note** — Assigning audio channels to groups does not alter the default or custom levels that you have set for them.

1. Press **HOME ➔ Setup ➔ Installation ➔ More ➔ Audio ➔ Audio Groups**.

   ![Audio Groups — Audio Menu](image)

2. Press **Group 1** to assign audio channels to that group. There are a total of **6** audio groups that you can assign audio channels to.

3. Assign up to **3** audio channels to the selected group as follows:

   **Note** — If you have programmed **Audio Assign Custom Controls**, the **Audio Channel** knobs on the **Audio Menu** will display the custom control that you assigned the channel to.

   - Use the **Audio Channel 1** knob to select the first audio channel that you want to assign to the group.
   - Use the **Audio Channel 2** knob to select the second audio channel that you want to assign to the group.
• Use the **Audio Channel 3** knob to select the third audio channel that you want to assign to the group.

4. Press **HOME** to display the **Installation Change Confirmation Screen**.
   • Press **Confirm** to accept the changes and reset all Remote, Peripheral, and Net ports.
   • Press **Confirm w/o Reset** to accept the changes without resetting all Remote, Peripheral, and Net ports. Only use this if told to do so by Ross Video Technical Support.
   • Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

### Setting Audio Channel Names

Each audio channel can have a unique name. This name appears on the mnemonic above the audio fader on the Audio Control module. The color of the mnemonic indicates the status of the audio channel. Orange for an on-air channel, and yellow for an off-air channel. Refer to the section “**Audio Control Module**” on page Eng 15-6 for more information on audio fader mnemonics.

1. Press **HOME ➔ Setup ➔ Installation ➔ More ➔ Audio ➔ Name Channels**.

   ![Audio Channel Menu](image)

   **Audio Channel Menu**

   **Operating Tip** — Refer to the section “**Using the Naming Menus**” on page Eng 5-17 for more information on using the **Audio Channel Names Menu** to enter a name for the audio channel.

   • Use the **Channel Name** knob to select the audio channel you want to name.
   • Enter the new name you want to use in the **New Name** field. The name can be no longer than 14 characters.
   • Press **Accept New Name** to assign the name to the audio channel.

### Setting Audio Fade Rate

Each audio channel can be set to use either the video transition rate, or a unique fade-in and fade-out rate when the audio channel is transitioned on, or off, air.

**Note** — If the **Audio Cut Only** personality option is set to **On**, any audio fade rate settings are ignored.
1. Press HOME ➔ Setup ➔ Installation ➔ More ➔ Audio.

2. Toggle Fade Rate to Audio.

3. Use the Audio Channel knob to select the audio channel that you want to set the audio fade rate for.

4. Use the Fade-in Rate knob to set the audio fade-in rate, in frames, for the selected audio channel.

5. Use the Fade-out Rate knob to set the audio fade-out rate, in frames, for the selected audio channel.

**Operating Tip** — Toggle Fade Rate to Video to set the selected channel back to the video transition rate.

6. Press HOME to display the Installation Change Confirmation Screen.
   - Press Confirm to accept the changes and reset all Remote, Peripheral, and Net ports.
   - Press Confirm w/o Reset to accept the changes without resetting all Remote, Peripheral, and Net ports. Only use this if told to do so by Ross Video Technical Support.
   - Press Cancel to exit the menus safely, without making any changes. The system returns to the previously stored settings.

**Not Assign Audio Channel to Audio Fader**

Each audio channel can be prevented from being assigned to a fader on the Audio Control module. This is useful if you only want a single channel from a stereo pair to be assigned to the Audio Control module. The single fader will control both channels in the stereo pair, or all channels in the group.

![Audio Fade Rate — Audio Menu]

2. Use the Audio Channel knob to select the audio channel you don’t want assigned to a fader on the Audio Control module.

3. Use the OnFaderModule knob to select No to have the selected channel not assigned to a fader. The channels that will not be assigned to a fader are listed on the menu.
Factory Default Settings

Each Vision switcher comes pre-configured from the factory with a number of default settings. Recalling these default settings allows you to return the switcher to a known state for diagnostic purposes, creating new Setups, or if advised to do so by Ross Technical support. The following are some of the situations where you may want to perform a recall of the factory default settings:

- If you sense a problem with one of the registers.
- If you need to create a new switcher Setup and want to start from the default state.
- If you need to delete all entries in a particular register. For example, if you needed to delete all memories on the switcher.
- If you need to reset all control panel values.

The recalling of factory default setting is performed on individual register types. Defaulting one of these register types will return all the entries stored in registers of that type to the factory installed state. Any entries in the registers are destroyed.

Note — If the Installation is locked, you cannot recall the factory default settings for Installation, but all other registers will recall normally.

Recalling Factory Default Settings

When you perform a recall of the factory default settings, each register must be recalled individually. This allows you to recall the factory default setting for only those registers that need to be defaulted. Factory default settings only apply to the active Setup on the switcher. Additional Setups that are stored on the switcher are not affected.

Important — You should back up any of your registers that you want to keep to a Setup before performing the recall of the factory default setting. Refer to the section “Storing and Recalling Files and Setups” on page Eng 13-4 for more information on storing registers to switcher Setups.


Recall Factory Menu 1-3

2. Recall a factory default setting by pressing the corresponding button for the register you want to default. You are prompted to confirm the factory default. The following registers can be factory defaulted:

   - Personality — The personality registers contain all the user interface settings. These registers contain items such as mnemonic settings, preview overlay positions
and settings, and transition rates. As a rule, anything that is set up from the **Personality Menus** is stored in these registers. If you recall the factory default setting for the personality registers, all these settings are returned to the default state.

- **Memories** — The memory registers contain all the memories that are stored on the switcher. If you recall the factory default settings for the memory registers, all the memories that have been stored on the switcher are erased.

- **Switcher** — The switcher registers contain information on the configuration of the control panel. If you recall the factory default settings for the switcher registers, all keyer settings and MLE settings are reset.

- **Installation** — The installation registers contain all the external device setup, and software configuration settings for the switcher. As a rule, anything that is set up from the **Installation Menus** is stored in these registers. If you recall the factory default settings for the installation registers, all the external devices you have set up and software configurations you have made are erased. In a multipanel configuration, the master panel is assigned all installed MLEs, with the highest numbered MLE as the Program MLE. For satellite panels, only the lowest number MLE installed is assigned to the panel and set as the Program MLE.

- **Custom Controls** — The custom control registers contain all the custom controls that have been stored on the switcher. If you recall the factory default setting for the custom control registers, all the custom controls that have been recorded on the switcher are erased. Custom control banks are stored in the Installation Registers.

- **Default VTR Clips** — The clip registers contain all the VTR and video server timecode and clip information stored on the switcher. If you recall the factory default settings for the clip registers, all clip information are erased. This will not affect the clip information on the external device.

- **Default NV-RAM** — The Non-Volatile RAM on the Vision switcher contains information such as active key effects and some personality settings. If you recall the factory default setting for the NV-RAM, all the information stored in the NV-RAM is erased.

- **Default S&T** — The Squeeze & Tease registers contain all the Squeeze & Tease sequences that have been stored on the switcher. If you recall the factory default settings for the Squeeze & Tease registers, all the sequences that have been recorded on the switcher are erased.

- **Default Bus Maps** — The Bus Maps registers contain all the user defined bus maps that have been stored on the switcher. If you recall the factory default settings for the Bus Map registers, all the custom bus mappings that have been created on the switcher are erased.

- **Default Shot Box Pages** — The Shot Box Pages registers contain all the user defined Shot Box Pages that have been stored on the switcher. If you recall the factory default settings for the Shot Box Pages registers, all the Shot Box Pages that have been created on the switcher are erased.

- **Camera File** — The Camera File registers contain all the camera shots that have been stored on the switcher. Only cameras that store shots on the switcher use this registers. If your camera does not store shots on the switcher, defaulting this register will not erase the shots stored on the camera. If you recall the factory default settings for the Camera File registers, all the camera shots that have been stored on the switcher, not on the camera, are erased.

- **CC/Macro Attachments** — The Custom Control Attachments registers contain all the attachments of custom controls to control panel buttons. If you recall the factory default settings for the CC/Macro Attachments registers, all the assignments of custom controls to control panel buttons are erased. The custom control that are attached to buttons are not defaulted.
• **Default MultiViewer** — The default MultiViewer option defaults both the MultiViewer Assignment registers and the MultiViewer Layout registers. If you recall the factory default settings for the MultiViewer, the mapping of layouts to MultiViewers, as well as the actual layouts and sources assigned to the boxes in the layout are defaulted.

• **Default CC Variables** — The default CC Variables register contains all the user defined custom control variables that have been stored on the switcher. If you recall the factory default settings for the CC Variables, all the values for the custom control variables that have been set on the switcher are erased.

3. Press **HOME** to display the **Installation Change Confirmation Screen**.

   • Press **Confirm** to accept the changes and reset all Remote, Peripheral, and Net ports.

   • Press **Confirm w/o Reset** to accept the changes without resetting all Remote, Peripheral, and Net ports. Only use this if told to do so by Ross Video Technical Support.

   • Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.
Preview Overlay Setup

The Preview Overlay allows you to view information such as Source ID, Safe Title area, and Time Clock on the preview monitor of your Vision switcher. With the exception of the Preview Overlay Module on the Vision 1 control panel (Figure 12.2), all of these features can be turned on or off by pressing the associated button on the Preview Overlay Module (Figure 12.3).

The Preview Overlay is only available to the highest number MLE. If your control panel does not have that MLE assigned to it, the Preview Overlay is not available.

**Note** — If Global-Store channel 4 is enabled, the Preview Overlay feature is not available. Refer to the section “Personality List” on page Eng 11-2 for more information on Global-Store 4 Mode.

**Operating Tip** — On the Vision 1, the Preview Overlay functions can be turned off and on from the Preview Overlay Menus.

Preview Overlay Font Color

You can adjust the color of the font used for various elements of the preview overlay. Color selections are applied to the fonts, and not to the safe title or other graphical elements.

1. Press HOME ⇒ Setup ⇒ Personality ⇒ Preview OVL Font Colors.

2. Use the Font knob to select the preview overlay element that you want to change the font color for. You can choose between the following:
• **Time Up** — Select this option to set the color of the Time Clock text when the time clock is counting up.

• **Time Down** — Select this option to set the color of the Time Clock text when the time clock is counting down.

• **VTR On Air** — Select this option to set the color of the VTR Timecode text when a VTR is contributing to the Program output.

• **VTR Active** — Select this option to set the color of the VTR Timecode text when a VTR is selected on the Preset bus of the Program MLE.

• **VTR Inactive** — Select this option to set the color of the VTR Timecode text when a VTR is not selected.

• **Source ID** — Select this option to set the color of the program video on the Source ID text.

• **Tran ID** — Select this option to set the color of the transition type on the Source ID text.

• **Dest ID** — Select this option to set the color of the preset video on the Source ID text.

3. Use the **Color** knob to select the color that you want to apply to the text of the selected preview overlay element.

### Preview Overlay Component Setup

From the **Preview Overlay Menus**, you can adjust the color, size, and appearance of many of the components used in the Preview Overlay.

1. Press **HOME ⇒ More ⇒ Effects ⇒ More ⇒ More ⇒ More ⇒ Preview Overlay**.

![Preview Overlay Menu](image)

2. Use the following sections to set up the Preview Overlay element you want to use:

   • VTR Timecode
   • Source ID
   • Safe Title
   • Center
   • Time Clock

*For More Information...*

   • on using the preview overlay, including the preview mask, refer to the section “**Preview Overlay**” on page Ops 4-17.
VTR Timecode

The VTR Timecode element shows the current timecode, or remaining time, of the VTR or Video Server currently selected on the Program/Preset MLE.

1. Press VTR.

![VTR Position Menu](image)

2. Adjust the VTR TC element as follows:
   - Use the X knob, or the positioner, to select the horizontal position on the Preview Overlay that the VTR Timecode text appears.
   - Use the Y knob, or the positioner, to select the vertical position on the Preview Overlay that the VTR Timecode text appears.
   - Use the Size knob, or the positioner, to select the size (20 to 350) of the VTR Timecode text on the Preview Overlay.

3. Press Done to save the current settings and display the Preview Overlay Menu.

Source ID

The Source ID element shows the name of the current on-air video signal, the transition type that is currently selected, and the video signal that is taken on-air with the next transition.

1. Press Source ID.

![Source ID Position Menu](image)

2. Adjust the Source ID element as follows:
   - Use the X knob, or the positioner, to select the horizontal position on the preview overlay that the Source ID text appears.
   - Use the Y knob, or the positioner, to select the vertical position on the preview overlay that the Source ID text appears.
• Use the Size knob, or the positioner, to select the size (20 to 350) of the Source ID text on the preview overlay.

3. Press Done to save the current settings and display the Preview Overlay Menus.

Safe Title

The Safe Title element shows guides for Safe Title, Safe Action and Minimum Text Size (Figure 12.4) using the SMPTE standards. A number of pre-defined Safe ID setups are stored on the switcher. The size and position of the elements for these Safe ID setups can be adjusted and stored.

![Safe Title Preview Overlay elements](image)

**Figure 12.4 Safe Title Preview Overlay elements**

1. Press Safe Title Center Pos.

2. Use the Safe ID knob to select the Safe ID that you want to adjust the values for.

3. Adjust the position of the Top and Left sides of the Safe Title and Safe Action elements as follow:
   • Press Top/Left.
   • Use the Left knob, or the Positioner, to adjust the horizontal position of the left side of the Safe Title and Safe Action elements.
   • Use the Top knob, or the Positioner, to adjust the vertical position of the top side of the Safe Title and Safe Action elements.

4. Adjust the position of the Bottom and Right sides of the Safe Title and Safe Action element as follow:
   • Press Bottom/Right.
   • Use the Right knob, or the Positioner, to adjust the horizontal position of the right side of the Safe Title and Safe Action elements.
   • Use the Bottom knob, or the Positioner, to adjust the vertical position of the bottom side of the Safe Title and Safe Action elements.
5. Name the **Safe ID** as follows:

**Operating Tip** — Refer to the section "Using the Naming Menus" on page Eng 5-17 for more information on using the **Change Safe Title Name Menu** to enter a name.

- Press **Modify Name**.
- Use the **Safe Title** knob to select the Safe ID you want to name.

![Change Safe Title Name Menu](image)

- Enter the new name you want to use in the **New Name** field.
- Press **Accept New Name** to assign the name to the Safe ID.

**Center**

The Center element shows a crosshairs on the Preview Overlay to indicate the center of the picture. The position of the crosshairs can be adjusted and stored.

1. Press **Safe Title Center Pos**.

![Safe Title Setup Menu](image)

2. Use the **Safe ID** knob to select the Safe ID that you want to adjust the values for.

3. Adjust the position of the **Center** element as follows:
   - Press **Center**.
   - Use the **X** knob, or the positioner, to adjust the horizontal position of the Center element.
   - Use the **Y** knob, or the positioner, to adjust the vertical position of the Center element.
Time Clock

The Time Clock element shows a count-down, count-up, or count-down-then-up timer on the Preview Overlay. The Time Clock can be set up to start counting down, or up, on every transition, from a preset start time. This can be tied to any MLE, or a particular MLE, or Fade to Black transition.

1. Press Time Clock.

2. Adjust the Position of the Time Clock element as follows:
   - Press Position.
   - Use the X knob, or the positioner, to select the horizontal position on the Preview Overlay that the Time Clock appears.
   - Use the Y knob, or the positioner, to select the vertical position on the Preview Overlay that the Time Clock appears.
   - Use the Size knob, or the positioner, to select the size (20 to 350) of the Time Clock on the Preview Overlay.
   - Press Done to save the current settings and display the Time Clock Menu.

3. Select the MLEs that the Time Clock will activate on when a transition is performed as follows:
   - Press Transition.

   - Toggle Master to On to allow the Time Clock to be tied to an MLE.

Note — You must have Master set to On in order to be able to tie the operation of the Time Clock to an MLE or Fade to Black transition.
• Toggle MLE X to On to tie the operation of the Time Clock to the selected MLE, where “X” represents the MLE number. Turning this feature Off will not have the Time Clock reset when a transition is performed in this MLE.

• Toggle FTB to On to tie the operation of the Time Clock to a Fade to Black transition. Turning this feature Off will not have the Time Clock reset when a Fade to Black transition is performed.

4. Set up the direction that the Time Clock will count as follows:

  • Press Direction.
  
  • Use the Going knob to select the direction you want the Time Clock to count in. You can choose between the following:
    › Up — Select this option to have the Time Clock count up from zero when reset and started.
    › Down — Select this option to have the Time Clock count down to zero when reset and started. The starting time is set from the Reset Time Menu.
    › Down→Up — Select this option to have the Time Clock count to zero, and then count up from zero when reset and started. The starting time is set from the Reset Time Menu.

5. Set up the Reset Time, or starting time, for the Time Clock as follows:

  • Press Reset Time.
  
  • Use the Hours knob to set the number of hours you want the Time Clock to count down from.
  
  • Use the Minutes knob to set the number of minutes you want the Time Clock to count down from.
  
  • Use the Seconds knob to set the number of seconds you want the Time Clock to count down from.

For More Information...

  • on using the preview overlay, refer to the section “Video Preview” on page Ops 4-15.
  
  • on using time clock custom controls, refer to the section “Programming Special Functions” on page Eng 10-15.
Set System Time

The System Time allows you to set the current date and time on the hardware clocks on both the frame and the Vision control panel.

The System Time can be set manually from the Master Panel, or automatically from a Network Time Protocol (NTP) server. The Set System Time Menu is not available to the Satellite Panels.

Setting System Time Manually

The Set System Time Menu allows you to manually set the system time for the switcher when a NTP server is not available. If an NTP server is set up, the current date and time entered into the Set System Time Menu is overwritten the next time the NTP time is updated.

1. Press HOME ⇒ Setup ⇒ More ⇒ Set System Time.

![Set System Time Menu]

Note — If there are NTP Servers listed on the Set System Time Menu, the switcher is getting system time information from the listed NTP Servers. You cannot set the time manually when an NTP Server is active.

2. Set the current date as follows:
   • Press Date.
   • Use the Year knob to select the current year.
   • Use the Month knob to select the current month.
   • Use the Day knob to select the current day.

3. Set the current time as follows:
   • Press Time.
   • Use the Hour knob to select the current hour.
   • Use the Minute knob to select the current minute.
   • Use the Second knob to select the current second.

4. Press Set to set the hardware clock on the Vision control panel and frame to the selected date and time.
Setting System Time Automatically

The system time can be set automatically by entering the IP address of up to three (3) Network Time Protocol (NTP) servers. The switcher must be able to access the IP addresses to get the time from an NTP server.

1. On your computer, open your Web Browser and, in the address bar, enter the IP address of your frame and press Enter. The QMD/X Web Interface Splash Screen is displayed.

2. Enter your username and password as follows when the Login Dialog Box appears. The default Name is user and Password is password.

3. Click Other ⇒ Time to display the Time Page. All NTP servers that have been set up on the switcher are listed.

4. In the blank Time Servers field, enter the IP Address of the NTP server you want to add. IP addresses in the range of 169.254.x.x are reserved by the switcher and cannot be used as a time server address.

Operating Tip — To remove an NTP server from the list, click DELETE next to the time server you want to remove.

5. Click ADD. You are asked to confirm the addition of the time server once it is validated, click OK to add the server.

Once the switcher is synchronized to the new NTP server, Okay appears in the Status column. If Okay is not shown next the IP address, check that the IP address is correct, or that the switcher has access to the address.
Auto Follow

The Auto Follow feature allows you to set one part, or many parts, of an MLE or Aux Bus to follow the operation of another part (Table 12.2). For example, you can have one Transition Module follow another, a Keyer bus follow another Keyer bus, or have an entire MLE or Aux Bus follow another. Both parts of the auto follow must be of the same type, a crosspoint bus can only follow another crosspoint bus.

Operations, such as crosspoint selection or transitions, that are performed on part are repeated on the other part.

Table 12.2 Supported Auto Follow Actions

<table>
<thead>
<tr>
<th>Module</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory</td>
<td>Memory Recall</td>
</tr>
<tr>
<td></td>
<td>Reset MLE (Store+Recall)</td>
</tr>
<tr>
<td>Keyers</td>
<td>Cut and Auto Transition</td>
</tr>
<tr>
<td>Transition</td>
<td>Next Transition Selection</td>
</tr>
<tr>
<td></td>
<td>Transition Type</td>
</tr>
<tr>
<td></td>
<td>Cut, Auto, Fader Transitions</td>
</tr>
<tr>
<td></td>
<td>Preset Black</td>
</tr>
<tr>
<td></td>
<td>Key Priority</td>
</tr>
<tr>
<td></td>
<td>Transition Limit</td>
</tr>
<tr>
<td></td>
<td>Roll Clip</td>
</tr>
<tr>
<td>Crosspoint</td>
<td>Source Selection</td>
</tr>
</tbody>
</table>

Auto follow actions only echo commands, and do not echo the state. For example, if a transition is performed on an MLE, the auto follow MLE also performs a transition, regardless of what is currently on-air on that MLE. If Key 1 is on-air on MLE 1 but off-air on MLE 2, the transition takes Key 1 off-air on MLE 1, but on-air on MLE 2.

The same is true for memory recalls. If a memory register contains different setting on each MLE, the local settings will be used. Auto Recall for memories only ensures that the same memory register is recalled on the Echo To MLE. For example, if memory register 09 is recalled on the Echo From MLE, memory register 09 is also recalled on the Echo To MLE. These two memory registers may contain different commands.

Auto Follow Setup

The Auto Follow feature must be turned on from the Personality Menu. Once turned on, you can specify the buses, keyers, transitions, and memory recalls that follow.

**Operating Tip** — When an Auto Follow is turned on, the word **Active** appears on the Main Menu 1-2 next to the Auto Follow under the Remote Enables.

An auto follow can be set up for an entire MLE at once, or for the individual elements of an MLE.
1. Press HOME ⇒ Setup ⇒ Personality ⇒ More ⇒ Auto Follow Setup.

Operating Tip — The currently active Auto Follows are listed on the Auto Follow Setup Menu 2-2. Press Buses to view the bus follows, Keyers to view the keyer follows, Transitions to view transition follows, and Mem Recalls to view memory recall follows.

2. Press Config.

![Auto Follow Setup Menu 1-2](image)

3. Turn on auto follows as required:
   - **AutoFollow CustCtrl** — The Auto Follow Custom Control feature allows you to select whether or not custom control events are included in the auto follow command echoing.
     - **Off** — Select this option to have the switcher not perform any command echoing for active custom controls.
     - **On** — Select this option to have the switcher perform command echoing for the active custom control. Any commands recorded in the custom control for an MLE, bus, or Transition Module, will be echoed on the auto follow.
   - **AutoFollow Editor** — The Auto Follow Editor feature allows you to select whether or not external editor commands are included in the auto follow command echoing.
     - **Off** — Select this option to have the switcher not perform any command echoing for external editor commands.
     - **On** — Select this option to have the switcher perform command echoing for external editor commands.
   - **AutoFollow Panel** — The Auto Follow Control Panel feature allows you to select whether or not control panel button presses are included in the auto follow command echoing.
     - **Off** — Select this option to have the switcher not perform any command echoing for control panel button presses.
     - **On** — Select this option to have the switcher perform command echoing for control panel button presses. This includes memory recalls, transitions, and crosspoint button selection. Custom control or editor based commands are not included.

4. Set up an auto follow for an entire MLE at once as follows:
   - Press MLEs.
MLEs — Auto Follow Setup Menu 1-2

- Use the **Echo From** knob to select the MLE that you want to be followed. This is the MLE that you perform the actions on that you want to be repeated on the **Echo To** MLE.
- Use the **Echo To** knob to select the MLE that you want to follow the select MLE. This is the MLE that repeats the actions performed on the **Echo From** MLE.
- Press **Set** to apply changes.

**Operating Tip** — You can clear the currently selected MLE auto follow by pressing **Clear**.

5. Press **More**.
6. Set up a Bus auto follow as follows:
   - Press **Buses**.

Buses — Auto Follow Setup Menu 2-2

- Use the **Echo From** knob to select the bus that you want to be followed. You can choose between the following:
  - **AuxBus Y** — Select this option to assign an Aux Bus as the bus that you want followed, where “Y” represents the number of the Aux Bus.
  - **MLE X PGM** — Select this option to have the Program Bus of an MLE as the bus that you want followed, where “X” represents the number of the MLE.
  - **MLE X PST** — Select this option to have the Preset Bus of an MLE as the bus that you want followed, where “X” represents the number of the MLE.
  - **MLE X Key #V** — Select this option to have the Key Video Bus of an MLE as the bus that you want followed, where “X” represents the number of the MLE and “#” represents the number of the Keyer.
› **MLE X Key #A** — Select this option to have the Key Alpha Bus of an MLE as the bus that you want followed, where “X” represents the number of the MLE and “#” represents the number of the Keyer.

› **MLE X Util 1** — Select this option to have Utility Bus 1 of an MLE as the bus that you want followed, where “X” represents the number of the MLE.

› **MLE X Util 2** — Select this option to have Utility Bus 2 of an MLE as the bus that you want followed, where “X” represents the number of the MLE.

- Use the **Echo To** knob to select the bus that you want to follow the **Echo From** bus.
- Press **Set Bus Follow** to apply changes.

---

**Operating Tip** — You can clear the currently selected Bus auto follow by pressing **Clear Bus Follow** on the **Auto Follow Setup Menu 2-2**, or you can clear all the Bus auto follows by pressing **Clear All Bus Follows** on the **Auto Follow Setup Menu 2-2**.

---

7. Set up a Keyer auto follow as follows:

- Press **Keyer**.

![](image)

**Keyers — Auto Follow Setup Menu 2-2**

- Use the **Echo From** knob to select the keyer that you want to be followed.
- Use the **Echo To** knob to select the keyer that you want to follow the **Echo From** keyer.
- Press **Set Keyer Follow** to apply changes.

---

**Operating Tip** — You can clear the currently selected Bus auto follow by pressing **Clear Keyer Follow** on the **Auto Follow Setup Menu 2-2**, or you can clear all the Keyer auto follows by pressing **Clear All Keyer Follows** on the **Auto Follow Setup Menu 2-2**.

---

8. Set up a Transition auto follow as follows:

- Press **Transitions**.
• Use the **Echo From** knob to select the Transition Module that you want to be followed.
• Use the **Echo To** knob to select the Transition Module that you want to follow the **Echo From** Transition Module.
• Press **Set Trans Follow** to apply changes.

**Operating Tip** — You can clear the currently selected Transition auto follow by pressing **Clear Trans Follow** on the **Auto Follow Setup Menu 2-2**, or you can clear all the Transition auto follows by pressing **Clear All Trans Follows** on the **Auto Follow Setup Menu 2-2**.

9. Set up a Memory Recall auto follow as follows:
   • Press **Mem Recalls**.

**Memory Recalls — Auto Follow Setup Menu 2-2**

• Use the **Echo From** knob to select the MLE that you want memory recalls to be followed from. Memory registers that are recalled on this MLE are also recalled on the Echo To MLE.
• Use the **Echo To** knob to select the MLE that you want to follow the **Echo From** MLE.
• Press **Set Mem Follow** to apply changes.

**Operating Tip** — You can clear the currently selected Memory auto follow by pressing **Clear All Mem Follows** on the **Auto Follow Setup Menu 2-2**, or you can clear all the Memory auto follows by pressing **Clear All Mem Follows** on the **Auto Follow Setup Menu 2-2**.
Frame Over-Temperature Shutdown

In the event that the frame over-heats, the switcher can be set to shutdown boards to prevent damage. When the frame over-heats, a warning is provided with the option to over-ride the shutdown. If you do not cancel the shutdown in 15 minutes, the frame will shutdown the boards automatically.

Frame over-heating can be caused by a high ambient temperature in the equipment rack room, poor airflow through the frame fan filter, or failing frame or power supply fans.

After the frame has shutdown the boards, you must correct the conditions that caused the over-heating and restart the frame.


   Temperature Alarm Menu

2. Press Shutdown to turn this feature on or off:

   • On — Select this option to have the switcher shutdown all the frame boards, except the CPU Board, when the frame is over-heating.

   • Off — Select this option to have the switcher not shutdown boards when the frame over-heats.

3. Press Yes to save the settings.
Lock/Unlock Installation

The Lock/Unlock Installation feature allows you to lock-out changes to the Installation Menus on the switcher with a password. This prevents anyone from changing settings on the Installation Menus without first unlocking the installation settings. This also included the recalling of an installation register. Other registers, such as Personality, can be recalled when the installation menu is locked.

A Warning Screen is displayed when you attempt to navigate to the Installation Menu stating that the installation settings are locked and any changes will not be saved.


   Note — If the Lock/Unlock Installation feature is active, and a password has been set up, the Enter Installation Password Menu is displayed. Enter the password in the New Name field and press Accept New Name to display the Lock/Unlock Installation Menu.

2. Turn the installation lock on or off as follows:
   - Toggle Install’n Lock to On or Off:
     • On — Select this option to turn the installation lock feature on.
     • Off — Select this option to turn the installation lock feature off.

   Operating Tip — You can delete the current password by pressing Clear Password on the Lock/Unlock Installation Menu.

3. Set a password for the installation lock as follows:
   - Press Add/Change Password to display the Change Installation Password Menu. If a password has already been set, the button is labelled Change Password.
- Enter the new password in the **New Password** field on the **Change Installation Password Menu**.
- Press **Accept New Password** on the **Change Installation Password Menu** to save the new password.
In This Chapter

This chapter provides information on storing files and registers to the internal hard drive, a USB drive, or directly to an external computer for backup.

The following topics are discussed in this chapter:

• File Storage Overview
• Storing and Recalling Files and Setups
• Managing Setups with an External Computer
• Hard Drive Backup and Restore
The Vision switcher stores configuration and operation data in a number of registers that contain the individual entries for items such as memories or personality settings. These registers can be stored as a single archive file, as a register set that contains all the individual register of that type, or as all individual registers. These files can be stored into Setups on the Hard Drive of the switcher, or as files onto a USB flash drive. Setups allow you to store a complete set of switcher files on the hard drive. Different Setups can be created for different shows or applications, allowing you to quickly locate and recall the switcher configurations.

The following Register Types are present on the Vision switcher:

- **Memory Registers** — The memory registers contain all the memories that are stored on the switcher. The memory registers can be stored and recalled as a set of all the memories on the switcher, or as individual memory registers (0 to 99). Memory registers are stored and recalled across all MLEs on the switcher, even if the same memory register contains different settings for each MLE.

- **Custom Control Registers** — The custom control registers contain all the custom controls that are stored on the switcher. The custom control registers can be stored and recalled as a set of all the custom controls on the switcher, or as individual custom controls. Custom control registers are stored and recalled by Bank and Custom Control. If there are more or fewer custom control buttons on the switcher you are recalling the custom control registers on, you may want to store and recall individual custom controls. Custom Control Bank information is stored in the installation registers.

- **Personality Registers** — The personality registers contain all the user interface settings. These registers contain items such as mnemonic settings, preview overlay positions and settings, and transition rates. As a rule, anything that is set up from the **Personality Menus** is stored in these registers. The following items are stored in the Personality Registers:
  - Personality settings
  - Preview Overlay setting
  - Default Mnemonics settings
  - Pbus Memory settings
  - Character Generator settings
  - Memory Attributes
  - Bus Map Assignment

- **Clip Registers** — The clip registers contain all the VTR and video server timecode and clip information stored on the switcher.

- **Installation Registers** — The installation registers contain all the external device setup, and software configurations settings for the switcher. As a rule, anything that is set up from the **Installation Menus** is stored in this register. The following items are stored in the installation registers:
  - Input source settings (including tally and crosspoint button assignments)
  - Output BNC settings
  - Aux Bus settings
  - GPI I/O settings
  - Clean Feed settings
  - Device communication settings
  - Custom Control Bank settings (not including custom controls)
  - Bus Maps
- **Squeeze & Tease Registers** — The Squeeze & Tease registers contain all the Squeeze & Tease sequences that have been stored on the switcher.

- **Bus Maps Registers** — The Bus Map registers contain all the Bus Maps that have been stored on the switcher.

- **Shot Box Pages Registers** — The Shot Box Pages registers contain all the Shot Box Pages that have been stored on the switcher.

- **Camera Registers** — The Camera registers contain all the stored shots for cameras that do not store shots on the camera or camera head controller. Refer to the Ross Video External Device Setup Sheet for your camera for information on whether it uses the Camera registers.

- **CC/Macro Attachments** — The Custom Control Attachments registers contain all the mappings of custom controls that are attached to control panel buttons.

- **MultiViewer Assignment** — The MultiViewer Assignment registers contain all the mapping of what layout is assigned to each MultiViewer.

- **MultiViewer Layouts** — The MultiViewer Layouts registers contain all the layouts and assigned sources for the MultiViewer that have been stored on the switcher. The assignment of a MultiViewer to output BNCs is stored in the Installation Register.

The Memory, Custom Control and Squeeze & Tease registers can all be stored as individual files for each value on the switcher. This allows you to store a particular Memory, Custom Control, or Squeeze & Tease sequence to a Setup on the Hard Drive, or to the USB flash drive, and recall it to another register position on the same or a different switcher. For example, Custom Control **Bank 3 Button 9** can be stored on the USB flash drive and then recalled into **Bank 1 Button 3**. This allows you to organize these registers on a single switcher, or transfer only the registers you need to another switcher.

**For More Information...**

- on recalling the factory default settings for the switcher registers, refer to the section “**Factory Default Settings**” on page Eng 12-27.

- on attaching custom controls to panel buttons, refer to the section “**Attaching Custom Controls to Panel Buttons**” on page Eng 10-25.
Storing and Recalling Files and Setups

The Vision switcher allows you to store and recall the various installation setting, custom controls, memories, sequences, and bus maps to either the hard drive, or USB flash drive. This can be to backup your settings, or to copy your settings from one switcher to another.

The Vision switcher can store files and setups on either the internal hard drive, located in the frame, or a USB drive that is inserted into the USB port on the **Fade To Black Module**. The USB drive must be formatted as FAT or NTFS.

Only the Master Panel can store or recall files or setups to either the internal hard drive, or a USB flash drive.

Storing Registers

You can store your switcher settings and files either to the internal hard drive, or to an external USB flash drive from the Master Panel.

1. Press **Disk → Dest/Source**.

2. Select the storage device that you want to store your files to as follows:
   - Use the **Disk Type** knob to select the storage device you want to store your files on. You can choose between the following:
     - **Hard Drive** — Select this option to store the files to one of the setups on the hard drive. There are 100 setups available to store files.
     - **USB** — Select this option to store the files to a USB flash drive inserted in the USB port on the control panel.
   - If you are storing files to the internal hard drive, use the **Set Names** knob on the **Disk Menu** to select the Setup, or location, that you want to store the files in.

   **Important** — Do not remove the USB flash drive from the control panel during a store or recall. If the USB flash drive is removed during a store or recall, the panel may need to be restarted to restore proper functionality.

3. Press **Store**.
Disk Store Menus

4. Select the switcher registers that you want to store to the selected Setup, or USB flash drive, as follows:

   **Note** — If a \( \checkmark \) is shown above a register type, then a switcher configuration file for that type is already present on the storage device. Confirm that you want to overwrite this file, or select a different Setup.

   - **All** — Select this option to store all categories of registers to the storage device.
   - **Memories** — Select this option to store only Memory Registers.
   - **Custom Controls** — Select this option to store only Custom Control Registers.
   - **Personality** — Select this option to store only Personality Registers.
   - **VTR Clips** — Select this option to store only VTR Clip Registers.
   - **Installation** — Select this option to store only Installation Registers.
   - Press **More** to view the following options.
   - **S&T MD Sequences** — Select this option to store only Squeeze & Tease Sequences.
   - **Bus Maps** — Select this option to store only Bus Map Registers.
   - **Shot Box Pages** — Select this option to store only Custom Control Shot Box Page Registers.
   - **Camera** — Select this option to store only Camera Shot Registers.
   - **CC/Macro Attachments** — Select this option to store only the custom control attachments to control panel buttons.
   - **MultiViewer Assignment** — Select this option to store only the MultiViewer Assignment Registers.
   - **MultiViewer Layouts** — Select this option to store only the MultiViewer Layout Registers.
   - **CC Variables** — Select this option to store only the CC Variables Register.

5. Press **Name Setup**.

   **Operating Tip** — Refer to the section “Using the Naming Menus” on page Eng 5-17 for more information on using the Setup Name Menu to enter a name for a Setup.

6. Enter the new name for the Setup in the **New Name** field. The name can be no more than 8 characters in length.

7. Press **Accept New Name** on the Setup Names Menu to store the new name.
Storing Individual Registers

When you store an individual register, the switcher allows you to select into which register that entry is stored and recalled. For example, this allows you to store the memory in register 06, and then recall it to Memory register 35. This can be useful for organizing your registers, or for copying only select registers onto a new switcher.

1. Press Disk ➔ Dest/Source.

2. Select the storage device that you want to store your files to as follows:
   - Use the Disk Type knob to select the storage device you want to store your files on. You can choose between the following:
     - Hard Drive — Select this option to store the files to one of the setups on the hard drive. There are 100 setups available to store files.
     - USB — Select this option to store the files to a USB flash drive inserted in the USB port on the control panel.
   - If you are storing files to the internal hard drive, use the Set Names knob on the Disk Menu to select the Setup, or location, that you want to store the files in.

3. Press Store Individual.

4. Store an individual Memory Register as follows:
   - Press Memory Register.

   - Use the From Switcher knob to select the switcher memory register that you want to save.
   - Use the To Disk knob to select the register on the storage device to save the file to.
   - Press Store Item to store the memory register to the selected location.
5. Store an individual Custom Control Register as follows:
   • Press CustCtrl Register.

6. Store an individual Sequence Registers as follows:
   • Press Sequence.

7. Store an individual Bus Map as follows:
   • Press Bus Maps.
Bus Maps — Store Individual Items Menu 1-2

- Use the **From Switcher** knob to select the bus map that you want to save.
- Use the **To Disk** knob to select the register on the storage device to save the file to.
- Press **Store Item** to store the bus map to the selected location.

8. Store an individual **Shot Box Page** as follows:

- Press **Shot Box Pages**.

Shot Box Pages — Store Individual Items Menu 1-2

- Use the **From Switcher** knob to select the shot box page that you want to save.
- Use the **To Disk** knob to select the register on the storage device to save the file to.
- Press **Store Item** to store the shot box page to the selected location.

9. Store an individual **MultiViewer Layout** as follows:

- Press **MultiViewer Layouts**.

MultiViewer Layouts — Store Individual Items Menu 2-2
• Use the **From Switcher** knob to select the MultiViewer layout that you want to save.
• Use the **To Disk** knob to select the register on the storage device to save the file to.
• Press **Store Item** to store the MultiViewer layout to the selected location.

With your individual registers stored, you can recall them onto the same switcher in different locations, or recall them onto a different switcher. Recalling your registers in different locations on the same switcher allows you to organize your memories, sequences, or custom controls in a different order.

### Recalling Registers

When you recall switcher registers by type, the switcher extracts the individual register items from the register type files and replaces the existing register entries with the new ones.

---

**Important** — A **Recall** cannot be undone. Ensure that you have **Stored** your current switcher configuration before recalling a new Setup so that you can revert to the previous configuration if needed.

---

1. Press **Disk ➔ Dest/Source**.

![Destination/Source — Disk Menu](image)

2. Select the storage device that you want to recall your files from as follows:
   - Use the **Disk Type** knob to select the storage device you want to recall your files from. You can choose between the following:
     - **Hard Drive** — Select this option to recall the files from one of the setups on the hard drive.
     - **USB** — Select this option to recall the files from a USB flash drive inserted in the USB port on the control panel.
   - If you are recalling files from the internal hard drive, use the **Set Names** knob on the **Disk Menu** to select the Setup, or location, that you want to recall the files from.

---

**Important** — Do not remove the USB flash drive from the control panel during a store or recall. If the USB flash drive is removed during a store or recall, the panel may need to be restarted to restore proper functionality.

---

3. Press **Recall**.
Disk Recall Menus

4. Select the switcher registers that you want to recall from the selected Setup or USB flash drive as follows:

**Note** — If a is shown above a register type, then a switcher configuration file for that type is already present on the storage device.

- **All** — Select this option to recall all categories of registers.
- **Memories** — Select this option to recall only Memory Registers.
- **Custom Controls** — Select this option to recall only Custom Control Registers.
- **Personality** — Select this option to recall only Personality Registers.
- **VTR Clips** — Select this option to recall only VTR Clip Registers.

**Note** — If you recall an Installation register that has the Video Processor Board set differently than it currently is (as a MultiViewer vs an MLE for example), the Video Processor will reboot on the recall.

- **Installation** — Select this option to recall only Installation Registers. If the Lock/Unlock Installation feature is active, you cannot recall an installation register.
- **S&T MD Sequences** — Select this option to recall only Squeeze & Tease Sequences.
- **Bus Maps** — Select this option to recall only Bus Map Registers.
- **Shot Box Pages** — Select this option to recall only Custom Control Shot Box Page Registers.
- **Camera** — Select this option to recall only Camera Shot Registers.
- **CC/Macro Attachments** — Select this option to recall only the custom control attachments to control panel buttons.
- **MultiViewer Assignment** — Select this option to recall only the MultiViewer Assignment Registers.
- **MultiViewer Layouts** — Select this option to recall only the MultiViewer Layout Registers.
- **CC Variables** — Select this option to recall only the CC Variables Register.

*For More Information...*

- on the Lock/Unlock Installation feature, refer to the section “Lock/Unlock Installation” on page Eng 12-45.
Recalling Individual Registers

When you recall an individual register, the switcher allows you to select into which register that entry is recalled. For example, this allows you to store the memory in register 06, and then recall it to Memory register 35. This can be useful for organizing your registers, or for copying only select registers onto a new switcher.

1. Press Disk  Dest/Source.

2. Select the storage device that you want to recall your files from as follows:
   - Use the Disk Type knob to select the storage device you want to store your files on. You can choose between the following:
     - Hard Drive — Select this option to recall the files from one of the setups on the hard drive.
     - USB — Select this option to recall the files from a USB flash drive inserted in the USB port on the control panel.
   - If you are recalling files from the internal hard drive, use the Set Names knob on the Disk Menu to select the Setup, or location, that you want to recall the files from.


4. Recall an individual Memory Register as follows:
   - Press Memory Register.

   - Use the From Disk knob to select the memory register on the storage device to recall.
   - Use the To Switcher knob to select the switcher memory register that you want recall to.
   - Press Recall Item to recall the memory register to the selected location.
5. Recall an individual **Custom Control Register** as follows:
   - Press **CustCtrl Register**.

![Custom Control Registers — Recall Individual Items Menu 1-2](image)

   - Use the **From Disk** knob to select the custom control register on the storage device to recall.
   - Use the **To Switcher** knob to select the custom control register that you want recall to.
   - Press **Recall Item** to recall the custom control register to the selected location.

6. Recall an individual **Sequence Registers** as follows:
   - Press **Sequence**.

![Sequence — Recall Individual Items Menu 1-2](image)

   - Use the **From Disk** knob to select the sequence on the storage device to recall.
   - Use the **To Switcher** knob to select the sequence that you want recall to.
   - Press **Recall Item** to recall the sequence to the selected location.

7. Recall an individual **Bus Map** as follows:
   - Press **Bus Maps**.
8. Recall an individual Shot Box Pages as follows:
   - Press Shot Box Pages.

9. Recall an individual MultiViewer Layout as follows:
   - Press MultiViewer Layouts.
• Use the **From Disk** knob to select the MultiViewer layout on the storage device to recall.
• Use the **To Switcher** knob to select the MultiViewer layout that you want recall to.
• Press **Recall Item** to recall the MultiViewer layout to the selected location.
Managing Setups with an External Computer

The web interface of the frame allows you to not only upgrade the software on the switcher, but also to manage the Setups you have stored on the hard drive of the switcher. Using a computer on the same sub-net of a network as the frame, you can browse to the frame, log in, and either download or upload Setups from or to the frame.

**Downloading Setups to an External Computer**

Downloading Setups from the frame allows you to back up different switcher configurations off of the switcher. These Setups can then either be archived, or uploaded to a different switcher.

1. On your computer, open your Web Browser and, in the address bar, enter the IP address of your frame and press **Enter**. The **QMD/X Web Interface Splash Screen** is displayed.

2. Enter your username and password as follows when the **Login Dialog Box** appears. The default **Name** is **user** and **Password** is **password**.

3. Click **File Sets** to display the **File Sets Page**. All the populated Setups on the switcher are shown in blue. If the Setup that you want to download does not appear, verify the Setup number on the switcher and refresh your browser.

4. Download a Setup from the switcher to your computer as follows:
   - Click on the blue Setup number that corresponds to the Setup you want to download. A Save dialog box is displayed.
   - Select the folder, or directory, on your computer to save the Setup to. The switcher will compress the contents of Setup into a single file and download it to the selected folder, or directory.

**Uploading Setups from an External Computer**

Uploading Setups to the frame allows you to restore different switcher configurations that you backed up off of the switcher, or transfer Setups from one switcher to another on the same network.
1. On your computer, open your Web Browser and, in the address bar, enter the IP address of your frame and press **Enter**. The **QMD/X Web Interface Splash Screen** is displayed.

2. Enter your username and password as follows when the **Login Dialog Box** appears. The default **Name** is **user** and **Password** is **password**.

3. Click **File Sets** to display the **File Sets Page**. All the populated Setups on the switcher are shown in blue.

4. Upload a Setup to the switcher from your computer as follows:
   - In the **Number** field, enter the 2-digit number for the Setup on the switcher that you want to upload the Setup files to. If any Setup files exist in that location, they will be replaced with the new files. All the populated Setups on the switcher are shown in blue.
   - In the **Filename** field, enter the location and name of the Setup on the computer that you want to upload to the selected Setup on the switcher.

   **Operating Tip** — You can use the **Browse...** button to display file browser dialog, and then locate the file you want to upload.

   - Click **Upload set** and **OK** to upload the Setup to the switcher.

   **For More Information...**
   - on logging into the frame, refer to the section “**Vision Web Interface Account**” on page Eng 6-2.
Hard Drive Backup and Restore

The content of the hard drive in the switcher can be backed up for archiving, or if you are replacing the hard drive.

**Note** — The backup and restore should not be used as a method of copying setups between switchers.

Keep the following in mind when working with the restore and backup feature:

- The backup requires a Linux-compatible USB storage device with at least 11GB of available space.
- Backup and restore can only be performed from a Master Panel.
- All panels connected to the switcher during the backup will be unresponsive.
- Option codes and serial number are not stored with the backup.
- Only files that are different on the USB drive compared to the hard drive will be backed up or restored.

**To Backup the Switcher Hard Drive**

1. Insert the USB storage device that you want to perform the backup to into the USB port on the control panel. The backup requires a Linux-compatible USB storage device with at least 11GB of available space. If the drive is not Linux-compatible, you will be prompted to format the drive.

2. Press **Disk** ➔ **More** ➔ **System Backup**. Based on the information on the hard drive, an estimated time for the backup is shown. The switcher will be unresponsive during this time, but the process can be aborted at any time.

3. Press **Continue**.

**Operating Tip** — You can stop the backup at any time by pressing **Abort Backup**. The backup can be started again from where it left off.
To Restore the Switcher Hard Drive

1. Insert the USB storage device that you want to perform the restore from into the USB port on the control panel.


   ![System Restore Menu]

   System Restore Menu

3. Press Continue.
Auxiliary Panels

In This Chapter

This chapter provides information on setting up an Auxiliary Control Panel or a Remote Aux Panel with the Vision switcher.

The following topics are discussed:

- Auxiliary Panel Overview
- Installing Auxiliary Panels
- Communications Connections
- Communications Setup
- Auxiliary Panel GPIs
Auxiliary Panel Overview

The Vision switcher supports both the Vision Auxiliary Control Panel and the Remote Aux Panels used with the Ross Synergy family of switchers.

Auxiliary Control Panel

The Auxiliary Control Panel (Figure 14.1) is available in either a 16, 24, 32, or 40 button version to match the size of your Vision control panel, and can be installed either on the back of the control panel or into the desk. The 24-button Auxiliary Control Panel can also be installed into a 19-inch rack frame. For information on installing and cabling your Auxiliary Control Panel, refer to the documentation that came with your Auxiliary Control Panel.

Note — An Auxiliary Control Panel that does not match the size of your control panel can be used; however, a different bus map will have to be assigned to the Auxiliary Control Panel to properly map all the crosspoint buttons.

Auxiliary Control Panel Components

The Auxiliary Control Panel has a number of functional components that allow you to select the mode the panel is operating in, and perform various operations when in each mode.

1. Aux Bank Select Buttons

These buttons are used to select the Aux Bus Bank that the Auxiliary Control Panel is currently assigned to.
2. **Aux Select Button**

These buttons are used to select the Aux Bus that the Auxiliary Control Panel is currently assigned to.

3. **Command Buttons**

These mnemonic buttons are used to switch between operational modes and perform specific functions based on the operational mode the Auxiliary Control Panel is in.

4. **Crosspoint Buttons**

The crosspoint buttons are used to select video sources. The number of crosspoint buttons depends on the model of Auxiliary Control Panel you have.

**Remote Aux Panels**

The Vision switcher supports the Assignable (Figure 14.3) Remote Aux Panel. The Remote Aux Panels are self-contained units that have their own power supply and connect to the control panel through one of the External Link ports.

Even though an unlimited number of Remote Aux Panels can be connected to the switcher, a practical limit of 24 panels should be observed. This limit will minimize delay, and allows 8 panels to be daisy-chained to each of the three External Link ports.

![Figure 14.3 Assignable Remote Aux Panel](image1)

**Remote Aux Panel Connections**

The Remote Aux Panel has a number of connections on the back of the panel that allow you to connect it to the switcher, as well as provide GPI and power connections.

![Figure 14.4 Remote Aux Panel Rear Connections](image2)

1. **Power Connector**

A single DC power connector is provided for the +5 VDC power supply. An AC Adapter (90-264 VAC) is provided with each Remote Aux Panel to provide the +5 VDC power for the panel.

2. **GPI Connector**

A single DB9 GPI connector is provided for special GPI triggers that allows a camera operator to manually override the Aux panel selection.

3. **Main Connector**

A single RJ-12 connector is provided for connecting the Remote Aux Panel to the External Link port on the back of the control panel.
4. **Echo Connector**

A single RJ-12 connector is provided for daisy-chaining the Remote Aux Panel to the next Remote Aux Panel in the chain.
Installing Auxiliary Panels

The Remote Aux Panel is 1 RU high, and is designed to install into a standard 19-inch equipment rack.

**Note** — For information on installing and cabling your Auxiliary Control Panel, refer to the documentation that came with your Auxiliary Control Panel.

1. Disconnect all cables from the Remote Aux Panel.
2. Place the Aux Panel into the rack where you want to install it.
3. Using standard rack mounting bolts, attach the Remote Aux Panel to the equipment rack.

**Caution** — Always connect the External Power Supply to the Remote Aux Panel before connecting the AC mains power. Connecting the power supply to the AC mains power before connecting to the Remote Aux Panel could damage the Remote Aux Panel.

4. Connect the AC Adapter to the **Power** port on the Aux Panel and to the appropriate AC outlet.
Communications Connections

This section outlines how to connect a Remote Aux Panel to one of the Aux ports on the Vision control panel.

For information on installing and cabling your Auxiliary Control Panel, refer to the documentation that came with your Auxiliary Control Panel.

In order to properly complete this procedure you will need the following cables:

- **Remote Aux Panel Cable Adapter** — This is a short TIA/EIA-568-B (CAT5e) cable with an RJ-45 connector on one end and an RJ-12 connector on the other. (Ross Part Number 4800CR-370)
- **Aux Cable** — This is a shielded, 6-conductor telco cable with an RJ-12 connector on each end.

### To Connect Two Remote Aux Panels to the Switcher

1. Connect and secure the RJ-45 end of the Remote Aux Panel Cable Adapter to one of the External Link Ports on the back of the control panel (Figure 14.5).

   **Note** — External Link Port 1 must be used to connect to the Touchscreen display, and External Link Port 2 is used to connect to the OverDrive Production Control System. If OverDrive is set up on any Vision control panel connected to the switcher, External Link Port 2 cannot be used for Remote Aux Panels.

2. Connect and secure one of the RJ-12 ends of the Aux Cable to the RJ-12 end of the Remote Aux Panel Cable Adapter.

3. Connect and secure the other RJ-12 end of the Aux Cable to the MAIN port on the back of the Remote Aux Panel.

4. Connect and secure one end of the Aux Cable to the ECHO port on the back of the Remote Aux Panel.

5. Connect and secure the other end of the Aux Cable to the MAIN port on the back of the second Remote Aux Panel.

You can connect up to 8 Remote Aux Panels to a single Aux Port on the switcher.
Remote Aux Cable Pinouts

Use the information in this section to connect the Remote Aux Panel Interface Cable from the Vision switcher to the Remote Aux Panel.

Remote Aux Panel Cabling

The Vision switcher connects to the Remote Aux Panel via the External Link ports on the Vision control panel, and the Main port on the Remote Aux Panel.

Note — Ross Video provides a Remote Aux Panel Cable Adapter (#4800CR-370) that plugs into the RJ-45 External Link ports and provides an RJ-12 Remote Aux port for a standard aux cable.

Cable connection in the following table (Table 14.1) refer only to those between the Vision switcher and the Remote Aux Panel. Refer to the section “Remote Aux Panel Pinouts” on page Eng 20-27 for information on other cable connections present on the Remote Aux Panel.

<table>
<thead>
<tr>
<th>Vision Switcher External Link Port</th>
<th>Signal</th>
<th>Remote Aux Panel Main Port</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>RxB (Rx+)</td>
<td>2</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
<td>1</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
<td>4</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>TxA (Tx-)</td>
<td>3</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>7</td>
<td>Reset</td>
<td>5</td>
<td>Reset</td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Communications Setup

The Vision switcher needs to be set up with the Auxiliary Control Panel or Remote Aux Panel to allow proper control and monitoring, as well as tally and GPI communications.

Auxiliary Control Panel

The Auxiliary Control Panel can be assigned to either an Internal Panel Row, or an External Panel Row, depending on the functionality you want.

**Note** — Only Auxiliary Control Panels assigned to Internal Panel Rows can be used for menu auto follows, double press actions, or recording custom controls.

Internal Panel Row Assignment

Assign the Auxiliary Control Panel to an Internal Panel Row if you need menu follows and double press actions. Actions such as double-pressing a crosspoint button to assign a Color Corrector to that video source must be done on an internal panel row.

To set up an Auxiliary Control Panel on an internal panel row, ensure that the Auxiliary Control Panel is connected to the **NEXT** port on the back of the Touchscreen Display, and assign the Auxiliary Control Panel to one of the Internal Panel Rows.

External Panel Row Assignment

Assign the Auxiliary Control Panel to an External Panel Row if you do not need menu follows or double press action.

To set up an Auxiliary Control Panel on an external panel row, ensure that the Auxiliary Control Panel is connected to External Link Ports 2, 3, or 4, and assign the Auxiliary Control Panel to one of the External Panel Rows.

For More Information...

- on installing and cabling up your Auxiliary Control Panel, refer to the documentation that came with your Auxiliary Control Panel.
- on assigning modules to a panel row, refer to the section “Mapping a Module to a Row” on page Eng 17-5.
- on how GPIs are assigned by panel row, refer to the section “Auxiliary Control Panel GPIs” on page Eng 14-11.
- on setting an External Link Port to External Module, refer to the section “External Panel Modules” on page Eng 9-20.

Remote Aux Panel

To set up a Remote Aux Panel, you must first assign an External Link port to Remote Aux Panels, and then assign each Remote Aux Panel to an Aux Bus.
1. Press HOME ➔ Setup ➔ Installation ➔ Com Setup ➔ Type.

2. Assign a Remote Aux port to the Remote Aux Panel as follows:
   - Use the Com Port knob to select the communications port on the Vision switcher that is connected to the Remote Aux Panel.
   - Use the Device knob to select Remote Aux. If the OverDrive Production Control System is set up with the switcher, you cannot assign ExtLink 2 to Remote Aux.
   - Use the Aux Buses knob to select the range of aux buses that you want to make available to the remote aux panels connected to the selected External Link port.

   **Note** — All the Remote Aux Panels that are connected to the selected External Link port, or to other Remote Aux Panels that are connected to the port, are restricted to Aux Buses in the range you select.

3. Press HOME to display the Installation Change Confirmation Screen.
   - Press Confirm to accept the changes and reset all Remote, Peripheral, and Net ports.
   - Press Confirm w/o Reset to accept the changes without resetting all Remote, Peripheral, and Net ports. Only use this if told to do so by Ross Video Technical Support.
   - Press Cancel to exit the menus safely, without making any changes. The system returns to the previously stored settings.


5. Press Remote Panel Setup. This places all the Remote Aux Panels connected to the switcher into assignment programming mode. The red On-Air indicator on the Remote Aux Panels flash (Figure 14.6).
6. In assignment programming mode, the first 12 crosspoint buttons (Figure 14.7) represent Aux Bus outputs in the range specified in Step (2) above.

7. Each aux panel can be assigned to all the available aux buses. The aux panel can be set up for each aux bus in one of three modes. Press the Aux Bus Output buttons on the Remote Aux Panel repeatedly until the required mode is selected for the aux bus. You can choose between the following:
   - **Regular** — The aux panel is assigned to the selected aux bus, allowing full control. The button is lit steadily.
   - **Follow** — The aux panel is assigned to the selected aux bus, allowing you to view what crosspoints are selected on that aux bus, but you cannot control the aux bus. The button is flashing.

8. Press **Accept** on the Remote Panel Setup Menu to store the new settings and exit programming mode.
Auxiliary Panel GPIs

Using the 16 GPIs on each Auxiliary Control Panel, or the 8 GPIs on each Remote Aux Panel, a camera operator can manually override the aux panel selection using a GPI trigger. For purposes of matching or monitoring cameras, the camera operator can override the selected aux bus crosspoint and manually switch to a selected output BNC using a button on the joystick or camera control unit.

Each aux panel can be programmed to ignore all the GPIs if required. Remote GPIs cannot be used for any other function other than aux bus signal selection.

For More Information...

- on the GPI Ports on the Remote Aux Panel, refer to the section “GPI Port” on page Eng 20-27.
- on the programming mode of the Remote Aux Panel, refer to the section “Aux Panel Programming Mode Summary” on page Eng 20-29.

Auxiliary Control Panel GPIs

The 16 GPIs on each Auxiliary Control Panel are assigned based on the GPI group that the Auxiliary Control Panel was assigned to. For example, if an Auxiliary Control Panel is assigned to GPI Group 1, GPIs 1-16 are used.

1. Press HOME $\Rightarrow$ Setup $\Rightarrow$ More $\Rightarrow$ Panel Modules. A warning is displayed, asking you if you want to enter the menu. Press Yes to display the Panel Modules Menu.

2. Use the Link/Node knob to select the module on the Auxiliary Control Panel that has the command buttons on it. You can also press a button on the module to jump to the link and node.


   Custctrl & GPI Group (Auxiliary Control Panel Module) — Panel Modules Menu

4. Use the GPI Group knob to select the GPI group that you want to assign to the Auxiliary Control Panel.

For More Information...

- on assigning modules to a panel row, refer to the section “Mapping a Module to a Row” on page Eng 17-5.
Remote Aux Panel GPIs

The 8 GPIs on each Remote Aux Panel can be offset by multiples of 8, allowing each remote panel to use different GPIs, to the maximum of 64. For example, Remote Aux Panel 1 can be set to use GPIs 1-8. By setting Remote Aux Panel 2 to an offset of 1, it will use GPIs 9-16.

In order to gain access to all 64 GPIs, you must program the offset and group for each Remote Aux Panel.

1. Press HOME ⇒ Setup ⇒ Installation ⇒ Aux Bus ⇒ Remote Panels.
2. Press Remote Panel Setup. This places all the Remote Aux Panels connected to the switcher into programming mode. The On-Air indicators on the Remote Aux Panels flash.

![Remote Panel Setup Menu](image)

3. Press CLEAN FEED on the Remote Aux Panel to switch the panel from assignment programming mode to GPI programming mode. The CLEAN FEED button flashes.
4. In GPI programming mode, the first 8 crosspoint buttons (Figure 14.8) on the Remote Aux Panel allow you to select the GPI Group you want to assign to the aux panel.

![Figure 14.8 GPI Programming Buttons](image)

5. Select the GPI Group you want to assign to the Remote Aux Panel, by selecting the appropriate crosspoint button (offset). Only one GPI Group can be assigned to a Remote Aux Panel at a time.
   - GPIs 1-8 — Select GPI Group 1 (Offset 0) to assign these GPIs.
   - GPIs 9-16 — Select GPI Group 2 (Offset 1) to assign these GPIs.
   - GPIs 17-24 — Select GPI Group 3 (Offset 2) to assign these GPIs.
   - GPIs 25-32 — Select GPI Group 4 (Offset 3) to assign these GPIs.
   - GPIs 33-40 — Select GPI Group 5 (Offset 4) to assign these GPIs.
   - GPIs 41-48 — Select GPI Group 6 (Offset 5) to assign these GPIs.
   - GPIs 49-56 — Select GPI Group 7 (Offset 6) to assign these GPIs.
   - GPIs 57-64 — Select GPI Group 8 (Offset 7) to assign these GPIs.
6. Test the GPIs on the Remote Aux Panel as follows:
• Press the GPI buttons on the CCU joystick. The crosspoint button that corresponds to the GPI (Figure 14.9) will light up, indicating that the GPI has been shorted to ground.

![GPI Testing](image)

Figure 14.9 GPI Testing

7. Press Accept to store the new settings and exit programming mode.

8. Press HOME to display the Installation Change Confirmation Screen.
   • Press Confirm to accept the changes and reset all Remote, Peripheral, and Net ports.
   • Press Confirm w/o Reset to accept the changes without resetting all Remote, Peripheral, and Net ports. Only use this if told to do so by Ross Video Technical Support.
   • Press Cancel to exit the menus safely, without making any changes. The system returns to the previously stored settings.

This completes the procedure for programming a Remote Aux Panel GPI. Once the GPIs have been set up, you will have to set up the CCU Joystick controls.

**Setting Up CCU Joystick Control**

Once the aux panel GPIs have been set up, and the panels have been set up with the proper group and offsets, you can assign each aux panel GPI to an aux bus and an input source, as well as setting the trigger type.

1. Press HOME ⇒ Setup ⇒ Installation ⇒ Aux Bus ⇒ Remote Panels ⇒ Remote GPI Assignment.

2. Assign a remote GPI input to an Aux Bus and Input as follows:
   • Use the Remote knob to select the Auxiliary Panel GPI that you want to assign an aux bus to.
   • Use the Aux Bus knob to select the aux bus that you want to assign the GPI input to.
• Use the **Source** knob to select the video source that you want to be selected on the Auxiliary Panel when the selected GPI is triggered.

3. **Press Remote GPI Type.**

   ![Remote GPI Type — Remote Panels Menu](image)

4. Set the type of GPI trigger as follows:
   - Use the **Remote** knob to select the Auxiliary Panel GPI that you want to set up.
   - Use the **Type** knob to select the type of control that you want to assign to the selected GPI. You can choose between the following:
     - **Low-Override** — Select this option to set the trigger as a temporary override when the circuit is closed (high to low signal). When the circuit opens again (low to high signal), the aux bus output returns to the selected video signal.
     - **Low-Toggle** — Select this option to set the trigger as a toggle when the circuit closes (high to low signal). Every time the circuit closes, the override state will toggle.
     - **High-Toggle** — Select this option to set the trigger as a toggle when the circuit opens (low to high signal). Every time the circuit opens, the override state will toggle.
     - **Latch** — Select this option to set the trigger to latch when the circuit opens or closes. Once latched, the trigger cannot be released except by selecting a different source on the Auxiliary Panel itself.
     - **Off** — Select this option to disable the GPI trigger.

   **Operating Tip** — The **Remote Panel Setup Menu** shows which Auxiliary Panel GPIs are currently closed. You can update the list by pressing the **Inquire GPIs** button.

5. **Press HOME** to display the **Installation Change Confirmation Screen.**
   - Press **Confirm** to accept the changes and reset all Remote, Peripheral, and Net ports.
   - Press **Confirm w/o Reset** to accept the changes without resetting all Remote, Peripheral, and Net ports. Only use this if told to do so by Ross Video Technical Support.
   - Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

**For More Information...**

- on naming an external panel row, refer to the section “** Naming an External Row**” on page Eng 17-8.
In This Chapter

This chapter provides information on setting up a Custom Control Shot Box Module or Audio Fader Module with the Vision switcher.

The following topics are discussed:

- Custom Control Shot Box Module
- Audio Control Module

For More Information...

- on installing the Custom Control Shot Box Module, refer to the documentation that came with your Shot Box Module.
- on storing and recalling shot box pages, refer to the section “Storing and Recalling Files and Setups” on page Eng 13-4.
Custom Control Shot Box Module

The Custom Control Shot Box Module (Figure 15.1) allows you to map custom controls from various banks to any of the 28 buttons on the Shot Box Module. Each custom control is mapped to a position on a Shot Box Page that corresponds to a button on the Shot Box. When the button on the Shot Box is pressed, the corresponding custom control is run. Additional commands such as selecting other pages can also be assigned to buttons on a page.

![Figure 15.1 Shot Box Module](image)

The active Shot Box Page is indicated in reverse text on the mnemonic button. The currently running custom control is indicated by the mnemonic text flashing between reverse text and normal, and the previously run custom control is shown in a different color, depending on the set color (if the normal color is green, the previously run custom control is shown in yellow). To avoid confusion, choose fonts and colors so the page buttons look different from the custom control buttons, and so you can tell the active page button from the other page buttons (its font is reversed between normal and inverted).

Custom Control Shot Box Module Setup

To set up the Shot Box Module, you must first assign each Shot Box Module to a panel row. Once the Shot Box Module is assigned to a panel row you can assign Shot Box Pages to the buttons. Assigning Shot Box Pages to buttons allows you to switch between pages by pressing the button on the Shot Box Module, just like switching between custom control banks on the bus.

Note — If more than one Shot Box Module is assigned to the same panel row, both modules will mirror each other. You cannot have two Shot Box Modules operate independently if they are assigned to the same panel row.

Shot Box Pages can be assigned to control buttons on the Auxiliary Control Panel when it is in Aux Bus mode.

For More Information...

- on assigning a module to a panel row, refer to the section “Mapping a Module to a Row” on page Eng 17-5.
- on the control buttons on the Auxiliary Control Panel, refer to the section “Auxiliary Control Panel Operation” on page Ops 12-2.

To Set up a Custom Control Shot Box Module

1. Press HOME ⇒ Setup ⇒ Installation ⇒ More ⇒ Custom Controls ⇒ Setup Shot Box Modules.
2. Use the Module Row knob to select the Shot Box Module that you want to assign buttons to pages on. Individual Shot Box Modules are identified by the panel row that they are assigned to. If you are setting up an Auxiliary Control Panel, the Panel Row is the row that the Auxiliary Control Panel is assigned to.

3. Use the Page knob to select the shot box page that you want to assign to a button.

4. Use the Button knob to select the button that you want to assign the select shot box page to. Only buttons 1 through 14 are available on the Auxiliary Control Panel.

5. Press HOME to display the Installation Change Confirmation Screen.
   - Press Confirm to accept the changes and reset all Remote, Peripheral, and Net ports.
   - Press Confirm w/o Reset to accept the changes without resetting all Remote, Peripheral, and Net ports. Only use this if told to do so by Ross Video Technical Support.
   - Press Cancel to exit the menus safely, without making any changes. The system returns to the previously stored settings.

Creating Shot Box Pages

When you create a Shot Box Page, you assign custom controls to the buttons on the page. The text on the buttons shows the mnemonic text for the custom control. The buttons on the shot box page correspond to the buttons on the Shot Box Module.

1. Press HOME ⇒ Custom Controls ⇒ More ⇒ Setup Shot Box Pages.

2. Use the Page knob to select the shot box page that you want to assign custom controls to.
3. Select the button on the shot box page that you want to assign a custom control to.

4. Use the **Bank** and **Button** knobs to select the custom control that you want to assign to the button on the shot box page.

### Naming Shot Box Pages

The Shot Box Page names appear on the menus the mnemonics, and the Shot Box buttons for that page. This is useful when working with multiple pages.

1. Press **HOME** ➔ **Custom Controls** ➔ **More** ➔ **Setup Shot Box Pages**.

2. Use the **Page** knob to select the shot box page that you want to change the name for.

3. Press **Modify Page Name**.

![Page Name Menu](image)

**Operating Tip** — Refer to the section “Using the Naming Menus” on page Eng 5-17 for more information on using the **Page Name Menu** to enter a name, or set up the mnemonics for the custom control button.

4. Enter the new name for the page in the **New Name** field. The name can be no more than 8 characters in length.

5. Press **Accept New Name** to store the new name and mnemonic settings.

### Copying or Moving Shot Box Pages

Each Shot Box page can be copied or moved to any other page location. The contents of the destination page is lost when a page is copied or moved to it. This allows you to duplicate or re-organize the Shot Box Pages.
1. Press HOME ⇒ Custom Controls ⇒ More ⇒ Setup Shot Box Pages ⇒ Copy/Move Pages.

![Manage Shot Box Pages Menu](image)

2. Use the **Source** knob to select the shot box page you want to copy or move.

3. Use the **Destination** knob to select the shot box page that you want to copy, or move, the source page to.

4. Copy a shot box page as follows:
   - Press **Copy** to copy the source shot box page to the destination.

5. Move a shot box page as follows:
   - Press **Move** to move the source shot box page to the destination. The commands in the source shot box page are moved to the destination. The source shot box page will be empty after the move.
Audio Control Module

The Audio Control Shot Box Module (Figure 15.2) allows you to map audio channels, or groups, from an audio mixer to any of the audio fader on the Audio Control Module.

![Figure 15.2 Audio Control Module](image)

When an audio channel, or group, is assigned to a slider, the source name for that audio channel is shown in the mnemonic above the audio fader. Audio channels, or groups, can be dynamically assigned to audio faders with a custom control.

The color of the mnemonic above each audio fader indicates the state of the audio channel, or group, assigned to the fader.

- **Orange** — Indicates that a channel assigned to that fader is on-air.
- **Yellow** — Indicates that all channels assigned to that fader are off-air.

To set up the Audio Control Module, you must first assign each Audio Control Module to a panel row. Once the Audio Control Module is assigned to a panel row you can assign audio channels to the audio faders.

**For More Information...**

- on assigning a module to a panel row, refer to the section “Mapping a Module to a Row” on page Eng 17-5.
- on naming audio channels, refer to the section “Setting Audio Channel Names” on page Eng 12-24.
- on creating audio fader custom controls, refer to the section “Programming Special Functions” on page Eng 10-15.
- on preventing a channel from being assigned to the module, refer to the section “Not Assign Audio Channel to Audio Fader” on page Eng 12-25.

**Audio Fader Maps**

Audio fader maps assign audio channels to audio faders on the Audio Control Menu.
1. Press HOME $\Rightarrow$ Setup $\Rightarrow$ Installation $\Rightarrow$ More $\Rightarrow$ Audio $\Rightarrow$ Assign Source.

![AudioFader Map Menu](image)

2. Use the Fader knob to select the audio fader that you want to assign an audio channel to.

3. Use the Audio Source knob to select the audio source that you want to assign to the audio fader.
   - NONE — Select this option to not assign an audio channel to the selected audio fader.
   - Chan X — Select this option to assign an audio channel to the selected audio fader.
   - Group X — Select this option to assign an audio group to the selected audio fader.
   - Floating — Select this option to have the switcher dynamically assign the audio channel, or group, that is on-air to the audio fader. Audio channel assignment starts with the lowest number channel that is on-air.
   - Master — Select this option to assign the master level to the audio fader.
SmartConversion and Up/Down Converters

In This Chapter

This chapter provides instructions for connecting, and setting up an Up/Down Converter with your Vision switcher. Before you begin, ensure that the SmartConversion™ option is installed. If not, please contact Ross Video for details. Refer to the section “Installed Options” on page Eng 6-9 for instructions on verifying the status of installed options.

The following topics are discussed in this chapter:

• Setting Up a Conversion Loop
• Switcher Setup

Operating Tip — A Conversion Loop Worksheet is provided to assist you in keeping track of which inputs and outputs have been assigned to the Up/Down Converters. Refer to the section “Conversion Loop Worksheets” on page Eng 21-20 for a copy of this worksheet.

For More Information...

• on operating an Up/Down Converter with SmartConversion, refer to the section “SmartConversion™” on page Ops 4-24.
Setting Up a Conversion Loop

Each conversion loop has an Output BNC that goes to the Up/Down Converter and an input source that comes from the Up/Down Converter. Along with the input and output BNCs, each conversion loop is assigned an input and output video format. This allows SmartConversion to route video signal that need to be converted to the proper Up/Down Converters.

Note — Up/Down Converters can only be used on a single video signal at a time. You should plan ahead to ensure that you will have enough Up/Down Converters of each video format for all the video signals you will want on-air at any one time. This includes video signals that are being transitioned off-air.

A conversion loop ties an Aux Bus output and an input source together so that when SmartConversion sends a video signal out to an Up/Down Converter, it knows on which input source the converted video signal is returned on.

Note — If you want the video selections for the Aux Buses that you are using for Up/Down Converters to be stored in memories, you must enable Aux Bus in the memory. Refer to the section “MLE Memory Attributes” on page Ops 9-10 for more information on using this feature.

1. Ensure that the **Output BNCs** that you want to use for your Up/Down Converter have been set up as **Aux Bus** outputs. Refer to the section “Configuring Video Outputs” on page Eng 8-2 for information on assigning an Aux Bus to an Output BNC.
2. Press HOME ⇒ Setup ⇒ Installation ⇒ Aux Bus.
3. Press **Ext Device Assign**.
4. Assign Input and Output BNCs to a particular Up/Down Converter as follows:
   - Use the **Aux Bus** knob to select the Aux Bus Output BNC that is connected to the input of your Up/Down Converter. This is the video signal that needs to be converted. The Aux Bus name and number is used to identify the conversion loop on the switcher.
   - Use the **Input** knob to select the input source that is connected to the output of your Up/Down Converter. This is the video signal that has been converted.
   - Use the **Tally when** knob to select **XPT On Air**. This allows the switcher to identify when a video signal is going on-air, and needs to be converted.
5. Press **SmartConversion ⇒ Aux To Converters**.

6. Activate a particular conversion loop as follows:
Use the **Aux Bus** knob to select the Aux Bus Output BNC that is connected to the input of your Up/Down Converter.

Use the **Used for Converter** knob to toggle the conversion loop on or off.

- **Yes** — Select this option to activate the selected conversion loop. SmartConversion will now be able to use this Up/Down Converter. Once activated, you will have to set the input and output video formats for each Up/Down Converter. Refer to the section “Assigning Buses to Use SmartConversion” on page Eng 16-5 for more information on assigning video formats to an Up/Down Converter.

- **No** — Select this option to not activate the selected conversion loop. SmartConversion will not use this Up/Down Converter.

7. Set the delay for a particular Up/Down Converter as follows:

- Use the **Delay** knob to select the amount of time that is required for the Up/Down Converter to convert the video signal and send it back to the switcher. Refer to your Up/Down Converter documentation for specific delay values.

8. Press **Converter Format**

9. Assign input and output video formats to a conversion loop as follows:

- Use the **Aux Bus** knob to select the conversion loop you want to assign the input and output video formats for.

- Use the **Input Format** knob to select the video format that is being sent to the Up/Down Converter.

**Note** — The **Converter Output Format** does not change the video format of the input source used by the conversion loop. When the conversion loop is activated, the video format of the input source is overridden by the **Converter Output Format**. Refer to the section “Assigning Input Source Types” on page Eng 7-4 for more information on setting up input sources.

- Use the **Output Format** knob to select the video format that the Up/Down Converter is converting the input video signal to. This is the output video signal of the Up/Down Converter.

10. Press **HOME** to display the **Installation Change Confirmation Screen**.

- Press **Confirm** to accept the changes and reset all Remote, Peripheral, and Net ports.

- Press **Confirm w/o Reset** to accept the changes without resetting all Remote, Peripheral, and Net ports. Only use this if told to do so by Ross Video Technical Support.
• Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

Next you must set up how the switcher will use the converters, and on which buses.

*For More Information...*

- on video formats, refer to the section “Video Formats” on page Eng 2-31.
- on setting specific video formats for input sources, refer to the section “Assigning Input Source Types” on page Eng 7-4.
- on resetting the video format of all input sources, refer to the section “Reference Connection and Setup” on page Eng 4-11.
- on defaulting the video format of all Aux Bus outputs, refer to the section “Reference Connection and Setup” on page Eng 4-11.
Switcher Setup

You can specify which MLEs and video feeds that SmartConversion is used on. This allows you to turn SmartConversion on or off for specific MLE video feeds or lock a specific conversion loop to an MLE or key. The display on the Fade to Black Module can be used to show the number of conversion loops that are still available.

Assigning Buses to Use SmartConversion

Assigning which buses, or video signals, SmartConversion can convert, allows you to prevent SmartConversion from converting video signals that you want to remain in non-native video format. This will also help to limit the usage of conversion loops for buses that do not need to be converted.

1. Press HOME ➔ Setup ➔ Installation ➔ Aux Bus ➔ SmartConversion ➔ Bus Disabling.

2. Use the Bus knob to select the Bus or Video Signal that you want to assign the SmartConversion usage to. You can choose between the following for each MLE:

   • **MLE X Program** — Select this option to select whether the Program bus on the selected MLE can use SmartConversion, where “X” represents the number of the MLE.

   • **MLE X Preset** — Select this option to select whether the Preset bus on the selected MLE can use SmartConversion, where “X” represents the number of the MLE.

   • **MLE X KY Video** — Select this option to select whether the Key Video Signal for the selected MLE can use SmartConversion, where “X” represents the number of the MLE, and “Y” is the number of the keyer.

   • **MLE X KY Alpha** — Select this option to select whether the Key Alpha Signal for the selected MLE can use SmartConversion, where “X” represents the number of the MLE, and “Y” is the number of the keyer.

   • **MLE X Utility1** — Select this option to select whether the Utility 1 bus on the selected MLE can use SmartConversion, where “X” represents the number of the MLE.

---

**Note** — If you have disabled Keyer 4 to activate Utility Bus 1 and 2, Key 4V and Key 4A will be replaced with U1 and U2.
• **MLE X Utility2** — Select this option to select whether the Utility 2 bus on the selected MLE can use SmartConversion, where “X” represents the number of the MLE.

• **MLEX DSKY Video** — Select this option to select whether the MultiDSK Key Video Signal on the program MLE can use SmartConversion, where “X” represents the number of the MLE, and “Y” is the number of the keyer.

• **MLEX DSKY Alpha** — Select this option to select whether the MultiDSK Key Alpha Signal on the program MLE can use SmartConversion, where “X” represents the number of the MLE, and “Y” is the number of the keyer.

• **MLEX KY BackV** — Select this option to select whether the Key Y Backside Video Signal for the selected MLE can use SmartConversion, where “X” represents the number of the MLE, and “Y” is the number of the keyer.

• **MLEX KY BackA** — Select this option to select whether the Key 1 Backside Alpha Signal for the selected MLE can use SmartConversion, where “X” represents the number of the MLE, and “Y” is the number of the keyer.

• **Aux Buses** — Select this option to select whether a particular Aux Bus can use SmartConversion. Aux Buses assigned to a conversion loop will not appear in the list.

**Note** — If an Aux Bus is assigned to an AuxKey, it is set to Conversion Enabled by default, all other Aux Buses are set to Conversion Disabled by default.

3. Use the Conversion Enabled knob to toggle SmartConversion On or Off.
   - **On** — Select this option to allow the selected bus, or video signal, to use SmartConversion.
   - **Off** — Select this option to prevent the selected bus, or video signal, from using SmartConversion.

4. Press HOME to display the Installation Change Confirmation Screen.
   - Press Confirm to accept the changes and reset all Remote, Peripheral, and Net ports.
   - Press Confirm w/o Reset to accept the changes without resetting all Remote, Peripheral, and Net ports. Only use this if told to do so by Ross Video Technical Support.
   - Press Cancel to exit the menus safely, without making any changes. The system returns to the previously stored settings.

**Locking Conversion Loops to Buses**

You can lock a specific conversion loop to a bus. This dedicates that Up/Down Converter to the selected bus preventing SmartConversion from using it somewhere else.
1. Press HOME ⇒ Setup ⇒ Installation ⇒ Aux Bus ⇒ SmartConversion ⇒ Converter Locking.

2. Use the Aux Bus knob to select the conversion loop you want to lock to an MLE bus.

3. Use the Lock To Bus/Pair knob to select the bus, or bus pair that you want to lock the selected conversion loop to. You can choose between the following for each MLE:
   - None — Select this option to not lock the conversion loop to a bus.
   - MLE X BKGD+PST — Select this option to lock the conversion loop to the Program and Preset bus of the select MLE, where “X” represents the number of the MLE.

   **Note** — If you are locking a conversion loop to the BKGD+PST bus pair, you should lock 2 conversion loops to the bus pair. One conversion loop for each bus.

   - MLE X KEY Y — Select this option to lock the conversion loop to the Key bus of the selected MLE, where “X” represents the number of the MLE, and “Y” is the number of the keyer.
   - Aux Buses — Select this option to lock the conversion loop to an Aux Bus.

4. Press HOME to display the Installation Change Confirmation Screen.
   - Press Confirm to accept the changes and reset all Remote, Peripheral, and Net ports.
   - Press Confirm w/o Reset to accept the changes without resetting all Remote, Peripheral, and Net ports. Only use this if told to do so by Ross Video Technical Support.
   - Press Cancel to exit the menus safely, without making any changes. The system returns to the previously stored settings.

**Fade to Black Display Mode for Up/Down Converters**

The Fade to Black Display Mode sets whether the display on the Fade to Black Module will display the current fade rate, or the number of Up/Down Converters available on the switcher.

1. Press HOME ⇒ Setup ⇒ Personality.
2. Use the Option knob to select FTB Display.
3. Use the **Value** knob to toggle between **SmrtConv** or **FTB**.

   - **SmrtConv** — Select this option to have the display on the **Fade to Black Module** show the number of available up/down converters for SmartConversion to use.
   - **FTB** — Select this option to have the display on the **Fade to Black Module** show the transition rate for a Fade to Black transition.
Switcher Calibration and Diagnostics

In This Chapter

This chapter provides information on performing calibration and diagnostic tests on your Vision switcher.

The following topics are discussed in this chapter:

- Switcher Software Version
- Switcher Calibration
- Mapping a Module to a Row
- Fail Indicators Diagnosis
- Communication Status and Errors
- Non-Sync Status
- Control Panel Diagnostic Tools
- Frame Diagnostic Tools
- VNC Viewer
- Video Checksum Custom Controls
- Communication Port Monitor
- Switcher Logs
Switcher Software Version

The Version Information shows the version number and date of the software that is currently running on the control panel and frame. Other information that is provided on this menu are the IP address of the control panel and frame, and size of the Global-Store on the frame.

- Press HOME ⇒ Status ⇒ Version Info.

For More Information...

- on finding the current version of the Vision Operating System, refer to the section “Panel Boards Menu” on page Eng 6-9.
Switcher Calibration

Calibration allows you to reset the limits of the faders on the control panel, re-center the positioner with X, Y and Z limits, and align the touchscreen display.

Calibration can also be used to have the LEDs in the buttons of the control panel display in a calibrated, or uncalibrated mode. When the control panel is manufactured, the LEDs for each button are calibrated to a single standard so that all the buttons appear as a consistent color. This color offset is stored in each module.

1. Press HOME \(\rightarrow\) Setup \(\rightarrow\) Installation \(\rightarrow\) More \(\rightarrow\) Calibration.

2. Use the LED Calibration knob to turn LED calibration on or off.
   - **No** — Select this option to not have the LEDs light as normal.
   - **Yes** — Select this option to have the LEDs light in an uncalibrated state. Any calibration color offsets are ignored.

3. Press ADC Calibration.

4. Calibrate a Fader as follows:
   - Move the fader from one limit to the other and back again. Be sure not to pressure the fader into the stop. Doing so may make it difficult to end a transition, or cause the fader to accidentally start a new transition when it is released.

Operating Tip — For more information on the Node and Link values for the module you are calibrating, refer to the section "Module Control Link Backbone" on page Eng 20-9.
5. Calibrate the **Positioner** as follows:
   - Move the positioner forwards and backwards along the Y-axis to calibrate the Y limits of the positioner.
   - Move the positioner left and right along the X-axis to calibrate the X limits of the positioner.
   - Twist the positioner clockwise and counter-clockwise to calibrate the Z limits of the positioner.

6. Press **Accept** to accept the new calibration limits.

7. Calibrate the **Touchscreen** as follows:
   - Press **Touch Screen Calibration**. The calibration screen is displayed.
   - Follow the on-screen instructions.

---

**Note** — If you have the V-100B TouchScreen, you must restart the control panel to apply the new calibration values.
Mapping a Module to a Row

Control Panel Mapping allows you to assign modules to Panel Rows, or control panel rows. This is used to assign a newly installed module to a row of modules on the control panel, or to assign an Auxiliary Control Panel to the switcher.

You can install a single module, or multiple at the same time, depending on how you want to install the modules.

For More Information...

- on installing a module, refer to the section “Replacing a Control Panel Module” on page Eng 18-21.
- on assigning a GPI to an Auxiliary Control Panel, refer to the section “Auxiliary Control Panel GPIs” on page Eng 14-11.
- on assigning an external module to an External Link Port, refer to the section “External Panel Modules” on page Eng 9-20.

Mapping Multiple Modules

If you are mapping several modules to a panel row, you can use the Quick Module Configuration to quickly map modules to a row by pressing button on each row in succession.

1. Press HOME ➔ Setup ➔ More ➔ Panel Modules. A warning is displayed, asking you if you want to enter the menu. Press Yes to display the Panel Modules Menu.

   ![Panel Modules Menu](image)

   **Important** — Do not use the Remove Unfound Module Cfgs button on the Panel Modules Menu unless instructed to do so by Ross Video Technical Support.

2. Press Quick Configure.
3. Select the panel row that you want to start assigning modules to as follows:
   - Select the type of panel row you want to program. You can choose between the following:
     - **Internal Rows** — Select this option to program a row on the Vision control panel. You can choose between **Row 1** and **Row 8**.
     - **External Rows** — Select this option to program a row on an Auxiliary Control Panel, or other external module, not including the Touchscreen Display. You can choose between **Row 1** and **Row 16**.

4. Press any button on the panel row module that you want to map buttons starting at 1 to. All the buttons on the module will light up.

5. Press any button on the next panel row module that you want to map the next set of buttons to. All the buttons on this module will light up.

6. Continue selecting modules until all the Crosspoint Modules and control modules, including the Transition Module and Memory Module, that you want to assign to the row, have been selected.

7. Configure additional rows as needed.

8. Press Exit to exit the menu.

### Mapping a Single Module

If you are mapping a single module to a panel row, you can use select the link and node that you installed the module on and assign it to a panel row.

1. Press HOME ⇔ Setup ⇔ More ⇔ Panel Modules. A warning is displayed, asking you if you want to enter the menu. Press Yes to display the Panel Modules Menu.

   **Important** — Do not use the Remove Unfound Module Cfgs button on the Panel Modules Menu unless instructed to do so by Ross Video Technical Support.

2. Use the Link/Node knob to select the link and node that the module you want to assign to a row is installed on. You can also press a button on the module to jump to the link and node.

4. Use the Panel Row knob to select the panel row that you want to assign the module to. You can select either an internal row (Row 1 to Row 8), or an external row (Row 1 to Row 16).

5. Use the First Crosspoint knob to select the number of the first crosspoint button on the module you are setting up. Each Crosspoint Module has 8 buttons, so the first button on module 1 is 1, the first button on module 2 is 9. If the module does not have crosspoint buttons, this knob is gray.

Note — If you are programming an Auxiliary Control Panel, the modules have 16 buttons.

6. Set up a Custom Control module as follows:
   - Use the Link/Node knob to select the link and node that the module you want to assign to a row is installed on. You can also press a button on the module to jump to the link and node.
   - Press Custctrl & GPI Group.

Operating Tip — The Custom Control module number will follow the numbering of the Crosspoint modules by default.

   - Use the First Custctrl knob to select the number of the first custom control button on the module you are setting up. Each custom control module has 8 buttons, so the first button on module 1 is 1, the first button on module 2 is 9. If the module does not have custom control buttons, this knob is gray.
7. Set up an Audio Control module as follows:
   - Use the **Link/Node** knob to select the link and node that the module you want to assign to a row is installed on. You can also press a button on the module to jump to the link and node.
   - Press **Audiofader**.

   ![Audio Fader Module — Panel Modules Menu](image)

   - Use the **First Fader** knob to select the number of the first audio fader on the module you are setting up. Each Audio Control module has 8 audio faders, so the first audio fader on module 1 is 1, the first audio fader on module 2 is 9.

### Naming an External Row

Each external row can be given a unique name that appears on the **Assign Bus Maps Menu**, as well as the **Panel Module Quick Configuration Menu**.

1. Press **HOME** ⇒ **Setup** ⇒ **Installation** ⇒ **Aux Bus** ⇒ **Remote Panels** ⇒ **External Row Setup**.

   ![External Rows Menu](image)

2. Use the **External Row** knob to select the external row that you want to name.
3. Press **Rename Row**.
4. Enter the new name for the external row in the New Name field. The name can be no more than 8 characters in length.

5. Press Accept New Name to store the new name.

6. Press HOME to display the Installation Change Confirmation Screen.
   - Press Confirm to accept the changes and reset all Remote, Peripheral, and Net ports.
   - Press Confirm w/o Reset to accept the changes without resetting all Remote, Peripheral, and Net ports. Only use this if told to do so by Ross Video Technical Support.
   - Press Cancel to exit the menus safely, without making any changes. The system returns to the previously stored settings.
Fail Indicators Diagnosis

The touchscreen display has two fail indicators (Figure 17.1) that are used to identify a possible problem with either a power supply or fan in either the control panel or frame.

![Fail Indicators Diagram]

Figure 17.1 Panel and Frame Power Fail Indicators

When either of these indicators is lit, the switcher has detected a possible problem with either the frame or control panel. With either of these fail indicators, pressing the lit indicator displays the Status Menus.

Complete Status

The Complete Status shows the current operational status of the fans and power supplies in the frame and control panel, as well as the temperature and communications status of the panel.

1. Press HOME ➔ Status ➔ Complete Status.

2. Refer to the section “Status Components and Conditions” on page Eng 17-11 for information on the status conditions.
Warnings

The Warnings list shows all the warnings or errors that have been generated by the switcher. This can include fan or power supply failures, or communications problems.

1. Press HOME ➔ Status ➔ Warnings.

![Warnings — Status Menu](image)

2. Refer to the section “Status Components and Conditions” on page Eng 17-11 for information on the status conditions.

Status Components and Conditions

There are a number of components and conditions that the switcher monitors and reports on. These items are as follows:

- **1080p29.97 Video Mode** — This item lists any boards in the frame that are not compatible with the 1080p 29.97Hz video format when this video format is selected.

- **3G Video Mode** — This item lists any boards in the frame that are not compatible with the 1080p 59.94Hz and 1080p 50Hz video formats when one of these video formats is selected.

- **Driver Status** — This item indicates the status of the FlexDevice drivers that are currently installed on the switcher. A driver can be OK, Obsolete, or Unsupported. Refer to the section “Installing and Managing FlexDevice Drivers” on page Eng 9-4 for information on managing drivers.

- **Frame Fans** — This item indicates whether the cooling fans in the frame are operating normally, or that a number of fans have failed. Refer to the section “Frame Fan Failure” on page Eng 18-8 for more information on replacing a fan.

- **Frame Graphics Buffer FPGA Temperature** — This item indicates whether the graphics buffer FPGA is operating in the normal temperature range.

- **Frame Power Supplies** — This item indicates whether there are enough power supplies in the frame, that they are operating normally, or that one, or more, of them has failed. If the status for the power supply is “Temperature not available”, the temperature sensor in the power supply is not functioning normally. Refer to the section “Frame Power Supply Failure” on page Eng 18-6 for more information on replacing a power supply.

- **Frame Power Supply Fans** — This item indicates whether the fans in the frame power supplies are operating normally.
• **Frame Present** — This item indicates whether a frame has been detected and is communicating with the Vision control panel. If the message, **Unsupported frame board configuration.** is displayed, one or more of the boards in the frame is in the wrong slot. Refer to the section “Removing and Installing Frame Boards” on page Eng 4-18 for information on the supported board locations for your frame.

• **Hard Drive Status** — This item indicates whether the hard drive on the frame CPU Board is reporting any Self-Monitoring, Analysis, and Reporting Technology (S.M.A.R.T.) warnings or has experienced a complete failure. If a warning or failure is displayed, contact Ross Video Technical Support for information on diagnosing the warning or replacing your hard drive.

• **Panel and Frame Software Versions** — This item indicates if the software version on the control panel is not the same as the software version on the frame. An upgrade must to be performed so that both the frame and the control panel are on the same software version. Refer to the section “Software Upgrade” on page Eng 6-3 for more information on performing a software upgrade.

• **Panel Fans** — This item indicates whether the cooling fans in the control panel are operating normally, or that one, or more, of them has failed. The **Power Supply Modules** that contain the cooling fans are closed units and not field serviceable. If a fan needs to be replaced, the entire module is replaced. Refer to the section “Control Panel Power Supply Failure” on page Eng 18-2 for more information on replacing a fan.

• **Panel Module Discovery** — This item indicates whether or not all the modules on the control panel have been successfully discovered and set up. If a module is not properly set up, or is not present, a warning is displayed. Refer to the section “Replacing a Control Panel Module” on page Eng 18-21 for more information on setting up a control panel module.

• **Panel OS Version** — This item indicates what the current version of the Operating System running on the control panel CPU Module is and if it is up to date.

• **Panel PCH Temperature** — This item indicates whether the Panel Communications Hub is operating in a safe temperature range.

• **Panel Power Supplies** — This item indicates whether the power supplies in the Vision control panel are operating normally, or that one, or more, of them has failed. Refer to the section “Control Panel Power Supply” on page Eng 18-10 for more information on replacing a power supply.

• **PMC Status** — This item indicates whether Panel Module Controller are running the current version of software. Refer to the section “Upgrading PMCs” on page Eng 18-23 for information on updating the software on a PMC.

• **Reference** — This item indicates whether the current input reference format is properly locked.

• **SBC CPU Temperature** — This item indicates whether the CPU in the Control Panel CPU Module is operating in the normal temperature range.

• **SBC Motherboard Temperature** — This item indicates whether the motherboard in the Control Panel CPU Module is operating in the normal temperature range.

• **Stuck Buttons** — This item indicates whether there are any stuck buttons on the Vision control panel. Refer to the section “Stuck Button Test” on page Eng 17-19 for more information on stuck buttons.

• **Vid Card Temperatures** — This item indicates whether the Video Processor Board in the frame is operating in the normal temperature range.

**Status Icons**

There are 3 types of status icons that indicate the current status of each component or condition that the switcher is monitoring. These icons are as follows:
- **Good** — This icon indicates that a component or condition is operating properly.

- **Warning** — This icon indicates that a condition is outside of the normal operating parameters. For example, the temperature inside the panel may be slightly above or below the safe operating temperature.

- **Failure** — This icon indicates a major problem with a component or condition that the switcher is monitoring. For example, the temperature inside the control panel could be dangerously above or below the safe operating temperature. The fail icon will also indicate control panel modules that are not properly assigned to MLEs.
Communication Status and Errors

The Vision switcher provides a number of status and error detection menus that allow you to troubleshoot and diagnose communication problems.

Control Panel Communication Status

The **TX/RX Status Menu** allows you to view the current communication status of the communication ports on the control panel.

- Press **HOME ➔ Status ➔ TxRx Status**.

![TX/RX Status Menu](image)

- The **TX/RX Status Menu** shows the current status of the Remote ports (R1-R8), the External Link ports (ELP2-ELP4), and the communication between the control panel and the frame (Panel/Frame).

Serial Communication Errors

The **TxRx Errors Menu** shows all the errors that have been reported for the serial communications from the frame and the control panel. The errors can be shown for all the serial communications ports on the control panel and frame, or for a specific port on either.

1. Press **HOME ➔ Status ➔ TxRx Errors**.

![TxRx Errors Menu](image)

**Operating Tip** — You can reset the error count by pressing the **Reset Count** button on the **TxRx Errors Menu**. This will clear all the error counters on the control panel and frame.
2. Use the Panel knob to select the serial communications port on the control panel that you want to view the errors for. You can choose between the following:

- **Total Errors** — Select this option to view the total number of errors for all the serial communication ports on the control panel.
- **AUXPAN X (AX)** — Select this option to view the errors for the selected Auxiliary serial communications port, where X represents the number of the port.
- **REMOTE X (RX)** — Select this option to view the errors for the selected Remote serial communications port, where X represents the number of the port.

3. Use the Frame knob to select the serial communications port on the frame that you want to view the errors for. You can choose between the following:

- **Total Errors** — Select this option to view the total number of errors for all the serial communication ports on the frame.
- **FRM2PAN (FP)** — Select this option to view the errors for the PANEL port.
- **PERIPH X (PX)** — Select this option to view the errors for the selected Peripheral serial communications port, where X represents the number of the port.

If you want more information on the serial communication errors that have occurred, you can view the error statistics.
Non-Sync Status

The **Non-Sync Status Menu** allows you to check if a video signal selected on a crosspoint bus, or the video outputs of the switcher, is synchronized with the switcher reference format. The Non-Sync indicators serve as a warning only, indicating that the timing of the input should be fixed at the source. If the source is non-synchronous with the switcher reference format, cuts, dissolves and other effects can still be performed, but the source is shifted vertically.

If a non-synchronous source is selected on a crosspoint bus, and the non-sync detection feature is turned on, the crosspoint button flashes, indicating that the source is mis-timed.

1. Press **HOME ⇒ Status ⇒ Non-Sync Status ⇒ MLEs**.

   ![Non-Sync Status Menu (4-Keyer, QMD-X shown)]

2. A Green or Yellow indicator is shown for each bus on each MLE. As you select different sources on each bus, the indicator updates, showing if the source is synchronized or not.
   - **Green** — A green indicator shows that the source selected on the corresponding bus and MLE is synchronized with the switcher reference.
   - **Yellow** — A yellow indicator shows that the source selected on the corresponding bus and MLE is not synchronized with the switcher reference. This source should be synchronized to the switcher reference from the source.

3. Press **Output Boards**.

   ![Non-Sync Status Menu (QMD-X shown)]

4. A Green or Yellow indicator is shown for each output BNC on each Video Output Board installed in the frame.
   - **Green** — A green indicator shows that the video being output on the corresponding output BNC is synchronized with the switcher reference.
• **Yellow** — A yellow indicator shows that the video being output on the corresponding BNC is not synchronized with the switcher reference.

*For More Information...*

• on turning Non-Sync detection on or off, refer to the section “**Non-Sync Detection**” on page Eng 7-10.
Control Panel Diagnostic Tools

The Vision control panel supports a number of diagnostic tests that can be used to identify issues with your switcher.

These tests are designed to be used by Ross Video Technical Support and other qualified Ross Video personnel.

The control panel diagnostic tests are grouped into the following categories:

- Module Tests
- Panel Communications Hub Tests
- Control Panel SBC Test
- Touchscreen Tests
- Burn Mode

Module Tests

The Module Tests allow you to test the functionality of the knobs, buttons, faders, and positioner of the switcher, as well as test the color of the buttons. Additional tests are provided for the control panel displays and the memory for each module.

Button Color Test

The button color test allows you to test the LEDs in each button on a module. Each Button LED on the module illuminates, and then transition to the next LED, cycling through the different colors. The brightness of the LEDs is also be cycled between max and min brightness.

1. Press HOME ⇒ Setup ⇒ Panel Diagnostics ⇒ Module Test.
2. Press LED Test to enter Button Color Display Mode.
3. Press any button on the control panel module you want to test.
4. Confirm that all buttons on the module are changing at the same time, and that the colors and brightness are consistent.

This completes the procedure for performing a button color test.

Button Function Test

The button function test allows you to test if the buttons on the control panel are working properly or not. This test requires you to press the button that you want to test and the switcher reports where and what that button is.

1. Press HOME ⇒ Setup ⇒ Panel Diagnostics ⇒ Module Test.
2. Press Device Test.
3. Press the button that you want to test. The Button Test Information is displayed with the name, or function, of the button is listed on the menu, as well as the module and hardware location of the button.
4. Confirm that the button you pressed is shown on the menu.

5. Double-press **Exit** on the **Device Test Menu** to stop the test.

**Stuck Button Test**

The stuck button test allows you to identify any and all buttons that the switcher reports as being stuck. A button is considered to be stuck when it is held for more than 30 seconds.

1. Press **HOME ➔ Setup ➔ Panel Diagnostics ➔ Module Test**.
2. Press **Stuck Buttons** to display a list of any stuck buttons.

3. Any buttons that the switcher reports as being stuck is listed on the menu. The button is identified by the **Module** it is on, as well as the **Label** of the button.

**Fader Test**

The fader test allows you to test the functionality of the faders on the control panel. This test requires you to move the fader that you want to test from one limit to the other. The switcher reports where that fader is, and whether the fader has been moved from one limit to the other.

1. Press **HOME ➔ Setup ➔ Panel Diagnostics ➔ Module Test**.
2. Press **Device Test**.
3. Move the fader that you want to test. The **Fader Test** is displayed with an illustration of the fader, and the transition indicators on the **Transition Module** light. The module and hardware location of the fader are also be displayed on the menu.
Positioner Test

The positioner test allows you to test the functionality of the positioner on the control panel. This test requires you to move the positioner left and right, as well as twist it. The switcher reports where that positioner is, and how it is being moved.

1. Press HOME ➔ Setup ➔ Panel Diagnostics ➔ Module Test.
2. Press Device Test.
3. Move the positioner forward and backward to display the Positioner Test. An illustration of the positioner appears on the menu. As you move the positioner, the Y value for the positioner is displayed on the menu.
4. Move the positioner left and right. As you move the positioner, the X value for the positioner is displayed on the menu.
5. Twist the positioner clockwise and counter-clockwise. As you twist the positioner, the Z value for the positioner is displayed on the menu.
6. Double-press Exit to stop the test.

Control Panel Display Test

The control panel display test allows you to test the color pixel functionality of all the displays and mnemonics on the control panel. Each display and mnemonic on the control panel is illuminate, and then transitions to the next color, cycling through the different colors. The brightness of the displays and mnemonics is also cycled between max and min brightness.
1. Press HOME ➔ Setup ➔ Panel Diagnostics ➔ Module Test.

2. Press Display Test to enter Display Test Mode.

3. Confirm that all displays and mnemonics are changing at the same time, and that the colors and brightness are consistent.

**Knob Test**

The knob test allows you to test the functionality of the knobs on the touchscreen display of the control panel. The Vision control panel supports either haptic knobs, with force feedback on the knob, or optical knobs, without feedback on the knob.

1. Press HOME ➔ Setup ➔ Panel Diagnostics ➔ Module Test.

2. Press Knob Test. In the center of the menu is a position graph for the knob. As you rotate the knob, the slider moves along the position graph.

---

**Change Only — Knob Test Menu**

### Operating Tip

Select Change Only on the Knob Test Menu to show only the changes in the knob position. Any range or boundary information is ignored. Select Wrap in Range on the Knob Test Menu to show the range for the knob. When the knob reaches the end of the range, it wraps around on the position graph.

---

3. Test the Boundaries functionality of the knob as follows:

   - Press Range with Boundaries.
   - Rotate the knob you want to test. The knob should become increasingly difficult to turn at the end of the position graph.

4. Test the Barrier functionality of the knob as follows:

   - Press Range with Barriers.
   - Rotate the knob you want to test. The knob should stop at the end of the position graph.

5. Test the Knob Button as follows:

   - Press the knob you want to test. The text under the knob should change to Knob Button Down while the knob button is being pressed.
Module Memory Test

The module memory test allows you to test the integrity of the button and mnemonic memory used in a module.

1. Press HOME  ➔ Setup  ➔ Panel Diagnostics  ➔ Module Test.
2. Press Memory Test. The switcher tests each module on the control panel, including the touchscreen display, and report any errors on the menu.

This completes the procedure for performing a module memory test.

Audio Fader Test

The Audio Fader test allows you to test the functionality of the audio faders on the Audio Control module. This test moves the audio faders on the menu and on the module, and shows you which audio fader is currently being touched.

1. Press HOME  ➔ Setup  ➔ Panel Diagnostics  ➔ Module Test  ➔ AudioFader.
2. Use the Link/Nodes knob to select the Audio Control module that you want to test.
3. Move each audio fader on the Audio Control module and confirm that the menu shows the correct position of the slider. As you touch each audio fader, a finger icon appears below that fader on the menu.

4. Run one of the automated movement test as follows:
   - **Up** — Press this button to have all the audio faders move to the top position.
   - **Down** — Press this button to have all the audio faders move to the bottom position.
   - **Wave** — Press this button to have all the audio faders move up and down in a wave pattern.

Panel Communications Hub Tests

The Panel Communications Hub (PCH) Tests allow you to test the functionality of the PCH communication links with the various components of the switcher. Some of these tests require the use of a loopback adapter on the communications port.

PCH Transmit/Receive Test

The PCH Tx/Rx test allows you to test the various serial communications ports on the control panel. This test helps to diagnose communication problems with external devices that you may be having on a particular serial communications port on the control panel.
These do not include the ports on the Control Panel CPU. Refer to the section “Control Panel SBC Test” on page Eng 17-25 for more information on testing the Control Panel CPU ports.

1. Press HOME ⇒ Setup ⇒ Panel Diagnostics ⇒ PCH Test.

2. Press TX/RX Test.

3. Connect a loopback adapter to the port that you want to test.

4. Use the Com Port knob to select the serial communications port on the frame you want to test. You can choose between the following:
   - AUXPAN X (AX) — Select this option to test one of the Aux ports on the control panel, where X represents the port number.
   - REMOTE X (RX) — Select this option to test one of the Remote ports on the control panel, where X represents the port number.

   **Operating Tip** — If you want to monitor the communications on one of the communications ports, you can select Monitor on the Panel CPU TX/RX Test Menu to view the communications on that port. Refer to the section “Communication Port Monitor” on page Eng 17-36 for more information on using the Communications Port Monitor.

5. Use the Mode knob to select the transmission standard you want to use to test the selected port. You can choose between the following:
   - RS-422 — Select this option to test the selected serial communications port using the RS-244 (TIA/EIA-422) transmission standard.
   - RS-422 Null — Select this option to test the selected serial communications port using the RS-422 (TIA/EIA-422) transmission standard. This option changes the signals on the pinouts of the port for use with a null modem cable.
   - RS-232 — Select this option to test the selected serial communications port using the RS-232 (TIA/EIA-232) transmission standard.

6. Press Test to run the test on the selected serial communications port. The outcome of the test is reported on the menu as Passed or Failed.

**LVDS Test**

The Low Voltage Differential Signalling (LVDS) test allows you to test the various communications between the Panel Communications Hub (PCH) and all the Panel Module.
Controllers (PMC) installed on the switcher. This test includes both internal and external modules.

1. Press HOME ⇒ Setup ⇒ Panel Diagnostics ⇒ PCH Test.
2. Press LVDS Test.
3. Test the internal LVDS links as follows:
   - Toggle LVDS Links to Intern display the Internal LVDS Test. The switcher tests the integrity of all the communications connections between the PCH and each PMC.

![Internal LVDS Test — LVDS Test Menu](image)

- Confirm that all the modules that are installed on your control panel pass. If you want to test LVDS links that are not connected to a PMC, you must use a loopback adapter.

4. Test the external LVDS links as follows:
   - Toggle LVDS Links to Extern display the External LVDS Test Menu. The switcher tests the integrity of all the communications connections between the PCH and each external PMC.

![External — LVDS Test Menu](image)

- Confirm that all the external modules that are installed on your control panel pass. If you want to test LVDS links that are not connected to a PMC, you must use a loopback adapter.

For More Information...
- on the LVDS Backbone, refer to the section “Module Control Link Backbone” on page Eng 20-9.
**Tally Test**

The tally test allows you to test the standard parallel tally system of the switcher. A Tally Test Box is required to ensure that the tally relays are operating properly. The number of tallies you have available to test depends on whether you have the Extended Tallies option installed.

1. Press HOME ⇒ Setup ⇒ Panel Diagnostics ⇒ PCH Test.
2. Press Tally Test.

3. Test your Tallies as follows:
   - Press Prev to select and test the previous tally.
   - Press Next to select and test the next tally.
   - Press All On to turn all tallies on.
   - Press All Off to turn all tallies off.

**PCI Bridge Test**

The Peripheral Component Interconnect (PCI) Bridge test allows you to test the PCI Bridge that is used to pass information between the Control Panel CPU and the PCH.

1. Press HOME ⇒ Setup ⇒ Panel Diagnostics ⇒ PCH Test.
2. Press PCI Test. The switcher will test the PCI Bridge and report any errors on the menu.

The outcome of the test is reported on the menu as Passed or Failed.

**Control Panel SBC Test**

The Control Panel Single Board Computer (SBC) Tests allow you to test the functionality of the external ports on the Control Panel SBC. Some of these tests require the use of the a loopback adapter on the communications port.

**Control Panel SBC Transmit/Receive Test**

The Control Panel SBC Tx/Rx Test allows you to test the various communications ports on the control panel SBC.

1. Press HOME ⇒ Setup ⇒ Panel Diagnostics ⇒ SBC Test.
2. Press TX/RX Test.
3. Connect a loopback adapter to the port that you want to test.

4. Use the Com Port knob to select the serial communications port on the control panel you want to test. You can choose between the following:
   - Com 1 — Select this option to test the Serial 1 port on the control panel.
   - Com 2 — Select this option to test the Serial 2 port on the control panel.
   - Parallel — Select this option to test the Parallel 1 port on the control panel.

5. Press Test to run the test on the selected communications port.

The outcome of the test is reported on the menu as Passed or Failed.

**Touchscreen Tests**

The Touchscreen tests allow you to test the functionality and performance of the touchscreen display. These tests include how well the touchscreen displays content, and if the touch sensor is properly calibrated.

**Pattern Test**

The pattern test allows you to visually check the performance of the touchscreen as it cycles through a number of patterns and colors.

1. Press HOME ➔ Setup ➔ Panel Diagnostics ➔ Touch Screen.
2. Press Test Pattern. The touchscreen cycles through a number of test patterns of different colors.
3. Confirm that the touchscreen is displaying the pattern correctly, and that the colors and brightness are consistent.
4. Tap the touchscreen anywhere to stop the test.

**Draw Test**

The Draw Test allows you to visually check the functionality of the touchscreen by having it feedback the location of where you touch with an X on the screen.

1. Press HOME ➔ Setup ➔ Panel Diagnostics ➔ Touch Screen.
2. Press Draw Test. The touchscreen goes blank for the duration of the test.
3. Tap the touchscreen to test it. A red X will appear where you start. Trace the yellow line from the red X to the blue O.
4. Press Quit, or press Esc on the keyboard, to stop the test.
Burn Mode

The burn mode performs a number of tests on the control panel to ensure that all internal memory and communications ports are operating properly. To ensure that all external communications ports are operating properly, a loopback adapter must be installed on each port.

1. Press HOME ➔ Setup ➔ Panel Diagnostics ➔ Burn Mode.

2. Set the dongle usage as follows:
   - **LVDS Ports** — Toggle the LVDS Dongle to **Yes** if you have connected a loop back dongle to the LVDS ports, including the Aux ports, that you want to test.
   - **Serial Ports** — Toggle the RS422 Dongle to **Yes** if you have connected a loop back dongle to the serial ports, including the Remote ports, that you want to test.

**Operating Tip** — The **View Summary** and **View Log** options allow you to view the outcome of the test on the menu. The Log can then be saved to a USB flash drive by pressing **Save Log to USB**.

3. Press **Start Test** to start the test. The switcher cycles through the LED tests, Display and Mnemonics tests, LVDS tests, Memory tests, and all the Tx/Rx tests for the control panel. The tests continues until stopped.

4. Press **Stop Test** to stop the test.
Frame Diagnostic Tools

The QMD/X and MD/X frames support a number of diagnostic tests that can be used to identify issues with your switcher. Some tests require a loopback adapter, or other external device, to confirm the diagnostics outcome.

These tests are designed to be used by Ross Video Technical Support and other qualified Ross Video personnel.

In a MultiPanel configuration, only the Master Panel can access the Frame Diagnostics Menu.

Frame Transmit/Receive Test

The frame Tx/Rx test allows you to test the various serial communications ports on the frame. This helps to diagnose communications problems with external devices that you may be having on a particular serial communications port on the frame.

1. Press HOME \(\Rightarrow\) Setup \(\Rightarrow\) Frame Diagnostics \(\Rightarrow\) TX/RX Test.

![Frame TX/RX Test Menu]

2. Use the Com Port knob to select the serial communications port on the frame you want to test.

**Operating Tip** — You can have the test run continuously by toggling Loop to Yes, on the Frame TX/RX Test Menu. When the test reaches the end, it starts over from the beginning until Loop is toggled to No.

3. Press Test to run the test on the selected serial communications port.

**Operating Tip** — If you want to monitor the communications on one of the communications ports, you can select Monitor on the Frame TX/RX Test Menu to view the communications on that port. Refer to the section “Communication Port Monitor” on page Eng 17-36 for more information on using the Communications Port Monitor.

GPI Test

The GPI test allows you to test the functionality of each GPI input and output on the switcher. A graphical representation of each GPI indicates whether a particular GPI is on or off. Refer to the section “Standard GPI Setup” on page Eng 12-10 for more information on setting up and using GPIs.
1. Press HOME ⇒ Setup ⇒ Frame Diagnostics ⇒ GPI Test.

![GPI Test Menu]

2. Test your GPIs as follows:
   • Press Prev to select and test the previous GPI input or output.
   • Press Next to select and test the next GPI input or output.
   • Press All On to turn all GPI inputs and outputs on.
   • Press All Off to turn all GPI inputs and outputs off.

### LEDs Test

The LEDs test allows you to confirm the functionality of the diagnostic LEDs on the frame CPU Board. In order to complete this test you need to access the internal boards of the frame.

**Note** — You must remove the front door of the frame to perform this test. Refer to the section “Opening and Closing the Frame Door” on page Eng 3-3 for more information on removing and installing the frame door.

1. Press HOME ⇒ Setup ⇒ Frame Diagnostics ⇒ LEDs Test.
2. Check the LEDs on the frame.
3. Press UP ONE to stop the test and display the Frame Diagnostics Menu.

### DIP Switch Test

The DIP test allows you to verify the current settings of the DIP Switch on the Frame CPU Board (4800AR-001 and 4800AR-002). To confirm this test, you must remove the Frame CPU Board to verify the setting of the DIP Switch. Contact Ross Video Technical Support before attempting to change any DIP switch setting on the Frame CPU Board. Refer to the section “Frame CPU Board DIP Switch” on page Eng 20-8 for more information on the Frame CPU Board and the DIP Switch.

• Press HOME ⇒ Setup ⇒ Frame Diagnostics ⇒ DIP Test. The number of DIP switches shown depends on the Frame CPU Board that you have.
Graphics Buffer Test

The GfxBuffDDR test allows you to test the performance of the graphics buffer RAM. The test verifies both read and write functionality of the graphics buffer.

1. Press HOME ➔ Setup ➔ Frame Diagnostics ➔ GfxBuffDDR Test.

2. Perform a quick Bus Test on the graphics buffer as follows:
   
   • Press **Bus Test** to perform the test. This test verifies the performance of the bus between the DDR and the switcher. The results of the test are shown on the menu.

3. Perform a full Device Test on the graphics buffer as follows:
   
   • Press **Device Test** to perform the test. This test verifies the performance of the graphics buffer DDR. The results of the test are shown on the menu.
VNC Viewer

The Virtual Network Computing (VNC) viewer allows you to remotely control the menu system of one of the control panels connected to the frame. You can only connect to one control panel at a time.

Note — This feature requires Vision OS 37, or higher, to be running on all the control panel you want to control. Contact Ross Video technical support for information on upgrading the OS on your Vision control panels.

Keep the following in mind when using the VNC viewer:

- You will be able to see the menu actions that a user at the control panel makes, and they can see the actions you make.

To Run the VNC Viewer

Note — The VNC Viewer requires Java to be installed for the browser you are using, and popup blocking to be turned off.

1. On your computer, open your Web Browser and, in the address bar, enter the IP address of your frame and press Enter. The QMD/X Web Interface Splash Screen is displayed.
2. Enter your username and password as follows when the Login Dialog Box appears. The default Name is user and Password is password.
3. Click Other... ⇒ VNC Viewer.
4. In the Panel list, click the control panel that you want to control. Control panels are listed as Master or Satellite and by their IP addresses.
5. Click Launch VNC Viewer. A VNC Viewer applet page will open, causing a Java window (sbc-vision) to open.
6. In the Java window, type user and press Enter.
7. Type password and press Enter.
Video Checksum Custom Controls

The Video Checksums custom control is a diagnostic tool that allows Ross Video Technical Support and other Ross Video staff to diagnose the operation of specific switcher functions based on the video output of the MLEs. When a checksum is inserted into a custom control, the switcher records the values that are returned at that point. When the custom control is run again, the switcher compares the new values that are returned against the stored values and reports either an error or a validation at the end of the custom control.

These tests are designed to be used by Ross Video Technical Support and other qualified Ross Video personnel.

Setting Up a Checksum Custom Control

**Note** — In order for the checksum value to be validated, the video signal used when running the test must be the same that was used when the custom control was recorded. Only stills or internally generated signals, such as color patterns, should be used.

1. Press HOME ➔ Custom Controls.
2. Select the custom control button you want to record to as follows:
   - Use the Bank knob to select the bank that you want to record the custom control on.
   - Use the Button knob to select the custom control button you want to record to.

   ![Checksums Menu](image)

4. Toggle Checksums to On to activate this feature.
5. To perform a Short Checksum, press Short to have a short checksum performed. When you choose a short checksum, you have to select the type of checksum to perform, and which input or output video signal to perform the test on.
   - Use the Checksum reg knob to select the Checksum Register you want to use.
     You can choose between the following:
     - **FE out** — Select this option to have the checksum calculated at the output of the Video Interface FPGAs on the Video Processor Board.
     - **Vid in** — Select this option to have the checksum calculated at the input of the Video Core FPGA on the Video Processor Board.
     - **Vid out** — Select this option to have the checksum calculated at the output of the Video Core FPGA on the Video Processor Board.
› **FE in** — Select this option to have the checksum calculated at the input of the Video Interface FPGAs on the Video Processor Board.

› **All** — Select this option to have the checksum calculated on all the checksum registers.

• If you selected **FE out** or **Vid in**, use the **Input video** knob to select the video signal that you want to perform the checksum on. You can choose between the following:
  
  › **Background** — Select this option to perform the checksum on the Background video signal.
  
  › **Preset** — Select this option to perform the checksum on the preset, or Preview, video signal.
  
  › **K1V** — Select this option to perform the checksum on the Video Fill signal of Key 1.
  
  › **K1A/K2A** — Select this option to perform the checksum on the Alpha signal for all the Keys.
  
  › **Trans_mix 0/1** — Select this option to perform the checksum on the video signals as a transition is being performed.
  
  › **K2V** — Select this option to perform the checksum on the Video Fill signal of Key 2.

• If you selected **FE in** or **Vid out**, use the **Output video** knob to select the video signal that you want to perform the checksum on. You can choose between the following:
  
  › **Program** — Select this option to perform the checksum on the Program video signal coming out of the MLE.
  
  › **Preview** — Select this option to perform the checksum on the Preview video signal coming out of the MLE.
  
  › **Clean** — Select this option to perform the checksum on the Clean Feed video signal coming out of the MLE.


7. Add events into the custom control. Refer to the section “Programming Control Panel Functions” on page Eng 10-10 for more information on adding events into a custom control.

---

**Important** — A 4 frame Custom Control Pause Command should be added to the custom control before each checksum point if the video signal has been changed. This ensures that enough time has passed to allow the new video signals to propagate through the switcher.

---

8. Add a **Checksum** event to the custom control as follows:

  • Press HOME ➔ Custom Controls ➔ Insert Special ➔ More ➔ Video Checksums.
9. Select the MLE, or MLEs, that you want to calculate a checksum for.

10. Add events into the custom control as needed.

11. Press **Finish Recording**.

*For More Information...*

- on the different video signals used by the switcher, refer to the section “**Video Routing**” on page Eng 2-20.

**Using a Checksum Custom Control**

The Checksum custom control records and display the checksum validation on one of four different ways. This option must be set before the custom control is run to have the validation perform the actions you want.

1. Press **HOME ➔ Custom Controls ➔ More ➔ Checksums ➔ Checksum Diff Action**.

2. Use the **Action on error** knob to select the action you want the switcher to take when a checksum is performed. You can choose between the following:

   - **No action** — Select this option to have no action taken when the checksum custom control is run.

   **Note** — Unless you select **No action**, a pop-up with the result of the checksum is displayed when the checksum event has finished.
• **Log change** — Select this option to have any changes in the checksum values recorded to a system log that can be viewed by a Ross Video employee. A pop-up is displayed when the custom control is finished. This is the default setting.

• **Halt macro** — Select this option to have any changes in the checksum values halt the custom control and display the checksum event that returned the incorrect value. A pop-up is displayed, indicating the problem.

• **Recalc c'sums** — Select this option to have the checksum values that are returned the next time the checksum custom control is run saved as the new checksum values. The existing checksum values is replaced with the new values. A pop-up is displayed if any of the checksum values were replaced.

3. Press **HOME**.

4. Run the checksum custom control.
Communication Port Monitor

The communications port monitor allows you to view the information that is being sent to or received by the switcher. This information can then be saved to a file that can be sent to Ross Video Technical Support if required.

The Com Port Monitor Menu is accessed through the Panel TX/RX Test Menu or the Frame Tx/RX Test Menu. On that menu you must select which port you want to monitor.

For More Information...

- on selecting a communications port on the frame, refer to the section “Control Panel SBC Transmit/Receive Test” on page Eng 17-25.
- on selecting a communications port on the frame, refer to the section “PCH Transmit/Receive Test” on page Eng 17-22.

Note — You cannot Save or turn on Streaming for a communications port that has been set to a Baud Rate of 115200.

To Monitor a Serial Port

1. Toggle Freeze to Yes to stop data from being displayed.
2. Press Clear to remove any existing data stored in the monitor buffer.

3. Toggle Format to Hex or ASCII to select how you want the data displayed.
   - Hex — Select this option to have the data displayed in a Hexadecimal format.
   - ASCII — Select this option to have the data displayed in an ASCII format.

4. Toggle View to Tx or Rx to select which data is displayed.
   - Tx — Select this option to monitor the data that is being transmitted from the selected serial communications port.
   - Rx — Select this option to monitor the data that is being received by the selected serial communications port.

Operating Tip — Toggle Streaming to Yes to store all the data being transmitted from or received by the selected communications port. Streaming stores data for a maximum of 1 hour, at which point Streaming is toggled to No.
5. Toggle **Freeze** to **No** to start viewing the data that is being sent to or received by the selected port.

6. Send or receive the commands you want to monitor.

7. Toggle **Freeze** to **Yes** to stop displaying the data on screen. At this point you can save

---

**Operating Tip** — **At this point you can save the data displayed on screen by pressing Save on the Com Port Monitor Menu.**

If you saved, or streamed, the data to a file, you will have to navigate to the frame to view the file.

---

**Port Monitor Data Files**

After you have saved the port monitor data to the hard drive on the frame, you have to navigate to the frame to access the data file.

1. On your computer, open your Web Browser and, in the address bar, enter the IP address of your frame and press Enter. The QMD/X Web Interface Splash Screen is displayed.

2. Enter your username and password as follows when the **Login Dialog Box** appears. The default **Name** is **user** and **Password** is **password**.

3. Click **Other...** ➔ **PMBrowser** to display the **Port Monitor File Browser Page**. This page allows you to download all the port monitor log files.

![Port Monitor File Browser Page](image)

4. Click on the file you want to view. Files are identified by where they come from, what port they are from, and whether they are transmit or receive data.

---

**Note** — Port Monitor file number is offset by three (3). For example, the file **pan04tx.txt** is from the control panel, remote port 1, transmit data.

---

**Operating Tip** — Press the **Refresh Files** button updates the list of port monitor files. You can also delete a file by selecting the file and pressing the **Delete Selected Files** button.
Switcher Logs

Switcher logs are used by Ross Video Technical Support to track and diagnose possible problems you might be having with your switcher. When asked for your switcher logs, you must log into the frame and download the logs.

The switcher stores up to a week worth of log data at any time. This log data is usually broken up into eight (8), 24-hour sets of log files.

Collecting Logs

At any one time there is a current log file, and up to seven archived log files. When you collect the log files, you can either get all of the logs for the past week, or only the current log file that the switcher is writing to.

1. On your computer, open your Web Browser and, in the address bar, enter the IP address of your frame and press Enter. The QMD/X Web Interface Splash Screen is displayed.

2. When the Login Dialog Box appears, enter your username and password as follows:
   - In the Name field enter user. This is the factory default name.
   - In the Password field enter password. This is the factory default password.
   - Click OK to display the System Info Page.

**Operating Tip** — You can collect only the current log files by clicking on Get Current Logs and following the instructions. Only the logs that the switcher is currently writing to are copied and a new log is started.

3. Click Logs... ➔ Get All Logs to display the Get All Switcher Log Files Page.
4. Click Get All Switcher Log Files. The switcher starts collecting all of the log files together into a single archive. This process may take several seconds to complete.
5. Click the stills/all-logs.tar.gz link to open or download the archive to your computer.

Deleting Logs

You can delete all or only the archived log files from the switcher. This allows you to free up space on the switcher, or clean up the logs before starting to debug an issue for technical support.

1. On your computer, open your Web Browser and, in the address bar, enter the IP address of your frame and press Enter. The QMD/X Web Interface Splash Screen is displayed.

2. When the Login Dialog Box appears, enter your username and password as follows:
   - In the Name field enter user. This is the factory default name.
   - In the Password field enter password. This is the factory default password.
   - Click OK to display the System Info Page.

**Operating Tip** — You can delete only the archived log files by clicking Delete Old Logs and following the instructions. The current log files are unaffected.

3. Click Logs... ➔ Delete All Logs to display the Delete All Switcher Log Files Page.
4. Click Delete All Switcher Log Files.
Cycling Logs

You can manually have the switcher start a new set of current log files. The old set of log files are added to the archive, and the oldest set of archived log files are deleted.

1. On your computer, open your Web Browser and, in the address bar, enter the IP address of your frame and press Enter. The QMD/X Web Interface Splash Screen is displayed.

2. When the Login Dialog Box appears, enter your username and password as follows:
   • In the Name field enter user. This is the factory default name.
   • In the Password field enter password. This is the factory default password.
   • Click OK to display the System Info Page.

3. Click Logs... → Cycle Logs to display the Cycle Switcher Log Files Page.

4. Click Cycle Switcher Log Files. The switcher archived the current set of log files and starts a new set of current log files.
Switcher Maintenance

In This Chapter

This chapter provides information on maintaining and replacing the power supplies, fans, faders and control panel modules of the Vision switcher. This includes diagnosing and replacing a failed power supply, cleaning the filters and replacing a fader assembly. General information is also provided for replacing a control panel module.

The following topics are discussed in this chapter:

- Control Panel Power Supply Failure
- Frame Power Supply Failure
- Frame Fan Failure
- Control Panel Power Supply
- Frame Power Supply
- Cleaning the Frame Air Filter
- Replacing the Hard Drive
- Replacing a Control Panel Module
- Dusting Mode

**Warning Hazardous Voltage** — Hazardous voltages are present in the control panel as long as any of the power supplies are connected to the AC power.

**ESD Susceptibility** — Static discharge can cause serious damage to sensitive semiconductor devices. Avoid handling the switcher circuit boards in high static environments such as carpeted areas and when synthetic fiber clothing is worn. Touch the frame to dissipate static charge before removing boards from the frame and exercise proper grounding precautions when working on circuit boards.
Control Panel Power Supply Failure

When a control panel power supply or cooling fan fails, the switcher will identify the failed component on the Status Menu. Use this information to trouble-shoot the Power Supply Module and replace it if required.

Note — The Vision control comes with a single power supply. If you purchased the Redundant Power option, a second power supply is installed in the control panel.

Troubleshooting a Failed Power Supply

When the switcher reports that a power supply has failed, the failure could be in the power supply, or in the Power Distribution Board for the control panel.

1. The Status Menu identifies which power supply is reporting a failure (Figure 18.1). If you have the Redundant Power option installed, Power Supplies 1 and 2 are located in the Primary Power Supply Module and Power Supplies 3 and 4 are located in the Secondary Power Supply. If you do not have the Redundant Power option, only the Primary Power Supply Module is present with Power Supplies 1 and 2.

2. Check the AC power cords for the failed Power Supply Modules. Ensure that they are securely plugged into the control panel power supply, as well as the power outlet.

3. If each Power Supply Module is connected to separate circuits, check that there has not been an interruption to the AC power for the failed power supply.

4. Lift up on the control panel lid to gain access to the control panel tub.

5. Locate the Power Distribution Board (Figure 18.2) at the back of the tub above the Control Panel CPU Module.
6. Using the **Power Supply Indicators** (Figure 18.2), identify the power supply that has failed. If a power supply is not providing power, or is not installed, the **Power Supply Indicator** will not be lit.

   - **Vision 3 and 4** — Power Supplies 1 and 2 are located in the **Primary Power Supply Module** and Power Supplies 3 and 4 are located in the **Secondary Power Supply Module**.
   - **Vision 1 and 2** — Power Supply 1 is located in the **Primary Power Supply Module** and Power Supply 2 is located in the **Secondary Power Supply Module**.

   **Note** — If all the **Power Supply Indicators** are lit, check the cables between the power supplies and the **Power Distribution Board**.

7. Remove the failed **Power Supply Module**. Refer to the section “Replacing a Power Supply Module” on page Eng 18-4 for information on replacing a power supply module.

### Troubleshooting a Failed Cooling Fan

When the switcher reports that a cooling fan has failed, the failure could be in the power supply, or in the fan itself.

1. The **Status Menu** identifies which cooling fan is reporting a failure. Locate that fan on the control panel (Figure 18.3). If you have the Redundant Power option installed, **Cooling Fans 1 and 2** are located in the **Primary Power Supply Module** and **Cooling Fans 3 and 4** are located in the **Secondary Power Supply Module**. If you do not have the Redundant Power option, only the **Primary Power Supply Module** is present.

2. Place a small piece of paper in front of each cooling fan in the **Power Supply Module** to determine if the fan is moving air.

3. If a cooling fan is *not* moving air, or is moving much less than the other fans, that **Power Supply Module** must be replaced. Refer to the section “Replacing a Power Supply Module” on page Eng 18-4 for information on replacing a **Power Supply Module**.
Replacing a Power Supply Module

To replace a Power Supply Module in the control panel, you must power down the control panel, disconnect all the cables and remove the old the Power Supply Module.

1. Toggle the Primary and, if installed, Secondary AC Power switches for the control panel to OFF (Figure 18.4).

2. Disconnect the AC power cords from the back of the Power Supply Module that contains the failed power supply.

3. Label and remove the Power Supply Status Cables and Power Supply Cables for each power supply in the Power Supply Module before you remove them. If there is only power supply in the module, you do not need to label the cables.

4. Disconnect the Power Supply Status Cables and Power Supply Power Cables for the power supplies in the Power Supply Module that you want to remove.

5. Remove the 2 retaining screws along the front flange of the Power Supply Module.

6. Slide the failed Power Supply Module out of the control panel tub and place on a clean, dry surface.

7. Slide the new Power Supply Module into the open slot in the control panel tub that you just removed the failed Power Supply Module from.

8. Replace the 2 retaining screws along the front flange of the Power Supply Module.

Note — If you do not connect the cables to the proper power supplies, you may cause the Status Menu to give false readings.
9. Reconnect the **Power Supply Status Cables** and **Power Supply Power Cables** for each power supply in the **Power Supply Module** according to how you marked them in **Step (3.) above**.

10. Reconnect the AC power cords from the back of the **Power Supply Module**.
Frame Power Supply Failure

In order to diagnose a power supply failure you must remove the door from the frame, and identify the failed power supply using the status indicators on each power supply.

1. Check the network status between the control panel and frame. If there has been a network interruption, the switcher may report a power failure of the frame power supplies.

2. Check the AC power cords for all power supplies. Ensure that they are securely plugged into each receptacle.

3. If each of your power supplies are connected to separate circuits, check that there has not been an interruption to the AC power on either of those circuits.

4. Check if there are enough power supplies installed in your frame. Refer to the section “Frame Power Supplies” on page Eng 20-4 for the minimum number of power supplies required.

5. Check if there is a power supply mismatch. The 500 Watt (4800AR-014) and 700 Watt (4800AR-024) power supplies cannot be used in the same frame at the same time.

6. Remove the front door of the frame. Refer to the section “Opening and Closing the Frame Door” on page Eng 3-3 for more information.

7. Locate the frame power supplies (Figure 18.5).

8. Use the following table (Table 18.1) to diagnose the status of each power supply and determine the corrective action.

![Figure 18.5 Frame Power Supplies (QMD Shown)](image)

**Table 18.1 Panel Power Supply Diagnosis**

<table>
<thead>
<tr>
<th>Power Switch</th>
<th>Green Power Indicator</th>
<th>Yellow Standby Indicator</th>
<th>Red Fail Indicator</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>On</td>
<td>Off</td>
<td>Off</td>
<td>Normal Operation — Check the network connection between control panel and frame.</td>
</tr>
<tr>
<td>Off</td>
<td>Off</td>
<td>On</td>
<td>Off</td>
<td>Standby Mode (QMD/MD)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Toggle the power switch on the power supply On for normal operation.</td>
</tr>
<tr>
<td>On</td>
<td>Off</td>
<td>On</td>
<td>Off</td>
<td>Standby Mode (QMD-X/MD-X)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Toggle the power switch on the power supply On for normal operation.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Check that the Main Power switch is on.</td>
</tr>
</tbody>
</table>
9. Replace the power supply if needed. Refer to the section “Replacing a Frame Power Supply” on page Eng 18-13 for information on replacing a power supply.

<table>
<thead>
<tr>
<th>Power Switch</th>
<th>Green Power Indicator</th>
<th>Yellow Standby Indicator</th>
<th>Red Fail Indicator</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Off</td>
<td>Off</td>
<td>On</td>
<td>Fail</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Check the AC power cable and building circuit breakers.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Replace the power supply if needed.</td>
</tr>
<tr>
<td>On</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
<td>Fail</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Check the AC power cable and building circuit breakers.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Check the AC power input fuse and replace if needed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Replace the power supply if needed.</td>
</tr>
<tr>
<td>Off</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
<td>Fail</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Check the AC power cable and building circuit breakers.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Check the AC power input fuse and replace if needed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Replace the power supply if needed.</td>
</tr>
</tbody>
</table>
Frame Fan Failure

In order to diagnose and repair a cooling fan failure, you must identify the fan that the switcher is reporting as failed on the Status Menu, and replace the fan.

1. Press HOME ⇒ Status ⇒ Complete Status.

2. Next to **Frame Fans**, identify which fans have failed by the fan numbers. These numbers identify individual fans on the Fan Carrier Board. The location of the fan on the board depends on the board you have.

![Complete Status — Status Menu](image)

![Figure 18.6 QMD-X Fan Board (4800AR-030 and 4800AR-031) Fan Numbers](image)
3. Shut down the switcher. Refer to the section “Powering Down the Switcher” on page Eng 4-3 for information on powering down the switcher.

4. Remove the front door of the frame. Refer to the section “Opening and Closing the Frame Door” on page Eng 3-3 for more information.

5. The System Status Indicators on the left side of the frame changes from Green to Red, indicating that it is safe to turn the power off.

6. Remove the Fan Carrier Board from the frame.

7. Replace the failed fans as required.
Control Panel Power Supply

The Power Supply Modules in the Vision control panel can operate in a primary, or load sharing mode, if the Redundant Power option is installed. The Redundant Power option allows all the Power Supply Modules in the frame to share the power load of the frame. In this configuration, if one of the Power Supply Modules fails, the remaining Power Supply Module can maintain the operation of the frame.

This section provides information on the functional components of a Power Supply Module.

Control Panel Power Supply Functional Components

The Vision control panels use a 250 or 500 (Figure 18.9) Watt Power Supply Module, depending on the control panel you have. The 250 Watt Power Supply Module is similar to the 500 Watt Power Supply Module, but has only the single power supply inside.

For More Information...

- on which power supply module each control panel requires, refer to the section “Control Panel Power Supplies” on page Eng 20-3.

Warning Hazardous Voltage — Hazardous voltages are present within the power supply for a short period of time after removal from the control panel. The power supply cover is intended to protect the user from access to these areas, and should not be removed. Ross Video Power Supply Module are intended to be factory serviced by qualified Ross Video service personnel only.

![Figure 18.9 Control Panel 500 Watt Power Supply Module](image)

1. **Power Supply 1 Power Connector**
   - The power connector for Power Supply 1 uses a 14-Pin, keyed locking Molex connector to interface with the Power Distribution Board to provide power to the control panel.

2. **Power Supply 1 Status Connector**
   - The status connector for Power Supply 1 uses a 9-Pin, friction fit Molex header to interface with the Power Distribution Board to pass status information on the power supply and cooling fan.

3. **Power Supply 2 Power Connector**
   - The power connector for Power Supply 2 uses a 14-Pin, keyed locking Molex connector to interface with the Power Distribution Board to provide power to the control panel.
4. **Power Supply 2 Status Connector**
   The status connector for Power Supply 2 uses a 9-Pin, friction fit Molex header to interface with the Power Distribution Board to pass status information on the power supply and cooling fan.

5. **Power Switch**
   The Power Switch is used to turn the individual Power Supply Modules on and off. The single switch turns both power supplies on and off for the 500 Watt Power Supply Module.

6. **Power Supply 1 Cooling Fan**
   The single fan provides cooling for Power Supply 1.

7. **Power Supply 2 Cooling Fan**
   The single fan provides cooling for Power Supply 2.

8. **AC Plug**
   The single AC port is used to connect the mains or AC power in the facility to the control panel.
Frame Power Supply

The power supplies in the frame can operate in a primary, or load sharing mode, if the **Redundant Power** option is installed. The redundant power option allows all the power supplies in the frame to share the power load of the frame. In this configuration, if one of the power supplies fails, the remaining power supplies can maintain the operation of the frame.

This section provides information on the functional components of a power supply, as well as information on how to replace a power supply.

Frame Power Supply Functional Components

There are a number of important components of the Frame Power Supply that are discussed in this section. These components include the power switch, the status indicators, and the midplane connectors.

**For More Information...**

- on which power supply module each frame requires, refer to the section “Control Panel Power Supplies” on page Eng 20-3.

---

**Warning Hazardous Voltage** — Hazardous voltages are present within the power supply for a short period of time after removal from the frame. The power supply cover is intended to protect the user from access to these areas, and should not be removed. Ross Video power supplies are intended to be factory serviced by qualified Ross Video service personnel only. Service or any component replacement other than the AC input fuse is not advised.

---

**Figure 18.10 Frame Power Supply Front**

1) Power Switch  
2) Green Power Indicator  
3) Yellow Standby Indicator  
4) Red Fail Indicator

1. **Power Switch**
   
The Power Switch is used to turn the individual power supplies on and off. The switch is in the off position when it is toggled down.

2. **Green Power Indicator**
   
   This green indicator illuminates to show that the power supply is functioning properly.

3. **Yellow Standby Indicator**
   
   This yellow indicator illuminates to show that the power supply is in standby mode. A power supply will be in standby mode because the master power switch or the power switch on the power supply has been turned off.

4. **Red Fail Indicator**
   
   This red indicator illuminates to show that the power supply is not operating. This is because the power supply has failed or is installed incorrectly.
Replacing a Frame Power Supply

The power supplies in the frame are hot-swappable only if the Redundant Power option is installed. If you do not have redundant power supplies, you must power down the frame before attempting to remove a power supply.

**Warning Hazardous Voltage** — Hazardous voltages are present on the pins of supply mating connectors within the frame power supply housing area. To reduce the risk of electric shock, keep clear of mating connectors within the supply area when power supplies modules are not installed.

---

1. Remove the front door of the frame. Refer to the section “Opening and Closing the Frame Door” on page Eng 3-3 for more information.

2. Locate the power supply to be replaced.

**Important** — If you do not have redundant power installed in your frame, you must power down the frame before proceeding, if it is not already off.

3. Switch the power supply **Off** by toggling the power switch down.

4. Loosen the 2 screws holding the slider catch in place until the catch moves freely (Figure 18.11).

![Power Supply Protective Cage](image_url)

**Figure 18.11 Power Supply Protective Cage**

5. Move the slider catch all the way to the right.

**Caution** — The metal cage surrounding the power supply may be hot after prolonged switcher operation.

6. Grasp the tab and gently pull the power supply out of the frame.

7. Switch the replacement power supply **Off** by toggling the power switch down.

**Warning** — The 500 Watt (4800AR-014) and 700 Watt (4800AR-024) power supplies cannot be used in the same frame at the same time; doing so may damage the power supply, the frame, or both.

8. Install the new power supply by sliding it into the open slot and pushing it firmly into place.

9. Move the slider catch to the left until it hooks the side of the slot.

10. Tighten the screws to secure the slider catch in place.
11. Switch the new power supply **On** by toggling the power switch up. The switcher will automatically detect the new power supply and clear the fail message.

12. Install the front door of the frame.
Cleaning the Frame Air Filter

The frame has a single air filter that is used to prevent dust and airborne particulates from contaminating the frame. This filter should be cleaned at least once a year; but may need to be cleaned more frequently in some environments.

1. Remove the front cover of the frame.
2. Locate the air filter on the far left side of the frame (Figure 18.12), next to the Fan Carrier assembly.
3. Grasp the end of the filter and gently pull it out of the frame.

4. While servicing the air filter, replace the front cover of the frame to ensure no dust or debris falls into the frame.
5. Brush any loose dust off of the filter.
6. Place the filter under warm running water to remove any remaining dust. On one side of the filter is a “bug screen” mesh. When rinsing, water should flow out of this side.
7. Remove the filter from the water and pat dry with a towel to remove any moisture.
8. Remove the front cover of the frame.
9. Replace the clean, dry filter back into the air filter slot in the frame. Ensure that the side with the mesh is facing the outer wall of the frame, and the edge without the foam is situated at the front of the frame.
10. Replace the front cover of the frame.

With the air filter cleaned, it is a good idea to record how dirty it was and how long it has been since the last cleaning. If the filter was very dirty, you should shorten the interval between cleanings to compensate for your particular conditions.
Replacing the Hard Drive

In the event that the hard drive installed in your frame needs to be replaced, a spare hard drive, with the original shipping version of the software on it, is provided in the spare parts kit.

Depending on the frame CPU you have, the type of hard drive that is used, and how it is installed are different.

Note — The software provided on the spare hard drive should be the current shipping version at the time the hard drive was imaged. This may not be the newest version of software available. Once you have installed the spare hard drive, you should contact Ross Video for the most current version of the software.

For More Information...

• on performing a software upgrade, refer to the section “Software Upgrade” on page Eng 6-3.
• on backing up your switcher setups, refer to the section “Storing and Recalling Files and Setups” on page Eng 13-4.

Replacing the Hard Drive on the 4800AR-001 Frame CPU Board

1. Power down the switcher. Refer to the section “Powering Down the Switcher” on page Eng 4-3 for information on Shutting down switcher.

2. Remove the Frame CPU Board from Slot A at the back of the frame. Refer to the section “Removing and Installing Frame Boards” on page Eng 4-18 for more information on locating and removing this board.

3. Locate the Hard Drive on the Frame CPU Board.

4. Release the Ribbon Cable from the Ribbon Cable Connector by pressing down and out on the Ejector Tabs at either end of the Ribbon Cable Connector (Figure 18.14).
5. Flip the CPU Board over so that the Hard Drive is facing down.

6. Locate the four Retaining Screw securing the Hard Drive in place (Figure 18.15).

7. Using a non-magnetic (electronics safe) screwdriver, remove the 4 Retaining Screws securing the Hard Drive.

8. While holding the Hard Drive to the CPU Board, flip the CPU Board back over so that the Hard Drive is facing up again.

Note — Ensure that you do not damage the rubber spacers located at each screw hole when you remove the Hard Drive.

9. Remove the Hard Drive from the CPU Board and place in a safe location.

10. Remove the Ribbon Cable from the Hard Drive you just removed and install it onto the replacement Hard Drive. Ensure that the stripe on the Ribbon Cable is aligned towards the four unused pins as illustrated (Figure 18.16).
11. Ensuring that the Rubber Spacers are in place, install the replacement Hard Drive using the 4 Retaining Screws you removed earlier (Figure 18.17).

12. Push the Ribbon Cable into the Ribbon Cable Connector until the Ejector Tabs at either end of the Ribbon Cable Connector close together, securing the Ribbon Cable in place.

13. Re-install the Frame CPU Board into the same slot in the frame that you removed it from.

You may have to reset your network configurations or update your software version.

Replaced the Hard Drive on the 4800AR-002 Frame CPU Board

1. Power down the switcher. Refer to the section “Powering Down the Switcher” on page Eng 4-3 for information on shutting down switcher.

2. Remove the Frame CPU Board from Slot A at the back of the frame. Refer to the section “Removing and Installing Frame Boards” on page Eng 4-18 for more information on locating and removing this board.

3. Locate the Hard Drive on the Frame CPU Board.
4. Flip the CPU Board over so that the Hard Drive is facing down. Ensure that you do not dislodge or damage the heat sinks on the top of the board.

5. Locate the four Retaining Screw securing the Hard Drive in place (Figure 18.19).

6. Using a non-magnetic (electronics safe) screwdriver, remove the 4 Retaining Screws securing the Hard Drive.

7. While holding the Hard Drive to the CPU Board, flip the CPU Board back over so that the Hard Drive is facing up again.

**Note** — Ensure that you do not damage the rubber spacers located at each screw hole when you remove the Hard Drive.

8. Ensuring that the Rubber Spacers are in place, install the replacement Hard Drive by angling it slightly down towards the Hard Drive Connector and pushing it firmly onto the connector.

9. Secure the replacement Hard Drive using the 4 Retaining Screws you removed earlier (Figure 18.19).
**Caution** — Do not over tighten the Retaining Screws. These screws only need to be snug in order to secure the Hard Drive in place.

10. Re-install the Frame CPU Board into the same slot in the frame that you removed it from.

    You may have to reset your network configurations or update your software version.
Replacing a Control Panel Module

Each module on the Vision control panel can be removed and replaced as required with the exceptions of the **Preview Bus Module** and the **Positioner Module**.

**Note** — Installing control panel modules in different locations than the default is not supported at this time.

Removing a Control Panel Module

To remove a module, you will have to power down the control panel, disconnect the power and communications cables to the module, and then un-bolt it from the control panel.

1. Power down the control panel. The frame can remain on during this procedure. Refer to the section “Powering Down the Switcher” on page Eng 4-3 for information on shutting down the control panel.
2. Unplug the Primary and Redundant (if installed) power from the control panel.
3. Lift up on the control panel lid to gain access to the control panel tub.
4. Identify the module that you want to replace from inside the control panel tub.
5. Disconnect the **Module Power Cable** from the module you want to remove (Figure 18.21). This 4-conductor ribbon cable delivers power to all the modules in the row, when removing it, ensure that you do not accidentally unplug it from any neighboring modules.

**Figure 18.21** Effects Keyer Module — Power Connector

**Note** — The **Preview Bus Module** connects to the Module Control Link Backbone through the **Positioner Module**. To remove either of these modules, the 26-Pin ribbon cable between the two modules must be removed. The **Preview Bus** will not operate properly if it is not connected to the **Positioner Module**.

6. Disconnect the Module Control Link **Cables** from the module you want to remove (Figure 18.22). This CAT5 (TIA/EIA-568-B) cable delivers all the command signals to and from the module, as well as other modules in the same row.
7. Remove the **Retaining Bolts** located at each corner of the module and keep them in a safe place. A ¼ inch hex driver or wrench is required.

8. Remove the module from the control panel and place it on a clean, static free surface.

---

**Important** — If a replacement module is not available, you must install and secure a blank module cover plate to replace the module until the new module is available.

Next, you will have to install the new control panel module.

### Installing a Control Panel Module

To install a module, you will have to power down the control panel, disconnect the communications cables, remove the blank cover plate if installed, install the new module, and then connect the power and communications cables.

1. Power down the control panel. The frame can remain on during this procedure. Refer to the section “**Powering Down the Switcher**” on page Eng 4-3 for information on shutting down the control panel.

2. Unplug the Primary and Redundant (if installed) power from the control panel.

3. Lift up on the control panel lid to gain access to the control panel tub.

4. Identify the module that you want to replace from inside the control panel tub.

5. Remove the blank cover plate, if one was installed in the module opening.

6. Slide the new module into the module opening. Ensure that the module opening is of the correct size for the module you are trying to install. Refer to the section “**Control Panel Dimensions**” on page Eng 20-6 for more information.

7. Install the **Retaining Bolts** located at each corner of the module to a maximum torque of 5 in-lbs (6 cm-kg). A ¼ inch hex driver or wrench is required.

---

**Note** — The Preview Bus Module connects to the Module Control Link Backbone through the Positioner Module. To remove either of these modules, the 26-Pin ribbon cable between the two modules must be removed. The Preview Bus will not operate properly if it is not connected to the Positioner Module.

---

8. Connect and secure the Module Control Link **Cables** to the module you are installing (Figure 18.23). This CAT5 (TIA/EIA-568-B) cable delivers all the command signals to and from the module, as well as other modules in the same row.
9. Connect and secure the Module Power Cable to the module you want to install (Figure 18.24). This 6-conductor ribbon cable delivers power to all the modules in the row, when installing it, ensure that you do not accidental unplug it from any neighboring modules.

10. Close the control panel lid and reconnect the Main and Redundant (if installed) power to the control panel.

11. Power up the control panel. Refer to the section “Powering Up the Switcher” on page Eng 4-2 for information on powering up the control panel.

12. If the message PMCs need to be upgraded; please go to Panel Modules menu is shown on the Main Menus, you need to upgrade your PMC. Refer to the section “Upgrading PMCs” on page Eng 18-23 for information on upgrading PMCs.

13. Test the functionality of the new module. Refer to the section “Control Panel Diagnostic Tools” on page Eng 17-18 for more information on performing control panel diagnostics.

14. Assign the module to a Crosspoint Group, or row, on the control panel. Refer to the section “Mapping a Module to a Row” on page Eng 17-5 for more information on assigning a module to a crosspoint group.

**Upgrading PMCs**

The Panel Module Controllers (PMCs) may need to be upgraded if you perform a software upgrade or replace a module. If PMCs need to be upgraded, the message PMCs need to be upgraded; please go to Panel Modules menu is shown on the Main Menus.
1. Press HOME \(\Rightarrow\) Setup \(\Rightarrow\) More \(\Rightarrow\) Panel Modules. A warning is displayed, asking you if you want to enter the menu. Press Yes to display the Panel Modules Menu.

![Panel Modules Menu](image)

2. Press Upgrade PMCs. The switcher starts upgrading the PMC on the control panel.

For More Information...
- on mapping a module to a control panel row, refer to the section “Mapping a Module to a Row” on page Eng 17-5.
Dusting Mode

Dusting Mode allows you to clean the surface of the Vision control panel, including the touchscreen display, without the switcher reacting to any accidental pressing of buttons. Dusting Mode does not affect the operation of the switcher, but prevents the switcher from acting upon button presses.

Caution — Do not use water, or any other liquid cleaner, to clean the surface of the control panel. Doing so can cause personal injury and/or damage to the control panel itself. A dry duster, vacuum, or low pressure compressed air should be used to clean the surface of the control panel.

1. Press HOME ➔ More ➔ Remote Enables ➔ Dust.

Dusting Menu

2. Dust the surface of the control panel as required. In dusting mode the switcher will not act upon any input from the control panel.

3. Press the F1 and F6 buttons simultaneously to take the control panel out of dusting mode. The F1 and F6 buttons are the two physical buttons located below the two EXIT buttons on the Dusting Menu.
Appendix A. Menu Trees

In This Appendix

This appendix provides information on the various branches of the Vision menu system.

The following menu trees are discussed in this appendix:

- Setup and Installation Menu Trees
- Source Configuration Menu Tree
- Output BNC Menu Tree
- Communications Menu Tree
- Custom Control Bank Menu Tree
- Custom Controls Menu Tree
- File Storage Menu Tree
- Recall Factory Menu Tree
- Squeeze & Tease and Effects Menu Tree
Setup and Installation Menu Trees

Setup Menu Tree

![Setup Menu Tree Diagram]

Installation Menu Tree

![Installation Menu Tree Diagram]
Source Configuration Menu Tree

Figure 19.3 Source Configuration Menu Tree
Output BNC Menu Tree

![Output BNC Menu Tree Diagram]

*Figure 19.4 Output BNC Menu Tree*
Communications Menu Tree

![Communications Menu Tree Diagram]

*Figure 19.5* Communications Menu Tree
Custom Control Bank Menu Tree

Figure 19.6  Custom Control Bank Menu Tree
Custom Controls Menu Tree

![Custom Controls Menu Tree](image)

*Figure 19.7 Custom Controls Menu Tree*
File Storage Menu Tree

Disk Store Menu Tree

Disk Recall Menu Tree

Figure 19.8 Disk Store Menu Tree

Figure 19.9 Disk Recall Menu Tree
Disk Store Individual Item Menu Tree

[Diagram of Disk Store Individual Item Menu Tree]

Figure 19.10 Disk Store Individual Item Menu Tree

Disk Recall Individual Item Menu Tree

[Diagram of Disk Recall Individual Item Menu Tree]

Figure 19.11 Disk Recall Individual Item Menu Tree
Recall Factory Menu Tree

Figure 19.12  Recall Factory Menu Tree
Squeeze & Tease and Effects Menu Tree

Effects Menu Tree

![Effects Menu Tree Diagram]

Figure 19.13 Effects Menu Tree

Squeeze & Tease MD Position/Crop Menu Tree

![Squeeze & Tease MD Position/Crop Menu Tree Diagram]

Figure 19.14 Squeeze & Tease MD Position/Crop Menu Tree
Squeeze & Tease MD Border Menu Tree

Squeeze & Tease MD Sequence Menu Tree

Channel Management Menu Tree
Squeeze & Tease MD Preprocessor Menu Tree

![S&T MD Preprocessor](image)

Figure 19.18 Squeeze & Tease MD Preprocessor Menu Tree

Squeeze & Tease MD Lighting Menu Tree

![S&T MD Lighting](image)

Figure 19.19 Squeeze & Tease MD Lighting Menu Tree

Squeeze & Tease WARP Menu Tree

![S&T WARP](image)

Figure 19.20 Squeeze & Tease WARP Menu Tree
Appendix B. Specifications

In The Appendix

This appendix provides technical specifications and connector pinout diagrams for the Vision switcher.

The following topics are discussed in this appendix:

- Standard Components
- General Switcher Specifications
- Physical Specifications
- Communication Specifications
- Video Characteristics
- Frame Pinouts
- Control Panel Pinouts
- Control Panel CPU Module Ports
- Remote Aux Panel Pinouts
- Aux Panel Programming Mode Summary
Standard Components

The following components are standard on all models:

- Complete Control Panel
- 2 UltraChrome™ Chroma keys per full MLE
- 8 Pattern Generators per full MLE
- Wipes in full Program/Preset
- 32 Timed Aux Buses
- Hard Disk Drive and USB Ports for file storage
- Touchscreen Display
- Custom Control Macro Buttons
- 100 Event Memory System
- 10 GPI Inputs and 10 GPI Outputs
- 72 Tally Outputs
- Switcher Manuals
- 1 Year Transferable Warranty
General Switcher Specifications

The information provided in the following table (Table 20.1) lists the general specifications of the switcher with all options installed.

<table>
<thead>
<tr>
<th>Switcher</th>
<th>MLEs</th>
<th>Input BNCs</th>
<th>Buttons/Bus</th>
<th>Output BNCs</th>
<th>Keys/MLE</th>
</tr>
</thead>
<tbody>
<tr>
<td>8 MLE Octane/QMD-X</td>
<td>8</td>
<td>96</td>
<td>40</td>
<td>48</td>
<td>4</td>
</tr>
<tr>
<td>7 MLE Octane/QMD-X</td>
<td>7</td>
<td>96</td>
<td>40</td>
<td>48</td>
<td>4</td>
</tr>
<tr>
<td>6 MLE Octane/QMD-X</td>
<td>6</td>
<td>96</td>
<td>40</td>
<td>48</td>
<td>4</td>
</tr>
<tr>
<td>5 MLE Octane/QMD-X</td>
<td>5</td>
<td>96</td>
<td>40</td>
<td>48</td>
<td>4</td>
</tr>
<tr>
<td>4 MLE QMD-X</td>
<td>4</td>
<td>96</td>
<td>40</td>
<td>48</td>
<td>4</td>
</tr>
<tr>
<td>4 MLE MD-X</td>
<td>4</td>
<td>96</td>
<td>40</td>
<td>48</td>
<td>2</td>
</tr>
<tr>
<td>4 MLE QMD</td>
<td>4</td>
<td>48</td>
<td>40</td>
<td>16</td>
<td>4</td>
</tr>
<tr>
<td>3 MLE QMD-X</td>
<td>3</td>
<td>96</td>
<td>32</td>
<td>48</td>
<td>4</td>
</tr>
<tr>
<td>3 MLE MD-X</td>
<td>3</td>
<td>96</td>
<td>32</td>
<td>48</td>
<td>2</td>
</tr>
<tr>
<td>3 MLE QMD</td>
<td>3</td>
<td>48</td>
<td>32</td>
<td>16</td>
<td>4</td>
</tr>
<tr>
<td>2 MLE QMD-X</td>
<td>2</td>
<td>96</td>
<td>16</td>
<td>48</td>
<td>4</td>
</tr>
<tr>
<td>2 MLE MD-X</td>
<td>2</td>
<td>96</td>
<td>16</td>
<td>48</td>
<td>2</td>
</tr>
<tr>
<td>2 MLE QMD</td>
<td>2</td>
<td>48</td>
<td>16</td>
<td>16</td>
<td>4</td>
</tr>
<tr>
<td>2 MLE MD</td>
<td>2</td>
<td>32</td>
<td>16</td>
<td>16</td>
<td>2</td>
</tr>
<tr>
<td>1 MLE QMD-X</td>
<td>1</td>
<td>96</td>
<td>16</td>
<td>48</td>
<td>4</td>
</tr>
<tr>
<td>1 MLE MD-X</td>
<td>1</td>
<td>96</td>
<td>16</td>
<td>48</td>
<td>2</td>
</tr>
<tr>
<td>1 MLE QMD</td>
<td>1</td>
<td>48</td>
<td>16</td>
<td>16</td>
<td>4</td>
</tr>
<tr>
<td>1 MLE MD</td>
<td>1</td>
<td>32</td>
<td>16</td>
<td>16</td>
<td>2</td>
</tr>
</tbody>
</table>

Control Panel Power Supplies

The Vision control panels use a 250 or 600 Watt Power Supply Module, depending on the control panel you have (Table 20.2).

Table 20.2 Control Panel Power Supply Modules

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Vision 4</td>
<td>600W</td>
<td>600W</td>
<td>250W</td>
<td>600W</td>
<td>250W</td>
<td>250W</td>
<td>250W</td>
<td>250W</td>
</tr>
</tbody>
</table>

Power Consumption – Control Panel

The information provided in the following table (Table 20.3) lists power consumption for each Vision control panel at average (8% Panel Glow) and peak power (100% Panel Glow) consumption.
Frame Power Supplies

The Octane/QMD/X and MD/X frames use a 500 or 700 Watt Power Supply, depending on the frame you have (Table 20.4). The following table provides the number of power supplies that are required for a fully populated frame.

### Table 20.4 Frame Power Supply Modules for Fully Populated Frame

<table>
<thead>
<tr>
<th>Power Supply Watts</th>
<th>Octane/QMD-X</th>
<th>MD-X</th>
<th>QMD</th>
<th>MD</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Supplies (Min/Max)</td>
<td>2/4</td>
<td>3/4</td>
<td>1/2</td>
<td>1/2</td>
</tr>
</tbody>
</table>

Power Consumption – Frame

The information provided in the following table (Table 20.5) lists power consumption for the Octane/QMD/X and MD/X frames.

### Table 20.5 Frame Power Consumption

<table>
<thead>
<tr>
<th>Frame</th>
<th>Parameter</th>
<th>Power Consumption</th>
</tr>
</thead>
<tbody>
<tr>
<td>Octane/QMD-X</td>
<td>Power Supply Rating</td>
<td>100-120V~</td>
</tr>
<tr>
<td></td>
<td></td>
<td>220-240V~</td>
</tr>
<tr>
<td></td>
<td></td>
<td>47-63 Hz</td>
</tr>
<tr>
<td></td>
<td></td>
<td>9A 650W (Canada 120V~ only)</td>
</tr>
<tr>
<td></td>
<td>Base System</td>
<td>~225W</td>
</tr>
<tr>
<td></td>
<td>Fully Loaded</td>
<td>~1160W</td>
</tr>
</tbody>
</table>
### Operating Environment Requirements

The information provided in the following table (Table 20.6) lists operating environment requirements for the Vision control panel and frame.

#### Table 20.6 Vision Operating Environment Requirements

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ambient Temperature Range</td>
<td>0 – 35°C</td>
</tr>
<tr>
<td>Ambient Frame Cooling</td>
<td>Side-to-Side airflow</td>
</tr>
<tr>
<td>Frame Power Supply Cooling</td>
<td>• 500W - Passive</td>
</tr>
<tr>
<td></td>
<td>• 700W - Active left-to-right</td>
</tr>
<tr>
<td>Ambient Control Panel Cooling</td>
<td>Passive</td>
</tr>
<tr>
<td>Control Panel Power Supply Cooling</td>
<td>Front-to-Back airflow</td>
</tr>
</tbody>
</table>
Physical Specifications

This section provides information on the physical dimensions of the control panel and frame, as well as the module sizes for the control panel.

Control Panel Dimensions

The dimensions (Figure 20.1) of the Vision control panels are listed in the following table (Table 20.7) and do not include the extra height of the positioner or fader above the control panel surface.

![Figure 20.1 Control Panel Dimensions](image)

<table>
<thead>
<tr>
<th>Panel</th>
<th>Width</th>
<th>Depth</th>
<th>Height</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vision 4</td>
<td>55.5 inches (1409.7 mm)</td>
<td>26 inches (660.4 mm)</td>
<td>7.9 inches (200.7 mm)</td>
</tr>
<tr>
<td>Vision 3M</td>
<td>45.3 inches (1150.6 mm)</td>
<td>20.5 inches (520.7 mm)</td>
<td>6.7 inches (170.2 mm)</td>
</tr>
<tr>
<td>Vision 3</td>
<td>51.0 inches (1295.4 mm)</td>
<td>20.5 inches (520.7 mm)</td>
<td>6.7 inches (170.2 mm)</td>
</tr>
<tr>
<td>Vision 2X</td>
<td>51.0 inches (1295.4 mm)</td>
<td>16.5 inches (419.1 mm)</td>
<td>6.0 inches (152.4 mm)</td>
</tr>
<tr>
<td>Vision 2M</td>
<td>39.5 inches (1003.3 mm)</td>
<td>16.5 inches (419.1 mm)</td>
<td>6.0 inches (152.4 mm)</td>
</tr>
<tr>
<td>Vision 2</td>
<td>34.0 inches (863.6 mm)</td>
<td>16.5 inches (419.1 mm)</td>
<td>6.0 inches (152.4 mm)</td>
</tr>
<tr>
<td>Vision 1M</td>
<td>35.0 inches (889 mm)</td>
<td>16.5 inches (419.1 mm)</td>
<td>6.0 inches (152.4 mm)</td>
</tr>
<tr>
<td>Vision 1</td>
<td>28.5 inches (723.9 mm)</td>
<td>16.5 inches (419.1 mm)</td>
<td>6.0 inches (152.4 mm)</td>
</tr>
</tbody>
</table>

Frame Dimensions

The information provided in the following table (Table 20.8) lists the frame dimensions for the frame.
<table>
<thead>
<tr>
<th>Frame</th>
<th>Rack Units</th>
<th>Height</th>
<th>Width</th>
<th>Depth</th>
</tr>
</thead>
<tbody>
<tr>
<td>Octane/QMD-X</td>
<td>8RU</td>
<td>14.13 inches</td>
<td>19.00 inches</td>
<td>26.00 inches</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(35.9 cm)</td>
<td>(48.3 cm)</td>
<td>(66.0 cm)</td>
</tr>
<tr>
<td>MD-X</td>
<td>8RU</td>
<td>14.13 inches</td>
<td>19.00 inches</td>
<td>26.00 inches</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(35.9 cm)</td>
<td>(48.3 cm)</td>
<td>(66.0 cm)</td>
</tr>
<tr>
<td>QMD</td>
<td>3RU</td>
<td>5.25 inches</td>
<td>19.00 inches</td>
<td>26.00 inches</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(13.34 cm)</td>
<td>(48.3 cm)</td>
<td>(66.0 cm)</td>
</tr>
<tr>
<td>MD</td>
<td>3RU</td>
<td>5.25 inches</td>
<td>19.00 inches</td>
<td>26.00 inches</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(13.34 cm)</td>
<td>(48.3 cm)</td>
<td>(66.0 cm)</td>
</tr>
</tbody>
</table>
Communication Specifications

This section provides information on the default network addresses of the control panel and frame, the Module Control Link backbone of the control panel, as well as the different connector types on the control panel and frame.

Default Network Settings

The Vision control panel and frame are set with default network addresses from the factory. These specific settings are listed in the table below (Table 20.9). The frame can be manually configured to these settings using a DIP switch on the Frame CPU Board.

<table>
<thead>
<tr>
<th>Frame Settings (LAN 1)</th>
<th>Frame Settings (LAN 2)</th>
<th>Panel Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Address</td>
<td>192.168.1.1</td>
<td>192.168.1.2</td>
</tr>
<tr>
<td>Subnet Mask</td>
<td>255.255.0.0</td>
<td>255.255.0.0</td>
</tr>
<tr>
<td>Gateway</td>
<td>0.0.0.0</td>
<td>0.0.0.0</td>
</tr>
</tbody>
</table>

Frame CPU Board DIP Switch

This DIP switch sets various system configurations and operational modes for the entire switcher. All DIP switches should be in the OFF position for normal operation.

Figure 20.2 Frame CPU Board (4800AR-001) — DIP Switch Location

Figure 20.3 Frame CPU Board (4800AR-002) — DIP Switch Location
Setting DIP switch 1 to ON defaults the IP address and netmask of the frame the next time the frame is restarted. This allows you to connect to the frame with the control panel to change the network address. Any changes to the network address will not be applied until the next time the frame is restarted.

---

**Caution** — Incorrect DIP switch settings may make your switcher inoperable. If your switcher does not appear to boot properly, and will not pass video, check that all DIP switches are in the OFF position. Do not change the position of the DIP switches unless instructed to do so by Ross Video Technical Support.

---

**Module Control Link Backbone**

The Module Control Link Backbone allows the switcher to identify where a particular module has been installed by the Link and Node address it has been assigned. All modules, external and internal, for the switcher have a link and node number.

**External Links**

The External Link Ports are located on the back of the control panel and support the Touchscreen Display, Auxiliary Control Panels, and any External Modules that are connected to the switcher.

The **Touchscreen Display** must be connected to **External Link Port 1 (Link 1)** in order to operate properly.

**Internal Links**

The internal links support all the modules in the Vision control panel, including the crosspoint, and custom control buttons. The module that is assigned to a particular link and node will depend on the control panel that you are using.

---

![Figure 20.4 Vision 4 Control Panel — Module Control Link Backbone](image-url)
Figure 20.5  Vision 3M Control Panel — Module Control Link Backbone

Figure 20.6  Vision 3 Control Panel — Module Control Link Backbone

Figure 20.7  Vision 2X Control Panel — LVDS Backbone
Figure 20.8 Vision 2M Control Panel — LVDS Backbone

Figure 20.9 Vision 2 Control Panel — Module Control Link Backbone
Frame Connector Types

The information provided in the following table (Table 20.10) lists the connector types for each connection on the frame.

For More Information...

- on the Aux Ports, refer to the section “Communication Ports” on page Eng 2-15.
Control Panel Connector Types

The information provided in the following table (Table 20.11) lists the connector types for each connection on the control panel.

### Table 20.10 Frame Connector Specifications

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video</td>
<td>BNC Type (Female)</td>
</tr>
<tr>
<td>Reference</td>
<td>BNC Type (Female)</td>
</tr>
<tr>
<td>Peripheral Ports</td>
<td>DB9 (Female)</td>
</tr>
<tr>
<td>GPI I/O</td>
<td>DB25 (Female)</td>
</tr>
<tr>
<td>Panel Port (legacy control panel)</td>
<td>RJ-45</td>
</tr>
<tr>
<td>LAN Ports</td>
<td>RJ-45</td>
</tr>
<tr>
<td>USB Ports</td>
<td>USB 1.1 Compatible, Type A (host)</td>
</tr>
<tr>
<td>AC Power (primary, redundant)</td>
<td>3-Pin IEC</td>
</tr>
</tbody>
</table>

### Table 20.11 Control Panel Connector Specifications

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Ports</td>
<td>DB9 (Female)</td>
</tr>
<tr>
<td>TallyPorts</td>
<td>DB25 (Female)</td>
</tr>
<tr>
<td>External Link Ports</td>
<td>RJ-45</td>
</tr>
<tr>
<td>Ethernet Port</td>
<td>RJ-45</td>
</tr>
<tr>
<td>USB Ports</td>
<td>USB 1.1 Compatible, Type A (host)</td>
</tr>
<tr>
<td>AC Power (primary, redundant)</td>
<td>3-Pin IEC</td>
</tr>
<tr>
<td>DVI Video</td>
<td>DVI-D</td>
</tr>
<tr>
<td>Mouse Port</td>
<td>PS/2</td>
</tr>
<tr>
<td>Keyboard Port</td>
<td>PS/2</td>
</tr>
</tbody>
</table>
Video Characteristics

This section provides information on the video formats, timing, and input and outputs that the Vision switcher uses.

Video Processing

The Vision switcher has the following video processing characteristics:

- 10 bit 4:2:2 Component Digital Video and Key Processing
- 4:3 and Anamorphic 16:9 switchable Aspect Ratio where applicable

Video Formats

The Vision switcher supports the following Input Reference and Video Formats (Table 20.12). References to 1080p 59.94Hz (A) and 1080p 50Hz (A) refer to 1080p Level A only.

<table>
<thead>
<tr>
<th>Input Reference</th>
<th>Usable Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>480i</td>
<td>• 480i</td>
</tr>
<tr>
<td></td>
<td>• 480i 16:9</td>
</tr>
<tr>
<td></td>
<td>• 720p 59.94Hz*</td>
</tr>
<tr>
<td></td>
<td>• 1080i 59.94Hz*</td>
</tr>
<tr>
<td></td>
<td>• 1080p 29.97Hz</td>
</tr>
<tr>
<td></td>
<td>• 1080p 59.94Hz (A)</td>
</tr>
<tr>
<td>576i</td>
<td>• 576i</td>
</tr>
<tr>
<td></td>
<td>• 576i 16:9</td>
</tr>
<tr>
<td></td>
<td>• 720p 50Hz*</td>
</tr>
<tr>
<td></td>
<td>• 1080i 50Hz*</td>
</tr>
<tr>
<td></td>
<td>• 1080p 50Hz (A)</td>
</tr>
<tr>
<td>720p 59.94Hz</td>
<td>• 720p 59.94Hz</td>
</tr>
<tr>
<td>720p 50Hz</td>
<td>• 720p 50Hz</td>
</tr>
<tr>
<td>1080i 59.94Hz</td>
<td>• 480i</td>
</tr>
<tr>
<td></td>
<td>• 480i 16:9</td>
</tr>
<tr>
<td></td>
<td>• 720p 59.94Hz</td>
</tr>
<tr>
<td></td>
<td>• 1080i 59.94Hz</td>
</tr>
<tr>
<td></td>
<td>• 1080p 29.97Hz</td>
</tr>
<tr>
<td></td>
<td>• 1080p 59.94Hz (A)</td>
</tr>
<tr>
<td>1080i 50Hz</td>
<td>• 576i</td>
</tr>
<tr>
<td></td>
<td>• 576i 16:9</td>
</tr>
<tr>
<td></td>
<td>• 720p 50</td>
</tr>
<tr>
<td></td>
<td>• 1080i 50Hz</td>
</tr>
<tr>
<td></td>
<td>• 1080p 50Hz (A)</td>
</tr>
<tr>
<td>1080p 24Hz</td>
<td>• 1080p 24Hz</td>
</tr>
</tbody>
</table>
Important — It is not recommended that you operate the switcher in these video formats when you are using a composite sync (480i or 576i) reference signal.

Timing

The Vision switcher has the following system timing characteristics:

- All video inputs are zero-time relative to reference input
- Auto timing correct for inputs out of sync by up to ± ¼ line (16us)

LTC Timecode Input

The information provided in the following table (Table 20.11) lists the LTC Timecode specifications.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signal Level</td>
<td>0.5 – 2.0V (1.0V nominal)</td>
</tr>
<tr>
<td>Termination</td>
<td>600 ohm, soft-selectable</td>
</tr>
</tbody>
</table>

Video Input Signal Characteristics

The information provided in the following table (Table 20.14) lists the video input signal characteristics.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max Cable Length (using Belden 1694 cable)</td>
<td>50m @ 3Gb/s&lt;br&gt;75m @ 1.5Gb/s&lt;br&gt;150m @ 270Mb/s</td>
</tr>
<tr>
<td>Impedance</td>
<td>75 ohm, terminating</td>
</tr>
<tr>
<td>Return Loss</td>
<td>&gt;18dB 5Mb/s to 1.5Gb/s&lt;br&gt; &gt;15dB 1.5Gb/s to 3Gb/s</td>
</tr>
<tr>
<td>Video Inputs</td>
<td>SMPTE 259M/292M/424M serial digital (non-looping)</td>
</tr>
<tr>
<td>Reference Inputs (non-terminating, looping)</td>
<td>• Standard Definition — analog black&lt;br&gt;• High Definition — tri-level sync</td>
</tr>
</tbody>
</table>
Video Output Signal Characteristics

The information provided in the following table (Table 20.15) lists the video output signal characteristics.

**Table 20.15 Video Output Signal Characteristics**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Return Loss</td>
<td>&gt;18dB 5Mb/s to 1.5 GHz</td>
</tr>
<tr>
<td></td>
<td>&gt;15dB 1.5Gb/s to 3Gb/s</td>
</tr>
<tr>
<td>Timing Jitter</td>
<td>• SD Video Format — &lt;0.2UI</td>
</tr>
<tr>
<td></td>
<td>• HD Video Format — &lt;1UI</td>
</tr>
<tr>
<td>Alignment Jitter</td>
<td>• SD Video Format — &lt;0.2UI</td>
</tr>
<tr>
<td></td>
<td>• HD Video Format — &lt;0.2UI</td>
</tr>
<tr>
<td>Rise and Fall times</td>
<td>• SD Video Format — 450ps to 700ps</td>
</tr>
<tr>
<td></td>
<td>• HD Video Format — &lt;240ps</td>
</tr>
<tr>
<td>Signal Level</td>
<td>800 mV ± 10%</td>
</tr>
<tr>
<td>DC Offset</td>
<td>0 volts</td>
</tr>
<tr>
<td>Overshoot</td>
<td>&lt;8%</td>
</tr>
<tr>
<td>Video Outputs (serial digital)</td>
<td>• SD Mode — 10-bit SMPTE 259M-C</td>
</tr>
<tr>
<td></td>
<td>• HD Mode — 10-bit SMPTE 292M/424M</td>
</tr>
</tbody>
</table>

**Note** — In SD Mode, Error Detection and Handling (EDH) signals are inserted into all video outputs, and can be disabled. Aux Bus outputs do not have EDH insertion, but do pass previously inserted EDH.
Frame Pinouts

This section provides pinout information for the ports found on the frame.

Peripheral Ports

The 4 DB9 Peripheral ports (Figure 20.12) on the back of the frame support both the RS-232 (TIA/EIA-232) and RS-422 (TIA/EIA-422) transmission standards. The following table (Table 20.16) lists the signal pinouts for the Peripheral ports.

![Figure 20.12 Peripheral Port — Female](image)

<table>
<thead>
<tr>
<th>Pin</th>
<th>RS-232</th>
<th>RS-422</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>n/c</td>
<td>Odd/Even Tx+</td>
</tr>
<tr>
<td>2</td>
<td>Rx</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>3</td>
<td>Tx</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>4</td>
<td>Ground</td>
<td>Ground</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>n/c</td>
<td>Odd/Even Tx-</td>
</tr>
<tr>
<td>7</td>
<td>n/c</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>8</td>
<td>n/c</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>9</td>
<td>n/c</td>
<td>5V 1K Pull-up</td>
</tr>
</tbody>
</table>

Panel Port

![Figure 20.13 Panel Port — Female](image)

Note — The Panel port is not used by the Vision control panel. The Panel port is only used to connect to the Synergy control panel.

The single RJ-45 Panel port (Figure 20.13) on the back of the frame supports the RS-422 transmission standard for direct connection to the control panel. The following table (Table 20.17) lists the signal pinouts for the Panel ports.
GPI I/O Ports

The single DB25 GPI I/O port (Figure 20.14) on the back of the frame supports a total of 10 GPI Inputs and 10 GPI Outputs. The following table (Table 20.18) lists the signal pinouts for the GPI I/O port.

- **GPI Inputs** — Active Drive 5V TTL-compatible signal
- **GPI Outputs** — 5V TTL-compatible edge or level trigger

![GPI I/O Port — Female](image)

Table 20.17 Panel Port Pinouts

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>2</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>3</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>4</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>5</td>
<td>Odd/Even+</td>
</tr>
<tr>
<td></td>
<td>(Transmit)</td>
</tr>
<tr>
<td>6</td>
<td>Odd/Even-</td>
</tr>
<tr>
<td></td>
<td>(Transmit)</td>
</tr>
<tr>
<td>7</td>
<td>Ground (AC coupled)</td>
</tr>
<tr>
<td>8</td>
<td>Ground (AC coupled)</td>
</tr>
</tbody>
</table>

Table 20.18 GPI I/O Port Pinouts

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Ground</td>
</tr>
<tr>
<td>2</td>
<td>n/c</td>
</tr>
<tr>
<td>3</td>
<td>n/c</td>
</tr>
<tr>
<td>4</td>
<td>GPI In 10</td>
</tr>
<tr>
<td>5</td>
<td>GPI In 9</td>
</tr>
<tr>
<td>6</td>
<td>GPI In 8</td>
</tr>
<tr>
<td>7</td>
<td>GPI In 7</td>
</tr>
<tr>
<td>8</td>
<td>GPI In 6</td>
</tr>
<tr>
<td>9</td>
<td>GPI In 5</td>
</tr>
<tr>
<td>10</td>
<td>GPI In 4</td>
</tr>
<tr>
<td>11</td>
<td>GPI In 3</td>
</tr>
<tr>
<td>12</td>
<td>GPI In 2</td>
</tr>
<tr>
<td>13</td>
<td>GPI In 1</td>
</tr>
</tbody>
</table>
LAN Ports

The 2 RJ-45 LAN ports (Figure 20.15) on the back of the frame support 10Base-T and 100Base-TX Ethernet communication. The following table (Table 20.19) lists the signal pinouts for the LAN port.

![LAN Port — Female](image)

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>14</td>
<td>n/c</td>
</tr>
<tr>
<td>15</td>
<td>n/c</td>
</tr>
<tr>
<td>16</td>
<td>GPI Out 10</td>
</tr>
<tr>
<td>17</td>
<td>GPI Out 9</td>
</tr>
<tr>
<td>18</td>
<td>GPI Out 8</td>
</tr>
<tr>
<td>19</td>
<td>GPI Out 7</td>
</tr>
<tr>
<td>20</td>
<td>GPI Out 6</td>
</tr>
<tr>
<td>21</td>
<td>GPI Out 5</td>
</tr>
<tr>
<td>22</td>
<td>GPI Out 4</td>
</tr>
<tr>
<td>23</td>
<td>GPI Out 3</td>
</tr>
<tr>
<td>24</td>
<td>GPI Out 2</td>
</tr>
<tr>
<td>25</td>
<td>GPI Out 1</td>
</tr>
</tbody>
</table>

Table 20.19  LAN Port Pinouts

AC Power Ports

The 3-pin IEC AC Power ports (Figure 20.16) on the back of the frame deliver AC power to the power supplies in the frame. The following table (Table 20.20) lists the signal pinouts for the AC Power ports.

Table 20.18  GPI I/O Port Pinouts

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>14</td>
<td>n/c</td>
</tr>
<tr>
<td>15</td>
<td>n/c</td>
</tr>
<tr>
<td>16</td>
<td>GPI Out 10</td>
</tr>
<tr>
<td>17</td>
<td>GPI Out 9</td>
</tr>
<tr>
<td>18</td>
<td>GPI Out 8</td>
</tr>
<tr>
<td>19</td>
<td>GPI Out 7</td>
</tr>
<tr>
<td>20</td>
<td>GPI Out 6</td>
</tr>
<tr>
<td>21</td>
<td>GPI Out 5</td>
</tr>
<tr>
<td>22</td>
<td>GPI Out 4</td>
</tr>
<tr>
<td>23</td>
<td>GPI Out 3</td>
</tr>
<tr>
<td>24</td>
<td>GPI Out 2</td>
</tr>
<tr>
<td>25</td>
<td>GPI Out 1</td>
</tr>
</tbody>
</table>

Table 20.19  LAN Port Pinouts

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Tx+</td>
</tr>
<tr>
<td>2</td>
<td>Tx-</td>
</tr>
<tr>
<td>3</td>
<td>Rx+</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>n/c</td>
</tr>
<tr>
<td>6</td>
<td>Rx-</td>
</tr>
<tr>
<td>7</td>
<td>n/c</td>
</tr>
<tr>
<td>8</td>
<td>n/c</td>
</tr>
</tbody>
</table>

Table 20.20  AC Power Port Pinouts
Table 20.20 AC Power Port Pinouts

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Neutral/Line 2</td>
</tr>
<tr>
<td>2</td>
<td>Line</td>
</tr>
<tr>
<td>3</td>
<td>Ground</td>
</tr>
</tbody>
</table>
Control Panel Pinouts

This section provides pinout information for the ports found on the Vision control panel.

Remote Ports

The 8 DB9 Remote ports (Figure 20.17) on the back of the control panel support both the RS-232 (TIA/EIA-232) and RS-422 (TIA/EIA-422) transmission standards. The following table (Table 20.21) lists the signal pinouts for the Remote ports.

![Figure 20.17 Remote Port — Female]

Table 20.21 Remote Port Pinouts

<table>
<thead>
<tr>
<th>Pin</th>
<th>RS-232</th>
<th>RS-422</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>n/c</td>
<td>n/c</td>
</tr>
<tr>
<td>2</td>
<td>Tx</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>Rx</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>4</td>
<td>Ground</td>
<td>Ground</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>n/c</td>
<td>n/c</td>
</tr>
<tr>
<td>7</td>
<td>n/c</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>8</td>
<td>n/c</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>9</td>
<td>n/c</td>
<td>n/c</td>
</tr>
</tbody>
</table>

External Link Ports

The 4 RJ-45 External Link ports (Figure 20.18) on the back of the control panel support the Touchscreen Display, the external control panel modules, Remote Aux Panels, and the Auxiliary Control Panels. The following table (Table 20.22) shows the signal pinouts for the External Link ports.

![Figure 20.18 External Link Port — Female]

Table 20.22 External Link Port Pinouts

<table>
<thead>
<tr>
<th>Pin</th>
<th>Pinout</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>12345678</td>
</tr>
</tbody>
</table>

Note — The Touchscreen Display must be connected to External Link port 1 (Link 1) in order to operate properly.
Tally Ports

The DB25 Tally ports (Figure 20.19) on the back of the control panel provide the solid state contact closure to tally common tally signals. The following table (Table 20.23) lists the signal pinouts for the Aux ports.

- **Tally Rating**: 150mA @ 100V DC (25°C operating temperature)

![Figure 20.19 Tally Port — Female](image)

**Note** — Tally Ports 3 through 8 are used for the extended tallies option and require the extended tallies hardware to be installed before they can be used.

### Table 20.22 External Link Port Pinouts

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>4</td>
<td>PMC_SDI_Load+</td>
</tr>
<tr>
<td>5</td>
<td>PMC_SDI_Load-</td>
</tr>
<tr>
<td>6</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>7</td>
<td>PMC_SDI_Latch+</td>
</tr>
<tr>
<td>8</td>
<td>PMC_SDI_Latch-</td>
</tr>
</tbody>
</table>

### Table 20.23 Tally Port Pinouts

<table>
<thead>
<tr>
<th>Pin</th>
<th>Tally Port 1</th>
<th>Tally Port 2</th>
<th>Tally Port 3</th>
<th>Tally Port 4</th>
<th>Tally Port 5</th>
<th>Tally Port 6</th>
<th>Tally Port 7</th>
<th>Tally Port 8</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Tally 1</td>
<td>Tally 19</td>
<td>Tally 37</td>
<td>Tally 55</td>
<td>Tally 73</td>
<td>Tally 91</td>
<td>Tally 109</td>
<td>Tally 127</td>
</tr>
<tr>
<td>2</td>
<td>Tally 3</td>
<td>Tally 21</td>
<td>Tally 39</td>
<td>Tally 57</td>
<td>Tally 75</td>
<td>Tally 93</td>
<td>Tally 111</td>
<td>Tally 129</td>
</tr>
<tr>
<td>3</td>
<td>Tally 5</td>
<td>Tally 23</td>
<td>Tally 41</td>
<td>Tally 59</td>
<td>Tally 77</td>
<td>Tally 95</td>
<td>Tally 113</td>
<td>Tally 131</td>
</tr>
<tr>
<td>4</td>
<td>Tally 7</td>
<td>Tally 25</td>
<td>Tally 43</td>
<td>Tally 61</td>
<td>Tally 79</td>
<td>Tally 97</td>
<td>Tally 115</td>
<td>Tally 133</td>
</tr>
<tr>
<td>5</td>
<td>Tally 9</td>
<td>Tally 27</td>
<td>Tally 45</td>
<td>Tally 63</td>
<td>Tally 81</td>
<td>Tally 99</td>
<td>Tally 117</td>
<td>Tally 135</td>
</tr>
<tr>
<td>6</td>
<td>Tally 11</td>
<td>Tally 29</td>
<td>Tally 47</td>
<td>Tally 65</td>
<td>Tally 83</td>
<td>Tally 101</td>
<td>Tally 119</td>
<td>Tally 137</td>
</tr>
<tr>
<td>7</td>
<td>Tally 13</td>
<td>Tally 31</td>
<td>Tally 49</td>
<td>Tally 67</td>
<td>Tally 85</td>
<td>Tally 103</td>
<td>Tally 121</td>
<td>Tally 139</td>
</tr>
<tr>
<td>8</td>
<td>Tally 15</td>
<td>Tally 33</td>
<td>Tally 51</td>
<td>Tally 69</td>
<td>Tally 87</td>
<td>Tally 105</td>
<td>Tally 123</td>
<td>Tally 141</td>
</tr>
<tr>
<td>9</td>
<td>Tally 17</td>
<td>Tally 35</td>
<td>Tally 53</td>
<td>Tally 71</td>
<td>Tally 89</td>
<td>Tally 107</td>
<td>Tally 125</td>
<td>Tally 143</td>
</tr>
<tr>
<td>10</td>
<td>Common</td>
<td>Common</td>
<td>Common</td>
<td>Common</td>
<td>Common</td>
<td>Common</td>
<td>Common</td>
<td>Common</td>
</tr>
<tr>
<td>11</td>
<td>Common</td>
<td>Common</td>
<td>Common</td>
<td>Common</td>
<td>Common</td>
<td>Common</td>
<td>Common</td>
<td>Common</td>
</tr>
<tr>
<td>12</td>
<td>Common</td>
<td>Common</td>
<td>Common</td>
<td>Common</td>
<td>Common</td>
<td>Common</td>
<td>Common</td>
<td>Common</td>
</tr>
<tr>
<td>13</td>
<td>Common</td>
<td>Common</td>
<td>Common</td>
<td>Common</td>
<td>Common</td>
<td>Common</td>
<td>Common</td>
<td>Common</td>
</tr>
</tbody>
</table>
AC Power Ports

The 2 3-pin IEC AC Power ports (Figure 20.20) on the back of the control panel deliver AC power to the power supplies in the control panel. The following table (Table 20.24) lists the signal pinouts for the AC Power ports.

![Figure 20.20  AC Power Port — Male](image)

<table>
<thead>
<tr>
<th>Pin</th>
<th>Tally Port 1</th>
<th>Tally Port 2</th>
<th>Tally Port 3</th>
<th>Tally Port 4</th>
<th>Tally Port 5</th>
<th>Tally Port 6</th>
<th>Tally Port 7</th>
<th>Tally Port 8</th>
</tr>
</thead>
<tbody>
<tr>
<td>14</td>
<td>Tally 2</td>
<td>Tally 20</td>
<td>Tally 38</td>
<td>Tally 56</td>
<td>Tally 74</td>
<td>Tally 92</td>
<td>Tally 110</td>
<td>Tally 128</td>
</tr>
<tr>
<td>15</td>
<td>Tally 4</td>
<td>Tally 22</td>
<td>Tally 40</td>
<td>Tally 58</td>
<td>Tally 76</td>
<td>Tally 94</td>
<td>Tally 112</td>
<td>Tally 130</td>
</tr>
<tr>
<td>16</td>
<td>Tally 6</td>
<td>Tally 24</td>
<td>Tally 42</td>
<td>Tally 60</td>
<td>Tally 78</td>
<td>Tally 96</td>
<td>Tally 114</td>
<td>Tally 132</td>
</tr>
<tr>
<td>17</td>
<td>Tally 8</td>
<td>Tally 26</td>
<td>Tally 44</td>
<td>Tally 62</td>
<td>Tally 80</td>
<td>Tally 98</td>
<td>Tally 116</td>
<td>Tally 134</td>
</tr>
<tr>
<td>18</td>
<td>Tally 10</td>
<td>Tally 28</td>
<td>Tally 46</td>
<td>Tally 64</td>
<td>Tally 82</td>
<td>Tally 100</td>
<td>Tally 118</td>
<td>Tally 136</td>
</tr>
<tr>
<td>19</td>
<td>Tally 12</td>
<td>Tally 30</td>
<td>Tally 48</td>
<td>Tally 66</td>
<td>Tally 84</td>
<td>Tally 102</td>
<td>Tally 120</td>
<td>Tally 138</td>
</tr>
<tr>
<td>20</td>
<td>Tally 14</td>
<td>Tally 32</td>
<td>Tally 50</td>
<td>Tally 68</td>
<td>Tally 86</td>
<td>Tally 104</td>
<td>Tally 122</td>
<td>Tally 140</td>
</tr>
<tr>
<td>21</td>
<td>Tally 16</td>
<td>Tally 34</td>
<td>Tally 52</td>
<td>Tally 70</td>
<td>Tally 88</td>
<td>Tally 106</td>
<td>Tally 124</td>
<td>Tally 142</td>
</tr>
<tr>
<td>22</td>
<td>Tally 18</td>
<td>Tally 36</td>
<td>Tally 54</td>
<td>Tally 72</td>
<td>Tally 90</td>
<td>Tally 108</td>
<td>Tally 126</td>
<td>Tally 144</td>
</tr>
<tr>
<td>23</td>
<td>Common</td>
<td>Common</td>
<td>Common</td>
<td>Common</td>
<td>Common</td>
<td>Common</td>
<td>Common</td>
<td>Common</td>
</tr>
<tr>
<td>24</td>
<td>Common</td>
<td>Common</td>
<td>Common</td>
<td>Common</td>
<td>Common</td>
<td>Common</td>
<td>Common</td>
<td>Common</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Neutral/Line 2</td>
</tr>
<tr>
<td>2</td>
<td>Line</td>
</tr>
<tr>
<td>3</td>
<td>Ground</td>
</tr>
</tbody>
</table>
## Control Panel CPU Module Ports

The Control Panel CPU Module houses the Single Board Computer (SBC) and the Panel Communications Hub (PCH). This module performs all the command and control functions between the different modules on the control panel, and the frame.

This section identifies and describes the various functional components and rear panel connections found on the Control Panel CPU Module.

**Important** — The Control Panel CPU Module is designed to be a closed module and should not be opened or serviced except by Ross Video Technical Support.

### Control Panel CPU Module Functional Components

The top of the Control Panel CPU Module (Figure 20.21) has a number of different ports and connections.

![Figure 20.21 Control Panel CPU Module — Functional Components](image)

1. **Power Connector**
   - The power connector uses a single 4-Pin, friction fit Molex connector to provide 12V DC to the Control Panel CPU Module from the Power Distribution Board.

2. **Module Control Link Ports**
   - The Module Control Link backbone uses 10, independent, 8-Pin, RJ-45 connectors to interface to the various internal PMCs on the control panel modules.

3. **Fan Status Port**
   - The Fan Status Port uses a single 8-Pin, RJ-45 connector to interface with the Power Distribution Board to pass fan status information from the individual cooling fans.
4. **Power Status Port**
   The Power Status Port uses a single 8-Pin, RJ-45 connector to interface with the Power Distribution Board to pass power supply status information from the individual power supplies.

5. **Tally Interface Port**
   The Tally Interface Port uses a single 8-Pin, RJ-45 connector to interface with the tally board.

6. **Tally Power Connector**
   The tally power connector uses a single 2-Pin, friction fit Molex connector to provide power to the Tally Boards.

7. **Reset Button**
   The Reset Button performs a hard reset of the Single Board Computer (SBC). This will re-start the control panel software.

8. **Power Switch**
   The Power Switch will power on and off the Single Board Computer (SBC).

9. **DIP Switch**
   This 8 switch DIP sets various control panel configurations and operational modes. Switches 2 through 8 should be in the OFF position for normal operation.

   If you have a **Vision 1** or **Vision 2** control panel, switch 1 should be in the OFF position. If you have a **Vision 3** or **Vision 4** control panel, switch 1 should be in the ON position.

### Control Panel CPU Module Rear Panel

The rear panel of the Control Panel CPU Module (Figure 20.22) has a number of different ports and connections

![Control Panel CPU Module — Rear Panel](image)

<table>
<thead>
<tr>
<th>Port</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1)</td>
<td>Serial Communications Ports</td>
</tr>
<tr>
<td>2)</td>
<td>External Link Ports</td>
</tr>
<tr>
<td>3)</td>
<td>USB Ports</td>
</tr>
<tr>
<td>4)</td>
<td>Keyboard Port</td>
</tr>
<tr>
<td>5)</td>
<td>DVI Port</td>
</tr>
<tr>
<td>6)</td>
<td>Mouse Port</td>
</tr>
<tr>
<td>7)</td>
<td>Ethernet Port</td>
</tr>
</tbody>
</table>

**Note** — Other ports found on the Control Panel CPU Module are not supported at this time and should not be used.

1. **Serial Communications Ports**
   The 8 Serial Communications Ports, or Remote Ports, use 9-Pin, DB9 connectors to interface with external devices using either an RS-232 (TIA/EIA-232) or RS-422 (TIA/EIA-422) transmission standard.

2. **External Link Ports**
   The 4 External Link Ports use 8-Pin, RJ-45 connectors to interface with the Touchscreen Display, Auxiliary Control Panels, and Remote AUX Panels.
3. **USB Ports**
   The 2 USB Ports use 4-Pin, USB Type-A connectors to interface with the touchscreen controller on the Touchscreen Display, as well as other supported USB devices.

4. **Keyboard Port**
   The Keyboard Port uses a purple, 6-Pin, PS/2 connector to interface with a standard keyboard.

5. **DVI Port**
   The DVI Port uses a single 24-Pin, DVI-D connector to interface with the LCD display on the Touchscreen Display.

6. **Mouse Port**
   The Mouse Port uses a green, 6-Pin, PS/2 connector to interface with a standard mouse.

7. **Ethernet Port**
   The Ethernet Port uses a single 8-Pin, RJ-45 connector to interface with a local network, and the control panel, using a 10/100 BASE-T network.
Remote Aux Panel Pinouts

GPI Port

The DB9 GPI port (Figure 20.23) on the back of the Remote Aux Panel provide a total of 8 GPI Inputs. The following table (Table 20.25) lists the signal pinouts for the GPI I/O port.

![GPI Port — Female](image)

**Important** — Remote Aux Panel GPI inputs are only intended for connection to “dry contact”, open collector type transistor outputs, or +5 VDC signals. Application of any negative voltages, or voltages in excess of +5 VDC, may damage the GPI inputs.

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>GPI 1</td>
</tr>
<tr>
<td>2</td>
<td>GPI 2</td>
</tr>
<tr>
<td>3</td>
<td>GPI 3</td>
</tr>
<tr>
<td>4</td>
<td>GPI 4</td>
</tr>
<tr>
<td>5</td>
<td>GPI 5</td>
</tr>
<tr>
<td>6</td>
<td>GPI 6</td>
</tr>
<tr>
<td>7</td>
<td>GPI 7</td>
</tr>
<tr>
<td>8</td>
<td>GPI 8</td>
</tr>
<tr>
<td>9</td>
<td>Ground</td>
</tr>
</tbody>
</table>

Main Port

The RJ-12 Main port (Figure 20.24) on the back of the Remote Aux Panel connects to the Aux port on the control panel, or the Echo port on the previous aux panel in the daisy-chain. The following table (Table 20.27) shows the signal pinouts for the Aux ports.

![Main Port — Female](image)
Echo Port

The RJ-12 Echo port (Figure 20.25) on the back of the Remote Aux Panel connects to the Main port on the next aux panel in the daisy-chain. The following table (Table 20.26) shows the signal pinouts for the Aux ports.

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>2</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>3</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>4</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>5</td>
<td>RESET (In)</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
</tbody>
</table>

![Echo Port — Female](image)

Figure 20.25 Echo Port — Female

Table 20.27 Echo Port Pinouts

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>2</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>3</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>4</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>5</td>
<td>RESET (Out)</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
</tbody>
</table>
# Aux Panel Programming Mode Summary

This section describes the normal, GPI, and diagnostic Remote Aux Panel programming modes.

## Table 20.28 Remote Aux Panel Programming Mode Button Assignment

<table>
<thead>
<tr>
<th>Button/LED</th>
<th>Normal Mode</th>
<th>Programming Mode Bus Assignment</th>
<th>Programming Mode GPI Offset</th>
<th>Power Up Diagnostics</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Select Crosspoint 1</td>
<td>Display/Modify Access Right to Aux Bus 1</td>
<td>Set GPI to group 1, offset 0</td>
<td>Start Walking LED Test c</td>
</tr>
<tr>
<td>2</td>
<td>Select Crosspoint 2</td>
<td>Display/Modify Access Right to Aux Bus 2</td>
<td>Set GPI to group 2, offset 1</td>
<td>Start Button LED Test</td>
</tr>
<tr>
<td>3</td>
<td>Select Crosspoint 3</td>
<td>Display/Modify Access Right to Aux Bus 3</td>
<td>Set GPI to group 3, offset 2</td>
<td>Start DUART Test d</td>
</tr>
<tr>
<td>4</td>
<td>Select Crosspoint 4</td>
<td>Display/Modify Access Right to Aux Bus 4</td>
<td>Set GPI to group 4, offset 3</td>
<td>Start EEPROM Test</td>
</tr>
<tr>
<td>5</td>
<td>Select Crosspoint 5</td>
<td>Display/Modify Access Right to Aux Bus 5</td>
<td>Set GPI to group 5, offset 4</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Select Crosspoint 6</td>
<td>Display/Modify Access Right to Aux Bus 6</td>
<td>Set GPI to group 6, offset 5</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Select Crosspoint 7</td>
<td>Display/Modify Access Right to Aux Bus 7</td>
<td>Set GPI to group 7, offset 6</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Select Crosspoint 8</td>
<td>Display/Modify Access Right to Aux Bus 8</td>
<td>Set GPI to group 8, offset 7</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Select Crosspoint 9</td>
<td>Display/Modify Access Right to Aux Bus 9</td>
<td>GPI 8 Status (on = shorted)</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Select Crosspoint 10</td>
<td>Display/Modify Access Right to Aux Bus 10</td>
<td>GPI 7 Status (on = shorted)</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Select Crosspoint 11</td>
<td>Display/Modify Access Right to Aux Bus 11</td>
<td>GPI 6 Status (on = shorted)</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Select Crosspoint 12</td>
<td>Display/Modify Access Right to Aux Bus 12</td>
<td>GPI 5 Status (on = shorted)</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Select Crosspoint 13</td>
<td>GPI 4 Status (on = shorted)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Select Crosspoint 14</td>
<td>GPI 3 Status (on = shorted)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Select Crosspoint 15</td>
<td>GPI 2 Status (on = shorted)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>Select Crosspoint 16</td>
<td>GPI 1 Status (on = shorted)</td>
<td>LED used in EEPROM test</td>
<td></td>
</tr>
<tr>
<td>17/Shift</td>
<td>Select Crosspoint 17 or Shift</td>
<td>Allow access to Shifted Crosspoints e</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Clean Feed</td>
<td>GPI Programming Mode</td>
<td>Assignment Programming Mode</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Program</td>
<td>Send Software Version to panel.</td>
<td>Send Software Version to panel.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Active LED</td>
<td>Selected aux crosspoint is used in Program output</td>
<td>Flashing</td>
<td>Flashing (along with Clean Feed button)</td>
<td>Test Fail Status f</td>
</tr>
</tbody>
</table>
a. For the first 12 indicators in the column, information applies to the Vision 3 and 4 Assignable Remote Aux Panels only. The Vision 2 Assignable Remote Aux Panels use the 12 Assignment buttons on the bottom row of the panel.
b. Indicator show the current group setting. Only one indicator in the first eight buttons can be on at a time. A panel that has never been programmed may have all the indicators off at first.
c. On the Vision 3 Remote Aux Panel, the indicator is button Shift/30. On the Vision 4, the indicator is button Shift/35.
d. Requires a special Loop Back Adapter.
e. Does not show special shifted modes, such as Reverse Shift.
f. In the EEPROM and DUART tests, the Active LED indicates that the test failed. If the crosspoint 1 button is lit, the test passed.
Appendix C. Worksheets

In The Appendix

This appendix provides worksheets that can be used when setting up and using your Vision switcher.

The following worksheets are provided:

- Video Input Worksheet
- Bus Map Worksheet
- Video Output Worksheet
- Communications Worksheet
- Standard GPI I/O Input Worksheets
- Standard GPI I/O Output Worksheets
- Aux Panel GPI I/O Worksheet
- Custom Control Worksheets
- Conversion Loop Worksheets
- Custom Device Protocol Worksheets
The video input worksheet (Table 21.2) helps you to identify which video source is connected to which Input BNC, and what device that source is coming from.

### Table 21.1 Sample Video Input Worksheet

<table>
<thead>
<tr>
<th>Input BNC</th>
<th>Source/Device</th>
<th>Video Format</th>
<th>Serial Port</th>
<th>Device Address</th>
<th>Input Name</th>
<th>Input Type</th>
<th>Tally Number</th>
<th>Alpha Type</th>
<th>Auto Key</th>
<th>Audio Channel</th>
</tr>
</thead>
<tbody>
<tr>
<td>X1</td>
<td>VTR 1</td>
<td>1080i 50</td>
<td>R1</td>
<td>--</td>
<td>VTR Blue</td>
<td>VTR</td>
<td>12</td>
<td>--</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td>X2</td>
<td>CG Alpha</td>
<td>720p 60</td>
<td>R2</td>
<td>--</td>
<td>CG Alpha</td>
<td>Alpha</td>
<td>--</td>
<td>Unshaped</td>
<td>C15</td>
<td>--</td>
</tr>
</tbody>
</table>

### Table 21.2 Video Input Worksheet

<table>
<thead>
<tr>
<th>Input BNC</th>
<th>Source/Device</th>
<th>Video Format</th>
<th>Serial Port</th>
<th>Device Address</th>
<th>Input Name</th>
<th>Input Type</th>
<th>Tally Number</th>
<th>Alpha Type</th>
<th>Auto Key</th>
<th>Audio Channel</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Table 21.2 Video Input Worksheet

<table>
<thead>
<tr>
<th>Input BNC</th>
<th>Source/ Device</th>
<th>Video Format</th>
<th>Serial Port</th>
<th>Device Address</th>
<th>Input Name</th>
<th>Input Type</th>
<th>Tally Number</th>
<th>Alpha Type</th>
<th>Auto Key</th>
<th>Audio Channel</th>
</tr>
</thead>
</table>


<table>
<thead>
<tr>
<th>Input BNC</th>
<th>Source/Device</th>
<th>Video Format</th>
<th>Serial Port</th>
<th>Device Address</th>
<th>Input Name</th>
<th>Input Type</th>
<th>Tally Number</th>
<th>Alpha Type</th>
<th>Auto Key</th>
<th>Audio Channel</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table 21.2 Video Input Worksheet
### Table 21.2 Video Input Worksheet

<table>
<thead>
<tr>
<th>Input BNC</th>
<th>Source/Device</th>
<th>Video Format</th>
<th>Serial Port</th>
<th>Device Address</th>
<th>Input Name</th>
<th>Input Type</th>
<th>Tally Number</th>
<th>Alpha Type</th>
<th>Auto Key</th>
<th>Audio Channel</th>
</tr>
</thead>
</table>
The bus map worksheet (Table 21.4) helps you to identify which sources you have mapped to each crosspoint button for a given bus map. Additional bus map worksheets will have to be created for each bus map.

### Table 21.3 Sample Bus Map Worksheet

<table>
<thead>
<tr>
<th>Source Button</th>
<th>No Shift</th>
<th>Shift 1</th>
<th>Shift 2</th>
<th>Shift 3</th>
<th>Shift 4</th>
<th>Shift 5</th>
<th>Shift 6</th>
<th>Shift 7</th>
<th>Shift 8</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>C06 (VTR-1)</td>
<td>C06 (VTR1)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Shift 5</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td>3</td>
<td>C07 (CAM-3)</td>
<td></td>
<td></td>
<td></td>
<td>C02</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Bus Map: ______________________

### Table 21.4 Bus Map Worksheet

<table>
<thead>
<tr>
<th>Source Button</th>
<th>Source/Name</th>
<th>Shift 1</th>
<th>Shift 2</th>
<th>Shift 3</th>
<th>Shift 4</th>
<th>Shift 5</th>
<th>Shift 6</th>
<th>Shift 7</th>
<th>Shift 8</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>17</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>18</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>19</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Source Button</td>
<td>Source/Name</td>
<td>Shift 1</td>
<td>Shift 2</td>
<td>Shift 3</td>
<td>Shift 4</td>
<td>Shift 5</td>
<td>Shift 6</td>
<td>Shift 7</td>
<td>Shift 8</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
<td>---------</td>
<td>---------</td>
<td>---------</td>
<td>---------</td>
<td>---------</td>
<td>---------</td>
<td>---------</td>
<td>---------</td>
</tr>
<tr>
<td>21</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>22</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>23</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>24</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>25</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>26</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>27</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>28</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>29</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>30</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>31</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>32</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>33</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>34</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>35</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>36</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>37</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>38</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>39</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>40</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>41</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>42</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>43</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>44</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>45</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>46</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>47</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>48</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>49</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>50</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>51</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>52</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>53</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>54</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>55</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Source Button</td>
<td>Source/Name</td>
<td>Shift 1</td>
<td>Shift 2</td>
<td>Shift 3</td>
<td>Shift 4</td>
<td>Shift 5</td>
<td>Shift 6</td>
<td>Shift 7</td>
<td>Shift 8</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
<td>---------</td>
<td>---------</td>
<td>---------</td>
<td>---------</td>
<td>---------</td>
<td>---------</td>
<td>---------</td>
<td>---------</td>
</tr>
<tr>
<td>56</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>57</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>58</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>59</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>60</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>61</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>62</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>63</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>64</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>65</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>66</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>67</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>68</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>69</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>70</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
The video output worksheet (Table 21.6) helps you to identify which video signals have been assigned to which Output BNCs.

### Table 21.5 Sample Video Output Worksheet

<table>
<thead>
<tr>
<th>Output BNC</th>
<th>Locked Mix/DSK</th>
<th>Locked MultiDSK</th>
<th>Locked Mix/DSK and MultiDSK</th>
<th>Output Type</th>
<th>Video Format</th>
<th>Destination</th>
</tr>
</thead>
<tbody>
<tr>
<td>X1</td>
<td></td>
<td></td>
<td></td>
<td>Program</td>
<td>1080i 50</td>
<td>Master Control</td>
</tr>
<tr>
<td>X2</td>
<td></td>
<td></td>
<td></td>
<td>Aux Bus 1:3</td>
<td>720p 60</td>
<td>Monitor 6</td>
</tr>
</tbody>
</table>

### Table 21.6 Video Output Worksheet

<table>
<thead>
<tr>
<th>Output BNC</th>
<th>Locked Mix/DSK</th>
<th>Locked MultiDSK</th>
<th>Locked Mix/DSK and MultiDSK</th>
<th>Output Type</th>
<th>Video Format</th>
<th>Destination</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program</td>
<td>Program</td>
<td>Program</td>
<td>Program</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mix Preview w/o Overlay</td>
<td>Program</td>
<td>Multi Preview w/o Overlay</td>
<td>Preview w/o Overlay</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mix Clean 1</td>
<td>Multi Clean 5</td>
<td>Multi Clean 6</td>
<td>Clean 1</td>
<td>Clean 2</td>
<td></td>
<td>Clean 3</td>
</tr>
<tr>
<td>Mix Clean 2</td>
<td>Multi Clean 6</td>
<td>Clean 4</td>
<td>Clean 4</td>
<td>Clean 5</td>
<td></td>
<td>Clean 6</td>
</tr>
<tr>
<td>Mix Clean 3</td>
<td>Multi Clean 6</td>
<td>Clean 5</td>
<td>Clean 5</td>
<td>Clean 6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Output Type</td>
<td>Video Format</td>
<td>Destination</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------------</td>
<td>--------------</td>
<td>-------------</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BNC</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Locked</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mix/DSK</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Locked</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mix/DSK</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MultiDSK</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Locked</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mix/DSK and MultiDSK</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Communications Worksheet

The communications worksheet (Table 21.8) helps you to identify which external device is connected to which serial communications port, or ethernet IP address.

### Table 21.7 Sample Communications Worksheet

<table>
<thead>
<tr>
<th>Port</th>
<th>IP Address</th>
<th>Device</th>
<th>Port on Device</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote 1B</td>
<td>--</td>
<td>Router - Philips Jupiter</td>
<td>Port 1</td>
</tr>
<tr>
<td>Peripheral 3</td>
<td>192.168.1.5</td>
<td>Audio Mixer - Wheatstone</td>
<td>--</td>
</tr>
</tbody>
</table>

### Table 21.8 Communications Worksheet

<table>
<thead>
<tr>
<th>Port</th>
<th>IP Address</th>
<th>Device</th>
<th>Port on Device</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Table 21.8  Communications Worksheet

<table>
<thead>
<tr>
<th>Port</th>
<th>IP Address</th>
<th>Device</th>
<th>Port on Device</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Standard GPI I/O Input Worksheets

The GPI I/O Input worksheet (Table 21.10) helps you to identify what events or actions have been assigned to each GPI I/O input.

### Table 21.9  Sample GPI I/O Input Worksheet

<table>
<thead>
<tr>
<th>GPI Input</th>
<th>Event Type</th>
<th>Event Area</th>
<th>Polarity</th>
</tr>
</thead>
<tbody>
<tr>
<td>GPI 1</td>
<td>Auto</td>
<td>MLE 1</td>
<td>Low</td>
</tr>
<tr>
<td>GPI 6</td>
<td>Cut</td>
<td>Fade-to-Black</td>
<td>High</td>
</tr>
</tbody>
</table>

### Table 21.10  GPI I/O Input Worksheet

<table>
<thead>
<tr>
<th>GPI Input</th>
<th>Event Type</th>
<th>Event Area</th>
<th>Polarity</th>
</tr>
</thead>
<tbody>
<tr>
<td>GPI 1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 4</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 6</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 7</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 8</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 9</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 10</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Standard GPI I/O Output Worksheets

The GPI I/O Output worksheet (Table 21.12) helps you to identify what events or actions have been assigned to each GPI I/O input.

**Table 21.11  Sample GPI I/O Output Worksheet**

<table>
<thead>
<tr>
<th>GPI Output</th>
<th>Output Name</th>
<th>Trigger Type</th>
<th>Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>GPI 1</td>
<td>PrevStill</td>
<td>Edge</td>
<td>Low</td>
</tr>
<tr>
<td>GPI 6</td>
<td>Roll VTR</td>
<td>Level</td>
<td>High</td>
</tr>
</tbody>
</table>

**Table 21.12  GPI I/O Output Worksheet**

<table>
<thead>
<tr>
<th>GPI Output</th>
<th>Event Type</th>
<th>Event Area</th>
<th>Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>GPI 1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 4</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 6</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 7</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 8</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 9</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 10</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Aux Panel GPI I/O Worksheet

The Aux Panel GPI I/O Input worksheet (Table 21.14) helps you to identify what Remote Aux Panel events or actions have been assigned to each GPI input.

Table 21.13 Sample Aux Panel GPI I/O Input Worksheet

<table>
<thead>
<tr>
<th>Aux GPI</th>
<th>Group</th>
<th>Offset</th>
<th>GPI</th>
<th>Aux Bus (BNC)</th>
<th>Event Area</th>
<th>Polarity</th>
</tr>
</thead>
<tbody>
<tr>
<td>GPI 5</td>
<td>1</td>
<td>0</td>
<td>5</td>
<td>Bnk: Aux1 (C03)</td>
<td>Cam 4 joystick</td>
<td></td>
</tr>
</tbody>
</table>

Table 21.14 Aux Panel GPI I/O Input Worksheet

<table>
<thead>
<tr>
<th>Aux GPI</th>
<th>Group</th>
<th>Offset</th>
<th>GPI</th>
<th>Aux Bus (BNC)</th>
<th>Event Area</th>
<th>Polarity</th>
</tr>
</thead>
<tbody>
<tr>
<td>GPI 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 11</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 12</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 13</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 14</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 15</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 16</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 17</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 18</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 19</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 20</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 21</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 22</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 23</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 24</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 25</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Table 21.14 Aux Panel GPI I/O Input Worksheet

<table>
<thead>
<tr>
<th>Aux GPI</th>
<th>Group</th>
<th>Offset</th>
<th>GPI</th>
<th>Aux Bus (BNC)</th>
<th>Event Area</th>
<th>Polarity</th>
</tr>
</thead>
<tbody>
<tr>
<td>GPI 26</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 27</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 28</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 29</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 30</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 31</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 32</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 33</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 34</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 35</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 36</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 37</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 38</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 39</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 40</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 41</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 42</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 43</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 44</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 45</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 46</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 47</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 48</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 49</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 50</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 51</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 52</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 53</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 54</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 55</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 56</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 57</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Table 21.14 Aux Panel GPI I/O Input Worksheet

<table>
<thead>
<tr>
<th>Aux GPI</th>
<th>Group</th>
<th>Offset</th>
<th>GPI</th>
<th>Aux Bus (BNC)</th>
<th>Event Area</th>
<th>Polarity</th>
</tr>
</thead>
<tbody>
<tr>
<td>GPI 58</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 59</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 60</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 61</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 62</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 63</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GPI 64</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Custom Control Worksheets

The custom control worksheet (Table 21.16) helps you to identify which custom controls are assigned to which button for each custom control bank. Additional worksheets will have to be created for each bank.

Table 21.15 Sample Custom Control Worksheet

<table>
<thead>
<tr>
<th>Number</th>
<th>Button</th>
<th>Name</th>
<th>Function</th>
<th>Device</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>13</td>
<td>Shot 1</td>
<td>Recall Shot 1 on Camera</td>
<td>Telemetrics (Remote 2)</td>
</tr>
<tr>
<td>37</td>
<td>--</td>
<td>Opening</td>
<td>Play Opening Sequence</td>
<td>--</td>
</tr>
</tbody>
</table>

Custom Control Bank Name/Number: _______________

Table 21.16 Custom Control Worksheet

<table>
<thead>
<tr>
<th>Number</th>
<th>Button</th>
<th>Name</th>
<th>Function</th>
<th>Device</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>17</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>18</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>19</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>21</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>22</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>23</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>24</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Number</td>
<td>Button</td>
<td>Name</td>
<td>Function</td>
<td>Device</td>
</tr>
<tr>
<td>--------</td>
<td>--------</td>
<td>------</td>
<td>----------</td>
<td>--------</td>
</tr>
<tr>
<td>25</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>26</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>27</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>28</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>29</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>30</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>31</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>32</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>33</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>34</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>35</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>36</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>37</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>38</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>39</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>40</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>41</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>42</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>43</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>44</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>45</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>46</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>47</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>48</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Conversion Loop Worksheets

The conversion loop worksheet (Table 21.18) helps you to identify each conversion loop from the switcher, to the Up/Down Converter and back to the switcher.

### Table 21.17 Sample Conversion Loop Worksheet

<table>
<thead>
<tr>
<th>Aux Bus</th>
<th>Output Video Format</th>
<th>Output Video Format</th>
<th>Output BNC</th>
<th>Input BNC</th>
<th>Locked to Bus</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bank 1: Bus 1</td>
<td>480i 60</td>
<td>1080i 59.94</td>
<td>I16</td>
<td>H16</td>
<td>--</td>
</tr>
<tr>
<td>Bank 1: Bus 2</td>
<td>720p 59.94</td>
<td>1080i 59.94</td>
<td>I15</td>
<td>H15</td>
<td>MLE 3 – BKGD+PST</td>
</tr>
</tbody>
</table>

### Table 21.18 Conversion Loop Worksheet

<table>
<thead>
<tr>
<th>Aux Bus</th>
<th>Output Video Format</th>
<th>Output Video Format</th>
<th>Output BNC</th>
<th>Input BNC</th>
<th>Locked to Bus</th>
</tr>
</thead>
</table>
| Bank 1: Bus 1
| Bank 1: Bus 2
| Bank 1: Bus 3
| Bank 1: Bus 4
| Bank 1: Bus 5
| Bank 1: Bus 6
| Bank 1: Bus 7
| Bank 1: Bus 8
| Bank 2: Bus 1
| Bank 2: Bus 2
| Bank 2: Bus 3
| Bank 2: Bus 4
| Bank 2: Bus 5
| Bank 2: Bus 6
| Bank 2: Bus 7
| Bank 2: Bus 8
| Bank 3: Bus 1
| Bank 3: Bus 2
| Bank 3: Bus 3
| Bank 3: Bus 4
| Bank 3: Bus 5
| Bank 3: Bus 6
| Bank 3: Bus 7
| Bank 3: Bus 8
<p>| Bank 4: Bus 1 |</p>
<table>
<thead>
<tr>
<th>Aux Bus</th>
<th>Output Video Format</th>
<th>Output Video Format</th>
<th>Output BNC</th>
<th>Input BNC</th>
<th>Locked to Bus</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bank 4: Bus 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bank 4: Bus 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bank 4: Bus 4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bank 4: Bus 5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bank 4: Bus 6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bank 4: Bus 7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bank 4: Bus 8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bank 5: Bus 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bank 5: Bus 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bank 5: Bus 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bank 5: Bus 4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bank 5: Bus 5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bank 5: Bus 6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bank 5: Bus 7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bank 5: Bus 8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bank 6: Bus 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bank 6: Bus 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bank 6: Bus 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bank 6: Bus 4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bank 6: Bus 5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bank 6: Bus 6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bank 6: Bus 7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bank 6: Bus 8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Custom Device Protocol Worksheets

The custom device protocol worksheet (Table 21.19) helps you to keep track of the custom commands you have created for a Custom Device Protocol.

Table 21.19  Custom Device Protocol Worksheet — CUSTOM0

<table>
<thead>
<tr>
<th>#1</th>
<th>Description</th>
<th>Tag</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>#2</th>
<th>Description</th>
<th>Tag</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>#3</th>
<th>Description</th>
<th>Tag</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>#4</th>
<th>Description</th>
<th>Tag</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>#5</th>
<th>Description</th>
<th>Tag</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>#6</th>
<th>Description</th>
<th>Tag</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>#7</th>
<th>Description</th>
<th>Tag</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>#8</th>
<th>Description</th>
<th>Tag</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>#9</th>
<th>Description</th>
<th>Tag</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>#10</th>
<th>Description</th>
<th>Tag</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Table 21.20  Custom Device Protocol Worksheet — CUSTOM1

<table>
<thead>
<tr>
<th>#</th>
<th>Description</th>
<th>Tag</th>
<th>Bytes</th>
</tr>
</thead>
<tbody>
<tr>
<td>#1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>#2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>#3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>#4</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>#5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>#6</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>#7</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>#8</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>#9</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>#10</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Operating Tip** — Helpful Abbreviations: H=Hex, B=BCD, AH=ASCII Hex, AB=ASCII BCD / 1-8 (digits) or 4,8...32 (bits) /M=Mot, I=Int., /S=Sca, E=Ext, +Sign
Appendix D. Software Licenses

In This Appendix

The Vision switcher uses software under one or more of the following licence agreements:

- GNU General Public License
- Lesser GNU Public License (LGPL)
- BSD License
- Apache License
- Expat License
- Imlib2
- Jiffy
- Fedora 14 - License Agreement
- PSF LICENSE AGREEMENT FOR PYTHON 2.7.3

Note — As required by the GNU General Public License, and the Lesser GNU Public License (LGPL), source code can be obtained from Ross Video for at least 3 years. Contact Ross Video Technical Support for more information.
GNU General Public License

GNU GENERAL PUBLIC LICENSE
Version 2, June 1991
Copyright (C) 1989, 1991 Free Software Foundation, Inc. 59 Temple Place, Suite 330, Boston, MA 02111-1307 USA
Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

Preamble
The licenses for most software are designed to take away your freedom to share and change it. By contrast, the GNU General Public License is intended to guarantee your freedom to share and change free software--to make sure the software is free for all its users. This General Public License applies to most of the Free Software Foundation's software and to any other program whose authors commit to using it. (Some other Free Software Foundation software is covered by the GNU Library General Public License instead.) You can apply it to your programs, too.

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are designed to make sure that you have the freedom to distribute copies of free software (and charge for this service if you wish), that you receive source code or can get it if you want it, that you can change the software or use pieces of it in new free programs; and that you know you can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask you to surrender the rights. These restrictions translate to certain responsibilities for you if you distribute copies of the software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must give the recipients all the rights that you have. You must make sure that they, too, receive or can get the source code. And you must show them these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and (2) offer you this license which gives you legal permission to copy, distribute and/or modify the software.

Also, for each author's protection and ours, we want to make certain that everyone understands that there is no warranty for this free software. If the software is modified by someone else and passed on, we want its recipients to know that what they have is not the original, so that any problems introduced by others will not reflect on the original authors' reputations.

Finally, any free program is threatened constantly by software patents. We wish to avoid the danger that redistributors of a free program will individually obtain patent licenses, in effect making the program proprietary. To prevent this, we have made it clear that any patent must be licensed for everyone's free use or not licensed at all. The precise terms and conditions for copying, distribution and modification follow.

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License applies to any program or other work which contains a notice placed by the copyright holder saying it may be distributed under the terms of this General Public License. The "Program", below, refers to any such program or work, and a "work based on the Program" means either the Program or any derivative work under copyright law: that is to say, a work containing the Program or a portion of it, either verbatim or with modifications and/or translated into another language. (Hereinafter, translation is included without limitation in the term "modification".) Each licensee is addressed as "you".

Activities other than copying, distribution and modification are not covered by this License; they are outside its scope. The act of running the Program is not restricted, and the output from the Program is covered only if its contents constitute a work based on the Program (independent of having been made by running the Program). Whether that is true depends on what the Program does.

1. You may copy and distribute verbatim copies of the Program's source code as you receive it, in any medium, provided that you conspicuously and appropriately publish on each copy an appropriate copyright notice and disclaimer of warranty; keep intact all the notices that refer to this License and to the absence of any warranty; and give any other recipients of the Program a copy of this License along with the Program.

You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty protection in exchange for a fee.

2. You may modify your copy or copies of the Program or any portion of it, thus forming a work based on the Program, and copy and distribute such modifications or work under the terms of Section 1 above, provided that you also meet all of these conditions:

   a. You must cause the modified files to carry prominent notices stating that you changed the files and the date of any change.
   b. You must cause any work that you distribute or publish, that is part of the whole, to carry prominent notices stating that this License and copyright notice are left intact.
   c. You must cause all work that you distribute or publish with the Program (even those portions that you do not modify) to carry the following notice:
      "Accompany it with the complete corresponding machine-readable source code, which must be distributed under the terms of Sections 1 and 2 above on a medium customarily used for software interchange; or,
      "Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no more than your cost of physically performing source distribution, a complete machine-readable copy of the corresponding source code, to be distributed under the terms of Sections 1 and 2 above on a medium customarily used for software interchange; or,
      "Accompany it with the information you received as to the offer to distribute corresponding source code. (This alternative is allowed only for noncommercial distribution and only if you received the program in object code or executable form with such an offer, in accord with Subsection b above.)"

These requirements apply to the modified work as a whole. If identifiable sections of that work are not derived from the Program, and can be reasonably considered independent and separate works in themselves, then this License, and its terms, do not apply to those sections when you distribute them as separate works. But when you distribute the same sections as part of a whole which is a work based on the Program, the distribution of the whole must be on the terms of this License, whose permissions for other licensees extend to the entire whole, and thus to each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you; rather, the intent is to exercise the right to control the distribution of derivative or collective works based on the Program.

In addition, mere aggregation of another work not based on the Program with the Program (or with a work based on the Program) on a volume of a storage or distribution medium does not bring the other work under the scope of this License.

3. You may copy and distribute the Program (or a work based on it, under Section 2) in object code or executable form under the terms of Sections 1 and 2 above provided that you also do one of the following:

   a. Accompany it with the complete corresponding machine-readable source code, which must be distributed under the terms of Sections 1 and 2 above on a medium customarily used for software interchange; or,
   b. Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no more than your cost of physically performing source distribution, a complete machine-readable copy of the corresponding source code, to be distributed under the terms of Sections 1 and 2 above on a medium customarily used for software interchange; or,
   c. Accompany it with the information you received as to the offer to distribute corresponding source code. (This alternative is allowed only for noncommercial distribution and only if you received the program in object code or executable form with such an offer, in accord with Subsection b above.)

The source code for a work means the preferred form of the work for making modifications to it. For an executable work, complete source code means all the source code for all modules it contains, plus any associated interface definition files, plus the scripts used to control compilation and installation of the executable. However, as a special exception, the source code distributed need not include anything that is normally distributed (in either source or binary form) with the major components (compiler, kernel, and so on) of the operating system on which the executable runs, unless that component itself accompanies the executable.
If distribution of executable or object code is made by offering access to copy from a designated place, then offering equivalent access to copy the source code from the same place counts as distribution of the source code, even though third parties are not compelled to copy the source along with the object code.

4. You may not copy, modify, sublicense, or distribute the Program except as expressly provided under this License. Any attempt otherwise to copy, modify, sublicense or distribute the Program is void, and will automatically terminate your rights under this License. However, parties who have received copies, or rights, from you under this License will not have their licenses terminated so long as such parties remain in full compliance.

5. You are not required to accept this License, since you have not signed it. However, nothing else grants you permission to modify or distribute the Program or its derivative works. These actions are prohibited by law if you do not accept this License. Therefore, by modifying or distributing the Program (or any work based on the Program), you indicate your acceptance of this License to do so, and all its terms and conditions for copying, distributing or modifying the Program or works based on it.

6. Each time you redistribute the Program (or any work based on the Program), the recipient automatically receives a license from the original licensor to copy, distribute or modify the Program subject to these terms and conditions. You may not impose any further restrictions on the recipients' exercise of the rights granted herein. You are not responsible for enforcing compliance by third parties to this License.

7. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not limited to patent issues), conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the conditions of this License, they do not excuse you from the conditions of this License. If you cannot distribute so as to satisfy simultaneously your obligations under this License and any other pertinent obligations, then as a consequence you may not distribute the Program at all. For example, if a patent license would not permit royalty-free redistribution of the Program by all those who receive copies directly or indirectly through you, then the only way you could satisfy both it and this License would be to refrain entirely from distribution of the Program.

8. If the distribution and/or use of the Program is restricted in certain countries either by patents or by copyrighted interfaces, the original copyright holder who places the Program under this License may add an explicit geographical distribution limitation excluding those countries, so that distribution is permitted only in or among countries not thus excluded. In such case, this License incorporates the limitation as if written in the body of this License.

9. The Free Software Foundation may publish revised and/or new versions of the General Public License from time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address new problems or concerns.

10. If you wish to incorporate parts of the Program into other free programs whose distribution conditions are different, write to the author to ask for permission.

11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING REPAIR OR CORRECTION.

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
Lesser GNU Public License (LGPL)

GNU LESSER GENERAL PUBLIC LICENSE
Version 2.1, February 1999

Copyright (C) 1991, 1999 Free Software Foundation, Inc. 59 Temple Place, Suite 330, Boston, MA 02111-1307 USA Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

[This is the first released version of the Lesser GPL. It also counts as the successor of the GNU Library Public License, version 2, hence the version number 2.1.]

Preamble

The licenses for most software are designed to take away your freedom to share and change it. By contrast, the GNU General Public Licenses are intended to guarantee your freedom to share and change free software--to make sure the software is free for all its users.

This license, the Lesser General Public License, applies to some specially designated software packages--typically libraries--of the Free Software Foundation and other authors who decide to use it. You can use it too, but we suggest you first think carefully about whether this license or the ordinary General Public License is the better strategy to use in any particular case, based on the explanations below.

When we speak of free software, we are referring to freedom of use, not price. Our General Public Licenses are designed to make sure that you have the freedom to distribute copies of free software (and charge for this service if you wish); that you receive source code or can get it if you want it; that you can change the software and use pieces of it in new free programs; and that you are informed that you can do these things.

To protect your rights, we need to make restrictions that forbid distributors to deny you these rights or to ask you to surrender these rights. These restrictions translate to certain responsibilities for you if you distribute copies of the library or if you modify it.

For example, if you distribute copies of the library, whether gratis or for a fee, you must give the recipients all the rights that you have; you must make sure that they, too, receive a copy of this License; and you must show them these terms so they know their rights.

We protect your rights with two steps: (1) copyright the library, and (2) offer you this License, which gives you legal permission to copy, distribute and/or modify the library.

To protect each distributor, we want to make it very clear that there is no warranty for this free library. If the library could only be distributed under the terms of a particular copyright license, we could distribution it only to those who agreed to pay for version 2 of the GPL, which contains the same provisions as the GNU Library Public License.

But there is no such license, and there are many programs, such as, for example, the GCC Library, designed to let the library be modified and redistributed freely by anyone.

The precise terms and conditions for copying, distribution and modification follow. Pay close attention to the difference between a "work based on the library" and a "work that uses the library".

0. This License Agreement applies to any software library or other program which contains a notice placed by the copyright holder or other authorized party saying it may be distributed under the terms of this Lesser General Public License (also called "this License"). Each licensee is addressed as "you".

A "library" means a collection of software functions and/or data prepared so as to be conveniently linked with application programs (which use some of those functions and data) to form executable.

The "Library", below, refers to any such software library or work which has been distributed under these terms. A "work based on the Library" means either the Library or any derivative work under copyright law: that is to say, a work containing the Library or a portion of it, either verbatim or with modifications and/or translated straightforwardly into another language.

"Source code" for a work means the preferred form of the work for making modifications to it. For a library, complete source code means all the source code for all modules it contains, plus any associated interface definition files, plus the scripts used to control compilation and installation of the library.

Activities other than copying, distribution and modification are not covered by this License; they are outside its scope. The act of running a program using the Library is not restricted, and output from such a program is covered only if its contents constitute a work based on the Library (independent of what the library does after having run).

Whether that is true depends on what the Library does and what the program that uses the Library does.

1. You may copy and distribute verbatim copies of the Library's complete source code as you receive it, in any medium, provided that you conspicuously and appropriately publish on each copy an appropriate copyright notice and disclaimer of warranty; keep intact all the notices that refer to this License and to the absence of any warranty; and distribute a copy of this License along with the Library.

You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty protection in exchange for a fee.

2. You may modify your copy or copies of the Library or any portion of it, thus forming a work based on the Library, and copy and distribute such modifications or work under the terms of Section 1 above, provided that you also meet all of these conditions:

a. The modified work itself must be a software library.

b. You must cause the files modified to carry prominent notices stating that you changed the files and the date of any change.

c. You must cause the whole of the work to be licensed at no charge to all third parties under the terms of this License.
You may opt to apply the terms of the ordinary GNU General Public License instead of this License to a given copy of the Library. To do this, you must alter all the notices that refer to this License, so that they refer to the ordinary GNU General Public License, version 2, instead of to this License. (If a newer version of the ordinary GNU General Public License has appeared, then you can specify that version instead if you wish.) Do not make any other change in these notices.

Once this change is made in a given copy, it is irreversible for that copy, so the ordinary GNU General Public License applies to all subsequent copies and derivative works made from that copy. This option is useful when you wish to copy part of the code of the Library into a program that is not a library.

You may copy and distribute the Library (or a portion or derivative of it, under Section 2) in object code or executable form under the terms of Sections 1 and 2 above provided that you accompany it with the complete corresponding machine-readable source code, which must be distributed under the terms of Sections 1 and 2 above on a medium customarily used for software interchange.

If distribution of object code is made by offering access to copy from a designated place, then offering equivalent access to copy the source code from the same place satisfies the requirement to distribute the source code, even though third parties are not compelled to copy the source along with the object code.

A program that contains no derivative of any portion of the Library, but is designed to work with the Library by being compiled or linked with it, is called a “work that uses the Library”. Such a work, in isolation, is not a derivative work of the Library, and therefore falls outside the scope of this License.

However, linking a “work that uses the Library” with the Library creates an executable that is a derivative of the Library (because it contains portions of the Library), rather than a “work that uses the library”. The executable is therefore covered by this License. Section 6 states terms for distribution of such executables.

When a “work that uses the Library” uses material from a header file that is part of the Library, the object code for the work may be a derivative work of the Library even though the source code is not. Whether this is true is especially significant if the work can be linked without the Library, or if the work is itself a library. The threshold for this to be true is not precisely defined by law.

If such an object file uses only numerical parameters, data structure layouts and accessors, and small macros and small inline functions (ten lines or less in length), then the use of the object file is unrestricted, regardless of whether it is legally a derivative work. (Executables containing this object code plus all the small macros, functions, and data from the Library as used in the executable need to be included in the executable.)

When a “work that uses the Library” uses material from a header file that is part of the Library, the object code for the work may be a derivative work of the Library even though the source code is not. Whether this is true is especially significant if the work can be linked without the Library, or if the work is itself a library. The threshold for this to be true is not precisely defined by law.

If such an object file uses only numerical parameters, data structure layouts and accessors, and small macros and small inline functions (ten lines or less in length), then the use of the object file is unrestricted, regardless of whether it is legally a derivative work. (Executables containing this object code plus all the small macros, functions, and data from the Library as used in the executable need to be included in the executable.)

6. As an exception to the Sections above, you may also combine or link a “work that uses the Library” with the Library to produce a work containing portions of the Library, and distribute that work under terms of your choice, provided that the terms permit modification of the work for the customer's own use and reverse engineering for debugging such modifications.

You must give prominent notice with each copy of the work that the Library is used in it and that the Library and its use are covered by this License. You must supply a copy of this License. If the work was developed by someone other than you, that person must give prominent notice with the work of those modifications.

a. Accompany the work with the complete corresponding machine-readable source code for the Library including whatever changes were used in the work (which must be distributed under Sections 1 and 2 above); and, if the work is an executable linked with the Library, with the complete machine-readable “work that uses the Library”, as object code and/or source code, so that the user can modify the Library and then relink to produce a modified executable containing the modified Library. (It is understood that the user who changes the contents of definitions files in the Library will not necessarily be able to recompile the application to use the modified definitions.)

b. Use a suitable shared library mechanism for linking with the Library. A suitable mechanism is one that (1) uses at run time a copy of the library already present on the user's computer system, rather than copying library functions into the executable, and (2) will operate properly with a modified version of the library, if the user installs one, as long as the modified version is interface-compatible with the version that the work was made with.

c. Accompany the work with a written offer, valid for at least three years, to give the same user the materials specified in Subsection 6a, above, for a charge no more than the cost of performing this distribution.

d. If distribution of the work is made by offering access to copy from a designated place, offer equivalent access to copy the above specified materials from the same place.

e. Verify that the user has already received a copy of these materials or that you have already sent this user a copy.

For an executable, the required form of the “work that uses the Library” must include any data and utility programs needed for reproducing the executable from it. However, as a special exception, the materials to be distributed need not include anything that is normally distributed (in either source or binary form) with the major components (compiler, kernel, and so on) of the operating system on which the executable runs, unless that component itself accompanies the executable.

It may happen that this requirement contradicts the license restrictions of other proprietary libraries that do not normally accompany the operating system. Such a contradiction means you cannot use both them and the Library together in an executable that you distribute.

7. You may place library facilities that are a work based on the Library side-by-side in a single library together with other library facilities not covered by this License, and distribute such a combined library, provided that the separate distribution of the work based on the Library and of the other library facilities is otherwise permitted, and provided that you do these two things:

a. Accompany the combined library with a copy of the same work based on the Library, uncombined with any other library facilities. This must be distributed under the terms of the Sections above.

b. Give prominent notice with the combined library of the fact that part of it is a work based on the Library, and explaining where to find the accompanying uncombined form of the same work.

8. You may not copy, modify, sublicense, link with, or distribute the Library except as expressly provided under this License. Any attempt otherwise to copy, modify, sublicense, link with, or distribute the Library is void, and will automatically terminate your rights under this License. However, parties who have received copies, or rights, from you under this License will not have their licenses terminated so long as such parties remain in full compliance.

You are not required to accept this License, since you have not signed it. However, nothing else grants you permission to modify or distribute the Library or its derivative works. These actions are prohibited by law if you do not accept this License. Therefore, by modifying or distributing the Library (or any work based
on the Library), you indicate your acceptance of this License to do so, and all its terms and conditions for copying, distributing or modifying the Library or works based on it.

10. Each time you redistribute the Library (or any work based on the Library), the recipient automatically receives a license from the original licensor to copy, distribute, link with or modify the Library subject to these terms and conditions. You may not impose any further restrictions on the recipients' exercise of the rights granted herein. You are not responsible for enforcing compliance by third parties with this License.

11. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not limited to patent issues), conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the conditions of this License, they do not excuse you from the conditions of this License. If you cannot distribute so as to satisfy simultaneously your obligations under this License and any other pertinent obligations, then as a consequence you may not distribute the Library at all. For example, if a patent license would not permit royalty-free redistribution of the Library by all those who receive copies directly or indirectly through you, then the only way you could satisfy both it and this License would be to refrain entirely from distribution of the Library.

If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance of the section is intended to apply, and the section as a whole is intended to apply in other circumstances. It is not the purpose of this section to induce you to infringe any patents or other property right claims or to contest validity of any such claims; this section has the sole purpose of protecting the integrity of the free software distribution system which is implemented by public license practices. Many people have made generous contributions to the wide range of software distributed through that system in reliance on consistent application of that system; it is up to the author/donor to decide if he or she is willing to distribute software through any other system and a licensee cannot impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this License.

12. If the distribution and/or use of the Library is restricted in certain countries either by patents or by copyrighted interfaces, the original copyright holder who places the Library under this License may add an explicit geographical distribution limitation excluding those countries, so that distribution is permitted only in or among countries not thus excluded. In such case, this License incorporates the limitation as if written in the body of this License.

13. The Free Software Foundation may publish revised and/or new versions of the Lesser General Public License from time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address new problems or concerns. Each version is given a distinguishing version number. If the Library specifies a version number of this License which applies to it and “any later version”, you have the option of following the terms and conditions either of that version or of any later version published by the Free Software Foundation. If the Library does not specify a license version number, you may choose any version ever published by the Free Software Foundation.

14. If you wish to incorporate parts of the Library into other free programs whose distribution conditions are incompatible with these, write to the author to ask for permission. For software which is copyrighted by the Free Software Foundation, write to the Free Software Foundation; we sometimes make exceptions for this. Our decision will be guided by the two goals of preserving the free status of all derivatives of our free software and of promoting the sharing and reuse of software generally.

15. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE LIBRARY “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE LIBRARY IS WITH YOU. SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

16. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE LIBRARY AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE LIBRARY (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE LIBRARY TO OPERATE WITH ANY OTHER SOFTWARE), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
BSD License

General

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

3. The name of the author may not be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled by, or are under common control with that entity. For the purposes of this definition, "control" means (i) the power, direct or indirect, to cause the direction or management of such entity, whether by contract or otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding shares, or (iii) beneficial ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this License.

"Source" form shall mean the preferred form for making modifications, including but not limited to software source code, documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source form, including but not limited to compiled object code, generated documentation, and conversions to other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under the License, as indicated by a copyright notice that is included in or attached to the work (an example is provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or derived from) the Work and for which the editorial revisions, annotations, elaborations, or other modifications represent, as a whole, an original work of authorship. For the purposes of this License, Derivative Works shall not include works that remain separable from, or merely link (or bind by name) to the interfaces of, the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and any modifications or additions to that Work or Derivative Works thereof, that is intentionally submitted to Licensor for inclusion in the Work by the copyright owner or by an individual or Legal Entity authorized to submit on behalf of the copyright owner. For the purposes of this definition, "submitted" means any form of electronic, verbal, or written communication sent to the Licensor or its representatives, including but not limited to communication on electronic mailing lists, source code control systems, and issue tracking systems that are managed by, or on behalf of, the Licensor for the purpose of discussing and improving the Work, but excluding communication that is conspicuously marked or otherwise designated in writing by the copyright owner as "Not a Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution has been received by Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable copyright license to reproduce, prepare Derivative Works of, publicly display, publicly perform, sublicense, and distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as stated in this section) patent license to make, have made, use, offer to sell, sell, import, and otherwise transfer the Work, where such license applies only to those patent claims licensable by such Contributor that are necessarily infringed by their Contribution(s) alone or by combination of their Contribution(s) with the Work to which such Contribution(s) was submitted. If You institute patent litigation against any entity (including a cross-claim or counterclaim in a lawsuit) alleging that the Work or a Contribution incorporated within the Work constitutes direct or contributory patent infringement, then any patent licenses granted to You under this License for that Work shall terminate as of the date such litigation is filed.

4. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works thereof in any medium, with or without modifications, and in Source or Object form, provided that You meet the following conditions:

   a. You must give any other recipients of the Work or Derivative Works a copy of this License; and
   b. You must cause any modified files to carry prominent notices stating that You changed the files; and
   c. You must retain, in the Source form of any Derivative Works that You distribute, all copyright, patent, trademark, and attribution notices from the Source form of the Work, excluding those notices that do not pertain to any part of the Derivative Works; and
   d. If the Work includes a “NOTICE” text file as part of its distribution, then any Derivative Works that You distribute must include a readable copy of the attribution notices contained within such NOTICE file, excluding those notices that do not pertain to any part of the Derivative Works; in at least one of the following places: within a NOTICE text file distributed as part of the Derivative Works; within the Source form or documentation, if provided along with the Derivative Works; or, within a display generated by the Derivative Works, if provided; and wherever such third-party notices normally appear. The contents of the NOTICE file are for informational purposes only and do not modify the License. You may add Your own attribution notices within Derivative Works that You distribute, alongside or as an addendum to the NOTICE text from the Work, provided that such additional attribution notices cannot be construed as modifying the License.
5. Submission of Contributions. Unless You explicitly state otherwise, any Contribution intentionally submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions of this License, without any additional terms or conditions. Notwithstanding the above, nothing herein shall supersede or modify the terms of any separate license agreement you may have executed with Licensor regarding such Contributions.

6. Trademarks. This License does not grant permission to use the trade names, trademarks, service marks, or product names of the Licensor, except as required for reasonable and customary use in describing the origin of the Work and reproducing the content of the NOTICE file.

7. Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, Licensor provides the Work (and each Contributor provides its Contributions) on an “AS IS” BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, including, without limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY , or FITNESS FOR A PARTICULAR PURPOSE. You are solely responsible for determining the appropriateness of using or redistributing the Work and assume any risks associated with Your exercise of permissions under this License.

8. Limitation of Liability. In no event and under no legal theory, whether in tort (including negligence), contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent acts) or agreed to in writing, shall any Contributor be liable to You for damages, including any direct, indirect, special, incidental, or consequential damages of any character arising as a result of this License or out of the use or inability to use the Work (including but not limited to damages for loss of goodwill, work stoppage, computer failure or malfunction, or any and all other commercial damages or losses), even if such Contributor has been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative Works thereof, You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, or other liability obligations and/or rights consistent with this License. However, in accepting such obligations, You may act only on Your own behalf and on Your sole responsibility, not on behalf of any other Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for any liability incurred by, or claims asserted against, such Contributor by reason of your accepting any such warranty or additional liability.
Expat License

Copyright (c) 1998, 1999, 2000 Thai Open Source Software Center Ltd. and Clark Cooper
Copyright (c) 2001, 2002, 2003 Expat maintainers.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the “Software”), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

1. The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

2. THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
Imlib2

Copyright (C) 2000 Carsten Haitzler and various contributors (see AUTHORS)

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies of the Software and its Copyright notices. In addition publicly documented acknowledgment must be given that this software has been used if no source code of this software is made available publicly. Making the source available publicly means including the source for this software with the distribution, or a method to get this software via some reasonable mechanism (electronic transfer via a network or media) as well as making an offer to supply the source on request. This Copyright notice serves as an offer to supply the source on request as well. Instead of this, supplying acknowledgments of use of this software in either Copyright notices, Manuals, Publicity and Marketing documents or any documentation provided with any product containing this software. This License does not apply to any software that links to the libraries provided by this software (statically or dynamically), but only to the software provided.

Please see the COPYING-PLAIN for a plain-english explanation of this notice and its intent.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
Copyright (C) 2009 Paul Duncan pabs@pablotron.org

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
Fedora 14 - License Agreement

LICENSE AGREEMENT
FEDORA(TM) 14

This agreement governs the download, installation or use of the Software (as defined below) and any updates to the Software, regardless of the delivery mechanism. The Software is a collective work under U.S. Copyright Law. Subject to the following terms, Red Hat grants to the user ("User") a license to this collective work pursuant to the GNU General Public License version 2. By downloading, installing or using the Software, User agrees to the terms of this agreement.

1. THE SOFTWARE. Fedora (the "Software") is a modular Linux operating system consisting of hundreds of software components. The end user license agreement for each component is located in the component's source code. With the exception of certain image files containing the Fedora trademark identified in Section 2 below, the license terms for the components permit User to copy and redistribute the component. With the potential exception of certain firmware files (denoted in the License field of the RPM packaging), the license terms for the components permit User to copy, modify and redistribute the component, in both source code and binary code forms. This agreement does not limit User's rights under, or grant User rights that supersede, the license terms of any particular component.

2. INTELLECTUAL PROPERTY RIGHTS. The Software and each of its components, including the source code, documentation, appearance, structure and organization are copyrighted by Red Hat and others and are protected under copyright and other laws. Title to the Software and any component, or to any copy, modification, or merged portion shall remain with the aforementioned, subject to the applicable license. The "Fedora" trademark is a trademark of Red Hat, Inc. ("Red Hat") in the U.S. and other countries and is used by permission. This agreement permits User to distribute unmodified copies of Software using the Fedora trademark on the condition that User follows Red Hat's trademark guidelines located at http://fedoraproject.org/wiki/Legal. User must abide by these trademark guidelines when distributing the Software, regardless of whether the Software has been modified. If User modifies the Software, then User must replace all images containing the "Fedora" trademark. Those images are in the fedora-logos package.

3. LIMITED WARRANTY. Except as specifically stated in this agreement or a license for a particular component, TO THE MAXIMUM EXTENT PERMITTED UNDER APPLICABLE LAW, THE SOFTWARE AND THE COMPONENTS ARE PROVIDED AND LICENSED "AS IS" WITHOUT WARRANTY OF ANY KIND, EXPRESSED OR IMPLIED, INCLUDING THE IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT OR FITNESS FOR A PARTICULAR PURPOSE. Neither the Fedora Project nor Red Hat warrants that the functions contained in the Software will meet User's requirements or that the Software will be entirely error free or appear precisely as described in the accompanying documentation. USE OF THE SOFTWARE IS AT USER'S OWN RISK.

4. LIMITATION OF REMEDIES AND LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, FEDORA PROJECT AND RED HAT WILL NOT BE LIABLE TO USER FOR ANY DAMAGES, INCLUDING INCIDENTAL OR CONSEQUENTIAL DAMAGES, LOST PROFITS OR LOST SAVINGS ARISING OUT OF THE USE OR INABILITY TO USE THE SOFTWARE, EVEN IF FEDORA PROJECT OR RED HAT HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

5. EXPORT CONTROL. As required by U.S. law, User represents and warrants that it: (a) understands that the Software is subject to export controls under the U.S. Commerce Department's Export Administration Regulations ("EAR"); (b) is not located in a prohibited destination country under the EAR or U.S. sanctions regulations (currently Cuba, Iran, Iraq, North Korea, Sudan and Syria); (c) will not export, re-export, or transfer the Software to any prohibited destination, entity, or individual without the necessary export license(s) or authorization(s) from the U.S. Government; (d) will not use or transfer the Software for use in any sensitive nuclear, chemical or biological weapons, or missile technology end-uses unless authorized by the U.S. Government by regulation or specific license; (e) understands and agrees that if it is in the United States and exports or transfers the Software to eligible end users, it will, as required by EAR Section 741.17(e), submit semi-annual reports to the Commerce Department's Bureau of Industry & Security (BIS), which include the name and address (including country) of each transferee; and (f) understands that countries other than the United States may restrict the import, use, or export of encryption products and that it shall be solely responsible for compliance with any such import, use, or export restrictions.

6. GENERAL. If any provision of this agreement is held to be unenforceable, that shall not affect the enforceability of the remaining provisions. This agreement shall be governed by the laws of the State of North Carolina and of the United States, without regard to any conflict of laws provisions, except that the United Nations Convention on the International Sale of Goods shall not apply.

All rights reserved. "Red Hat" and "Fedora" are trademarks of Red Hat, Inc. "Linux" is a registered trademark of Linus Torvalds. All other trademarks are the property of their respective owners.
PSF LICENSE AGREEMENT FOR PYTHON 2.7.3

1. This LICENSE AGREEMENT is between the Python Software Foundation (“PSF”), and the Individual or Organization (“Licensee”) accessing and otherwise using Python 2.7.3 software in source or binary form and its associated documentation.

2. Subject to the terms and conditions of this License Agreement, PSF hereby grants Licensee a nonexclusive, royalty-free, world-wide license to reproduce, analyze, test, perform and/or display publicly, prepare derivative works, distribute, and otherwise use Python 2.7.3 alone or in any derivative version, provided, however, that PSF’s License Agreement and PSF’s notice of copyright, i.e., “Copyright © 2001-2012 Python Software Foundation; All Rights Reserved” are retained in Python 2.7.3 alone or in any derivative version prepared by Licensee.

3. In the event Licensee prepares a derivative work that is based on or incorporates Python 2.7.3 or any part thereof, and wants to make the derivative work available to others as provided herein, then Licensee hereby agrees to include in any such work a brief summary of the changes made to Python 2.7.3.

4. PSF is making Python 2.7.3 available to Licensee on an “AS IS” basis. PSF MAKES NO REPRESENTATIONS OR WARRANTIES, EXPRESS OR IMPLIED. BY WAY OF EXAMPLE, BUT NOT LIMITATION, PSF MAKES NO AND DISCLAIMS ANY REPRESENTATION OR WARRANTY OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR PURPOSE OR THAT THE USE OF PYTHON 2.7.3 WILL NOT INFRINGE ANY THIRD PARTY RIGHTS.

5. PSF SHALL NOT BE LIABLE TO LICENSEE OR ANY OTHER USERS OF PYTHON 2.7.3 FOR ANY INCIDENTAL, SPECIAL, OR CONSEQUENTIAL DAMAGES OR LOSS AS A RESULT OF MODIFYING, DISTRIBUTING, OR OTHERWISE USING PYTHON 2.7.3, OR ANY DERIVATIVE THEREOF, EVEN IF ADVISED OF THE POSSIBILITY THEREOF.

6. This License Agreement will automatically terminate upon a material breach of its terms and conditions.

7. Nothing in this License Agreement shall be deemed to create any relationship of agency, partnership, or joint venture between PSF and Licensee. This License Agreement does not grant permission to use PSF trademarks or trade name in a trademark sense to endorse or promote products or services of Licensee, or any third party.

8. By copying, installing or otherwise using Python 2.7.3, Licensee agrees to be bound by the terms and conditions of this License Agreement.
Appendix E. Custom Device Protocols

In This Appendix

This appendix provides information for setting up a custom device and programming a serial protocol to communicate with that device from a Vision peripheral or remote port.

The following topics are discussed in this appendix:

• Custom Devices – Uses and Limitations
• Advanced Topics and Tables
Custom Devices – Uses and Limitations

Custom Device commands allow you to select the signals that the switcher sends to the custom device when you select a command on the switcher. For example, when you create a Play DVE custom control for CUSTOM0, the signal that you coded for that command is sent to the CUSTOM0 device when that custom control is run.

Operating Tip — You can control devices other than VTRs, Video Servers, Audio Servers or External DVEs by substituting their commands for those in the Command-tag list of the Custom Device Menu. Make sure to note these substitution on the Custom Device Protocol Worksheet.

When working with a custom device protocol, the following limitations apply:

- The custom device protocol supports only one way communication. The switcher will not record or act upon signals being returned from the custom device. Therefore, queries for Current-time-sense (such as grab timecode), Inpoint, Outpoint and Clip-ID-names are not supported.

- Some protocol signals may exceed the maximum number of bytes (19) allocated per command. In cases where a custom control is used, 2 command slots (and 2 tags) can be used and a custom control programmed to run both of them in immediate succession. Each user-programmed device supports a maximum of 10 command slots. There may be other practical problems with the protocol you are trying to reproduce that may render custom devices unsuitable.
Advanced Topics and Tables

Besides strings of constant Hex values (bytes), commands can be programmed with special characters and with converted parameter values. Examples of the special characters include the two special values to perform a communications break. The communications break is formed by a data zero event that extends beyond the normal data bit length permitted in the serial data word (for example, serial word length of 8-Odd-1Stop bit is 1+8+1+1 = 11 bits long). The commonly used minimum length for break is 17 bits long or one and a half to two data-words. To implement a break in custom devices, there needs to be a [Break On], a [Break Off], and an optional delay in between.

Certain commands pass a parameter to the custom device driver that can be converted into a string of bytes using a special packed command in place of a single byte. Only one of these special command lines may appear in any given command slot (since only one parameter is ever passed). This command line is converted during runtime into the specified one to four bytes of parameter data, and included at that location in the command string. One command tag that gets a parameter is the Cue to Clip command. The value passed when a Cue to Clip command is triggered is the desired cue time as represented in a packed word timecode format. Typically, this value must then be converted into some representation of packed timecode bytes to be sent to the external device. The packed command flags are described in the following table. You may want to use the Panel Diagnostic\RX/\TX\Monitor to view the results when using parameters in commands.

<table>
<thead>
<tr>
<th>Special Names</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Break On]</td>
<td>Force the outputs to data low value (for RS-232 data low is a positive voltage)</td>
</tr>
<tr>
<td>[Break Off]</td>
<td>Release the outputs from a forced data low</td>
</tr>
<tr>
<td>[Checksum]</td>
<td>Insert the checksum byte (currently supports only simple 8-bit additive checksum)</td>
</tr>
<tr>
<td>[Posn X]</td>
<td>Not currently supported</td>
</tr>
<tr>
<td>[Posn Y]</td>
<td>Not currently supported</td>
</tr>
<tr>
<td>[Posn Z]</td>
<td>Not currently supported</td>
</tr>
<tr>
<td>[Param…]</td>
<td>Parameter (refer to the Parameter Formatting Flags (Table 23.2))</td>
</tr>
</tbody>
</table>

Table 23.1 Packed Command Flags

<table>
<thead>
<tr>
<th>Special Names</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hex</td>
<td>Parameters take as-is and are converted into string of bytes (1-4). If the parameter is already in a packed BCD format then using Hex format will preserve the BCD format of the parameter.</td>
</tr>
<tr>
<td>ASCII Hex</td>
<td>Text representation of the above “Hex” format.</td>
</tr>
<tr>
<td>BCD</td>
<td>Binary Coded Decimal (each nybble represents 1 digit 0-9). This command converts a parameter that is in non-BCD format to a BCD format.</td>
</tr>
<tr>
<td>ASCII BCD</td>
<td>Text representation of the above “BCD” format. This command converts a parameter from a non-BCD format to a text representation of the equivalent BCD format.</td>
</tr>
</tbody>
</table>

Table 23.2 Parameter Formatting Flags
### Table 23.3 Special Options

<table>
<thead>
<tr>
<th>Selection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mot</td>
<td>Motorola ordering. Most Significant Byte (MSB) first, LSB last.</td>
</tr>
<tr>
<td>Int</td>
<td>Intel ordering. Least Significant Byte (LSB) first, MSB last.</td>
</tr>
<tr>
<td>Scaled (Sca)</td>
<td>Re-scales a 12-bit parameter to fit output range.</td>
</tr>
<tr>
<td>ASCII Extended (Ext)</td>
<td>Extends up the output to an even number of digits/characters without changing the output range.</td>
</tr>
<tr>
<td>Signed (Sign)</td>
<td>Internal use — sign conversion.</td>
</tr>
</tbody>
</table>

### Table 23.4 BCD Width Descriptions

<table>
<thead>
<tr>
<th>BCD Width</th>
<th>Motorola Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Digit</td>
<td>1 byte of 1 digit, [00] to max [09]</td>
</tr>
<tr>
<td>2 Digits</td>
<td>1 bytes of 2 packed digits each, [00] to max [99]</td>
</tr>
<tr>
<td>3 Digits</td>
<td>1 bytes of 2 packed digits and 1 byte of 1 digit, [00][00] to max[09][99]</td>
</tr>
<tr>
<td>4 Digits</td>
<td>2 bytes of 2 packed digits each, [00][00] to max[99][99]</td>
</tr>
<tr>
<td>5 Digits</td>
<td>2 bytes of 2 packed digits and 1 byte of 1 digit, max [09][99][99]</td>
</tr>
<tr>
<td>6 Digits</td>
<td>3 bytes of 2 packed digits each, max [99][99][99]</td>
</tr>
<tr>
<td>7 Digits</td>
<td>3 bytes of 2 packed digits and 1 byte of 1 digit, max [09][99][99][99]</td>
</tr>
<tr>
<td>8 Digits</td>
<td>4 bytes of 2 packed digits each, max [99][99][99][99]</td>
</tr>
</tbody>
</table>

### Table 23.5 Hexadecimal Width Description

<table>
<thead>
<tr>
<th>Hex Width</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>4 Bits</td>
<td>[00] to [0F]</td>
</tr>
<tr>
<td>8 Bits</td>
<td>[00] to [FF]</td>
</tr>
<tr>
<td>12 Bits</td>
<td>[00][00] to [0F][FF] (or Intel [FF][0F])</td>
</tr>
<tr>
<td>14 Bits</td>
<td>[00][00] to [3F][FF] (or Intel [FF][3F])</td>
</tr>
<tr>
<td>15 Bits</td>
<td>[00][00] to [7F][FF] (or Intel [FF][7F])</td>
</tr>
<tr>
<td>16 Bits</td>
<td>[00][00] to [FF][FF]</td>
</tr>
<tr>
<td>24 Bits</td>
<td>[00][00][00] to [FF][FF][FF]</td>
</tr>
<tr>
<td>32 Bits</td>
<td>[00][00][00][00] to [FF][FF][FF][FF]</td>
</tr>
</tbody>
</table>
### Table 23.6 Decimal to Hexadecimal to ASCII Conversion Table

<table>
<thead>
<tr>
<th>Decimal</th>
<th>Hex</th>
<th>ASCII</th>
<th>Decimal</th>
<th>Hex</th>
<th>ASCII</th>
<th>Decimal</th>
<th>Hex</th>
<th>ASCII</th>
<th>Decimal</th>
<th>Hex</th>
<th>ASCII</th>
<th>Decimal</th>
<th>Hex</th>
<th>ASCII</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>00</td>
<td>43</td>
<td>10</td>
<td>01</td>
<td>4C</td>
<td>20</td>
<td>10</td>
<td>4C</td>
<td>30</td>
<td>1A</td>
<td>54</td>
<td>40</td>
<td>28</td>
<td>40</td>
</tr>
<tr>
<td>1</td>
<td>01</td>
<td>2C</td>
<td>11</td>
<td>02</td>
<td>2D</td>
<td>21</td>
<td>03</td>
<td>2E</td>
<td>31</td>
<td>11</td>
<td>43</td>
<td>40</td>
<td>28</td>
<td>40</td>
</tr>
<tr>
<td>2</td>
<td>02</td>
<td>2D</td>
<td>12</td>
<td>03</td>
<td>2E</td>
<td>22</td>
<td>04</td>
<td>2F</td>
<td>32</td>
<td>12</td>
<td>44</td>
<td>40</td>
<td>28</td>
<td>40</td>
</tr>
<tr>
<td>3</td>
<td>03</td>
<td>2E</td>
<td>13</td>
<td>04</td>
<td>2F</td>
<td>23</td>
<td>05</td>
<td>30</td>
<td>33</td>
<td>13</td>
<td>45</td>
<td>40</td>
<td>28</td>
<td>40</td>
</tr>
<tr>
<td>4</td>
<td>04</td>
<td>2F</td>
<td>14</td>
<td>05</td>
<td>30</td>
<td>24</td>
<td>06</td>
<td>31</td>
<td>34</td>
<td>14</td>
<td>46</td>
<td>40</td>
<td>28</td>
<td>40</td>
</tr>
<tr>
<td>5</td>
<td>05</td>
<td>30</td>
<td>15</td>
<td>06</td>
<td>31</td>
<td>25</td>
<td>07</td>
<td>32</td>
<td>35</td>
<td>15</td>
<td>47</td>
<td>40</td>
<td>28</td>
<td>40</td>
</tr>
<tr>
<td>6</td>
<td>06</td>
<td>31</td>
<td>16</td>
<td>07</td>
<td>32</td>
<td>26</td>
<td>08</td>
<td>33</td>
<td>36</td>
<td>16</td>
<td>48</td>
<td>40</td>
<td>28</td>
<td>40</td>
</tr>
<tr>
<td>7</td>
<td>07</td>
<td>32</td>
<td>17</td>
<td>08</td>
<td>33</td>
<td>27</td>
<td>09</td>
<td>34</td>
<td>37</td>
<td>17</td>
<td>49</td>
<td>40</td>
<td>28</td>
<td>40</td>
</tr>
<tr>
<td>8</td>
<td>08</td>
<td>33</td>
<td>18</td>
<td>09</td>
<td>34</td>
<td>28</td>
<td>10</td>
<td>35</td>
<td>38</td>
<td>18</td>
<td>50</td>
<td>40</td>
<td>28</td>
<td>40</td>
</tr>
<tr>
<td>9</td>
<td>09</td>
<td>34</td>
<td>19</td>
<td>10</td>
<td>35</td>
<td>29</td>
<td>11</td>
<td>36</td>
<td>39</td>
<td>19</td>
<td>51</td>
<td>40</td>
<td>28</td>
<td>40</td>
</tr>
<tr>
<td>10</td>
<td>0A</td>
<td>36</td>
<td>20</td>
<td>12</td>
<td>38</td>
<td>30</td>
<td>13</td>
<td>37</td>
<td>40</td>
<td>28</td>
<td>40</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>0B</td>
<td>37</td>
<td>21</td>
<td>13</td>
<td>38</td>
<td>31</td>
<td>14</td>
<td>39</td>
<td>41</td>
<td>29</td>
<td>40</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>0C</td>
<td>38</td>
<td>22</td>
<td>14</td>
<td>39</td>
<td>32</td>
<td>15</td>
<td>40</td>
<td>42</td>
<td>2A</td>
<td>40</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>0D</td>
<td>39</td>
<td>23</td>
<td>15</td>
<td>40</td>
<td>33</td>
<td>16</td>
<td>41</td>
<td>43</td>
<td>2B</td>
<td>40</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>0E</td>
<td>40</td>
<td>24</td>
<td>16</td>
<td>41</td>
<td>34</td>
<td>17</td>
<td>42</td>
<td>44</td>
<td>2C</td>
<td>40</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>0F</td>
<td>41</td>
<td>25</td>
<td>17</td>
<td>42</td>
<td>35</td>
<td>18</td>
<td>43</td>
<td>45</td>
<td>2D</td>
<td>40</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>10</td>
<td>42</td>
<td>26</td>
<td>18</td>
<td>43</td>
<td>36</td>
<td>19</td>
<td>44</td>
<td>46</td>
<td>2E</td>
<td>40</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>11</td>
<td>43</td>
<td>27</td>
<td>19</td>
<td>44</td>
<td>37</td>
<td>20</td>
<td>45</td>
<td>47</td>
<td>2F</td>
<td>40</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>12</td>
<td>44</td>
<td>28</td>
<td>20</td>
<td>45</td>
<td>38</td>
<td>21</td>
<td>46</td>
<td>48</td>
<td>30</td>
<td>50</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>13</td>
<td>45</td>
<td>29</td>
<td>21</td>
<td>46</td>
<td>39</td>
<td>22</td>
<td>47</td>
<td>49</td>
<td>31</td>
<td>51</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>14</td>
<td>46</td>
<td>30</td>
<td>22</td>
<td>47</td>
<td>40</td>
<td>23</td>
<td>48</td>
<td>50</td>
<td>32</td>
<td>52</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>15</td>
<td>47</td>
<td>31</td>
<td>23</td>
<td>48</td>
<td>41</td>
<td>24</td>
<td>49</td>
<td>51</td>
<td>33</td>
<td>53</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>16</td>
<td>48</td>
<td>32</td>
<td>24</td>
<td>49</td>
<td>42</td>
<td>25</td>
<td>50</td>
<td>52</td>
<td>34</td>
<td>54</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>17</td>
<td>49</td>
<td>33</td>
<td>25</td>
<td>50</td>
<td>43</td>
<td>26</td>
<td>51</td>
<td>53</td>
<td>35</td>
<td>55</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>24</td>
<td>18</td>
<td>50</td>
<td>34</td>
<td>26</td>
<td>51</td>
<td>44</td>
<td>27</td>
<td>52</td>
<td>54</td>
<td>36</td>
<td>56</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>25</td>
<td>19</td>
<td>51</td>
<td>35</td>
<td>27</td>
<td>52</td>
<td>45</td>
<td>28</td>
<td>53</td>
<td>55</td>
<td>37</td>
<td>57</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>26</td>
<td>20</td>
<td>52</td>
<td>36</td>
<td>28</td>
<td>53</td>
<td>46</td>
<td>29</td>
<td>54</td>
<td>56</td>
<td>38</td>
<td>58</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>27</td>
<td>21</td>
<td>53</td>
<td>37</td>
<td>29</td>
<td>54</td>
<td>47</td>
<td>30</td>
<td>55</td>
<td>57</td>
<td>39</td>
<td>59</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>28</td>
<td>22</td>
<td>54</td>
<td>38</td>
<td>30</td>
<td>55</td>
<td>48</td>
<td>31</td>
<td>56</td>
<td>58</td>
<td>40</td>
<td>60</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>29</td>
<td>23</td>
<td>55</td>
<td>39</td>
<td>31</td>
<td>56</td>
<td>49</td>
<td>32</td>
<td>57</td>
<td>59</td>
<td>41</td>
<td>61</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>30</td>
<td>24</td>
<td>56</td>
<td>40</td>
<td>32</td>
<td>57</td>
<td>50</td>
<td>33</td>
<td>58</td>
<td>60</td>
<td>42</td>
<td>62</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>31</td>
<td>25</td>
<td>57</td>
<td>41</td>
<td>33</td>
<td>58</td>
<td>51</td>
<td>34</td>
<td>59</td>
<td>61</td>
<td>43</td>
<td>63</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>32</td>
<td>26</td>
<td>58</td>
<td>42</td>
<td>34</td>
<td>59</td>
<td>52</td>
<td>35</td>
<td>60</td>
<td>62</td>
<td>44</td>
<td>64</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>33</td>
<td>27</td>
<td>59</td>
<td>43</td>
<td>35</td>
<td>60</td>
<td>53</td>
<td>36</td>
<td>61</td>
<td>63</td>
<td>45</td>
<td>65</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>34</td>
<td>28</td>
<td>60</td>
<td>44</td>
<td>36</td>
<td>61</td>
<td>54</td>
<td>37</td>
<td>62</td>
<td>64</td>
<td>46</td>
<td>66</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>35</td>
<td>29</td>
<td>61</td>
<td>45</td>
<td>37</td>
<td>62</td>
<td>55</td>
<td>38</td>
<td>63</td>
<td>65</td>
<td>47</td>
<td>67</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>36</td>
<td>30</td>
<td>62</td>
<td>46</td>
<td>38</td>
<td>63</td>
<td>56</td>
<td>39</td>
<td>64</td>
<td>66</td>
<td>48</td>
<td>68</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>37</td>
<td>31</td>
<td>63</td>
<td>47</td>
<td>39</td>
<td>64</td>
<td>57</td>
<td>40</td>
<td>65</td>
<td>67</td>
<td>49</td>
<td>69</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>38</td>
<td>32</td>
<td>64</td>
<td>48</td>
<td>40</td>
<td>65</td>
<td>58</td>
<td>41</td>
<td>66</td>
<td>68</td>
<td>50</td>
<td>70</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>39</td>
<td>33</td>
<td>65</td>
<td>49</td>
<td>41</td>
<td>66</td>
<td>59</td>
<td>42</td>
<td>67</td>
<td>69</td>
<td>51</td>
<td>71</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>40</td>
<td>34</td>
<td>66</td>
<td>50</td>
<td>42</td>
<td>67</td>
<td>60</td>
<td>43</td>
<td>68</td>
<td>70</td>
<td>52</td>
<td>72</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>41</td>
<td>35</td>
<td>67</td>
<td>51</td>
<td>43</td>
<td>68</td>
<td>61</td>
<td>44</td>
<td>69</td>
<td>71</td>
<td>53</td>
<td>73</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>42</td>
<td>36</td>
<td>68</td>
<td>52</td>
<td>44</td>
<td>69</td>
<td>62</td>
<td>45</td>
<td>70</td>
<td>72</td>
<td>54</td>
<td>74</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note** — 7-bit printable ASCII range from 32 to 126 decimal. The Custom device menus represent text values outside that range with a period (·).
Glossary of Terms

**Active Video Lines** — All video lines not occurring in the vertical blanking interval. The portion of the video signal that contains picture information.

**Aspect Ratio** — The numerical ratio of picture width to height, for example, 4:3 or 16:9.

**Auto Transition** — An automatic transition in which the manual movement of the fader handle is simulated electronically. The transition starts when the AUTO TRANS button is pressed and takes place over a pre-selected time period, measured in frames.

**Border** — Effects created around the edges of a pattern or on a keyer. If an optional Dual Border Generator Card is installed, several border, shadow, and outline effects are available on that keyer as well.

**Border Generator** — Circuitry that generates various border effects on keys created by the switcher.

**Chroma Key** — An effect in which video from one source replaces video of a specific hue in a second video source. The blue and green hues are most commonly used for chroma keying.

**Chrominance** — The “depth” or saturation of a color. The three characteristics of a TV color signal are chrominance, luminance, and hue.

**Cut** — An instantaneous switch from one video signal to another.

**Dissolve** — A transition from one video signal to another in which one signal is faded down, while the other is simultaneously faded up. The term “mix” is often used interchangeably with “dissolve”.

**Downstream Keyer (DSK)** — A keyer that places a key “downstream” of the MLE effects system output. This “top level” effect usually consists of a character generator title.

**External Key** — A video input (non-primary video) used to produce a key effect. Examples of external key sources are character generators and cameras.

**Fade-to-Black** — A controlled change of the on-air picture signal level down to black level.

**Field** — One half of a complete picture (or frame) interval containing all of the odd, or all of the even, lines in interlaced scanning. One scan of a TV screen is called a “field”; two fields are required to make a complete picture (which is a “frame”).

**Field Frequency** — The rate at which one complete field is scanned, approximately 50 times per second in 625 video, or 60 times per second in 525 video.

**Frame** — One complete picture consisting of two fields of interlaced scanning lines.

**GPI** — An abbreviation for General Purpose Interface, a device which typically allows switcher automatic transition functions to be controlled remotely.
**Hue** — The characteristic of a color signal that determines whether the color is red, yellow, green, blue, purple, etc. (the three characteristics of a TV color signal are chrominance, luminance, and hue). White, black, and gray are not considered hues.

**Internal Key** — The use of a primary input to produce a key effect.

**Key** — An effect produced by “cutting a hole” in the background video, then filling the hole with video or matte from another source. Key source video cuts the hole, key fill video fills the hole. The video signal used for cut and fill can come from the same, or separate, sources.

**Key Fill** — A video input which is timed to “fill the hole” provided by the key source video. An example of key fill is the video output of a character generator.

**Key Invert** — An effect that reverses the polarity of the key source so that the holes in the background are cut by dark areas of the key source instead of bright areas. The KEY INV button selects this effect.

**Key Mask** — A keying technique in which a pattern is combined with the key source to block out unwanted portions of the key source.

**Key Source** — The video signal which “cuts a hole” in the background video to make a key effect possible. Also called “Key Video”. In practice, this signal controls when a video mixer circuit will switch from background to key fill video.

**Key Video** — See Key Source.

**Linear Keys** — Linear keys make it possible to fully specify the transparency of a key from opaque, through transparent, to fully off. The transparency is specified by the key signal (also known as the “hole cutter” or “alpha channel”) that is associated with the key fill. A keyer capable of a linear key converts the key signal voltage directly to the transparency effect on the screen. The KEY MEM button allows the user to store the Clip and Gain settings required to match the incoming key signal to your requirements.

**Line Frequency** — The number of horizontal scans per second. For 525 line 60 Hz systems, this is approximately 15734 scans per second.

**Luminance Key** — An effect in which video from one source is replaced by video that exceeds a set level in a second video source.

**Mask** — See Key Mask.

**Matte** — A solid color signal that is generated by the switcher and can be adjusted for hue, saturation, and luminance levels.

**Matte Key** — A key effect in which the fill video is a matte, provided by one of the internal matte generators.

**Memory** — The memory feature provides storage and recall of complete switcher setups.

**MIX** — See Dissolve.

**MLE** — An abbreviation for multi-level effects.

**PGM Output** — The on-air video output of the system.

**Primary Input** — Video sources selected by the control panel push-buttons for the crosspoint buses. These buses are normally labelled “KEY”, “PGM”, and “PST”.

**PV Output** — A switcher output that shows the scene that will go on-air when the next automatic or manual transition takes place.

**Self Key** — A key effect in which the same video signal serves as both the key signal and key fill.

**Soft Edge** — A pattern edge effect produced by mixing key source and key fill signals in such a way that the edge of the pattern is not sharp.

**Split Screen** — An effect in which a wipe pattern provides the key source signal. This is known as a “preset pattern” key.
Tally — An indicator which illuminates when the associated button, or control, is selected or is on-air.

Termination — A means of closing a circuit by connecting a resistive load to it. In video systems, a termination is typically a 75 ohm resistive load.

Transition — A controlled change from one video input to another video input or black. The change can occur through a wipe, cut, dissolve or “DVE Send” effect.

Transition Preview — A transition seen only on the preview monitor. It may be observed and adjusted without disturbing the program or “on-air” output.

Video — The electrical signal produced by a camera, character generator or other image source. The signal amplitude varies in relation to the tonal scale from black to white presented at the source. White produces the highest amplitude; black produces the lowest signal amplitude.
Index

Symbols ............................................................... Eng 11-7

Numerics
1080i explained ................................................ Eng 2-31
4400AR-061 ................................................ Eng 2-12
4400AR-065 ................................................ Eng 2-12
4800AR-001 ................................................ Eng 2-13
4800AR-020 ................................................ Eng 2-13
4800AR-040 ................................................ Eng 2-13
4800AR-041 ................................................ Eng 2-13
4800AR-043 ................................................ Eng 2-13
4800AR-047 ................................................ Eng 2-13
4800AR-060A ................................................ Eng 2-12
4800AR-060B ................................................ Eng 2-12
4800AR-060C ................................................ Eng 2-12
4800AR-061A ................................................ Eng 2-12
4800AR-061B ................................................ Eng 2-12
4800AR-061C ................................................ Eng 2-12
4800AR-064 ................................................ Eng 2-12
4800AR-065 ................................................ Eng 2-12
4800AR-066 ................................................ Eng 2-12
4800AR-067 ................................................ Eng 2-12
4-Keyers option ................................................ Eng 2-2
720p explained ................................................ Eng 2-31

A
Abbreviations ..................................................... Eng 1-5
AC Power Ports ........................................ Eng 20-19, Eng 20-23
Act MLE Trans (Automation) Custom Control .... Eng 10-19
A-D, definition ................................................ Eng 1-5
Adjusting, Touchscreen Display ..................... Eng 5-4
AFV Hold Custom Controls ........................ Eng 10-16
AFV Off Custom Controls ........................ Eng 10-16
AFV On Custom Controls ........................ Eng 10-16
Air Filter Cleaning ........................................ Eng 18-15
Alpha
  Input BNC ............................................... Eng 7-6
  Input BNC Type ....................................... Eng 7-4
  shaped ................................................. Eng 7-7
  unshaped .............................................. Eng 7-6
Ancillary Data ................................................ Eng 8-11
Apache License .............................................. Eng 22-8
Architecture
  CPU ....................................................... Eng 2-36
  system ................................................. Eng 2-1

Assign
  BKGDCUT button .................................. Eng 7-15
  BKGDTRNS button ................................ Eng 7-15
  black ................................................. Eng 7-14
  Bus Hold button .................................. Eng 7-15
  Bus Maps ............................................ Eng 7-19
  Bus Maps to Multiple Buses .................... Eng 7-20
  color background ................................... Eng 7-14
  global-store button ................................ Eng 7-14
  K+B CUT button .................................. Eng 7-15
  K+B TRNS button ................................ Eng 7-15
  Key Cut button ..................................... Eng 7-15
  Key Trans button .................................. Eng 7-15
  MLE Re-entry ...................................... Eng 7-14
  MLE-store button ................................ Eng 7-14
  MV button .......................................... Eng 7-15
  shift ................................................... Eng 7-14
  Assign Audio Custom Controls ................. Eng 10-16
  Assign Channel Custom Control ............... Eng 10-19
  Assign Fader Custom Controls ................. Eng 10-15
  Assign MLE, Personality setting ............... Eng 11-3
  Assign MultiViewer ................................ Eng 8-14
  Assigning Crosspoint Colors ................... Eng 11-19
  Assigning Individual Bus Maps ................. Eng 7-19
  At Black Extra Option ............................ Eng 9-29
  Attach Custom Control to Button .............. Eng 10-25
    Post-Attach ...................................... Eng 10-26
    Pre-Attach ....................................... Eng 10-26
    Replace ............................................ Eng 10-26
  Audio All Off Custom Controls ................. Eng 10-16
  Audio channel assignment ....................... Eng 7-12
  Audio Channel Off Custom Controls ........... Eng 10-16
  Audio Channel On Custom Controls ............ Eng 10-16
  Audio Control Module ............................ Eng 12-25, Eng 15-6
    Map ................................................ Eng 15-6
    Mnemonics ........................................ Eng 15-6
    Row Mapping ..................................... Eng 17-8
  Audio Cut Only, Personality setting .......... Eng 11-3
  Audio Fade Rate ................................... Eng 12-24
  Audio Fader Test ................................... Eng 17-22
  Audio Memory Custom Controls ................. Eng 10-16
  Audio Mixers
    Audio Fade Rate ................................... Eng 12-24
    channel and group setup ....................... Eng 12-21
    channel assignment ............................. Eng 7-12
  Custom Controls
    banks ............................................... Eng 10-8
    PGM Audio Level/Duration ..................... Eng 10-17
    default levels .................................... Eng 12-22
    Groups ............................................. Eng 12-23
    source assignment ................................ Eng 12-21
  Audio Mute Off Custom Controls ............... Eng 10-16
  Audio Mute On Custom Controls ............... Eng 10-16
  Audio Remote Control Setup ..................... Eng 12-21
  Audio Server Control option .................... Eng 6-12
  Audio Server, Input Type, see VTR
Worksheet .................................................. Eng 21-6

Buses
Swap Program and Preset ........ Eng 11-14
Button Cap Assembly, removing ... Eng 3-17

Button Insert Films ......................... Eng 3-17
installing ................................ Eng 3-17
size ........................................ Eng 3-17
specifications .............................. Eng 3-17

Button mapping, default ........ Eng 3-13

Buttons
Back ........................................ Eng 5-6
Bus Map ...................................... Eng 7-13
Copy Down .................................. Eng 5-6
Copy Up ...................................... Eng 5-6
Forward ...................................... Eng 5-6
programming a control button .... Eng 10-10
Swap ........................................ Eng 5-6

C

Cables
cr (Touchscreen) ...................... Eng 3-9
DVI ........................................ Eng 3-9
Frame/Control Panel ................... Eng 3-11
power (Touchscreen) ........ Eng 3-20
USB (Touchscreen) ...................... Eng 3-9

Cabling
Aux Mix/Pre .............................. Eng 8-28
BSS4 ...................................... Eng 9-13
DeviceMaster ........................... Eng 9-14
frame to control panel ................. Eng 3-11
NetExp ...................................... Eng 9-14
remote aux panels ........................ Eng 14-7
Calibration ................................. Eng 17-1
Fader ........................................ Eng 17-3
Positioner .................................. Eng 17-4
Touchscreen ................................ Eng 17-4
call Custom Control event ........... Eng 10-3
Cam All Stop Custom Controls ...... Eng 10-20
Camera File
Defaulting ................................. Eng 12-28
Camera Grab Time, Personality setting ... Eng 11-4
Capture, screen ......................... Eng 5-19
Card, System Information Page ........ Eng 6-7
Carrier, Squeeze & Tease Board , Eng 2-27, Eng 2-28
CC/CC Macro Attachments ........ Eng 13-5, Eng 13-10
Registers .................................... Eng 13-3

CC/CC Macro Attachments, Personality setting Eng 11-4
Center
Preview Overlay Setup ................ Eng 12-34
CG, definition ............................ Eng 1-5
Char Gen, Input BNC Type ........ Eng 7-5
Character Generators ................. Eng 6-12
Check, Keys .............................. Eng 7-25
Checksum Custom Control ........ Eng 17-32
short ..................................... Eng 17-32
using ..................................... Eng 17-34
Choose Clip ID ........................... Eng 12-18

Circuit Boards
installing (frame) ..................... Eng 4-18
labelling ................................. Eng 2-37
removing (frame) ..................... Eng 4-18
Clean Feed ................................. Eng 8-7
Layer Mode ............................... Eng 8-7
MLE .......................................... Eng 8-3
output BNC ................................ Eng 8-3
setup ....................................... Eng 8-7
Clean Feed Setup ........................ Eng 8-7
Cleaning, Air Filter ..................... Eng 18-15
Clear Bus Hold ......................... Eng 11-5
ClearAllFB Custom Control ........ Eng 10-21
ClearFB Custom Control ........ Eng 10-20, Eng 10-21
Clip and Gain, Keys ................... Eng 7-26
Clip ID
setup ....................................... Eng 12-18
Clip Inpoint/Outpoint, video serversEng 12-18
Clip List Extra Option ................. Eng 9-30
Clip Lists Extra Option (Automation) ... Eng 9-26
Clip Registers ......................... Eng 12-17, Eng 13-2
timecode, grab ......................... Eng 12-20
Clip Setup ................................ Eng 12-17
Clips
Defaulting ................................. Eng 12-28
Keypad Clip IDs Entry ........ Eng 11-9
Keypad DVE Num Entry ........ Eng 11-9
Keypad Still Num Entry ........ Eng 11-9
Keypad Wipe Num Entry ........ Eng 11-10
Cmd Queue Extra Option .......... Eng 9-30
CmdDelay Extra Option .......... Eng 9-27
Color Correction ......................... Eng 6-13
Color Scheme Quick Navigation .... Eng 5-10
Color Schemes
All MLEs the Same ................ Eng 11-17
editing buttons ....................... Eng 11-17
editing mnemonics ........ Eng 11-21
Loading ................................. Eng 11-24
User Colors ............................. Eng 11-18
Custom Control Buttons ........ Eng 11-18
Re-entry ................................ Eng 11-18
Selected Buttons .................... Eng 11-18
Selected Xpt ........................... Eng 11-18
Xpt Colors ............................ Eng 11-19
Communication Errors ................ Eng 17-14
Communication Port Monitor ........ Eng 17-36
Data File ................................ Eng 17-37
Communication Ports ................. Eng 2-15
Device Drivers ......................... Eng 9-2
Ethernet ................................ Eng 9-3
Serial, Frame ......................... Eng 9-2
Serial, Panel ......................... Eng 9-2
Communication Status ................. Eng 17-14
Communications ...................... Eng 9-1
Extra Options ........................... Eng 9-25
Setup ..................................... Eng 9-7
Com Settings ........................... Eng 9-8, Eng 9-11
Communications connections
remote aux panels .....................................Eng 14-6
Communications Settings
BSS4 ..................................................Eng 9-18
NetExp ..................................................Eng 9-18
Communications Worksheet ......................Eng 21-11
Complete Status .....................................Eng 17-10
Completing Setup .....................................Eng 12-1
Composite-Sync reference signal .....................Eng 4-12
Control DeviceMaster
programming .........................................Eng 9-17
Configuration
BNC ..................................................Eng 8-1
control panel DIP .....................................Eng 20-25
frame DIP ..............................................Eng 20-8, Eng 20-9
Configuring video inputs
types ..................................................Eng 7-4
Connecting to the GPI I/O port .....................Eng 12-11
Connections
input ..................................................Eng 3-13
output .................................................Eng 3-15
Connector Types
custom control functions .....................Eng 10-2
Dimensions .........................................Eng 20-6
dimensions .........................................Eng 20-6
delays ..................................................Eng 5-16
brightness ............................................Eng 11-16
installation .........................................Eng 3-7
Maintenance
Hard Drive replacement ......................Eng 18-16
mapping .............................................Eng 17-5
Quick Module Configure .....................Eng 17-5
Single Module Configure .....................Eng 17-6
overview .............................................Eng 2-2
port .....................................................Eng 2-16
power connection .....................................Eng 3-19
power fail indicators .....................................Eng 3-21
reference description .............................Eng 1-4
restart .................................................Eng 4-24
Touchscreen installation ...........................Eng 3-8
tub installation (console-top) .....................Eng 3-7
tub installation (flush mounted) .....................Eng 3-8
tub installation (in-console) .....................Eng 3-7
Vision 1 .............................................Eng 2-6
Vision 1M .............................................Eng 2-5
Vision 2 .............................................Eng 2-5
Vision 2M .............................................Eng 2-4
Vision 2X .............................................Eng 2-3
Vision 3 .............................................Eng 2-2
Vision 3M .............................................Eng 2-4
Vision 4 .............................................Eng 2-2
Control Panel Diagnostics .....................Eng 17-18
Burn Mode .............................................Eng 17-27
Button Color Test ..............................Eng 17-18
Button Function Test ..............................Eng 17-18
Display Test ........................................Eng 17-20
Fader Test ...........................................Eng 17-19
Knob Test .............................................Eng 17-21
barrier .................................................Eng 17-21
boundary .............................................Eng 17-21
button .................................................Eng 17-21
Module Memory Test ..............................Eng 17-22
PCH
LVDS Test ...........................................Eng 17-23
PCI Bridge Test .....................................Eng 17-25
Tally Test ............................................Eng 17-25
Tx/Rx Test ............................................Eng 17-22
Positioner Test .....................................Eng 17-20
SBC Tx/Rx Test .....................................Eng 17-25
Stuck Button Test .....................................Eng 17-19
Touchscreen
Draw Test ...........................................Eng 17-26
Pattern Test .........................................Eng 17-26
Control Panel Ports
AC power ...........................................Eng 20-23
aux .....................................................Eng 20-22
external link .........................................Eng 20-21
remote ..................................................Eng 20-21
Control Panel Power Supply .....................Eng 18-10
replacing ............................................Eng 18-4
Control Panel Power Supply Failure .............Eng 18-2
troubleshooting .....................................Eng 18-2, Eng 18-3
 Hold CC ...........................................Eng 10-23
 Hold For Group ................................Eng 10-23
 Hold For Run .....................................Eng 10-23
 In Flag Reset ...................................Eng 10-21
 In Recall .........................................Eng 10-21
 Key Frame Adv ..................................Eng 10-18
 Key Frame Rev ..................................Eng 10-18
 Load (CG) ......................................Eng 10-17, Eng 10-18
 Load Layout .....................................Eng 10-19
 Loop CC .........................................Eng 10-23
 looping ............................................Eng 10-3
 Modify Dynamic Text .........................Eng 10-19
 moving ............................................Eng 10-32
 Multiple .......................................Eng 11-10
 naming buttons ................................Eng 10-28
 Next .............................................Eng 10-21
 Notify End CC ...................................Eng 10-23

 OverDrive
 Prepare Next ...................................Eng 10-19
 Prepare Previous ...............................Eng 10-19
 Preview CC .....................................Eng 10-19
 Run On-Air CC ................................Eng 10-19
 Rundown .........................................Eng 10-19
 Take & Prepare ................................Eng 10-19
 Transition ......................................Eng 10-19
 Pause .............................................Eng 10-17
 Pause CC ........................................Eng 10-23
 Pause DVE ......................................Eng 10-18
 Pause VTR .......................................Eng 10-22
 Pbus protocol functions .......................Eng 10-2
 PGM Audio Level/Duration ....................Eng 10-17
 Play .............................................Eng 10-17, Eng 10-18, Eng 10-22
 Play (CG) .......................................Eng 10-18
 Play Loop Off ...................................Eng 10-22
 Play Loop On ...................................Eng 10-22
 Play no Stat ....................................Eng 10-22
 Play Rev .........................................Eng 10-18
 Prepare Move ...................................Eng 10-20
 Preroll ..........................................Eng 10-22
 PST Audio Level .................................Eng 10-17
 Quick Navigation Button ......................Eng 5-11
 Read ..............................................Eng 10-21
 Read (CG) .......................................Eng 10-18
 Recall (CG) ......................................Eng 10-18
 Recall DVE ......................................Eng 10-18
 Recall Pbus .....................................Eng 10-18
 Recall Shot .....................................Eng 10-19
 recalling individual .........................Eng 13-12
 Record ..........................................Eng 10-22
 Registers ........................................Eng 13-2
 Relative .........................................Eng 10-11
 Resave Last ....................................Eng 10-20
 Reset Audio ....................................Eng 10-17
 Reset Fader ....................................Eng 10-15
 Reset GPI ........................................Eng 10-18
 Reset Time Clock ................................Eng 10-22
 Resume ..........................................Eng 10-21

 Rewind ..........................................Eng 10-22
 Rewind DVE ....................................Eng 10-18
 Run Custom Control event .................Eng 10-3
 Run Held ........................................Eng 10-23
 Run Held Group ................................Eng 10-23
 Run Sequence ..................................Eng 10-24
 Safe Title .......................................Eng 10-23
 Select Memory Bank event .................Eng 10-3
 Seq Next .........................................Eng 10-18
 Seq Prev .........................................Eng 10-18
 Seq Take .........................................Eng 10-18
 SeqIn ............................................Eng 10-20
 SeqOut ..........................................Eng 10-20
 Server functions ..............................Eng 10-2
 Set AFV Level ..................................Eng 10-16
 Set Folder (CG) ................................Eng 10-18
 shortcuts .......................................Eng 10-34
 Bank .............................................Eng 10-34
 Pause/Hold .....................................Eng 10-34
 Record ..........................................Eng 10-34
 Run A-Z .........................................Eng 10-35
 Run Held .......................................Eng 10-34
 Run Held X .....................................Eng 10-34
 Stop CC .........................................Eng 10-35
 Stop Held X .....................................Eng 10-35
 Shot Box Module ..............................Eng 10-6, Eng 15-2
 Simulate GPI ....................................Eng 10-19
 Soft Shot Box .................................Eng 10-5

 Special Functions
 special functions .............................Eng 10-2
 Standby Off ....................................Eng 10-22
 Standby On .....................................Eng 10-22
 start recording ...............................Eng 10-10
 start relative recording ......................Eng 10-13
 Stop ..............................................Eng 10-4, Eng 10-17, Eng 10-22
 Stop DVE ........................................Eng 10-18
 Stop Held X .....................................Eng 10-23
 Stop Other CC ................................Eng 10-24
 Stop Time Clock ...............................Eng 10-22
 Store Pbus .....................................Eng 10-19
 storing individual ............................Eng 13-7
 swapping ........................................Eng 10-32
 Take ..............................................Eng 10-18, Eng 10-20
 Take Out (CG) ..................................Eng 10-18
 Take XPT ........................................Eng 10-21
 time clock functions ........................Eng 10-2
 tips ...............................................Eng 10-2
 Transition Keys ................................Eng 10-23
 Trigger GPI ......................................Eng 10-19
 Trigger Pbus ....................................Eng 10-20
 TypeInCmd ......................................Eng 10-21
 Up ................................................Eng 10-21
 Variable Pause CC ............................Eng 10-24, Eng 10-37
 video server functions ......................Eng 10-2
 VTR functions ..................................Eng 10-2
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom Device</td>
<td>Eng 9-21</td>
</tr>
<tr>
<td>advanced topics and tables</td>
<td>Eng 23-3</td>
</tr>
<tr>
<td>commands</td>
<td>Eng 9-21</td>
</tr>
<tr>
<td>protocol uses and limitations</td>
<td>Eng 23-2</td>
</tr>
<tr>
<td>Protocol Worksheet</td>
<td>Eng 21-22</td>
</tr>
<tr>
<td>Customer service</td>
<td>Eng 1-7</td>
</tr>
<tr>
<td>Cut Keys Custom Control</td>
<td>Eng 10-22</td>
</tr>
</tbody>
</table>

**D**

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>D-A, definition</td>
<td>Eng 1-5</td>
</tr>
<tr>
<td>DA, definition</td>
<td>Eng 1-5</td>
</tr>
<tr>
<td>Data Txfr Extra Option</td>
<td>Eng 9-29</td>
</tr>
<tr>
<td>Date, System Information Page</td>
<td>Eng 6-8</td>
</tr>
<tr>
<td>DDR, definition</td>
<td>Eng 1-5</td>
</tr>
<tr>
<td>Decode NAKs Extra Option</td>
<td>Eng 9-31</td>
</tr>
<tr>
<td>Default Audio Level, setting</td>
<td>Eng 12-21</td>
</tr>
<tr>
<td>Default Audio Levels</td>
<td>Eng 12-22</td>
</tr>
<tr>
<td>Default Mapping</td>
<td>Eng 3-13</td>
</tr>
<tr>
<td>input</td>
<td>Eng 3-15</td>
</tr>
<tr>
<td>output</td>
<td>Eng 3-15</td>
</tr>
<tr>
<td>Default MLE Map Assignment</td>
<td>Eng 12-5</td>
</tr>
<tr>
<td>Default Names</td>
<td>Eng 4-16</td>
</tr>
<tr>
<td>Default Network Address</td>
<td>Eng 20-8</td>
</tr>
<tr>
<td>Default Trans Rate</td>
<td>Eng 11-5</td>
</tr>
<tr>
<td>Active</td>
<td>Eng 11-5</td>
</tr>
<tr>
<td>Effects Dissolve</td>
<td>Eng 11-5</td>
</tr>
<tr>
<td>FTB</td>
<td>Eng 11-5</td>
</tr>
<tr>
<td>Keyer</td>
<td>Eng 11-5</td>
</tr>
<tr>
<td>MLE</td>
<td>Eng 11-5</td>
</tr>
<tr>
<td>Sequence</td>
<td>Eng 11-5</td>
</tr>
</tbody>
</table>

**Defaulting**

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bus Maps</td>
<td>Eng 12-28</td>
</tr>
<tr>
<td>Camera File</td>
<td>Eng 12-28</td>
</tr>
<tr>
<td>CC Variables</td>
<td>Eng 12-29</td>
</tr>
<tr>
<td>Clips</td>
<td>Eng 12-28</td>
</tr>
<tr>
<td>Custom Control Attachment</td>
<td>Eng 12-28</td>
</tr>
<tr>
<td>Custom Controls</td>
<td>Eng 12-28</td>
</tr>
<tr>
<td>Installation</td>
<td>Eng 12-28</td>
</tr>
<tr>
<td>Memories</td>
<td>Eng 12-28</td>
</tr>
<tr>
<td>MultiViewer</td>
<td>Eng 12-29</td>
</tr>
<tr>
<td>NV-RAM</td>
<td>Eng 12-28</td>
</tr>
<tr>
<td>Personality</td>
<td>Eng 12-27</td>
</tr>
<tr>
<td>Shot Box Pages</td>
<td>Eng 12-28</td>
</tr>
<tr>
<td>Squeeze &amp; Tease</td>
<td>Eng 12-28</td>
</tr>
<tr>
<td>Switcher</td>
<td>Eng 12-28</td>
</tr>
<tr>
<td>Defaulting Bus Maps</td>
<td>Eng 7-17</td>
</tr>
<tr>
<td>Defaults, Factory</td>
<td>Eng 12-27</td>
</tr>
<tr>
<td>Defaults, recalling factory</td>
<td>Eng 12-27</td>
</tr>
<tr>
<td>Definitions</td>
<td>Eng 1-5</td>
</tr>
<tr>
<td>abbreviations</td>
<td>Eng 1-4</td>
</tr>
<tr>
<td>terms</td>
<td>Eng 1-4</td>
</tr>
<tr>
<td>Deleting Custom Control Events</td>
<td>Eng 10-31</td>
</tr>
<tr>
<td>Deleting Custom Controls</td>
<td>Eng 10-33</td>
</tr>
<tr>
<td>Deleting FlexDevice Drivers</td>
<td>Eng 9-6</td>
</tr>
<tr>
<td>Deleting option codes</td>
<td>Eng 6-14</td>
</tr>
<tr>
<td>Deselect Cam Custom Controls</td>
<td>Eng 10-20</td>
</tr>
<tr>
<td>Device Drivers</td>
<td>Eng 9-2</td>
</tr>
</tbody>
</table>

**Device Drivers**, see FlexDevice Drivers

**Device, storage capacity**

**DeviceMaster**

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>cabling</td>
<td>Eng 9-14</td>
</tr>
</tbody>
</table>

**Diagnosis**

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fail Indicators</td>
<td>Eng 17-10</td>
</tr>
<tr>
<td>Diagnostics</td>
<td>Eng 17-1</td>
</tr>
<tr>
<td>Checksums Custom Controls</td>
<td>Eng 17-32</td>
</tr>
<tr>
<td>Com Port Monitor</td>
<td>Eng 17-36</td>
</tr>
<tr>
<td>Data File</td>
<td>Eng 17-37</td>
</tr>
<tr>
<td>Communication Status</td>
<td>Eng 17-14</td>
</tr>
<tr>
<td>Errors</td>
<td>Eng 17-14</td>
</tr>
<tr>
<td>Status</td>
<td>Eng 17-14</td>
</tr>
<tr>
<td>Control Panel</td>
<td>Eng 17-18</td>
</tr>
<tr>
<td>Audio Fader</td>
<td>Eng 17-22</td>
</tr>
<tr>
<td>Burn Mode</td>
<td>Eng 17-27</td>
</tr>
<tr>
<td>Button Color Test</td>
<td>Eng 17-18</td>
</tr>
<tr>
<td>Button Function Test</td>
<td>Eng 17-18</td>
</tr>
<tr>
<td>Display Test</td>
<td>Eng 17-20</td>
</tr>
<tr>
<td>Fader Test</td>
<td>Eng 17-19</td>
</tr>
<tr>
<td>Knob Test</td>
<td>Eng 17-21</td>
</tr>
<tr>
<td>barrier</td>
<td>Eng 17-21</td>
</tr>
<tr>
<td>boundary</td>
<td>Eng 17-21</td>
</tr>
<tr>
<td>button</td>
<td>Eng 17-21</td>
</tr>
<tr>
<td>Module Memory Test</td>
<td>Eng 17-22</td>
</tr>
<tr>
<td>PCH</td>
<td>Eng 17-20</td>
</tr>
<tr>
<td>LVDS Test</td>
<td>Eng 17-23</td>
</tr>
<tr>
<td>PCI Bridge Test</td>
<td>Eng 17-25</td>
</tr>
<tr>
<td>Tally Test</td>
<td>Eng 17-25</td>
</tr>
<tr>
<td>Tx/Rx Test</td>
<td>Eng 17-22</td>
</tr>
<tr>
<td>Positioner Test</td>
<td>Eng 17-20</td>
</tr>
<tr>
<td>SBC</td>
<td>Eng 17-28</td>
</tr>
<tr>
<td>Tx/Rx Test</td>
<td>Eng 17-25</td>
</tr>
<tr>
<td>Stuck Button Test</td>
<td>Eng 17-19</td>
</tr>
<tr>
<td>Touchscreen</td>
<td>Eng 17-26</td>
</tr>
<tr>
<td>Draw Test</td>
<td>Eng 17-26</td>
</tr>
<tr>
<td>Pattern Test</td>
<td>Eng 17-26</td>
</tr>
<tr>
<td>Frame</td>
<td>Eng 17-28</td>
</tr>
<tr>
<td>DIP Switch Test</td>
<td>Eng 17-29</td>
</tr>
<tr>
<td>GPI Test</td>
<td>Eng 17-28</td>
</tr>
<tr>
<td>Graphics Buffer Test</td>
<td>Eng 17-30</td>
</tr>
<tr>
<td>LEDs Test</td>
<td>Eng 17-29</td>
</tr>
<tr>
<td>Tx/Rx Test</td>
<td>Eng 17-28</td>
</tr>
<tr>
<td>Non-Sync</td>
<td>Eng 17-16</td>
</tr>
<tr>
<td>Quick Navigation Button</td>
<td>Eng 5-10</td>
</tr>
<tr>
<td>Switcher Logs</td>
<td>Eng 17-38</td>
</tr>
<tr>
<td>Switcher Status</td>
<td>Eng 17-10</td>
</tr>
<tr>
<td>Complete Status</td>
<td>Eng 17-10</td>
</tr>
<tr>
<td>Icons</td>
<td>Eng 17-12</td>
</tr>
<tr>
<td>Version Information</td>
<td>Eng 17-2</td>
</tr>
<tr>
<td>Warnings</td>
<td>Eng 17-11</td>
</tr>
<tr>
<td>VNC Viewer</td>
<td>Eng 17-31</td>
</tr>
</tbody>
</table>

**Digital reference connection**

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimensions</td>
<td>Eng 4-11</td>
</tr>
<tr>
<td>control panel</td>
<td>Eng 20-6</td>
</tr>
<tr>
<td>frame</td>
<td>Eng 20-6</td>
</tr>
</tbody>
</table>

**DIP Switch**
Index • IX–9

Vision Engineering Manual (v18.0 MD)

Audio Servers
Bus Address ........................................ Eng 9-25

Automation
Clip Lists ........................................ Eng 9-26

Cameras
CmdDelay ........................................ Eng 9-27
Focus Speed ..................................... Eng 9-27
Iris Control ...................................... Eng 9-27
Iris Mode .......................................... Eng 9-28
Iris Res ............................................ Eng 9-28
Iris Speed ........................................ Eng 9-28
Lens Type ......................................... Eng 9-28
Master Ped ........................................ Eng 9-28
Pan/Tilt Damping ............................... Eng 9-28
Pan/Tilt Speed ................................... Eng 9-28
Panel ID .......................................... Eng 9-28
Poll ................................................ Eng 9-28
Protocol .......................................... Eng 9-28
RecTime .......................................... Eng 9-28
Select Delay ..................................... Eng 9-28
SerialSwitch ..................................... Eng 9-28
ShotOffset ...................................... Eng 9-29
Z Speed .......................................... Eng 9-29
Zoom Speed ...................................... Eng 9-29

Character Generators
Back-to-Back ..................................... Eng 9-26
Display Mode .................................... Eng 9-26
PlayTime ........................................ Eng 9-26
Show on PV ...................................... Eng 9-26
Software Ver .................................... Eng 9-26
Timeout .......................................... Eng 9-26

Editors
CustCtrl MLE .................................. Eng 9-27
Editor Type ...................................... Eng 9-27
Pattern .......................................... Eng 9-27
Use Break ........................................ Eng 9-27

Pbus
Query Cmd ....................................... Eng 9-27

Routers
Base .............................................. Eng 9-29
Level Base ...................................... Eng 9-29
Num Levels ..................................... Eng 9-29
Src & Dest Base ............................... Eng 9-29
Xpts ............................................. Eng 9-29

Serial Tallies
At Black ......................................... Eng 9-29
Data Txfr ........................................ Eng 9-29
Rate .............................................. Eng 9-29
Slot 1 ............................................. Eng 9-29
Source Name .................................... Eng 9-29
Start .............................................. Eng 9-29

Video Servers
Clip List ......................................... Eng 9-30

VTR
Decode NAKs .................................... Eng 9-31
NPlayRetries .................................... Eng 9-31
Request TC ..................................... Eng 9-31
TargetMachine ................................. Eng 9-31
Wait nFields .................................... Eng 9-32

F
Factory Defaults ................................. Eng 12-27
Recalling ........................................ Eng 12-27

Fade to Black
Default Rate ..................................... Eng 11-5
Display Mode .................................... Eng 11-8
Display Mode, Personality setting .......... Eng 16-7
setup ............................................. Eng 8-9

Fader Calibration ............................... Eng 17-3
Fail
Frame Indicator ................................ Eng 5-3
Panel Indicator ................................ Eng 5-3
Fail Indicators Diagnosis ...................... Eng 17-10
Fast Forward Custom Control ............... Eng 10-21
Field 1 and Field 2 ............................ Eng 2-32
Field and Frame information ............... Eng 2-33
Field, Switch on ............................... Eng 8-13
Fields ............................................ Eng 2-32
File and Setup Storage ....................... Eng 13-1, Eng 13-4
Downloading .................................... Eng 13-15
External Computer ............................ Eng 13-15
Overview ....................................... Eng 13-2
Recall
all ................................................ Eng 13-10
bus maps ........................................ Eng 13-10
cameras .......................................... Eng 13-10
CC Variables .................................... Eng 13-10
Custom Control Attachments .............. Eng 13-10
custom controls ............................... Eng 13-10
individual Bus Maps ......................... Eng 13-10
individual custom control ................... Eng 13-12
individual memory ............................ Eng 13-11
individual MultiViewer layouts .......... Eng 13-13
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>individual register items</td>
<td>Eng 13-11</td>
</tr>
<tr>
<td>individual S&amp;T Sequences</td>
<td>Eng 13-12</td>
</tr>
<tr>
<td>individual Shot Box Pages</td>
<td>Eng 13-13</td>
</tr>
<tr>
<td>installation</td>
<td>Eng 13-10</td>
</tr>
<tr>
<td>memories</td>
<td>Eng 13-10</td>
</tr>
<tr>
<td>MultiViewer Assignment</td>
<td>Eng 13-10</td>
</tr>
<tr>
<td>MultiViewer Layout</td>
<td>Eng 13-10</td>
</tr>
<tr>
<td>personality</td>
<td>Eng 13-10</td>
</tr>
<tr>
<td>register types</td>
<td>Eng 13-9</td>
</tr>
<tr>
<td>shot box pages</td>
<td>Eng 13-10</td>
</tr>
<tr>
<td>squeeze &amp; tease sequences</td>
<td>Eng 13-10</td>
</tr>
<tr>
<td>VTR clips</td>
<td>Eng 13-10</td>
</tr>
<tr>
<td>Store</td>
<td>Eng 13-5</td>
</tr>
<tr>
<td>all</td>
<td>Eng 13-5</td>
</tr>
<tr>
<td>bus maps</td>
<td>Eng 13-5</td>
</tr>
<tr>
<td>cameras</td>
<td>Eng 13-5</td>
</tr>
<tr>
<td>CC Variables</td>
<td>Eng 13-5</td>
</tr>
<tr>
<td>Custom Control Attachments</td>
<td>Eng 13-5</td>
</tr>
<tr>
<td>custom controls</td>
<td>Eng 13-5</td>
</tr>
<tr>
<td>individual Bus Maps</td>
<td>Eng 13-7</td>
</tr>
<tr>
<td>individual custom control</td>
<td>Eng 13-7</td>
</tr>
<tr>
<td>individual memory</td>
<td>Eng 13-6</td>
</tr>
<tr>
<td>individual MultiViewer layouts</td>
<td>Eng 13-8</td>
</tr>
<tr>
<td>individual register items</td>
<td>Eng 13-5, Eng 13-6</td>
</tr>
<tr>
<td>individual S&amp;T Sequences</td>
<td>Eng 13-7</td>
</tr>
<tr>
<td>individual Shot Box Pages</td>
<td>Eng 13-8</td>
</tr>
<tr>
<td>installation</td>
<td>Eng 13-5</td>
</tr>
<tr>
<td>memories</td>
<td>Eng 13-5</td>
</tr>
<tr>
<td>MultiViewer Assignment</td>
<td>Eng 13-5</td>
</tr>
<tr>
<td>MultiViewer Layout</td>
<td>Eng 13-5</td>
</tr>
<tr>
<td>personality</td>
<td>Eng 13-5</td>
</tr>
<tr>
<td>register types</td>
<td>Eng 13-4</td>
</tr>
<tr>
<td>shot box pages</td>
<td>Eng 13-5</td>
</tr>
<tr>
<td>squeeze &amp; tease sequences</td>
<td>Eng 13-5</td>
</tr>
<tr>
<td>VTR clips</td>
<td>Eng 13-5</td>
</tr>
<tr>
<td>Uploading</td>
<td>Eng 13-15</td>
</tr>
<tr>
<td>Films, button insert</td>
<td>Eng 3-17</td>
</tr>
<tr>
<td>Fire Salvo Custom Control</td>
<td>Eng 10-21</td>
</tr>
<tr>
<td>Flash full</td>
<td>Eng 6-5</td>
</tr>
<tr>
<td>FlexDevice</td>
<td>Eng 9-2</td>
</tr>
<tr>
<td>FlexDevice Drivers</td>
<td>Eng 9-4</td>
</tr>
<tr>
<td>Deleting</td>
<td>Eng 9-6</td>
</tr>
<tr>
<td>Installing</td>
<td>Eng 9-4, Eng 9-5</td>
</tr>
<tr>
<td>Status</td>
<td>Eng 9-4</td>
</tr>
<tr>
<td>Obsolete</td>
<td>Eng 9-4</td>
</tr>
<tr>
<td>OK</td>
<td>Eng 9-4</td>
</tr>
<tr>
<td>Unsupported</td>
<td>Eng 9-4</td>
</tr>
<tr>
<td>Stopping</td>
<td>Eng 9-5</td>
</tr>
<tr>
<td>Flexi Mode, Key 4</td>
<td>Eng 12-8</td>
</tr>
<tr>
<td>FlexiClean Setup</td>
<td>Eng 8-7</td>
</tr>
<tr>
<td>Flush mounted control panel installation</td>
<td>Eng 3-8</td>
</tr>
<tr>
<td>Focus Custom Control</td>
<td>Eng 10-21</td>
</tr>
<tr>
<td>Focus Speed Extra Option</td>
<td>Eng 9-27</td>
</tr>
<tr>
<td>Follow</td>
<td>Eng 12-39</td>
</tr>
<tr>
<td>Bus</td>
<td>Eng 12-41</td>
</tr>
<tr>
<td>Keyer</td>
<td>Eng 12-42</td>
</tr>
<tr>
<td>Memory Recall</td>
<td>Eng 12-43</td>
</tr>
<tr>
<td>MLE</td>
<td>Eng 12-40</td>
</tr>
<tr>
<td>Transition Module</td>
<td>Eng 12-42</td>
</tr>
<tr>
<td>Font Color, Preview Overlay Setup</td>
<td>Eng 12-30</td>
</tr>
<tr>
<td>Force Menu Change</td>
<td>Eng 4-10</td>
</tr>
<tr>
<td>Format, Input BNCs</td>
<td>Eng 4-13</td>
</tr>
<tr>
<td>Format, Output BNCs</td>
<td>Eng 4-13</td>
</tr>
<tr>
<td>Forward Button</td>
<td>Eng 5-6</td>
</tr>
<tr>
<td>Frame</td>
<td>Eng 6-10</td>
</tr>
<tr>
<td>boards menu</td>
<td>Eng 6-10</td>
</tr>
<tr>
<td>connecting to control panel</td>
<td>Eng 3-11</td>
</tr>
<tr>
<td>CPU, overview</td>
<td>Eng 2-12</td>
</tr>
<tr>
<td>front layout</td>
<td>Eng 2-8</td>
</tr>
<tr>
<td>GPI I/O port, overview</td>
<td>Eng 2-16</td>
</tr>
<tr>
<td>installing boards</td>
<td>Eng 4-18</td>
</tr>
<tr>
<td>LAN port, overview</td>
<td>Eng 2-16</td>
</tr>
<tr>
<td>operating environment</td>
<td>Eng 3-5</td>
</tr>
<tr>
<td>Over-Temperature Shutdown</td>
<td>Eng 12-44</td>
</tr>
<tr>
<td>peripheral ports, overview</td>
<td>Eng 2-16</td>
</tr>
<tr>
<td>ports</td>
<td>Eng 2-16</td>
</tr>
<tr>
<td>power connection</td>
<td>Eng 3-19</td>
</tr>
<tr>
<td>power fail indicators</td>
<td>Eng 3-21</td>
</tr>
<tr>
<td>processor</td>
<td>Eng 2-35</td>
</tr>
<tr>
<td>rear layout</td>
<td>Eng 2-7</td>
</tr>
<tr>
<td>reference description</td>
<td>Eng 1-4</td>
</tr>
<tr>
<td>support brackets</td>
<td>Eng 3-5</td>
</tr>
<tr>
<td>frame advance custom control</td>
<td>Eng 10-18, Eng 10-21</td>
</tr>
<tr>
<td>Frame Board, rear</td>
<td>Eng 4-22</td>
</tr>
<tr>
<td>Frame Boards</td>
<td>Eng 4-21</td>
</tr>
<tr>
<td>front</td>
<td>Eng 4-21</td>
</tr>
<tr>
<td>locations</td>
<td>Eng 4-18</td>
</tr>
<tr>
<td>Frame Connector Types</td>
<td>Eng 20-12</td>
</tr>
<tr>
<td>Frame CPU Board</td>
<td>Eng 2-12</td>
</tr>
<tr>
<td>Frame Diagnostics</td>
<td>Eng 17-28</td>
</tr>
<tr>
<td>DIP Switch Test</td>
<td>Eng 17-29</td>
</tr>
<tr>
<td>GPI Test</td>
<td>Eng 17-28</td>
</tr>
<tr>
<td>Graphics Buffer Test</td>
<td>Eng 17-30</td>
</tr>
<tr>
<td>LEDs Test</td>
<td>Eng 17-29</td>
</tr>
<tr>
<td>Tx/Rx Test</td>
<td>Eng 17-28</td>
</tr>
<tr>
<td>Frame Dimensions</td>
<td>Eng 20-6</td>
</tr>
<tr>
<td>Frame Door, opening/closing</td>
<td>Eng 3-3</td>
</tr>
<tr>
<td>Frame Fail Indicator</td>
<td>Eng 5-3, Eng 17-10</td>
</tr>
<tr>
<td>cooling fans</td>
<td>Eng 18-8</td>
</tr>
<tr>
<td>power supply</td>
<td>Eng 18-6</td>
</tr>
<tr>
<td>Frame Ports</td>
<td>Eng 20-19</td>
</tr>
<tr>
<td>AC power</td>
<td>Eng 20-19</td>
</tr>
<tr>
<td>GPI I/O</td>
<td>Eng 20-18</td>
</tr>
<tr>
<td>LAN</td>
<td>Eng 20-19</td>
</tr>
<tr>
<td>panel</td>
<td>Eng 20-17</td>
</tr>
<tr>
<td>peripheral</td>
<td>Eng 20-17</td>
</tr>
<tr>
<td>Frame Power Supplies</td>
<td>Eng 18-12</td>
</tr>
<tr>
<td>functional components</td>
<td>Eng 18-12</td>
</tr>
</tbody>
</table>
replacing ........................................ Eng 18-13
Frame Rates, using ................................ Eng 2-33
Frame Reverse Custom Control Eng 10-18, Eng 10-21
Frame Serial Ports .................................. Eng 9-2
Frame to Control Panel cabling .................. Eng 3-11
Frame, overview .................................. Eng 2-7
Frame/Control Panel cabling ..................... Eng 3-11
Frames ........................................... Eng 2-32
Frequency Extra Option ........................ Eng 9-25
Frequency, scan ................................ Eng 2-33
Front Frame Boards ................................ Eng 4-21
Full MLE ........................................ Eng 1-4
Full reset ........................................ Eng 4-24
Function buttons ................................ Eng 5-3
Function, System Information Page ........ Eng 6-7
Functional check ................................ Eng 4-17

G
General Specifications ............................ Eng 20-3
GfxBuffDDR Test, see Frame Diagnostics
Global Memory CC Recall, Personality setting ... Eng 11-5
Global Memory Module ........................ Eng 2-10
Global Memory Number Entry, Personality Eng 11-8
Global-Store
Auto key setup ................................ Eng 7-8
Enable Channel 4 ................................ Eng 11-8
Memory Recall Mode, Personality ... Eng 11-11
Global-Store 4 Mode, Personality .............. Eng 11-8
GNU General Public License ................... Eng 22-2
Go To Clip Custom Control ..................... Eng 10-21
Go To Cut Custom Controls .................... Eng 10-17
Go To End Custom Control ..................... Eng 10-18
Go To Menu Custom Control ................... Eng 10-22
Go To Start Custom Control ................... Eng 10-18
GP I/O port ........................................ Eng 2-19
GPI (CG) Custom Control ....................... Eng 10-17
GPI Custom Control .............................. Eng 10-21
GPI I/O ............................................ Eng 2-16
Aux Panel setup
CCU joystick control ....................... Eng 14-13
Aux Panels ........................................ Eng 14-11
Auxiliary Control Panel setup
programming GPI ........................ Eng 14-11
Remote Aux Panel setup
programming GPI ........................ Eng 14-12
GPI I/Os
Connections .................................... Eng 12-11
Information Menu ............................. Eng 12-10
Input BNC ...................................... Eng 7-24
Input GPI I/Os ................................ Eng 12-11
Memory Recall event ......................... Eng 12-11
Run Custom Control ......................... Eng 12-13
Tallies ......................................... Eng 12-14
Transition event ............................. Eng 12-12

Trigger Signal Polarity ..................... Eng 12-13
Output GPI I/Os ................................ Eng 12-15
Naming ....................................... Eng 12-16
Trigger Signal ........................ Eng 12-15
Ports ........................................ Eng 20-18
setup ........................................ Eng 12-10
Worksheet
Input ....................................... Eng 21-13
Output .................................... Eng 21-14
Grab a Timecode
Video Server ................................ Eng 12-20
Grab Positioner Custom Controls ................ Eng 10-20
Grey Input BNC .............................. Eng 7-4
Grouping Audio Channels ...................... Eng 12-23

H
Half MLE
reference description .......................... Eng 1-4
Half MLE, see Mix/DSK
Hard Drive
installing ...................................... Eng 18-16
Ribbon Cable Connector ....................... Eng 18-16
Hard Restart, switcher ...................... Eng 6-3, Eng 6-6
HD, definition ................................ Eng 1-5
Help
online manuals .............................. Eng 5-18
pop-up ......................................... Eng 5-18
Quick Navigation Button ................ Eng 5-10
HOLD button ................................. Eng 5-2
Hold CC Custom Control ................ Eng 10-23
Hold For Group Custom Control ................ Eng 10-23
Hold For Run Custom Control ............ Eng 10-23
Hold Quick Navigation Button ............. Eng 5-10
Hold, Store Mode ........................ Eng 11-14
HOME button ................................ Eng 5-2
Home Quick Navigation Button ........ Eng 5-10
Horizontal Scan Lines ...................... Eng 2-31

I
Icons
positioner ..................................... Eng 5-9
Status ......................................... Eng 17-12
ID, definition ................................ Eng 1-5
Imlib2 License ................................ Eng 22-11
In Flag Reset Custom Control .............. Eng 10-21
In Recall Custom Control ................ Eng 10-21
Include Aux ............................... Eng 16-2
In-Console, control panel installation ...... Eng 3-7
Indicators
frame power fail ........................... Eng 3-21
panel power fail ........................ Eng 3-21
Power Fail ................................ Eng 3-21
Information, Web Interface ................. Eng 6-7
Inpoint, Video Server Clip ................ Eng 12-18
Input BNCs
Alpha ......................................... Eng 7-6
Auto Key
setup ............................................Eng 7-8
Bus Map ............................................Eng 7-13
default mapping ....................................Eng 3-13
GPI Outputs .......................................Eng 7-24
gray ..................................................Eng 7-4
Non-Sync Detect ....................................Eng 7-10
Output BNC ............................................Eng 8-3
Tallies .............................................Eng 7-22
Type
Alpha ..................................................Eng 7-4
Char Gen ............................................Eng 7-5
External Still Store ................................Eng 7-4
Robotic Cam .......................................Eng 7-5
Router ...............................................Eng 7-4
Video ...............................................Eng 7-5
Video Formats ....................................Eng 7-5
Input GPI I/Os ......................................Eng 12-11
Setting up Memory Recall events ..............Eng 12-11
Setting up run custom control events .........Eng 12-13
Setting up transition events ......................Eng 12-12
Setting up trigger signal priority ..............Eng 12-13
Tallies .............................................Eng 12-14
Input Source Type
DVE ..................................................Eng 7-4
Input Sources Type
off ..................................................Eng 7-4
VTR ..................................................Eng 7-4
Input Verification ....................................Eng 4-16
Inputs, connection ................................Eng 3-13
Inputs, naming (video) .........................Eng 7-2
Inserting Custom Control Events
control panel ......................................Eng 10-30
special ..............................................Eng 10-31
Inserts, button ....................................Eng 3-17
Install Quick Navigation Button ..............Eng 5-10
Install serial numbers ............................Eng 6-11
Installation
control panel ......................................Eng 3-7
control panel power ................................Eng 3-19
control panel to frame .............................Eng 3-11
control panel touchscreen ......................Eng 3-8
control panel tub ..................................Eng 3-7, Eng 3-8
Defaulting ..........................................Eng 12-28
frame ...............................................Eng 3-5
frame power ........................................Eng 3-19
lock/unlock .........................................Eng 12-45
monitor ..............................................Eng 3-16
reference ............................................Eng 4-11
Registers ............................................Eng 13-2
serial numbers ....................................Eng 3-2
Installation Menu Status ......................Eng 4-10
Installed
frame boards, option boards ..................Eng 6-10
panel boards ......................................Eng 6-9
Installed Options ..................................Eng 6-9

Frame Boards ......................................Eng 6-10
Panel Boards .......................................Eng 6-9
Software Options .................................Eng 6-11
Installing
Button Insert Films ...............................Eng 3-17
FlexDevice Drivers ................................Eng 9-4, Eng 9-5
frame boards .....................................Eng 4-18
frame door ..........................................Eng 3-4
Hard Drive replacement .........................Eng 18-16
Remote Aux Panels ...............................Eng 14-5
serial numbers ....................................Eng 6-9
software options .................................Eng 6-11
Installing New Modules .........................Eng 17-5
Quick Module Configure .........................Eng 17-5
Single Module Configure .......................Eng 17-6
Interface, menu ....................................Eng 5-2
Interlaced ............................................Eng 2-31, Eng 2-32
Internal Panel Row Auxiliary Control Panels Eng 14-8
Internal reference ................................Eng 4-14
Internal Rows ......................................Eng 17-6
Internet Security ....................................Eng 4-8
IP Issues .............................................Eng 4-8
IP, default ..........................................Eng 20-8
Iris Control Extra Option .........................Eng 9-27
Iris Mode Extra Option ............................Eng 9-28
Iris Res Extra Option .............................Eng 9-28
Iris Speed Extra Option .........................Eng 9-28
Isolate MultiDSK ..................................Eng 11-8

J
Jiffy License ........................................Eng 22-12

K
K+B CUT, button ....................................Eng 7-15
K+B TRNS, button .................................Eng 7-15
Key 4 Mode
External ............................................Eng 12-8
Flexi .................................................Eng 12-8
Internal 1 ............................................Eng 12-8
Internal 2 ............................................Eng 12-8
Internal 3 ............................................Eng 12-8
Key Alpha
output BNC ..........................................Eng 8-4
Key Cut then Fade .................................Eng 11-9
Key Cut, button ....................................Eng 7-15
Key Frame Adv Custom Control .................Eng 10-18
Key Frame Rev Custom Control .................Eng 10-18
Key Trans, button ..................................Eng 7-15
Key Video
output BNC ..........................................Eng 8-4
Key, Auto ...........................................Eng 7-3
Keyboard installation .............................Eng 3-12
Keyboard port ......................................Eng 2-15
Keyer Module ......................................Eng 2-10
Keyer Rate
default ............................................Eng 11-5
Keyers
- Auto Follow .................................. Eng 12-42
- Key Cut then Fade ........................ Eng 11-9
- Swap Cut and Auto ...................... Eng 11-14
- Keypad Clip IDs Entry ....................... Eng 11-9
- Keypad DVE Num Entry ..................... Eng 11-9
- Keypad Still Num Entry ..................... Eng 11-9
- Keypad Wipe Num Entry .................... Eng 11-10

Keys
- check ........................................ Eng 7-25
- Clip and Gain ............................... Eng 7-26
- Key Memory ................................ Eng 7-26
- Keys Off Air (Automation) Custom Control Eng 10-19

Knobs
- selection ...................................... Eng 5-3

L
- Labelling boards .............................. Eng 2-37
- LAN Ports ........................................ Eng 20-19
  overview ...................................... Eng 2-16
- Large Audio Mixer option ............... Eng 6-12
- Layout
  - front frame ................................ Eng 2-8
  - rear frame .................................. Eng 2-7

Layouts
- MultiViewer ................................ Eng 8-15
  - edit ......................................... Eng 8-15
  - name ....................................... Eng 8-17
- Lens Type Extra Option .................... Eng 9-28
- Lesser GNU Public License ................ Eng 22-4
- Level Base Extra Option ................... Eng 9-29
- Levels
  - default levels ............................. Eng 12-22
- LGPL, see Lesser GNU Public License
- Limitations
  - custom device protocol ..................... Eng 23-2
  - Link and Node ................................ Eng 20-9
  - external links ................................ Eng 20-9
  - internal links ................................ Eng 20-9
- Load (CG) Custom Control .............. Eng 10-17, Eng 10-18
- Load Layout Custom Control .......... Eng 10-19
- Loading Color Schemes ..................... Eng 11-24
  - Locations, frame boards ................ Eng 4-18
  - Lock/Unlock Installation .............. Eng 12-45
  - Lock/Unlock Personality ............... Eng 11-25
  - Logs ........................................ Eng 17-38
- Look Ahead Preview
  - MLE ......................................... Eng 8-3
  - Loop CC Custom Controls ............... Eng 10-23
  - Looping Custom Controls ............ Eng 10-3
  - LoopMinLength Extra Option ........ Eng 9-30
  - LoopRecueTime Extra Option ........ Eng 9-30
  - Lower Display Region .................. Eng 5-3
  - LTC Timecode Specifications .......... Eng 20-15

M
- Macros, see Custom Controls

Main Area ...................................... Eng 5-7
- Main Area, menu ............................ Eng 5-7
- Maintenance .................................. Eng 18-1
  - control panel module ................... Eng 18-21
  - control panel power supplies ........ Eng 18-10
    - failure .................................. Eng 18-2
    - dusting ................................ Eng 18-25
  - frame fans
    - failure ................................ Eng 18-8
  - frame power supplies ................. Eng 18-12
    - failure ................................ Eng 18-6
- Hard Drive replacement ................. Eng 18-16
- Managing Custom Controls ............. Eng 10-32
- Managing Setups .......................... Eng 13-15
  - downloading ............................. Eng 13-15
  - uploading ................................ Eng 13-15
- Managing Web Interface Account .... Eng 6-2
- Manuals
  - online help ................................ Eng 5-18
  - Mapping
    - Control Panel ........................ Eng 17-5
    - Audio Control ........................... Eng 17-8
    - Custom Control ........................ Eng 17-7
    - Quick Module Configure ............ Eng 17-5
    - Single Module Configure .......... Eng 17-6
    - crosspoint buttons .................... Eng 7-13
- Master Panel
  - reference description ................ Eng 1-4
  - Master Ped Extra Option .............. Eng 9-28
  - Matrix, crosspoint ..................... Eng 2-20
- Matte Limit
  - Personality setting ..................... Eng 11-10
- Max Channels Extra Option ............ Eng 9-25
- MD DVE option ................................ Eng 6-12
- MD, definition ............................. Eng 1-5
- MediaIDLength Extra Option .......... Eng 9-30

Memories
- Defaulting ................................ Eng 12-28
- Recall
  - auto follow .............................. Eng 12-43
  - Recalling individual .................. Eng 13-11
  - Registers ................................ Eng 13-2
  - Store Mode Personality Setting ..... Eng 11-14
  - Storing individual ..................... Eng 13-6
- Memory Bank Cycle, Personality setting Eng 11-10
- Memory, Key ................................ Eng 7-26
- Menu
  - BNC type ................................ Eng 8-2
- Menu Locking
  - Installation ............................. Eng 12-45
  - Personality ................................ Eng 11-25
- Menu System ............................... Eng 5-5
  - Back button ............................. Eng 5-6
  - Copy Down button ...................... Eng 5-6
  - Copy Up button ......................... Eng 5-6
Forward button .......................Eng 5-6
main area ..................................Eng 5-7
menu title ..................................Eng 5-6
navigation area ..........................Eng 5-7
positioner icons ........................Eng 5-9
punchpad ..................................Eng 5-7
Quick Navigation buttons ..............Eng 5-10
screen capture ..........................Eng 5-19
selection area ............................Eng 5-6
Swap button ..............................Eng 5-6
Menu Title ................................Eng 5-6

Menus
Appearance ..............................Eng 5-12
Aux Bus Outputs .........................Eng 8-5
collection buttons ......................Eng 5-2
Function buttons .......................Eng 5-3
Hold button ..............................Eng 5-2
Home button .............................Eng 5-2
knobs .......................................Eng 5-3
lower display region ....................Eng 5-3
More button .............................Eng 5-3
on the touchscreen .....................Eng 5-2
Quick Navigation buttons ..............Eng 5-3, Eng 5-10
Quick Navigation More Button .........Eng 5-3
Skins ........................................Eng 5-12
System Power button ...................Eng 5-3
Up One button ...........................Eng 5-2
upper display region ....................Eng 5-3
Midplane .................................Eng 2-13
Mix/DSK ....................................Eng 8-19
operation .................................Eng 8-20
setup .......................................Eng 8-20, Eng 8-23, Eng 8-24
with MultiDSK .........................Eng 8-24
Mix/DSK option ........................Eng 6-12
Mixers Extra Option ....................Eng 9-25
MLE
Auto Follow .............................Eng 12-41
definition ...............................Eng 1-5
fade to black ............................Eng 8-9
Naming .....................................Eng 7-2
processor ...............................Eng 2-35
resetting .................................Eng 4-25
tally .......................................Eng 8-10
MLE Assignment .......................Eng 4-9
MLE MD option ........................Eng 6-12
MLE Rate
default .................................Eng 11-5
MLE Re-entry button .................Eng 7-14
MLE reset
all .......................................Eng 4-25
individual ...............................Eng 4-26
individual (1-4) .........................Eng 4-25
individual (5-8) .........................Eng 4-26
MLE SD option ........................Eng 6-12
MLE-Store
Auto key setup ........................Eng 7-8
Mnemonic Displays Appearance ....Eng 5-13
Mnemonics ..............................Eng 5-13
Mnemonics, default names ..............Eng 4-16
Modify bank name, custom control ....Eng 10-8
Modify Dynamic Text Custom Control Eng 10-19
Modify function name, custom control Eng 10-8
Modifying Custom Control Events ......Eng 10-8
Module Configuration ..................Eng 17-6
Audio Control ...........................Eng 17-8
Custom Control ........................Eng 17-7
Module Control Link Backbone ......Eng 20-9
external links ............................Eng 20-9
internal links ............................Eng 20-9

Modules
Control Panel CPU ......................Eng 2-10, Eng 20-24
Effects Memory .........................Eng 2-10
Global Memory ..........................Eng 2-10
Keyer Module ............................Eng 2-10
Panel Communications Hub ..........Eng 2-10
Panel Communications Hub (PCH) ....Eng 20-24
Panel Module Controller ..........Eng 2-10
Positioner ...............................Eng 2-11
Preview Bus ..............................Eng 2-11
Replacing ..............................Eng 18-21
installing ...............................Eng 18-22
removing ...............................Eng 18-21
Transition ..............................Eng 2-11
Monitor Connection .....................Eng 3-16
Monitor Wall option ....................Eng 6-12
MORE button ............................Eng 5-3
Mounting Arm (Touchscreen) .......Eng 3-9
Mouse installation .....................Eng 3-12
Mouse port ..............................Eng 2-15
Mouse Sensitivity, setting ..........Eng 11-10
Moving Custom Controls ..........Eng 10-32
Moving Shot Box Pages ..............Eng 15-4
MultiDSK ...............................Eng 8-22
isolate .................................Eng 11-8
option .................................Eng 6-12
setup .................................Eng 8-23, Eng 8-25
with Mix/DSK .........................Eng 8-24
MultiDSK 5 and 6 .......................Eng 8-22
MultiDSK Key Alpha
output BNC ..............................Eng 8-4
MultiDSK Key Video
output BNC ..............................Eng 8-4
MultiPanel
MLE Assignment .......................Eng 4-9
Setup .................................Eng 4-9
System Permissions ....................Eng 4-10
Multiple Custom Controls ..........Eng 10-3, Eng 11-10
running ...............................Eng 10-13
MultiViewer .........................Eng 8-14, Eng 13-5, Eng 13-10
Assignment ............................Eng 8-14
defaulting ............................Eng 12-29
Layouts .................................Eng 8-15
edit .................................Eng 8-15
name .................................Eng 8-17
### Vision Engineering Manual (v18.0 MD) Index

<table>
<thead>
<tr>
<th>Option Codes</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>OV-RAM</td>
<td></td>
</tr>
<tr>
<td>OD Master Extra Option</td>
<td>Eng 9-25</td>
</tr>
<tr>
<td>Off, Input Source Type</td>
<td>Eng 7-4</td>
</tr>
<tr>
<td>Online Manuals</td>
<td>Eng 5-18</td>
</tr>
<tr>
<td>Operating Environment, frame</td>
<td>Eng 3-5</td>
</tr>
<tr>
<td>Operating Environment, frame</td>
<td>Eng 3-5</td>
</tr>
<tr>
<td>Operator</td>
<td></td>
</tr>
<tr>
<td>reference description</td>
<td>Eng 1-4</td>
</tr>
<tr>
<td>Option</td>
<td></td>
</tr>
<tr>
<td>Mix/DSK</td>
<td>Eng 8-19</td>
</tr>
<tr>
<td>Mix/MultiDSK</td>
<td>Eng 8-24</td>
</tr>
<tr>
<td>Option Codes</td>
<td></td>
</tr>
<tr>
<td>recalling</td>
<td>Eng 6-15</td>
</tr>
<tr>
<td>NetExp</td>
<td></td>
</tr>
<tr>
<td>cabling</td>
<td>Eng 9-14</td>
</tr>
<tr>
<td>Network Address, default</td>
<td>Eng 20-8</td>
</tr>
<tr>
<td>Network Security</td>
<td>Eng 4-8</td>
</tr>
<tr>
<td>Network Setup</td>
<td>Eng 4-5</td>
</tr>
<tr>
<td>Next Custom Control</td>
<td>Eng 10-21</td>
</tr>
<tr>
<td>Next Quick Navigation Button</td>
<td>Eng 5-10</td>
</tr>
<tr>
<td>Non-Sync Detect</td>
<td>Eng 7-10</td>
</tr>
<tr>
<td>Non-Sync Status</td>
<td>Eng 17-16</td>
</tr>
<tr>
<td>Notify End CC Custom Control</td>
<td>Eng 10-23</td>
</tr>
<tr>
<td>NPlay Retries Extra Option</td>
<td>Eng 9-31</td>
</tr>
<tr>
<td>NTP Server Time</td>
<td>Eng 12-38</td>
</tr>
<tr>
<td>Num Levels Extra Option</td>
<td>Eng 9-29</td>
</tr>
<tr>
<td>NV-RAM</td>
<td></td>
</tr>
<tr>
<td>Defaulting</td>
<td>Eng 12-28</td>
</tr>
</tbody>
</table>

| Options                     |       |
| codes, deleting             | Eng 6-14 |
| codes, store and recall     | Eng 6-14 |
| custom control banks, enable| Eng 10-7 |
| installed                   | Eng 6-9 |
| installed panel boards      | Eng 6-9 |
| Output BNCs                 |       |
| Aux Bus                     | Eng 8-2 |
| Aux Monitor                 | Eng 8-3 |
| Clean Feed                  | Eng 8-3 |
| clean feed                  | Eng 8-7 |
| Clean Feed, MLE             | Eng 8-3 |
| default mapping             | Eng 3-15 |
| Input BNC                   | Eng 8-3 |
| Key Alpha, MLE              | Eng 8-4 |
| Key Video, MLE              | Eng 8-4 |
| Look Ahead Preview, MLE     | Eng 8-3 |
| MultiDSK Key Alpha, MLE     | Eng 8-4 |
| MultiDSK Key Video, MLE     | Eng 8-4 |
| MultiViewer                 | Eng 8-3 |
| Preview, main               | Eng 8-3 |
| Preview, MLE                | Eng 8-3, Eng 8-4 |
| Program, main               | Eng 8-3 |
| Program, MLE                | Eng 8-3, Eng 8-4 |
| verification                | Eng 8-5 |
| Output Boards Functionality  | Eng 2-35 |
| Output Connections          | Eng 3-15 |
| Output GPI I/Os             | Eng 12-15 |
| Naming                      | Eng 12-16 |
| Setting up trigger signals  | Eng 12-15 |

| OverDrive                   |       |
| relative custom controls    | Eng 10-11 |
| Overlay, Preview            | Eng 12-30 |
| Over-Temperature Shutdown, Frame | Eng 12-44 |
| Overview                    |       |
| Equipment                   | Eng 2-2 |
| Video Formats               | Eng 2-31 |

| Pages, Shot Box             |       |
| copying                     | Eng 15-4 |
| creating                    | Eng 15-3 |
| moving                      | Eng 15-4 |
| naming                      | Eng 15-4 |
| Pan/Tilt Damping Extra Option | Eng 9-28 |
| Pan/Tilt Speed Extra Option  | Eng 9-28 |
| PANEL                       | Eng 2-16 |
| Panel Boards Menu           | Eng 6-9 |
| Panel buttons               |       |
| assign black                | Eng 7-14 |
| assign color background     | Eng 7-14 |
| BKGDCUT                     | Eng 7-15 |
| BKGDTRNS                    | Eng 7-15 |
| Bus Hold                    | Eng 7-15 |
| Global-Store                | Eng 7-14 |
| K+B CUT                     | Eng 7-15 |

| N                          |       |
| Name MultiViewer Layout    | Eng 8-17 |
| Names, mnemonic default   | Eng 6-16 |
| Naming Bus Maps            | Eng 7-21 |
| Naming Custom Control Banks | Eng 10-8 |
| Naming Custom Control Buttons | Eng 10-28 |
| Naming control functions  | Eng 10-8 |
| Naming External Rows       | Eng 17-8 |
| Naming Menus               | Eng 5-17 |
| Naming Output GPI I/Os     | Eng 12-16 |
| Naming Shot Box Pages      | Eng 15-4 |
| Naming video inputs        | Eng 7-2 |
| Navigation Area            | Eng 5-7 |
| Navigation Area, menu      | Eng 5-7 |
| Net Expander               |       |
| communications settings    | Eng 9-18 |

| Options                     |       |
| codes, deleting             | Eng 6-14 |
| codes, store and recall     | Eng 6-14 |
| custom control banks, enable| Eng 10-7 |
| installed                   | Eng 6-9 |
| installed panel boards      | Eng 6-9 |

| Output BNCs                 |       |
| Aux Bus                     | Eng 8-2 |
| Aux Monitor                 | Eng 8-3 |
| Clean Feed                  | Eng 8-3 |
| clean feed                  | Eng 8-7 |
| Clean Feed, MLE             | Eng 8-3 |
| default mapping             | Eng 3-15 |
| Input BNC                   | Eng 8-3 |
| Key Alpha, MLE              | Eng 8-4 |
| Key Video, MLE              | Eng 8-4 |
| Look Ahead Preview, MLE     | Eng 8-3 |
| MultiDSK Key Alpha, MLE     | Eng 8-4 |
| MultiDSK Key Video, MLE     | Eng 8-4 |
| MultiViewer                 | Eng 8-3 |
| Preview, main               | Eng 8-3 |
| Preview, MLE                | Eng 8-3, Eng 8-4 |
| Program, main               | Eng 8-3 |
| Program, MLE                | Eng 8-3, Eng 8-4 |
| verification                | Eng 8-5 |

| OverDrive                   |       |
| relative custom controls    | Eng 10-11 |
| Overlay, Preview            | Eng 12-30 |
| Over-Temperature Shutdown, Frame | Eng 12-44 |

| Overview                    |       |
| Equipment                   | Eng 2-2 |
| Video Formats               | Eng 2-31 |

| O                          |       |
| OD Master Extra Option     | Eng 9-25 |
| Off, Input Source Type     | Eng 7-4 |
| Online Manuals             | Eng 5-18 |
| Opening/Closing the frame door, QMD/X | Eng 3-3 |
| Operating Environment Requirements | Eng 20-5 |
| Operating Environment, frame | Eng 3-5 |
| Operator                   |       |
| reference description      | Eng 1-4 |
| Option                     |       |
| Mix/DSK                    | Eng 8-19 |
| Mix/MultiDSK               | Eng 8-24 |
| Option Codes               |       |
| recalling                  | Eng 6-15 |
K+B TRNS ...........................................Eng 7-15
Key Cut ...........................................Eng 7-15
Key Trans ...........................................Eng 7-15
MLE re-entry ......................................Eng 7-14
MLE-Store ..........................................Eng 7-14
MV ....................................................Eng 7-15
Shift ..................................................Eng 7-14
Panel Communications Hub ...........Eng 20-24
Panel Communications Hub (PCH) ....Eng 20-24
Panel Extra Option ............................Eng 9-30
Panel Fail Indicator ............................Eng 5-3, Eng 17-10
Panel ID Extra Option ........................Eng 9-28
Panel Module Controller .....................Eng 2-10
Panel Port ............................................Eng 20-17
Panel port on frame .........................Eng 3-11
Panel Rows
  External .........................................Eng 17-6
  Internal ..........................................Eng 17-6
Panel Serial Ports .............................Eng 9-2
Panel Sleep Time, Personality setting ......Eng 11-11
Parallel Tallies Overview ........................Eng 2-18
Pattern Extra Option ............................Eng 9-27
Pause Audio Server Custom Controls ......Eng 10-17
Pause CC Custom Control .......................Eng 10-23
Pause Custom Controls
  modify ............................................Eng 10-30
Pause DVE Custom Control ......................Eng 10-18
Pause VTR Custom Control .......................Eng 10-22
Pause/Hold Custom Control Shortcut ........Eng 10-34
Pbus
  custom control functions ....................Eng 10-2
  option ............................................Eng 6-12
Pbus Memory .........................................Eng 11-11
PCH, see Panel Communications Hub
Percent Used, storage capacity ..............Eng 6-8
Peripheral Bus II option .........................Eng 6-12
Peripheral Ports .................................Eng 2-16, Eng 20-17
Personality ..........................................Eng 11-2
Assign MLE .........................................Eng 11-3
Audio Cut Only .....................................Eng 11-3
Audio Transitions ................................Eng 11-3
Auto Follow
  Custom Controls ................................Eng 12-40
  Editors ..........................................Eng 12-40
  Panel .............................................Eng 12-40
Auto Key Alpha ....................................Eng 11-3
Auto Recall .........................................Eng 11-3
Auto Remove Key ..................................Eng 11-4
Bank 0 Lit ..........................................Eng 11-4
BKGD Double-Press ...............................Eng 11-4
Camera Grab Time ................................Eng 11-4
CC Global Recall ..................................Eng 11-5
CC/Macro Attachments .........................Eng 11-4
Clear Bus Hold .....................................Eng 11-5
Default Trans Rate
  Active ............................................Eng 11-5
  Eff Dissolve .....................................Eng 11-5
FTB ..................................................Eng 11-5
Keyer ...............................................Eng 11-5
MLE ..................................................Eng 11-5
Sequence ..........................................Eng 11-5
Defaulting .........................................Eng 12-27
Double-Press Rate ..............................Eng 11-6
DSK Auto Cut ......................................Eng 11-6
Editor Pattern Codes ............................Eng 11-7
Editor Trans Rate ................................Eng 11-7
Execute Camera Move on Trans .............Eng 11-7
FTB Display Mode .................................Eng 11-8, Eng 16-7
Global Memory Number Entry ...............Eng 11-8
Global-Store 4 Mode .............................Eng 11-8
Isolate MultiDSKs ................................Eng 11-8
Key Cut then Fade ................................Eng 11-9
Keypad Clip IDs Entry ............................Eng 11-9
Keypad DVE Num Entry ............................Eng 11-9
Keypad Still Num Entry ...........................Eng 11-9
Keypad Wipe Num Entry ...........................Eng 11-10
lock/unlock .........................................Eng 11-25
Matte Limit ........................................Eng 11-10
Memory Bank Cycle ..............................Eng 11-10
Mnemonics appearance ........................Eng 5-13
Mouse Sensitivity ................................Eng 11-10
Multiple Custom Controls ......................Eng 11-10
Panel Sleep Time ....................................Eng 11-11
Pbus Memory .........................................Eng 11-11
Quick Bank Select ................................Eng 11-11
Quick Navigation Button .......................Eng 5-10
Recall Global-Store Memory Mode ..........Eng 11-11
Recall MLE-Store Memory Mode ..............Eng 11-12
Recall WhiteFlash .................................Eng 11-12
Re-entry Depth .....................................Eng 11-12
Re-entry Loops .....................................Eng 11-12
Roll Clip Mode .....................................Eng 11-13
Roll Clip On-Air Only ............................Eng 11-13
Shift Locking .......................................Eng 11-13
Show CC’s on Key Bus ............................Eng 11-13
Show Last CC Pressed ............................Eng 11-14
Show Last Mem Recalled ........................Eng 11-14
Squeeze & Tease Mode ............................Eng 12-6
Store Mode .........................................Eng 11-14
Swap Keyers Cut and Auto ......................Eng 11-14
Swap Program and Preset .......................Eng 11-14
Swap Trans, Cut and Auto .........................Eng 11-15
Time Clock Source ................................Eng 11-15
Time Clock UMD Number ........................Eng 11-15
UltraChrome
  default color ......................................Eng 11-15
  default edge width ..............................Eng 11-15
  default mode ....................................Eng 11-15
  VTR POL On-air Display .........................Eng 11-15
  VTR POL Prep’d Display .........................Eng 11-16
Wake Up On Command .............................Eng 11-8, Eng 11-16
Personality Registers .............................Eng 13-2
PGM
  definition .........................................Eng 1-5
overlay option ............................................Eng 10-2
Preview Bus Module .....................................Eng 2-11
Preview CC (Overdrive) Custom Control ........Eng 10-19
Preview output
main ..................................................Eng 8-3
Preview output, main ..................................Eng 8-3
Preview Overlay ..................................Eng 12-30
    Center setup ..................................Eng 12-34
    font color ......................................Eng 12-30
    Safe Title setup ................................Eng 12-33
    Safe Title, naming .............................Eng 12-34
    Source ID setup ................................Eng 12-32
    Time Clock
        Count Direction ............................Eng 12-36
        Position .....................................Eng 12-35
        Reset on Transition ......................Eng 12-35
        Reset/Start Time ..........................Eng 12-36
    setup ............................................Eng 12-35
    VTR Timecode setup .............................Eng 12-32
Preview Overlay output ................................Eng 8-3
Proc Amps option ....................................Eng 6-13
Processor
    frame ............................................Eng 2-35
    Video ............................................Eng 2-35
Processor, Video ................................Eng 2-24, Eng 2-26
Program
    output BNC .....................................Eng 8-4
Program output
main ..................................................Eng 8-3
MLE ....................................................Eng 8-3
Programming BSS4 ....................................Eng 9-17
Programming Control DeviceMaster ...............Eng 9-17
Programming control panel functions ..........Eng 10-10
Progressive Scan ....................................Eng 2-31, Eng 2-32
Progressive Segmented Frames ....................Eng 2-33
Protocol Extra Option ................................Eng 9-28
PS/2 port ............................................Eng 2-15
PS/2 ports ............................................Eng 3-12
PST Audio Level Custom Controls .................Eng 10-17
PST PATT, definition ................................Eng 1-5
PST, definition ......................................Eng 1-5
Punchpad .............................................Eng 5-7
PV, definition ......................................Eng 1-5

Q
QMD/X
    4-Keyers option .....................................Eng 2-2
Query Cmd Extra Option ................................Eng 9-27
Quick Bank Select Personality ....................Eng 11-11
Quick Module Configuration ......................Eng 17-5
Quick Navigation ....................................Eng 5-10
    Aux Bus .........................................Eng 5-10, Eng 5-11
    Color Scheme .....................................Eng 5-10
    Custom Controls ................................Eng 5-11
    Diagnostics .....................................Eng 5-10
    DVE ..............................................Eng 5-11
    Help ..............................................Eng 5-10
Hold ..................................................Eng 5-10
Home ..............................................Eng 5-10
Install ...............................................Eng 5-10
Next ...............................................Eng 5-10
Pers .................................................Eng 5-10
Quick Navigation buttons ............................Eng 5-3
More ....................................................Eng 5-3

R
Rate Extra Option ....................................Eng 9-29
Rates, Effects Dissolve
    default ........................................Eng 11-5
Recall........Time Extra Option ....................Eng 9-28
Read (CG) Custom Control .........................Eng 10-18
Read Custom Control ................................Eng 10-21
Rear connectors, frame ................................Eng 2-7
Rear Frame Boards ....................................Eng 4-22
Recall
    all ..............................................Eng 13-10
    bus maps ........................................Eng 13-10
    cameras ..........................................Eng 13-10
    CC variables ....................................Eng 13-10
    cc/macro attachments ........................Eng 13-10
    custom controls ................................Eng 13-10
    Factory Defaults ................................Eng 12-27
    individual Bus Maps ...........................Eng 13-12
    individual custom control .....................Eng 13-12
    Individual Items ................................Eng 13-11
    individual memories ............................Eng 13-11
    individual MultiViewer Layouts ............Eng 13-13
    individual S&T Sequences .....................Eng 13-12
    individual Shot Box Pages ....................Eng 13-13
    installation .....................................Eng 13-10
    memories .........................................Eng 13-10
    multiviewer assignment .......................Eng 13-10
    multiviewer layouts ............................Eng 13-10
    option codes ....................................Eng 6-14
    personality ......................................Eng 13-10
    Register Types ..................................Eng 13-9
    shot box pages ..................................Eng 13-10
    squeeze & tease sequences ....................Eng 13-10
    VTR clips ........................................Eng 13-10
Recall (CG) Custom Control .........................Eng 10-18
Recall DVE Custom Control .........................Eng 10-18
Recall Memories
    Auto Follow ......................................Eng 12-43
Recall MLE-Store
    Memory Recall Mode, Personality ...............Eng 11-12
Recall Pbus Custom Control .........................Eng 10-19
Recall Shot Custom Controls .......................Eng 10-20
    recall variables .....................................Eng 13-10
    recalling assignments from disk .............Eng 13-10
    recalling from disk ................................Eng 13-10
    recalling layouts from disk ..................Eng 13-10
    Recalling Option Codes ........................Eng 6-15
    Record Custom Control ........................Eng 10-22
    Record Custom Control Shortcut ..............Eng 10-34
Remote audio mixer control

- Related publications
- Eng 1-6
- Relative Custom Controls
- Eng 10-11
- Remaining storage capacity
- Eng 10-11
- Remote audio mixer control
- Eng 12-21

Reference
- Composite
- Eng 4-11
- connection
- Eng 4-11
- Input BNCs reset
- Eng 4-13
- Internal
- Eng 4-14
- Output BNCs reset
- Eng 4-13
- setting
- Eng 4-11
- Tri-Level Sync
- Eng 4-11

Reference Description
- Bottom MLE
- Eng 1-4
- Control Panel
- Eng 1-4
- Frame
- Eng 1-4
- Full MLE
- Eng 1-4
- Half MLE
- Eng 1-4
- Master Panel
- Eng 1-4
- Operator
- Eng 1-4
- Satellite Panel
- Eng 1-4
- SDI
- Eng 1-4
- Setup
- Eng 1-4
- Storage Device
- Eng 1-4
- Switcher
- Eng 1-4
- User
- Eng 1-4
- Video System
- Eng 1-4

Registers
- Bus Maps
- Eng 12-28, Eng 13-3
- Camera
- Eng 13-3
- Camera File
- Eng 12-28
- Clip
- Eng 13-2
- Clips
- Eng 12-28
- Custom Control Attachment
- Eng 12-28
- Custom Control Attachments
- Eng 13-3
- Custom Controls
- Eng 12-28, Eng 13-2
- Installation
- Eng 12-28, Eng 13-2
- Memory
- Eng 12-28, Eng 13-2
- MultiViewer Assignment
- Eng 12-29, Eng 13-3
- MultiViewer Layout
- Eng 12-29, Eng 13-3
- NV-RAM
- Eng 12-28
- Personality
- Eng 12-27, Eng 13-2
- Shot Box Pages
- Eng 12-28, Eng 13-3
- Squeeze & Tease
- Eng 12-28, Eng 13-3
- Switcher
- Eng 12-28

Related publications
- Eng 1-6
- Relative Custom Controls
- Eng 10-11
- Remaining storage capacity
- Eng 10-11
- Remote audio mixer control
- Eng 12-21

source assignment
- Eng 12-21

Remote Aux Panel GPI I/O
- programming GPI
- Eng 14-12
- Remote Aux Panels
- Eng 14-3
- cabling
- Eng 14-7
- com setup
- Eng 14-8
- communications connections
- Eng 14-6
- GPs
- Eng 14-11
- installing
- Eng 14-5
- Remote Control Port
- Eng 2-16
- Remote Ports
- Eng 20-21
- Removing Button Cap Assembly
- Eng 3-17
- Removing frame boards
- Eng 4-18
- Removing the frame door, MD/X
- Eng 3-4
- Replace Custom Control
- Eng 10-26
- Replacing a Control Panel Module
- Eng 18-21
- installing
- Eng 18-22
- removing
- Eng 18-21
- Replacing a Power Supply, Panel
- Eng 18-4
- Request TC Extra Option
- Eng 9-31
- Resave Last Custom Controls
- Eng 10-20

Reset
- All MLEs
- Eng 4-25
- Individual MLE
- Eng 4-26
- Individual MLEs (1-4)
- Eng 4-25
- Individual MLEs (5-8)
- Eng 4-26
- software
- Eng 4-25
- system
- Eng 4-24
- Reset Audio Custom Controls
- Eng 10-17
- Reset Fader Custom Controls
- Eng 10-15
- Reset GPI Custom Control
- Eng 10-18
- Reset Input BNCs Format
- Eng 4-13
- Reset Output BNCs Format
- Eng 4-13
- Reset Time Clock Custom Control
- Eng 10-22
- Reset, full
- Eng 4-24
- Resetting individual MLEs
- Eng 4-25

Restart
- control panel
- Eng 4-24
- switcher
- Eng 4-24
- Resume Custom Control
- Eng 10-21
- Rewind Custom Control
- Eng 10-22
- Rewind DVE Custom Control
- Eng 10-18
- RGB Color Corrector option
- Eng 6-13
- Ribbon Cable Connector
- Eng 18-16
- Robotic Cam, Input BNC Type
- Eng 7-5
- Robotic Cameras

- Registers
- Eng 13-3
- Robotic System option
- Eng 6-13
- Roll Clip Mode, selecting
- Eng 11-13
- Roll Clip On-Air Only, selecting
- Eng 11-13
- Roll GPO
- Eng 7-24

RossTalk
- ClearAllFB Custom Control
- Eng 10-21
- ClearFB Custom Control
- Eng 10-20, Eng 10-21
- Down Custom Control
- Eng 10-21
- Focus Custom Control
- Eng 10-21
- GPI Custom Control
- Eng 10-21
Pause/Hold ............................................. Eng 10-34
Record ................................................ Eng 10-34
Run A-Z ............................................... Eng 10-35
Run Held ............................................. Eng 10-34
Run Held X ......................................... Eng 10-34
Stop CC ............................................... Eng 10-35
Stop Held X ..................................... Eng 10-35
Shot Box
Shot Box Module ......................... Eng 10-6, Eng 15-2
Soft Shot Box ................................ Eng 10-5
Shot Box Modules ................................ Eng 15-1
pages ................................................... Eng 15-3
copying ................................................. Eng 15-4
moving ................................................... Eng 15-4
naming ................................................... Eng 15-4
setup .................................................... Eng 15-2
Shot Box Pages
Defaulting ........................................... Eng 12-28
Recalling individual ......................... Eng 13-13
Registers .............................................. Eng 13-3
Storing individual ..................... Eng 13-8
ShotOff Extra Option ......................... Eng 9-29
Show CC’S on Key Bus, Personality setting Eng 11-13
Show Last CC Pressed, Personality setting Eng 11-14
Show Last Mem Recalled, Personality setting ..... Eng 11-14
Show on Preview Extra Option .......... Eng 9-26
Simulate GPI Custom Control ........... Eng 10-19
Skins ................................................... Eng 5-12
Slot 1 Extra Option .......................... Eng 9-29
Slot, System Information Page ........ Eng 6-7
Small Audio Mixer option ............. Eng 6-13
SmartConversion option ............. Eng 6-13
SmartConversion ......................... Eng 16-1
Soft key labels ................................ Eng 1-3
Software
options, installing ........................... Eng 6-11
reset .................................................... Eng 4-25
upgrade procedure ........................ Eng 6-3
Software Licenses
Apache License ................................ Eng 22-8
BSD License ................................ Eng 22-7
Expat License ................................ Eng 22-10
GNU General Public License .......... Eng 22-2
Imlib2 .............................................. Eng 22-11
Jiffy ................................................ Eng 22-12
Lesser GNU Public License ........... Eng 22-4
Software Options
Audio Server Control .................. Eng 6-12
AuxKeys ............................................ Eng 6-12
Character Generator .................. Eng 6-12
DVE Send and Remote Control ........ Eng 6-12
Editor Interface ................................. Eng 6-12
Extra Half MLE ................................. Eng 6-12
Large Audio Mixer ......................... Eng 6-12
MD DVE ............................................ Eng 6-12
Mix/DSK ............................................ Eng 6-12
MLEs in MD Mode ......................... Eng 6-12
MLEs in SD mode ........................ Eng 6-12
Monitor Wall ................................ Eng 6-12
MultiDSK ........................................ Eng 6-12
MultiViewer ................................ Eng 6-12
Peripheral Bus II ......................... Eng 6-12
Proc Amps ................................ Eng 6-13
RGB Color Corrector ................ Eng 6-13
Robotic System ............................ Eng 6-13
Router ........................................ Eng 6-13
SD DVE ........................................ Eng 6-13
Serial Tally ..................................... Eng 6-13
Small Audio Mixer ..................... Eng 6-13
SmartTally ................................ Eng 6-13
Still Store, external ..................... Eng 6-13
VideoConversion ................................ Eng 6-13
VTR Remote Control ..................... Eng 6-13
Software Ver Extra Option .......... Eng 9-26
Software Version ......................... Eng 17-2
Source ........................................ Eng 7-3
Names ........................................ Eng 7-2
Physical BNC ................................ Eng 7-3
Setup
input types ................................ Eng 7-4
Tally ........................................ Eng 7-3
Type ........................................ Eng 7-3
Video Mode ................................ Eng 7-3
Source ID, Preview Overlay Setup .... Eng 12-32
Source Name Extra Option ........ Eng 9-29
Special
custom control Functions ................ Eng 10-15
custom control functions ................ Eng 10-2
Specifications ................................ Eng 20-1
Button Insert Films ...................... Eng 3-17
control panel dimensions .............. Eng 20-6
frame dimensions ......................... Eng 20-6
general ................................ Eng 20-3
LTC timecode ................................ Eng 20-15
operating environment ............... Eng 20-5
power consumption
control panel ................................ Eng 20-3
frame ........................................ Eng 20-4
power supplies
control panel ................................ Eng 20-3
frame ........................................ Eng 20-4
standard components ................ Eng 20-2
timing ........................................ Eng 20-15
video formats ................................. Eng 20-14
Video Input Signal ................. Eng 20-15
Video Input Signal Characteristics .... Eng 20-16
video processing ......................... Eng 20-14
Squeeze & Tease
Defaulting ................................ Eng 12-28
Mode, Personality setting .............. Eng 12-6
Registers ................................... Eng 13-3
Squeeze & Tease Carrier ........ Eng 2-13
Squeeze & Tease Carrier Board, overview .Eng 2-27,
DSK Auto Cut ........................................ Eng 11-6
Editor Pattern Codes ................................ Eng 11-7
Editor Trans Rate .................................... Eng 11-7
Execute Camera Move on Trans .................. Eng 11-7
FTB Display Mode ................................... Eng 11-8, Eng 16-7
Global Memory Number Entry .................... Eng 11-8
Global-Store 4 Mode ................................ Eng 11-8
Isolate MultiDSKs .................................... Eng 11-8
Key Cut then Fade ................................... Eng 11-9
Keypad Clip IDs Entry ................................ Eng 11-9
Keypad DVE Num Entry .............................. Eng 11-9
Keypad Still Num Entry ............................. Eng 11-9
Keypad Wipe Num Entry ............................. Eng 11-10
lock/unlock .......................................... Eng 11-25
Matte Limit ........................................ Eng 11-10
Memory Bank Cycle ................................... Eng 11-10
Mouse Sensitivity .................................... Eng 11-10
Panel Sleep Time .................................... Eng 11-11
Pbus Memory .......................................... Eng 11-11
Quick Bank Select ................................... Eng 11-11
Recall Global-Store Memory Mode ............. Eng 11-11
Recall MLE-Store Memory Mode ............... Eng 11-12
Recall WhiteFlash ................................... Eng 11-12
Re-entry Depth ....................................... Eng 11-12
Re-entry Loops ...................................... Eng 11-12
Roll Clip Mode ....................................... Eng 11-13
Roll Clip On-Air Only ............................... Eng 11-13
Shift Locking ......................................... Eng 11-13
Show CC’s on Key Bus .............................. Eng 11-13
Show Last CC Pressed ............................... Eng 11-14
Show Last Mem Recalled ........................... Eng 11-14
Squeeze & Tease Mode .............................. Eng 12-6
Store Mode ........................................... Eng 11-14
Swap Trans Cut & Auto ............................ Eng 11-15
Time Clock Source ................................... Eng 11-15
Time Clock UMD Number .......................... Eng 11-15
UltraChrome
  default color ..................................... Eng 11-15
  default edge width .............................. Eng 11-15
  default mode .................................... Eng 11-15
Switcer Power Down ................................ Eng 4-3
Switcer Reference Setup ........................... Eng 4-11
Switcer Restart ....................................... Eng 4-24
Switcer Status ....................................... Eng 17-10
Communication ...................................... Eng 17-14
Status ............................................. Eng 17-14
Complete Status .................................... Eng 17-10
Non-Sync ........................................ Eng 17-16
Version Information ................................ Eng 17-2
Vision OS ........................................ Eng 6-9
Warnings ........................................ Eng 17-11
Switcher, hard restart ............................. Eng 6-3, Eng 6-9
Switches
  control panel configuration ...................... Eng 20-25
  frame configuration ............................. Eng 20-8, Eng 20-9
System
  functional check ................................ Eng 4-17
  reset ............................................. Eng 4-24
turn on power ..................................... Eng 4-24
System Architecture ................................ Eng 2-1
System Cards
  XFX Extra Effects ................................ Eng 2-29
System Information Page ......................... Eng 6-7
card ............................................. Eng 6-7
date ............................................. Eng 6-8
function ......................................... Eng 6-8
slot ............................................. Eng 6-7
status ........................................... Eng 6-8
version .......................................... Eng 6-8
System Permissions ................................ Eng 4-10
System Power button .............................. Eng 5-3
System Time/Date
  setting automatically ......................... Eng 12-38
  setting manually ................................ Eng 12-37

T
Take & Prepare (OverDrive) Custom Control .... Eng 10-19
Take Custom Control ............................... Eng 10-20
Take Out (CG) Custom Control .................... Eng 10-18
Take XPT Custom Control ........................ Eng 10-21
Take, Custom Control ............................. Eng 10-18
Tallies
  GPI I/O Inputs ................................... Eng 12-14
  Input BNC ....................................... Eng 7-22
  MLE ........................................... Eng 8-10
  Ports .......................................... Eng 2-18
  Sources ....................................... Eng 7-3
  TargetMachine Extra Option ................... Eng 9-31
  TD, definition ................................ Eng 1-5
  Technical support .............................. Eng 1-7
Time Clock
  Count Direction ................................. Eng 12-36
  custom control functions .................... Eng 10-2
  Position ...................................... Eng 12-35
  Preview Overlay Setup ......................... Eng 12-35
  Reset on Transition ........................... Eng 12-35
  Reset/Start Time ............................. Eng 12-36
  Time Clock Source, Personality ............. Eng 11-15
  Time Clock UMD Number, Personality .... Eng 11-15
  Time Code Input Overview ..................... Eng 2-16
Time/Date
  setting automatically ......................... Eng 12-38
  setting manually ................................ Eng 12-37
  TimeOut Extra Option ......................... Eng 9-31
  Timeout Extra Option ........................ Eng 9-26
  Timing Specifications ......................... Eng 20-15
  Title, menu ................................... Eng 5-6
  Total storage capacity ........................ Eng 6-8
  Touchscreen
    lower display region ......................... Eng 5-3
    power button ................................ Eng 5-3
    upper display region ....................... Eng 5-3
    Touchscreen Calibration ..................... Eng 17-4
Touchscreen Display ........................................ Eng 2-7
adjusting ..................................................... Eng 5-4
Touchscreen Display port ................................ Eng 2-15
Touchscreen installation .................................... Eng 3-8
Touchscreen interface ........................................ Eng 5-2
Transition (OverDrive) Custom Control .............. Eng 10-19
Transition Keys Custom Control ....................... Eng 10-23
Transition Module .......................................... Eng 2-11
Auto Follow ................................................ Eng 12-42
Transport Commands ........................................ Eng 10-36
Trigger GPI Custom Control ............................. Eng 10-19
Trigger Pbus Custom Control ............................ Eng 10-20
TxRx Errors ................................................ Eng 17-14
Type, Source .............................................. Eng 7-3
TypeInCmd Custom Control ............................. Eng 10-21

U
UltraChrome
Default Color, Personality .............................. Eng 11-15
Default Edge Width, Personality ....................... Eng 11-15
Default Mode, Personality .............................. Eng 11-15
Unlock Installation ...................................... Eng 12-45
Unlock Personality ....................................... Eng 11-25
Unshaped, alpha ......................................... Eng 7-6
Up Custom Control ....................................... Eng 10-21
UP ONE button ............................................. Eng 5-2
Up/Down Converters ...................................... Eng 16-1
Bus Disabling ............................................. Eng 16-5
Conversion Loop ......................................... Eng 16-2
activation .................................................... Eng 16-2
delay ........................................................... Eng 16-3
setup ........................................................... Eng 16-2
video formats .............................................. Eng 16-3
Locking Conversion Loops .............................. Eng 16-6
Switcher Setup ........................................... Eng 16-5
Upgrade procedure ...................................... Eng 6-3
Upgrade Status
Done ......................................................... Eng 6-8
Failed ......................................................... Eng 6-8
In Progress ................................................ Eng 6-8
No Status .................................................... Eng 6-8
Pending ....................................................... Eng 6-8
Upgrading PMC ............................................... Eng 18-23
Upper Display Region .................................... Eng 5-3
USB
cable (Touchscreen) ...................................... Eng 3-9
ports ......................................................... Eng 2-15, Eng 2-16
software upgrade ........................................ Eng 6-3
Use Break Extra Option .................................. Eng 9-27
User
reference description ..................................... Eng 1-4
User Colors ................................................ Eng 11-18
Custom Control Buttons ................................ Eng 11-18
Re-entry Buttons .......................................... Eng 11-18
Selected Buttons ......................................... Eng 11-18
Selected Xpt ............................................... Eng 11-18
Xpt Colors ................................................ Eng 11-19
Using
custom control, basics ................................ Eng 10-10
Using Frame Rates ........................................ Eng 2-33

V
Variabel Pause CC Custom Control .......... Eng 10-24, Eng 10-37
VCR, definition ............................................. Eng 1-5
Verification of Inputs .................................... Eng 4-16
Verification of Output BNCs ........................... Eng 8-5
Version Extra Option .................................... Eng 9-25
Version upgrade, software ............................. Eng 6-3
Version, software ........................................ Eng 17-2
Version, System Information Page .................. Eng 6-8
Video Formats ............................................ Eng 20-14
explained .................................................... Eng 2-31
Input BNC .................................................... Eng 7-5
setting ....................................................... Eng 4-11
Video Input Board ......................................... Eng 2-12
10 input ...................................................... Eng 2-12
16 input with crosspoint .............................. Eng 2-12
Video Input Connections .............................. Eng 3-13
Video Input Signal Characteristics ................. Eng 20-15, Eng 20-16
Video Input Worksheet ................................. Eng 21-2, Eng 21-9
Video Inputs
configuring types ........................................ Eng 7-4
naming ....................................................... Eng 7-2
Video Mode, Source ...................................... Eng 7-3
Video Output Board ....................................... Eng 2-12
Video Output Connections ............................ Eng 3-15
Video Processing Specifications ..................... Eng 20-14
Video Processor Board Eng 2-13, Eng 2-24, Eng 2-26
functionality ............................................... Eng 2-35
Video Routing ............................................. Eng 2-20
Crosspoint .................................................. Eng 2-20
Squeeze & Tease Carrier ............................... Eng 2-27, Eng 2-28
Video Processor ......................................... Eng 2-24, Eng 2-26
Video Server Clip Setup ................................. Eng 12-17
Video Server Control option .......................... Eng 6-13
Video Server, Input Type, see VTR
Video Servers
clip timecode, grab ...................................... Eng 12-20
custom control functions .............................. Eng 10-2
inpoint/outpoint ......................................... Eng 12-18
Video system
reference description .................................... Eng 1-4
Video, Input BNC Type ................................ Eng 7-5
Vision 1
control panel .............................................. Eng 2-6
Vision 1M
control panel .............................................. Eng 2-5
Vision 2
control panel .............................................. Eng 2-5
Vision 2M
control panel .............................................. Eng 2-4
Vision 2X
control panel ........................................... Eng 2-3
Vision 3
control panel ........................................... Eng 2-2
Vision 3M
control panel ........................................... Eng 2-4
Vision 4
control panel ........................................... Eng 2-2
Vision OS Version ......................................... Eng 6-9
VNC Viewer .............................................. Eng 17-31
VTR Clip Setup .......................................... Eng 12-17
VTR POL On-air Display .......................... Eng 11-15
VTR POL Prep’d Display .......................... Eng 11-16
VTR Remote Control option ........................ Eng 6-13
VTR Timecode, Preview Overlay Setup .... Eng 12-32
VTR, definition .............................................. Eng 1-5
VTR, Input Source Type .............................. Eng 7-4
VTRs
   custom control functions ....................... Eng 10-2
   Custom Device ...................................... Eng 9-21

W
Wait nFields Extra Option ....................... Eng 9-32
Wake Up On Command .............................. Eng 11-8, Eng 11-16
Warnings .................................................... Eng 17-11
Status Icons ......................................... Eng 17-12
Web Interface
   Account, managing ................................. Eng 6-2
   downloading to Frame ....................... Eng 13-15
   Frame .................................................. Eng 13-15
   storage capacity ................................... Eng 6-8
   system information page ....................... Eng 6-7
   upgrading the switcher ............................ Eng 6-3
   uploading to Frame ............................. Eng 13-15
Web Issues ..................................................... Eng 4-8
WhiteFlash
   Memory Recall Mode, Personality .... Eng 11-12
Worksheets ................................................... Eng 21-1
   Bus Map .......................................... Eng 21-6
   Communications ................................. Eng 21-11
   Conversion Loop ................................. Eng 21-20
   Custom Control ................................. Eng 21-18
   Custom Device Protocol ..................... Eng 21-22
GPI I/Os
   Aux Panel ..................................... Eng 21-15
   Input ............................................. Eng 21-13
   Output .......................................... Eng 21-14
   Video Input .................................... Eng 21-2, Eng 21-9

X
XFX Extra Effects Card ............................... Eng 2-29
Xpts Extra Option ........................................Eng 9-29

Z
Z Speed Extra Option ................................... Eng 9-29
Zoom Speed Extra Option ............................ Eng 9-29